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1 Quick start to Tekla Structures
drawings

Read this article if Tekla Structures drawings are new to you!

You will learn:

• What is specific to Tekla Structures drawings, and what is included in the
drawings

• What to do before creating any drawings

• How to create drawings in your first project using the predefined settings
in your environment

• How to modify the created drawings manually in the drawing mode

1.1 Basics of Tekla Structures drawings
• In Tekla Structures, a drawing is a window to the model presenting the 3D

model structures in 2D, together with object dimensions and other
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markings derived from model data. Below is an example of a drawing view
containing building objects, marks and dimensions:

• From Tekla Structures, you can get general arrangement drawings
(page 80), single-part drawings (page 85), assembly drawings (page 88),
cast unit drawings (page 90), and multidrawings (page 93).

Up-to-date drawings

Tekla Structures drawings are always up to date (page 46) because:

• The building objects shown in the drawing are exactly the same as the
model objects created in the model. You can change their representation
(page 991) in the drawing, but you cannot change the geometry or the
location of the building object, or delete building objects; all changes to
building objects are made in the model.

• Most objects in the drawing are associative (page 46) and automatically
updated when the corresponding model objects change. For example, if
you resize a model object, the associated dimension points move with the
corresponding object in the drawing, the dimensions are recalculated, and
the related data is updated in markings. Still, you do not lose any manual
changes that you have made in the drawing. Note that if the dimension
points do not move, they are not associated with any building objects.

Drawing objects, views and drawing layout

Drawing objects are organized inside drawing views, which are placed in the
selected drawing layout according to the selected settings:

• Drawing objects (page 59) include building objects (parts, bolts, welds,
chamfers, reinforcement, surface treatment, etc.), annotation objects
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(marks, notes, dimensions, texts, linked objects, reference objects, etc.) and
sketch objects (lines, rectangles, clouds, circles, etc.).

All these objects are adjustable.

Some examples building objects, dimensions, marks, texts, and clouds:

• Drawing views (page 168) act as containers for the building objects, or for
areas in the model that you have selected to include in the drawing. The
drawing view size adjusts automatically to fit in more content when
necessary. Drawing views can show building objects from different
directions (top, front, back, bottom), or as cross sections. View settings, for
example the view depth and scale, are adjustable.

Example of a GA drawing with an erection elevation view and detail views:
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Example of a combined form and reinforcing bar drawing of stairs with
landings with two main views and a couple of detail views:

Example of a beam assembly drawing with one main view and a section
view:
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• A drawing layout (page 655) defines:

• The drawing size, and spaces between the drawing frame and views,
and between the drawing views (page 656)

• The drawing frames and fold marks (page 656)

• The table set (page 669) including a revision table, title block, material
list, bill of materials, and general notes.

The data in the tables is derived directly from the model data. You can
create tables in Template Editor, and add tables in the drawing layout
and adjust the layout settings in Layout editor (page 656).

Below is an example of a typical fabrication drawing layout:
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(1) Margins between the drawing frame and the outermost views

(2) Spaces between the views

(3) Top view

(4) Front view

(5) Section views A-A and B-B

(6) Drawing frame

(7) Key plan

(8) Material list

(9) Revision table

(10) Drawing title block

(11) Fold marks

Predefined drawing settings

Your environment contains predefined drawing settings suited for various
purposes, on multiple levels.

When you a create drawing for the first time, all you have to do is to pick the
most suitable predefined drawing settings file from the list in the drawing
properties dialog box.

Note that the drawing level settings also define which layout is used.

You can modify these settings and save your own settings files for your future
drawings.

Below is an example of a list of drawing settings in a GA drawing:
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1.2 Before creating drawings in Tekla Structures
• You can create drawings at any stage of the project, but to minimize re-

work, take the detailing as far as possible, and finish numbering before
drawing creation (page 97). Numbering is a prerequisite for creating
single-part, assembly, and cast unit drawings.

• Ensure that the object classifications and naming in your model matches
filtering. Follow the company conventions.

• In the model, create all necessary views for GA drawings. GA drawing views
will have the same orientation and content as the model view. For
example, create an erection elevation view or a floor plan view. A good idea
is to fit the work area in the model view using two points to select the area
that you want to show in the drawing.

• Decide the view depth to use in GA drawings. Set the desired view depth in
the initial model view for efficient and transparent workflow. The drawings
will use the depth defined for the view in the model.

• Decide which predefined settings and drawing layout (page 656) you want
to use. Select suitable default settings and a layout available in your
environment.
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1.3 Create a general arrangement drawing
In your first project, the idea is to create a general arrangement (GA) drawing
using predefined settings from your environment, and then modify the
drawing manually in the drawing mode as necessary.

1. Go to the Drawings & reports tab on the ribbon, and select Drawing
properties --> GA drawing. 

• Open the drawing settings list, and select the settings file with a name
that suits your needs.

• Check the general settings. If you modify the settings in the subdialog
boxes, remember to click OK:

• Define Name and Title 1 - Title 3.
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• Go to Layout... settings and change the layout to another one if
necessary.

• Go to View... settings and select the Scale and the Label. The
depth is taken automatically from the model view.

• Go to building object (part, reinforcement, surface treatment, etc.)
settings and modify the representation.

• Go to Filter... settings and create filters. Decide which objects you
want to show in the drawing, and filter other objects away.

In the following example, you only want to show columns, beams,
and footings:

• Click Apply in the General Arrangement Drawing Properties
dialog box to apply the changes to the drawing that you will create.
Also, save the drawing settings so that you can use the saved
settings in your next projects.

2. On the Drawings & reports tab on the ribbon, click Create drawings -->
GA drawing.

3. In the Create General Arrangement Drawing dialog box, select the view
from which you want to create the drawing among the views that you
created earlier in the model. 

GA drawings are based on model views, so select a suitable floor plan
view or grid line view, for example.

4. To create the drawing, click Create.
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1.4 Modify a GA drawing
In the drawing mode, modify the drawing manually to get the desired result.

1. On the Drawings & reports tab on the ribbon, click Document manager,
and select and open the GA drawing you created earlier.

2. Check the layout, tables and the title block; all content outside the views.
To modify the layout, open Layout editor (page 656) by double-clicking a
table in the layout. 

For example, double-click the title block:

3. Check the view, and change the view settings (page 920) by double-
clicking the view frame. The view frame is visible when your mouse
pointer is within the view frame. 

• Is the scale appropriate?

• Is the view label appropriate?

• Does the view contain the building objects that you want? If not,
change the object visibility settings and filtering.

• Are you happy with the building object representations? If not, check
the part, bolt, surface treatment, reinforcement, etc. representations.

• When you are done, click Modify. Also save the view settings so that
you can use them in your next projects.

4. Create the necessary detail views (page 169), and add 2D details from 2D
Library (page 519). The view creation commands are located on the
drawing Views tab, and 2D details in Drawing 2D Library in the side
pane. 
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5. Check and modify the content of the views, one by one: 

• Note that after you start modifying the view content, you should not
touch the view settings.

• Add lines, graphics (page 353), symbols (page 330), and text (page 320).
Tools for adding these are located on the drawing mode ribbon on the
Drawing and Annotations tabs.

• Remove undesired dimensions, add new dimensions (page 201), and
double-click a dimension to change the dimension settings (page 257).
Save the settings for later use. The dimensioning commands are
located on the Dimensioning tab on the drawing ribbon.

• Delete unnecessary marks (page 304), create new marks (page 287)
and reinforcement marks (page 289), double-click a mark to change
mark settings (page 299), and arrange (page 344) or align (page 345)
the marks. Save the settings for later use. The related commands are
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located on the Annotations tab on the drawing ribbon and in the
context menu.

6. Arrange the views, or align all views vertically or horizontally with the main
view. (page 189) 

The Arrange command is located on the Views tab on the drawing
ribbon, and the alignment commands on the context menu.

When you are happy with the result, use this drawing as the cloning template
for cloning drawings (page 144) for other similar model content. You can also
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use drawings in the current project as cloning templates (page 143) in your
future projects.

Below is an example of a foundation plan drawing. To see the drawing in full
size, right-click here and select the option that opens the PDF drawing in
another browser window.

(1) Grid dimensions

(2) Part marks

(3) Section marks A-A, B-B, and C-C

(4) Manual dimensions

(5) Section views A-A, B-B, and C-C

(6) Rebar group mark

(7) Rebar mark with pull-out picture

(8) Level marks

(9) Revision table

(10) Drawing title block table

(11) Drawing frame and margin

1.5 Create a precast fabrication drawing
As this is your first project, we recommend that you create a precast
fabrication drawing using predefined settings from your environment, and
then modify the drawing manually in the drawing mode as necessary.

1. Go to the Drawings & reports tab on the ribbon, and select Drawing
properties --> Cast unit drawing.
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2. Open the drawing settings list, and select the settings file with a name that
suits your needs. 

3. Check and change the general settings in Cast Unit Drawing Properties: 

• Define Name and Title 1 - Title 3.

• Go to Layout settings and change the layout to another one if
necessary.
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• Go to Section view and set the default section view depth and section
mark content.

• Go to View creation and define at least one main view to create, for
example, front view, and type a Label for the view.

4. Select a view that you created from the view list and go to View
properties. Modify the view settings (page 920). If you decide to create
several main views, modify the settings for each view separately. 
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• Set the Scale.

• Modify building object settings and set the object representation.

In your first project, you will probably have one concrete part and
some embed parts. Set the part representation to either Outline or
Exact. Set the reinforcement to Visible, and the reinforcement
representation to single line with filled ends, for example. Also,
remember to check surface treatment settings.

• Go to Filter... settings and create filters. Decide which objects you
want to show in the drawing, and filter other objects away.

In the following example, all other rebars have been filtered out,
except embeds:
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• When you are done, Save the view settings and click Close.

5. Click Apply in the Cast Unit Drawing Properties dialog box to apply the
changes to the drawing that you will create. Also, save the drawing
settings so that you can use the saved settings in your next projects.

6. Select the objects. 

Ensure that the correct selection switches are active, and select the entire
model using area selection. You can also use selection filters to select
objects.

7. On the Drawings & reports tab, select Create drawings --> Cast unit
drawing.

1.6 Modify a precast fabrication drawing
In the drawing mode, modify the precast fabrication drawing manually to get
the desired result.

1. On the Drawings & reports tab on the ribbon, click Document manager,
and select and open the precast fabrication drawing you created earlier.

2. Check the layout, tables and title blocks; all content outside the views. To
modify the layout, go to Layout editor (page 656) by double-clicking a
table in the layout. 

For example, double-click the title block:
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3. Check the settings in the main view that you created, and change the view
settings (page 920) by double-clicking the view frame. The view frame is
visible when your mouse pointer is within the view frame. 

• Is the scale appropriate?

• Is the view label appropriate?

• Does the view contain the building objects that you want? If not,
change the object visibility settings and filtering.

• Are you happy with the building object representations? If not, check
the part, surface treatment, reinforcement, etc. representations.

• When you are done, click Modify. Also save the view settings so that
you can use them in your next projects.

4. Create other views (page 169) (section views, detail views), and check the
view settings in the same way as for the main view you created. Also, add
2D details from 2D Library (page 519), and links to DXF files (page 323)
and images (page 323). The view creation commands are located on the
drawing Views tab, 2D details in Drawing 2D Library in the side pane,
and the linking commands on the Drawing tab. 

Quick start to Tekla Structures drawings 32 Modify a precast fabrication drawing



5. Check and modify the content of the views, one by one: 

• Note that after you start modifying the view content, you should not
touch the view settings.

• Add lines, graphics (page 353), symbols (page 330), and text (page 320).
Tools for adding these are located on the Drawing and Annotations
tabs on the drawing ribbon.

• Remove undesired dimensions, add new dimensions to parts
(page 195) and reinforcement (page 211), and change part dimension
settings (page 257) and rebar dimension settings (page 939) by double-
clicking a dimension. Save the settings for later use. The dimensioning
commands are located on the Dimensioning tab on the drawing
ribbon.

• Delete unnecessary marks (page 304), create new marks (page 287),
reinforcement marks (page 289), and associative notes (page 297),
double-click a mark to change mark settings (page 299), and arrange
(page 344) or align (page 345) the marks. Save the settings for later
use. The related commands are located on the Annotations tab on
the drawing ribbon and in the context menu.
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6. Arrange the views, or align all views vertically or horizontally with the main
view. (page 189) 

The Arrange command is located on the Views tab on the drawing
ribbon, and the alignment commands on the context menu.

When you are happy with the result, use this drawing as the cloning template
for cloning drawings (page 144) for similar cast units. You can also use
drawings in the current project as cloning templates (page 143) in your future
projects.

Below is an example of a cast unit formwork drawing. To see the drawing in
full size, right-click here and select the option that opens the PDF drawing in
another browser window.
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(1) Associative note

(2) 3D view created automatically

(3) Symbol (center of gravity)

(4) Line

(5) Text

(6) 2D detail from Drawing 2D Library or image

(7) Rebar bending schedule with graphical fields for pull-out pictures

(8) Material list table with table header row, table content rows, total
reinforcement weight row and total cast unit weight sum row

(9) Recess with hidden lines

(10) Concrete part

(11) Embed part/rebar

(12) Overall dimensions created automatically

(13) Recess dimensions created automatically

(14) Filter dimensions created automatically

(15) Formwork front view

(16) Section mark A-A

(17) Part contour
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(18) Dimension tag

(19) Section view A-A created automatically

(20) Rebar mark with pull-out picture

(21) Rebar group mark

(22) Rebar

(23) Reinforcement front view

(24) Rebar group dimension

(25) Detail mark

(26) Detail view

(27) Drawing title block table

(28) Attribute (Tekla Corporation) and fixed text (Product name) in table

(29) Revision table

(30) Image in table

(31) Drawing frame and margin

1.7 Create a steel fabrication drawing
As this is your first project, we recommend that you create a steel fabrication
drawing using predefined settings from your environment, and then modify
the drawing manually in the drawing mode as necessary. The instructions
below apply to assembly drawings.

1. Go to the Drawings & reports tab on the ribbon, and select Drawing
properties --> Assembly drawing.
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2. Open the drawing settings list, and select the settings file with a name that
suits your needs.

3. Check and change the general settings in Assembly Drawing Properties: 

• Define Name and Title 1 - Title 3.

• Go to Layout settings and change the layout to another one if
necessary.
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• Go to Section view and set the default section view depth and section
mark content.

• Go to View creation and define at least one main view to create
(page 689), for example, front view, and type a Label for the view. You
can also create section views and end views here.

Also, define the bolt and weld visibility settings (page 915) common to
all views. Check and fill in the user-defined attributes (page 915) that
are common to all your fabrication drawings.
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4. Select a view that you created from the view list, for example the front
view, and go to View properties. Modify the view settings (page 920). If
you decided to create several main views, modify the settings for each
view separately. 
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• Set the Scale.

• Go to building object (part, neighbor part, bolt, weld, reference object,
grid, etc.) settings and set the object visibility and representation.

For parts, Outline usually works for parts shown in main views. Exact
is ideal for parts in detail, section, and end views, because it shows the
true contours of hot-rolled profiles, for example. For welds, you can
define whether to show the modeled welds or not (page 1015). For
bolts, you can define whether to show bolt holes and bolt axis, or
actual bolts (page 997). If you prefer it simple, use the hole
representation.

• When you are done, Save the view settings and click Close.

5. Click Apply in the Assembly Drawing Properties dialog box to apply the
changes to the drawing that you will create. Also, save the drawing
settings so that you can use the saved settings in your next projects.

6. Select the objects. 

Use selection filters to select objects. When you create assembly
drawings, ensure that the assembly selection switch is active.
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7. On the Drawings & reports tab on the ribbon, select Create drawings -->
Assembly drawing.

1.8 Modify a steel fabrication drawing
In the drawing mode, modify the steel fabrication drawing manually to get the
desired result.

1. On the Drawings & reports tab on the ribbon, click Document manager,
and select and open the steel fabrication drawing you created earlier.

2. Check the layout, tables and title blocks; all content outside the views. To
modify the layout, go to Layout editor (page 656) by double-clicking a
table in the layout. 

For example, double-click the shop material list:

3. Check the settings in the main views (top, front, bottom, back) that you
created, and change the view settings (page 920) by double-clicking the
view frame. The view frame is visible when your mouse pointer is within
the view frame. 

• Is the scale appropriate?

• Is the view label appropriate?

• Does the view contain the building objects that you want? If not,
change the object visibility settings.

• Are you happy with the building object representations? If not, check
the part, surface treatment, bolt, weld, etc. representations.

• When you are done, click Modify. Also, save the view settings so that
you can use them in your next projects.

4. Create other views (page 169) (section views, detail views), and check the
view settings in the same way as for the main views you created. Also, add
2D details from 2D Library (page 519), or links to DXF files (page 323). The
view creation commands are located on the drawing Views tab, the
Drawing 2D Library in the side pane, and the commands for adding links
on the Drawing tab. 
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5. Check and modify the content of the views, one by one: 

• Note that after you start modifying the view content, you should not
touch the view settings.

• Add lines, graphics (page 353), symbols (page 330), and text (page 320).
Tools for adding these are located on the drawing mode ribbon on the
Drawing and Annotations tabs.

• Remove undesired dimensions, add new dimensions to parts and bolts
(page 195), and double-click a dimension to change dimension settings
(page 257). Save the settings for later use. The dimensioning
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commands are located on the Dimensioning tab on the drawing
ribbon.

• Delete unnecessary marks (page 304), create new marks (page 287),
double-click a mark to change mark settings (page 299), and arrange
(page 344) or align (page 345) the marks. Also, add manual section
marks (page 293). Save the settings for later use. The related
commands are located on the Annotations tab on the drawing ribbon
and in the context menu.

6. Arrange the views, or align all views vertically or horizontally with the main
view. (page 189) 
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The Arrange command is located on the Views tab on the drawing
ribbon, and the alignment commands on the context menu.

When you are happy with the result, use this drawing as the cloning template
for cloning drawings (page 144) for similar assemblies. You can also use
drawings in the current project as cloning templates (page 143) in your future
projects.

Below is an example of a column assembly drawing. To see the drawing in full
size, right-click here and select the option that opens the PDF drawing in
another browser window.

(1) Grid location table tells on which grid line the assembly is located in the
model

(2) Section A-A created automatically, manual marks and dimensions

(3) Model weld marks

(4) Part marks

(5) Section marks A-A, B-B, and C-C

(6) Front view
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(7) Bolt mark

(8) Bolts

(9) Column C/54

(10) Column contour

(11) Manual section mark C-C (without a section view). The identifier is C-C to
indicate that this section is identical to the C-C section that has a section view

(12) Section C-C created automatically, manual marks and dimensions

(13) Top view

(14) Bolts, plates and marks hidden by other parts

(15) Drawing frame and margin

(16) Revision table

(17) Drawing title block

(18) Call off table indicating the total number of main parts in the drawing

(19) Material list table

(20) Dimensions: Most dimensions are automatic Integrated dimensions.
The section view dimensions are manual.

(21): Section B-B created automatically, manual marks and dimensions
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2 Drawings in Tekla Structures

Tekla Structures drawings contain a large variety of features and tools that
help you to create and manage your drawings efficiently.

Main drawing features

• The model is the single source of information for drawings. The drawing is
just another view to the model, usually a 2D view.

• Creating drawings is fast, efficient and controlled thanks to one centralized
location, Master drawing catalog.

• Automatic workshop single-part and assembly drawings, and cast unit
drawings of selected parts with predefined settings for layout, views,
dimensions, marks, and building objects. View properties are defined
separately for each view before a drawing is created.

• Automatic general arrangement drawings and anchor bolt plans of
selected views.

• Drawing objects are associated with model objects, and updated when the
model changes.

• Changing some of the properties requires the recreation of the drawings.

• If there are several identical parts, cast units or assemblies in the model,
Tekla Structures creates only one drawing.

• You can modify drawing properties on three levels; drawing, view and
object level, depending on the drawing type and the desired results.

• The drawings consist of three main types of elements: drawing layout,
drawing views, and drawing objects. You can select what to include in the
drawing before you create it, and also add, modify and delete objects in an
existing drawing.

• You can check previews of the drawings, and print your drawings to pdf,
printer or plot files.

• You can control drawing revisions, and issue, lock, and freeze drawings.

• You can use interactive editing tools for adding dimensions, various sketch
objects, marks, notes, texts, symbols, images and links in the drawings.
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Drawings are integrated with models

Tekla Structures integrates the drawings with the model. A drawing is a
window to the model presenting 3D structures in 2D. The building objects
shown in the drawing are model objects you create in the model. You can
change their representation in the drawing but you cannot change the
geometry or the location of the building object, or delete building objects; all
changes to building objects are made in the model. That is why the drawings
are always up to date, and dimensions and marks in drawings are always
correct, for example. You can filter out parts and bolts in drawings using the
filtering tools, or make them invisible by hiding them.

You can create drawings at any stage of the project. Creating single-part,
assembly and cast unit drawings requires that the model is numbered, so you
need to plan and perform the numbering before creating drawings. For more
information about numbering, see .

If the model changes, Tekla Structures notifies in Document manager that
you need to update the related drawings. You cannot open a drawing that is
not up to date. For more information about updating the model, see Update
drawings when the model changes (page 581).

Drawings are associative

Tekla Structures drawings are associative. The objects in the drawing are linked
to model objects, which means that most objects in the drawing are
automatically updated when the corresponding model objects change. For
example, if a model object is resized, the dimension points move with the
corresponding object in the drawing, and the dimensions are recalculated. Still
you do not lose any manual changes that you have made in the drawing. This
applies to all drawing types.

Tekla Structures updates the following drawing objects to reflect the changes
in the model:

• Parts

• Marks

• Dimensions

• Welds

• Views

• Section marks

• Detail marks

• Associative notes

• Lines and other shapes

• Tables

Tekla Structures retains the following manual changes made to drawings:

• Base points of objects; for example, if you drag an object to a new location
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• Object properties; for example, color, font, and line type

Advanced options related to associativity

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL

XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES

Associativity symbol

In drawings, the associativity symbol indicates which drawing objects are
associative and automatically updated. Associativity symbols are shown only
when you select a drawing object, for example, a dimension.

Objects that do not have valid association get a ghost associativity symbol and
a question mark. These symbols are shown constantly, even though the
drawing object is not selected. This makes it easier to find objects that need
attention.

The associativity symbols are not shown in printed drawings.

Drawings in Tekla Structures 48



TIP To hide associativity symbols in drawing views, on the File menu, click
Settings and select the Associativity symbol check box, or press Shift
+A on the keyboard.

Find out more about drawings

To Click the links below to find out
more

Check the controls available in
drawing mode

Drawing mode in Tekla Structures
(page 50)

Find out what happens when a
drawing needs to be updated

How to keep your drawings up to
date? (page 61)

Learn where you can change the
drawing properties and in which
order

Different levels of setting up and
modifying drawing properties
(page 62)

Find out the cases when a drawing
needs to be updated

Recreation of drawings (page 78)

Find out what the drawing consists of Drawing objects, views and layouts
(page 59)

Check the different drawing types
available and learn how to create
them using different methods

Create drawings in Tekla Structures
(page 95)

Create drawings by cloning, and find
out the situations when cloning is the
best choice

Clone drawings (page 141)

Find the drawings that you need
using searching and filtering in
Document manager, select
drawings, and open drawings

Document manager (page 559)

Edit your drawings manually: add
objects, modify properties, etc.

Edit drawings (page 155)

Update drawings when the model
changes, lock drawings, freeze
drawings, issue drawings, revise
drawings, and delete drawings

Manage drawings (page 558)

Print drawings as PDF files, save them
as plot files (.plt) for printing with
printer/plotter, or print them on a
selected printer

Print drawings (page 606)

Set up and modify automatic drawing
settings

Define automatic drawing settings
(page 650)

Check the available drawing
properties and setting

Drawing settings reference (page 911)
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2.1 Drawing mode in Tekla Structures
When you open a drawing, Tekla Structures activates the drawing mode. The
ribbon and tabs for the modeling mode are replaced by those of the drawing
mode. The model views remain on the screen in the background. When you
Save and close drawings (page 158) close the drawing, you automatically
return to the modeling mode.

The following image identifies the locations of the controls in the a drawings
window:

(1) The File menu contains commands that can be used in the drawing mode.

(2) The ribbon and the tabs mostly contain commands available only for
drawings, some commands are common with the modeling mode.

(3) Quick Launch for searching drawing-related commands.

(4) The side pane gives access to macros and other applications that are
available in drawings in the Applications & components catalog. The 2D
Library for drawings is also located in the side pane.

(5) With selection switches you can scale down the amount of selectable
objects.

(6) Snap switches control which points you can snap to and pick.
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Snapping in drawings
In drawings, you can snap in positions in the same way as in the model. You
can also snap to orthogonal angles while placing drawing objects or sketching.
Zoom level affects free snapping in the way that the closer you zoom, the
more exact you can snap. You can also place a drawing sketch object at a
specified distance in the indicated direction.

Note that you cannot snap to blank lines.

Drawing snap switches and snap settings

For a list of and for more information about drawing snap switches, see Snap
to points by using snap switches. .

For more information on snap settings, see .

Snap to orthogonal points in a drawing
Use the Ortho tool to snap to the closest orthogonal point in a drawing. You
can specify the orthogonal angle in Drawing snap settings. Using ortho
snapping is useful if you need to place associative notes in a consistent
manner, or sketch a polygon using a certain angle, for example. You can use
predefined ortho angles and specify custom angles.

1. To activate orthogonal snapping, on the File menu, click Settings and
select the Ortho check box. 

By default, the keyboard shortcut is O.

2. Open a drawing and on the File menu, click Settings --> Snap settings . 

Note that you have the same snap settings available in the model, but
these settings have no effect on drawings.

3. Set the snapping angles using one or both of the following ways: 

• Angle interval: Select the check box next to Angle interval and then
select a predefined angle: 10, 15, 30, 45, 90.

• Custom angles: Select the check box next to Custom angles and
define the custom angles you want to snap to, for example, 12.5 or
17.5.
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4. You can save different snap settings by entering a unique name in the
Save as box and clicking Save as. 

The settings are saved in the \attributes folder under the model folder.

5. Click to save and apply the new settings.

In the example below, you first add a text with a leader line using a 60 degree
angle to the part:

Then you will add a new text using the same angle:
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Free snapping

Free snapping  in drawings is based on the zooming level in drawings: The
closer you zoom, the more exact you can sketch. For example, you can more
easily create rectangles that are of exact length when you zoom closer. The
snapping step changes from 1 to 1000 ( 1/16" - 5') depending on the zoom
level. You can follow the dimensions while you sketch.

Place a sketch object at a specified distance
You can snap to a specified distance in the indicated direction and place a
sketch object in that position. You can specify the distance coordinate in the
Enter a Numeric Location dialog box. In the following, you will ad a line.

1. On the Drawing tab, click Line to activate the line tool. 

2. Hold down Ctrl and pick an origin. 

3. Point to the direction where you want to place the start point of the line. 
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Here, the bolt group needs to be moved 30 mm to the right and the line
will indicate the new position for the group.

4. Start entering the distance, for example 30. 

The Enter a Numeric Location dialog box is displayed.

5. When you have entered the distance, click OK. Tekla Structures indicates
the start point of the line. 

6. Pick an end point for the line. 
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7. To check that the distance is correct, create a dimension. 
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Zooming and panning in drawings
The zooming commands in the context menu in drawings allow you to focus
on a particular area, or pull out for a wider view. You can also use the mouse,
keyboard shortcuts or Quick Launch. You can also pan (move) the drawings.

TIP Try the advanced option XS_USE_SMART_PAN: To activate optimized
zooming and panning in drawings, set this advanced option to TRUE.
When the smart pan is enabled while you pan or zoom a heavy drawing
with lots of graphics, the whole screen is not drawn, empty space is left
on the edges, and zooming and panning is faster. The default setting is 
FALSE, because using the optimization sometimes results in an
unwanted checkerboard effect.

NOTE The point at which the level of detail is reduced in drawings was set
earlier starting from the Tekla Structures version 2020. This means
that zooming out in drawings drops details earlier than before. As a
result, overall zooming and panning is smoother, while some drawing
content is simplified and some is left out when zoomed out to certain
extent. The effect is easy to notice in large drawings with a high
amount of content.

The change in the level of detail affects:

• Hidden lines, which are not drawn

• Very short lines, which are not drawn

• Hatches, which are drawn as a cloud of points

• Text, which is replaced by a line

Zoom in and out

You can use a variety of tools to zoom in and out in the drawing. By default,
the mouse pointer position determines the center point of zooming.

To Do this
Zoom in Do one of the following:

• Scroll forward with the mouse
wheel.

• Press Page Up on the keyboard.

• Right-click the drawing and select
Zoom --> Zoom in. Then click the
location in the view that you want
to zoom in.
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To Do this
• Go to Quick Launch, enter Zoom

in and select the command from
the list.

Zoom out Do one of the following:

• Scroll backwards with the mouse
wheel.

• Press Page Down on the
keyboard.

• Right-click the drawing and select
Zoom --> Zoom out. Then click the
location in the view that you want
to zoom out.

• Go to Quick Launch, enterZoom
out and select the command from
the list.

Zoom to selected objects 1. Select the objects in the drawing.

To select multiple objects, hold
down Ctrl.

2. Right-click and select Zoom -->
Zoom selected.

You can also go to Quick Launch,
enter Zoom selected and select the
command from the list.

Zoom selected works for any
drawing objects that you select inside
and outside the drawing views, and
also for selected views.

Note that Zoom selected also works
for templates.

Restore the original zoom level Do one of the following:

• Right-click the drawing and select
Zoom --> Zoom original.

• Press Home on the keyboard.

• Go to Quick Launch, enter Zoom
original and select the command
from the list.

Return to the previous zoom level Do one of the following:

• Right-click the drawing and select
Zoom --> Zoom previous.

• Press End on the keyboard.
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To Do this
• Go to Quick Launch, enter Zoom

previous and select the command
from the list.

Create a zoom window 1. Right-click the drawing and select
Zoom --> Create Zoom Window.

2. Click a starting corner for the
zoom window, and then drag the
pointer to size the window.

You can also go to Quick Launch,
enter Create Zoom Window and
select the command from the list.

Pan in drawings

To Do this
Activate panning Do one of the following:

• Press P on the keyboard.

• Go to Quick Launch, enter Pan
and select the command from the
list.

In an open drawing, the Pan
command moves the whole drawing.
The pointer will change to a hand.
Click and drag the mouse to move the
drawing anywhere within the window.

• To deactivate panning, press Esc.
Activate middle mouse button pan Do one of the following:

• Select File --> Settings --> Middle
button pan.

• Press Shift+M on the keyboard.

• Go to Quick Launch, enter Toggle
middle button pan and select the
command from the list.

When middle mouse button panning
is active, the text Pan is shown at the
bottom of the Tekla Structures
window. Hold down the middle
mouse button and drag the drawing
anywhere within the window.

• To deactivate middle mouse
button panning, clear the Middle
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To Do this
button pan check box or press
Shift+M again.

2.2 Drawing objects, views and layouts
Drawing objects are organized inside drawing views, which are placed in the
selected drawing layout according to the selected settings.

Drawing objects

Drawings may contain several types of objects. Some of them come from the
model and represent something that will exist in the real building or will be
closely related to it. Others are objects that represent information that is only
relevant in the drawing, or add extra information to the information in the
model. Drawings may include the following object types:

• Building objects (page 375): parts, bolts, welds, chamfers, reinforcing bars,
surface treatment, etc.

• Associative annotation objects (page 276): dimensions, marks, associative
notes.

• Independent annotation objects (page 276): objects that are not linked to
the model: text, .rtf files, symbols, links, hyperlinks, DWG/DXF files, and
reference models. These objects become associative if they have
associativity points, i.e. they are associated to building objects.

• Sketch objects (page 352): graphical objects you create using the various
sketching tools. These objects can be used for highlighting parts of the
drawing (clouds, lines, rectangles, etc.), for example. These object are
associative if they have associativity points, i.e. they are associated to
building objects.
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(1) Sketch objects: clouds and rectangles

(2) Dimensions

(3) Marks, associative notes

(4) Building objects

Drawing views and layouts

• Drawing views (page 168) are views to the whole model, to a part of the
model or to individual parts in the model. Views can show building objects
from different directions (top, front, back, bottom) and cross sections.
Drawing views act as containers for the building objects or areas in the
model that you have selected to be included in the drawing.

• A drawing layout (page 655) defines the drawing size, drawing view
margins, spaces between drawing views, a table set including tables, such
as revision tables, title blocks, material lists, key plans, DWG references, or
bills of materials, and also drawing frames and foldmarks. The data in the
tables is derived from the model data. Tekla Structures has a range of
predefined layouts, and you can also create your own layouts. Different
tables can be included in your drawing according to the selected drawing
layout and drawing size.

Below is an example of the drawing layout and views in a workshop drawing.
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(1) Top view to a part. Here you have selected to include the top view
(page 689) in the View creation pane.

(2) Front view to a part. Here you have selected to include the front view
(page 689) in the View creation pane.

(3) Material list. This is defined in your drawing layout (page 656).

(4) Drawing title block. This is defined in your drawing layout (page 656).

2.3 How to keep your drawings up to date?
When a model changes, the related drawings need to be updated. Tekla
Structures takes care of updating and notifies you if updating is needed.

WARNING When you start using a newer version of Tekla Structures, updating
drawings created with the older version may cause problems. We
recommend that you complete any drawings you have started using the
older version, or recreate the drawings using your new version of Tekla
Structures.

You need to update drawings when:

• The geometry of a model object changes.

• Some other model object properties, for example, material and class
change.
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• Model objects are added or deleted.

• The number of identical model objects changes.

Tekla Structures automatically updates drawings each time you number the
model. If you have not numbered the model, you are prompted to do so when
you create a drawing. Furthermore, if you have changed the model and go to
the Document manager to open drawings, Tekla Structures has marked the
outdated drawings, and you need to update them before you can open them.

General arrangement drawings are always updated when you open them if
the model has changed. You do not need to number the model to update
general arrangement drawings.

Click the following links to find out more about drawing update, when
recreation is needed, and how the drawings are numbered:

Update drawings when the model changes (page 581)

Recreation of drawings (page 78)

2.4 Different levels of setting up and modifying drawing
properties
In Tekla Structures, you can set up and change drawings and drawing
properties on different levels, depending on how permanent and extensive
changes are needed. You can change drawings on drawing, view and object
level.

Single-part, assembly and cast unit drawings

• On the highest level, you can define drawing properties on drawing level:

• The drawing-specific properties that you define in Drawing properties
apply to the whole drawing: user-defined attributes for the drawing,
detail view start number/letter, drawing-specific section view settings,
some drawing-specific view attributes, drawing titles and drawing layout
settings.

• On the drawing level, you can also select the views that you want to
create, and set view, dimensioning, protection, building object and mark
settings separately for each view by going further to View properties
for the selected view. For example, you can define that all marks have
blue frame in the top view, or that model weld marks are shown in a
front view. It is very important to save the view-level properties files in
View properties to be able to connect the desired view properties to
the views that you are creating.

• You can modify the drawing level properties before you create the
drawing and also change them in the created drawing.
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• You can also change drawing properties in single-part, assembly and cast
unit drawings on view level:

• Double-click a view frame in an open drawing, which opens View
properties.

• Change an object property. The change takes place only in the views
that you have selected in an open drawing.

• The object properties change in all objects of the particular type in the
selected views. For example, if you change the mark line color, the mark
line changes in all marks in the selected views.

• Finally, you can change drawing properties on object level:

• Double-click an object in an open drawing, which opens object-specific
properties.

• Properties change for the selected object only. You can change select
several objects and change the properties in all of them.

• The properties changed on the object level are no longer affected by
any property changes on higher levels.

General arrangement drawings

• On the highest level, you can change general arrangement drawing
properties on drawing level Drawing properties and its subdialog boxes:

• This way you can change the properties of all building objects,
protected areas, marks, dimensions, and views in the drawing at the
same time. For example, you can define that all marks have blue frame.

• You can modify the drawing properties before you create the drawing
and also change them in the created drawing.

• The object properties change in all views and objects in that drawing,
except for new views that you create after the drawing is created.

• You can also change general arrangement drawing properties on view level:

• Double-click a view frame in an open drawing, which opens View
properties.

• The changes take place only in the views that you have selected in an
open drawing.

• The object properties change in all objects of the particular type in the
selected views. For example, if you change the mark line color, the mark
line changes in all marks in the selected views.

• Finally, you can change drawing properties on object level:

• Double-click an object in an open drawing, which opens object-specific
properties.

• Properties change for the selected object only.
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• The properties changed on the object level are no longer affected by
any property changes on higher levels.

Detailed object level properties

By saving the object property settings and combining them with drawing or
view filters and drawing object types into detailed object level settings, you can
also apply the object level properties on the drawing and view level. Note that
detailed object levels properties on drawing level are available only in general
arrangement drawings. Object level settings are a powerful tool: you can use
the same property file for creating drawings and quickly change a particular
property before you create drawings, for example, reinforcement color or
mark frame shape. The object level settings override the property settings in
the view and drawing properties. Changes in the object level settings applied
on the drawing level are inherited to the view level if there are no object level
settings defined on the view level. If you apply object level settings on the view
level, they override the drawing level settings.

Recommended workflow

The recommended way of working is to work from top to bottom, from
drawing level to object level:

1. Set your drawing and automatic drawing view properties as close as
possible to what you want by first attempting this on the drawing level.

2. Then modify anything else that needs to be changed on the view level.

3. Finally, if any further cleanup is necessary, you can make changes on the
individual object level.

The modifications made on the drawing level remain when the drawing is
recreated due to a model change.

Once you change properties on the view level you should not go to the
drawing level properties and modify drawing properties there. This is because
once you have changed a setting at one level, changing the same setting on
the level above may for some settings negate the changes you have just made.

Example workflow in a general arrangement drawing

The following image illustrates the idea of the three property levels in a GA
drawing. The frame color and the shape of the mark are used as an example.
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1. You change the mark frame color and shape for the whole drawing on the
drawing level. The changes propagate to the view level and to the object
level.

2. You change the mark frame color and shape in the selected views. The
changes take place in the selected views only. The properties do not
change in the whole drawing.

Note that if you change the frame color and shape on the drawing level
after changing them on the view level for some of the views, the drawing
level changes override the view level changes in all views. View settings
behave differently: they are not overridden, for example, the view scale
stays as you have set it for individual views.

3. You change the mark frame color and shape in the selected marks. The
properties do not change anywhere else. If you try to change the mark
frame color and shape on the view or drawing level, the properties do not
change in the marks that you changed separately.

Click the following links to find out more:

Set automatic drawing properties before creating drawings (page 65)

Modify drawing properties of an existing drawing (page 67)

Modify view-level drawing properties (page 67)

Modify drawing object properties (page 69)

Detailed object level settings (page 70)

How Tekla Structures applies drawing properties in drawing creation
(page 78)

Recreation of drawings (page 78)

Set automatic drawing properties before creating drawings
Tekla Structures creates drawings using the automatic drawing properties
defined separately for each type of drawing.
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1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. If possible, load drawing properties closest to the ones you need by
selecting a properties file from the list at the top. 

In general arrangement drawing properties, you need to click Load.

3. Do one the following, depending on the type of the drawing: 

Single-part, assembly and cast unit drawings:

a. Go through the various properties in the drawing properties options
tree and adjust the values as requires.

The check boxes next to the options are automatically selected when
you change something for that particular option.

b. To save properties for future use, give a unique name for the
properties in the Save box and click Save. Note that you should not
include spaces or special characters in the name.

c. To adjust view-level settings (views, dimensions, filters, protected
areas, marks and objects), click View creation, select the desired
view and view properties file, and then click View properties.

d. Adjust the properties for the selected view as required.

e. To save properties, for example, part properties for future use, give a
unique name for the properties in the Save box and click Save. Note
that you should not include spaces or special characters in the name.

f. Click Save in View Properties to save the properties in the view
properties file, when you are done.

g. Click OK in View Properties to return to the drawing properties.

General arrangement drawings:

a. Switch off the all the check boxes by clicking the on/off switch at the

bottom  and only select the check boxes for the options that
you wish to change.

b. Go through the various properties in the drawing properties dialog
box, and make the necessary changes.

c. Click OK in each subdialog box where you changed the properties to
save the changes and to return to drawing properties.

d. To save properties, for example, part properties, for future use, give a
unique name for the properties in the Save as box and click Save as.
Note that you should not include spaces or special characters in the
name.

4. Click OK to save the properties. 
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If you want to save the changes in another drawing properties file, enter
the new name.

Note that you should not use spaces in the properties file name, this may
cause problems. For example, when you use the drawing properties file in
a rule set in the Master Drawing Catalog, the drawings are not created if
the properties file name contains spaces.

In general arrangement drawing properties, click Save as.

Now you can create a drawing using the drawing properties file that you just
set up.

Modify view-level drawing properties
You can modify the view-level drawing properties after you have created the
drawing. Most of the properties that a single-part, assembly and cast unit
drawing have are specified for each of the drawing views separately already
before creating a drawing in the automatic drawing properties. General
arrangement drawings do not have automatic view properties, and the view
properties can only be modified in an open drawing.

The changes you make in view properties apply only to the view that you have
selected to modify.

For a list of view properties and their values, see View properties in drawings
(page 920).

1. Open the drawing.

2. Double-click a drawing view frame to open the drawing view properties
dialog box.

3. The check boxes in the options tree are off by default. When you touch a
property, for example, select an option in the panel, Tekla Structures adds
a check mark to the check box next to the option in the option tree.

4. Make the necessary changes.

5. Click Modify when you are ready with the changes.

The view changes according to the changes that you made in the drawing view
properties.

NOTE Some of the changes in you make require a drawing recreation. For more
information, see Recreation of drawings (page 78).

See also

Modify drawing properties of an existing drawing (page 67)
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Modify drawing properties of an existing drawing
If you are not satisfied with the drawing properties after creating the drawing
and checking it, you can modify the automatic drawing properties in the
created drawing.

1. Open the drawing.

2. Double-click the drawing background.

3. Do one the following, depending on the type of the drawing: 

Single-part, assembly and cast unit drawings:

a. Go through the various options in the drawing property options tree
and adjust the values as required.

The check boxes next to the options are automatically selected when
you change something for that particular option.

b. To adjust view-level settings (views, dimensions, filters, protected
areas, marks and objects), click View creation, select the desired
view and view properties file and click View properties.

c. Adjust the view properties as required.

d. Click Save in View Properties to save the properties in the view
properties file, when you are done.

e. Click OK in View Properties to return to the drawing properties.

General arrangement drawings:

a. Switch all the check boxes off by clicking the on/off switch 
at the bottom of the dialog box and only select the check boxes for
the options that you wish to change.

b. Go through the various options in the drawing properties dialog box,
and make the necessary changes.

c. Click OK in each subdialog box where you changed the properties to
save the changes and to return to drawing properties.

4. Click Modify. 

The drawing is changed according to the changes that you made in the
drawing properties.

NOTE Some of the changes in you make require a drawing recreation. For more
information, see Recreation of drawings (page 78).

TIP You can also modify the properties of several drawings by selecting them from
Document manager, right-clicking and selecting Properties

See also

Modify view-level drawing properties (page 67)
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Set automatic drawing properties before creating drawings (page 65)

Modify drawing object properties
You can change the properties of the objects in the drawings such as parts,
marks, bolts, and welds, and save the object properties files for later use.

1. Open a drawing.

2. Double-click the object that you want to modify. 

For example, double-click a part or a bolt, or a reinforcing bar.

3. Change the desired properties.

4. Give a new name for the properties file and save the file. 

Note that you should not use spaces or special characters in the
properties file names.

5. If you want to apply the change in the object, click Modify.

Now you have a new object properties file. You can load the properties in this
file in other drawing objects, in this case, parts. You can also use the object
properties files with filters to apply detailed object level settings.

See also

Load saved drawing object properties (page 69)

Load saved drawing object properties
You can change the object properties in an existing drawing, for example the
part color, by loading saved object properties.

1. Open a drawing.

2. Double-click the drawing object you want to change. For example, double-
click a part.

3. Select the desired object properties file from the list next to the Load
button and click Load. 

4. Click Modify.

Tekla Structures changes the drawing object according to the settings in the
loaded object properties file.
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See also

Modify drawing object properties (page 69)

Detailed object level settings
In addition to defining automatic drawing mark and object properties, you can
also set up a special representation for marks and building objects in drawings
and use these detailed object level settings for specific purposes. For example,
you may want to define that all columns in a specific general arrangement
drawing are shown in a specific color, and in all other general arrangement
drawings in the default part color.

To create the detailed object level settings, you first need to define the part
properties and filters. For example, in part properties, set the part color to
blue and save the properties.

To create detailed objects settings, you need to have:

• A filter that selects the objects that you want to be affected

• Object properties that you want to apply on the objects

Create detailed object level settings in a general arrangement drawing
To create detailed object level settings on drawing level in general
arrangement drawings:

1. On the Drawings & reports tab, click Drawing properties --> GA
drawing .

2. Click Part and create part properties that define the object appearance
that you want.

3. Save the part properties by entering a unique name in the box next to the
Save as button and click the button.

4. Click Cancel to close the dialog box.

5. In the drawing properties dialog box, click Filter and create a drawing
filter that selects the objects that you want to have special representation.

For example, create a filter that selects columns.
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6. Save the filter by entering a name for it and click Save as.

7. Click Cancel to close the dialog box.

8. In the drawing properties dialog box, click Edit settings....

9. In the Object level settings for general arrangement drawing dialog
box, click Add row and select the filters to be used, the drawing object
types and the drawing object properties to be used. 

By doing this, you are combining the filter, object type, and object
property settings into detailed object level settings.

You can add several rows in detailed object level settings.

10. Give the object level settings a name and save using Save as. 

Note that you should not include spaces or special characters in the
name.

11. Click Cancel to close the dialog box.

Now you have new detailed object level settings to be applied on a drawing.

Example: Apply detailed object level settings on drawing level in a GA
drawing
Before doing this, drawing object properties for beams, columns and braces
have been created and saved with aunique names in the part properties
dialog box so that these parts have different colors. For details about creating
drawing object properties, see the instructions above.

First you will make a general arrangement drawing filter, then save detailed
object level settings in a settings file and finally, apply the new detailed object
level settings on drawing level.

In this example, the filter uses part names defined in the model, similarly as in
modeling filters.

1. On the Drawings & reports tab, click Drawing properties --> GA
drawing

2. Click Filter in the drawing properties dialog box.

3. Create filters by Part - Name for column, beam, and brace and save the
settings using Save as with different names, such as ts_column,
ts_beam and ts_brace. 
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4. Click Cancel to close the dialog box. 

Now you have created the required filters needed for selecting the
desired parts.

5. In the General arrangement drawing properties dialog box, click Edit
settings.... 

6. In the Object level settings for drawing dialog box, select the filters to
be used, the drawing object types and the drawing object properties to be
used:

a. Click Add row and select ts_column as Model object (Drawing
view filter), Part as Drawing object type, and column as Settings
used.

b. Click Add row and select ts_beam as Model object (Drawing view
filter), Part as Drawing object type, and beam as Settings used.

c. Click Add row and select ts_brace as Model object (Drawing view
filter), Part as Drawing object type, and brace as Settings used.

7. Save the detailed object level settings as gatype1 using Save as. 
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The same detailed object level settings can be used in other general
arrangement properties, you do not need to create new ones.

8. Click Cancel to exit the dialog box.

9. Open a created general arrangement drawing and double-click the
drawing background to open the drawing properties.

10. Click Edit settings....

11. Load object level settings you created, in this example gatype1, and click
Load.

12. Click OK.

13. Click OK.

14. Ensure that Use detailed object level settings is set to Yes.

15. Click Modify to apply the changes in the drawing.

16. Confirm the detailed object level changes by clicking Yes in the on Object
level settings changed. message box.
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NOTE If a row in the Object level settings for view dialog box is shown in red,
either the object properties file defined for Settings used, or the filter file
defined for Model object (Drawing view filter) is missing from the
\attributes folder in the current model folder. See an example below:

Create detailed object level settings in cast unit drawings
Before creating the detailed object level settings, create the part properties
and needed filters. For example, in reinforcement properties, set color to red
and save the properties. You create detailed object level settings in the same
way in single-part drawings and assembly drawings.

To create detailed object level settings on view level:

1. On the Drawings & reports tab, click Drawing properties --> Cast unit
drawing .

2. Click View creation, and click theView properties button.

3. Click Part in the options tree and create part properties that define the
object appearance that you want.

4. Save the part properties by entering a unique name in the box next to the
Save button and click the button.

5. Click Filter in the options tree and create a view filter that selects the
objects that you want to have special representation. 
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For example, create a filter that selects reinforcing bars in class 100 and
101.

6. Save the filter by entering a name in the box at the top and clicking Save.

7. Click View properties in the options tree and click Edit settings....

8. In the Object level settings for view dialog box, click Add row and select
the filters to be used, the drawing object types and the drawing object
properties to be used. 

By doing this, you are combining the filter, object type, and object
property settings into detailed object level settings.

You can add several rows.

9. Give the detailed object level settings a name (here class_100) and save
using Save as. 

Note that you should not include spaces or special characters in the
name.
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10. Click Cancel to close the dialog box.

Now you have new detailed object level settings to be applied on a drawing.

Example: Apply detailed object level settings on view level in a cast
unit drawing
In this example, detailed object level settings will be set up for lifting anchors
in a cast unit drawing.

Before doing this, drawing object properties for lifting anchors have been
created so that they use different color. For details about creating drawing
object properties, see the instructions above.

First you will make a cast unit drawing view filter, then save detailed object
level settings in a settings file and finally, apply the new detailed object level
settings in a view.

1. On the Drawings & reports tab, click Drawing properties --> Cast unit
drawing .

2. Click View creation, and click theView properties button.

3. Click Filter in the options tree. 

4. Create a filter by Reinforcing bar - Class and enter value 100 101. 

5. Save the filter as class100filter and click Save. 

Now you have the filter needed for selecting the reinforcing bar.

6. Click View properties in the options tree and click Edit settings.... 

7. In the Object level settings for view dialog box, select the filter to be
used, the drawing object type and the drawing object properties to be
used:

a. Click Add row and define the following values: 
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Model object (Drawing view filter): class100filter
Drawing object type: Reinforcing bar

Settings used: class100
8. Save the detailed object level settings as class_100 using Save as. 

The same detailed object level settings can be used in other cast unit
drawing properties, you do not need to create new ones.

9. Click Cancel to close the dialog box.

10. Create a cast unit drawing containing lifting anchors and open the
drawing.

11. Double-click the view frame to open the View properties dialog box.

12. Click Edit settings....

13. Load object level settings you created, in this example class_100, and
click Load.

14. Click OK.

15. Ensure that Use detailed object level settings is set to Yes.

16. Click Modify to apply the changes in the view.

17. Confirm the detailed object level changes by clicking Yes in the on Object
level settings changed. message box. 

The lifting anchors now have a different color, they are red.
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NOTE If a row in the Object level settings dialog box is shown in red, either the
object properties file defined in the Settings used box, or the filter file
defined in the Model object (Drawing filter) box is missing from the
\attributes folder in the current model folder. See an example below:

How Tekla Structures applies drawing properties in
drawing creation
Tekla Structures generates drawings according to the properties defined for
each drawing type. You define the desired properties before you create the
drawings. The way Tekla Structures connects the properties to the drawing
you create depends on the method you select for creating the drawing.

• If you create the drawings in the Master Drawing Catalog using saved
settings, Tekla Structures uses the properties defined in the saved settings
file you select. Saved settings file in the Master Drawing Catalog is the
same thing as the drawing properties file you save in various drawing
properties dialog boxes.

• If you create the drawings in the Master Drawing Catalog using a rule set,
Tekla Structures creates the drawing according to the properties defined in
the saved settings file or cloning template file used in the rule set.

• If you create the drawings in the Master Drawing Catalog using cloning
templates, Tekla Structures creates the drawing using the properties that
you have defined for the drawing used as a cloning template together with
the manual modifications that you have made in the drawing.

• If you create drawings through Drawings & reports tab using the Create
drawings menu button commands,Tekla Structures uses the current
drawing properties to create the drawings.

See also

Define automatic drawing settings (page 650)

Create drawings in Master Drawing Catalog (page 106)

Create drawings in Tekla Structures (page 95)

Create general arrangement drawings (page 97)

Create single-part, assembly, or cast unit drawings (page 99)
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Recreation of drawings
Changing some of the drawing settings requires the drawing to be recreated.
The changes will be applied, and the drawing will be recreated only if and
when you click Modify.

Settings affecting the recreation of drawings

In the View creation panel:

• Coordinate System

• Around X

• Around Y

• Around Z

• Undeformed

• Unfolded

• New views added into the Views list.

If at least one of the above mentioned settings is changed, the Recreate the
drawing option is automatically set to Yes and the drawing will be recreated
when you click Modify. If you manually set Recreate the drawing to Yes, the
drawing will also be recreated. When View creation settings have changed
and drawings will be recreated, you will get a warning message.

In the Section view panel:

• Section depth

• Distance for combining cuts

• Left section

• Middle section

• Right section

If at least one of the above mentioned settings is changed, Tekla Structures
automatically recreates the drawing without giving a warning message when
you click Modify.

If you only want to modify the view properties for one of the created views:

• If the changed properties are saved in the same file for all created views,
the only way to modify the properties for one view is to set Recreate the
drawing to Yes.

• If the changed properties are saved in a separate file not used for other
created views, and that file is selected for the changed view in the Views
list, then drawing will only be updated on Modify, not recreated.
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Prevent automatic drawing updates and recreation
There are some ways you can prevent drawings from being updated and/or
recreated.

• Freeze the drawings where you do not want to update all associative
objects on top of the drawing views. The building objects (parts, bolts,
welds, etc) are always updated in frozen drawings. For more information
about freezing, see Freeze drawings (page 583)

• Lock the drawings that you do not want to update. For details about
locking, see Lock drawings (page 582)

• If you update a drawing that has not been modified, the drawing is
recreated. Drawings are automatically recreated unless the drawing has
been edited and then saved, or the drawing has been issued using the
Issue functionality in Document manager. Use the advanced to control
the recreation of unmodified drawings.

• To prevent Tekla Structures from automatically updating drawings if the
model changes, set the advanced option to FALSE.

2.5 Drawing types
You can create many types of drawings in Tekla Structures according to your
needs.

Click the links below to find out more:

• General arrangement drawings (page 80)

• Single-part drawings (page 85)

• Assembly drawings (page 88)

• Cast unit drawings (page 90)

• Multidrawings (page 93)

General arrangement drawings
A general arrangement drawing (GA drawing) is a contract document, which
records information needed to understand the general arrangement
structural elements on a project. A GA drawing is created in BIM workflows
from one or more model views, with associated schedules and on a project
title sheet. This is the most common form of drawing used by consulting
structural engineers to communicate a structure sufficiently to other legal
teams, public authorities, along with the design, costing and construction
teams.
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General arrangement drawings show the model from the most suitable
direction. For example, in plan drawings, you are looking from the top of a
building or floor down towards the ground. In elevation drawings you are
looking from one of the sides of the building, like along a grid line. General
arrangement drawings often contain enlarged views of complex areas or
details, and other additional information that helps in the approval process
and during the installation phase.

Create general arrangement drawings when you need

• Several views in one drawing, including the entire model or a part of it

• Plan drawings (foundation, floor, deck layout, and anchor bolt plans)

• Erection elevation drawings

• Information from model views, including 3D views

You can create general arrangement drawings using ribbon or context menu
commands in the following ways:

Create general arrangement drawings (page 97)

Create general arrangement drawings using saved settings in Master Drawing
Catalog (page 112)

Create anchor bolt plans using saved settings (page 113)

For details on about GA drawing properties, see General arrangement drawing
properties (page 912).

Examples of GA drawings

Foundation plan:
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Slab plan:

Framing plan:
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Deck plan:

Erection elevation drawing:

Drawings in Tekla Structures 83 Drawing types



Isometric drawing:

Anchor bolt plan:
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Single-part drawings
Single-part drawings are workshop drawings showing fabrication information
for one part (usually without welds). Single-part drawings usually use small
sheet sizes, for example, A4 or imperial standard size 8.5" x 11.5".

You can create single-part drawings using ribbon or context menu commands.
Click the links below to find out more:

Create single-part, assembly, or cast unit drawings (page 99)

Create single-part, assembly and cast unit drawings using saved settings in
Master Drawing Catalog (page 116)

Create drawings using rule sets or wizards in Master Drawing Catalog
(page 122)

Create AutoDrawings (page 101)

For details about single-part drawing properties, see Single-part drawing
properties (page 915).

Examples of single-part drawings

Single-part drawing presenting an anchor bolt:
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Single-part drawing presenting an embed:

Single-part drawings presenting plates (three examples):
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Assembly drawings
Assembly drawings are typically workshop drawings showing fabrication
information for one assembly. In most cases, an assembly consists of a main
part and secondary parts. The secondary parts are either welded or bolted to
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a main part. Assembly drawings usually use larger sheet sizes than single-part
drawings, for example, A3 or imperial standard size 11" x 17".

You can create assembly drawings using ribbon or context menu commands.
Click the links below to find out more:

Create single-part, assembly, or cast unit drawings (page 99)

Create single-part, assembly and cast unit drawings using saved settings in
Master Drawing Catalog (page 116)

Create drawings using rule sets or wizards in Master Drawing Catalog
(page 122)

Create AutoDrawings (page 101)

For details about assembly drawing properties, see Assembly drawing
properties (page 915)

Examples of assembly drawings

Beam assembly drawing:

Stairs assembly drawing:
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Rail assembly drawing:
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Cast unit drawings
Cast unit drawings are dimensional, form work, or reinforcement drawings
used in concrete design and construction. They show cast-in embeds, edge
chamfers, and hard and soft insulation. Cast unit drawings that show cast-in-
place concrete structures usually use large sheet sizes, for example, A1 or
imperial standard size 24" x 36". Drawings that show precast structures
usually use smaller sheet sizes, for example, A3 or imperial standard size 11" x
17".

You can only create cast unit drawings of concrete parts and cast-in embeds
(steel parts or assemblies added to a cast unit). Cast unit drawings also show
bolts and welds in steel parts. The volume and weight information of the cast
unit remains accurate even if there are cuts inside the cast unit.

Note that it is very important to set the correct cast unit type in part properties
in the model (Cast in place or Precast), because some features, for example,
numbering and continuous concrete are based partly on the cast unit type. In
the Rebar Detailing configuration, you can create cast unit drawings of cast-
in-place cast units only.

You can create cast unit drawings using ribbon or pop-up menu commands.
Click the links to find out more:

Create single-part, assembly, or cast unit drawings (page 99)

Create single-part, assembly and cast unit drawings using saved settings in
Master Drawing Catalog (page 116)

Create drawings using rule sets or wizards in Master Drawing Catalog
(page 122)

For details about cast unit drawing properties, see Cast unit drawing
properties (page 915)

Create AutoDrawings (page 101)

Examples of cast unit drawings

A combined form and reinforcing bar drawing of an inverted tee beam:
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A combined form and reinforcing bar drawing of an exterior column with no
corbels or plats for beams:

A combined form and reinforcing bar drawing of stairs with landings:
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Multidrawings
Multidrawings are workshop drawings that gather several single-part or
assembly drawings on one sheet. Multidrawings usually demand large sheet
sizes such as A1 or imperial standard size 24" x 36".

Create multidrawings when you want to:

• Have more than one assembly on a sheet

• Collect multiple single-part drawings on a large sheet

Below is an example of a multidrawing with several assemblies included.
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See also

Create multidrawings (page 104)
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3 Create drawings in Tekla
Structures

Drawing creation is always based on drawing properties, no matter which way
you use to create them. Planning and implementing the most suitable drawing
settings carefully is very important. You can create drawings one by one, in
groups, or you can create all drawings automatically.

Choose the way that meets your needs the best:

• Create drawings using ribbon and pop-up menu commands.
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• Create drawings using the various master drawing types in the Master
Drawing Catalog. Using rule sets is a highly automated process of creating
several drawings of different type in one go.

• Clone drawings on the basis of cloning templates in the current model or in
the cloning template models. You can clone drawings in the Master
drawing catalog and in Document manager.

• You can increase the level of automation even more by applying detailed
object level settings to all of the above mentioned methods. When the level
of automation increases, the need for manual modifications decreases. We
recommend that you put extra effort in making the automated settings as
effective as possible.

Click the links below to find out more:

• Drawing types (page 80)

• What to do before creating drawings (page 97)

• Create general arrangement drawings (page 97)

• Create single-part, assembly, or cast unit drawings (page 99)

• Create multidrawings (page 104)

• Create drawings in Master Drawing Catalog (page 106)

Create drawings in Tekla Structures 96



• Clone drawings (page 141)

• Detailed object level settings (page 70)

3.1 What to do before creating drawings
The list below contains some things that you may need to do before you
create or clone drawings in Tekla Structures:

• For assembly, single-part, cast unit and multidrawings, the model needs to
be numbered. If the model changes, the numbering needs to be updated.
Numbering ensures that Tekla Structures connects the right objects to the
right drawings. If you try to create drawings without numbering the model,
Tekla Structures prompts you to do so. Once the model is numbered, part
positions can also be shown in general arrangement drawings. Prior to
numbering, if the part position is included in a mark on a general
arrangment drawing, it will be shown as a question mark (?).

• Check that the detailing is correct.

• You may want to create test drawings of different types of parts to see how
well the predefined drawing and view properties, layouts, rule sets or
cloning templates suit your needs.

• You may want to modify drawing and view properties, layouts, or rule sets
and save the modified settings for future usage.

• If you are going to use a drawing as a cloning template, check that it
contains all the necessary elements for this purpose.

See also

Create drawings in Master Drawing Catalog (page 106)

Create general arrangement drawings (page 97)

Create single-part, assembly and cast unit drawings using saved settings in
Master Drawing Catalog (page 116)

Define automatic drawing settings (page 650)

Create multidrawings (page 104)
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3.2 Create general arrangement drawings
When you create general arrangement drawings, remember to load the
closest possible predefined properties in the drawing properties first, then
modify the properties if needed, and then create the drawing.

Before you create general arrangement drawings, create the model views that
you need and ensure that the views are as you want them to be in drawings.
The drawing views will have the same orientation and content as the model
view you select. A good idea is to fit the work area in the model view using two
points to select the area that you want to show in the general arrangement
drawing.

1. Create the model views you need. 

If you want to switch between 3D view and plane view in the created view,
press Ctrl+P.

2. On the Drawings & reports tab, click Drawing properties --> GA
drawing .

3. Select the appropriate predefined drawing properties (saved settings)
from the list at the top and click Load. 

Always load predefined properties when you are creating a drawing.
When you need to modify drawing properties, save the new changes to
the properties file when necessary.

4. If needed, modify drawing properties and, if necessary, apply object-level
settings.

5. Click Apply or OK.

6. On the Drawings & reports tab, click Create drawings --> GA drawing . 

Alternatively, you can select the model views from the model (selected
views get a yellow frame), right-click and click Create General
Arrangement Drawing...

7. If you have not selected the views yet, select them from the displayed list. 

You can use the Shift and Ctrl buttons for selecting several views.

8. In the Options list, select if you want to create one drawing for each
selected view or add all selected views in one drawing. 

By selecting Empty drawing, you can create an empty drawing and add
drawing views in it afterwards. For more information about copying,
moving or linking drawing views to another drawing, see Copy, move and
link drawing views (page 178).

9. If you want to open the created drawings, select Open drawing.

10. Click Create.

Tekla Structures creates the drawings and adds them in Document manager.
You can now open the drawings and also change the drawing properties.
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See also

Define automatic drawing settings (page 650)

General arrangement drawings (page 80)

Create general arrangement drawings using saved settings in Master Drawing
Catalog (page 112)

General arrangement drawing properties (page 912)

Pours in drawings (page 488)

3.3 Create single-part, assembly, or cast unit drawings
When you create single-part, assembly or cast-unit drawings, remember to
load the closest possible predefined properties in the drawing properties first,
then modify the properties if needed, and then create the drawing. Your
environment contains some predefined properties and there are also some in
the default environment.

For cast unit drawings, ensure that you are using the correct cast unit type,
because some functionalities, for example numbering, are based on the cast
unit type. Cast units have the cast unit type part property setting in the model
- they are set either Cast in place or Precast. In the Cast in Place
configuration, you can create cast unit drawings of cast-in-place cast units
only.

To create drawings:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. In the drawing properties dialog box, load the appropriate predefined
drawing properties (saved settings). 

Always load predefined properties when you are creating a drawing.
When you need to modify drawing properties, save the changes to a new
properties file for future use.

Ensure that for cast unit drawings, you use a property file that contains
the desired Cast unit definition method:

• By cast unit position: A drawing will be created from each cast unit. If
there are identical cast units, one of them will serve as the base cast
unit for the drawing. This is the most common method for creating
cast unit drawings.

• By cast unit ID: Each part in the model includes a unique GUID. You
can create drawings by using cast unit GUIDs. The GUID determines
the marking of the drawing. You can create several drawings from
identical cast units.

3. Click View creation in the options tree on the left and do the following: 
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• In Common settings for all views, define the Ignore bolt size, Weld
size limit and Weld marks visible (page 915) settings, if necessary.

• Add the necessary drawing views (page 689) and then select the view
properties for the views in the View properties list.

4. Select the view and the properties that you want to change, click View
properties, and modify the view properties including view, building
object, dimensioning and mark settings and apply detailed object-level
settings.

5. Click Save to save the view properties.

6. Click Close to return to drawing properties.

7. Save the drawing properties you loaded earlier.

8. Click Apply or OK.

9. Select the objects, or use an appropriate selection filter to select the
objects you want to create drawings from and select the entire model. 

Activate only the Select parts switch  on the Selecting toolbar when
selecting parts. Otherwise selection could take a long time in large
models.

10. Do one of the following: 

• On the Drawings & reports tab, click Create drawings and select the
drawing type.

• If you selected individual objects, you can right-click and select the
appropriate drawing creation command. The available commands
depend on the type of objects you have selected in the model.

• If you selected individual objects, you can also create drawings by
clicking the Open or create drawings button in the contextual
toolbar, and selecting Create single-part drawing, Create assembly
drawing, or Create cast unit drawing. The available commands
depend on the type of objects you have selected in the model. Note
that you cannot create GA drawings from the contextual toolbar.

11. Number the model if you are prompted to do so.

Tekla Structures creates the drawings. The created drawings are listed in the
Document manager. If you already have a drawing with the same type and
mark, Tekla Structures will not create a new one.

TIP To automatically open any drawing after the drawing has been created, hold
down Ctrl+Shift while you create the drawing.

See also

Define automatic drawing settings (page 650)
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Single-part, assembly and cast unit drawing properties (page 915)

View properties in drawings (page 920)

3.4 Create AutoDrawings
The AutoDrawings wizard combines a series of actions so that you can create
drawings using a single command. You can use AutoDrawings to create single-
part drawings, assembly drawings, cast-unit drawings and multi-drawings.

AutoDrawings wizards contain instructions telling Tekla Structures which
drawing type, selection filter, and drawing properties to use. You can edit
AutoDrawings wizard files or create your own ones. The AutoDrawings dialog
box lists the available wizard files.

Create AutoDrawings
Before you can create AutoDrawings, the appropriate wizard files must exist
and numbering must be up to date.

1. In the model, select the parts from which to create drawings. You can also
select the entire model and use filters to fine-tune your selection. You can
also use selection filters in the wizard file. If you do, your selection can
include parts that will not be included in the drawings.

2. Type AutoDrawing in the Quick Launch box.

3. In the AutoDrawings dialog box, select a wizard file. 

• To view the file, click Show.

• To edit the file, click Edit.
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4. On the Advanced tab, select whether to create a log file, what information
it should include and name the log file.

5. Click Create from selected.

AutoDrawings wizard files

You can create your own AutoDrawings wizard files using any standard text
editor. Use the existing wizard files as examples to construct your own.

A typical AutoDrawings wizard file contains several sets of drawing requests
containing drawing, attribute and part settings to apply to selected objects, as
well as a selection filter. The order of sets is important, as Tekla Structures
only creates one drawing for each object.

Place the newly created drawing wizard files in the attributes sub-folder in the
model folder.

Example

The AutoDrawings wizard file set in this example creates an assembly drawing
for an object that fulfills the selection filter criteria in the set. Tekla Structures
will not create another assembly drawing for that object, even if it matches the
criteria of the selection filter in later sets in the same wizard file.

The wizard file consist of the lines below. Note the use of parentheses.

set_drawing_type(assembly)
set_drawing_attributes(column)
set_filter(column_filter)
create_drawings()

Line Description
set_drawing_type(assembly) This line defines the type of drawing

the wizard creates. The drawing type
appears in parentheses. The options
are:

single: workshop drawings

assembly: assembly drawings

multi_single: workshop multi-
drawings

multi_single_with_layout:
workshop multi-drawings with layout

multi_assembly: assembly multi-
drawings
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Line Description
multi_assembly_with_layout:
assembly multi-drawings with layout

cast_unit: cast-unit drawings
set_drawing_attributes(column
)

This line tells Tekla Structures which
drawing properties to use when
creating the drawings. The name of
the saved drawing properties file
appears in parentheses.

set_filter(column_filter) This line tells Tekla Structures which
selection filter to use to select the
parts from which to create drawings.
The filter name appears in
parentheses.

create_drawings() This line starts the drawing creation.
This line should always appear
immediately after the lines 
set_drawing_type,
set_drawing_attributes and 
set_filter.

Wizard log

Tekla Structures writes a log file when you run an AutoDrawings wizard. The
log file contains information about errors, number of drawings created,
commands used etc.

You can configure whether or not Tekla Structures creates a log file and how it
is displayed using the Advanced tab in the AutoDrawings dialog box.

Create log options:

• No: Tekla Structures does not create a log file.

• Create: Tekla Structures creates a new log file and deletes the old one.

• Append: Tekla Structures adds a new entry to the existing log file.

Display log options:

• No: Tekla Structures does not display the log,

• With associated viewer: Tekla Structures displays the log file in an
associated viewer (e.g. Notepad) when you run the wizard. You can edit the
log file.

• On dialog: Tekla Structures displays the log file in a dialog box when you
run the wizard. You can not edit the log file.
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3.5 Create multidrawings
You can create multidrawings of selected parts and of selected drawings. You
can also create empty multidrawings and copy or link views in them from
other drawings.

If you create multidrawings from existing drawings, you can choose to include
their individual drawing layouts. If you want to have separate lists, tables, and
call-offs for each part or assembly, you should include the individual drawing
layouts. You can also include lists and tables for all parts or assemblies in the
multidrawing.

Before creating a multidrawing, check the original assembly or single-part
drawing, and clean it up, if necessary. Do not modify the multidrawing object
that links to the original drawing.

Before you start, you can set to TRUE in the Drawing Properties category of
the Advanced Options dialog box to remove extra space between drawing
view labels and drawing views.

Link or copy drawing views to empty multidrawings
You can create empty multidrawings in which you can link or copy views from
other drawings as such or with the original drawing layout.

1. On the Drawings & reports tab, click Multidrawing --> Empty drawing .

2. On the Drawings & reports tab, clickDocument manager .

3. Open the empty multidrawing from Document manager.

4. Still on the Document manager, select the drawings that you want to
copy or link to the multidrawing.

5. On the Views tab, click From other drawing and select one of the
copying or linking commands: 

• Copy

• Copy with layout

• Link

• Link with layout

The drawing views are placed in the multidrawing from top to bottom
starting from the top-left corner. The views are placed in the same order
as they appear in Document manager. If you have sorted the list by the
name, the drawings are created in the same order.

6. Arrange the views if they are on top of each other.
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NOTE When you update multidrawings, the linked drawings are also updated.

Useful links

What does XS_CREATE_CONNECTION_WHEN_COPYING DRAWING_VIEWS do?

Create multidrawings of selected parts
Create single-part and assembly drawings of the parts that you select and
place the drawings in a multidrawing. You can also keep the layout of the
selected single-part or assembly drawings.

1. Select the parts from the model using appropriate selection switches or
filters.

2. On the Drawings & reports tab, click Multidrawing and select one of the
following commands depending on the desired result: 

• New single-part drawings of selected parts: Create single-part
drawings of the selected parts and place the drawings in a
multidrawing

• New single-part drawings of selected parts with layout: Create
single-part drawings of the selected part, keeping the layout of each
drawing, and place the drawings in a multidrawing.

• New assembly drawings of selected parts: Create assembly
drawings of the selected parts and place the drawings in a
multidrawing.

• New assembly drawings of selected parts with layout: Create
assembly drawings of the selected parts, keeping the layout of each
drawing, and place the drawings in a multidrawing.

Create multidrawings of selected drawings
You can create multidrawings of the drawings you select. You can also keep
the layout of the selected drawing in the new multidrawing.

1. On the Drawings & reports tab, click Document manager.

2. Select the drawings you want to add in the multidrawing from Document
manager.

3. On the Drawings & reports tab, click Multidrawing and select one of the
following commands: 

• Selected drawings: Create multidrawings of the selected drawings
without the drawing layout.
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• Selected drawings with layout: Create multidrawings of the selected
drawings, keeping the layout of each selected drawing.

The drawing views are placed in the multidrawing from top to bottom
starting from the top-left corner. The views are placed in the same order
as they appear in Document manager. If you have sorted the list by the
name, the drawings are created in the same order.

3.6 Create drawings in Master Drawing Catalog
The Master Drawing Catalog is a fast, efficient and controlled way of creating
drawings using master drawings. In the Master Drawing Catalog, all drawing
creation commands are available in one centralized location.

A master drawing is a Tekla Structures drawing or a set of drawing properties
that is used for creating new drawings that look the same as the master
drawing. There are several types of master drawings: cloning templates, saved
settings and rule sets. You can also use the existing AutoDrawings wizard files
as master drawings.

• To open the Master Drawing Catalog, on the Drawings & reports tab,
click Create drawings --> Master Drawing Catalog .

The image below shows the search view of the Master Drawing Catalog as a
thumbnail list.
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The Master Drawing Catalog has a toolbar containing commands for creating
drawings, selecting the view type and the master drawing list type, displaying
master drawing descriptions, selecting the models from which you want to use
cloning templates, creating rule sets, displaying Document manager, and for
keeping the Master Drawing Catalog window always on top.

Tekla Structures populates the catalog by looking for items in the Tekla
Structures default folder search order: first from the firm folder, then from the
project folder, and then from the system folder and so on. Cloning templates
in the folder defined for the advanced option XS_CLONING_TEMPLATE_
DIRECTORY are shown in the catalog. You can define several folders for this
advanced option.

See also

Create general arrangement drawings using saved settings in Master Drawing
Catalog (page 112)

Create anchor bolt plans using saved settings (page 113)

Create single-part, assembly and cast unit drawings using saved settings in
Master Drawing Catalog (page 116)

Master drawing types (page 108)
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Search for master drawings and save the results in Master Drawing Catalog
(page 128)

Customize Master Drawing Catalog (page 129)

Master drawing types

The master drawing type you should use depends on the type of the drawing
that you want to create:

• You can create single-part drawings, assembly drawings or cast unit
drawings using saved settings, rule sets, or cloning templates.

• You can create general arrangement drawings using saved settings.

• You can create multidrawings using wizards (old file-based rule sets)

• For more information about adding different master drawing templates to
Master drawing catalog, see Add master drawings in Master Drawing
Catalog (page 130).

Cloning templates

Cloning templates are Tekla Structures drawings that are used as templates for
creating new drawings. You can select a drawing from Document manager
and add it to the Master drawing catalog to be used as a template.
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You can also use cloning templates that are located in other models. When
you have similar parts in several projects, you can maintain a set of cloning
template models and then take the cloning templates in the cloning template
models in use when necessary.

For more information about cloning and creating drawings using cloning
templates, see the links below:

Clone drawings (page 141)

Create drawings using cloning templates in Master Drawing Catalog (page 142)

Clone by using cloning templates located in other models (page 143)

Saved settings

The saved settings in Master drawing catalog are drawing property files that
have been created and saved in the drawing properties dialog boxes for
different drawing types. There are also many predefined drawing property
files.

Each drawing type has its own properties file. Default saved settings are
located under the environment folder (..\Tekla Structures\<version>
\environments\). The exact file location may vary depending on your
environment. When you save your own settings, they are saved under the
current model directory.

Below are some examples how the saved settings are shown in the Master
drawing catalog dialog box.
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For more information about creating drawings using saved settings, see the
links below:

Create general arrangement drawings using saved settings in Master Drawing
Catalog (page 112)

Create single-part, assembly and cast unit drawings using saved settings in
Master Drawing Catalog (page 116)

Rule sets

Rule sets are sets of rules on how to create drawings for different object types.
A rule set is a combination of object groups (model selection filters) and
master drawing settings (cloning templates, saved settings) that define which
objects to include in the drawing, and which drawing settings to use. You can
use the existing AutoDrawings wizard files or create your own rule sets.

The order of sets is important, as Tekla Structures by default creates only one
drawing for each object. For example, a rule set creates an assembly drawing
for an object that fulfills the selection filter criteria in one set. Tekla Structures
will not create another assembly drawing for that object, even if it matches the
criteria of the selection filter in later sets in the same rule set file.
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For more information about creating drawings using rule sets, see Create
drawings using rule sets or wizards in Master Drawing Catalog (page 122).

Wizard files

A wizard file is a file-based wizard consisting of several sets of drawing
requests containing drawing, attribute and part settings to apply to selected
objects, as well as a selection filter. The order of sets is important, as Tekla
Structures by default creates only one drawing for each object. You can edit
the files in the Master drawing catalog. However, creating new wizard files is
not possible in the Master drawing catalog. Instead, you can create a rule
set, which is basically the same thing as a wizard: It applies drawing properties
to objects selected by filters, but in a dialog box, not in a text file like a wizard.

NOTE In the Master drawing catalog, the only way to create multidrawings
is to use the wizard files.

For more information about wizard files, see the following links:

Create drawings using rule sets or wizards in Master Drawing Catalog
(page 122)

Modify master drawing properties (page 133)
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Create general arrangement drawings using saved settings
in Master Drawing Catalog
You can create GA drawings in Master Drawing Catalog on the basis of saved
settings.

Before you create general arrangement drawings, create the model views that
you need and ensure that the views are as you want them to be. The drawing
views will have the same orientation and content as the model view you select.
Fit work area using two points to select the area that you want to show in the
general arrangement drawing.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog .

2. Select the set of saved settings from the list at the top.

3. If needed, modify the drawing properties by double-clicking the saved
setting and clicking Edit drawing properties.... 

Remember to save the changes in the properties file.

4. Click Create drawings (Alt+C).

5. In the Create General Arrangement Drawing dialog box, select the
views that you want to create and the desired option from the Options
list. 

If you select Empty drawing, you can create an empty drawing and add
drawing views in it afterwards.

6. Click Create to create the drawings.

Tekla Structures creates the drawings and adds them in Document manager.

Click  in the Master drawing catalog toolbar to open Document
manager.

For more information about creating cast in place general arrangement
drawings, see Pours in drawings (page 488).

See also

Master drawing types (page 108)

Create general arrangement drawings (page 97)

Create anchor bolt plans using saved settings
Anchor bolt plans are general arrangement drawings showing the anchor bolt
layout. You can create anchor bolt plans in Master Drawing Catalog or using
ribbon or pop-up menu commands.
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Tekla Structures selects the objects that are included in the anchor bolt plan
based on the following default rules:

• The part is a column or an almost vertical beam.

• The part is the main part of an assembly.

• A base plate is included in the assembly, and it is located lower than the
main part. If there is more than one part in the column assembly that
fulfills the rules, the lowest part of them is considered to be the base plate.

• Bolts are attached to the base plate.

• The assembly is cut by the view plane.

• The boundary box of the base plate in the xy-direction intersects the
boundary box of the column.

Create anchor bolt plan

Below you will create an anchor bolt plan using the Master Drawing Catalog.

Before creating the anchor bolt plan, create a model view that is in the XY-
plane.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

2. Double-click a saved settings master drawing that has been created for
anchor bolt plans, for example, anchor_bolt_plan.

3. Open the General Arrangement Drawing Properties dialog box by
clicking Edit drawing properties....

4. Click View

5. On the Anchor bolt plan tab, ensure that the option Show as anchor
bolt plan is set to Yes.

Define the drawing as an anchor bolt plan when you are creating the
drawing. You cannot convert a general arrangement drawing to an anchor
bolt plan afterwards.

6. Modify the enlarged part view scale, if necessary.

7. If needed, set the Create detail views option to Yes to create separate
detail views.

If you select No, Tekla Structures dimensions the anchor bolts in the
enlarged view. Tekla Structures groups similar detail views so that similar
details are drawn only once.

8. Set the Detail view scale.

9. Click Save to save the changes in the saved settings file.

10. Click OK to close the Master Drawing Properties dialog box.
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11. Click Create drawings.

12. Select one view in the xy-plane.

If you select some other type of view or several views, Tekla Structures
displays a warning message and the anchor bolt plan is not created.

13. Click Create.

Tekla Structures creates the anchor bolt plan.

Tekla Structures creates bolt dimensions in the anchor bolt plan in the
directions of the bolt group coordinate system. If the angle between the
bolt group and the view coordinate systems is not orthogonal, Tekla
Structures adds angle dimensions to the detail view. Use the advanced
option to create the dimensions in the x and y directions of the main view.

When details are compared, the following aspects are taken into account:

• bolt dimensions

• column profile

• column orientation (coordinate system)

• plate profile

TIP In the created drawing, go to the File menu, click Settings and check that
Ghost outline is selected and Drawing Color Mode is set to Color. In
color drawings with white background, hidden objects are shown as
ghost outlines, if this setting is selected. In gray scale and black and white
drawings, hidden objects are not shown even if Ghost outline is
selected.

Define anchor bolt plan parts using drawing filters

1. Create the necessary general arrangement drawing filters in the Filter
Properties subdialog box of the General Arrangement Drawing
Properties dialog box.

2. On the File menu, click Settings --> Advanced options and go to the
Drawing Properties category.

3. Enter the following values for the following advanced options:

• : <the name of the drawing filter for columns>
• : <the name of the drawing filter for bolts>
• : <the name of the drawing filter for base plates>
• : <the name of the drawing filter for additional parts>

If you do not use these advanced options, the default rules are used for
determining the columns, base plates, and anchor bolts to be included in the
anchor bolt plan.
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NOTE Using these advanced options only affects the creation of new anchor
bolt plan drawings, and has no affect on the existing anchor bolt plan
drawings.

Include assemblies in anchor bolt plans
If you have anchor bolts at varying elevations, you can create a general
arrangement drawing at the level of the top-most base plate/anchor bolt.

The anchor bolt plan view extrema looks downwards. If the lowest level
anchor bolt is not shown, adjust the advanced option 
XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE.

To specify the tolerance:

1. On the File menu, click Settings --> Advanced options --> Drawing
Properties .

2. Set a value for the advanced option . 

Define the distance in millimeters. The default value is 200 mm.

Create single-part, assembly and cast unit drawings using
saved settings in Master Drawing Catalog
You can create single-part, cast unit and assembly drawings in Master
Drawing Catalog using saved settings.

NOTE • Cast units have the cast unit type part property setting in the model - they
are set either Cast in place or Precast. It is important to use the correct
cast unit type, because some features, for example numbering, are based
on the cast unit type. In the Cast in Place configuration, you can create
cast unit drawings of cast-in-place cast units only.

Create single-part, assembly and cast unit drawings
1. On the Drawings & reports tab, click Create drawings --> Master

drawing catalog.

2. Select the desired set of saved settings (drawing properties file) from the
list. 

For cast unit drawings, select a file that contains the desired Cast unit
definition method:

• By cast unit position: A drawing will be created from each cast unit. If
there are identical cast units, one of them will serve as the base cast
unit for the drawing. This is the most common method for creating
cast unit drawings.
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• By cast unit ID: Each part in the model has a unique GUID. You can
create drawings by using cast unit GUIDs. The GUID determines the
marking of the drawing. You can create several drawings from
identical cast units.

3. If needed, modify the drawing properties and apply object-level settings.
To do this, double-click the saved setting and click Edit drawing
properties.... Remember to save your changes in the property file.

4. If you are creating a drawing only for selected objects, select the objects. 

You can also use an appropriate selection filter and select the whole
model. Activate only the Select parts selection switch when you select
objects, otherwise the selection may take a long time.

5. Click Create drawings (Alt+C) or Create drawings for all parts (Alt+A).

6. Number the model if you are asked to do so.

Tekla Structures creates the drawings and adds them in Document manager.

Click the Open drawing list button  on the Master Drawing Catalog
toolbar to open Document manager.

NOTE If you already have a drawing with the same type and mark, Tekla Structures
will not create a new one.

Example: Create cast unit drawings one by one
In this example, you will create a drawing of a cast unit using saved settings
called Column_with_BOM.

1. In the model, right-click the concrete column and select Cast Unit --> Set
Top in Form Face , and select the cast unit face that will face upwards in
the form. 
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When you right-click the column and select Cast Unit --> Show Top in
Form Face , the selected face is shown red, see the image below.

The top-in-form face will be displayed in the front view of a drawing.

2. Still in the model, double-click the column and select Precast as the Cast
unit type. 

It is important to use the correct cast unit type, because some features,
for example, numbering, are based on the cast unit type.

3. On the Drawings & reports tab, click Drawing properties --> Cast unit
drawing .

4. In the properties dialog box, load the appropriate predefined drawing
properties (saved settings). In this example, Column_with_BOM is loaded.

5. Ensure that the Column_with_BOM settings contain the desired Cast
unit definition method: 

• By cast unit position: A drawing will be created from each cast unit. If
there are identical cast units, one of them will serve as the base cast
unit for the drawing. This is the most common method for creating
cast unit drawings.

• By cast unit ID: Each part in the model has a unique GUID. You can
create drawings by using cast unit GUIDs. The GUID determines the
marking of the drawing. You can create several drawings from
identical cast units.
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6. If you made any changes in Column_with_BOM, save the changes and
close the dialog box.

7. Select the column in the model.

8. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

9. Set the type to Cast-unit drawings and select the saved settings
Column_with_BOM (C). 

10. Click Create drawings. 

Tekla Structures creates the drawing.

You can open the Document manager by clicking the Open drawing list

button  on the toolbar and then open the drawing to view it.
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Example: Create assembly drawings from groups of similar parts
Creating drawings one by one may take a lot of time. You can automate the
creation process a bit more by selecting groups of items and then create the
drawings. For example, you can define the needed properties for the beams
and then run all the beam drawings at once by using the Tekla Structures
model selection filters.

In this example, you are going to use saved settings named Beam_with_BOM
and create assembly drawings from all beams.

1. Define a selection filter that selects only one type of items, in this case
beams.

a. Click the selection filter button  on the Selecting toolbar or press
Ctrl+G to open the Object Group - Selection Filter dialog box.

b. Create a selection filter that selects all parts named BEAM and save it
using the name BEAM. 
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2. Activate the BEAM filter from the list of selection filters and use area
selection to select all beams in the model. 

3. Open the Master Drawing Catalog: On the Drawings & reports tab, click
Create drawings --> Master drawing catalog .

4. Under Assembly drawings, select the saved settings master drawing. In
this example, Beam_with_BOM (A) is selected.

5. Click Create drawings. 
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Tekla Structures creates the beam assembly drawings.

Create drawings using rule sets or wizards in Master
Drawing Catalog
In the Master Drawing Catalog, you can create single-part, assembly and cast
unit drawings using rule sets, and multidrawings using wizards. You can also
create your own rule sets.

Limitation: In the Master Drawing Catalog, you can create multidrawings
only by using file-based wizards and general arrangement drawings using
saved settings. You cannot create rule sets for multidrawings or general
arrangement drawings.

For more information about adding master drawings to Master Drawing
Catalog, see Add master drawings in Master Drawing Catalog (page 130).

Create drawings using a rule set or wizard
1. On the Drawings & reports tab, click Create drawings --> Master

drawing catalog .

2. Select a rule set or a wizard file from the list.

3. If needed, modify rule set properties or wizard file contents by double-
clicking the rule set or wizard.

4. If needed, edit the drawing properties of the master drawing connected to
the rule set. To do this, double-click the rule set, select the master drawing
from the list and click Properties... --> Edit drawing properties... .
Remember to save your changes.

5. Select the whole model or desired parts.
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6. Do one of the following: 

• If you selected parts, click Create drawings (Alt+C).

• If you selected the whole model, click Create drawings for all parts
(Alt+A).

7. Number the model if you are asked to do so.

Tekla Structures creates the drawings and adds them in the Document

manager. Click the Document manager button  on the Master Drawing
Catalog toolbar to open the Document manager.

NOTE If you already have a drawing with the same type and mark, Tekla Structures
will not create a new one.

Example - Create a new rule set and drawings for all parts

The following example will go through creating a basic rule set that will create
assembly and single part drawings based on the names of the parts in the
model.

The model used here is a very simple model consisting of two columns with a
beam in between, base plates and end plates. The parts are named BEAM,
COLUMN and PLATE.

Before setting up a rule set in the Master Drawing Catalog, you need to have
some saved settings (drawing properties) and some selection filters that link
the drawing properties to the parts in the model.

Create selection filters

You need to have filters that select the beams, columns and plates.

1. Click the selection filter button  on the Selecting toolbar or press Ctrl
+G to open the Object Group - Selection Filter dialog box.
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2. Click Add row and add a selection filter for the beams as shown below,
saving it as DRAWING_BEAM.

3. In the same way, create selection filters for columns and plates, saving
them as DRAWING_COLUMN and DRAWING_PLATE.

The new filters are displayed in the selection filter list.
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4. Close the Object Group - Selection Filter dialog box by clicking Cancel.

The new filters will be saved in the model folder. If necessary, copy them to
the necessary folders, for example, to the firm or project folders.

Create saved settings (drawing properties)

Next you need to modify the drawing properties and save them so that they
are displayed as saved settings in the Master Drawing Catalog. The saved
settings are created separately for single-part drawings and assembly
drawings.

1. On the Drawings & reports tab, click Drawing properties --> Assembly
drawing and create properties for a beam and a column drawing.

2. Give a descriptive name for the drawing in the Name box, for example,
BEAM for the beam properties and COLUMN for the column properties.

3. Save the properties as DRAWING_BEAM and DRAWING_COLUMN.
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4. On the Drawings & reports tab, click Drawing properties --> Single-part
drawing and create some single-part drawing settings for a beam shaft,
column shaft and plates.

5. Give a descriptive name for the drawing in the Name box, for example,
BEAM SHAFT for the beam shaft properties, COLUMN SHAFT for the
column shaft properties and PLATE for the plate properties.

6. Save the settings as DRAWING_BEAM_SHAFT, DRAWING_PLATES and
DRAWING_COLUMN_SHAFT.

Create a rule set

Now that you have created the necessary selection filters and saved settings,
you can create a rule set that automatically creates single-part and assembly
drawings for beams, columns and plates.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog .

2. Click the Define rule set button  on the toolbar.

3. In the Define Rules for Creating Drawings dialog box, select the drawing
types you want to create with the rule set and click Next.

In this example, select Single-part drawings and Assembly drawings.

4. In the Define Rules - Single-Part Drawings dialog box, click Add group
and select the filters and the corresponding single-part drawing saved
settings.

5. Under Object group select the three new filters, and under Master
drawing, select the three new saved settings.

The (S) after the master drawing name indicates that its type is saved
setting.
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6. Click Next.

7. In the Define Rules - Assembly Drawings dialog box, Add group and
select the filters and the corresponding assembly drawing saved settings.

8. Under Object group select the two new filters, and under Master
drawing, select the two new saved settings.

9. Click Next.

10. Give the rule set a name (Rule Set: Column+Beam+Plate), description
and keywords.

11. Use Browse next to Preview Image and add a sample image for the
master drawing.

12. Click Finish when you are done.
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Create all drawings using the rule set

Now you can create drawings using the new rule set.

1. In the Master Drawing Catalog Search view, enter your search criteria in
the box next to the Search button and click the button.

In this example, column beam plate is entered. Tekla Structures finds the
newly created rule set.

2. Right-click the rule set and select Create drawings for all parts.

Tekla Structures starts creating the drawings. When the drawings have
been created, a message is displayed indicating the number of created
drawings, in this case six drawings were created.

3. To check which drawings have been created, click the Open drawing list
toolbar icon to open the Document manager.
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Search for master drawings and save the results in Master
Drawing Catalog

In the Master Drawing Catalog search view, you can search for master
drawings on the basis of the text that has been entered in the name,
description and keyword boxes in the Master Drawing Properties dialog box
and save your search results. In the folder view, you can copy master drawings
from a search results folder to another folder to make it easier for you to
locate the master drawings you need.

TIP Make sure to always add all important information for each master
drawing in the Master Drawing Properties dialog box. This makes it a
lot easier to find the master drawings you are looking for.

To search for master drawings and save the search results:

1. Enter the search criteria in the box next to the Search button. 

Tekla Structures remembers search strings. When you start typing a
string, it suggests previous strings starting with the same characters.

2. Click Search. The results are listed.

3. To save the search results, click Store, type a name for the search, and
click OK. 

The search results are added in the category list in the search view.

The search results are also displayed as a folder in the folder view. There
you can rename the saved search results, and copy the found drawings to
the folders of your choice.

See also

Create drawings in Master Drawing Catalog (page 106)

Modify master drawing properties (page 133)

Customize Master Drawing Catalog
You can customize the Master Drawing Catalog according to your needs.
Keeping the Master Drawing Catalog up to date and well organized is
essential if you want to create drawings fast and efficiently. Having good
master drawings saves time and effort.
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Add only the necessary master drawings, remove obsolete ones, organize the
master drawings in folders, add proper preview images, and keep the
properties, descriptions and keywords up to date.

To Click the links below to find out
more

Add new master drawings (saved
settings, rule sets and cloning
templates)

Add master drawings in Master
Drawing Catalog (page 130)

Remove an obsolete master drawing
from Master Drawing Catalog

Remove master drawings from the
Master Drawing Catalog (page 133)

Change the name, description,
keyword and sample image of a
master drawing and edit the saved
setting properties file, rule set
contents, or cloning options

Modify master drawing properties
(page 133)

Create folders in Master Drawing
Catalog, copy master drawings
between folders, and change the
folder location

Manage Master Drawing Catalog
folders (page 138)

Create new drawings based on
master drawings

Create drawings in Master Drawing
Catalog (page 106)

Add master drawings in Master Drawing Catalog
Depending on your environment, the Master Drawing Catalog usually
contains some master drawings when you start using it, at least the
predefined saved settings (drawing property files) are there, and maybe some
wizards.

You can also add new:

• Saved settings

• Rule sets

• Cloning templates

Add a rule set master drawing in Master Drawing Catalog

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

2. Click the Add rule set toolbar button .

Create drawings in Tekla Structures 130 Create drawings in Master Drawing Catalog



3. In the Define Rules for Creating Drawings dialog box, select the drawing
types you want to create with the rule set. 

You can select several drawing types with the same rule set. For example,
you can use the same rule set to create single-part drawings and
assembly drawings.

4. Click Next.

5. In the next dialog box, click Add group and select the object groups for
which you want to create drawings, and a master drawing for each group. 

Only those master drawing types are listed that can be used for the
drawing types that you selected in the previous dialog box. Saved settings
are marked with an S and cloning templates with T.

You can use the buttons in the dialog box to do the following:

• Use Move up and Move down to move a rule upwards and
downwards in the list.

If a rule that is higher in the list creates a drawing of an object, another
rule lower in the list that would create a drawing of the same object
will not do it again.

• Use Properties to view or modify the properties of a master drawing
that you have selected in the list.

• Use Preview to display a sample image of the selected master
drawing.
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6. Click Next.

7. If you have selected several drawing types, repeat steps 4 and 5 for all
drawing types that you have selected.

8. Modify master drawing properties of the rule set: give a name to the rule
set, add a sample image, and enter a description and keywords.

9. Click Finish. 

The rule set is added in the Master Drawing Catalog.

Add a saved settings master drawing in Master Drawing Catalog
All predefined drawing properties files are shown as saved settings in the
Master Drawing Catalog. When you save a new drawing properties file, Tekla
Structures shows it in the Master Drawing Catalog automatically.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Modify the drawing properties in the Single-part Drawing Properties,
Cast Unit Drawing Properties, Assembly Drawing Properties or
General Arrangement Drawing Properties dialog box.

3. Load drawing properties that are as close to the ones you need as
possible.

4. Modify the properties.

5. Give a name to the properties file and save the file. 

The new property file is automatically added to the Master Drawing
Catalog. If it is not displayed in the list, press F5 to refresh the view.

6. Modify master drawing properties: give the master drawing a name, add a
sample image, and enter a description and keywords.

Add a cloning template master drawing in Master Drawing Catalog
You can add drawings as cloning templates to the Create Drawings - Master
Drawing Catalog from Document manager.

Before you add a cloning template in the Create Drawings - Master Drawing
Catalog, create a drawing with the desired properties and contents and save
it.

Limitations: You cannot add general arrangement drawings or multidrawings
to the Create Drawings - Master Drawing Catalog from the Document
manager. You can clone general arrangement drawings using the Clone
command in the Document manager dialog box.

1. On the Drawings & reports tab, click Document manager.

2. Select the drawing, right-click and select Add to Master Drawing Catalog
(Ctrl+M).
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3. Modify the master drawing properties of the cloning template. On the
General tab, enter a name for the cloning template, and a short
description and keywords.

4. Tekla Structures adds a preliminary thumbnail image for the cloning
template. If necessary, click Change image...and browse for a new image.
The same image will then be displayed when you right-click the thumbnail
and select Preview.

5. Go to the Drawing creation tab and specify how dimensions and marks
are created, and select the objects to be cloned from the master drawing.

6. Click OK. 

The new cloning template is added in the Create Drawings - Master
Drawing Catalog. The icon  is displayed in the Master column of the
Document manager next to the drawing you added to Create Drawings
- Master Drawing Catalog.

Remove master drawings from the Master Drawing Catalog
You can remove obsolete master drawings from the Master Drawing
Catalog.

Limitations: In the folder view, you cannot remove master drawings from the
Master Drawing Catalog through the folders that you have created yourself.
Use the Saved searches folders to display the desired master drawings and
then remove the extra ones.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

2. In the Master drawing catalog, select the master drawings you want to
remove.

3. Right-click and select Remove from Catalog.

4. Confirm the removal. 

Tekla Structures removes the master drawings from the catalog. Any
created drawings that are based on removed master drawings remain in
Document manager. The catalog properties that you have entered for
the master drawing are not deleted. They are still available for the master
drawing if you decide to add the master drawing back to the catalog.

Modify master drawing properties
Each master drawing in the Master Drawing Catalog has its own properties:

• You can search for master drawings based on the master drawing name,
description and keywords that you add.

• You can add a sample image for each master drawing (Change image...
button).
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• The sample image is also shown as a thumbnail in the thumbnail view of
the Master Drawing Catalog.

• You can access drawing properties (Edit drawing properties... button) and
you can, for example, apply object level settings.

TIP Make sure to always add all important information for each master drawing in
the Master Drawing Properties dialog box. This makes it a lot easier to find the
master drawings you are looking for.

Modify saved settings properties
You can modify the name, description and keywords of saved settings in
Master Drawing Catalog, and change its sample image.

1. In the Master Drawing Catalog, double-click a master drawing of the
desired type.

2. Modify the name of the drawing in the Name box.

3. Enter or modify the description of the master drawing. You can search
master drawings on the basis of data that you enter here.

4. Enter or modify keywords for the master drawing. Use spaces between
words. You can search master drawings on the basis of data that you
enter here.

5. To add or change the sample image, click Change image and select the
image. You can use.bmp,.jpg,.jpeg, or.png images. We recommend
that you use.png images.

6. If needed, modify the drawing properties of the master drawing by
clicking Edit drawing properties... to display the drawing properties
dialog box. This also allows you to apply object level settings (page 70). 

Save the modified properties. Ensure that you have the correct drawing
property file name at the top.
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7. Click OK.

Apply detailed object level settings in saved settings
You can apply drawing object level settings in the drawings that you create in
Master Drawing Catalog for the saved settings type of master drawings. This
way you can use the same saved settings for many drawings and only apply
some specific object level settings at the point when you create the drawing,
for example, use different kind of marks or change the reinforcement color.

To apply detailed object level settings in saved settings for a general
arrangement drawing:

1. In the Master Drawing Catalog, double-click the saved setting you want
to use for creating drawings.

2. In the Master Drawing Properties dialog box, click Edit drawing
properties...

3. Click the toggle button  at the bottom to empty the check boxes.

4. In the Drawing Properties dialog box, select only the Use detailed
object level settings check box and ensure that the Yes button next to it
is selected.

5. Click Edit settings....

6. Select the filter to be used, the drawing object type and the drawing object
property file to be used.

7. Click OK.

8. Click Save on the top of the dialog box to save the changes in the saved
settings file (property file).

9. Click OK in the Master Drawing Properties dialog box.

10. Create the drawings.

Modify properties and contents of wizard files
You can modify wizard files in the Master Drawing Catalog using a text
editor. You can change the name, description, and keywords, and add a
sample image.

1. In the Master Drawing Catalog, double-click a wizard file.

2. Modify the name of the drawing in the Name box.

3. Enter or modify the description of the master drawing. 

You can search for master drawings based on the data you enter here.

4. Enter of modify keywords of the master drawing. 

Use spaces between words. You can search for master drawings based on
the data you enter here.
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5. To add or change the sample image, click Change image... and select the
image. 

You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you
use .png images.

The sample image will also be used as the thumbnail image of the master
drawing in the thumbnail view of the Master Drawing Catalog.

6. To edit the contents of the wizard file, click Edit drawing properties... 

The wizard file is opened in a text editor. Modify the contents of the file,
and save and close it.

7. Click OK.

Wizard file contents

Wizard files consist of the following entries. Notice the use of parentheses.

set_drawing_type(assembly)
This line defines the type of drawing the wizard creates. The drawing type
appears in parentheses. The options are:

Option Creates
single single-part drawings
assembly assembly drawings
multi_single single-part multidrawings
multi_single_with_layout single-part multidrawings with

layout
multi_assembly assembly multidrawings
multi_assembly_with_layo
ut

assembly multidrawings with
layout

cast_unit cast unit drawings

set_drawing_attributes(column)
This line tells Tekla Structures which drawing properties to use when creating
the drawings. The name of the saved drawing properties appears in
parentheses.

set_template_drawing
This line tells Tekla Structures to use the defined drawing as a template when
creating a new drawing. This line is used instead of the line 
set_drawing_attributes. The path and the name of the drawing template
are given in parenthesis like in the following example: 
set_template_drawing("C:\TSModels\AngleModel":"[A.2]")
set_filter(column_filter)
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This line tells Tekla Structures which selection filter to use to select the parts
from which to create drawings. The filter name appears in parentheses.

create_drawings()
Tekla Structures starts creating the drawings. This line should always appear
immediately after the lines set_drawing_type, set_drawing_attributes
and set_filter.

Modifying cloning template properties
You can modify the name, description and keywords of cloning templates in
Master Drawing Catalog, and change its sample image.

1. In the Master Drawing Catalog, double-click a master drawing of the
desired type.

2. Modify the name of the drawing in the Name box.

3. Enter or modify the description of the master drawing. 

You can search for master drawings based on the data you enter here.

4. Enter of modify keywords of the master drawing. 

Use spaces between words. You can search for master drawings based on
the data you enter here.

5. To add or change the sample image, click Change image... and select the
image. 

You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you
use .png images.

The sample image will also be used as the thumbnail image of the master
drawing in the thumbnail view of the Master Drawing Catalog.

6. Go to the Drawing creation tab.

a. For the Dimensions, Marks, and Marks for welds in model, define
whether you want to Clone them, recreate them automatically when
you clone a drawing (Create) or Ignore them in cloning.

b. Select the objects to be cloned from the master drawing: Drawing
welds, Level marks, DWG/DXF, Text files, Texts, Symbols,
Graphics, and Hyperlinks).

7. Click OK.

Add sample and thumbnail images to master drawings
You can create sample or preview images of the drawings. You can add
sample images for master drawings in Master Drawing Catalog. The same
image is used as a thumbnail in the Master Drawing Catalog thumbnail list.
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Before you can add a sample image or a preview image to a master drawing,
you must have it somewhere ready.

Sample images are just samples, they are not real-time drawings, and they do
not update when the drawing changes.

First create the image:

1. Open the drawing you want to use.

2. Clean up the drawing from unnecessary objects, for example, associativity
symbols.

3. On the Views tab, click Screenshot --> Sample image for Master
drawing catalog.

The image is saved in the \drawings folder under the model folder in .png
format with the same name as the drawing. You can see the name of the
image on the status bar.

Then you can add the sample image in the master drawing properties:

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

2. In the Master Drawing Catalog, locate the desired master drawing and
double-click it to open the Master Drawing Properties dialog box.

3. Add the image you created: 

• For the master drawings of the type saved settings, cloning templates,
and wizard files, click Change image... and browse for the sample
image. Click OK to save the image as a sample image.

• For rule sets, click Next until you get to the page where you can add
the sample image. Click Browse and browse for the sample image.
Click Save to save the image as a sample image.

Now you can display the sample image by selecting the master drawing
on the catalog list, right-clicking and selecting Preview. The thumbnail
image in the Master Drawing Catalog thumbnail list is a smaller version
of the same sample image.

Manage Master Drawing Catalog folders
In the folder view of the Master Drawing Catalog you can add new folders,
rename folders, and move folders. You can also copy master drawings to
another folder, and delete master drawings.

You can manage Master Drawing Catalog in the following ways:

• Add new, rename, and move folders.

• Copy master drawings to another folder.

• Delete master drawings from folders.
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NOTE Deleting master drawings from a folder or copying them to another
folder in the folder view does not affect the catalog contents in any
way. The folder view is just another way to help you to keep you
master drawings well organized.

Add, rename, and move folders

This is an example of how you can add, rename and move folders in Master
Drawing Catalog:

1. In the Master Drawing Catalog, click the folder view button  to go to
the folder view.
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2. To add a folder: Right-click the tree area in the upper part of the folder
view, select Create New Folder and enter a name for the new folder. 

For example, enter PROJECT_XYZ.

3. To add a subfolder: Right-click folder, in this case PROJECT_XYZ, and
select Create New Sub-folder.

4. Enter a name for the folder. 

For example, enter Site12.

5. Create another subfolder Site10 following the steps 3 - 4.

6. To rename a folder: Right-click the folder, select Rename (F2) and enter
a new name. 

For example, rename Site10 to Site11.

7. To move a folder upwards: Right-click the folder and select Move up. In
this case, move Site11 one step up. 

Copy master drawings to another folder

1. In the Master Drawing Catalog, click the folder view button  to go to
the folder view.

2. Open the folder containing the master drawings that you want to copy to
another folder, and select the drawings.

3. Right-click and select Add to and then select the desired folder.

The master drawings are copied. They are not removed from the original
folder.

TIP Use the following keys and key combinations for selecting drawings:

• Select all displayed drawings: Ctrl + A

• Select consecutive drawings: Click the first drawing, hold down Shift and
select the last drawing.

• Select several drawings: Click the first drawing, hold down Ctrl and select the
rest of the drawings.

Remove master drawings from a folder
You may want to remove master drawings from a folder in the folder view, for
example, when you have copied master drawings to another folder and no
longer need them in the original folder.
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1. In the Master Drawing Catalog, click the folder view button to go to
the folder view.

2. In the upper part of the folder view, click the folder from which you want
to remove drawings. 

The master drawings in the folder are shown in the lower part of the view.

3. Select the master drawings to be deleted, right-click and select Remove
from folder.

The master drawings are removed from the folder. The master drawings are
not removed from the catalog, just from the folder.

3.7 Clone drawings
You should consider cloning drawings when:

• There are several similar parts, assemblies, or cast units in the model.

• You want to ease editing work when there are several similar parts that
have different position numbers. You may have separate drawings of these
similar parts.

• The drawings need a lot of manual editing

If cloning does not produce a satisfactory result, you need to modify the
cloned drawing manually. For example, you can create a drawing for one truss,
modify the drawing, and then clone it for similar trusses. Sometimes you need
to modify the cloned drawings where the trusses differ.

The cloned drawing may contain more or less parts than the original drawing.
Part properties, marks, associative notes and related text objects are cloned
from a similar part in the original drawing.

You can clone drawings using the cloning templates added in the Master
Drawing Catalog in the existing model and in other models, using a drawing
in Document manager of the current model, and using the cloning templates
in the template library.

Click the following links to find out more about cloning:

Create drawings using cloning templates in Master Drawing Catalog (page 142)

Clone by using cloning templates located in other models (page 143)

Clone from Document manager (page 144)

Clone dimensions in selected views only (page 148)

Clone using drawing templates in template library (page 151)

Cloned objects (page 149)
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What to check in cloned drawings (page 149)

Refresh drawing associativity after cloning (page 150)

Create drawings using cloning templates in Master Drawing
Catalog
In the Master Drawing Catalog, you can create single-part, assembly and cast
unit drawings using cloning templates that you have added there from
Document manager.

Note that only the cloning templates located in the folder that is set for the
advanced option XS_CLONING_TEMPLATE_DIRECTORY are displayed in the
Master Drawing Catalog.

Limitations:

• You cannot clone general arrangement drawings through the Master
drawing catalog. You can clone general arrangement drawings only by
using the Clone command in Document manager.

• You cannot clone multidrawings.

• The drawing properties of cloning templates cannot be modified through
the Master Drawing Catalog.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

2. Double-click the cloning template that you want to use.

3. Go to the Drawing creation tab and specify how dimensions and marks
are cloned. 

You can select to ignore the dimensions and marks, clone them, or
recreate them.

The Marks option controls revision marks and all building object marks.

Selecting Create in the Dimensions and Other marks box is useful if
cloning the dimensions or other marks does not produce satisfactory
results. Using this option does not create any new views.

4. On the same tab, select which object types you want to clone.

5. If you want to create a drawing only for certain parts, select the parts from
the model. 

You can also use an appropriate selection filter and select the whole
model. Activate only the Select parts selection switch when you select
objects, otherwise the selection may take a long time.

6. Click Create drawings or Create drawings for all parts.
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7. Number the model if prompted to do so. 

Tekla Structures creates the drawings and adds them in Document
manager. In the Document manager, cloned drawings are marked with
the text Drawing was cloned in the Changes column.

8. Check the cloned drawing and modify it (page 149), if necessary.

TIP If you have cloning templates that you have created using an older Tekla
Structures version and want to utilize the better associativity of a newer Tekla
Structures version, refresh the drawing associativity (page 150) by using the
Refresh Associativity command, which you can type in the Quick Launch box.

See also

Cloned objects (page 149)

Master drawing types (page 108)

Add master drawings in Master Drawing Catalog (page 130)

Clone by using cloning templates located in other models
You can take into use in the Master Drawing Catalog cloning templates
located in other models, and create drawings using them.

Limitations: You can only use cloning templates from other models, not other
types of master drawings, such as saved settings or rule sets.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog.

2. In the Master Drawing Catalog, click  to open the Models Containing
Master Drawings dialog box.

3. Click Add model... and browse to the desired model.

4. Click OK. 

Now the cloning templates in the defined folder are displayed in the
Master Drawing Catalog.

5. Select the cloning template from the Master Drawing Catalog and create
a drawing using the selected template.

TIP When you have similar parts in several projects, you can maintain a set of cloning
models and then take the cloning templates in the cloning models in use when
necessary.

See also

Create drawings in Master Drawing Catalog (page 106)
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Create drawings using cloning templates in Master Drawing Catalog (page 142)

Clone from Document manager (page 144)

Clone using drawing templates in template library (page 151)

Clone from Document manager
In addition to cloning drawings using cloning templates in Master Drawing
Catalog, you can clone single-part, cast unit, assembly and general
arrangement drawings from the Document manager.

NOTE • When you clone drawings of assemblies or cast units, they must
have the same type of main part as the assembly or cast unit from
which the original drawing was created. For example, the upper
chords of the original and the cloned truss could be main parts.

• In general arrangement drawings, one main view, and section and
detail views are cloned.

Before cloning, finalize, save, and close the drawing you want to use as a
cloning template.

To clone a drawing from the Document manager:

1. In the model, select what to include in the drawing:

• If you are cloning a single-part drawings, cast unit drawing or assembly
drawing, select parts, assemblies or cast units.

Create drawings in Tekla Structures 144 Clone drawings



• If you are cloning a general arrangement drawing, select a model view.
To do this, click the desired model view so that the view gets a yellow
frame around it.

2. On the Drawings & reports tab, click Document manager.

3. In Document manager, select the drawing that you want to use as a
cloning template.

4. Click Clone

5. In the Clone Drawing dialog box, select the drawing object types you
want to clone into the new drawing, and the actions for each object type.

• For Dimensions and Other marks (all building object marks), select
whether you want to Clone them, recreate them automatically when
you clone a drawing (Create) or Ignore them in cloning.

Selecting Create in the Dimensions and Dimensions box is useful if
cloning the dimensions or other marks does not produce satisfactory
results. Using this option does not create any new views.

• For other objects, select to Clone or Ignore them.

6. Click Clone selected.

Tekla Structures clones the drawing. In the Document manager, cloned
drawings are marked with the text Drawing was cloned in the Changes
column.

For an example of cloning a general arrangement drawing, see Example: Clone
a general arrangement drawing (page 146)
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See also

Clone drawings (page 141)

Create drawings using cloning templates in Master Drawing Catalog (page 142)

Example: Clone a general arrangement drawing

In this example, we first created a general arrangement drawing of the +3200
plan in a building, then edited the drawing and then cloned the general
arrangement drawing of the +6300 plan.

For detailed instructions on cloning, see Clone from Document manager
(page 144).

The first floor and second floor are quite similar:

We edited the general arrangement drawing of the +3200 plan view slightly,
for example, deleted some marks.
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We selected the model view that represents the +6300 plan and then cloned
the drawing using the general arrangement drawing of the +3200 plan as a
template.

In the cloned drawing:
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• The drawing view plane has been moved to match the model view +6300
plan.

• If there are parts in matching places, the marks have been cloned to the
new location and the content has been updated.

• Dimensions are cloned.

• All building object marks cloned.

See also

Clone from Document manager (page 144)

Clone dimensions in selected views only
The dimension cloning options in the Clone Drawing dialog box affect all
views, whereas the option Dimension creation method in this view sets the
dimension creation method for the selected view only. You can create
automatic dimensions in the front view and clone the dimensions in section
and end view, for example.

1. Double-click the drawing view frame to open the View Properties dialog
box.

2. On the Attributes 2 tab, set Dimension creation method in this view to
Clone. 

Using this option affects the creation of the dimensions during cloning
and re-dimensioning of existing drawings.

3. Click Modify.

4. Save and close the drawing.

5. Open the Document manager, select the drawing and click Clone...

6. In the Clone Drawing dialog box, select the objects to be cloned and the
dimension cloning option (Ignore, Clone, Create). 

• If you select Dimensions > Ignore, the dimensions will be cloned only
for those views that have Dimension creation method in this view
set to Clone.

• If you select Dimensions > Clone, the dimensions will be cloned for all
views.

• If you select Dimensions > Create, the dimensions will be created for
all views except for those that have Dimension creation method in
this view set to Do not create.

7. Click Clone selected.

See also

Clone drawings (page 141)
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Cloned objects
The following objects can be cloned:

• Dimensions

• Marks for welds added in the drawing

• Marks for welds added in the model

• Level marks

• Revision marks

• Annotation objects

• All user-defined attributes of a drawing

• Texts

• Symbols

• Graphical drawing objects (shapes)

• Text files

• DWG/DXF files

• Hyperlinks

• Manually created section and detail views

• When you clone an assembly drawing that includes single-part drawings,
Tekla Structures includes the single-part drawings in the cloned assembly
drawing by default.

See also

Clone drawings (page 141)

What to check in cloned drawings
Always check the cloned drawings to make sure that the drawing contents
meet your needs, and marks, views and dimensions are correct.

You should go through the cloned drawings and check that everything is
correct. Below is a checklist for this purpose.

Object Check and change if necessary
Marks • In general, mark contents are

correct in cloned drawings, but
sometimes you may need to
modify the location of the marks.

• Tekla Structures clones marks that
can be mapped to the original
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Object Check and change if necessary
drawing and creates new marks
for parts that cannot be mapped
to the template drawing.

Views • Ensure that the view sizes and
view orientation are correct, and
that the views are placed correctly
in the cloned drawing. The size of
the views is updated according to
the parts included in the views.

Dimensions • If the cloned drawing contains less
parts than the original drawing,
the dimensions to the missing
parts are automatically removed.

• If the cloned drawing contains
more parts than the original
drawing, Tekla Structures
dimensions the additional parts
using automatic dimensioning, if
you have set the advanced option 
XS_INTELLIGENT_CLONING_ADD_
DIMENSIONS to TRUE. Because
Tekla Structures uses automatic
dimensioning for creating
dimensions for new parts, you
may have to check and correct the
created dimensions.

• Add missing dimensions and
remove the incorrect ones.

See also

Clone drawings (page 141)

Cloned objects (page 149)

Refresh drawing associativity after cloning
Often improvements in cloning and associativity require that the associative
rules have to be recreated. This can be done by using the Refresh
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associativity command. When you use this command, you do not need to
recreate the drawing.

For example, this command is very useful if you have a cloning template you
have created using an older Tekla Structures version and want to utilize the
better associativity of a newer Tekla Structures version.

1. On the Drawings & reports tab, click Document manager.

2. Open a cloning template the associativity of which you want to refresh.

3. Go to Quick Launch, enter Refresh associativity, and click the
Refresh associativity command on the displayed list.

4. Save the cloning template.

See also

Drawings in Tekla Structures (page 46)

Clone drawings (page 141)

Clone using drawing templates in template library
This is a more manual way of cloning drawings: you can create drawings using
drawing templates located in the template library. The template library is in
practice a model folder that contains the drawings that you want to use as
drawing templates.

1. In a model that you use as a template model, create a drawing you want
to use as a drawing template and save the drawing.

2. In another model where you want to create a drawing using a drawing
template, select the objects to be included in the new drawing.

3. On the Drawings & reports tab, click Document manager.

4. In Document manager, select a drawing and click Clone.

5. Click Other model.

Use Browse for model... to browse for another model folder containing
the drawing templates that you want.

6. Click Select template...

7. In the Drawing Templates dialog box, select a drawing template and
leave the list open.

8. In the Clone Drawing dialog box, use the Objects and actions in cloning
options to define the drawing objects to be cloned and the actions for
each cloned object.

9. Clone the drawing by clicking Clone selected.

Tekla Structures clones the drawing. In the Document manager, cloned
drawings are marked with text Drawing was cloned in the Changes column.
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TIP You can specify that a certain model folder is always used as a template
library using the advanced option XS_DRAWING_TEMPLATES_LIBRARY.

See also

Clone drawings (page 141)

Clone by using cloning templates located in other models (page 143)

3.8 Create multiple drawing sheets of the same part
You can create several drawings from the same part as multiple drawing
sheets. The number of sheets is not limited, and each drawing can have its
own properties.

This is useful when you need extra sheets for details and section views, and
especially when you want to have several drawings of an assembly with
different presentation options: one with a large 3D image of the assembly, one
with additional section views, and one where only certain parts or sub-
assemblies of the assembly are marked and dimensioned.

You can create multiple drawing sheets of the same part in the Master
Drawing Catalog using rule sets or wizards, or using the drawing properties
dialog box.

Create multiple drawing sheets with wizards
Before you start, ensure that you have created drawing property files (saved
settings) for creating multiple sheets of the same part, each file containing the
desired settings for a specific purpose and individual sheet numbers.

1. On the Drawings & reports tab, click Create drawings --> Master
drawing catalog to open the Create Drawings - Master Drawing
Catalog dialog box.

2. Double-click the desired wizard file in the list to open the Master
Drawing Properties dialog box.

3. Click Edit drawing properties... to open the wizard file (page 133). 

For an example of the wizard file contents, see Modify master drawing
properties (page 133).

4. In the file, give the names of the drawing properties files that you want to
use to create the multiple drawing sheets. 
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Give the file names in parenthesis on the set_drawing_attributes row
as shown below:

set_drawing_type(cast_unit)
set_drawing_attributes(sheet1, sheet2, sheet3)
set_filter(column_filter)
create_drawings()

5. Save the wizard file with a new name.

6. In the model, select the parts you want to create the drawings from.

7. Click the newly created wizard file in the Master Drawing Catalog and
click Create drawings. Tekla Structures creates the drawings.

Create multiple drawing sheets using drawing properties

1. Open the drawing properties dialog box by double-clicking the
background of an open drawing.

2. Adjust the drawing properties as needed, and change the drawing name
so that it refers to the type of drawing you want to create, for example,
FRAME 3D.

Do not touch the Sheet number box.

3. Click Apply to keep the changes and leave the dialog box open.

4. Create a drawing of the object by selecting the appropriate command: On
the Drawings & reports tab, hold down Shift and click Create drawings
and click the drawing type.

5. In the open drawing properties dialog box, adjust the drawing properties
again and change the name to match the type of the new drawing, for
example, FRAME FRONT.

6. Change the sheet number in the Sheet number box to get another
drawing of the same assembly with a different sheet number.

7. Click Apply and create a new drawing of the same object with different
properties.

8. Continue making all the sheets you need in the same way as in steps 5 - 7.

Example

An example how the Document manager shows the multiple drawings:
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3.9 Copy a drawing to a new sheet
You can copy a drawing to a new sheet. This is useful, for example, if you want
to have the same layout and views as in the original drawing, but highlight
something else on the new drawing sheet.

1. On the Drawings & reports tab, click Document manager.

2. Select the drawing that you want to use as the original for copying.

3. Right-click and select Create Drawings --> Copy to new sheet . 

Tekla Structures copies the original drawing to a new sheet and gives the
copied drawing a new sheet number.

4. Open the new drawing sheet, make the necessary changes and save it.

NOTE If you use the Recreate (Shift+R) command for the copied drawing in
Document manager, Tekla Structures asks if you want to copy the drawing
again from the original drawing. If you answer yes, the previously copied
drawing sheet will be replaced by a new copy of the previously selected
original drawing.

See also

Create multiple drawing sheets of the same part (page 152)
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4 Edit drawings

After you have created a drawing, you can modify properties of the drawing
and views, building objects, and dimensions and marks already included in the
drawing. You can add views, marks, notes, text, sketch objects and other
objects. You can also change drawing colors, and use special custom
presentations for some object types.

You can have a look at a snapshot of a drawing without opening it:

Snapshots in drawings (page 159)

Open drawings (page 157)

You can edit the drawing name and titles:

Modifying drawing names and titles (page 156)

You can add and/or edit drawing views, dimensions, marks and other
drawing objects:

Create and modify drawing views (page 168)

Manual dimensioning (page 194)

Create and modify marks, notes, texts, symbols and links in drawings
(page 276)

Clone selected in drawings (page 514)

Drawing sketching tools and sketch objects (page 352)

Building objects in drawings (page 375)

2D Library in drawings (page 519)

Add symbols in drawings (page 330)

Custom presentations in drawings (page 530)

Welds in drawings (page 492)

Reinforcement in drawings (page 395)

Pours in drawings (page 488)

Spiral beams in drawings (page 390)
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Reference models in drawings (page 552)

Grids in drawings (page 534)

Colors in drawings (page 547)

User coordinate system (UCS) (page 555)

You can hide, align, arrange, reposition, drag, reshape, resize, and
explode drawing objects and indicate with cut lines parts partly outside
the view border:

Show or hide drawing objects (page 339)

Align selected drawing objects (page 345)

Drag, reshape and resize drawing objects (page 348)

Arrange annotation objects (page 344)

Indicate cut lines in Tekla Structures drawings (page 350)

Explode drawing plug-ins and use ordinary drawing objects (page 352)

When you save and close the drawings, there are some things you need
to keep in mind:

Save and close drawings (page 158)

4.1 Modifying drawing names and titles
Tekla Structures names the drawings according to the name given in the
drawing properties. The drawing name is displayed in Document manager
and in drawing and report templates. You can change the default drawing
name when you create the drawing and in an existing drawing. In addition to
the drawing name, you can give titles for your drawings. Tekla Structures
shows the titles in Document manager and in drawing and report templates,
and also in print output file names. You can define up to three titles.

Rename drawings
1. In Document manager, right-click the drawing and select Properties.

2. Enter the new name in the Name box. 

The maximum number of characters in 32.

3. Click Modify. 

Close the Document manager and open it again to see the change.
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Give titles to drawings
1. In Document manager, right-click the drawing and select Properties.

2. Enter the titles.

3. Click Modify. 

Close Document manager and open it again to see the change.

TIP If you want to customize your print file names and use title values instead of
drawing names in them, you can define that the title entered in this dialog box is
used in the print file name. To do this, enter the value %TPL:TITLE1% (or 
%TPL:TITLE2% or %TPL:TITLE3%) as the value for the advanced option 
XS_DRAWING_PLOT_FILE_NAME_G (or _W, _A, _M or _C depending on the
drawing type) through File --> Settings --> Advanced options --> Printing .

For more information, see Customize print output file names (page 622) and
TITLE1..3.

4.2 Open drawings
You can open drawings both in the model and in the drawing mode. Only one
drawing can be open at a time.

TIP To always open the drawings maximized, set the advanced option
XS_OPEN_DRAWINGS_MAXIMIZED to TRUE.

Open a drawing in the model
Do one of the following:

• In the model mode, on the Drawings & reports ribbon tab, click
Document manager (Ctrl + L), and then double-click a drawing in the list,

or select a drawing in the list and click  at the bottom.

• Select objects in the model, open the contextual toolbar and select the
Open or create drawings button. Single-part drawings, assembly
drawings, cast unit drawings, and multidrawings containing the selected
objects are listed in the menu. You can open a drawing just by clicking it in
the list.

When you open a drawing, a message box is displayed showing the progress
and what is happening, and a snapshot of the drawing is displayed. You can
click Cancel to cancel the opening.
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Open a new drawing when a drawing is already open
You can open another drawing while you already have a drawing open. The
drawing that you already have open closes when you do this.

Do any of the following:

• In the drawing mode, on the Drawing ribbon tab, click Document
manager (Ctrl + O), and then double-click a drawing in the list, or select a

drawing in the list and click  at the bottom.

• To open the next drawing in the Document manager list, press Ctrl +

Page Down, or click the Open next drawing  button at the bottom.

• To open the previous drawing in the Document manager list, press Ctrl +

Page Up, or click the Open previous drawing  button at the bottom.

If you have made some changes in the currently open drawing, Tekla
Structures asks you if you want to save the changes before opening another
drawing. You also have a chance to take a snapshot (page 159) of the current
drawing or mark it ready for issuing (page 584). If you have set the advanced
option XS_ALWAYS_CONFIRM_SAVE_WHEN_CLOSING_DRAWING to TRUE the
confirmation message is always shown. The default value is FALSE. This means
that if you close a drawing without making any changes, Tekla Structures does
not by default prompt you to save the drawing.

When you open a drawing, a message box is displayed showing the progress
and what is happening, and a snapshot of the drawing is displayed. You can
click Cancel to cancel the opening.

Cannot load the selected drawing

Sometimes, you cannot open the drawing because the drawing file cannot be
found, or the drawing file is somehow incompatible. Tekla Structures then
displays one of the following messages:

• "Cannot load the selected drawing. Could not find the drawing file. Check
Tekla User Assistance for more information."

• "Cannot load the selected drawing. Incompatible drawing file. Check Tekla
User Assistance for more information."

For more information, see Cannot load selected drawing.

4.3 Save and close drawings
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Save a drawing
Tekla Structures automatically saves drawings at set intervals. You can also
save your drawing when ever you want to.

• To save a drawing, in the open drawing, go to the File menu and click Save
drawing.

Both the drawing *.dg and the model *.db1 and *.db2 are saved. The
drawings are saved in the \drawings folder under the model folder.

A snapshot is by default created when you open and save a drawing. The
snapshot represents the situation when the drawing was last saved. For
more information, see Snapshots in drawings (page 159).

For more information about autosave and the autosave interval, see Autosave
drawings.

Close drawings
You can only have one drawing open at a time. You always have to close an
open drawing before you can open another one.

1. Do one of the following: 

• Go to the File menu and click Close drawing mode.

• On the Drawing tab, click Close.

• Click the Close button X in the upper-right corner of the drawing
window.

2. If you have made changes in the drawing, Tekla Structures asks you to
confirm if you want to save your changes. 

You can also select to mark the drawing ready for issuing. For more
information, see Mark drawings ready for issuing (page 584).

4.4 Snapshots in drawings
With snapshots you can take a quick look at any drawings without opening the
drawing. Use this tool when you just want to check but not edit a drawing, or
take a look at several drawings while trying to find the one you are looking for,
for example, a certain drawing revision. Using snapshot overlay, you can view
the contents of drawings directly in model view without opening the actual
drawing. You can also show drawing snapshots against the latest version of a
drawing or against another drawing in the drawing mode. You can take
snapshots of all types of drawings, and all drawing types can be overlaid with
drawing snapshots.
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Create and view drawing snapshots
A snapshot is by default created when you open and save a drawing. The
snapshot represents the situation when the drawing was last saved, so any
newer changes to the model are not reflected in the snapshot.

1. Select a drawing and open it from the Document manager.

2. Save the drawing by going to the File menu and clicking Save drawing. 

The snapshot is saved in the ..\<model>\drawings\Snapshots folder.

3. Select the same drawing from the Document manager.

4. Click the Snapshots button at the bottom of the Document manager to
display the snapshot.

Below is an example of a snapshot.

If you have selected a drawing that does not have a snapshot and click
Snapshots, an instructional view is displayed asking you to open the drawing
and save it to create the snapshot.

To create a snapshot of a drawing automatically when the drawing is created,
set XS_DRAWING_CREATE_SNAPSHOT_ON_DRAWING_CREATION to TRUE in the
Drawing Properties category in the Advanced Options dialog box.
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Snapshot overlay
You can view a snapshot of a drawing while you are editing a drawing. In the
snapshot overlay, you can see the latest changes, and can align the drawing
content, for example. You can see the changes in a drawing since the latest
update, and switch between the snapshot and the actual drawing.

Finding the correct drawing by going through the snapshots is much faster
than opening the actual drawings one by one.

Limitations

• Texts are one sided when viewed from the model, and DX graphics do not
support text in snapshots.

• Overlay in the model was not designed to work for the 3D drawing views .

• Views that are outside the printing area are displayed in the model overlay.

• Reading large GA drawing snapshots may take a long time.

• Loading the snapshot takes longer for the first snapshot than for the rest.

Before you can see a snapshot overlay of a drawing, you need to create a
snapshot by opening a drawing, and saving the drawing.

Below you can see the settings in the snapshot view:

Snapshot overlay in model
1. Open Document manager and select a drawing.

2. Click Snapshots.

3. At the top of the displayed snapshot dialog box, under Overlay in model,
select the Overlay check box. You can also select a color for the snapshot.

A cast unit is overlaid with the corresponding cast unit drawing.
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Snapshot overlay in drawings
1. Click Drawing --> Document manager, and open a drawing that has

changed after the latest snapshot.

2. Still in Document manager, select the same drawing and click
Snapshots.

3. Select one of the options under Overlay in drawing: 

Overlay: Show the snapshot on the actual drawing so that both are
visible.

Show snapshot only: Show the snapshot only without the actual drawing.

None: Quickly switch to the actual drawing.

4. Select a color for the snapshot.
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In the example below, the size of the cast unit has changed since the snapshot
was taken.

TIP If a plan view GA drawing is open, and you want to align content using
another GA drawing, you can open a snapshot of the second drawing on
the first one, and snap to the snapshot, when placing or moving objects
in an open drawing. You can snap to drawing snapshot overlays with the

Snap to geometry lines / points snap switch .

4.5 Select a new layout for your drawing
You can select which layout you want to use in a drawing in the drawing
properties dialog box. You can either use the new drawing layout for the
currently open drawing, or save the new drawing layout to drawing properties
for future use.

1. Depending on where you are, do one of the following:

• In an open drawing, select Properties --> Drawing on the Drawing
tab.

• On the Drawings & reports tab, click Drawing properties and select
the drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Layout.

4. Select a new layout from the Layout list.

5. Do any of the following:

• To apply and save the new layout to the open drawing, click Modify.
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• To save the changed drawing properties for future use, click Save.

6. Click OK to close the drawing properties dialog box.

See also

Define drawing layout (page 655)

Layout properties (page 918)

4.6 Change table sets in drawings
To make minor changes to the table sets in your drawings, you can exclude
individual tables from the drawing layout. When you exclude a table, the table
becomes a part of the current drawing, so any changes that you make to that
table will not be saved to the drawing layout. This way, you can avoid and
remove overlaps in drawing content and tables without creating new layouts
or drawing sizes for each case.

Exclude tables from the drawing layout
1. In the open drawing, select the tables that you want to edit.
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2. Right-click one of the tables, and select Exclude template from layout.

The tables are now part of the current drawing, so making changes to them
does not affect the drawing layout.

NOTE If any table has been excluded from the drawing layout, you cannot
change the drawing size.

According to your needs, see any of the following instructions.

Move excluded tables
1. In the open drawing, select the tables that you want to move.

2. Do any of the following: 

• Select the tables and hold down the left mouse button. Then, drag the
tables to new positions, and release the mouse button.

• Right-click one of the tables and select Move. Then, pick the origin for
moving, and the destination point.

Rotate excluded tables
1. In the open drawing, select the tables that you want to rotate.

2. Right-click one of the tables.

3. Select Rotate clockwise.

The tables are rotated clockwise by 90 degrees.

Repeat steps 2 and 3 to achieve the right rotation angle.

Delete excluded tables
1. In the open drawing, select the tables that you want to delete.

2. Right-click one of the tables.

3. Select Delete.

You can undo deleting a table by pressing Ctrl+Z on the keyboard.

Edit excluded tables in Layout editor
1. In the open drawing, select the tables that you want to edit.

2. Do any of the following: 

• Double-click one of the tables, and select Drawing layout editor.
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• Right-click one of the tables, and select Open Layout editor.

Note that when you open Layout editor like this, you can only modify
layout properties related to tables.

In the Tables in use list in Layout editor, excluded tables are shown as
follows: <<TABLE NAME>>.

3. Do any of the following: 

To Do this
Scale a table a. In the drawing layout, select the

table.

b. In the Scale box, type a new
value.

c. Press Enter.
Rotate a table a. In the drawing layout, select the

table.

b. In the Rotation list, select a new
rotation angle.

c. Press Enter.
Allow overlapping with drawing views a. In the drawing layout, select the

table.

b. Select the Overlap with views
check box.

If you do not select the Overlap with
views check box, Tekla Structures
keeps the drawing views outside the
tables area when it recreates the
drawing.

4. On the Layout editor ribbon, click Save.

The changes are saved to the current drawing only. The drawing layout is not
updated to include the changes.

Add new tables to the current drawing
1. In the open drawing, select one of the excluded tables.

2. Do any of the following: 

• Double-click the table, and select Drawing layout editor.

• Right-click the table, and select Open Layout editor.
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Note that when you open Layout editor like this, you can only modify
layout properties related to tables.

In the Tables in use list in Layout editor, excluded tables are shown as
follows: <<TABLE NAME>>.

3. On the Layout editor ribbon, click  Add tables.

4. In the Available tables dialog box, click the table that you want to add.

5. If you are adding a DWG or DXF file, or a keyplan, do one of the following: 

To Do this
Add a DWG or DXF File a. Browse to find and select the file

that you want to add to the
drawing.

b. Click Open.
Add a keyplan • In the Drawings dialog box, select

an existing key plan drawing and
click Select.

You can now close the Available
tables dialog box.

6. Click the point in the drawing layout where you want to add the table. 

The tables are automatically anchored to the drawing view frame.

7. If you want to change the table scale or rotation, select the table and type
a new Scale or Rotation value. 

Note that you can only edit the scale and rotation of template files (.tpl).

Rotation and scale changes are applied to the drawing layout
immediately. When you scale or rotate tables, the tables remain anchored
to the same position.

8. If you want to allow the table to overlap with a drawing view, select the
Overlap with views check box. 

If you do not select the Overlap with views check box, Tekla Structures
keeps the drawing views outside the tables area when it recreates the
drawing.

Repeat steps 3 to 8 for all tables that you want to add.

9. On the Layout editor ribbon, click Save.

The new tables are saved to the current drawing only. The original drawing
layout is not updated to include the tables.
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Discard drawing-specific changes
• According to your needs, do one of the following: 

To Do this
Reinclude excluded tables in the
drawing layout and restore their
positions

1. Select the tables.

2. Right-click and select Restore
template position.

Reinclude all excluded tables in the
drawing layout and restore the
original drawing layout

Do one of the following:

• Right-click anywhere in the
drawing, and select Restore
layout.

• In the Layout editor ribbon, click
Restore layout.

4.7 Create and modify drawing views
Drawing views contain modeled Tekla Structures building objects, and marks,
dimensions and other objects that you have added. A drawing view is another
way of looking at the model. Drawings may include several views. In addition
to the views Tekla Structures creates automatically based on your selection at
drawing creation, you can also add new ones in the open drawing, and modify
the existing ones.

You can have different types of views in Tekla Structures drawings:

• Main views: front, top, back and bottom views

• Section views

• End views

• Single-part views

• 3D views

• Detail views

• Key plan views

• Views along grid lines

• Elevation views

• Plan views

Adding views manually

You can manually add more views in drawings:

Create views in drawings (page 169)
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Copying, linking and moving views

You can move, copy and link views from one drawing to another:

Copy, move and link drawing views (page 178)

Modifying views, view location, detail marks and section marks, detail
view labels and section view labels:

You can modify views manually:

Modify, arrange and align drawing views (page 189)

Modify detail mark, view label and mark boundary properties in drawings
(page 297)

Modify section mark, view label and cutting line in drawings (page 294)

See also

Define drawing views (page 687)

View properties in drawings (page 920)

Section view properties (page 927)

Create views in drawings
After creating a drawing, you can manually add more views.

You can create the following types of views in an existing drawing:

• Section views

• Curved section views

• Detail views

• Front, top, back, bottom views of parts

• 3 D views of parts

• Drawing views of an entire model view

• Drawing views of selected areas in a model view

• Drawing views of selected areas in a drawing view

Create a section view
You can create section views of the parts in a drawing view in an open drawing
that contains at least one view.

1. Set the section mark properties first: On the Drawing tab, click
Properties --> Section mark .

2. Modify the cutting line, section mark, and section view label properties in
Section symbol properties, and click OK or Apply. For more information,
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see Modify section mark, view label and cutting line in drawings
(page 294) and Define view labels and view label marks (page 691).

3. Next, set the section view properties: Hold down Shift and on the Views
tab, click Section view.

4. Modify the view properties as required, and click OK or Apply. For more
information, see View properties in drawings (page 920).

5. Pick two points to define the position of the section plane. 

It is easier to pick the points if you activate orthogonal snapping: On the
File menu, click Settings and select Ortho or press O.

For beams, you can also try picking the top line of the beam and then the
bottom line of the beam using the snap switch Snap to perpendicular
points.

6. Pick two points to define the direction of the cut box and the section view
depth. 

When you pick the cut box, exaggerate a little. You can adjust the view
depth and the view boundary also later on.

The direction of the section is the direction where the section mark
arrows are pointing.

7. Pick the position for the section view. 

A view symbol follows the mouse pointer allowing you to see where you
are about to place the section view.

The depth to the opposite direction is zero (0).

Tekla Structures creates the section view using the current properties in
the View Properties and Section symbol properties dialog boxes and
adds a section mark in the original view. You can change the properties
after creating the view. For more information about modifying the view
properties, see Modify drawing view properties.

TIP • The view boundary of the created section view remains selected,
and you can adjust the depth and the height of the view
boundary by dragging it.

• If necessary, change the view scale of the section view: Double-
click the view frame, clear all other selections using the toggle
switch at the bottom, select only the Scale option, and adjust the
scale.

• If you want to create another view, start the Section view
command again.
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(1) The first two picked points indicate the position of the section plane.

(2) The third picked point indicates the direction of the cut box and the depth
of the section view. Here you can exaggerate a little.

(3) The fourth pick finalizes the cut box.

(4) A view symbol follows the mouse pointer while you are placing the section
view. The section view is placed in the selected location. The section view
remains selected and the view boundary highlighted right after the view
creation.

The section mark is drawn in the original view. The view boundary of the
section view is also highlighted in the original view right after the view
creation.
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Create a curved section view
You can create a curved section view of an existing drawing view. This tool is
useful when you want to visualize an unfolded face of a building or to manage
cladding.

Limitation: A curved section view does not work if it is done on a curved object
that is vertical or in 3D.

1. Open a drawing.

2. Set the section mark properties first: On the Drawing tab, click
Properties --> Section mark .

3. Modify the section label, cut direction symbol, and cutting line properties.
For more information, see Modify section mark, view label and cutting line
in drawings (page 294) and Define view labels and view label marks
(page 691).

4. Set the section view properties: Hold down Shift and on the Views tab,
click Curved section view.

5. Modify the view properties as required. For more information, see View
properties in drawings (page 920).

6. Pick three points on the cut plane.

7. Pick two points to indicate the cut box.

8. Pick a point to indicate the location of the curved section view. 

A symbol follows the cursor allowing you to see where you are about to
place the curved section view.

Tekla Structures creates the curved section view using the current view
properties and section mark properties and adds a section mark in the original
view. You can change the properties after creating the view.

Create a detail view
You can create a detail view from a selected area in an existing drawing view in
another view. The scale of the detail view is by default the same as that of the
main view, but in some environments the detail view is scaled up. The
direction of the detail view is the same as that of the original view. Before
creating the detail view label and detail mark define a start number or letter in
the drawing properties.

1. Open a drawing.

2. Set the detail mark properties first: On the Drawing tab, click Properties
--> Detail mark .

3. Enter a name for the detail, and modify the detail view label, detail
boundary and detail mark properties in Detail symbol properties. 

The shape of the detail boundary you select affects the way you select the
area for your detail. For more information about the properties,
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seeModify detail mark, view label and mark boundary properties in
drawings (page 297).

To change the detail symbol to a custom symbol, use the advanced option
XS_DETAIL_MARK_REFERENCE_SYMBOL.

4. Click OK or Apply.

5. Next, set the view properties: Hold down Shift and, on the Views tab, click
Detail view.

6. Modify the view properties as required. For more information, see View
properties in drawings (page 920).

7. Click OK or Apply.

8. Depending on the selected detail boundary shape, do one of the
following: 

• If the shape is Circle, pick the center point of the circle and then pick a
point on the circle.

• If the shape is Rectangle, pick corner points for the rectangle.

9. Pick a position for the detail mark.

10. Pick a position for the detail view.

Tekla Structures creates the detail view using the current properties in View
Properties and Detail symbol properties. The detail view takes the view
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depth from the original view even if you try to change it. You can change the
properties after creating the view.

(1) Detail boundary is set to Circle. You can increase or decrease the detail
symbol size by dragging the handle on the detail boundary.

(2) Detail mark

(3) Detail view

(4) Detail view label

Define a start number or letter for detail view label and mark

1. Double-click an open drawing.

2. Click the check box toggle selection button at the bottom of the dialog
box, and select only the check box next to Detail view.

3. Click Detail view.

4. Enter the start number or letter.
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5. Click Modify.

Create additional drawing views of parts
You can create additional views of a part within a single-part, cast unit or
assembly drawing. You can select the part plane (front, top, back, bottom) to
use or create a 3 D view of the part.

1. Open a drawing.

2. On the Views tab, click View of part and select one of the following: 

• Front

• Top

• Back

• Bottom

• 3D view

Tekla Structures creates the view using the current properties in View
Properties. If a plane already has a view in the drawing, a new one is not
created.

3. Double-click the frame of the new view to open View Properties and
modify the properties as required. 

For example, for 3D views, you may want to modify the view angle.

For more information, see View properties in drawings (page 920).

4. Click Modify.

Example

In the example below, the drawing originally contained only the front view. A
3D view and a top view were added. The angle of the 3D view was modified in
View Properties.
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Create a drawing view of an entire model view
You can create a drawing view of an entire model view and add it in a drawing.

1. Open a drawing.

2. Open the model view list: On the Views tab, click Model views --> Model
view list , and leave the list open.

3. Set the drawing view properties: Hold down Shift, and on the Views tab,
click Entire model view. 

For more information about view properties, see View properties in
drawings (page 920).

4. Modify the view properties, for example the view scale, and click OK or
Apply.

5. Open a model view from the model view list.

6. Click the open model view.

Tekla Structures creates the drawing view using the current view properties.
The view depth is the same as the model view depth. Tekla Structures
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calculates the boundaries of the view to fit the entire model view into the
drawing view, and places the view in the drawing.

Create a drawing view of a selected area in a model view
You can create a drawing view of a selected area in the model, and add it in a
drawing.

1. Open a drawing.

2. Open a model view list: On the Views tab, click Model views --> Model
view list , and leave the list open.

3. Set the drawing view properties: Hold down Shift and on the Views tab,
click Area in model view. 

For more information, see View properties in drawings (page 920).

4. Modify the drawing view properties as required, and click OK or Apply.

5. Open a model view from the model view list.
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6. Pick two corners in the model to define the X and Y dimensions of the
drawing view. 

The X and Y directions use the coordinate system of the model view. The
view depth is the same as defined in the applied settings in drawing view
properties.

Tekla Structures creates the drawing view using the current view properties
and places the view in the current drawing.

Create a drawing view of a selected area in a drawing view
You can create a new drawing view of an area in an existing drawing view.

To create a new drawing view of an area in the existing drawing view:

1. Open a drawing.

2. Hold down Shift and on the Views tab, click Area in drawing view.

3. You can modify the view label color. 

Other view properties are inherited from the original drawing view. For
more information about drawing view properties, see View properties in
drawings (page 920).

4. Click OK or Apply.

5. Select an area in the drawing view to be added in the new view.

6. Select a location for the new view. 

A symbol representing the view that you are about to place follows the
mouse pointer, so it is easier for you to see where to place the view.

Tekla Structures creates the drawing view using the view properties of the
original view.

Copy, move and link drawing views
You can copy drawing views from other drawings in the current drawing as
such or using the original layout. You can also move section and detail views to
another drawing through Document manager. When you move views to
another drawing, the source drawing and the target drawing will contain
references to each other. It is also possible to link drawing views from other
drawings as such or using the original layout. Linked drawing views update
when the original views change.

Copy drawing views from other drawings
1. Open a drawing where you want to copy drawing views from another

drawing.

2. Open the Document manager by pressing Ctrl+O.
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3. Select the drawing containing the view you want to copy. 

You can select several drawings.

4. On the Views tab, click From other drawing and then click one of the
following commands: 

• Copy: Copy the views from the selected drawings as such in the open
drawing. Tekla Structures does not copy the drawing layout.

• Copy with layout: Copy the views and layout from the selected
drawings in the open drawing.

NOTE Copied drawing views do not update when the original views change.

Link drawing views from other drawings
1. Open a drawing where you want to link drawing views.

2. Open Document manager by pressing Ctrl+O.

3. Select the drawing containing the drawing view you want to link. 

You can select several drawings.

4. On the Views tab, click From other drawing and click one of the
following commands: 

• Link: Display the views of the selected drawings in the open drawing.
Tekla Structures does not copy the drawing layout.

• Link with layout: Display the views and the layout of the selected
drawings in the open drawing.

NOTE The changes of the original views are also shown in the linked views. If
you modify the linked views, the changes will be lost, for example,
when you save the model. Do all the modifications in the original view.

Move drawing views to another drawing
Note that if something changes in the detail in the source drawing, the detail
view will be updated in the target drawing. If something changes in the
section, the section view in the target drawing will not be updated.

TIP General arrangement drawings are often full of information. You may
want to create empty general arrangement drawings and move detail or
section views from the original general arrangement drawings to the
empty drawing.

1. In an open drawing, select the frame of the drawing view you want to
move.

2. Right-click and select Move to drawing from the pop-up menu.
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3. Select the target drawing from Document manager. 

You can select additional drawing views after you have started the Move
to drawing command and move multiple drawing views in one go. If you
have multiple drawing views selected before starting the Move to
drawing command, the command will not be available.

4. Click Move in the Move view to drawing dialog box.

5. Close and save the source drawing. 

Tekla Structures moves the selected view to the target drawing and
creates references between the source and target drawings.

6. Open the target drawing from the Document manager. 

The Document manager indicates that the drawing has been updated.

7. Arrange the drawing views, if necessary. For more information, seeModify,
arrange and align drawing views (page 189).

8. Save the target drawing.

Example

In this example, we have two drawings on the Document manager: BEAM1
and BEAM2.

We move section view C-C from drawing BEAM1 to BEAM2. Below is the original
section view in the source drawing BEAM1.

We move this view to drawing BEAM2 according to the instructions above.
Below is the moved section view in the target drawing BEAM2. The view label
name contains the name of the source drawing BEAM1.
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In the source drawing BEAM1, the section mark of the moved section view
contains a reference to the target drawing BEAM2.

TIP You can use the following advanced options to set the reference text for
section view labels:

XS_SECTION_VIEW_REFERENCE

XS_SECTION_SYMBOL_REFERENCE

XS_DETAIL_VIEW_REFERENCE

XS_DETAIL_SYMBOL_REFERENCE

Show and modify drawing views in the model
You can show the drawing views of the selected drawings in any of the open
model views to get a clearer understanding of exactly where a drawing view is
located in the 3D model, the view direction, and the 3D extents of that view.
You can then modify the drawing views in the model and save your changes to
the drawing.
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Show and modify drawing views in the model
1. In the modeling mode, click Drawings & reports --> Document manager

to open Document manager.

2. Select one or more drawings in the document list.

3. Click the Show drawing views in the model button in the top-right
corner of the Document manager window. 

The button changes color: 

Tekla Structures shows the views of the selected drawings in the model.

You can drag the drawing view edges, corners, or faces, or the view plane
edges, and modify the views using direct modification.

When Show drawing views in the model is active, and you select
another drawing or set of drawings, Tekla Structures automatically
updates the model view and the drawing views in it. This way you can
easily walk through a list of drawings, selecting one drawing at a time, and
see the views of that drawing in the model.
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4. To show the name of a drawing view in the model, move the mouse
pointer over an unselected view edge, or select the drawing view. 

Tekla Structures displays a view label:

5. To show the direct modification handles and dimensions of a drawing
view, select the drawing view. 

Tekla Structures shows the view width and height, and depth above and
below the view plane.

The direction of the selected drawing view is shown by open arrows on
the four edges of the view plane.
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Work with drawing views in the model
Note that when working with the drawing views, you first need to select the
desired drawing view in the model.

To Do this
Select a drawing view in the model Click the drawing view in the model

view, or select it from the list on the
contextual toolbar.

When you select one drawing view, all
other drawing views are hidden in the
model.

Deselect a drawing view Hold down Ctrl and click an edge of
the selected view.

Increase or decrease the view extents • Drag the edges, corners, or faces
of the drawing view, or the edges
of the view plane.

• Drag the direct modification
handles, or view dimension arrows
to change the view size.

• You can also enter a new value in
the dimension value box to
change the view size.

Note that you can override the
current snap switches by holding
down Shift while dragging.

Create clip planes
On the contextual toolbar, click 
Clipping around selected view
bounding box on/off.

Tekla Structures creates six clip
planes that are aligned with the
drawing view extents. The selected
drawing view is isolated and
highlighted and the rest of the model
is hidden.
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To Do this
When you modify the drawing view,
the clip planes are automatically
adjusted to keep their alignment to
the view extents.

You can also use drawing snapshot
overlays (page 159) with the Show
drawing views in the model
command and the clip planes mode
to isolate the view.

Emphasize objects intersecting the
view bounding box On the contextual toolbar, click 

Emphasize objects intersecting the
view bounding box on/off.

Every object that roughly intersects
the drawing view is colored red, and
every object that roughly does not
intersect is made semi-transparent.

Create a temporary model view of the
selected drawing view On the contextual toolbar, click 

Display selected view as a new
model view.

This creates a new temporary model
view based on the properties of the
current model view, and sets the
camera direction of the new model
view to match the camera direction of
the selected drawing view.

Set the selected drawing view’s
camera direction to match the
camera direction of the current
model view

On the contextual toolbar, click 
Change view angle in selected
views to match current model
view.

The view angle of the drawing view
changes to match the view angle of
the current model view.

Reverse the drawing view camera
direction On the contextual toolbar, click 

Reverse view direction.

The direction of the selected drawing
view is shown by open arrows on the
four edges of the view plane.

Move or rotate the drawing view 1. On the contextual toolbar, click

 Show rotation handles to
display direct modification

Edit drawings 185 Create and modify drawing views



To Do this
rotation handles of the drawing
view.

The rotation handles are hidden
by default.

2. Move or rotate the drawing view
using the direct modification axis
and rotation handles.

Save any drawing view changes to the
drawings On the contextual toolbar, click 

Update drawing, or click the middle
mouse button.

Drawing view changes are only saved
when you click the Update drawing
button or the middle mouse button.
You can edit a drawing view, then
select a different drawing view in the
model and edit that, and keep going
and then click Update drawing.

Discard any drawing view changes
On the contextual toolbar, click 
Discard changes.

Any drawing view changes that have
not been saved are discarded.

Stop showing drawing views in the
model

Press Esc or right-click and select
Interrupt. If you have made changes
but have not saved them, you are
asked to save the changes or discard
them.
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Examples of drawing views in the model
A drawing view is selected in the model:

The Clipping around selected view bounding box on/off command has
been used to isolate the view:
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Clip planes have been created in the drawing view of a plan drawing:

Drawing snapshot overlays are used with the Show drawing views in the
model command and the clip planes mode to isolate the view:
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Modify, arrange and align drawing views

Resize the drawing view boundary
The view boundary or view restriction box is the dashed frame around the
contents of a drawing view, which becomes visible when you click the view
frame. You can resize the view boundary, for example, to show just a specific
part of the view contents.

When you select a view, the view boundary is highlighted also in other views.
When you change the selected view's boundary in the other views using view
boundary handles, the change can be seen in the view boundary of the
selected view. This way you can easily adjust the section view plane and view
depth, and you do not need to go to the view properties to do this.

1. Click the view frame.

2. Click one of the handles on the view boundary.

3. Drag the handles along the x or y axis of the view. 

When the view boundary changes size, the view frame adjusts with the
new boundary size.

For more information about visualizing views in other views, see the
following advanced options:

• XS_VISUALIZE_VIEW_IN_ANOTHER_VIEWS

• XS_VISUALIZE_VIEW_IN_FATHER_VIEW_ONLY
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(1) View boundary handle

(2) View boundary

(3) View frame

(4) Resized view boundary and view

Example

In the example below, the section view in the bottom-left corner has been
selected, and the view boundary is highlighted in two other views. You can
change the view boundary of the selected view in the other views by dragging
the view boundary handles, to change the section view depth, for example.
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Drag drawing views
You can move drawing views by dragging.

1. Click the view frame. 
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2. Hold down the left mouse button and drag the view to a new location. 

The view follows the cursor while you drag the view, which makes it easier
to follow the view movement.

NOTE When you drag a view, its placing setting may change to Fixed depending on
what is set for the advanced option XS_CHANGE_DRAGGED_VIEWS_TO_FIXED .
This advanced option is by default set to TRUE, which means that the placing
setting changes to Fixed when the view is dragged.

Rotate drawing views
You can rotate the drawing views in open drawings.

1. In an open drawing, click the frame of the drawing view you want to
rotate.

2. On the Views tab on the ribbon, click Rotate view.

3. Enter the angle in degrees, for example, 90 or -90, in the displayed dialog
box and click Rotate.

Align drawing views
You can align views vertically or horizontally.

1. Select a drawing view in an open drawing, then right-click to display the
pop-up menu.

2. Select Align vertically from the pop-up menu.

3. Pick a point in the selected view.

4. Pick a point in the view with which you want to align the selected view. 
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Tekla Structures moves the views so that the picked points line up
vertically.

You can align the selected drawing view horizontally by selecting the Align
horizontally command from the pop-up menu.

Arrange drawing views
You can fit the drawing views so that they include all connected objects, and
rearrange the drawing views using the drawing's current layout properties.

• On the Views tab, click Arrange.

NOTE • Arrange views only affects views where the Place option is set to
Free in the view properties. Fixed views are not moved.

• If you have set XS_CHANGE_DRAGGED_VIEWS_TO_FIXED to TRUE
(default) and drag a view in a drawing, the view becomes fixed, and
the Arrange views command does not work

• Arrange views may change the drawing size if you have used
automatic scaling of drawing views.

Modify drawing view properties
You can modify view properties in the final drawing view by view or in selected
views.

1. Do one of the following: 
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• If you want to modify the properties in several views, hold down Ctrl,
click the view frames of the views you want to modify, and on the
Drawing tab, click Properties --> View.

• To modify the properties of one view, double-click the view frame.

2. Modify the view properties as required. 

For example, change the view Scale.

3. Click Modify.

4. If there are some object level settings that you want to apply, click the Edit
settings... button and load the object settings that you want to use. Click
Modify. For more information about drawing view properties, see View
properties in drawings (page 920).

Add single-part views in assembly drawings
In addition to automatically including single-part views in assembly drawings
through drawing properties, you can also add single-part drawing views in an
open assembly drawing.

1. Open the assembly drawing.

2. In the drawing view, select the parts of which you want to create a single-
part view.

3. Right-click and select Create single-part views.

Tekla Structures adds the single-part views to the assembly drawing using the
current properties in Assembly Drawing Properties ( Drawing properties -->
Assembly drawing --> Layout --> Other --> Single-part attributes ).

See also

XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS

Include single-part drawings in assembly drawings (page 695)

4.8 Manual dimensioning
In addition to the automatically created dimensions defined in the drawing
properties of the created drawings, Tekla Structures contains several tools for
modifying dimensions and for adding new dimensions in an open drawing.

Add manual dimensions

You can add manual dimensions to drawings:

Add manual dimensions (page 195)

Add manual dimensions using User Coordinate System (page 202)
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Add dual dimensions manually (page 209)

Recreate dimensions for all parts (page 211)

Add manual dimensions to general arrangement drawings (page 201)

Add dimensions to reinforcement (page 211)

Dimension rebars with Rebar group dimensioning application (page 221)

Dimension center of gravity (COG) (page 252)

Add closing dimensions (page 263)

Add or remove dimension points (page 264)

Modify dimensions

You can modify dimensions manually:

Modify dimension properties (page 257)

Control dimension tag content (page 204)

Drag dimension marks (page 275)

Move the end of the dimension line (page 276)

Exaggerate selected dimensions in drawings (page 256)

Add dimension points in anchor bolt plans (page 259)

Show plate side marks on dimension leader lines (page 260)

Change the location of short outside dimension texts (page 261)

Set a new dimension start point (page 262)

Link perpendicular dimension lines (page 271)

Combine dimension lines (page 271)

See also

Dimension and dimensioning properties (page 928)

Dimension properties - Marks and Tags tabs (page 936)

Define dimensioning (page 724)

Add manual dimensions
In addition to automatic dimensions, you can add dimensions manually in an
open drawing. Manual dimensions are not recommended to be used in 3D
views.

1. Hold down Shift and, on the Dimensioning tab, click one of the
dimensioning buttons depending on the type of dimension you want to
create: 
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 Horizontal: Create a dimension in the x direction by picking the
points to be dimensioned. X depends on the current UCS.

 Vertical: Create a dimension in the y direction by picking the points
to be dimensioned. Y depends on the current UCS.

 Perpendicular: Create a dimension perpendicular to a line you
define by picking two points to set the direction of the dimension line, and
then picking the points to be dimensioned.

Orthogonal: Create a dimension in either the x or y direction by
picking the points to be dimensioned. Tekla Structures uses the direction
of the larger overall distance. X and y depend on the current UCS.

Curved dimension, orthogonal reference lines: Create curved
dimension with orthogonal reference lines by picking three points to
define the arc and then picking the points to be dimensioned. The
dimension text on the line can be either a distance or an angle value.

 Curved dimension, radial reference lines: Create curved
dimension with radial reference lines by picking three points to define the
arc and then picking the points to be dimensioned. The dimension text on
the line can be either a distance or an angle value.

Free: Create a dimension parallel to a line between any two points
you pick.

 COG: Indicate the location of the center of gravity (COG) in single-
part, assembly, and cast unit drawings by creating COG dimensions and
adding a COG symbol at the center of gravity. You can also create COG
dimensions in section views.

Parallel: Create a dimension parallel to a line you define by first
picking two points to define the direction of the dimension line and then
picking the points to be dimensioned.

 Radial: Create radial dimension by picking three points to define the
arc and pick a position for the dimension.

 Angular: Create angular dimension by picking the vertex point and
two points to define the angle. Pick the side to place the dimension.
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2. Modify the dimension properties in the properties dialog box.

3. Add the desired elements in dimension marks and modify their
properties.

4. Add dimension tags with the desired elements as required, and set the
dimension tag rotation. 

You can also include part count to dimension tags and select a filter that
removes the desired default content from the tag.

The available dimension mark and dimension tag mark elements are the
same as those for the part, bolt, reinforcement and surface treatment
marks.

5. Click OK or Apply.

6. Add the dimensions by following the instructions on the status bar. 

It is very important to use correct snap switches to get the dimensions
correct. You can change the switch temporarily by right-clicking and
selecting the switch that suits the best for your purpose.

In dimension types where you click the middle mouse button to place the
dimension line, the placement setting affects the result. If you have set
Placing to fixed, the position you click will be the location of the
dimension line. If you have set Placing to free, the middle mouse button
click defines which side of the object the dimension line is located on, and
Tekla Structures places the dimension line.

7. Drag the dimensions to the desired locations. 

When you drag the dimensions, the Placing setting changes to fixed by
default.

You can also drag the dimension mark, and when you drag it, a leader line
is automatically created.
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Examples of manual dimensions

Command Example
Add parallel dimension

(1) Shows the edge points picked for
defining the direction for the parallel
dimension line.

(2) Shows the dimension points
picked.

Same part as before, now
dimensioned with Add

perpendicular dimension 

(1) Shows the edge points picked for
defining the direction for the
perpendicular dimension line.

(2) Shows the dimension points
picked.
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Command Example
Add curved dimension with
orthogonal reference lines

The dimension text on the line is a
distance value.

If the ends of a curved beam or
polybeam have been cut or fitted, the
points at the ends of the beam do not
necessarily lie on the true curve of the
beam. This is because curved beams
are created with straight segments.
The points are indicated with (2).

To avoid creating incorrect curved
dimensions, pick the three points
defining the arc using three of the
points indicated with (1) .

Use end point snap.
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Command Example
Add curved dimension with radial
reference lines

Curved set to Distance.

The dimension text on the line is a
distance value.

Add curved dimension with radial
reference lines

Curved set to Angle.

The dimension text on the line is an
angle value.

Add angular dimension

Angle set to Degrees at angle
vertex.
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Command Example
Add angular dimension

Angle set to Degrees on side

Add angular dimension

Angle set to Triangle.

Triangle base length set to 100
Add radial dimension

See also

Define object protection and placement settings in drawings (page 677)

Modify dimension properties (page 257)

Dimension and dimensioning properties (page 928)

Change the prefix in radial dimensions (page 802)

Control dimension tag content (page 204)

Mark elements (page 971)
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Add manual dimensions to general arrangement drawings
You can dimension parts to grids along their X, Y, or X and Y axis and along
grid lines in general arrangement drawing plan views.

Limitation: Parts like beams that are not located along the grids are not
dimensioned.

1. Open a general arrangement drawing.

2. To check and change the dimension properties, on the Drawing tab, click
Properties --> Dimension , make the necessary changes and click Apply
or OK.

3. On the Dimensioning tab, click GA dimensions and the click one of the
following commands: 

• To dimension along grid lines, click Add dimensions along grid lines
and pick the view in the location where you want to create the
dimensions.

• To dimension along part X or Y axis or both, select the part, and click
Along part X axis, Along part Y axis or Along part X and Y axis. The
parts are dimensioned to the two nearest grids.

Tekla Structures creates the dimensions according to the dimension
properties you defined in the Dimension Properties dialog box.

For instructions on how to dimension reinforcement in GA drawings, see Add
dimensions to reinforcement (page 211).

See also

Modify dimension properties (page 257)

Add manual dimensions using User Coordinate System
You can pick UCS (user coordinate system) points to define the current
coordinate system in the drawing view. If you do this, the dimensioning

commands Horizontal , Vertical  and Orthogonal  follow the
defined coordinate system.

1. Open a drawing.

2. On the Views tab, click User coordsys --> Set origin by two points.

3. Pick the UCS origin and the UCS X direction. 
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4. Click Dimensioning --> Horizontal .

5. Pick the start and end point for the dimension. 

6. Point to the location where you want to add the dimension line and click
the middle mouse button. 

NOTE When you use the Orthogonal command , it automatically finds out
whether the dimension line is in the X or Y direction depending on which one
is the closest.
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See also

User coordinate system (UCS) (page 555)

Add manual dimensions (page 195)

Control dimension tag content
Tags allow you to display the properties and other related information of the
associated building objects in single dimensions and dimension sets. In
addition to text or property elements, you can include part count, or select a
filter that removes the desired default content from the tag, or control
dimension tag content with associativity rules.

You can define the contents of the dimension tags of the building object
dimensions on the Tags tab of the dimension properties. During the tag
creation process, all building object categories are checked for content
availability, and the properties in the first found category that has content are
read and displayed in the tag. If you do not want to display tag contents for
some building objects, you can create an appropriate exclusion filter for this
building object type, or select the desired tag content from the associativity
rule list. This means that you can display properties related to any associated
object regardless of its type and order in the hierarchy.

The reading order of building object content categories:

1. Surface treatment

2. Bolt

3. Rebar

4. Part/Pour object

Limitations:

• Rotation is not available for the middle dimension tags.

• The dimension tags are automatically updated according to model
changes, when you update the drawing. If you want to disable the
automatic update, you can freeze the drawing or set the advanced option
to FALSE. This advanced option affects all drawings.

Add tags to dimensions
1. Double-click the dimension.

2. Go to the Tags tab and select the locations where you want to add
dimension tags. 
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You can add dimension tags above and below the dimension line to the
left and right end of the line, to the dimension line ends, and in the middle
of the dimension line below the line.

3. Click the ... buttons to go to the Tag Mark Properties dialog box. 

You can also enter text directly in the A - G boxes.

4. Select the tag rotation. Each tag has an independent rotation setting, so
you can rotate some tags and leave others unrotated. 

• Parallel to dimension line does not rotate the tag. This is the default
value.

• Perpendicular to dimension line rotates the tag.

5. Include the elements that you want in the dimension tag. 

The available elements are the same as those of the part, bolt,
reinforcement and surface treatment marks.

6. Select the element frame type and color and the text color, font, and
height.

7. Click OK.

8. If you want to show the part count in the tag, set Include part count in
the tag to Yes.

9. Use Exclude parts according to filter and select a predefined filter to
remove some of the automatically created tag content. 

In addition to the user-selectable elements, some of the dimension tag
content is automatically created based on the dimension end point
locations. If you want to exclude unnecessary tag content for parts that
are located in the same location as the dimensioning point, create
suitable drawing view filter.

10. If you are adding tags to curved dimensions, you can select the tag type in
Curved Dimension Tag Type.

11. Click Modify.

Example

Below is an example of dimension tags.
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Below is an example of an unrotated and rotated dimension tags.

Example: How to filter out dimension tag content
In this example, you will remove from a dimension tag some content that is
added in the tag automatically based on the dimension end point locations.
First you will create a drawing view filter that you will use for removing the
content.

The example below shows a tag that automatically contains the text "CORBEL".
You will remove this text.

1. Open a drawing.

2. Double-click the view frame to open the View Properties dialog box.

3. Double-click Filter... to open the View Filter Properties dialog box.
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4. Click Add row and create a filter according to the example below. 

5. Enter concrete as the name of the filter in the box next to the Save as
button and click the button to save the filter.

6. Click Cancel to close the dialog box.

7. In the drawing, double-click the dimension that contains the content that
you want to remove. 

The Dimension Properties dialog box is displayed.

8. Go to the Tags tab.

9. In Exclude parts according to filter, select the concrete filter.

10. Click Modify. 
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Tekla Structures removes the text "CORBEL" from the dimension tag. The
material type of corbel is concrete, and the concrete filter removes all
concrete parts from the tag.

Control dimension tag content with associativity rules
Dimension tag content can also be controlled using associativity rules.
Selecting the right associativity rules helps you to easily select objects that
need to be shown in the tags and set up dimension tags, without having to
create complex exclusion filters. Only attributes that correspond to the
selected objects will be shown in the tags.

This is especially helpful in conflict situations when dimension points might
not be associated with the desired objects, because there are other objects in
the same dimension point location.

To adjust dimension tag content:

1. In an open drawing, right-click a dimension whose tags you want to
modify.

2. In the context menu, select Show dimension associativity rules, and
then select the objects that you want to show in the dimension tag. 

The objects that are not selected from the associativity rule list are
immediately filtered out from the tag.

Example:

Properties that correspond to all dimensioned objects are shown in the
tag:
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After selecting the appropriate objects from the associativity rule list, the
objects that are not selected are immediately filtered out from the tag.

Limitations

There are some hard-coded filtering rules in the dimension tag code that you
should keep in mind:

• The main part properties are always filtered out if the dimension is
associated to the main part and secondary parts.

Example: You create a dimension that is connected to a number of
embeds (secondary parts) and a main part. Then the marks are displayed
from the embeds (secondary parts), and the main part is filtered out
automatically.

• The attributes of sub-assembly secondary parts are always filtered out.
Instead, the attributes of sub-assembly main parts are shown.

Example: You create a dimension that is connected to embeds. All embed
sub parts need to be filtered out. In addition, if the embed main parts are
not in the array, then they are added to this array.

Add dual dimensions manually
In dual dimensions, you can show dimensions in different units and format
above and below the dimension line.
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You can add dual dimension automatically (page 795), or manually in an
existing drawing.

To add dual dimensions manually:

1. On the File menu, click Settings --> Options , and go to the Drawing
dimensions settings.

2. Set the unit, formats and precision, and activate the dual dimensions for
the drawing types you want in Dimensions in tags.

3. Click OK.

4. Double-click a dimension in your drawing.

5. Go to the Tags tab, and enter the text DIMENSION in the middle
dimension tag. 

6. Click Modify.

7. If you do not want to show dual dimensions in all dimensions, you can
manually delete the text DIMENSION from the tag.

Example

Below is an example of dual dimensions that use the unit mm and format
###.
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See also

Modify dimension properties (page 257)

Dimension properties - Marks and Tags tabs (page 936)

Recreate dimensions for all parts
You can recreate the dimensions that were originally created for the parts in
the drawing.

1. In an open drawing, double-click a drawing view frame to open view
properties, click Attributes, go to the Attributes 2 tab, and check that
you have set Dimension creation method in this view to Automatically
in the drawing view properties. 

Tekla Structures only dimensions parts in views where this setting is set to
Automatically.

2. On the Dimensioning tab on the ribbon, click Recreate all dimensions. 

Tekla Structures re-dimensions all views except linked, 3D and key plan
views, and removes all manually created dimensions.

See also

Add manual dimensions (page 195)

View properties in drawings (page 920)

Add dimensions to reinforcement
You can manually add dimension lines and dimension marks to reinforcing bar
groups.

Each reinforcing bar group may have dimension marks without tags, tagged
dimension marks, distributed dimension lines, or variants of these styles. The
dimensions are created based on dimension properties defined in the Rebar
dimension mark properties dialog box (page 939). The command for creating
the rebar dimension marks is available in GA drawings and cast unit drawings.

The Rebar dimension mark properties dialog box is introduced in Tekla
Structures 2020 SP2.

• You may want to add reinforcement dimension marks or tagged dimension
marks especially in concrete cast unit drawings, where there is only one
reinforced cast unit visible.

• The dimension lines or distribution lines show the distribution of the
rebars in the group, and typically draw dashed lines from the dimension
lines to the rebars when you drag the dimension outside the rebar group.
You may want to use distribution lines especially in GA reinforcement
drawings, because they may contain a lot of parts with rebar groups, and
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you often need to show only one rebar from the group and drag the
dimension line to a proper place to see everything clearly.

• When adding dimensions, start by using predefined dimension settings
defined in your own environment, and modify these settings for individual
dimensions, if necessary.

The Default environment contains the following rebar dimension settings files
to be loaded in the Rebar dimension mark properties dialog box:

• rebar_dimension_line for creating distribution lines

• rebar_dimension_mark for creating dimension marks

• rebar_tagged_dimension_mark for creating tagged dimension marks

For more information about typical settings, see section "Typical dimension
mark, tagged dimension mark, and dimension line settings" below.

In addition to the rebar dimensioning methods described below, you can also
dimension rebars by using the Rebar group dimensioning application, see
Dimension rebars with Rebar group dimensioning application (page 221).

Add dimensions to rebar groups
To add dimension marks, tagged dimension marks or dimension lines to rebar
groups:

1. First open the dimension properties by pressing down Shift and clicking
the Rebar command on the Dimensioning ribbon tab.

2. Load one of the predefined rebar dimension settings, or go through the
properties on the various tabs in the Rebar dimension mark properties
dialog box (page 939), and see if you want to modify something.

3. Click Apply.

4. Select a reinforcement in the drawing.

5. If you had selected fixed (default) as the Placing option in rebar
dimension properties, you will be asked to pick a position. 

The rebar dimension is created. You can continue picking more
reinforcing bar groups, or stop creating rebar dimension by pressing Esc
on the keyboard.

TIP You can also add rebar dimension marks with the Add Mark -->
Dimension Mark command on the context menu, or with the Add
rebar dimension mark command in Quick Launch. You can also
create a keyboard shortcut for the command.

Below is an example of dimension marks:
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Below is an example of tagged dimension marks:

Below is an example of dimension lines:

Below is an example of the dimension line when it has been dragged
outside the reinforcing bar group:
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Below is an example, where only one rebar of the group is visible, and the
dimension line has been dragged outside the group.

You can change the representation of the current rebar dimension after
creating it by double-clicking the rebar dimension in an open drawing, and
modifying the dimension properties as required. For example, you may want
to add more tags, change dimension mark content, or select how to align tags
in curved dimensions.

Note that you cannot change the following properties when you have a
drawing open and you are editing a rebar dimension mark:

Dimension to

Part edge

Tapered dimension type

Curved dimension type
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Placing rebar dimensions

During manual dimension creation the Placing setting is considered as
follows:

• If you have selected more than one rebar object, the Dimension Mark
command ignores the fixed option and automatically places the rebar
dimension mark for each selected rebar object.

• If you have selected only one rebar object, and Placing is set to fixed, you
will be prompted to pick a position for the dimension.

• If you have selected only one rebar object, and Placing is set to free, the
dimension will be placed automatically.

• With the Rebar command on the ribbon, you can create rebar dimension
marks without selecting a rebar object first. In this case, you will be
prompted to pick a rebar object:

• If Placing is set to fixed, you will be prompted to pick a position for the
dimension, and if Placing is set to free, the dimension will be placed
automatically.

• After the dimension has been placed either manually or automatically,
you will be prompted to pick another rebar object.

Typical dimension mark, tagged dimension mark, and dimension line
settings

rebar_dimension_mark.rdim
Dimension to: All rebars

Subgrouping: Yes

Extension line to visible rebar: No

Combine equal dimensions: 3*60=180

Minimum number to combine: 1

Set Prefix in Dimension mark content.

Set Visibility of numeric value to Hidden in Dimension mark content.

rebar_tagged_dimension_mark.rdim
Dimension to: All rebars

Subgrouping: Yes

Extension line to visible rebar: No

Combine equal dimensions: 3*60=180

Minimum number to combine: 1

Set the appropriate tag contents.

Edit drawings 215 Manual dimensioning



rebar_dimension_line.rdim
Dimension to: Start and end rebars

Subgrouping: No

Extension line to visible rebar: Yes

Combine equal dimensions: Off

Create dimension marks to all rebars
You can add dimension marks to all rebars at one go with the Create
dimension marks to all rebars application. This application creates any type
of rebar dimension mark.

1. Open a drawing with rebars.

2. To open rebar dimension properties, select Drawing --> Properties -->
Rebar dimension mark on the ribbon.

3. Adjust the properties if necessary and click Apply.

4. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

5. Search for the Create dimension marks to all rebars application, and
double-click the application.

Rebar dimension marks are created for all rebars according to the defined
rebar dimension mark properties.

Examples of rebar dimensions

• Below is a tapered skewed part, and the dimension line follows the shape
of the edge that is closest to where you pick. The dimensions have skewed
representation.
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• Below is a tapered curved part, and the dimensions have curved
representation.
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• Below is an example of curved orthogonal dimensions of a tapered curved
rebar group with a dimension tag:

• You can also add middle tags in rebar dimensions. Here dual dimensions
(page 209) have been applied:
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• Curved dimension tags can be aligned by selecting one of the options in
the Curved Dimension Tag Type list in the Dimension Properties dialog
box:

In the example below, only one rebar is visible, and rebar tags are aligned

vertically :
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In the example below, the dimension tag follows the dimension curve

:
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• Below is an example of curved orthogonal dimensions of a radial
reinforcing bar group.

Dimension rebars with Rebar group dimensioning
application
The Rebar group dimensioning application offers different styles for
presenting rebar group dimension lines and dimension marks flexibly. For
example, you can mark and dimension multiple stirrups at one go. The Rebar
group dimensioning helps you to efficiently create quality reinforcement
drawings according to the market requirements.

Add dimensions to rebar groups
1. In a drawing, select the rebar groups to be dimensioned.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. In the Applications list, select Rebar group dimensioning.

5. Pick a location for the dimension line in the model.

6. Double-click the dimension to adjust the settings: 

• On the Parameters tab, define what the dimensions look like and
what it contains. You can also define the content of the stirrup
dimension marks.

• On the Extra marks in front and Extra marks behind tabs, create an
extra mark in front of or behind the dimension line.

• On the Advanced settings tab, define the offsets, spaces and cc
distances for the stirrup dimension marks.
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• On the Rebar lines tab, define the generation and the appearance of
the leader lines belonging to the stirrup dimensions.

For more information about the settings, see Rebar group dimensioning
settings below.

7. Click Modify.

Rebar group dimensioning settings

Parameters tab

Setting Options and descriptions
Annotation type Select the annotation type. The options are:
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Setting Options and descriptions

Define the positioning of the mark. The available
options depend on the selected Annotation type
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Setting Options and descriptions
Angle option. You can also define the mark angle in the

Angle box. The options are:
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Setting Options and descriptions

Mark position examples:
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Setting Options and descriptions

In the example below, the mark angle has been
defined.
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Setting Options and descriptions

Group number

Define the number and the location of the mark
leader lines. You can also indicate which group you
are working with by entering the group number in
the Group number box.

This option is available for certain annotation types
only. The options are:
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Setting Options and descriptions

In the following example, group number 2 is
defined.

In the following example, group number 2 is
defined.
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Setting Options and descriptions

Consider irregular
spaces as separate
groups

Yes

No

Dimension each CC
distance

Yes

No

Combine dim. between
rebar - dim.

Allows you to combine the dimensions of the
distance between two rebar groups with the
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Setting Options and descriptions
dimensions of the rebar group where the spacing
is the same as the distance between the groups. It
also combines the first/last group dimension line
with the distance to the part end if the distance to
the border is the same as the rebar group spacing.

For an example, see the section "More examples"
below.

Distribution line
properties

Select the desired dimension properties for the
displayed dimension line by selecting a dimension
properties file. The available properties are the
ones that have been defined and saved in
Dimension Properties (page 928).

Available elements Select the information to be displayed in the mark
such as grade, diameter and cc distances for mark
1 and mark 2.

Elements in mark List of the information that you have selected to
display in mark 1 and mark 2.

Text properties Define the text properties. The available properties
files are the ones that have been defined and
saved in Text properties (page 320).

Position Select where you want to place the mark. The
options are:

• Automatic: Mark 1 is positioned above the
dimension text, when the dimension is above
the part, and under the dimension text when
the dimension is under the part.

• Above dim. text: Mark 1 is always positioned
above the dimension text.

• Below dim. line: Mark 1 is always positioned
below the dimension text.

When placing the mark, the dimension text font
size for the above text position and the spacing
values defined on the Advanced settings tab for
both positions are considered. This setting is only
available for the non-radial annotation types.

Units Define the units:

• Automatic

• mm

• cm

• m

• foot - inch
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Setting Options and descriptions
• inch

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Format Define the format:

• ###

• ###[.#]

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Precision Define the precision:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16
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Setting Options and descriptions
• 1/32

• 1/10

• 1/100

• 1/1000

For example, for precision 0.33, the actual value
50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Sum values A B C

Sum segm rebar axis

Length TplEd

These options are only available for the following
mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target
Mark 2 position Define whether and how the rebar position is

displayed in mark 2. The options are:

Not

Before main mark

Behind main mark

Above main mark

Below main mark
Mark 2 frame Select the frame type and color for the mark 2.

This option is available for certain annotation types
only. The options are:
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Setting Options and descriptions

Extra marks in front and Extra marks behind tabs

Setting Options and descriptions
Marks in front of the
dimension line

To create marks in front of the dimension line,
select Yes. No is the default value.

Marks behind the
dimension line

To create marks behind the dimension line, select
Yes. No is the default value.

Available elements Select the information to be displayed in the mark
in front of or behind the dimensions line.

Elements in mark List of the information that you have selected to
display in the mark in front of or behind the
dimensions line.

Text properties Define the text properties for the marks. The
available properties files are the ones that have
been defined and saved in Text properties
(page 320).

Position Define whether and how the rebar position is
displayed in marks. The options are:

No

Before main mark

Behind main mark
Text properties Define the text properties for the rebar position.

The available properties files are the ones that
have been defined and saved in Text properties
(page 320).

Number Select how to show the number of rebars. The
options are:

Total number in rebar group

Number displayed in view

Total number in drawing
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Setting Options and descriptions
Total number in cast unit

These options are only available for the Number
element.

Units Define the units:

• Automatic

• mm

• cm

• m

• foot - inch

• inch

Only available for the following

content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Format Define the format:

• ###

• ###[.#]

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max
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Setting Options and descriptions
• cc exact

• cc target

• Length itemized
Precision Define the precision:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16

• 1/32

• 1/10

• 1/100

• 1/1000

For example, for precision 0.33, the actual value
50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Sum values A B C

Sum segm rebar axis

Length TplEd

These options are only available for the following
mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target
Mark placement settings

The options 3 is the default option.
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Setting Options and descriptions

(1) All the marks are placed above the dimension
line.

(2) The middle of the last mark is on the the
dimension line.

(3) The middle (calculated in the dir. - to the
dimension line) of the mark group is on the
dimension line. This is the default option.

(4) The dimension line is extended between the
marks.

• If there is only one mark, it is placed above the
line.

• If there are two marks, one mark is placed
above and the other under the line.

• If there are three marks, two marks are placed
above and one mark is placed under the line.

(5) The middle of the first mark is on the dimension
line.

(6) All marks are placed under the dimension line.
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Setting Options and descriptions
The parameters a, b, c1 and c2 are needed to get
the desired distances between the marks and the
dimension line.

The default values are:

a = 1

b = 1

c1 = 5

c2 = 5

Advanced settings tab

Setting Options and descriptions
First mark spacing Enter a millimeter value to indicate the space

between the dimension line and the first line of
dimension mark text.

You can also define the first mark distance when
the label is below the dimension line.
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Setting Options and descriptions
Space between Mark1
and Mark2

Define the space between mark 1 and mark 2

Free space below text /
Dimension line spacing

If you select Free space below text, enter a
millimeter value to indicate the space between the
last line of dimension mark text and the next
dimension line.

If you select Dimension line spacing and enter a
millimeter value to indicate the space between two
or more dimension lines.
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Setting Options and descriptions
Text offset dimension
line

Group dimensions Control if dimensions are grouped or not.
Grouping also works when the distance between
the groups is zero.

Grouping tolerance Define whether double stirrup groups are
combined into one dimension line.

If the distance between the stirrups (in the image
below 12 mm) is greater than the entered value
(=10 mm), two dimension lines are created:

Group mark spacing Enter a millimeter value to indicate the space
between several lines of dimension mark text.
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Setting Options and descriptions
Part extrema Define how to close the dimension lines on the

contour of the concrete part. The following options
are available:

Examples:

The dimension line is always positioned on the
outermost lines of the concrete part.

The dimension line is positioned to the nearest
side/geometry point of the concrete part relative to
the picked insertion point of the dimension line
(plugin). See the examples below.
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Setting Options and descriptions

Rebar lines tab

On the Rebar lines tab, you can define the generation and the appearance of
the leader lines and symbols of the dimension line. You adjust the settings of
Not visualized rebars, Visualized rebars, Group end rebars and Part edges.

Setting Options and descriptions
Not visualized rebars

Visualized rebars
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Setting Options and descriptions

Group end rebars Applied to the first and last bar in the group.

Part edges

Define the generation of the leader lines and
symbols for the Not visualized rebars or
Visualized rebars. The options are:

No leader lines or symbols.

Edit drawings 242 Manual dimensioning



Setting Options and descriptions

Leader lines. Define the length of the leader lines
relative to the dimension line.

Leader lines and symbols. Define the length of the
leader lines relative to the dimension line.
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Setting Options and descriptions

Leader lines. Define the length of the leader lines
relative to the contour of the concrete part.

Leader lines and symbols. Define the length of the
leader lines relative to the contour of the concrete
part.
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Setting Options and descriptions

Leader lines. Define the length of the leader lines
relative to the rebar.

Leader lines and symbols. Define the length of the
leader lines relative to the rebar.
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Setting Options and descriptions

Symbols only

Define the generation of the leader lines and
symbols for the Part edges.

See the examples for the option Not visualized
rebars above.

The following options are available:
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Setting Options and descriptions
 Define the generation of the leader lines and

symbols for the contour of the concrete part

See the examples for the option Not visualized
rebars above.

The following options are available:

Define the color and the line type for the various
leader line types.

Define whether all leader lines and symbols are
shown for Visualized rebars and if this should be
done for one single rebar only. The following
options are available:
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Setting Options and descriptions

Define the symbol file and symbol number to be
used. You can use existing symbols in Tekla
Structures by selecting a symbol file and a symbol
number. You can also define the color and the size
of the symbol.

Symbols are defined separately for Not visualized
rebars, Visualized rebars, Group end rebars and
Part edges

Examples:
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Setting Options and descriptions
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More examples
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Example of the setting Combine dim. between rebar - dim. on the
Parameters tab

• In the example below, the first dimension from the top shows the rebar
groups (blue color) with the distances between the groups (green color)
plus the distances to the part ends (grey color). Dimensions are not
combined.

• The second dimension shows the same situation with marked equalities
between the drawing rebar group spacing (cc) and the distances between
the groups.

• In the third dimension, the new combining type Consider same spacings
has been applied. The green distances between the two blue rebar groups
have been combined with the group that has the same spacing (cc) as the
distance between the groups.

• The combining has also been applied to the gray distance to the part end
because the distance to the part end is the same as the spacing (cc) of the
adjacent rebar group.
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Dimension center of gravity (COG)
You can indicate the location of the center of gravity (COG) in single-part,
assembly, and cast unit drawings by creating COG dimensions and a COG
symbol at the center of gravity. You can also create COG dimensions in section
views. COG dimensions will be automatically updated if the single part,
assembly, or cast unit changes. The COG dimensions can also be cloned.

Limitations:

• If you copy or link a drawing containing COG dimensions to another
drawing, such as a multidrawing, the COG dimensions will not be copied.

• You cannot create COG dimensions in general arrangement drawings or
multidrawings.

1. On the Dimensioning tab in an open drawing, click COG .

2. Modify the options as required: 
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• In Create, select Symbol to see only the COG symbol, or Dimensions
to see only COG dimensions. To see both, select Both.

• In Dimensioning, select to create Horizontal or Vertical dimensions,
or Both.

• In Dimension attributes, you can load predefined dimension settings.

The appearance settings (size, color, etc.) of the COG dimensions are
read from the dimension settings file you load in Dimension
attributes. To create and save dimension settings files, on the
Drawing tab, click Properties --> Dimension. For example, you may
create a special COG dimension settings file to change the color or
arrow type, and load the saved settings in Dimension attributes.

• In Symbol Options, you can change the Symbol file in use by
selecting another symbol file in the list. To change the COG symbol,
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click Select, and select another symbol. To load other symbol settings
from another symbol settings file, select another file from the Symbol
attributes list.

You can access the symbol options only if you have selected Both or
Symbol for Create. The appearance settings (height, color, etc.) of the
symbol are read from the symbol properties file you load in Symbol
attributes.

To create and save symbol settings files, on the Drawing tab, click
Properties --> Symbol . For example, you may create a special COG
symbol settings file to change the color and height of the symbol, and
load the saved settings in Symbol attributes.

3. Click OK.

4. Pick the first point to specify the origin of the dimensions. 
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The origin is the point from which you want to measure the location of the
center of gravity. This point must be located within the view frame.

5. Pick the second point to place the dimensions. 

This point may fall outside the view frame.

The example below shows the created dimensions.
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6. When the dimension is selected, handles are shown at the dimension
origin and the dimension location. You can drag these handles to adjust
the origin or the location, or move them using the standard editing
commands. 

Exaggerate selected dimensions in drawings
You can exaggerate narrow dimensions to make them easier to read by using
the macro Exaggerate selected dimensions. When exaggerated, a dimension
that is narrower than the limit defined in the Options dialog box is enlarged
using the defined scale. If there are many exaggerated dimensions, Tekla
Structures arranges them automatically.

1. Go to On the File menu, click Settings --> Options and go to the Drawing
dimensions page.

2. Set the Exaggeration limit and Exaggeration scaling. 

Exaggeration scaling defines whether you are using Paper or Model as
the exaggeration scaling method. If you select Paper, the exaggeration
limit is multiplied by the view scale. If you select Model, and the scale is
1:10, all the dimensions smaller than 10 mm are exaggerated regardless
of the drawing scale.

3. Click OK to save the settings and close the Options dialog box.

4. In an open drawing, click the dimension that you want to exaggerate.

5. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

6. Click the arrow next to Applications to open the applications list.

7. Double-click Exaggerate selected dimensions. 
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TIP You can also define dimension exaggeration in dimension properties, see Create
exaggerated dimensions (page 800).

Modify dimension properties
You can modify the properties of the dimensions in an open drawing.

1. Double-click a dimension.

2. Modify the dimension type, format, and placing settings. 

For example, here you can set the dimension to be free or fixed. Free lets
Tekla Structures to decide the location and direction of the dimension.
Fixed allows you to place the dimension at any point.

3. Modify the text, line and arrow settings.

4. Modify the dimension mark contents and exaggeration settings. 

Here you can also select whether you want to show plate side marks.

5. Add dimension tags as required, modify font properties, and set the
dimension tag rotation. Here you can also set the dimension prefix and
postfix. 

Here you can also select to include part count to dimension tags and
select a filter that removes the desired default content from the tag.
Additionally, you can select whether you want to show the numeric value.
You can also select the curved dimension tag type to control how the tags
are aligned to the dimension.

6. Click Modify.

See also

Dimension and dimensioning properties (page 928)

Control dimension tag content (page 204)

Add manual dimensions (page 195)
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Add manual dimensions to general arrangement drawings (page 201)

Customize dimension line arrows
If you do not find a suitable dimension line arrow in the Arrow list in the
Dimension Properties dialog box, you can create and use an arrow of your
own.

First you need to create the arrow symbol in the Symbol Editor, and save the
created symbol in the dimension_arrows.sym file. Then you need to add the
position of the new symbol in the dimension_arrows.sym file to the
configuration file dimension_arrows.txt file. This file tells which arrows are
available for use in your environment. Finally, you need to create a bitmap for
the new arrow to be used in the Dimension Properties dialog box.

1. On the File menu, click Editors --> Symbol editor to open the Symbol
Editor.

2. Open the dimension_arrows.sym file located in the Common
environment (...ProgramData\Trimble\TeklaStructures
\<version>\Environments\common\symbols) or in your environment
under the \symbols folder.

3. Click an empty symbol slot and sketch your symbol with drawing tools. 

You can also import AutoCAD or MicroStation files through File -->
Import .

4. When the symbol is completed, point the symbol slot to check the number
of the new symbol at the bottom of the window. 

5. Save the dimension_arrows.sym file by clicking File --> Save .

6. Click File --> Exit to close the Symbol Editor.
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7. Open the dimension_arrows.txt file located in the same symbols
folder as the dimension_arrows.sym file. 

The file contains a list of symbol numbers.

8. Add the number of your symbol preceded by two zeros (00) in the correct
position and separate it with a comma: 

000,001,002,003,004

9. Click File --> Save to save your change.

10. Create a bitmap of the new arrow and save it in the ..\ProgramData
\Trimble\Tekla Structures\<version>\Bitmaps folder on your
computer. 

Use the following naming convention in the file name:
dr_dialog_dim_arrow_type_004.bmp.

11. Finally, restart Tekla Structures.

12. Check that the the new arrow is displayed in the Arrow list: 

• Double-click a dimension in a drawing to open the Dimension
Properties dialog box, and then open the Arrow list. You should see
that the new arrow symbol is available for use.

NOTE We recommend you define a firm folder (page 330) for symbols, because the
default folders are overwritten when you upgrade to a newer version of Tekla
Structures. Add the firm folder to the advanced option DXK_SYMBOLPATH.

See also

Dimension properties - Appearance tab (page 934)

Add dimension points in anchor bolt plans
You can add dimension points to dimensions inside the enlarged views in an
open anchor bolt plan.

Limitations: You cannot create new dimension lines that have dimension
points inside both the enlarged views and the plan view.

To add dimension points to the dimensions inside the enlarged views:

1. Select the enlarged view frame.
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2. Select the dimension to modify.

3. Right-click and select Add Dimension Point.

See also

Create anchor bolt plans using saved settings (page 113)

Example: Dimension anchor bolt plans (page 820)

Show plate side marks on dimension leader lines
You can show plate side marks on dimension leader lines. The plate side
marks indicate whether the dimension point is to the face or center of the
part, for example, a plate, web, or flange.

1. Open a drawing.

2. On the Drawing tab, click Properties --> Dimension.

3. In the Dimension Properties dialog box, go to the Marks tab, set Type
under Plate side marks to SpecifiedSpecified to manually control the
symbol and insert plate side mark symbols in the drawing. 

The option Automatic is available only in intelligent drawings, that is
when the advanced option XS_INTELLIGENT_DRAWING_ALLOWED is set to 
TRUE.

4. Modify the other properties of the plate side marks as required: 

• Select the left and right plate side mark.

• Set the mark size.

• Adjust the mark color.

• Set an offset for the mark from the dimension line.

5. Click Modify.
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See also

Modify dimension properties (page 257)

Dimension properties - Marks and Tags tabs (page 936)

Change the location of short outside dimension texts
If you have selected to place texts of short dimensions outside the dimensions
by setting Short dimensions to Outside on the General tab of the
Dimension Properties, you can select on which side of the extension line the
dimension text is placed.

Limitations:

• You can flip only start or end dimensions in a dimension set.

• You can place the dimension text outside the dimensions if there is enough
space for the dimension text.

1. On the Dimensioning tab, click Flip outside dimension.

2. Click the dimension whose location you want to change.
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See also

Modify dimension properties (page 257)

Set a new dimension start point
You can select a new start point for running dimensions (dimensions that start
from a common start point).

1. Select an existing dimension in a drawing.

2. On the Dimensioning tab, click Set start point.

3. Select the new start point. 

Tekla Structures automatically updates the dimensions.

Example

You can use this command to swap the running dimensions start point to the
opposite end of the member.

When you use the US absolute dimension type, Tekla Structures draws a new
RD symbol (Running Dimension) at the new zero point and updates the
dimensions according to the new start point.
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See also

Modify dimension properties (page 257)

Add closing dimensions
In a drawing containing a reinforcing bar group, you can manually add closing
dimensions to the edge of the part.

1. Open a cast unit drawing.

2. Select the reinforcing bar group dimension line.

3. On the Dimensioning tab, click Add point.

4. Select the points where you want to add the closing dimensions. 

Tekla Structures creates the closing dimensions.
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You can also define closing dimensions in the Dimension Properties by using
the Dimension to part edge setting.

Add or remove dimension points
You can add new dimension points to, or remove existing dimension points
from the selected dimension set. You can only add points to one dimension
line at a time.

1. Select the dimension line.

2. On the Dimensioning tab, click Add point.

3. Click a position on the part where you want to add the dimension point. 

You can add several points.

4. To remove a point, on the Dimensioning tab, click Remove point and
click the point you want to remove. 

You can remove several points in a row.

TIP A quick way to add and remove dimension points is to first click a positions on
the parts where you want to add the dimension points and, if some of them
seem unnecessary, remove those by holding down Shift and then clicking the
points you want to remove.

See also

Modify dimension properties (page 257)

Add closing dimensions (page 263)
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Display and change dimension point associativity
You can change the dimension point associativity to avoid incorrect
associativity, or to simply make the associativity selection distinct. Each
dimension point associativity anchor shows a list of objects that have locations
available for association. You can change the dimension point associativity in
straight dimensions only.

Dimensioning points created in Tekla Structures are associated to the objects
where the dimension points have been added. This allows the dimensions to
update automatically when the objects are changed during modeling.

Sometimes the dimension point locations may be unclear due to orthogonal
projection. A dimension point might be not be associated to the desired object
because there are various other objects in the same point location. In drawing
update or cloning, this may lead to unwanted dimensioning values or
associativity.

It is also possible to associate dimensions to object center lines outside the
object area.

Display and change dimension point associativity
1. In an open drawing, select the desired dimension or dimension set.

2. Click a dimension point associativity anchor. 

This displays the dimension associativity rule list, which shows the objects
where the dimension point can be associated.

Note that the feature intelligently selects the rules based on the data
collected on previously selected rules in the range of the dimension that is
being created. When you continue picking dimension points you may
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notice that the associativity rules similar to the rules picked earlier are
selected automatically.

The associativity rule list is located so that it avoids overlapping with the
building objects and mouse pointer. The feature detects the current
position of the mouse pointer and keeps the associativity rule list on the
opposite side relative to the picked dimension point.

In the following image, the mouse pointer position is indicated with a blue
circle and the picked dimension point with an orange circle:

3. Click a rule in the list to select it and associate the dimension point to a
new object. 

When you click the rule, the corresponding object is highlighted in the
drawing. This makes it easy for you to to check if the selected rule refers
to the object you want.

4. You can also do the following: 

• Open a several dimension associativity rule lists at a time by holding
down Ctrl or Shift and clicking dimension point associativity anchors,
or holding down Alt and using area selection.
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• Open all associativity rules related to the selected dimension, click a
dimension and select Show dimension associativity rules from the
contextual menu.

• You can alter associativity rules by scrolling the mouse wheel while
mouse cursor hovers over a rule list.

• To select associativity rules related to same object types in all opened
rule lists, double-click the desired rule. Selected rules will be
highlighted with yellow color in all opened rule lists.

• You can control the maximum number of shown rules in the
associativity rule list with the following advanced options:

XS_INTELLIGENCE_MAX_RULE_COUNT,

XS_INTELLIGENCE_MAX_PART_COUNT

XS_INTELLIGENCE_MAX_PLANE_COUNT

If the needed associativity option is missing from the rule list, increase
the number of the shown rules by changing the advanced option
values.

5. Click the drawing background to close the rule list.

Select dimension point associativity in manual dimensioning
You can select the associativity rules for each dimension point during manual
dimensioning of the drawing objects. This way you can properly associate a
dimension during its creation, and the dimension locations are preserved
better during updates and cloning.

1. In an open drawing, activate the dimension creation associativity
functionality: Go to File --> Settings, and select the Dimension creation
associativity check box.

Edit drawings 267 Manual dimensioning



2. Start creating a dimension with any of the following dimensioning
commands: Horizontal, Vertical, Orthogonal, Perpendicular, Parallel
or Free.

3. To display the associativity rule list, pick a dimension point position. 

4. Select the desired associativity rule in one of the following ways: 

• By scrolling the mouse wheel when the mouse pointer is on the
associativity rule list.

• By directly selecting the desired associativity rule from the list by
clicking the rule with the left mouse button.

• By entering the Select next associativity option command in Quick
Launch.

• By using a keyboard shortcut that you have defined for Select next
associativity option.

When you select a rule, the related object is highlighted in the drawing,
which allows you to check if the selected rule refers to an appropriate
object.
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When you have selected the associativity rule, you can continue creating
the dimension by picking the following dimension points. The associativity
rule list is displayed each time when a point with available associativity
rules is detected.

Limitations

• Selecting dimension associativity rule during manual dimension creation
works only with straight type of dimensions, only with the following
commands: Horizontal, Vertical, Orthogonal, Perpendicular, Parallel
and Free.

• Some rules can be missing in the associativity rule list. To increase the
number of rules listed in associativity rule list, increase the value of the
following advanced options:

XS_INTELLIGENCE_MAX_RULE_COUNT

XS_INTELLIGENCE_MAX_PART_COUNT

XS_INTELLIGENCE_MAX_PLANE_COUNT

Associativity rule list content
• The following attributes are shown in the rule list for the following building

objects:

• Steel parts: "NAME", "PART_POS", "PROFILE"

• Concrete objects: "NAME", "PROFILE"

• Polygon cuts: "NAME", "PROFILE"

• Reinforcement: "NAME", "REBAR_POS"

• Bolts: "NAME", “DIAMETER”, “LENGTH”

• Grid: Grid "NAME"
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• Intersection of grid line and building object side: Grid “NAME” or the
label of the building object:

• Intersection of grid lines: Grid “NAME”/”NAME”:

• Building object reference line or centerline: “Reference point” or
“Center” accordingly

• Pour units: Pour object "POUR_TYPE", # "POUR_NUMBER"

• The Default associativity rule is not always shown in the associativity
rule list, unless it is the only rule available, or if it has been previously
selected as the active rule for the chosen dimension point. If Default is
selected, the dimension point will automatically select which object to
follow during the dimension update based on the new position of the
objects. Note that there might not be any rule in the associativity rule
list that would correspond the behavior of the Default option. Selecting
another option than the Default option makes it possible to guarantee
which object will be followed during the dimension update.
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• Display dimension associativity with the Clone and Clone selected
commands:

• Changing associativity rules in selected dimension points allows you
to achieve more accurate results in cloning dimensions in drawings.
An associativity option selected in a rule list will be preserved in the
cloned dimension if the selected rule corresponds to a similar object
in a cloned drawing or in a target selection in a GA drawing. Objects
are not considered to be similar if they have been modeled by using
different commands, such as steel beam, steel plate, reinforcement,
or bolt.

• Note that when the drawing is cloned automatically due to
renumbering, the associativity rules are recomputed from scratch
and any preferred rules set by the user are lost.

Link perpendicular dimension lines
You can connect two perpendicular dimension lines. Connecting dimension
lines makes your drawings clearer and easier to read. For example, you might
want to link dimension lines of embedded objects in a cast unit, floor beams in
a floor plan, or anchor bolts in an anchor bolt plan.

1. In an open drawing, hold down Ctrl and select two perpendicular
dimension lines to connect.

2. On the Dimensioning tab, click Link dimensions.

3. If you want to unlink the dimension lines you linked, select the linked
dimension line and, on the Dimensioning tab, click Unlink dimensions.

Example

Below is an example of linked dimension lines:

See also

Modify dimension properties (page 257)
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Combine dimension lines
You can manually combine a group of two or more parallel dimension lines
into one line.

1. Hold down Ctrl and click the dimension lines you want to combine.

2. On the Dimensioning tab, click Combine lines. 

You can also right-click and select Combine Dimension Lines.

See also

Modify dimension properties (page 257)
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Set the dimension extension line length
You can adjust the length of the dimension extension lines in dimension
properties in an open drawing. You can also adjust the extension line length
using advanced options.

You can load the dimension properties file where you have the correct setting
when you add automatic dimensions on view level.

1. Open a drawing and double-click a dimension.

2. Go to the General tab in dimension properties.

3. Select an option from the Short extension line list: 

Options Description

No
Yes Use this option to create extension

lines all of the same length:

On grid lines only Use this option to use the short
extension line automatically if a
dimension line falls on a grid line.
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Options Description
Elsewhere the extension line will be
as usual.

4. Save your setting in a properties file for later use.

5. Click Modify.

6. To adjust the extension line lengths, go to File --> Settings --> Advanced
options --> Dimensioning: General and set the following advanced
options. These advanced options adjust the extension line length in
relation to the text size:
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(1) Text height * 1.0 (default). Use 
XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR to adjust the length of the
dimension extension lines that are facing away from the dimension points.

(2) Text height * 1.5 (default). Use 
XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR to adjust the length of
the dimension extension lines that are facing towards the dimension points.

See also

Dimension properties - General tab (page 929)

Drag dimension marks
Dimension marks can be freely dragged to avoid overlapping dimensions and
marks.

Note that you can only drag relative dimensions, not absolute dimensions.

Go to File --> Settings and ensure that Drawing drag & drop is selected .

1. Point the handle, press down the left mouse button, and drag the
dimension mark to the desired location. 

Tekla Structures automatically adds a leader line to the dimension mark
that is dragged from its original position.

Note that if you do not want to draw a leader line when a dimension text
is dragged away from the dimension line, set the advanced option 
XS_LEADER_LINE_TO_DRAGGED_DIMENSION_TEXT to FALSE in the
category Dimensioning: General in the Advanced Options dialog box.
The default value is TRUE.
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See also

Drag, reshape and resize drawing objects (page 348)

Modify dimension properties (page 257)

Move the end of the dimension line
You can move the end of the dimension line orthogonal to itself outside the
part. The dimension tags are moved together with the end of the line. This is
useful when the tags would otherwise cover part geometry or other objects,
such as dimensions or marks.

Limitations: You can move the end of the dimension line in all straight
dimensions, except elevation dimensions.

1. In an open drawing, click the dimension. 

The dimension line handle becomes visible.

2. Select the handle and drag the end of the line to the desired position. 

It is easier to select the handle when your hold down Alt and then click
the handle.

If the dimension contains dimension tags, the tags are visible while you
drag.

4.9 Create and modify marks, notes, texts, symbols and
links in drawings
You can add many kinds of annotation objects in your drawings, such as
marks, associative notes, texts, and links. Some of these are associative and
some independent.

Associative annotation objects

Associative objects update according to the changes made in a building object
in the model. Dimensions, marks, and notes are associative.

In addition to the automatic marks and dimensions that you already may have
in a drawing, you can add new ones and modify their properties:

Drawing content manager (page 278)

Add part marks manually in drawings (page 287)
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Add reinforcement marks manually in drawings (page 289)

Add reinforcement ticks or reinforcement tags in drawings (page 290)

Welds in drawings (page 492)

Add level marks in drawings (page 292)

Add associative notes in drawings (page 297)

Add manual dimensions to general arrangement drawings (page 201)

Modify mark or note properties (page 299)

Update part and weld marks in drawings (page 303)

Delete marks for selected parts (page 304)

Check changed marks, notes and dimensions and remove change symbols
(page 306)

Merge marks (page 311)

Drag the mark and associative note leader line start point (page 319)

Add manual dimensions (page 195)

You can also delete marks for parts and reinforcement (page 304).

Independent annotation objects

Independent annotation objects are not linked or connected to the Tekla
Structures model in any way. For example, texts, DWG/DXF files, symbols,
section marks, detail marks, revision marks, links and hyperlinks are all
independent annotation objects.

Independent objects will also become associative if you snap to a building
object when you create them, because then they will get associativity points.
For example, in texts, the content does not change when the model changes
but the associativity point may change. Another example is a line: if you snap
to a part edge when you create a line, the line will get an associativity point
and move with the part if the part changes.

You can only add texts, section marks, detail marks, DWG/DXF files, links,
hyperlinks, revision marks and symbols in an open drawing, and modify the
properties of the added ones:

Add section marks in drawings (page 293)

Add detail marks (page 296)

Add text in drawings (page 320)

Add links in drawings (page 323)

Add revision marks in drawings (page 329)

Add symbols in drawings (page 330)

Modify the properties of independent annotation objects (page 329)
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See also

Drawing objects, views and layouts (page 59)

Manual dimensioning (page 194)

Drawing content manager
Drawing content manager is an interactive tool for checking and editing
building objects and drawing content, especially marks, dimension marks, and
associative notes, in the current drawing.

Use Drawing content manager to quickly and easily:

• Select relevant drawing content for checking and editing purposes, and
target actions on single or multiple building objects or marks
simultaneously.

• Add, modify or remove building object marks, dimension marks, and
associative notes.

• Add weld marks to model welds in drawings.

• Highlight either objects or marks.

• Check how many marks building objects have in one view or in the entire
drawing.

• Add other content to building objects depending on the object type, such
as rebar dimension lines.

• Modify building object or mark properties.

• Hide/show building objects.

With this tool you can avoid duplicate, missing, or false information, and
efficiently check if all necessary content exists, without having to manually go
through all drawing objects separately.

• To open Drawing content manager, first open a drawing and click the

Drawing content manager button  in the side pane. Then click Show
to populate the Drawing content manager list. If you do not want to list
all building objects, narrow your selection by selecting certain drawing
views, drawing areas or multiple objects, and then click Show.

TIP If you suspect that some objects are missing from the list, go to the
drawing view properties by double-clicking the drawing view frame
and set the needed building objects visible.
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• Drawing content manager lists building objects in the drawing, and by
default the related mark content and quantity. You can add and change
property columns. Associative notes and dimension marks are also
considered and counted as marks.
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• You can only see the contents of one category at the time. If you have a lot
of objects in a category, and you need to scroll, the objects are loaded as
you scroll.

• The following building object categories are available in Drawing content
manager if they exist in the drawing, and have been set visible in the
drawing View properties:

• Assemblies

• Parts

• Welds

• Bolts

• Reinforcement

• Pour objects

• Neighbor parts

• Neighbor reinforcement

• Connections - Connection objects have a symbol representation in
drawings. By default, the connection representation symbol is the
symbol number 142 in the xsteel.sym file in the ..\ProgramData
\Trimble\Tekla Structures\<version>\environments\common
\symbols\ folder. You can modify the connection representation
symbol in Symbol Editor. Connection symbols are only highlighted in a
drawing when you have selected the objects from the Drawing content
manager list, otherwise connection symbols are hidden.

How to use the building object list

To Do this
Show in the Drawing
content manager list
the building objects that
are hidden in the
drawing

Click  Show hidden items on the Options
menu.

Select and highlight the
selected building objects
or marks in all drawing
views where they are
visible

Click  Show in all viewson the Options
menu.

Refresh the Drawing
content manager list
with correct mark
quantity information

Click  Update. Do this every time you hide
some building objects, or if the number of marks
changes.
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To Do this
Select and highlight
either building objects or
marks in the drawing

Select the objects in Drawing content manager
and change the selection from object to mark

using the switch . When building object

selection is active, the switch is gray , and
when mark selection is active, the switch is blue

.

Marks selected:

Parts selected:

Highlight objects in the
Drawing content
manager list

Select and highlight objects in the drawing.

Parts selected in the drawing are highlighted in the
list:
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To Do this

Collapse or expand
building object
categories

Use the arrow buttons .

Search for and list
specific building objects

Use the search box.

You can use operators OR and AND. AND is the
default, you do not need to type it. For example, to
find all ground beams and footings, enter FOOTING
OR GROUND_BEAM. To find only ground beams with
position number GB/1, enter GROUND_BEAM GB/1.

Sort mark properties in
alphabetical order

Click a column header.

Add a new property
column in Drawing
content manager

1. Click the arrow button next to a category to
expand the category.

2. Click the + button nex to the the property
column title row. The + button is displayed
when a category is open.

3. In the Add/Edit properties dialog box, do the
following:

• Select the required property from the list
on the left and drag it to the list on the
right. Use the Search box for searching
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To Do this
properties. You can add several properties
to the same column.

• If you want to add custom text in a column
cell, select Custom text and type the
required text in the displayed Text box.
The press Enter to add the custom text in
the list on the right.

• To show the property cells even though
there is no value, select the Show empty
fields of the column option.

4. Enter the name for the property column and
click OK.

Change a property
column

Right-click the column name and select Edit.
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To Do this
Remove a property
column

Right-click the column name and select Remove.

Change the order of the
columns

Drag the columns to the new position.

Hide category types
from the list of visible
categories

Click the  Options button to open the Options
menu and click the categories on the displayed list.

Save category properties All generic category properties are saved in the
DrawingContentManagerCategories.xml file
located by default in the system folder defined for
the advanced option XS_SYSTEM. All property
column modifications (new columns, edited
columns, column order) are saved in the
DrawingContentManagerCategories_
<user>.xml file in the \attributes folder under
the current model folder.

First, Tekla Structures tries to find the user-specific
setting file
DrawingContentManagerCategories_
<user>.xml. If it cannot be found, Tekla
Structures will next look for
DrawingContentManagerCategories.xml.
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To Do this
You can convert the user-specific file to a generic
one just by removing _<user> from the file name.

The folder search order for the generic settings file
is the following:

• \attribute folder under the model folder

• Project folder (XS_PROJECT)

• Firm folder (XS_FIRM)

• System folder (XS_SYSTEM)

• Folder defined by the advanced option 
XS_USER_SETTINGS_DIRECTORY

Copy selected rows to
clipboard to be used in
Microsoft Excel

Select rows in the Drawing content manager list
and use Ctrl+C to copy the selected rows to the
clipboard in the .csv format. You can then paste
the rows to a Microsoft Excel sheet. Hold down
Crtl or Shift to select several rows.

Add marks to building objects in a drawing
You can add marks and notes to all visible building objects in a drawing.

1. Click Show to populate the Drawing content manager list. If you do not
want to list all building objects, narrow your selection by selecting certain
drawing views, areas or multiple objects, and then click Show.

2. Select the building objects that need marks from the Drawing content
manager list. 

You can only select multiple objects inside one category. Activate the

switch  to select only objects in the drawing. The selected objects are
highlighted in the drawing.

To select the whole object category, click the category name, for example,
Parts or Welds.

3. Right-click in the drawing and select one of the following options: 

Add associative note: Notes are created using the current associative
note properties.

Add Mark --> Using view properties: Marks are created using the view
level mark properties.

Add Mark --> Using applied mark properties: Marks are created using
the current mark properties.

Add weld mark: Marks are created using the view level mark properties.

Add Mark --> Dimension Mark: Marks are created using current applied
dimension properties.
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Tekla Structures creates the marks or notes. The added marks are shown in

Drawing content manager. To update the mark quantity, click  Update.

Note that if you select several building objects in the drawing at the same
time, and if some of the selected objects already have marks, the content of
the existing marks does not change.

Check mark count
1. Click Show to populate the Drawing content manager list. If you do not

want to list all building objects, narrow your selection by selecting certain
drawing views, areas or multiple objects, and then click Show.

2. If you want to know the mark count in the whole drawing, click  Show

in all views on the Options menu.

3. To include hidden objects in the list and show their mark count as well,

click  Show hidden items on the Options menu.

4. To make sure that the mark information is up to date, click  Update. 

Note that Drawing content manager supports counting all kinds of
building object marks, dimension marks, and associative notes.

Hide building objects from drawing or drawing view
1. Click Show to populate the Drawing content manager list. If you do not

want to list all building objects, narrow your selection by selecting certain
drawing views, areas or multiple objects, and then click Show.

2. Select the building objects from the list, right-click in the drawing and
select Hide/Show --> Hide from drawing view or Hide from drawing.

Delete marks
If you are not happy with the existing marks, you can delete them.

1. Click Show to populate the Drawing content manager list. If you do not
want to list all building objects, narrow your selection by selecting certain
drawing views, areas or multiple objects, and then click Show.

2. Click Show in all views and Show hidden items on the 
Options menu to show in the list building objects in the whole drawing,
including the hidden building objects.

3. If you are looking for certain building objects, use the Search... box.
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4. Activate the mark selection .

5. In Drawing content manager, select the building objects whose marks
you want to delete.

6. Press Delete on the keyboard, or right-click in the drawing and select
Delete. 

If you have activated Show in all views and Show hidden items, marks
are deleted from all views, including marks for hidden building objects.

7. Click  Update to update the mark information in the list.

Modify building object or mark drawing properties
• To modify the properties of building objects in the drawing, select the

objects from the Drawing content manager list, right-click in the drawing
and select Properties.... If you are looking for certain building objects, use
the Search... box.

• To modify the properties of the marks, select the objects from the list,

activate mark selection , hold down Shift and double-click a mark.

• If you wish to list some of the marks, such as weld marks, but not show the
marks in the drawing, use the first color option in weld mark properties, it
will show the marks invisible. First select the objects from the list, activate

mark selection , hold down Shift and double-click a weld mark. Then
change the weld mark text and line color and click Modify.

Add part marks manually in drawings
In an open drawing, you can add part marks for all building objects, surface
treatment and connections, or for the selected ones only. For each view, Tekla
Structures creates the marks according to the mark properties defined in view
properties.

TIP Use orthogonal snapping in marks and associative notes with leader
lines. For example, you can use it for placing your marks and notes in a
more consistent way in exact locations. When you start dragging a mark
or note from a leader line end handle, and you have orthogonal
snapping on, the leader line end handle locks to the closes orthogonal
point in the drawing (0, 45, 90, 135, 180 degrees). To activate orthogonal
snapping, press O.

To add part marks, do one of the following:
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To Do this
Add part marks for all
building objects in a
drawing

On the Annotations tab, click Part mark --> For
all parts .

If you have deleted marks manually from the
drawing, this command will not create the marks,
and you will have to create them manually part by
part.

Add part marks for
selected building objects
in a drawing

1. Select the building objects in the drawing:

• Activate the Select parts in drawings
selection switch and select the parts using
area selection, for example.

• Open the Drawing content manager from
the side pane, and click Show to populate
the Drawing content manager list. You
can also narrow down the selection by
selecting areas, single or multiple views, or
single or multiple building objects. Then
ensure that building object selection is

active  in Drawing content manager,
and select the desired building objects
from the list.

2. Do one of the following:

• On the Annotations tab, click Part mark --
> For selected parts .

• Right-click and select Add Mark and then
Using view properties or Using applied
mark properties.

3. If the part mark does not contain any
elements in view properties, Part Mark
Properties are displayed, and you can select
the elements to be included in the part mark.

Add elements and click Modify.

Note that if you select several building objects
at the same time, and some of the selected
objects already have marks, the content of the
existing marks does not change.

See also

Modify mark or note properties (page 299)

Mark elements (page 971)

Common elements in marks (page 972)
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Mark properties (page 965)

Modify mark or note properties (page 299)

Add reinforcement marks manually in drawings
You can add marks manually to reinforcing bars and meshes in drawings.

The reinforcement marks may already exist in a drawing if you have selected
to create the marks at drawing creation (page 826). If there are no marks, you
can add them manually.

1. Open a drawing that contains reinforcement.

2. If you want to adjust the reinforcement mark properties, do one of the
following depending on whether you want to use the current
reinforcement mark properties or view level reinforcement mark
properties: 

• To adjust the current reinforcement mark properties, such as color
and mark elements included, on the Drawing tab, click Properties -->
Reinforcement mark . When you have made the necessary
adjustments, click Apply or OK.

• To adjust the view level reinforcement mark properties, double-click
the view frame, click Reinforcement mark in the options tree and
adjust the properties. Click Modify.

3. Select the reinforcement by doing one of the following: 

• Hold down Shift and select the desired reinforcement.

• Open the Drawing content manager, and click Show to populate the
Drawing content manager list. You can select areas, single or
multiple views, or individual reinforcement. Then ensure that building

object selection is active , and select the desired reinforcement
from the list.

4. Right-click and select Add Mark, and select Using applied mark
properties to use the current reinforcement mark properties, or Using
view properties to use the view level reinforcement mark properties. 

The reinforcement marks are created.

Note that if you have not added any elements in the reinforcement mark
properties before adding the reinforcement marks, the properties dialog
will be displayed.

See also

Reinforcement and neighbor reinforcement mark elements (page 976)

Reinforcement and neighbor reinforcement mesh mark elements (page 977)
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Add reinforcement ticks or reinforcement tags in drawings
Reinforcement ticks and reinforcement tags are types of reinforcement marks
that you can add for selected reinforcement in drawings. You can add
reinforcement ticks and reinforcement tags for individual reinforcement bars,
reinforcement bar groups, and reinforcement bar sets.

You can add reinforcement ticks and reinforcement tags manually from the
Applications & components catalog when you have a drawing open.

Add reinforcement ticks
1. Open a drawing that contains reinforcement.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. In the catalog, double-click Reinforcement tick.

4. In the Reinforcement tick dialog box, adjust the used reinforcement
mark attribute, mark alignment, arrow orientation, arrow head type, line
color, arrow head dimensions, and arrow offsets according to your needs.

5. Click Apply or OK.

6. In the drawing, select the reinforcement.

7. Select a point near the end of the reinforcement to place the
reinforcement tick.

See an example of a reinforcement tick below.

Add reinforcement tags
You can add reinforcement tags for reinforcing bars that are perpendicular to
the drawing view.

1. Open a drawing that contains reinforcement.
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2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. In the catalog, double-click Reinforcement tag.

4. In the Reinforcement tag dialog box, adjust the used reinforcement
mark attribute, tag pattern, tag orientation, and rotation angle according
to your needs.

5. In the drawing, select the reinforcement.

6. Select a point near the end of the reinforcement to place the
reinforcement tag.

See an example of a reinforcement tag below.

Move reinforcement ticks or reinforcement tags
You can change the position of previously created reinforcement ticks and
reinforcement tags by dragging their handles.

1. Select the reinforcement tick or reinforcement tag. 
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Two green handles appear.

2. Do any of the following: 

To Do this
Move the reinforcement
tick or reinforcement tag

a. Select the handle that is closer to the
reinforcement tick or reinforcement tag.

b. Drag the handle to a new location, and release
the mouse.

Mark another
reinforcing bar in a
reinforcing bar group or
reinforcing bar set

a. Select the handle that is further from the
reinforcement tick or reinforcement tag.

b. Drag the handle to a new location, and release
the mouse.

Note that you cannot mark another reinforcing bar
if you have added the reinforcement tick or the
reinforcement tag for an individual reinforcing bar.

Add level marks in drawings
A level mark represents the elevation of a point. In addition to the automatic
elevation dimensions that you can define in the drawing properties before
creating the drawing, and the elevation information in the grid labels added in
the model, you can also add manual level marks in your drawing to ensure
that the dimensions are correct.

1. Open the drawing.

2. Hold down Shift and, on the Annotations tab, click Level mark.
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3. In Level Mark Properties, modify the content and the appearance of the
level mark.

4. Click Apply or OK to save the properties.

5. Pick a start point for the leader line and a position for the mark.

NOTE Shortening value added in the user-defined properties of a part also affects
level marks.

1. Elevation dimension in the grid label

2. Elevation dimension created with Add level mark in the drawing

You can also add level marks in GA drawing plane views. In this case, you
might want to leave the leader line out.

See also

Level mark properties (page 989)

Mark properties - Content, General, Merging and Appearance tabs (page 965)
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Add section marks in drawings
You can add section marks in an open drawing.

1. Open a drawing.

2. On the Annotations tab, hold down Shift and click Section mark.

3. In Section Mark Properties, set the cutting line properties and select a
color for the line.

4. On the Section mark tab, set the contents and the appearance of the
section mark.

5. Click OK or Apply.

6. Pick the first and the second point on the cut plane. 

Create as many section marks as you need.

7. Press Esc to interrupt.

TIP You can move or copy manually created section marks:

• Copied using Ctrl+drag

• Copied inside a drawing view with the context menu commands Copy -->
Linear and Copy --> Linear..., the ribbon command Copy, or by entering
Copy - Linear in Quick Launch. You can also use the keyboard shortcut Ctrl
+C.

• Moved using Shift+drag

• Moved inside a drawing view with the context menu command Move -->
Linear, the ribbon command Move, or by entering Move - Linear in Quick
Launch. You can also use the keyboard shortcut Ctrl+M.

Section marks can only be copied or moved within a view. When moved beyond
the view frame, the view frame will adjust so that the section mark will always be
within the frame.

See also

Modify section mark, view label and cutting line in drawings (page 294)

Modify section mark, view label and cutting line in
drawings
You can modify section mark, section view label and section view cutting line
properties in an open drawing.

1. Double-click the section mark. 
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2. On the Cutting line tab, set the section mark line length and offset
(distance between the mark and the section).

3. On the Section mark tab, click the ... button next to A1–A5 to open the
Mark Contents dialog box and select the elements to be included in the
section mark.

4. If needed, select an element from the list, click Add > and select the frame
Type and Color. You can set these individually for each element.

5. If needed, select an element from the list and select the text Color, Font
and Height. You can set these individually for each element.

6. On the Position tab of the Mark Contents dialog box, set the side to
show the text, the text position, the horizontal and vertical offset, and the
text rotation. Text positioning depends on whether you use a symbol or
not.

7. Click Modify.

8. In the Symbol area, define the section mark symbols. You can select from
a list of predefined arrow symbols or use your own custom symbol. The
symbol properties can be given separately for both the left and the right
section mark symbols. Also set the color, size and position of section mark
symbols.

9. On the View label tab, click the ... button next to A1–A5 to open the Mark
Contents dialog box, and select the elements to be included in the
section view label.

10. Modify the element appearance and mark position as described above.

11. Click Modify.

12. Select the view label Symbol to be used in the label. You can also set the
color, size, and the line length of the section view label line and symbol.

13. Set the label position and whether you wan to center it according to the
view frame or view boundary (view restriction box)

14. Click Modify.

See also

View, section view and detail view label mark elements (page 982)
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Section and detail mark elements (page 981)

Positioning properties of view label, section and detail marks (page 983)

Section view properties (page 927)

Add detail marks
You can mark details in the drawing with detail marks.

1. In an open drawing, on the Annotations tab, hold down Shift and click
Detail mark.

2. In Detail Properties , enter the name for the detail, and modify the detail
boundary and detail mark properties, as desired. 

The shape of the detail boundary you select affects the way you select the
area for your detail.

3. Click OK or Apply.

4. Depending on the selected detail boundary shape, do one of the
following: 

• If the shape is Circle, pick the center point of the circle and then pick a
point on the circle.

• If the shape is Rectangle, pick corner points for the rectangle.

5. Pick a position for the label.

6. Press Esc to interrupt.

TIP You can move or copy manually created detail marks:

• Copy detail marks using Ctrl+drag

• Copy detail marks inside a drawing view with the context menu commands
Copy --> Linear and Copy --> Linear..., the ribbon command Copy, or by
entering Copy - Linear in Quick Launch. You can also use the keyboard
shortcut Ctrl+C.

• Move detail marks using Shift+drag

• Move detail marks inside a drawing view with the context menu command
Move --> Linear, the ribbon command Move, or by entering Move - Linear
in Quick Launch. You can also use the keyboard shortcut Ctrl+M works as
well.

Note that detail marks can only be moved or copied within a view. When moved
beyond the view frame, the view frame will adjust so that the detail mark will
always be within the frame.

See also

Modify detail mark, view label and mark boundary properties in drawings
(page 297)
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Modify detail mark, view label and mark boundary
properties in drawings
You can modify the properties of detail marks, detail view labels and detail
mark boundaries in an open drawing.

1. Double-click a detail mark to display the Detail Properties dialog box.

2. Modify the detail name in the Detail name box.

3. On the View label tab, click the ... button next to A1–A5 to open the Mark
Contents dialog box, and select the elements to be included in the detail
view label.

4. If needed, select an element from the list, click Add > and select the frame
Type and Color. You can set these individually for each element.

5. If needed, select an element from the list and select the text Color, Font
and Height. You can set these individually for each element.

6. On the Position tab of the Mark Contents dialog box, set the text
position, horizontal and vertical offset, and the text alignment. Text
positioning depends on whether you use a symbol or not.

7. Click Modify.

8. Select the view label Symbol to be used in the label. You can also set the
color, size, and the line length of the view label line and symbol.

9. Select the Vertical and Horizontal position of the view label.

10. Go to the Detail boundary tab and define the shape of the boundary and
the color and type of the bounding line. 

Use the advanced option XS_DETAIL_BOUNDARY_RADIUS for setting a
fixed size for the detail boundary.

11. On to the Detail mark tab, click the ... button next to A1–A5 to open the
Mark Contents dialog box and select the elements to be included in the
detail mark.

12. Modify the element appearance and mark position as described above.

13. Click Modify.

14. Select the detail mark Symbol to be used in the mark. You can also
change the color and size of the symbol.

15. Click Modify in the Detail Properties dialog box.

See also

View, section view and detail view label mark elements (page 982)
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Add associative notes in drawings
Associative notes are extra marks that contain additional information about
the object they are attached to. Associative notes are updated according to the
changes made in the related object in the model. You can add associative
notes to building objects in drawings, such as parts and reinforcement, surface
treatments, edge chamfers, reference objects, pour breaks and pour objects.
Associative notes are handy: You can add multiple notes to one object,
whereas you only can add one mark to one object.

1. Open the drawing.

2. To adjust the note properties, on the Drawing tab, click Properties -->
Associative note: 

• Select what kind of an object you want to attach the note to in the
Content list.

• Select the elements you want to show in the note, and modify the note
appearance, for example, select the desired leader line.

The elements for associative notes are same as those of marks. The
elements vary according to the building object type.

Associative note appearance properties on the General tab are the
same as those of marks. Additionally, you can adjust the leader line
arrow height and length.

• To change the rotation of the note, enter a value in the Rotation box.

• To set the note text alignment, select an Alignment option.

• To place the note exactly in the position you pick and keep it there,
click the Place... button and select fixed in the Placing list.

3. Click Apply or OK to save the properties.

4. If you want to add the note to multiple objects at one go, select the
objects by doing one of the following: 

• Hold down Shift and click the building objects.

• Activate the Select parts in drawings selection switch and select the
building objects in the drawing using area selection.

• Open the Drawing content manager from the side pane, select the
building objects in the drawing and click Show to populate the
Drawing content manager list. You can select areas, single or
multiple views, or single or multiple building objects. Then ensure that

building object selection is active  in Drawing content manager,
and select the desired building objects from the list.

5. Add the associative note: 

• If you selected several objects, right-click and select Add associative
note. This adds notes to the building objects you have selected at one
go.
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• If you did not select any objects yet, click Note on the Annotations tab
and click one of the following commands, and pick a position for the
note. If you are using a leader line, first pick the position on the object,
and then pick the position for the note.

• With leader line: Add an associative note with a leader line at the
position you specify.

• Without leader line: Create an associative note without a leader
line at the position you specify.

• Along line: Add an associative note along the a line at the position
you specify.

Continue picking to add the same note in another location. You can
stop adding notes by pressing Esc.

See below for some examples of leader lines. The one on the left is With
leader line, the one in the middle Without leader line and the one on the
right Along line.

TIP For edge chamfers and other hard-to-see items, it is easier to use the context
menu command Add associative note because then you do not have to select
the object again after selecting the command.

See also

Mark elements (page 971)

Common elements in marks (page 972)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Create and modify marks, notes, texts, symbols and links in drawings
(page 276)

Modify mark or note properties
You can modify the properties of the marks and notes in an open drawing.

If you only want to modify the properties of a single mark or note, just double-
click it. If you want to modify multiple marks or notes, follow the instructions
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below to select the desired marks or notes. Instructions for modifying the
marks or notes apply to both cases.

1. To select several building objects whose marks or associative notes you
want to modify, do one of the following: 

• Hold down Shift and click the marks or notes you want to modify.

• Activate the Select parts in drawings switch and use area selection to
select the building objects. Then right-click and select Select part
marks and From current drawing view or From all drawing views.

• Activate the Select drawing marks selection switch and use area
selection to select the needed marks or notes.

• Open the Drawing content manager from the side pane, select the
building objects in the drawing and click Show to populate the
Drawing content manager list. You can select areas, single or
multiple views, or single or multiple building objects. Then ensure that

mark selection is active  in Drawing content manager, and select
the desired building objects from the list.

2. If you have selected multiple marks or notes, go to the Drawing tab, click
Properties and Part mark (or another mark type), or Associative note.

3. Switch all the check boxes off in the dialog box by clicking the on/off

switch  at the bottom of the dialog box.

4. Select only the check boxes next to the properties that you want to
modify, and then modify the properties: 

• Add missing elements in the mark on the Content tab and change the
element properties.

• Adjust the mark frame and leader line settings, for example the
Leader line Type.

• If you want to change the note or mark rotation, enter a new value in
the Rotation box.

• To change the text alignment, select the desired option in Alignment.

• To exactly place the mark in the position you pick and keep it there,
click the Place... button and select fixed in the Placing list.

5. Click Modify to apply the changes in all the selected marks or notes.

TIP To modify the properties of the weld marks of welds that you added in the
model, you need to modify the weld in the model. When you number the model,
the weld marks are updated in the drawings. In drawings, you can only modify
the visibility settings and appearance of the model welds.
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Adjust mark visibility in an existing drawing
In addition to defining the mark visibility settings in drawing properties before
creating a drawing, you can also modify the mark visibility settings in an open
drawing separately for the views that you have in the drawing.

To modify mark visibility in an existing drawing:

1. Open a drawing.

2. Double-click the drawing background to open drawing properties.

3. Do one of the following depending on the drawing type. Note that all
settings are not available for all mark types.

Drawing type Adjust mark visibility settings
Single-part, assembly
and cast unit drawings:

1. Click View creation in the options tree on the
left, select the view and the properties that
you want to change, and click View
properties.

2. Click a mark type in the options tree. For
example, click Part mark.

3. Go to the General tab and select whether you
want to display marks by selecting one of the
Visibility in view options. The available
options depend on the mark type:

• distributed: Distributes the marks in the
view. Tekla Structures only creates marks
that are not visible in the other views.

• always: Always creates marks in the view,
irrespective the settings in other views.

• preferred: Acts as distributed, but the
preferred view has a higher priority.

Select preferred to one view only in a
drawing. If you set other views to
distributed, the marks are located only in
the view that has the setting Visibility in
view set to preferred.

• none: Does not create marks.

Note that if you want to create your own
marks manually, always use the none option.
Selecting another option, for example always,
might slow down the drawing update during
opening, even if you had deleted the marks
manually.
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Drawing type Adjust mark visibility settings
4. In Parts out of view plane, select whether

you want to display marks for parts that are
out of view plane:

• Visible: Displays marks for parts outside
the view in the drawing.

• Not visible: Displays no marks for parts
outside the view in the drawing.

5. For bolt marks, select if you want to show bolt
marks in main parts, secondary parts, sub-
assembly main parts, or in sub-assembly
secondary parts.

For bolt marks, you can also define the Ignore
size, which filters standard-sized bolt marks
out of drawings. Tekla Structures will not
display bolt marks of the size you enter here.

6. Click to save the changes in view properties,
and then click Close to return to drawing
properties.

7. Click Modify.
General arrangement
drawings:

1. Click a mark type button in drawing
properties. For example, click Part mark....

2. Go to the General tab and select whether you
want to display marks by selecting one of the
Visibility in view options. The available
options depend on the mark type:

• distributed: Distributes the marks in the
view. Tekla Structures only creates marks
that are not visible in the other views.

• always: Always creates marks in the view,
irrespective the settings in other views.

• preferred: Acts as distributed, but the
preferred view has a higher priority.

Select preferred to one view only in a
drawing. If you set other views to
distributed, the marks are located only in
the view that has the setting Visibility in
view set to preferred.

• none: Does not create marks.

Note that if you want to create your own
marks, always use the none option.
Selecting another option, for example
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Drawing type Adjust mark visibility settings
always, might slow down the drawing
update during opening, even if you had
deleted the marks manually.

3. In Parts out of view plane, select whether
you want to display marks for parts that are
out of view plane:

• Visible: Displays marks for parts outside
the view in the drawing.

• Not visible: Displays no marks for parts
outside the view in the drawing.

4. For bolt marks, select if you want to show bolt
marks in main parts, secondary parts, sub-
assembly main parts, or in sub-assembly
secondary parts.

For bolt marks, you can also define the Ignore
size, which filters standard-sized bolt marks
out of drawings. Tekla Structures will not
display bolt marks of the size you enter here.

5. Click OK.

6. Click Modify.

See also

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Update part and weld marks in drawings
You can update part marks and weld marks in an open drawing. Normally part
marks and weld marks are up to date when you open the drawing. Updating is
needed in frozen drawings.

To update marks in an open drawing, do any of the following:

To Do this
Update all part marks On the Annotations tab, click

Update --> All part marks .
Update selected part marks 1. Select the part marks you want to

update.

2. On the Annotations tab, click
Update --> Selected part
marks .
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To Do this
Update all weld marks On the Annotations tab, click

Update --> All weld marks .

Tekla Structures updates the marks according to your selection.

See also

Freeze drawings (page 583)

Delete marks for selected parts
You can easily select and delete marks for the parts that you have selected,
even in big models.

With the Select part marks command you can select the part marks that you
want to delete in the current window or in all drawing windows. You might
want to create a selection filter first, then use area selection to select the parts.
Another way to select the marks to delete is to use the Drawing content
manager.

To Do this:
Delete marks for selected parts using
selection filter

1. In an open drawing, click

Selection filter  and create a
selection filter that filters out
parts that you do not want to
select.

For an example of the selection
filter, see Example filter below.

2. When you are ready, click Apply.

3. Only activate the Select parts in

drawings  selection switch.

4. Select the parts using area
selection.

5. Right-click and select Select part
marks and From current
drawing view or From all
drawing views .

6. To delete the marks, press
Delete on the keyboard, or right-
click in the drawing and select
Delete.
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To Do this:
Delete marks for selected parts using
Drawing content manager

1. In Drawing content manager,
click Show to populate the
Drawing content manager list.

You can narrow your selection by
selecting certain drawing views,
areas or multiple objects, and
then click Show

2. Click the eye buttons next to
Show in all views and Show
hidden items to include in the
list all building objects in the
whole drawing, including the
hidden building objects.

3.
Click the toggle button  to
activate mark selection. When
you do this, the button changes

to yellow .

4. From Drawing content
manager, select the building
objects whose marks you want to
delete.

5. Press Delete on the keyboard, or
right-click in the drawing and
select Delete.

Example filter

In the following example, you do not want to delete marks from cast units with
a position number B/1. This means that when you use this filter, activate the
Select parts in drawings selection switch, and use area selection to select the
parts, all other parts get selected.
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The image below shows the selected parts and the part marks that you want
to delete.

The marks have been deleted.
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Check changed marks, notes and dimensions and remove
change symbols
Tekla Structures highlights the marks and dimension marks that have changed
due to changes in the model, and dimension points that have been moved.
Tekla Structures also highlights the changed angle dimensions, level marks,
and associative notes.

Tekla Structures highlights the changes in the following way:

• A change symbol (by default, a cloud) is drawn around the old point, the
new point and the dimension values, or around the changed mark or note.

• An arrow is drawn from the old dimension point to the new one.

Remove change symbols

After you have checked all the change symbols that Tekla Structures has
created in your drawing, you can remove all of them or just the selected ones.

To remove the change symbols, do one of the following in the open drawing:

To Do this
Remove all change symbols at one go • On the Drawing tab, click Remove

--> All change symbols.
Remove all dimension change
symbols

• On the Drawing tab, click Remove
--> All dimension change
symbols .

Remove the selected dimension
change symbols

1. Select the dimension change
symbols you want to remove.

2. On the Drawing tab, click
Remove --> Selected dimension
change symbol .

Remove all mark change symbols • On the Drawing tab, click Remove
--> All mark change symbols .
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To Do this
Remove the selected mark change
symbols

1. Select the mark change symbols
you want to remove.

2. On the Drawing tab, click
Remove --> Selected mark
change symbol .

Remove all associative note change
symbols

• On the Drawing tab, click Remove
--> All associative note change
symbols .

Remove the selected associative note
change symbols

1. Select the associative note
change symbols you want to
remove.

2. On the Drawing tab, click
Remove --> Selected
associative note change
symbol .

Examples

The following image shows an example of a mark change symbol after a
material change, and of a dimension change symbol after a change in the size
of the part.
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The following image shows the dimension text and the mark after you have
selected Remove --> All change symbols.

The following image shows an example of a mark change symbol after a
material change, and of a dimension change symbol after a change in the size
of the part.
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The follwoing image shows the dimension text and the mark after you have
selected Remove --> All change symbols.
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Related advanced options

There are some advanced options related to change symbols that you may
want to use:

XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES

XS_HIGHLIGHT_MARK_CONTENT_CHANGES

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL

XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE

Merge marks
You can merge marks to reduce the number of marks in the drawing, and to
make the drawing cleaner. You can merge marks if their content matches. You
can merge marks automatically before creating a drawing, in drawing
properties of and open drawing, and manually in the final drawing.

For more information about automatic merging, see Merge marks
automatically (page 841).

For more information about mark properties, including merging settings, see
Mark properties - Content, General, Merging and Appearance tabs (page 965).
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Merged part marks
A merged part mark means that you have only one part mark for similar parts
in a drawing, instead of a separate mark for each of the parts. Merged part
marks indicate the number of included parts, and contain the defined part
mark contents, and the near side and far side information. The marks are
merged only in X direction of the main part.

Tekla Structures merges marks for visible parts in drawings if:

• The secondary parts are welded or bolted to the same main part.

• The parts are on the same line.

• Distances between the parts are equal.

• The parts have the same part position.

• Distance between parts is not more than what is set for the advanced
option XS_PART_MERGE_MAX_DISTANCE.

• There are at least as many parts in the array as it has been set for the
advanced option XS_MIN_MERGE_PART_COUNT.

Limitations

• You cannot merge part marks (assembly marks) that are not part of the
same assembly.

• Tekla Structures does not merge neighbor part marks.

Advanced options in merging marks

In merging part marks, you may find the following advanced options useful:

Example

In the example below, the part marks are merged in X direction of the HEA300
beam (main part).
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In the example below, the leftmost part marks are not merged, because they
are too far from each other.

In the example below, the marks in the Y direction are not merged, because
the marks are merged only in X direction (which in this example is horizontal).
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Merge part marks or bolt marks manually
1. Open a drawing in which you want to merge part or bolt marks, and

ensure that the marks are visible.

2. Select the marks that you want to merge.

Marks need to have the same content. Note that you can only merge bolt
marks that have not been merged already.

3. Right-click and select Merge.

4. If you want to change leader line settings, double-click the merged mark.

5. On the General tab, select one of the options in the Merged marks list:

• One leader line to group: Creates one leader line for a group of parts.

• One leader line per row: Merges the marks and creates one leader
line for a row of parts.

• Parallel leader lines: Merges the marks and creates parallel leader
lines.

• Leader lines to one point: Merges the marks and draws all leader
lines to one point.

6. Select the leader line type and the arrow to be used.

7. If needed, you can split the merged marks by selecting the marks to split,
right-clicking and selecting Split.

If merging part marks fails for some reason, an error message is displayed in
the status bar: "Mark properties do not match, could not merge all marks".

In the following example, Leader lines to one point has been selected, and a
leader line is going from the mark frame to each part it is related to:

TIP You can also modify the part mark merging settings before merging: To do this,
on the Drawing tab, click Properties --> Part mark. Adjust the properties as
required on the General tab, and click OK.
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Merged reinforcement marks
Tekla Structures can automatically merge similar reinforcement marks of bars,
and you can also merge reinforcement marks manually. Merged
reinforcement marks may include several blocks, and additional information.
Blocks combine similar single marks .

To merge reinforcement marks in drawings, the reinforcement must be
attached to a concrete part or cast unit in the model.

Tekla Structures merges marks for visible reinforcing bars in drawings if:

• The bars belong to the same concrete part or cast unit.

• The direction of the bars is the same.

• The bar marks are identical.

• The bars are close to each other.

• A straight line can be drawn through all the bars.

Merge reinforcement marks manually
1. Open a drawing in which you want to merge reinforcement marks, and

ensure that the marks are visible.

2. On the Drawing tab, click Properties --> Merged reinforcement mark .

3. Modify merging properties as required and click OK.

4. Select the reinforcement marks to merge in the drawing.

5. Right-click and select Merge from the pop-up menu.

6. If needed, you can split the merged marks by selecting the marks to split,
right-clicking and selecting Split.

If merging of rebar marks fails due to settings that are not compatible with
merging, or to some other errors in settings, a new error message is displayed:
"Could not merge all marks, please check the applied merged rebar mark
settings".

Note that when you merge several reinforcement marks, and the mark text is
very long, an error message is displayed, and the marks will not be merged.

Merge marks by adjusting drawing properties
In a final drawing, you can merge marks also by adjusting the drawing
properties.

To activate merging through drawing properties:

1. Open a drawing.

2. Double-click the drawing background to open drawing properties.

3. Do one of the following depending on the drawing type:
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Drawing type Adjust mark visibility settings
Cast unit drawings 1. Click View creation in the options tree on the

left, select the view and the properties that
you want to change, and click View
properties.

The merging needs to be set view by view
separately.

2. Click a mark type in the options tree. For
example, click Part mark.

3. Go to the General tab, and set Merge marks
to On.

4. In Merged marks, select one of the following:

• One leader line to group: creates one
leader line for a group of parts.

• One leader line per row: Merges the
marks and creates one leader line for a row
of parts.

• Parallel leader lines: Merges the marks
and creates parallel leader lines.

• Leader lines to one point: Merges the
marks and draws all leader lines to one
point.

5. Select the leader line type and the arrow to be
used.

6. To merge reinforcement marks, click
Reinforcement mark in the options tree, and
go to the Merging tab.

• In Identical marks in same cast unit,
select one of the following:

• One leader line to group creates one
leader line for a group of reinforcing
bars.

• One leader line per row: Merges the
marks and creates one leader line for a
row of reinforcing bars.

• Parallel leader lines: Merges the
marks and creates parallel leader lines.

• Leader lines to one point: Merges the
marks and draws all leader lines to one
point.
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Drawing type Adjust mark visibility settings
• No merge: Marks are not merged, an

individual leader line is created for each
mark.

• If you select No merge, you still need to
define the mark content for the marks
that Tekla Structures automatically
merges on the Merging tab.

• In Preferred direction of merge, if there
are several possible merge directions,
select Merge horizontal or Merge
vertical.

• In Available elements/Elements in mark,
Select the contents to be included in the
merged reinforcement marks (page 979).

To ensure that merged reinforcement
marks appear in the drawing, always
include Symbol separating blocks in
mark as the last element in the
reinforcement mark. To omit the
separating symbol, leave this box blank,
but still include the element in the mark.

7. Select the leader line type and the arrow to be
used.

8. Click Save to save the changes in view
properties, and then click Close to return to
drawing properties.

9. Click Modify.
General arrangement
drawings

1. Click a mark type button in drawing
properties. For example, click Part mark....

2. Go to the General tab, and set Merge marks
to On.

3. In Merged marks, select one of the following:

• One leader line to group creates one
leader line for a group of parts.

• One leader line per row: Merges the
marks and creates one leader line for a row
of parts.

• Parallel leader lines: Merges the marks
and creates parallel leader lines.
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Drawing type Adjust mark visibility settings
• Leader lines to one point: Merges the

marks and draws all leader lines to one
point.

4. Select the leader line type and the arrow to be
used.

5. To merge reinforcement marks, click
Reinforcement marks... in drawing
properties and go to the Merging tab.

• In Identical marks in same cast unit,
select one of the following:

• One leader line to group creates one
leader line for a group of reinforcing
bars.

• One leader line per row: Merges the
marks and creates one leader line for a
row of reinforcing bars.

• Parallel leader lines: Merges the
marks and creates parallel leader lines.

• Leader lines to one point: Merges the
marks and draws all leader lines to one
point.

• No merge: Marks are not merged, an
individual leader line is created for each
mark.

• If you select No merge, you still need to
define the mark content for the marks
that Tekla Structures automatically
merges on the Merging tab.

• In Preferred direction of merge, if there
are several possible merge directions,
select Merge horizontal or Merge
vertical.

• In Available elements/Elements in mark,
select the contents to be included in the
merged reinforcement marks (page 979).

To ensure that merged reinforcement
marks appear in the drawing, always
include Symbol separating blocks in
mark as the last element in the
reinforcement mark. To omit the
separating symbol, leave this box blank,
but still include the element in the mark.
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Drawing type Adjust mark visibility settings
6. Select the leader line type and the arrow to be

used.

7. Click OK.

8. Click Modify.

Drag the mark and associative note leader line start point
You can move the leader line base point by dragging it.

Ensure that you have selected Drawing drag & drop in File --> Settings .

• Hold down the left mouse button and drag the base point to a new
location.

If the base point is originally on a line, you can drag it along that line. If the
base point is originally inside a part, you can drag the base point inside that
part.

Add text in superscript
You can use superscript in texts in all your text objects, dimension marks,
other marks and associative notes.

1. On the File menu, click Settings --> Advanced options and go to the
Dimensioning: General category.

2. Ensure that the advanced option XS_SUPERSCRIPT_USED_IN_DRAWING_
TEXTS is set to TRUE.

3. Open the properties of a text object, mark or associative note by holding
down Shift and clicking the command. 

For example, on the Annotations tab, click Text --> With leader line .

4. Do one of the following: 

• For text objects, enter the desired text in the Text box.
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• For marks and associative notes, open the Mark content - text dialog
box by double-clicking Text in the Available elements list and enter
the desired text in the Text box.

5. Enter circumflexes (^) around the characters that you want to have in
superscript.

6. Click OK.

7. Add the text, mark or note.

Example

The following example shows how the superscript is entered in the Text box
and what it looks like in the text.

See also

Add text in drawings (page 320)

Create and modify marks, notes, texts, symbols and links in drawings
(page 276)

Manual dimensioning (page 194)

Add text in drawings
You can add several lines of text in a drawing, and use word wrapping if you
like. You can select the desired color, height, font, angle, frame type, and
leader line arrow type, and align the text as required.

1. Open a drawing

2. On the Annotations tab, hold down Shift, click Text and select one of the
following commands to create a single line or multiple lines of text: 

• Text: Add text without a leader line at the position you pick.

• With leader line: Add text with a leader line at the position you pick.

• Along line: Add text along a line at the position you pick.

• Along line, arrow at end: Add text along a line at the position you
pick. An arrow is inserted at the second position you pick.

• Along line, arrow at start: Add text along a line at the position you
pick. An arrow is inserted at the first position you pick.
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3. Enter the text in the Text box. 

You can add a line break by pressing Enter.

4. Modify the text color, height, font, angle and alignment as required.

5. In Background mask, select one of the following: 

Opaque hides the area in the drawing that is covered by the text:

Transparent shows the area in the drawing that is covered by the text so
that the linework is shown:

6. To wrap the word, set Word wrapping to On. You can define the line
length using the Ruler width option. 

When the word wrapping is activated, the text object gets a handle, which
you can drag to make the text wider or narrower.

7. Select a frame type, leader line and color.

8. Select the leader line arrow type and size.

9. To exactly place the text in the position you pick, and keep it there, click
the Place... button and select fixed in the Placing list.

10. Click OK or Apply.

11. Pick the point where you want to place the text. Depending on the
command, you have to pick one to three times. 

By default, text is aligned to the left. The line spacing is automatically
adjusted by the font size you select.

You can continue picking to add the same line of text in another location.
You can also drag the base point of the text leader line freely after adding
the text.
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See below for examples of the different text options. From left: Text; With
leader line; Along line; Along line, arrow at end; and Along line, arrow at
start.

The text object gets a handle when word wrapping is activated, and you can
drag the handle to change the text object size:

In the following example, the text is aligned to the leader line start:

TIP In addition to using the text tool, you can add texts as links from .txt or .rtf files.
This allows you to use more sophisticated formatting of the text, and add tables,
for example. For more information, see Add links to rich text files (page 323).
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Add links in drawings
You can add the following kinds of links in drawings:

• Links to text files

• Links to other drawings

• Hyperlinks to Internet (url) addresses

• Links to DWG/DXF files

• Links to images

Add links to rich text files in drawings
You can insert text inside a frame in a drawing. First you create a .txt or .rtf
file in WordPad, and then add a link to it in a Tekla Structures drawing. Tekla
Structures adds the text using some basic formatting settings you can set in
the file itself, and some of the properties in Text File Properties.

NOTE If you change the text in the text file, it will change in all drawings
containing a link to the text file.

Limitation: The .rtf texts need to be created with WordPad.

1. Create the text file. 

You can add basic formatting to the file, such as bold, italics, underline,
strikethrough, subscript, and superscript, use indent and tabs, and set a
specific font. You can add bulleted lists with hyphens and circular bullets,
and numbered lists, and nest the lists. Simple tables are also supported.

When you add the text link, Tekla Structures preserves the formatting
settings.

Note that the text links do not support hyperlinks or images.

Tekla Structures colors will always be shown correctly. If you use in
the .rtf file a color that is not supported in Tekla Structures, then the
closest Tekla Structures color will be used.

2. Open the drawing where you want to add the text file.

3. On the Annotations tab, click Rich text.

4. Browse for the file.

5. For .txt files, you can set the text color, height and font.

6. For .rtf files, set the desired scale. 
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The Scale tells how much the .rtf content should be scaled. If you define
1 as the scale, the letters will keep the same size as the letters in the
original .rtf file.

Color, height and font settings are not adjustable.

7. Set the frame line type and color.

8. Select if you want to adjust how the text is placed: 

• Scale to fit : You only need to pick the upper left corner of the frame
when placing the text. Tekla Structures inserts the object in its original
size. In this case, when you change the text frame size by dragging
from the handles, the text does not wrap, and the font scales
automatically.

• No scaling: You only need to pick the upper left corner of the frame
when placing the text. Tekla Structures adjusts the object size to fit the
frame. The text wraps when you change the size of the frame by
dragging the handles. The minimum width of the box is defined by the
longest word.

9. Click OK or Apply.

10. Pick a location for the upper left corner of the text frame in the drawing. 

Tekla Structures adds the link to the text file.

11. You can edit the text and modify the text file properties: 

• To edit the text file, double-click the text inside the frame. Tekla
Structures opens the original text file.

• To modify the text file properties, double-click the frame around the
text. For .rtf files, you cannot modify the text color or font here, you
need to changes these in the .rft file itself. For plain text files, you
can also change the font color.

Examples

In the following example you can see that the text file may contain bulleted
lists, numbered lists, colors, italics, and bold, and you can change the font of
the desired text parts.

In the following example, the scaling type is No scaling. The text wraps when
you change the size of the frame by dragging the handles, so that the text
always fits the frame. The font size does not change.
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In the following example, the scaling type is Scale to fit. If you change the text
frame size by dragging from the handles, the text does not wrap, and the font
size changes automatically so that the text fits the frame.

Add links to other drawings
You can insert a link to another drawing in a frame in a drawing. Tekla
Structures adds the link to the drawing using the properties in Drawing Link
Properties.

1. Open the drawing.

2. On the Drawing tab, click Link --> To another drawing .

3. Modify the text color, height, font and effect.

4. Modify the frame line type and color.

5. Select if you want to scale the link. If you select No scaling, Tekla
Structures inserts the link in its original size. 

If you select Scale to fit, Tekla Structures adjusts the object size to fit the
frame.

6. On the Drawing tab, click Document manager, and select the drawing to
link to. 

The drawings on the list are the drawings in the current model.

7. If you want to display text for the link instead of the drawing name, enter
the text in the Text box.

8. Pick two points to define the frame and add the link.
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9. Click OK or Apply.

You can open the linked drawing by double-clicking the link.

Example

In the example below, Scale to fit has been selected, and the link contains the
name of the drawing.

Add hyperlinks in drawings
You can add hyperlinks to Internet addresses (URLs) within a frame in a
drawing.

1. Open a drawing where you want to add a hyperlink.

2. On the Drawing tab, click Link --> Hyperlink .

3. Modify the text color, height, font and effect.

4. Modify the frame line type and color.

5. Select if you want to scale the link. 

If you select No scaling, you only need pick the upper left corner of the
frame when you insert the link. Tekla Structures inserts the link in its
original size. If you select Scale to fit, you need to pick two points to
define the frame. Tekla Structures adjusts the link size to fit the frame.

6. In the File or URL text box, enter an Internet address or filename and
path. 

If you need to locate the file, click Browse... Tekla Structures inserts an
active hyperlink to the location you specify.

7. If you want to display text for the hyperlink instead of the hyperlink, enter
the text in the Text box.

8. Click OK or Apply.
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9. Pick one or two points in the drawing to indicate the corners of the
hyperlink frame.

Double-click the hyperlink text in the drawing to go to the Internet address in a
browser.

Example

In the example below, Scale to fit has been selected. The Internet address for
the hyperlink is shown.

Add links to DWG and DXF files in drawings
You can insert a DWG or DXF file inside a frame in a drawing as a link. Tekla
Structures adds the DWG or DXF file link using the properties in DWG/DXF
Properties. When you modify the original file, Tekla Structures also modifies
all the linked instances in drawings.

Tekla Structures supports AutoCAD version 2010 and earlier in DWG/DXF links.
The added dwg/dxf files also support AutoCAD control codes, such as %%u for
underscore, or %%c for a circle diameter dimensioning symbol ø.

1. Open the drawing where you want to insert a link to a DWG/DXF file.

2. On the Drawing tab, click DWG/DXF.

3. Select the scaling options: 

• Scaling:

• X: When you use this setting, you need to pick the left upper corner
of the frame to insert the file. You can only set the drawing scale in
the X direction.

• XY: When you use this setting, you need to pick the left upper
corner of the frame to insert the file. You can set the drawing scale
in both the X and Y direction.

• Scale to fit: When you use this setting, you need to pick the left
upper and bottom right corners of the frame to size and create the
frame. Tekla Structures scales the file to fit the frame.

• Best fit: When you use this setting, you need to pick the left upper
and bottom right corners of the frame to size and create the frame.
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Tekla Structures scales the file to fit, maintaining its original aspect
ratio.

• Scale in X

• Scales the file in the X direction. Enter a coefficient to indicate the
scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type
must be set to X or XY.

• Scale in Y

• Scales the file in the Y direction. Enter a coefficient to indicate the
scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type
must be set to XY.

4. Select the link frame line type and color.

5. In Name, browse for the DWG or DXF file you want to use.

6. Pick one or two points in the drawing to place the frame.

7. Click OK or Apply. 

Tekla Structures adds a link to the DWG or DXF file inside a frame in the
drawing.

TIP If you want to insert DWG files as reference models in your model, see .

Add links to image files in drawings
You can insert a images inside a frame in a drawing. Tekla Structures adds the
image link using the properties in Image properties. When you modify the
original file, Tekla Structures also modifies all the linked instances in drawings.

1. Open the drawing where you want to insert a link to an image.

2. On the Drawing tab, click Image .

3. Select the scaling options: 

• Type

• X: When you use this setting, you need to pick the left upper corner
of the frame to insert the image. You can only set the drawing scale
in the X direction.

• XY: When you use this setting, you need to pick the left upper
corner of the frame to insert the image. You can set the scale in
both the X and Y directions.

• Scale to fit: When you use this setting, you need to pick the left
upper and bottom right corners of the frame to size and create the
frame. Tekla Structures scales the image to fit the frame.

• Best fit: When you use this setting, you need to pick the left upper
and bottom right corners of the frame to size and create the frame.
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Tekla Structures scales the image to fit, maintaining its original
aspect ratio.

• Scale in X

• Scales the file in the X direction. Enter a coefficient to indicate the
scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type
must be set to X or XY.

• Scale in Y

• Scales the file in the Y direction. Enter a coefficient to indicate the
scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type
must be set to XY.

4. Select the link frame line type and color.

5. In Name, browse for the image file you want to use.

6. Pick the points in the drawing to place the frame.

7. Click OK or Apply. 

Tekla Structures adds a link to the image file inside a frame in the
drawing.

Modify the properties of independent annotation objects
You can modify the properties of texts, symbols, links, hyperlinks, links to DWG
and DXF files, and revision marks in an open drawing.

1. Double-click the object in an open drawing.

2. Switch all the check boxes off in the dialog box by clicking the on/off

switch  at the bottom of the dialog box, and select only the
check boxes next to the properties that you want to modify.

3. Modify the properties.

4. Click Modify.

Add revision marks in drawings
Revision marks are symbols that you can add in the drawing when you want to
indicate a change in the Tekla Structures model or drawing, and the objects
that have changed. Tekla Structures creates the revision mark using the
properties in the Revision Mark Properties dialog box.

1. Open a drawing.

2. On the Annotations tab, click Revision mark and select one of the
following commands: 

• Add revision mark
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• Pointing to left

• Pointing to right

• Along line, pointing to left

• Along line, pointing to right

3. Enter the mark, date, and information on the changes. 

Tekla Structures shows this information in the revision table of the
drawing.

4. To place the revision mark exactly in the position you pick and keep it
there, click the Place... button and select fixed in the Placing list.

5. Go to the Appearance tab and set the text color, height, font and angle,
the frame color, leader line and type, and the leader line arrow type and
size.

6. Click OK or Apply.

7. Pick a point or points to place the mark. 

Tekla Structures creates the revisions and revision marks. You can also
see the new revisions in Document manager.

To delete any unnecessary revision marks, select the marks and press
Delete on the keyboard.

See below for examples of revision marks.

Note that if you want to create revisions of drawings, use the Revision
command in Document manager. Note that creating revisions using the
Revision command will not create any marks inside the drawing. For more
information about creating revisions, see Revise drawings (page 586).

See also

Leader line types (page 990)
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Add symbols in drawings
You can use symbols in drawings as such and in marks, object
representations, and line arrows. Symbols can be created and edited in
Symbol Editor.

Add symbols in drawings
You can add symbols in open drawings.

Symbols added in open drawings can be represented in three different ways:
without leader line, with leader line, and along line. Tekla Structures adds
symbols using the properties defined in Symbol Properties. All types of marks
allow you to add symbols in them.

1. In the drawing, hold down Shift and, on the Annotations tab, click
Symbol and one of the following symbol commands: 

• Symbol: Add a symbol in the current drawing without a leader line.

• Along line: Create a symbol along the line you define by picking two
points. Then pick an insertion point for the symbol.

• With leader line: Add a symbol with a leader line pointing to the point
you pick first.

For more information about the leader line types, see Leader line
types (page 990).

2. Modify the symbol properties: 

• File: Change the symbol file in use.

• Number: Change the symbol.

• Symbol: Change the color, height and angle of the symbol.

• Frame: Change the frame type, leader line and color.

3. Click OK.

4. Pick one to three points in the drawing to place the symbol. The symbol
command you selected affects the number of points to pick.

Add symbols in marks
You can select the symbol file to be used and the symbol to be added in the
mark.

1. In an open drawing, double-click a mark.

2. In mark properties, double-click Symbol in the Available elements list.

3. In the Mark content - Symbol dialog box, click Select next to the File box
to select the symbol file you want to use.
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4. When you have selected the file, click Select next to the Number box, and
double-click the symbol you want to use. You can also enter the number
of the symbol if you know it.

5. Click OK. 

Tekla Structures adds the name of the symbol file and the number of the
symbol in the elements list.

6. Click Modify in mark properties. 

Tekla Structures adds the symbol in the mark.

Change a symbol in a symbol file
You can make changes in a symbol in a symbol file. If you do this, we
recommend that you save the file with another name and save it in another
folder, for example, in model, firm or project folder.

1. Depending on where you are in Tekla Structures, you can open a symbol
file in Symbol Editor in several ways: 

• On the File menu, click Editors --> Symbol editor . Open a symbol file
using File --> Open .

• Open the Mark content - symbol dialog box by double-clicking a mark
in an open drawing, and selecting Symbol from the available mark
elements list in the mark properties dialog box. Then click Select...,
select a file from the Symbol files browser and click Edit....

• Open the Symbol Properties dialog box by double-clicking a symbol
that you have added in a drawing. Then click Select..., select a file from
the Symbol files browser and click Edit....

2. Modify the file in the Symbol Editor:

a. Click symbol in slot and sketch your new symbol with drawing tools. 

You can also import AutoCAD or MicroStation files on the Import tab.

b. When you are happy with the symbol, point the symbol slot to check
the number of the new symbol at the bottom of the window. 
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In many places, when adding a symbol, you need to know the
number of the symbol to be able to use it.

3. Click File --> Save as... and give a new name. 

You can also save the file with a new name in a new location, for example,
in model, firm or project folder. We strongly recommend that you do not
the original symbol files delivered with your Tekla Structures software. If
you need to modify any symbols, copy the original symbol file and work
on the copy, keeping the original symbol file intact.

Tekla Structures reads the symbol files in certain search order, section
"Symbol file search order" below.

4. Click OK.

TIP In Symbol Editor, you can copy symbols between symbol files (*.sym). Press Ctrl
+ C and select the symbol you would like to copy, then open the symbol file you
want to copy to (or a new symbol file), select the location for the symbol and
press Ctrl + V.

Change the symbol file in use
You can change the currently used symbol file if the current symbol file does
not contain the symbols that you need.

1. Do one of the following, depending on what you are working with: 

• Open the Mark content - symbol dialog box by double-clicking a mark
in an open drawing, and selecting Symbol from the available mark
elements list in the mark properties dialog box.

• Open the Symbol Properties dialog box by double-clicking a symbol
that you have added in a drawing.

2. Click Select... next to the File box.
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3. Select a new file from the Symbol files list and click OK or double-click the
file.

Create a new symbol file
In addition to the default symbol files that are delivered with Tekla Structures,
you can create symbol files of your own, and save them in model, firm, or
project folder, for example.

If you decide to use your own files, you can add DXK_SYMBOLPATH in the
options.ini file under the model folder and define your own symbol file
folder paths there. The symbol files are read in a certain search order, see
section "Symbol file search order" below.

1. On the File menu, click Editors --> Symbol editor.

2. Click File --> New. 

You can also open an existing symbol file, edit it and save with a new
name.

3. Create the symbol in the Symbol Editor.

4. Click File --> Save and save the symbol file in the folder that you use for
keeping your symbol files. 

If you opened an existing symbol file, use File --> Save as and give the
symbol file another name.

Modify symbol properties
You can modify the properties of symbols in an open drawing.

To modify the symbol properties:

1. Double-click a symbol.

2. Switch all the check boxes off in the dialog box by clicking the on/off

switch  at the bottom of the dialog box, and select only the
check boxes next to the properties that you want to modify..

3. If necessary, change the symbol file in use and select the symbol to use.

4. To modify symbol placement settings, click Place... 

Here you can set the placing to free or fixed, specify the search margin,
minimal distance and select the desired quarter to place the symbol.

For more information, see Placement properties for marks, dimensions,
notes, texts and symbols (page 1013).

5. Go to the Appearance tab and set the symbol color, height and angle,
and the frame type, leader line and color. For more information about the
leader line types, see Leader line types (page 990).

6. Click Modify.
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Customize leader line arrow symbols
If you do not find a suitable leader line arrow in the Arrow list in mark
properties, you can add an arrow of your own.

First you will create the arrow symbol in the Symbol Editor, and save the
created symbol in the arrow.sym file. Then you need to add the position of
the new symbol in the arrow.sym to the configuration file arrow.txt file,
which tells which arrows are available for use in your environment.

1. On the File menu, click Editors --> Symbol editor to open the Symbol
Editor.

2. Open the arrow.sym file located in common environment or in your
environment under symbols folder.

3. Click an empty symbol slot and sketch your symbol with drawing tools. 

You can also import AutoCAD or MicroStation files through File -->
Import .

4. When the symbol is completed, point the symbol slot to check the number
of the new symbol at the bottom of the window. 

5. Save the arrow.sym file by clicking File --> Save .

6. Click File --> Exit to close the Symbol Editor.

7. Open the arrow.txt file located in the same symbols folder as the
arrow.sym file. 

The file contains a list of symbol numbers.

8. Add the number of your symbol preceded by zero (0) in the correct
position and separate it with a comma: 

016,017,018,019,020,021,022,023,024,032,048,049,101,102,110,200
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9. Click File --> Save to save your change.

10. Add a bitmap of the created arrow in the ..\ProgramData\Trimble
\Tekla Structures\<version>\Bitmaps folder on your computer. 

Use the following format in the file name:
dr_dialog_arrow_type_022.bmp.

11. Double-click a mark in a drawing to open mark properties.

12. Open the Arrow list, and you should see that the new arrow symbol is
now available for use. 

NOTE We recommend you define a firm folder for symbols, because the default
folders are overwritten when you upgrade to a newer version of Tekla
Structures. Add the firm folder to the advanced option DXK_SYMBOLPATH.

Add surfacing symbols in drawings
You can add surfacing symbols in cast unit drawings using the Add surfacing
symbols macro.

Before you start, ensure that you have an object that has surface treatment in
the model, and that you have created a cast unit drawing of that object. Also
check in the cast unit drawing properties that the surface treatment is set to
Visible.

1. Open a drawing that has a part containing surface treatment.
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2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. Double-click Add surfacing symbols. 

5. In the Create surface symbols dialog box, select the texts that you want
to include in the surface treatment symbol from the Available elements
list and add the texts to the Elements in mark by clicking Add >.

6. Select All Views to include the symbols in all drawing views, or Selected
Views to include the symbols only in the views you select.

7. Change the font settings, if necessary.

8. If you selected Selected Views, select the views where you wish to have
surface treatment symbols.

9. Click Create.

Tekla Structures creates the surface treatment symbols according to the
defined settings. You can change the symbol properties and the text
afterwards in Text Properties, which is opened when you double-click the
symbol.

Symbol Editor
You can open Symbol Editor by clicking File --> Editors --> Symbol editor . In
Symbol Editor, you can create new symbol files, and create and modify
symbols.

The Symbol files dialog box in drawing mode allows you to change the symbol
file in use. It also provides access to Symbol Editor.
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We recommend that you have a look at the Symbol Editor User's Guide, so
that you get familiar with creating new symbols and modifying the existing
ones.

We strongly recommend that you do not modify the original symbol files
delivered with your Tekla Structures application. If you need to modify any
symbols, copy the original symbol file and work on the copy, keeping the
original symbol file intact.

If your symbols are located in a protected folder, the symbols are read-only,
because you cannot save a modified symbol in a protected folder if you are
not an administrator. In this case, run Tekla Structures as administrator.

Symbol file search order
The symbol files (.sym) are searched from the following folders in the
following order:

1. All DXK_SYMBOLPATH folders

The advanced option DXK_SYMBOLPATH is defined in the environment
initialization file <your_environment>.ini and in the Tekla Structures
initialization file teklastructures.ini.

Alternatively, you can add your own DXK_SYMBOLPATH in options.ini
under the model folder and define your own symbol folder paths there.
Note that also the path settings in the <your_environment>.ini file
need to be added there.

The reading order of the .ini files containing the DXK_SYMBOLPATH
definition:

1. teklastructures.ini
2. <your_environment> .ini
3. options.ini

2. Current model folder

Add here any additional symbol files that you might need.

All symbol files that are found are available to be used in Tekla Structures. If
there are duplicate file names, the first one found is used and the rest are
discarded. If the model folder contains a symbol file that has the same name
as another symbol file in DXK_SYMBOLPATH, the one in the model folder is
discarded.

Example of overriding a symbol temporarily

If there is no permanent need to add your own symbol paths in the
options.ini file in the model folder, you can temporarily override symbols.
In this example, you will temporarily override the weld symbol with a
customized symbol located in your model folder:

1. Customize the symbol in ts_welds.sym first.
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2. Copy the edited ts_welds.sym in your model folder
C:\TeklaStructuresModels\ <mymodel>

3. Open the options.ini file located in your model folder, and add the line
DXK_SYMBOLPATH=C:\ TeklaStructuresModels\<mymodel>;
C:\TeklaStructures\2017\Environments\common\symbols; +
possible other symbol folders in your local environment.

Define a firm folder for images and symbols
You can define a firm folder where Tekla Structures always searches for the
images and symbols. When you store the images and symbols in this folder,
you do not have to move them from folder to folder when you install a new
version of Tekla Structures. Installing a new version does not replace the files
in the firm folder.

Define the firm folder in the options.ini file under the model folder or
user.ini using the advanced option XS_FIRM.

To define the firm folder for images and symbols in the options.ini file:

1. Modify the options.ini file to include the advanced option 
DXK_SYMBOLPATH that points to the firm folder. 

The advanced option DXK_SYMBOLPATH may contain multiple paths
separated by semicolons.

Since Tekla Structures version 19.0, the folder path definitions like 
%DATADIR% or %XS_FIRM% in DXK_SYMBOLPATH have not converted the
paths correctly when used in options.ini located in the firm folder.
However, these definitions work correctly if used in user.ini. Currently
in options.ini in the firm folder you need to write the absolute paths
for DXK_SYMBOLPATH, like in the example below:

DXK_SYMBOLPATH=C:\ProgramData\Trimble\Tekla Structures
\2017\Environments\common\symbols\;C:\firm\Symbols\;

2. In Template Editor, click Options --> Preferences --> File Locations and
enter the path to the firm folder also for Symbols, pictures.

4.10 Show or hide drawing objects
You can hide selected drawing objects in either drawings or drawing views.
You can also list which objects you have hidden. You can also hide dimensions
of graphical drawing objects.
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Hide objects in drawings and drawing views
You can hide selected objects in drawings and drawing views, for example,
parts or marks. When you hide a part, Tekla Structures will hide all its related
objects. Note that if an object is hidden in drawing views it will not be printed.

1. Open a drawing.

2. Check that the ghost outline option is selected in File --> Settings -->
Ghost outline .

3. Select the Color mode by pressing B. 

Hidden objects are shown as ghost outlines in color drawings. In grayscale
and black and white drawings, hidden objects are not shown even if
Ghost outline is selected.

4. Select the objects you want to hide in one of the following ways: 

• Activate the appropriate selection switch and select the objects using
area selection, for example. For example, to select parts, use Select
parts in drawings.

• Open the Drawing content manager from the side pane, and click
Show to populate the Drawing content manager list. You can also
select areas, single or multiple views, or single or multiple building
objects to narrow down your selection. To select parts, ensure that

building object selection is active , and to select marks, ensure

that mark selection is active . Then select the desired building
objects from the list.

5. On the Drawing tab, click Hide/show and one of the following
commands: 

• Hide from view: Tekla Structures hides the selected object in the view
where the selected objects are located.

• Hide from drawing: Tekla Structures hides the selected object in all
drawing views.

You can also right-click and select the commands from the pop-up menu.

6. When you want to show the hidden objects again, go to the Drawing tab
and click Hide/show and select Show in view or Show in drawing.

Example

Below there are some examples of the results with different combinations of
selections.
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Setting Example
Color mode is set to Color in File -->
Settings . No objects have been
hidden. Marks are shown.

Color mode is set to Color and Ghost
outline is not selected in File -->
Settings . Selected reinforcing bars
are hidden and related marks are not
shown.
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Setting Example
Color mode is set to Color and Ghost
outline is selected in File --> Settings
Hidden rebars are shown as ghost
outlines and related part marks are
not shown.

Color mode is set to Black and
white and Ghost outline is selected
in File --> Settings . The ghost outline
has no effect on black and white
drawings. Rebars are hidden and
related marks are not shown.
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List hidden parts in drawings
You can select whether to list the hidden parts in drawings, for example, in the
material list.

Note that listing hidden objects does not work in all templates. It works in
templates containing PART rows, but not in hierarchical templates. For
example, if the template is of type ASSEMBLY - PART, and the Assembly is
included in the drawing, all of its parts will also be included.

1. Open a drawing containing hidden parts.

2. Double-click the drawing to open the drawing properties dialog box.

3. Click Layout...

4. Select whether you want to list the hidden parts in List hidden objects in
templates. No removes all information about the hidden parts, also from
the total weight.

5. Click Modify. 

In the example below, the hidden reinforcing bars are listed.

In the example below, the hidden reinforcing bars are not listed.

Hide or show dimensions of drawing sketch objects
You can hide and show the dimensions of the sketch objects in drawings, such
as lines, or arcs, from Quick Launch or by using a keyboard shortcut. By
default, the dimensions are visible.

In an open drawing where you want to hide or show sketch object dimensions,
do one of the following:

• Press Ctrl+d to hide the dimensions. To show the dimensions, press Ctrl+d
again. For more information about shortcuts, see .
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• Go to Quick Launch, start typing toggle graphical object
dimensions, and select the Toggle graphical object dimensions
command from the list that appears. To show the dimensions again, do the
same.

When the dimensions are visible, a small d is displayed on the status bar:

4.11 Arrange annotation objects
You can reposition annotation objects such as marks, dimensions or texts on
the basis of the protection and placing properties of each drawing object type.

1. Open a drawing.

2. For each view, double-click the view frame to open the view properties,
click Protection in the options tree.

3. Check the protection properties, modify them as required and click
Modify. 

With protection properties you can define protected areas in drawings to
prevent text, marks or dimensions from being placed in that area.

4. Double-click objects in your drawing, such as marks and dimensions, and
click Place... to check and change the placing settings as required. 

Placing properties define where and how far the annotation objects are
placed, and the empty margin around the mark. If the object is set to
fixed, the Arrange objects commands will reposition the objects and
keep the fixed state.

5. Click OK and Modify.

6. In the open drawing, select the annotation objects you want to arrange: 

• Select the individual objects such as marks, dimensions and texts by
pressing down Shift and clicking the objects.

• Use selection switches to select only texts, marks, and associative
notes, for example, and use area selection to select the objects that
you want.
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• To select marks or associative notes only, first activate the Select
parts in drawings selection switch and select the parts using area
selection, for example, and then right-click and select Select part
marks.

• Another way to select marks or associative notes only is to open the
Drawing content manager from the side pane, click Show to
populate the Drawing content manager list, ensure that marks

selection is active , and select the desired building objects from
the list.

7. On the Annotations tab: 

• To arrange marks and texts near current location, click Arrange
objects --> Near current location .

Tekla Structures positions the selected drawing objects so that they do
not overlap other objects. Objects located in a free location are not
moved, and overlapping objects are moved as close to the current
location as possible.

• To arrange marks and texts ignoring the current location, click
Arrange objects --> Ignore current locations .

Tekla Structures positions the selected drawing objects so that they do
not overlap with other objects without checking the current location of
the objects.

• To arrange the selected marks and notes so that you avoid crossing

leader lines, click Arrange marks on the Annotations tab.
Remember that you first have to select the marks or notes.

See also

Define object protection and placement settings in drawings (page 677)
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4.12 Align selected drawing objects
You can align objects (texts, marks, notes and views) above, below, to the left,
to the horizontal center, to the vertical center and to the right of the point you
pick. You can also position objects horizontally or vertically at equal distances
from each other.

1. In an open drawing, do any of the following:

2. To Do this
Align selected views,
texts, marks, and notes

a. Select the objects that you want to align.

You can select one or several objects using
appropriate selection switches or filters and
area selection, for example. If you want to
align marks and notes only, you can use
Drawing content manager for first selecting
the building objects and then the related
marks or notes.

For more information about Drawing content
manager, see Drawing content manager
(page 278).

b. Select the aligning command from the toolbar:

Click  to align objects above the point you
pick.

Click  to align objects below the point you
pick.

Click  to align objects to the right of the
point you pick.

Click  to align objects to the left of the
point you pick.

Click  to align objects to the vertical center
of the point you pick.

Click  to align objects to the horizontal
center of the point you pick.

Click  to position objects to the vertical
center of the point you pick at equal distances.
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To Do this

Click  to position objects to the
horizontal center of the point you pick at equal
distances.

c. Pick a location for the alignment.

If you have mixed objects selected, such as
views and text objects, you will be asked to
select which objects you want to align.

d. If you selected one of the two commands that
position objects at equal distances, type the
distance in the displayed dialog box and press
Enter.

TIP To create a row of objects, align them first to
the top and then position them horizontally
at equal distances from each other. You do
not need to reselect the objects between the
two commands.

Align selected marks and
notes automatically • Click Align marks --> Auto-align marks 

on the Annotations tab.

This aligns the selected marks and notes by
stacking the marks or notes and placing them
evenly.

This command applies to all marks and associative
notes, except weld marks.

Align selected marks and
notes around a point • Click Align marks --> Align to a point  on

the Annotations tab and pick a point.

This command tries to avoid crossing leader lines
when placing the marks.
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To Do this

This command applies to all marks and associative
notes, except weld marks.

4.13 Drag, reshape and resize drawing objects
Many drawing objects, dimension lines and leader lines of many drawing
objects have handles. You can use these handles to reshape, and resize
objects. You can also drag the objects. If you have activated the Drawing drag
& drop switch, you do not need to select the handles separately to reshape,
resize, or drag.

Drag annotations, sketch objects and grid lines

To drag, resize or reshape:

• In an open drawing, go to the File menu, click Settings and select the
Drawing drag & drop check box. After this, you can move drawing objects
such as annotations, sketch objects and grid lines without selecting the
objects first.

• To move handle points of sketch objects without first selecting the handle
when you have activated Drawing drag & drop: Hold down the left-mouse
button close to the handle point and drag the handle point to the new
position.

Note that if you want to drag the handle points of grid labels, you need to
select the grid line first.
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Drag dimension points

• Straight (linear) dimensions in drawings can be modified by dragging the
dimensions from dimension handles.

• Dragging in single dimension lines: If you try to drag a dimension point to a
new position that is located behind an existing dimension point, the
selected dimension point will be deleted from the old position and
recreated in the new, preferred position. If you try to drag the point to the
same coordinate position where the existing point is already located, the
dragged dimension point is dropped back automatically to the initial
position.

• Dragging in dimension sets: If you try to drag the point into the area
between two points of neighbor dimension line, the selected dimension
point will be deleted from the old position and recreated in the new,
preferred position. If you try to drag the point to the same coordinate
position where the existing point is already located, the dragged dimension
point will be deleted from the old location and will be combined with the
existing one, after dropping to the new location.
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• Dragging a dimension point with a zero coordinate in running dimensions
allows you to change the coordinate of the start dimension point without
running the Set dimension start point command.

• Note that if Drawing drag & drop switch is activated, the dimension point
handle can be dragged without selecting the handle first.

NOTE If you drag a mark, note, text or dimension, its placing setting may be
set to fixed depending what its set for the advanced options listed
below. The mark, note, text or dimension stays where it is even
though you update the drawing. You may want to check the settings
for the following advanced options:

.

See also

Define object protection and placement settings in drawings (page 677)

Adjust part mark leader lines with advanced options (page 836)

Place reinforcement mark leader line base point automatically (page 836)

Drag the mark and associative note leader line start point (page 319)

4.14 Indicate cut lines in Tekla Structures drawings
Cut lines are lines that indicate with zigzag or dash-and-dot lines in different
colors that a part is partially outside the view border.

Edit drawings 350 Indicate cut lines in Tekla Structures drawings



Create cut lines
You can create cut lines to visualize the lines that are partially outside the view
frame. You can create cut lines automatically for all parts in the view, or for
selected parts.

Limitations:

• Cut lines cannot be created for polybeams.

• View extension for neighbor parts setting is not taken into account.

1. On the Drawing tab, click Create cut lines.

2. Do any of the following: 

• Select the type (zigzag or dash-and-dot) for the line from the list of
types.

• Select the color for the line from the color list.

• Enter a scale for the line in the box next to the list of types.

3. Do one of the following: 

• To create cut lines for all parts in the view, select the view.

• To create cut lines for selected parts, select the parts.

4. Click Create.

Example

Update cut lines
1. Open a drawing that contains cut lines.

2. On the Drawing tab, click  Create cut lines.

3. Do one of the following: 

• To update the cut lines of all parts in the view, select the view.

• To update the cut lines of selected parts, select the parts.
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4. Click Create.

Tekla Structures removes all previously created cut lines, and creates new
ones that are up-to-date.

Delete cut lines

1. On the Drawing tab, click  Create cut lines.

2. Do one of the following: 

• To delete the cut lines of all parts in the view, select the view.

• To delete the cut lines of selected parts, select the parts.

3. Click Delete.

4.15 Explode drawing plug-ins and use ordinary drawing
objects
You can explode drawing plug-ins into base objects, and then edit and use
them as any other drawing objects. For example, if you want to modify COG
dimension in a way that is not available for the plug-in in the plug-in
properties, you can explode the COG dimension and then modify its
properties in dimension properties.

1. Click a drawing object that has been created using a plug-in.

2. Right-click and select Explode.

Tekla Structures explodes the plug-in into base objects that are added to the
view. Now you can edit and use the exploded objects as any other drawing
objects through object properties.

4.16 Drawing sketching tools and sketch objects
Sketch objects are objects that you may add in a drawing to highlight important
information, or to indicate positions of openings, windows, doors, and such. In
Tekla Structures drawings, you can use the sketching tools to sketch clouds,
lines, circles, rectangles, arcs, polylines, and polygons, for example. Use these
tools to explode and combine sketch objects, add cover-up outlines and part
faces, and create fillets and chamfers. You can re-order sketch objects and
sketch objects and building objects. You can also trim, extend, split and divide
sketch objects, and copy objects using offset.
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Sketch objects are associative if they have associativity points, i.e. they are
associated to a building object.

Click the following links to find out more about sketching tools and sketch
objects:

Draw sketch objects in drawings (page 353)

Combine and explode sketch objects in drawings (page 357)

Create and add pattern lines in drawings (page 359)

Re-order sketch objects in drawings (page 358)

Trim drawing lines (page 366)

Split sketch objects (page 368)

Divide sketch objects (page 368)

Create fillets in drawings (page 370)

Create chamfers in drawings (page 371)

Copy sketch objects with offset (page 369)

Hide part face areas and outlines with cover-up tools (page 373)

See also

Drawing objects, views and layouts (page 59)

Drawing sketch object properties (page 1017)

Draw sketch objects in drawings
You can create lines, single continuous lines, pattern lines, polygons, polylines,
rectangles, circles, arcs, clouds and cover-up rectangles, lines, polygons and
polylines in an open drawing using sketching tools.

1. Hold down Shift, and on the Drawing tab, click one of the following
commands to modify the object properties first: 

• Line --> Draw line: Sketch a single line between two points you
pick.

•  Line --> Draw single lines continuously : Create multiple single
lines at one go using the current line properties. Press Esc to interrupt.
Tekla Structures creates a continuous line as separate line sections.
You can combine (page 357) the sections into one by using the
Combine command.

Note that for the continuous single line tool, you cannot open the
properties before creating the line by holding down Shift and clicking
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the command on the ribbon. You can change the properties of a
continuous line through the properties of a normal single line.

• Line --> Pattern line: Sketch a line containing a pattern that you
select using the current pattern line properties.

Tip: If you need a new pattern, use the Pattern line editor to create it
(File --> Editors --> Pattern line editor).

• Draw rectangle: Sketch a rectangle between points you pick. You
can create rectangles with horizontal and vertical sides.

• You can change the size of the rectangle by dragging the handles.

• You can explode (page 357) rectangles into single lines.

• To rotate the rectangle, click Move --> Rotate on the Drawing tab.

• Draw circle by center and radius: Sketch a circle by picking the
center point first and then a point on the circle that specifies the
radius.

• Draw circle by three points: Sketch a circle that traverses the
three points you pick, either clockwise or counter-clockwise.

• Draw arc by end points and center: Sketch an arc by specifying
two end points first and then a center point. The center point specifies
the center of the circle of which the arc is a part.

• Draw arc by three points: Sketch an arc that traverses the three
points you pick, either clockwise or counter-clockwise.

• Draw polyline: Sketch a line with straight segments using the
current polyline properties. Remember to set the Bulge for all lines
factor if you are creating curved polylines.

• While sketching a polyline, you can:

• snap to temporary graphical points and set them as reference
points by holding down Ctrl and clicking a point on the
temporary line.

• set multiple reference points using DWG objects and Tekla
Structures building objects.

• delete a reference point by holding down Ctrl and clicking the
point.

• create a polygon by clicking the start point of the polyline.
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• You can delete the selected corner point by right-clicking and
selecting Delete.

• You can add handles by dragging a handle point on the polyline.
You can change the shape of the polyline by dragging the handles.

• You can explode (page 357) a polyline into separate straight lines,
and combine (page 357) polylines into closed polygons.

• Draw polygon: Sketch a polygon by picking the corner points
using the current polygon properties. To close the polygon, pick the
start point again or click the middle mouse button.

• While sketching a polygon, you can:

• snap to temporary graphical points and set them as reference
points by holding down Ctrl and clicking a point on the
temporary line.

• set multiple reference points using DWG objects and Tekla
Structures building objects.

• delete a reference point by holding down Ctrl and clicking the
point.

• You can delete the selected corner point by right-clicking and
selecting Delete.

• You can add handles by dragging a handle point on the polygon.
You can change the shape of the polygon by dragging the handles.

• You can explode (page 357) polygons into single lines.

• Draw cloud: Sketch a cloud that traverses the points you pick.
Close the cloud by clicking the middle mouse button. Remember to set
the Bulge for all lines factor for the clouds.

• Draw cover-up rectangle: Quickly hide building object outlines in
drawings. To use, select the command and sketch a non-transparent
rectangular area (page 373) over the building object outline that you
want to hide. You can change the size of the rectangle by dragging the
handles.

• Draw cover-up line: Quickly hide building object outlines in
drawings. To use, select the command and sketch a non-transparent
line (page 373)over the building object outline that you want to hide.

• Draw cover-up polygon: Quickly hide building object outlines in
drawings. To use, select the command and sketch a non-transparent
polygon (page 373) over the building object outline that you want to
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hide. You can change the shape of the polygon by dragging the
handles.

• Draw cover-up polyline: Quickly hide building object outlines in
drawings. To use, select the command and sketch a non-transparent
polyline (page 373) over the building object outline that you want to
hide. You can change the shape of the polyline by dragging the
handles. You can also explode (page 357) a cover-up polyline into
separate straight lines, and combine (page 357) cover-up polylines into
closed cover-up polygons.

2. Click OK or Apply.

3. Sketch the object by following the instructions on the status bar. 

While using sketching tools

• Object dimensions are shown while you draw the objects, and also when
you select the objects. To hide the dimension of the objects, use the new
Toggle graphical object dimensions command in drawings: Go to Quick
Launch, start typing toggle graphical object dimensions, and
select the Toggle graphical object dimensions command from the list
that appears, or use the Control+d shortcut command to switch command
on and off.When the dimensions are visible, a small d is displayed on the
status bar.

• You may want to activate orthogonal snapping by pressing O while
sketching to show ortho angles. You can define snapping steps (page 51)
and custom angles in Drawing snap settings (File --> Settings --> Snap
settings).

• The view scale is taken into account when you copy sketch objects from
one view to another, which means that the scale of the object and the
related numerical information adjusts to the scale of the target view.

• Sketch object dimensions take into account dimension settings in drawings
in general. This means, for example, that units can be controlled in the
same way as for the other dimensions.

• You can also change the mutual order of sketch objects (graphical objects),
and the mutual order of sketch objects and building objects. You can bring
sketch objects forward or in front of other sketch objects, or send them
backward or behind other sketch objects,. You can also send sketch objects
behind building objects or bring them in front of building objects. You can
also re-order DWGs and images in the same way. For more information,
see Re-order sketch objects in drawings (page 358).

See also

Drawing sketch object properties (page 1017)

Define customized line types in TeklaStructures.lin (page 908)

Edit drawings 356 Drawing sketching tools and sketch objects



Combine and explode sketch objects in drawings
You can explode a polyline, rectangle, or polygon into separate straight lines.
You can also combine separate lines, continuous lines and polylines into a
single polyline or a closed polygon.

Do one of the following:

To Do this
Combine separate lines,
continuous lines or
polylines into a single
polyline or a closed
polygon

1. Select the separate lines or polylines.

2. Go to the Drawing tab and click Combine

.

Separate lines and polyline are combined into a
single polyline or a closed polygon. When you
select the combined shape, you can see that Tekla
Structures has combined the lines and created
more handles in the shape:

Explode a polyline,
rectangle, or polygon
into separate straight
lines

1. Select polylines, rectangles or polygons.

2.
Go to the Drawing tab and click Explode .

The polylines, rectangles and polygons are
exploded into single lines:
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To Do this

See also

Draw sketch objects in drawings (page 353)

Re-order sketch objects in drawings
In drawings, you may want to indicate positions of openings, windows, doors
and such by sketch objects. You can change the mutual order of sketch objects
(graphical objects), and the mutual order of sketch objects and building
objects. You can bring sketch objects forward or in front of other sketch
objects, or send them backward or behind other sketch objects. You can also
send sketch objects behind building objects or bring them in front of building
objects. You can also re-order DWGs and images in the same way.

If you have several sketch objects (objects on several layers), the drawing
order affects on which layer the forward and backward commands place the
objects.

Newly created sketch objects are placed on their own layer in the drawing
order: newer ones on top of the older ones.

1. Right-click a sketch object, DWG or an image and click Re-order.

2. Select one of the following commands: 

• Send backward: Moves the selected object one step closer to the back
of all other sketch objects.

• Send to back: Places the selected object behind all other sketch
objects.

• Bring forward: Moves the selected object one step closer to the front
of all other sketch objects.

• Bring to front: Places the selected object in front all other sketch
objects.

• Send behind model objects: Places the object behind all building
objects. You can also set this option in sketch object properties
( Behind model objects --> Yes ).
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• Bring in front of model objects: Places the object in front of all
building objects. You can also set this option in sketch object
properties ( Behind model objects --> No ).

NOTE • Sketch objects that are placed behind building objects, cannot
be rearranged together with sketch objects that are placed in
front of the building objects.

• You cannot change the mutual order of building objects.

Create and add pattern lines in drawings
You can easily apply special and complex lines to drawings by using pattern
lines. You can create new pattern lines and modify existing pattern lines in
Pattern line editor, and add the created pattern lines in drawings using the
Pattern line command. Pattern lines may include symbols, lines and spacings.
You can create pattern lines to indicate cut lines, foundations, weld paths, or
electrical wiring, for example.

Create a pattern line
1. In the model or when a drawing is open, on the File menu, click Editors --

> Pattern line editor. 

If you have not defined a pattern line earlier, all Pattern line editor fields
and containers are empty.

2. Click Browse... to browse for an image to be used as a sample for the
pattern line. 
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If you do not select an image, the default image will be used.

The selected image is also shown later on when you select a pattern line
in the Pattern line properties dialog box.

3. Enter a name for the pattern line in Create new. If you want to modify a
pattern line, select the desired pattern line from the list first.

4. In the Start element area, click New on the right to create a new start
element. The start element starts the pattern line (marked with red in the
dialog box example below). 

If you select Symbol as the Element type:

• Select the symbol file from the File list.

• In the Index list, enter the number of the symbol. To select a symbol in
a separate window, click Select... and double-click the desired symbol.

• In Space, enter the space allocated for the element in millimeters.

• In Size, enter the size of the element in millimeters.

• In Spacing type, select the spacing type for the elements on the
pattern line:

Fixed: The unoccupied space will not be distributed.
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Variable: The unoccupied space will be equally distributed to the
elements with this spacing type.

Infinite: The blocks will occupy all the space between the two points.
The space will be distributed to fixed elements, and the rest will be
equally distributed to the infinite elements.

• In Color, select the element color.

• In Vertical offset and Horizontal offset, enter offsets for the
elements in millimeters.

• In Rotate, define a rotation angle for the element.

If you select Line as the Element type:

• Select a line type from the Line type list.

• In Space, enter the space allocated for the element in millimeters.

• In Size, enter the size of the element in millimeters.

• In Spacing type, select the spacing type for the elements:

Fixed: The unoccupied space will not be distributed.

Variable: The unoccupied space will be equally distributed to the
elements with this spacing type.

Infinite: The blocks will occupy all the space between the two points.
The space will be distributed to fixed elements, and the rest will be
equally distributed to the infinite elements.

• In Color, select the element color.

• In Vertical offset and Horizontal offset, enter offsets for the
elements in millimeters.

If you select Spacing as the Element type:

• In Space, enter the space allocated for the element in millimeters.
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• In Spacing type, select the spacing type for the elements:

Fixed: The unoccupied space will not be distributed.

Variable: The unoccupied space will be equally distributed to the
elements with this spacing type.

Infinite: The blocks will occupy all the space between the two points.
The space will be distributed to fixed elements, and the rest will be
equally distributed to the infinite elements.

5. In the End element area, click New to create a new end element in the
same way as you did for the start element. 

The end element is marked with red in the editor dialog box:

6. On the Repeating and continuous elements tab, define the elements
that are repeating on the pattern line (marked with red in the editor
dialog box): 

7. On the Repeating and continuous elements tab, define the elements
that are drawn continuously on the pattern line (marked with red in the
editor dialog box): 

8. You can check your pattern line definitions and how the line looks by

clicking the Preview button : 

• If you have the Automatic preview option active, Tekla Structures
automatically opens a drawing preview that shows the created pattern
line with different spacing options taken from the Pattern line
properties dialog box. If you already have a drawing open, Tekla
Structures will ask if you want to save and close the drawing before the
preview is opened.

• To update the preview by clicking the button , select the preview
option.

• You can also see previews of other saved pattern lines by selecting a
pattern line from the list at the top.

• To close the preview, click the Preview button  again.
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9. Save your pattern line by clicking the Save button . The pattern line is
saved in a .clp file in the \attributes folder under the model folder.

Now you can open a drawing and create a pattern line using the pattern line
that you defined.

The symbols in the following example are taken from the
PatternLineSymbols symbol file.

• The symbol at the left end is the start element, symbol #49.

• The symbol at the right end is the end element, symbol #48.

• Blue color is defined for the start and end elements.

• Symbol #51 in red is used as a repeating element.

• Two SolidLines are used as continuous elements with vertical offsets 2.0
and -2.0.

Tip: If your pattern lines are jumping like in the example below, try using
continuous elements instead of repeating elements.

Add a pattern line in a drawing
You may select among predefined pattern lines, or create your own in Pattern
line editor.
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Limitations

• Pattern lines are not included in a 2D Library detail unless the pattern line
has been exploded.

• You cannot rotate or mirror created pattern lines.

• You cannot clone pattern lines.

1. In an open drawing, hold down Shift and click Drawing --> Line -->
Pattern line.

2. In the Pattern line properties dialog box, select the pattern line that you
want to use from the Pattern line list. You can also load other pattern
line properties by selecting a properties file from the list at the top and
clicking Load.

3. Select whether to show the Start element and/or the End element in the
pattern line. The start and end elements are defined in the Pattern line
editor.

4. Select how the elements are aligned and spaced in Spacing options: 

Left aligns the elements to the left.

Right aligns the elements to the right.

Centered centers the elements.

Distributed uses the same space in between the elements.

Best fit tries to fit as many elements as possible with minimal distortion.
This setting affects both element size and space.

5. Set the Size of the pattern line.

6. Select the desired Scaling option: 

View draws the line and elements scaled down to the view.

Paper draws the line and elements scaled down to the scale of the paper.

7. Enter the Vertical offset in millimeters if necessary. A positive value
moves the whole pattern line upwards and a negative value downwards.

8. Select the Color of the pattern line. 
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The color depends on how you set the colors in Pattern line editor and
Pattern line properties:

• If you select Default as the color both in Pattern line editor and in
Pattern line properties, all elements will be black.

• If you select the Default color in Pattern line editor, and you select
another color in Pattern line properties, the color selected in Pattern
line properties will be used.

• If you select some other color than Default in Pattern line editor, and
you select another color in Pattern line properties, the color selected
in Pattern line editor properties will be used.

9. If you want to save the pattern line properties in a properties file, enter a
name for the file and click Save as.

10. Click OK, pick the points for a polyline, and end the line by clicking the
middle-mouse button. Note that you can select the handles in the added
pattern line and move the sections of the polyline by dragging.

Pattern line elements
A pattern line consists of one or several blocks of elements. These element
blocks are arranged between two given points.

The illustration below shows a pattern line consisting of two repeating symbol
elements in three blocks.

The symbol elements have the following settings:

Space = 1.5

Spacing type = Fixed

Size = 1

Color = 1st element is blue, and the 2nd element is red

1. Block size

2. Unoccupied space, which is the space that is left when the blocks are
arranged between two points. This space is redistributed to the elements
which have the spacing type Variable.
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The following illustration describes the different element settings. The letter E
inside a circle is an element:

1. Size of the element

2. Origin

3. Horizontal offset from the origin

4. Vertical offset from the origin

5. Space

Trim drawing lines
You can shorten or extend a line relative to the boundary you select in an
open drawing. The boundary can be a line, part, arc, or rectangle, for example.

1. On the Drawing tab, click Trim .

2. Select the object you want to use as a boundary.

3. Click the middle mouse button.

4. Do one of the following: 

To Do this
Extend the line Click the end of the line to extend it to the boundary line.

Original lines:

The extended line:
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To Do this

Shorten the line
from the left or right
end

Click the line at the end from which you want to shorten it.

Original line:

Line clicked at the left end:

Line clicked at the right end:

See also

Drawing sketching tools and sketch objects (page 352)
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Split sketch objects
You can cut a sketch object into two pieces at a point you select in an open
drawing. You can split lines, polylines, circles, and arcs.

1. Select the line. 

2. On the Drawing tab, click Split.

3. Pick a point on the line to indicate the location for splitting. 

4. Tekla Structures splits the line into two. 

See also

Drawing sketching tools and sketch objects (page 352)

Divide sketch objects
You can divide a sketch object into a number of segments that you specify in
an open drawing. You can divide lines and arcs.

1. Select the line. 

2. On the Drawing tab, click Divide.

3. In the displayed Segments dialog box, enter the number of segments, for
example 4, and click OK.

Tekla Structures divides the line into four lines.

See also

Drawing sketching tools and sketch objects (page 352)
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Copy sketch objects with offset
You can copy lines, circles, polylines, polygons and rectangles in the direction
you point using the offset that you specify. You can also create new circles
centered in the same location as the original circle and adjust the radius by the
offset that you specify.

1. Select the object that you want to copy in a drawing, for example a line or
a circle.

2. On the Drawing tab, click Copy with offset.

3. Click the drawing view in the direction where you want to copy the object.

4. Type the offset in the displayed box , and press Enter. 

Tekla Structures copies the selected shape to the specified direction. For
example, if you are copying a line, Tekla Structures makes a new copy of
the line in the specified location. If you are copying a circle, Tekla
Structures creates a new circle that is centered in the same location as the
original circle, and adjusts the radius by the offset that you specified.

When you copy a line that has a bulge, the created line has the same
bulge as the original one.

If the rectangle has no bulges, the copied object will still be a rectangle
after you use Segments. Note that if the original rectangle has a bulge, it is
not possible to draw a new rectangle using Copy with offset. When you
use segments, the new copied object will become a polygon.

Example

Example of a copied line:

Example of a copied circle:
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Create fillets in drawings
You can connect two intersecting lines by extending the two selected lines to
their intersection point by creating a fillet. If no intersection point is found or if
it is outside the drawing, nothing will be done.

1. Open a drawing.

2. Select two intersecting lines.

3. On the Drawing tab, click Create fillet.
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Create chamfers in drawings
You can create chamfers between two lines using a distance that you specify.
You can create both straight and round chamfers.

1. Select two intersecting lines.

2. Do one of the following: 

• To create a straight chamfer, on the Drawing tab, click Create
straight chamfer.

Enter the distance that you want to have between the two lines (the
length of the chamfer line) in the displayed dialog box.
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• To create a round chamfer, on the Drawing tab, click Create
round chamfer.

Enter the desired radius in the displayed dialog box.

Example

Example of a straight chamfer:

Example of a round chamfer:
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Hide part face areas and outlines with cover-up tools
Use cover-up line, rectangle, polyline or polygon tool for quickly hiding areas
of building object faces or outlines in drawings. Cover-up objects are also
shown in printouts.

1. Open a drawing.

2. On the Drawing tab, click one of the cover-up tools: 

Draw cover-up rectangle
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Draw cover-up line

Draw cover-up polyline

Draw cover-up polygon

3. Pick points and draw a non-transparent area or line over the area that you
want to hide. 

The cover-up object dimensions are shown while you draw it, and also
when the object is selected. You can do the following with cover-up
objects:

• Drag cover-up objects to another location.

• Resize cover-up objects by dragging the handles.

• Reshape polyline and polygon objects by dragging the handles.

Edit drawings 374 Drawing sketching tools and sketch objects



Limitation:The Re-order command in the pop-up menu has no effect on the
cover-up object. To have a cover-up area hiding sketch objects, such as
polygons and polylines, use Re-order for the sketch object and send it behind
model object.

See also

Drawing sketching tools and sketch objects (page 352)

4.17 Building objects in drawings
Building objects are 2D representations of the 3D objects in the model, for
example, parts, bolts, surface treatment, and reinforcement. Building objects
in drawings get their appearance from the automatic drawing settings when
you create a drawing. After creating the drawing, you can change their
appearance in an open drawing.

NOTE If you want to change the model weld properties, go back to the
model, and make the changes there. In the drawing, you can only
change the visibility settings and appearance of the model welds. For
manually added drawing weld marks the properties can be changed in
the drawings.

You can modify building objects in many ways:

Modify building object properties (page 376)

Shorten parts view by view (page 377)

Hide part face areas and outlines with cover-up tools (page 373)

Show a single reinforcing bar in a group (page 396)

Show layer information on reinforcing bars in drawings (page 396)
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Edge chamfers in drawings (page 378)

Fillet edges in drawings (page 382)

See also

Part and neighbor part properties in drawings (page 991)

Bolt content and appearance properties in drawings (page 997)

Surface treatment visibility and content properties in drawings (page 998)

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)

Welds in drawings (page 492)

Modify building object properties
You can modify the drawing properties of the building objects (parts, bolts,
reinforcement, surface treatment, welds, pour breaks, pour objects,
reinforcement) in an open drawing. For example, you can change the color
and how different kinds of lines are shown, or use fills in parts and cross
sections.

Limitations: The color of the center lines can be changed only on the drawing
and view level, not on the object level. For center lines, you can only adjust the
color in object properties dialog box. You can adjust the line type of part
center lines with the advanced option XS_CENTER_LINE_TYPE.

To modify the properties of a building object in a drawing:

1. Double-click a building object, for example a part, reinforcement, surface
treatment, or bolt.

2. Switch all the check boxes off in the dialog box by clicking the on/off

switch  at the bottom of the dialog box.

3. Select the check boxes of only those properties that you want to modify.

4. On the Content tab, select the part representation, whether to show
hidden lines, center lines and reference lines, and which additional
markings to show. 

Note that the center line is only shown for assembly primary parts and
not for secondary parts when looking from the cross section direction. If
the part is viewed from the side, the center line is also shown for
secondary parts.

5. On the Appearance tab, select the color and type of the lines. 

It is easier to adjust the center line color, if you hide the hidden lines on
the Content tab first.

6. On the Fill tab, set the part and section fill options and add hatches.
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7. Click Modify.

See also

Part and neighbor part properties in drawings (page 991)

Bolt content and appearance properties in drawings (page 997)

Surface treatment visibility and content properties in drawings (page 998)

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)

Pour object and pour break properties in drawings (page 1010)

Model weld properties in drawings (page 1015)

Example: Part representations (page 869)

Add hatches (fills) to parts and sketch objects in drawings (page 884)

Shorten parts view by view
You can shorten parts in the selected view in an open drawing. By default,
there is only an empty area shown between the parts, but you can use a
shortening symbol instead, and adjust the shortening symbol color and line
type.

1. Double-click a drawing view frame in an open drawing.

2. In View properties, go to the Attributes 2 tab.

3. In Cut parts, select Yes, Only in x direction or Only in y direction.

4. In Cut skew parts, select Yes to cut skewed parts.

5. In Minimum cut part length, set the minimum length of the shortened
part. 

This option defines how long the part must at least be to get shortened.
The length of the part must be at least twice the entered value.

6. In Space between cut parts, enter the distance between the cut parts on
paper.

7. Click Modify.

TIP To use a view shortening symbol instead of the empty area, set the advanced
options and to TRUE.

You can control the appearance of the view shortening symbol with the
advanced options , , and .

Example

Below is an example where the zig zag shortening symbol is used.
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See also

Shorten or lengthen parts (page 708)

View properties in drawings (page 920)

Edge chamfers in drawings
You can show edge chamfers in drawings, and control the way they are shown
by modifying the part properties and the edge chamfer properties. You can
also add chamfer marks as associative notes.

Show edge chamfers in a drawing
You can select whether to show edge chamfers in your drawing, and the way
they are shown.

1. Open a drawing of a part that has edge chamfers, and double-click the
drawing background to open the drawing properties.

2. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

3. In the Additional marks area of the part properties dialog box, select the
Edge chamfers on/off check box.

4. Select Outline or Exact in the Representation list depending on the
desired result. 
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Exact Outline

5. Save the view properties and click Close.

6. Click Modify.

7. If needed, double-click an edge chamfer and modify the line color and
type in the drawing.

Define default line color and type for edge chamfers
You can define a default color and line type for edge chamfers in drawings.

1. On the File menu, click Settings --> Options and go to the Drawing
objects settings.

2. Define the default line color.

3. Define the default line type.

4. Click OK to save and close the dialog box.

TIP You can override the default settings manually in a drawing by changing the
edge chamfer line color and type in edge chamfer properties.

Change edge chamfer line color and type manually
You can change the line type and color of the edge chamfers in an open
drawing. This overrides the default color and type defined in the Options
dialog box.

1. In the drawing, double-click an edge chamfer to display Edge Chamfer
Properties.

2. Select the desired color and line type. 
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Background color  is often used for edge chamfer lines for the
reason that you may not want to print edge chamfers, or see them in
small scale drawings, but you want to be able select them, for example, to
add chamfer marks.

Example

The following examples show how the edge chamfers are displayed with
different part representation settings:

Part representation Exact.

Part representation Outline,
edge chamfer not selected.

Part representation Outline,
edge chamfer selected.

Add associative notes to edge chamfers
You can add associative notes to edge chamfers.

1. Open a drawing of a part that has edge chamfers.

2. Modify the part properties and edge chamfer properties so that edge
chamfers are visible and you can easily select them.

3. On the Annotations tab, hold down Shift and click one of the commands
in the Note menu to go to the note properties.

4. In associative note properties, modify the note properties as required.

5. Select Edge chamfer from the Content list.

6. Add the elements that you want to have in the edge chamfer mark.

7. Click the edge chamfer. 

If you use a leader line, you need to pick a position for the note.
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Example: Edge chamfers

See below for typical examples of the ways showing edge chamfers.

In this example, Representation is Exact and Edge chamfers are On.
Background color is used in edge chamfer lines, because you usually do not
want to show edge chamfers in printouts, but may want to see and select
them in the drawing, for example, to add associative notes.

In this second example, Representation is Outline and Edge chamfers are
On. Background color is used in edge chamfer lines, because you may want to
see and select chamfers in the drawing, for example, to add associative
notes.This representation is often used when the scale is small and you do not
need to see the small chamfers clearly. The edge chamfer presented in the
bottom right corner of the image shows what the edge chamfer looks like
when it is selected.
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Fillet edges in drawings
Fillet edges are lines that define the boundary between straight faces and
curved faces in the model. Examples of building objects containing fillet edges
are profiles with curved fillets, slabs or contour plates with curved chamfers,
and curved polybeams. The fillet edges can be shown in all drawing types for
parts and pours. Fillet edges are visible by default for new drawings, and
invisible for drawings that are created in a Tekla Structures version earlier
than 2016.

Show fillet edges in drawings
To show the fillet edges, you need to set the option Fillet edges to on. For
profiles, Exact representation might be required to show the fillet edges,
depending on the profile. You can control the fillet edge visibility in Part
properties and in Pour object properties on drawing, view and object level.

To set the fillet edges visible on drawing level in a general arrangement
drawing:
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1. Open a general arrangement drawing that contains steel or concrete
parts with curved faces, for example, profiles with curved fillets, slabs or
contour plates with curved chamfers, or curved polybeams.

2. Double-click the drawing background to display the General
arrangement drawing properties dialog box.

3. Click Part or Pour object.

4. If you need to change part representation (page 991) for profiles, select
Exact from the Part representation list.

5. Under Additional marks, select the Fillet edges on/off check box.

6. If needed, set the hidden lines options: 

• Select the Hidden lines on/off check box to show the hidden lines of
other parts.

• Select the Own hidden lines on/off check box to show the part's own
hidden lines.

7. Click Modify.

Examples

Below is an example of fillet edges in the model:

Below is an example of parts in a drawing showing the fillet edges (Fillet
edges > on):
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Below is an example of parts in a drawing not showing the fillet edges (Fillet
edges > off):
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Show neighbor parts and neighbor reinforcement in
general arrangement drawings
In GA drawings, you can define neighbor parts using neighbor part filters on
the drawing or view settings. The parts that fulfill the filtering criteria will be
treated as neighbor parts. Note that you must also define a filter for normal
parts to get neighbor parts working.

The functionality described below for neighbor parts works in a similar way
also for neighbor reinforcement. At the end of this page, there is an example
filter for neighbor reinforcement.

When you have defined which parts are normal parts and which are neighbor
parts using the filters, you can define the way to show the parts and neighbor
parts, for example, by modifying part and neighbor part properties.

This simple example describes how you can show the normal parts (columns)
in blue, and the neighbor parts (beams) in red. You need to create the
necessary filters, and modify part and neighbor part properties.

1. In an open GA drawing, double-click the drawing background to open the
General arrangement drawing properties.
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2. Go to the General - Filter Properties dialog box and create a filter by
Part - Name and Object - Object type for columns and click Modify.
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3. Go to the General - Part Properties dialog box, and on the Fill tab, select
a fill, set the fill to blue, and click Modify.
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4. Go to the General - Neighbor Part Filter Properties dialog box, create a
filter by Part - Name and Object - Object type for beams and click
Modify.
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5. Go to the General - Neighbor Part Properties dialog box, and do the
following:

• On the Visibility tab, set Neighbor parts to By extreme.

• On the Fill tab, select a fill type, and set it to red.

6. Click Modify.

Now the parts are shown in blue and the neighbor parts in red.

TIP • If you do not want to show the neighbor parts in the GA drawing, use
a part filter for defining and selecting the normal parts, then go to
General - Neighbor Part Properties, and on the Visibility tab, set
Neighbor parts to None.

• Object level settings is another alternative for defining neighbor
parts.

Example of a neighbor reinforcement filter

Below is an example of a filter that filters both neighbor parts and neighbor
reinforcement.
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Spiral beams in drawings
Spiral beams can be show in drawings either folded or unfolded. In unfolded
views, spiral beam is unfolded straight.

For details about creating concrete and steel spiral beams, see and .

In the example below, the Unfolded option is set to Yes and in view properties
on the Attributes 2 tab. Note that the part is cut in the view.

In the following example, the Unfolded option is set to No.
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Dimension spiral beams
You can add straight dimensions, angle dimensions and radius dimensions to
spiral beams.

In the following, the automatic creation of dimensions is explained. You can
also create dimensions in spiral beams in an existing drawing in view level
properties.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

3. Click Dimensioning on the options tree.

4. Add a row and select Spiral beam dimensions as the Dimensioning
type, select the desired dimensioning rule properties and click Edit rule.

5. In the Dimensioning rule properties dialog box, select the dimension
properties that you want to use from Straight dimensions, Angle
dimensions and Angle and radius dimensions. 

If none of the available properties suit your needs, open a drawing, click
Drawing --> Properties --> Dimension, and edit and save the needed
dimension properties so that they are available for selecting in the spiral
beam Dimensioning rule properties dialog box for the three dimension
types.

6. Save the dimension rule properties by entering a unique name and
clicking Save as. 
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7. Save the view properties by clicking Save and return to the drawing
properties dialog box by clicking Close.

8. Click Save to save the drawing properties, then click OK and create the
drawing.

Spiral beam part marks
You can show the rotation of the spiral beam in part marks. The rotation angle
is defined in the spiral beam properties in the model.

• You can add part marks (page 287) to spiral beams in the same way as for
other parts using one of the following ways:

• In an open drawing, select a spiral beam, right-click and select Add
Mark and then select Using applied mark properties to use the
current mark properties, or Using view properties to use view level
mark properties.

• In an open drawing, select a spiral beam, and on the Annotations tab,
click Part mark and select For selected parts.

• You can also define automatic marks (page 826) in drawing properties
before creating the drawing.
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Examples of spiral beam dimensions and marks

The example below shows a straight dimension and a part mark that contains
the rotation angle information:

The following example shows a radius dimension of a spiral beam:
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Reinforcement in drawings
There are several ways in Tekla Structures you can use to affect how the
reinforcement is shown in drawings.

Click the links below to find out more:

Show a single reinforcing bar in a group (page 396)

Show layer information on reinforcing bars in drawings (page 396)

Add reinforcement marks manually (page 398)

Add reinforcement marks with Rebar group marking application (page 398)

Draw rebar pull-out pictures with Draw rebar pull-outs application (page 419)

Draw rebar pull-out pictures with Rebar pull-out picture and marking
application (page 422)

Add dimensions to rebars (page 442)

Dimension rebars with Rebar group dimensioning application (page 451)

Create a drawing view for a reinforcement mesh (page 482)

Define automatic reinforcement and mesh properties (page 896)

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)
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Show a single reinforcing bar in a group
You can show one reinforcing bar in a group or in a mesh and hide the rest.

1. In an open drawing, select the reinforcing bar group or mesh.

2. Go to Quick Launch, enter Adjust Reinforcing Bars, and click the
Adjust reinforcing bars command on the displayed list.

3. Click the bar you want to remain visible.

4. If needed, change the number of visible bars again by double-clicking the
bar and changing the setting.

5. If you want to adjust the location of a single reinforcing bar, right-click the
reinforcing bar group, and click Adjust location. 

Only one bar is displayed, and the others are hidden.

6. Click the location where you want to place the bar.

NOTE When you use the Adjust reinforcing bars command to select the visible
reinforcing bar, also the customized setting becomes available for the
Visibility of reinforcing bars in group option in drawing reinforcement
properties. You can use this setting only after you have used the Adjust
reinforcing bars command and not, for example, when you create the
drawing.

Example

Show layer information on reinforcing bars in drawings
You can mark reinforcing bar layers with different marking styles and line
types in a drawing by using the Rebar layering marker macro.

Before you can show layer information in a drawing, you first need to run the
Rebar classification macro in the model. The Rebar classification classifies
the meshes and reinforcing bars in the selected walls or slabs by their
position. All reinforcing bars and meshes get an attribute indicating the layer
where they are placed inside the concrete element.

To show reinforcing bar layer information in a drawing:
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1. Open the drawing.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. Double-click Rebar layering marker to display the Rebar layering
marker dialog box.

5. Select symbol style or level prefix style from the list on the left showing
the preview.

6. Select the marker line type.

7. Do one of the following depending on the selected marking style: 

• For symbol style markers, select the symbol you want to use, and the
symbol height.

• For level prefix style markers, select the level prefix.

8. Click All objects to show layering markers on all reinforcing bars, or select
the individual reinforcing bars and click Selected objects to show the
markers on the selected bars only.

1. Level prefix style layering marker. The number, for example number 1 in
T1, indicates the layer number. The letter, for example T in T1, indicates
whether the reinforcing bar is on the top, bottom, near side or far side
layer.

2. Symbol style layering marker. The number of triangles indicates the layer
number from the face. Triangle orientation indicates whether the
reinforcing bar is on the top, bottom, near side or far side layer. For
example for top bars, the triangle head points downwards, and for
bottom bars upwards.
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Add reinforcement marks manually
You can add marks manually to reinforcing bars and meshes in drawings.

The reinforcement marks may already exist in a drawing if you have selected
to create the marks at drawing creation (page 826). If there are no marks, you
can add them manually.

1. Open a drawing that contains reinforcement.

2. If you want to adjust the reinforcement mark properties, do one of the
following depending on whether you want to use the current
reinforcement mark properties or view level reinforcement mark
properties: 

• To adjust the current reinforcement mark properties, such as color
and mark elements included, on the Drawing tab, click Properties -->
Reinforcement mark . When you have made the necessary
adjustments, click Apply or OK.

• To adjust the view level reinforcement mark properties, double-click
the view frame, click Reinforcement mark in the options tree and
adjust the properties. Click Modify.

3. Select the reinforcement by doing one of the following: 

• Hold down Shift and select the desired reinforcement.

• Open the Drawing content manager, and click Show to populate the
Drawing content manager list. You can select areas, single or
multiple views, or individual reinforcement. Then ensure that building

object selection is active , and select the desired reinforcement
from the list.

4. Right-click and select Add Mark, and select Using applied mark
properties to use the current reinforcement mark properties, or Using
view properties to use the view level reinforcement mark properties. 

The reinforcement marks are created.

Note that if you have not added any elements in the reinforcement mark
properties before adding the reinforcement marks, the properties dialog
will be displayed.

Add reinforcement marks with Rebar group marking application
The Rebar group marking application offers different styles to create marks
to rebar groups and distribution areas flexibly. With the Rebar group
marking application you can efficiently create quality reinforcement drawings
according to the market requirements.

Mark rebar groups

1. In a drawing, select the rebar groups to be marked.
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2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. In the Applications list, click Rebar group marking.

5. Pick the position for the leader line.

6. Pick the position for the mark.

7. To adjust the mark settings, double-click the mark, and make the
necessary changes: 

• On the Geometry tab, define the shape and position of the rebar
mark, and mark line and leader line settings.

On the Mark 1–Mark 3 tabs, define the content for the rebar mark,
such as the diameter, cc distances and the number.

On the Lines and symbol tab, define the generation of distribution
and leader lines, the color of the lines, and the line type. You can also
define the symbol created at the intersection of distribution lines and
leader lines.

• On the Symbols on rebars tab, define the lines and symbols for the
rebar mark.

For more information about the settings, see Rebar group marking
settings below.

8. Click Modify.

Tekla Structures creates the rebar marks according to the defined settings.

Rebar group marking settings

Geometry tab

On the Geometry tab, define the shape and position of the rebar mark, and
the mark line and leader line settings.

Setting Options and descriptions
Define the shape of the rebar mark. In the
descriptive option images, P1 is the first point that
you pick and P2 the second one. Mark x indicates
the locations of the marks defined on the Mark 1–
Mark 3 tabs. The options are:

Option 1:
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Setting Options and descriptions

• The leader line is perpendicular to the rebars.

• The mark line is parallel to the rebars.

Example:

Option 2:

• The leader line is perpendicular to the rebars.

• The mark line is also perpendicular to the
rebars.

Example:
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Setting Options and descriptions

Option 3:

• The leader line is perpendicular to the rebars.

• The mark line is horizontal.

Example:
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Setting Options and descriptions

Option 4:

• The leader line is perpendicular to the rebars.

• The mark line is vertical.

Option 5:

• The leader line direction is defined by an angle
relative to the rebars. The angle can be entered
for the option A2.
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Setting Options and descriptions
• The mark line direction is defined by an angle

relative to the horizontal line. The angle can be
entered for the option A1.

Option 6:

• See the image above to see how to pick the
points P1 and P2. Use the option B to define
the distance of the marks.
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Setting Options and descriptions
Define the shape of the leader line. The available
options depend on the selected mark line option.
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Setting Options and descriptions
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Setting Options and descriptions
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Setting Options and descriptions

You can also affect the shape of the leader line for
many of the options with the settings d1, d2, h, v,
and e.
Define the shape of the mark line. The options are
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Setting Options and descriptions

You can also affect the shape of the mark line for
some of the options with settings b1, b2, a, andc,
and e
Define an offset for Mark 3 from the mark line.

Mark 1–Mark 3 tabs

On the Mark 1–Mark 3 tabs, you can define the content of the rebar marks.
You can have three separate marks with the desired content within one rebar
mark: Mark 1, Mark 2 and Mark 3. Each of the marks may have extra marks.
The following image shows the position of each mark within the entire rebar
mark:
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Setting Options and descriptions
Available elements Select the rebar information to be displayed in the

mark such as grade, diameter and cc distances.
Elements in mark List of the selected information that will be

displayed in the mark.
Text properties Define the text properties. The available properties

files are the ones that have been defined and
saved in Text properties (page 320).

Add frame Add frame around mark elements. You can select
the frame type and color.

Note that symbo al, new line and pull-out picture
cannot have a frame.

Create Define whether the mark should be created or not.
The options are Yes and No.

Extra mark: Create Define whether and how the extra marks are
placed in the mark. The options are:

No

Before main mark

Behind main mark
Units Define the units:

• Automatic

• mm

• cm

• m

• foot - inch

• inch

Only available for the following mark content:
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Setting Options and descriptions
• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Format Define the format:

• ###

• ###[.#]

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Precision Define the precision:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16

• 1/32

• 1/10
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Setting Options and descriptions
• 1/100

• 1/1000

For example, for precision 0.33, the actual value
50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Sum of exact lengths

Length along rebar
axes

Sum segm rebar axis

Length TplEd

Sum of exact lengths:

If you select Length along rebar axes, the length
is calculated along the center line of the rebar:

Sum segm rebar axis counts rebar lengths from
rebar geometry. This option does not take into
account bending radius lengths.

Length TplEd takes rebar length from template
attribute (user attribute property LENGTH).

These options are only available for some of the
following mark content:

• Length

• Cc

• cc min

• cc max
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Setting Options and descriptions
• cc exact

• cc target
Total number in rebar
group

Number displayed in
view

Total number in cast
unit

These options are only available for mark content
Number.

Total number in rebar group: Displays the total
number of rebars in the rebar group, regardless of
the number of the physically visible rebars in the
drawing.

Number displayed in view: Only displays the
number of the visible rebars in the drawing view.

Total number in cast unit: Displays the total
number of rebars in the cast unit.

Row distance Define the distance between the mark rows.

Example: Row distance = 0

Example: Row distance = 5
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Setting Options and descriptions

Define the distance of the mark text from the
leader line.

Mark rotation Define how to rotate the mark text. You can rotate
the mark text horizontally and vertically or to the
mark line direction (default).

Extra line length When Mark 1 and Mark 2 have no text, the extra
line length setting on the Mark 3 tab is activated.
Specify the length of the line.

Lines and symbol tab

On the Lines and symbol tab, you can define the generation of distribution
and leader lines, the color of the lines, and the line type. You can also define
the symbol created at the intersection of distribution lines and leader lines.
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Setting Options and descriptions
Distribution line: Color

Distribution line: Line
type

Leader line: Color

Leader line: Line type

Define the Color and Line type for the
Distribution line and the Leader line.

Symbol between
distribution and leader
line

Set Show to Yes to show a symbol between
distribution lines and leader lines. Then select the
symbol file that you want to use and the symbol
number. You can also change the symbol color and
size.

Symbols on rebar tab

On the Symbols on rebars tab, you can define the lines and symbols for the
rebar mark.

Setting Options and descriptions
Visualized rebar s:
Small lines

Visualized rebar s:
Symbols

Define the generation of the symbols and lines on
the dimension lines of the visible rebars. The
options are:

Examples:
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Setting Options and descriptions

: Define the color and the line type
for the lines.

: Define the symbol file
and symbol number to be used. You can use
existing symbols in Tekla Structures by selecting a
symbol file and a symbol number.

: Define the color and the size of the
symbol.

Not visualized rebars

First and last rebar

The settings listed below only apply for Not
visualized rebars and Not visualized rebars. The
settings are only applicable if the option bar in the
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Setting Options and descriptions
middle of group is defined (page 1001) for
Visibility of reinforcing bars in group in
reinforcement properties.

Define if symbols/lines should be applied for Not
visualized rebars or Not visualized rebars.

Example of Not visualized rebars:

Example of Not visualized rebars:

Define the generation of the symbols and lines for
the dimension line. The options are:
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Setting Options and descriptions

: Define the color and the line type
for the lines.

: Define the symbol file
and symbol number to be used. You can use
existing symbols in Tekla Structures by selecting a
symbol file and a symbol number.

: Define the color and the size of the
symbol.
Define how to place the symbols. The options and
their examples are listed below:
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Setting Options and descriptions
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Setting Options and descriptions

You can define the distance between the lines by
using the setting a if that is available for the option.

Draw rebar pull-out pictures with Draw rebar pull-outs application
The Draw rebar pull-outs application creates exploded drawings of
reinforcement using the settings defined in Rebar pull-out picture and
marking or in associative notes. The application can be used for creating pull-
out pictures automatically for multiple rebars at one go. To optimize flexible
working with different types of drawings, use Draw rebar pull-outs together
with Rebar pull-out picture and marking.

The application creates rebar pull-out pictures based on the objects that you
select. You can select:

• Reinforcement: Bending shapes are only created for the selected rebars.

• Parts: Bending shapes are created for rebars in the selected concrete part.

• Views: Bending shapes are created for rebars in the selected drawing view.

• A drawing from the Document manager: Bending shapes are created for
rebars in the selected drawings.

Draw pull-out pictures

1. In the drawing, select the object for which you want to create pull-out
pictures: reinforcement, parts, views, or a drawing from the Document
manager.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. In the Applications list, double-click Draw rebar pull-outs. 
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5. Define the type of method, the positions of the bending shapes, and other
necessary settings: 

Create pull-outs by Rebar pull-out picture and marking:

• Create the bending shapes on the basis of a
saved Rebar pull-out picture and marking
properties file.

Define and save the properties in the Rebar
pull-out picture and marking application,
which can be started from the Applications &
components catalog.

• In the Configuration file list, select the desired
settings file.

Associative note:

• Create the bending shapes on the basis of a
saved associative notes properties file.

• Define and save the properties in associative
note properties. It is important to define at
least one pull-out properties file for associative
notes.

Create pull-out for Each rebar position number: A bending shape is
created for each rebar position number.

Each rebar group: A bending shape is created for
each rebar group.

Position Defines the position of the bending shapes relative
to the concrete part. The options are:

Above and bottom: Positions the bending shapes
above and at the bottom of the concrete part.
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Bottom: Positions the bending shapes at the
bottom of the concrete part.

Above: Positions the bending shapes above the
concrete part.

Left: Positions the bending shapes on the left side
of the concrete part.

Right: Positions the bending shapes on the right
side of the concrete part.

Classes Include or exclude the defined rebar classes.

Define the class of the rebars. Use the Exclude or
Include to define whether to create a bending
shape for those rebars.

Rebar types Include or exclude the defined bending shapes.

Here you can define the shape codes of the rebars.
Use Exclude or Include to define whether to
create a bending shape for those rebars.

You can inquire the shape code of a rebar by

clicking Inquire object  on the ribbon.

6. Click Draw.
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Examples:

Draw rebar pull-out pictures with Rebar pull-out picture and marking
application
With the Rebar pull-out picture and marking application you can visualize
rebars by using bending shapes. Bending shapes can be positioned both
inside and outside the concrete shape. Bending shapes are provided with
marks containing information about the rebar.

Create rebar pull-out pictures and marks

1. In a drawing, select the rebar group for which you want to create a
bending shape mark.
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2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. In the Applications list, select Rebar pull-out picture and marking.

5. Pick a point for the position of the bending shape mark. 

Note that you change the alignment setting for placement in the settings.

6. Double-click the mark to adjust the settings: 

• On the Rebar tab, define the representation and the location of the
bending shape. Here you can also define the hook directions.

• On the Mark 1 and Mark 2 tabs, define the content, appearance and
the position of the marks associated with the bending shape.

• On the Dimensions tab, define how the dimensions are displayed, and
how the rounding is performed.

For more information about the settings, see Rebar pull-out picture and
marking settings below.

7. Click Modify.

Rebar pull-out picture and marking settings

Rebar tab

On the Rebar tab, define the representation and the location of the bending
shape. Here you can also define the hook directions.

Setting Options and descriptions
Rebar geometry Select one of the following options:

This is a schematic representation of the bending
shape, without bending radius in the corners of the
bending shape.

In this option, the bending shape is represented
with bending radius.

Use same line as
pattern

• Yes: The color and line type are defined based
on what is set in the drawing properties.
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Setting Options and descriptions
• No: The color and line type are defined based

on the Color and Line type settings in this
dialog box.

Color

Line type

Reinforcing bar
representation

Select the rebar representation:

• Single line: The bending shape is represented
with a single line.

• Double lines nominal diameter: The bending
shape is represented with double lines. The
nominal diameter of the bar is considered.

• Double lines actual diameter: The bending
shape is represented with double lines. The
actual diameter of the bar is considered,
including the ribs on the bar.

Rebar location Define the position of the bending shape using any
of the options described below:

Option 1:
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Setting Options and descriptions
In this option, the area around the rebar is divided
in four quadrants. The insertion point can be
picked in any random quadrant.

The position of the bending shape is based on the
picked quadrant:

• Insertion point in quadrant 1: the bending
shape is centered on top of the rebar.

• Insertion point in quadrant 2: the bending
shape is centered to the left of the rebar.

• Insertion point in quadrant 3: the bending
shape is centered under the rebar.

• Insertion point in quadrant 4: the bending
shape is centered to the right of the rebar.

Example:

Option 2:

In this option, the insertion point P1 is the start
point of the bending shape.

Example:
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Setting Options and descriptions

Option 3:

In this option, the bending shape is located on the
line of the insertion point P1. The bending shape
will be positioned centered relative to the position
of the rebar in the concrete shape.

Example:
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Setting Options and descriptions

Option 4:

This option creates marks and hooks for all rebars
in the view.

Rotation of bars
perpendicular to view

Rotate rebar pull-out pictures vertically or
horizontally. This setting affects single bars
perpendicular to the view only.

Custom rotation angle Rotate all pull-out pictures using the same rotation
angle.

Hook directions Define the direction of the hooks of the bars. Seen
from a top view from a beam, for example, the
direction of the hooks may be defined as Top,
Middle and Bottom of the the beam. For all of the
directions, you can select between two options:

Use the Thickness box to define an area for the
bars on the top and bottom side of the beam.
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Setting Options and descriptions
Example 1: In the front view of a concrete beam
below, both the Top and the Bottom thicknesses
are set to 300:

Example 2: Top view of a concrete beam

Example 3: Top view of a concrete beam with other
hook directions
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Setting Options and descriptions

Presentation options When set to Yes, Exaggeration exaggerates a
shape when the reinforcing bar parts are
overlapping. This setting works in a way similar to
the pull-out pictures in rebar marks.

In the following example, Exaggeration is set to
Yes.

Shorten bars longer than allows you to set a
maximum output length for long bars. If the
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Setting Options and descriptions
boundary of the shape exceeds the maximum
length, the pull-out picture is shortened with cut
lines. Use this setting especially for straight bars or
straight bars with hooks.

In the following example, Shorten bars longer
than is set to 1000.00.

Mark 1 and Mark 2 tabs

On these tabs, you can define the generation of Mark 1 and Mark 2. For
example:

Settings Options and descriptions
Available elements Select the rebar information to be displayed in the

mark, such as grade, diameter, and cc distances.
Elements in mark A list of the selected information or elements that

will be displayed in the mark.
Text properties Define the text properties. The available properties

files are the ones that have been defined and
saved in Text properties (page 320).

Rebar text properties Define the text properties for the rebar position.
The available properties files are the ones that
have been defined and saved in Text properties
(page 320).

Number of rebars Total number in rebar group: Displays the total
number of rebars in the rebar group, regardless of
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Settings Options and descriptions
the number of the physically visible rebars in the
drawing.

Number displayed in view: Only displays the
number of the visible rebars in the drawing view.

Total number in cast unit: Displays the total
number of rebars in the cast unit.

These options are only available when you select
Number as the mark content.

Units Define the units:

• Automatic

• mm

• cm

• m

• foot - inch

• inch

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Format Define the format:

• ###

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Only available for the following mark content:

• Length

• Cc
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Settings Options and descriptions
• cc min

• cc max

• cc exact

• cc target

• Length itemized
Precision Define the precision:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16

• 1/32

• 1/10

• 1/100

• 1/1000

For example, for the precision 0.33, the actual
value 50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Mark positioning Define the positioning of the mark. There are three
options available:

Option 1:

Mark text parallel is to the bending shape.

Option 2:

Mark text is placed horizontally.

Option 3:
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Settings Options and descriptions

Mark text is placed vertically.
Horizontal text position Define the position of the text in the horizontal

direction. The options are:

Use the setting a to define a distance:

Vertical text position Define the position of the text in the vertical
direction. The options are:
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Settings Options and descriptions

Use box b to define a distance:

Dimensions tab

On the Dimensions tab, you can define how the dimensions are displayed,
and how the rounding is performed.

Note that to allow duplicate dimensioning, set PullOutShowDuplicateDims
to the desired value in the rebar_config.inp file. For example, 
PullOutShowDuplicateDims=3 shows all dimensioning, and 
PullOutShowDuplicateDims=0 does not show duplicate dimensions. The
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default value is 0. For more informaton, see Reinforcement settings for
drawings (rebar_config.inp) (page 1004)

Settings Options and descriptions
Create Define whether all bending dimensions are

displayed with the bending shape or not. The
options are:

• Yes

• No

Generation of leg
lengths

Define the generation of the length of the legs,
marked in the image below:

Option 1:

Option 2:
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Settings Options and descriptions

Option 3:

Tapered lengths To dimension rebars when the rebars are of
different lengths, select Yes.

Location Define the location of the length of the leg, marked
in the image below:

The options are:
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Settings Options and descriptions
• None

• (1)

• (2)

• (3)

• (4)
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Settings Options and descriptions
• (5)

• (6)

Round settings Define whether the rounding is performed by user
settings or by rebar_config.inp.

If you select to use rebar_config.inp, you
cannot define the units, precision, and format.

Units Define the units. The options are:

• Automatic

• mm

• cm

• m

• foot - inch

• inch
Format Define the format. The options are:

• ###

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###
Precision Define the precision. The options are:

• 0.00
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Settings Options and descriptions
• 0.50

• 0.33

• 0.25

• 1/8

• 1/16

• 1/32

• 1/10

• 1/100

• 1/1000

For example, for the precision 0.33, the actual
value 50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Text properties Define the properties for the text that will be
displayed for the bending shape (length of the
legs). The available properties files are the ones
that have been defined and saved in Text
properties (page 320) .

Length calculation Exact length:

If you select Along rebar axis, the length is
calculated along the center line of the rebar:
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Angle dimensions In Create, define whether you want to show the
bending angles of the rebar pull-outs.

The options are:

• Yes: Shows the bending angles.

• Dimension lengths: Creates perpendicular
dimensions when the bar shape gets a not 90º
angle that returns to parallel or perpendicular
to the original bar leg. This option is useful for
complex bends that will normally be done on-
site.
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• Both dimensions: Creates both Dimension

lengths type of dimensions and basic angle
dimensioning.

You can also define the Text properties for the
bending angles. The available properties files are
the ones that have been defined and saved in Text
properties (page 320) .

Define the Format for angle dimensions. The
options are:

• ###

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Define the Precision for angle dimensions. The
options are:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16

• 1/32

• 1/10

• 1/100
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Settings Options and descriptions
• 1/1000

You can also define a Color and Line type for the
angle dimensions.

Add dimensions to rebars
You can manually add dimension lines and dimension marks to reinforcing bar
groups. When adding dimensions, start by using predefined dimension
settings defined for your environment, and modify these settings for individual
dimensions, if necessary.

Each reinforcing bar group may have a dimension mark, tagged dimension
mark and/or a dimension line. The dimensions are created based on
dimension properties defined in the Rebar dimension mark properties dialog
box (page 939). The command for creating the rebar dimension marks is
available in GA drawings and cast unit drawings.

• You may want to add reinforcement dimension marks or tagged dimension
marks especially in concrete cast unit drawings, where there is only one
reinforced cast unit visible.

• The dimension lines or distribution lines show the distribution of the
rebars in the group, and typically draw dashed lines from the dimension
lines to the rebars when you drag the dimension outside the rebar group.
You may want to use distribution lines especially in GA reinforcement
drawings, because they may contain a lot of parts with rebar groups, and
you often need to show only one rebar from the group and drag the
dimension line to a proper place to see everything clearly.

• When adding dimensions, start by using predefined dimension settings
defined in your own environment, and modify these settings for individual
dimensions, if necessary.

The Default environment contains the following rebar dimension settings files
to be loaded in the Rebar dimension mark properties dialog box:

• rebar_dimension_line for creating distribution lines

• rebar_dimension_mark for creating dimension marks

• rebar_tagged_dimension_mark for creating tagged dimension marks

For more information about typical settings, see section "Typical dimension
mark, tagged dimension mark, and dimension line settings" below.

In addition to the rebar dimensioning methods described below, you can also
dimension rebars by using the Rebar group dimensioning application, for
more information, see Dimension rebars with Rebar group dimensioning
application (page 451).
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Add dimensions to rebar groups

To add dimension marks, tagged dimension marks or dimension lines to rebar
groups:

1. First open the dimension properties by pressing down Shift and clicking
the Rebar command on the Dimensioning ribbon tab.

2. Load one of the predefined rebar dimension settings, or go through the
properties on the various tabs in the Rebar dimension mark properties
dialog box (page 939), and see if you want to modify something.

3. Click Apply.

4. Select a reinforcement in the drawing.

5. If you had selected fixed (default) as the Placing option in rebar
dimension properties, you will be asked to pick a position. 

The rebar dimension is created. You can continue picking more
reinforcing bar groups, or stop creating rebar dimension by pressing Esc
on the keyboard.

TIP You can also add rebar dimension marks with the Add Mark -->
Dimension Mark command on the context menu, or with the Add
rebar dimension mark command in Quick Launch. You can also
create a keyboard shortcut for the command.

Below is an example of dimension marks:

Below is an example of tagged dimension marks:
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Below is an example of dimension lines:

Below is an example of the dimension line when it has been dragged
outside the reinforcing bar group:
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Below is an example, where only one rebar of the group is visible, and the
dimension line has been dragged outside the group.

You can change the representation of the current rebar dimension after
creating it by double-clicking the rebar dimension in an open drawing, and
modifying the dimension properties as required. For example, you may want
to add more tags, change dimension mark content, or select how to align tags
in curved dimensions.

Note that you cannot change the following properties when you have a
drawing open and you are editing a rebar dimension mark:

Dimension to

Part edge

Tapered dimension type

Curved dimension type

Placing rebar dimensions

During manual dimension creation the Placing setting is considered as
follows:

• If you have selected more than one rebar object, the Dimension Mark
command ignores the fixed option and automatically places the rebar
dimension mark for each selected rebar object.

• If you have selected only one rebar object, and Placing is set to fixed, you
will be prompted to pick a position for the dimension.

• If you have selected only one rebar object, and Placing is set to free, the
dimension will be placed automatically.

• With the Rebar command on the ribbon, you can create rebar dimension
marks without selecting a rebar object first. In this case, you will be
prompted to pick a rebar object:

• If Placing is set to fixed, you will be prompted to pick a position for the
dimension, and if Placing is set to free, the dimension will be placed
automatically.

• After the dimension has been placed either manually or automatically,
you will be prompted to pick another rebar object.
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Typical dimension mark, tagged dimension mark, and dimension line settings

rebar_dimension_mark.rdim
Dimension to: All rebars

Subgrouping: Yes

Extension line to visible rebar: No

Combine equal dimensions: 3*60=180

Minimum number to combine: 1

Set Prefix in Dimension mark content.

Set Visibility of numeric value to Hidden in Dimension mark content.

rebar_tagged_dimension_mark.rdim
Dimension to: All rebars

Subgrouping: Yes

Extension line to visible rebar: No

Combine equal dimensions: 3*60=180

Minimum number to combine: 1

Set the appropriate tag contents.

rebar_dimension_line.rdim
Dimension to: Start and end rebars

Subgrouping: No

Extension line to visible rebar: Yes

Combine equal dimensions: Off

Create dimension marks to all rebars
You can add dimension marks to all rebars at one go with the Create
dimension marks to all rebars application. This application creates any type
of rebar dimension mark.

1. Open a drawing with rebars.

2. To open rebar dimension properties, select Drawing --> Properties -->
Rebar dimension mark on the ribbon.

3. Adjust the properties if necessary and click Apply.

4. Click the Applications & components button  in the side pane to
open the Applications & components catalog.
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5. Search for the Create dimension marks to all rebars application, and
double-click the application.

Rebar dimension marks are created for all rebars according to the defined
rebar dimension mark properties.

Examples of rebar dimensions

• Below is a tapered skewed part, and the dimension line follows the shape
of the edge that is closest to where you pick. The dimensions have skewed
representation.

• Below is a tapered curved part, and the dimensions have curved
representation.
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• Below is an example of curved orthogonal dimensions of a tapered curved
rebar group with a dimension tag:

• You can also add middle tags in rebar dimensions. Here dual dimensions
(page 209) have been applied:
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• Curved dimension tags can be aligned by selecting one of the options in
the Curved Dimension Tag Type list in the Dimension Properties dialog
box:

In the example below, only one rebar is visible, and rebar tags are aligned

vertically :
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In the example below, the dimension tag follows the dimension curve

:
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• Below is an example of curved orthogonal dimensions of a radial
reinforcing bar group.

Dimension rebars with Rebar group dimensioning application
The Rebar group dimensioning application offers different styles for
presenting rebar group dimension lines and dimension marks flexibly. For
example, you can mark and dimension multiple stirrups at one go. The Rebar
group dimensioning helps you to efficiently create quality reinforcement
drawings according to the market requirements.

Add dimensions to rebar groups

1. In a drawing, select the rebar groups to be dimensioned.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. In the Applications list, select Rebar group dimensioning.

5. Pick a location for the dimension line in the model.

6. Double-click the dimension to adjust the settings: 

• On the Parameters tab, define what the dimensions look like and
what it contains. You can also define the content of the stirrup
dimension marks.

• On the Extra marks in front and Extra marks behind tabs, create an
extra mark in front of or behind the dimension line.

• On the Advanced settings tab, define the offsets, spaces and cc
distances for the stirrup dimension marks.

• On the Rebar lines tab, define the generation and the appearance of
the leader lines belonging to the stirrup dimensions.

For more information about the settings, see Rebar group dimensioning
settings below.
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7. Click Modify.

Rebar group dimensioning settings

Parameters tab

Setting Options and descriptions
Annotation type Select the annotation type. The options are:
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Setting Options and descriptions

Define the positioning of the mark. The available
options depend on the selected Annotation type
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Setting Options and descriptions
Angle option. You can also define the mark angle in the

Angle box. The options are:
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Setting Options and descriptions

Mark position examples:
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Setting Options and descriptions

In the example below, the mark angle has been
defined.
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Setting Options and descriptions

Group number

Define the number and the location of the mark
leader lines. You can also indicate which group you
are working with by entering the group number in
the Group number box.

This option is available for certain annotation types
only. The options are:
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Setting Options and descriptions

In the following example, group number 2 is
defined.

In the following example, group number 2 is
defined.
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Setting Options and descriptions

Consider irregular
spaces as separate
groups

Yes

No

Dimension each CC
distance

Yes

No

Combine dim. between
rebar - dim.

Allows you to combine the dimensions of the
distance between two rebar groups with the
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Setting Options and descriptions
dimensions of the rebar group where the spacing
is the same as the distance between the groups. It
also combines the first/last group dimension line
with the distance to the part end if the distance to
the border is the same as the rebar group spacing.

For an example, see the section "More examples"
below.

Distribution line
properties

Select the desired dimension properties for the
displayed dimension line by selecting a dimension
properties file. The available properties are the
ones that have been defined and saved in
Dimension Properties (page 928).

Available elements Select the information to be displayed in the mark
such as grade, diameter and cc distances for mark
1 and mark 2.

Elements in mark List of the information that you have selected to
display in mark 1 and mark 2.

Text properties Define the text properties. The available properties
files are the ones that have been defined and
saved in Text properties (page 320).

Position Select where you want to place the mark. The
options are:

• Automatic: Mark 1 is positioned above the
dimension text, when the dimension is above
the part, and under the dimension text when
the dimension is under the part.

• Above dim. text: Mark 1 is always positioned
above the dimension text.

• Below dim. line: Mark 1 is always positioned
below the dimension text.

When placing the mark, the dimension text font
size for the above text position and the spacing
values defined on the Advanced settings tab for
both positions are considered. This setting is only
available for the non-radial annotation types.

Units Define the units:

• Automatic

• mm

• cm

• m

• foot - inch
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Setting Options and descriptions
• inch

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Format Define the format:

• ###

• ###[.#]

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Precision Define the precision:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16
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Setting Options and descriptions
• 1/32

• 1/10

• 1/100

• 1/1000

For example, for precision 0.33, the actual value
50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Sum values A B C

Sum segm rebar axis

Length TplEd

These options are only available for the following
mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target
Mark 2 position Define whether and how the rebar position is

displayed in mark 2. The options are:

Not

Before main mark

Behind main mark

Above main mark

Below main mark
Mark 2 frame Select the frame type and color for the mark 2.

This option is available for certain annotation types
only. The options are:
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Setting Options and descriptions

Extra marks in front and Extra marks behind tabs

Setting Options and descriptions
Marks in front of the
dimension line

To create marks in front of the dimension line,
select Yes. No is the default value.

Marks behind the
dimension line

To create marks behind the dimension line, select
Yes. No is the default value.

Available elements Select the information to be displayed in the mark
in front of or behind the dimensions line.

Elements in mark List of the information that you have selected to
display in the mark in front of or behind the
dimensions line.

Text properties Define the text properties for the marks. The
available properties files are the ones that have
been defined and saved in Text properties
(page 320).

Position Define whether and how the rebar position is
displayed in marks. The options are:

No

Before main mark

Behind main mark
Text properties Define the text properties for the rebar position.

The available properties files are the ones that
have been defined and saved in Text properties
(page 320).

Number Select how to show the number of rebars. The
options are:

Total number in rebar group

Number displayed in view

Total number in drawing
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Total number in cast unit

These options are only available for the Number
element.

Units Define the units:

• Automatic

• mm

• cm

• m

• foot - inch

• inch

Only available for the following

content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target

• Length itemized
Format Define the format:

• ###

• ###[.#]

• ###[.##]

• ###[.###]

• ###.#

• ### #/#

• ###.##

• ###.###

Only available for the following mark content:

• Length

• Cc

• cc min

• cc max
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Setting Options and descriptions
• cc exact

• cc target

• Length itemized
Precision Define the precision:

• 0.00

• 0.50

• 0.33

• 0.25

• 1/8

• 1/16

• 1/32

• 1/10

• 1/100

• 1/1000

For example, for precision 0.33, the actual value
50.40 is displayed as 50.33.

1/8, 1/16, and 1/32 are for imperial units.

1/10, 1/100, and 1/1000 are used for defining
precision without rounding.

Sum values A B C

Sum segm rebar axis

Length TplEd

These options are only available for the following
mark content:

• Length

• Cc

• cc min

• cc max

• cc exact

• cc target
Mark placement settings

The options 3 is the default option.
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Setting Options and descriptions

(1) All the marks are placed above the dimension
line.

(2) The middle of the last mark is on the the
dimension line.

(3) The middle (calculated in the dir. - to the
dimension line) of the mark group is on the
dimension line. This is the default option.

(4) The dimension line is extended between the
marks.

• If there is only one mark, it is placed above the
line.

• If there are two marks, one mark is placed
above and the other under the line.

• If there are three marks, two marks are placed
above and one mark is placed under the line.

(5) The middle of the first mark is on the dimension
line.

(6) All marks are placed under the dimension line.
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The parameters a, b, c1 and c2 are needed to get
the desired distances between the marks and the
dimension line.

The default values are:

a = 1

b = 1

c1 = 5

c2 = 5

Advanced settings tab

Setting Options and descriptions
First mark spacing Enter a millimeter value to indicate the space

between the dimension line and the first line of
dimension mark text.

You can also define the first mark distance when
the label is below the dimension line.
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Setting Options and descriptions
Space between Mark1
and Mark2

Define the space between mark 1 and mark 2

Free space below text /
Dimension line spacing

If you select Free space below text, enter a
millimeter value to indicate the space between the
last line of dimension mark text and the next
dimension line.

If you select Dimension line spacing and enter a
millimeter value to indicate the space between two
or more dimension lines.
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Text offset dimension
line

Group dimensions Control if dimensions are grouped or not.
Grouping also works when the distance between
the groups is zero.

Grouping tolerance Define whether double stirrup groups are
combined into one dimension line.

If the distance between the stirrups (in the image
below 12 mm) is greater than the entered value
(=10 mm), two dimension lines are created:

Group mark spacing Enter a millimeter value to indicate the space
between several lines of dimension mark text.
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Setting Options and descriptions
Part extrema Define how to close the dimension lines on the

contour of the concrete part. The following options
are available:

Examples:

The dimension line is always positioned on the
outermost lines of the concrete part.

The dimension line is positioned to the nearest
side/geometry point of the concrete part relative to
the picked insertion point of the dimension line
(plugin). See the examples below.
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Rebar lines tab

On the Rebar lines tab, you can define the generation and the appearance of
the leader lines and symbols of the dimension line. You adjust the settings of
Not visualized rebars, Visualized rebars, Group end rebars and Part edges.

Setting Options and descriptions
Not visualized rebars

Visualized rebars
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Setting Options and descriptions

Group end rebars Applied to the first and last bar in the group.

Part edges

Define the generation of the leader lines and
symbols for the Not visualized rebars or
Visualized rebars. The options are:

No leader lines or symbols.
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Leader lines. Define the length of the leader lines
relative to the dimension line.

Leader lines and symbols. Define the length of the
leader lines relative to the dimension line.
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Setting Options and descriptions

Leader lines. Define the length of the leader lines
relative to the contour of the concrete part.

Leader lines and symbols. Define the length of the
leader lines relative to the contour of the concrete
part.
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Setting Options and descriptions

Leader lines. Define the length of the leader lines
relative to the rebar.

Leader lines and symbols. Define the length of the
leader lines relative to the rebar.
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Symbols only

Define the generation of the leader lines and
symbols for the Part edges.

See the examples for the option Not visualized
rebars above.

The following options are available:
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Setting Options and descriptions
 Define the generation of the leader lines and

symbols for the contour of the concrete part

See the examples for the option Not visualized
rebars above.

The following options are available:

Define the color and the line type for the various
leader line types.

Define whether all leader lines and symbols are
shown for Visualized rebars and if this should be
done for one single rebar only. The following
options are available:
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Define the symbol file and symbol number to be
used. You can use existing symbols in Tekla
Structures by selecting a symbol file and a symbol
number. You can also define the color and the size
of the symbol.

Symbols are defined separately for Not visualized
rebars, Visualized rebars, Group end rebars and
Part edges

Examples:
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More examples
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Example of the setting Combine dim. between rebar - dim. on the
Parameters tab

• In the example below, the first dimension from the top shows the rebar
groups (blue color) with the distances between the groups (green color)
plus the distances to the part ends (grey color). Dimensions are not
combined.

• The second dimension shows the same situation with marked equalities
between the drawing rebar group spacing (cc) and the distances between
the groups.

• In the third dimension, the new combining type Consider same spacings
has been applied. The green distances between the two blue rebar groups
have been combined with the group that has the same spacing (cc) as the
distance between the groups.

• The combining has also been applied to the gray distance to the part end
because the distance to the part end is the same as the spacing (cc) of the
adjacent rebar group.
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Create a drawing view for a reinforcement mesh
You can create drawing views each containing one reinforcement mesh by
using the Rebar mesh view creator macro. The mesh view contains the
overall mesh length and width dimensions, and dimension lines for wire
spacing in horizontal and vertical directions. Also the wire sizes are displayed.
You can create mesh views in general arrangement and cast unit drawings.

1. Open a drawing containing meshes.

2. Select the meshes. 

If you want to create views for all meshes in the drawing, you do not need
to select separately.

3. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

4. Click the arrow next to Applications to open the applications list.

5. Double-click Rebar mesh view creator. 
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6. You have the following options for creating mesh views: 

• If you want to create a mesh view for each separate mesh in the
current drawing, select Create mesh view for all meshes in the
drawing.

• If you want to create a view for the selected meshes only, select
Create view for selected meshes. Here you must select the meshes
before running the macro.

• If you have already created the mesh views and just want to add
dimension lines and diameters in the views, select Create
annotations for selected meshes. Here you must select the meshes
before running the macro.

7. Select the view, dimension, text, line, and unbent wire line property files
that you want to use in the new the mesh view.

8. Select the wire annotation type in Text content type . 

The choices are and .

9. Select the wire length unit in Unit of length in text. 

When you select Auto, with imperial units the text will be using the
current units, and otherwise the text will use m.
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10. Click Create. 

Tekla Structures creates or updates the views based on your selections
and the property files.

Example

Below is an example of a mesh view.

The drawing below contains a 3D view of a wall with two bent meshes, and a
separate unbent mesh view of both of the meshes.
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Show rebar coupler and end anchor symbols in drawings
You can show graphical symbols representing the rebar couplers and end
anchors in bending schedules and in rebar mark pull-out pictures using the
Pullout graphical attribute.

You need a precast concrete or cast-in-place structure model with generated
rebar detailing drawings (GA or cast unit drawings), and the reinforcement
details need to be modeled by using any of the rebar coupler or rebar end
anchor tools available in the Applications & components catalog. The rebar
coupler and end anchor symbols work based on rebar UDAs, and these UDAs
are controlled by the rebar coupler and rebar end anchor tools.

The symbols are read from the file defined in RebarCoupler.Symbols.dat,
by default CouplerSymbols.sym located in ..\ProgramData\Tekla
Structures\<version>\environments\common\symbols.

You can adjust the font name, font size, font color, end mark, bending radius
visibility and a number of other bending schedule attributes individually for
the Pullout graphical attribute in Template Editor, according to your company
or country standards.
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Display rebar coupler and end anchor symbols in rebar bending schedules

1. In a drawing that contains rebar couplers or end anchors shown in a rebar
bending schedule, open the bending schedule template in Template
Editor by double-clicking a rebar shape in the bending schedule.

2. Double-click the graphical field containing the bending shape.

3. In the Graphical Field Properties dialog box, ensure that the PULLOUT
attribute is displayed in the Attribute field, and open the Free attributes
dialog box. 

4. Select the CouplerSymbols attribute, and enter 1 in the Value field. Adjust
other properties as required. 

Rebar coupler symbols will be shown if CouplerSymbols property value is
set to 1 and disabled if 0 is entered. The default value is 1.
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5. Save the changes in the template and close Template Editor.

6. Refresh the template by right-clicking the template in the drawing and
selecting Refresh template from the context menu. 

TIP You can customize rebar coupler symbols in Symbol Editor by modifying the 
*.sym file defined in the RebarCoupler.Symbols.dat file. By default, 
CouplerSymbols.sym is used.

Display rebar coupler and end anchor symbols in rebar mark pull-out pictures

1. In an open drawing that contains reinforcement with couplers or end
anchors, double-click a rebar mark for which you want to enable a pull-
out picture, and double-click the Pullout picture element. The Pullout
picture dialog box is displayed.

2. Select the Couplers/end anchor symbols check box, and set the desired
scale. 
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3. Click OK. 

Pours in drawings
Tekla Structures general arrangement drawings can present pour object
geometry, and pour breaks. Pour drawings can be used for communicating
the sequencing of the pours, and the properties of the pours and pour breaks.
You can add marks to pour objects, and associative notes to pour breaks.

How to enable pours

Options and functionality related to pours are only available if pours are
enabled in the model. Pours can be enabled in a model by setting the
XS_ENABLE_POUR_MANAGEMENT advanced option to TRUE. In the default
environment, pours are only enabled in the (Concrete) Contractor role.

WARNING If the pours are enabled in the model, do not disable the pours
using XS_ENABLE_POUR_MANAGEMENT, especially in the middle of
the project. This may cause problems if you have drawings
containing pours, and if you are sharing your model. The pours
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and pour breaks in the model and in the drawings may get
invalid, and you may lose all pour-related modeling work.

Pour objects

The geometry of the pour objects is presented as monolithic concrete. The
pour objects can be presented in plan, section and 3D drawings. Tekla
Structures shows the pour object geometry in general arrangement drawings
exactly like it has been modeled: overlaps and extra outlines vanish if the parts
collide, have the same concrete material grade, have Cast in place as the Cast
unit type, and have the same pour phase.

You can select whether you want to show pour objects or not. You can use
different colors, line types and fills in different pour objects. You can also
modify the pour object properties in an open drawing on object, view and
drawing level. For more information about showing the pour objects, see
Show pour objects, pour marks and pour breaks in drawings (page 894).

Pour object marks

Using pour object marks, you can show information related to pour objects,
for example, pour number, pour type, material grade, planned pour start date
and the name of the pour team. You can add automatic pour marks before
creating the pour drawing, and add and modify pour object marks also in an
open drawing.

Pour breaks

Pour breaks are shown in general arrangement drawings as they have been
modeled. The pour breaks are represented by a symbol. You can change the
symbol using the advanced option XS_POUR_BREAK_SYMBOL. The symbol
scale and the spacing between the symbols follows the drawing view scale
automatically.

You can show pour breaks automatically, and modify the pour break
properties and add associative notes to the pour breaks in an open drawing.

Predefined pour drawing properties and templates

In the default environment, the Concrete Contractor role contains some
predefined drawing properties, a couple of traditional report templates, and
an organizer report template for pours. Your own environment may also
contain some predefined drawing properties, and templates for pours. For
examples of pour drawings and pour reports, see examples beloww.

Examples

In the image below, you can see two pour objects colored differently, each
having a pour object mark. The pour break can be seen between the pour
objects, it is represented by a symbol. The pour break is marked with an
associative note.
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Modify pour objects, pour marks and pour breaks in a drawing
After you have created a pour drawing, you can open it and modify the pour
objects, pour marks and pour breaks.

1. Open a pour drawing and double-click the drawing background to go to
the drawing properties.

2. If you want so show the pours in the drawing, click the View button, check
that Show pours in drawing is set to Yes, and click OK.

3. Click the Pour object... button to modify the properties: 

• Content tab: Select whether you want to see the hidden lines and own
hidden lines, and the edge chamfers by selecting On or Off.

• Appearance tab: Set the color and type for visible lines and hidden
lines.

• Fill tab: Select the fill for the pour object face and/or pour object
section face.

4. Click OK.

5. Click the Pour object mark... button, select the contents and appearance
of the mark, and click OK.
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6. Click the Pour breaks... button and check that Visibility is set to Visible
and click OK. 

You can also select whether you want to show pour break hidden lines on
the Content tab. On the Appearance tab you can change the color and
type of the visible and hidden lines in pour breaks.

7. Modify the other properties as required. For example, click
Reinforcement... and set the Visibility of all reinforcing bars to Visible
to show the reinforcement in the pour drawing.

8. Click Modify to apply the changes in your pour drawing.

Change the pour break symbol
If you want to change the pour break symbol, you can do that using the
advanced option XS_POUR_BREAK_SYMBOL.

1. On the File menu, click Settings --> Advanced options and go to the
Drawing Properties category.

2. Set a new value for the advanced option XS_POUR_BREAK_SYMBOL. 

The default value is PourBreaks@0. The value refers to the
PourBreaks.sym file where the symbol is defined. The symbol value
starts with the symbol library file name (PourBreaks) and ends with the
number of the symbol (0). The default symbol file is located
in ..\ProgramData\Trimble\Tekla Structures\<version>
\environments\common\symbols.

You can also create a new symbol file containing a new symbol, and save
it. Then define the new .sym file for XS_POUR_BREAK_SYMBOL. If you wish
to use a symbol file that is not located under your environment folders,
enter the complete path to the symbol file location, the symbol file name
and symbol number as the value for this advanced option.

3. Click Apply and OK.

Example

Examples of pour drawings and pour reports
The Concrete Contractor role in the default environment contains some
predefined templates and settings for pour drawings and reports.
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Examples of drawing properties predefined for pours

The Concrete Contractor role in the default environment contains predefined
general arrangement drawing properties CIP_Pour_3D, CIP_Pour_Plan, and
CIP_Pour_Plan_with_Pour_List. These drawing properties use detailed
object level settings to color pour objects with different colors based on pour
number. In addition, the drawing properties file CIP_Pour_3D does not
render hidden lines, and CIP_Pour_Plan_with_Pour_List adds a pour list
to the drawing.

The following example drawing is created by using the
CIP_Pour_Plan_with_Pour_List drawing properties, and applying
CIP_Pour_3D view level properties to 3D views. Click the following link to
open the drawing:

Pour Drawing

Examples of reports predefined for pours

The Concrete Contractor role in the default environment contains predefined
report templates for pour information:

• There are two traditional types or report templates that can be created
using the Create reports command: Pour_List and Pour_Schedule.csv.

• The Pour Organizer report can be exported to excel format.

Click the links below to see example reports created using these report
templates:

Pour list

Pour schedule

Pour Organizer report exported to Excel

Welds in drawings
Tekla Structures shows the welds that you have added in a model as weld
seams and weld marks in drawings. You can add both model weld marks and
drawing weld marks manually in drawings. Model weld marks refer to welds
that have been created in the model. Drawing weld marks do not have an
associated physical weld in the model.
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How are welds displayed in drawings
Tekla Structures shows the welds that you have added in a model as weld
seams and weld marks in drawings. You can also add weld marks manually in
an open drawing.

Weld concepts

Model welds are displayed as weld marks and welds or weld seams in drawings.
Welds and weld marks can be controlled separately. For example, you may
want to show the welds in one drawing view and the weld marks in another.

3D model welds are representations of welds in the real world. Weld solids in
drawings are representations of the welds in models. Weld seam is the part of
the weld path where the weld solid is drawn. Weld path may consist of several
weld seams.

Weld solids are shown in drawings for the following welds:

• Weld solids are shown in drawings for those weld types that have real solid
support. Welds that have no real solid support are shown in the model with
a hexagonal placeholder, and in drawings weld solids are not shown.

• Custom cross-section welds are also supported.

Weld solids can be shown as outlines or paths, with or without hidden lines.

In the first example, the welds on the right and in the middle are drawn with
outlines and own hidden lines. The weld on the left shows the weld path and
hidden lines:
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The second example is a cross-section of the structure. The welds on the left
and in the middle are drawn with outlines, and the weld on the right shows
the path. The weld dimensions have been added manually.

The weld symbols inside the weld marks indicate the weld properties defined
for the model weld in the model or for the drawing weld mark in the drawing.
Below is an example of a model weld seam (in red) and a model weld mark (in
green) in a drawing.
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In addition to the weld symbols, the weld mark contains a reference line and
an arrow. The arrow connects the reference line to the arrow side of a
connection. The welds on the arrow and other sides of a part can have different
weld properties.

Weld placement

When parts are welded together, you can place welds on:

• The arrow sides only

• The other sides only

• Both the arrow and other sides

The following images describe the basic placement principles of welds.
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(1) Above line

(2) Below line

(3) Arrow side for weld

(4) Other side for weld

By default Tekla Structures places the welds above line according to the ISO
standard. You can change this to below line to comply with the AISC standard
with the advanced option XS_AISC_WELD_MARK.

Model weld properties

To change model weld properties, you need to modify the weld in the model.
When you update the model, the weld objects and weld marks are updated in
the drawing according to the model changes. In drawings, you can modify the
contents and the appearance of the model welds marks and the visibility,
representation and appearance of model weld objects.

Weld solids can be shown in single-part, assembly and general arrangement
drawings. In general arrangement drawings, you can only change the
representation of welds on view and object level, not on drawing level.

Manual weld marks

To add weld marks in an open drawing:

• Select the welds and add a model weld mark through the pop-up menu
command Add Weld Mark.

• Add a drawing weld mark by using the Weld mark command on the
Annotations tab.

Add manual drawing weld marks
You can add manual weld marks in an open drawing. Tekla Structures creates
manual weld marks using the properties in Weld Mark Properties.

1. Hold down Shift and, on the Annotations tab, click Weld mark to open
weld mark properties.

2. Enter or modify the content and the appearance of the weld mark.

3. To exactly place the weld mark in the position you pick and keep it there,
click the Place... button and select fixed in the Placing list.

4. Click Apply or OK to save the properties.

5. Pick a position for the weld mark. 

You can drag the created drawing weld mark freely to a more suitable
location by the leader base point handle.
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Example: Weld marks added in drawings

In this example, the first image below is the Weld Mark Properties dialog box
in a drawing. The weld mark properties are numbered in the dialog box. The
second image shows how the weld mark properties are displayed in a weld
mark in a drawing. The same numbers are used in the weld mark as in the
dialog box to indicate the weld mark property in the weld. Under the images
the meaning of different numbers is explained.
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(1) Weld prefix

(2) Weld size

(3) Weld type

(4) Weld angle

(5) Weld contour symbol

(6) Weld finishing symbol

(7) Effective throat

(8) Root opening

(9) Edge/Around, here a weld around symbol

(10) Workshop/Site, here a site weld symbol

Add manual model weld marks
You can add marks to model weld marks in an open drawing. Tekla Structures
creates model weld marks using the properties defined for the model weld in
the model. You can adjust the visibility and appearance settings of the weld
mark in the drawing.

1. Open a drawing that contains welds created in the model.

2. Do one of the following: 

• Select a model weld in the drawing.

• Select several model welds in the drawing using the Select welds
switch and area selection, or Drawing content manager.

If you cannot see any welds in the drawing, check the weld visibility
settings in the view properties.

3. Right-click and select Add Weld Mark.
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4. To modify the visibility and appearance of the model weld mark:: 

• Double-click a weld mark in the drawing, and adjust the properties.

• Select several model welds using the Select welds switch and area
selection, or Drawing content manager. When the welds are
selected, right-click and select Select weld marks and From current
drawing view or From all drawing views. Activate all selection
switches again. Then press down Shift and double-click a weld mark,
and adjust the properties.

Note that you cannot drag the mark away from the associated weld, but
you can only drag it along the weld seam.

Also note that when a weld mark is added through context menu, it is now
visible even if its size is below the minimum weld size limit defined in
drawing view settings.

Examples: Model welds in drawings
Model welds are welds that you have added in the model. In drawings, they
are represented by weld seams and weld marks.

Example 1

In this example, the first image below shows an example of weld properties in
the model. You can add welds in the model by selecting one of the welding
commands on the ribbon Steel tab. Some of the weld properties are
numbered in image, and the second image shows how these properties are
shown in a weld mark in a drawing. The same numbers are used in the weld
mark to indicate the position and appearance of the property information in
the weld.
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(1) Edge/Around, weld around symbol is used

(2) Workshop/Site, site weld symbol is used

(3) Weld prefix

(4) Weld type

(5) Weld size

(6) Weld angle

(7) Weld contour symbol

(8) Weld finishing symbol
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(9) Effective throat

(10) Root opening

Example 2

The example below shows a staggered, intermittent weld. The length is set to
50 and the pitch to 100.

(1) Staggered, intermittent weld
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(2) Length of weld segment

(3) Pitch (center-to-center spacing) of weld segments

Example 3

The example below shows a non-staggered, intermittent weld. The length is
set to 50 and the pitch to 100. The pitch is shown in the weld mark when the
pitch value is greater than 0.0.

Example 4

Below is an example of a continuous weld.
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Example 5

In this example, the staggered, intermittent weld option is selected, and the
advanced option XS_AISC_WELD_MARK is set to FALSE to produce an ISO-
compliant weld mark.
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Example 6

In this example, the staggered, intermittent weld option is selected like in the
previous example, but the advanced option XS_AISC_WELD_MARK is set to 
TRUE to produce an AISC-compliant weld mark.
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TIP For instructions on how to customize weld symbols, see section "Customize weld
type symbols" later in this help article.

Modify model weld mark visibility and appearance in a drawing
Welding properties are set in the model. You can select the welding properties
that you want to show in model weld marks in drawings and adjust the
appearance of the model weld marks in Weld mark properties.

To select which model weld properties to show, and to modify weld mark
properties on drawing view level:

1. In an open drawing, double-click a view frame to open the View
Properties dialog box.

2. Click Weld mark to go to weld mark properties.

3. Select whether to show the weld number in Weld number (No/Yes).

4. Under Visibility: 

• In Welds and Welds in sub-assemblies, select what kind of weld
marks to show, or whether to hide all welds (None, Site, Workshop,
Both ).

• In Welds in hidden parts, select what kind of weld marks to show for
hidden parts (None, Site, Workshop, Both).

• In Weld size limit, enter a weld size limit to filter weld marks of that
weld size out of the drawing.

Even though you set the weld size limit, weld marks are always shown
if they have reference texts.

• Note that you can also set the Weld size limit for all views at one go at
the bottom of the View creation page in single-part and assembly
drawing properties (page 915).

5. Under Above line, Below line and Other, clear a check box in the Visible
column next to a weld mark property that you want to hide. Note that if
you hide Size, Prefix is also hidden, and when you hide Length, Pitch is
also hidden.

6. To adjust the placing properties, click Place....

7. Click Modify.

8. Go to the Appearance tab and modify the weld mark text and line
appearance.

9. Click Modify. 

TIP You can modify the properties of individual model weld marks in an
open drawing by double-clicking a model weld mark to open
Welding Mark Properties dialog box. To select several marks, for
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example for deleting, right-click the weld mark and select Select
weld marks and From current drawing view or From all drawing
views.

Example

The first example shows a weld mark where a lot of properties are visible:

In the second example, all other welding mark properties have been hidden,
except Type from Above line and Below line, and Reference text from
Other:
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TIP • You can omit welds from drawings by weld type using the advanced
option . Then you first need to set a value for the Weld size limit.

• You can also customize some weld type symbols (page 492).

Modify model weld object representation and appearance in a drawing
You can modify the model weld object representation and appearance
manually on object level.

1. In an open drawing, double-click a model weld seam. 

It is easier to select the model weld if only activate the Select drawing

welds selection switch .

2. On the Content tab, select the desired Representation. The options are
Path and Outline.

3. Select whether you want to show Hidden lines and Own hidden lines.
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4. On the Appearance tab, modify the color and line type of the Visible
lines and Hidden lines.

5. Click Modify.

Examples

In the first example below, the welds on the right and in the middle are drawn
with outlines and hidden lines. The weld on the left shows the path and
hidden lines.

The second example is a cross-section of the structure. The welds on the left
and in the middle are drawn with outlines, and the weld on the right shows
the path. The welds on the right and left go around the part corner. The welds
have manual dimensions.
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TIP You can define automatic weld properties (page 893) for model welds
before creating a drawing. You can also modify the weld properties on
view level in an open drawing by double-clicking frame of the drawing
view containing the weld objects and selecting Weld from the options
tree. On drawing and view level, you can also modify the visibility
settings.

Drag weld marks
You can drag model welds by the base point of the weld mark leader line
along the weld seam. This way you can position the weld marks more
optimally for increased clarity in the drawings. Manual drawing weld marks
not associated to model welds can be dragged freely.

TIP Having Drawing drag & drop( File menu --> Settings ) selected makes
selecting the leader line base point and dragging it much easier.

Limitation: You cannot drag the weld leader base point to the back-side of a
double-sided weld.

1. Click the weld mark near the leader line base point. 

If you have Smart select and Drawing drag & drop selected, you do not
need to click the leader line, pointing is enough.

2. Hold down the left mouse button and drag the base point to a new
location by the leader line base point handle located in the tip of the
arrow. 
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Example

The first image below shows the welds in the model.

The second image shows the model weld marks in a drawing. The area within
which the weld mark leader line base point can be dragged is indicated with
dark green.
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Merge weld marks
You can force Tekla Structures to use the same mark and symbol for identical
welds in a drawing by merging the weld marks.

1. Open a drawing.

2. Hold down Ctrl and select the weld marks to merge.

3. Right-click and select Merge from the pop-up menu. 

Tekla Structures combines the marks.

4. If needed, you can split merged weld marks by right-clicking the mark and
selecting Split from the pop-up menu.
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Description Example
Original drawing

Merged weld marks.

Customize weld type symbols
Most of the weld type symbols are hard coded, but you can edit some of them
in Symbol Editor.

The bottom seven symbols in the Type list in model Weld properties and
drawing Weld Mark Properties (see image below) are taken from the
TS_Welds.sym file. You can edit any of these seven symbols in Symbol Editor
to create a custom weld symbol. The rest of the weld symbols are hard coded.
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Note that the symbol in the Type list does not change when you update the
symbol.

1. Open Symbol Editor as administrator.

2. Click File --> Open and browse to the folder were you have the
TS_Welds.sym file.

3. Select the file and click OK.

4. Modify the desired symbol.
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When doing this, you need to keep the symbol in the same scale as the
other symbols. If your symbol is too large to fit in the box, you can let it
extend beyond the borders:

5. Save the symbol by selecting File --> Save.

For more information about Symbol Editor, click Symbol Editor User's Guide.

4.18 Clone selected in drawings
The Clone selected command allows you to clone previously created
annotation objects and drawing object representations among the assemblies
or cast units with the same type and similar shape in GA drawings.

When editing GA drawings, it is often required to add annotations,
dimensioning and styles for building objects as repetitive task. The new Clone
selected feature clones existing annotation objects,drawing object
representations and styles from selected source objects to selected target
objects in GA drawings. With this feature, you can reduce manual repetition
considerably.

You can clone annotation objects and drawing object representations inside
one drawing view or among different drawing views.

Clone selected recognizes the following types of drawing content:

• Associative and independent annotation objects: dimensions, marks, texts,
symbols, text files, and DWG/DXF files

• Sketch objects, such as circles, rectangles, and polygons

• Object representations and styles: line colors, line types, hatches
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Adjust cloning settings
Before you clone, you may want to define how and what to clone in Cloning
settings. You can also clone using the default settings.

1. On the Drawing tab, click Clone selected --> Cloning settings .

2. Define the cloning settings: 

Merge Override all annotation objects and building object
properties in the cloning target by cloning
matching content from the cloning source.

This is the default mode.
Keep all Keep the existing annotation objects and building

object properties in the cloning target and only
clone the missing ones from the cloning source.

Discard all Discard all annotation objects and building object
properties in the cloning target and clone all
selected content from the cloning source.

Clone building object
properties and styles

Clone drawing object properties such as line colors
and types, hatching styles and other
representation properties in the drawing object
properties for parts, reinforcement, bolts and
welds.

Place marks and
associative notes
according to
protection settings

Automatically run the Arrange drawing objects
near current location command for all
associative annotation objects except for level
marks, weld marks, dimensions and independent
annotation objects.

This option positions the annotation objects in the
cloning target so that they do not overlap other
objects. Objects located in a free location are not
moved, and overlapping objects are moved as
close to the current location as possible.

3. Click OK.

Clone selected annotations and object properties
Before you clone, first modify the source object so that it contains the desired
dimensions and annotations, and adjust the source object properties.

When cloning dimensions, remember to set the dimension associativity rules
before cloning to avoid the situation where it is unclear which object a
dimension point is associated to. For more information, see Display and
change dimension point associativity (page 264).
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1. In an open GA drawing, click Clone selected on the Drawing tab.

2. Select the cloning source objects by clicking the objects or using area
selection. 

You can also select the objects before activating the Clone selected
command.

You can also select the objects using Drawing content manager and
selection filters.

You can deselect objects by holding down Ctrl and clicking the selected
object.

3. Press the middle mouse button to complete the selection.

4. Select the cloning target objects by clicking the objects or using area
selection.

5. Press Esc to stop the cloning. 

TIP You can also clone from the source that you selected last. To do this,
click Clone from last selected source on the Drawing tab.

Below on the left a detailed footing and on the right a similar footing that
will be the target of cloning:

Below, the detailed footing on the left has been used as source for the
target on the right. The details have been cloned to the target.
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NOTE Cloning of annotations to multiple assemblies or cast units produces
best results only when annotations and dimensions are associated to
single-assemblies or cast units in source selection.

When the source selection contains annotations and dimensions
associated to multiple assemblies, Clone selected will produce
accurate results only if corresponding groups of assemblies or cast
units are selected in the target one by one, not all at once.

Limitations

• Some drawing objects cannot be used as source objects, such as grid lines,
section view symbols, drawing view names, neighbor parts and neighbor
reinforcement. These objects types will not be highlighted during/after
area or single selection. Messages on the status bar indicate if an object
cannot be selected.

• Clone selected cannot be used with pour units.

• To achieve accurate cloning results all dimensions should be associated
either to grid line intersection points or to intersections of building objects
and grid lines.

Dimension point associated to intersection of two perpendicular grid lines:
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Note that all dimension points that are located in arbitrary position along
the grid lines in the source selection will be cloned to wrong coordinates in
the target.

Dimension point associated to intersection of part side and grid line:

• Clone selected cannot be used for cloning radial or curved dimensions.

• Cloning of annotations to mirrored objects created with the Mirror
command in the model does not produce accurate results.

• Cloning modes do not affect cloning of independent annotation objects or
sketch objects. Listed object types will be copied to target as many times as
clone selected is applied to the target objects.

• Dimensions will not be cloned if the viewing directions of the source and
target drawing views do not match. In this case, a message is shown on the
status bar.
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4.19 2D Library in drawings
Drawing 2D Library allows you to quickly select objects in any drawings and
save them as 2D drawing details. You can insert details in drawing views and
drawings in any model. You can create details out of many kinds of drawing
objects, such as parts, texts, notes, drawing sketch objects, or DWG files. In
addition to details, you can browse and insert DWG files and images directly to
your drawings from the Drawing 2D Library. It allows you to browse for
details in other folders and use them in your drawing. Your company can
create a collection of standard details that can be distributed in the system,
project or firm folders and reused in different drawings and projects.

Limitations

• Multi-colored part section hatches cannot be recognized in detail creation,
and the part face hatch will be used instead.

• Templates or images cannot be captured in detail creation.

• Manually added weld marks cannot be captured in detail creation. This also
applies to certain other manually added marks, such as revision marks and
level marks.

• Details inserted in container views (views around linked/copied views) may
be placed incorrectly.

• Inserted details do not rotate if the view is rotated.

• Inserted details cannot be cloned with the drawing.

• You cannot use pattern lines ( Drawing --> Line --> Pattern line ) for 2D
detailing.

Open and view Drawing 2D Library
Drawing 2D Library is located in the Tekla Structures side pane. It is available
when a drawing is open.

1. Open a drawing.

2. Open the Drawing 2D Library by clicking the Drawing 2D Library button

 in the side pane. 
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3. Click the Folder button  to check the contents of the various folders: 

• Current model shows the details in the \Drawing Details folder
under the current model folder. Your details are saved here, and here
you can also create new subfolders. This folder may be empty if you
have not created any details or used details in other folders.

• Project and Firm show the details in the subfolder \Drawing
Details under the project and firm folders if you have defined paths
to these folders as values for the advanced options XS_PROJECT and 
XS_FIRM, respectively.

• System shows the details in the subfolder \Drawing Details in any
of the folders defined as a value for the advanced option XS_SYSTEM.

• Browse... allows you to browse to any folder for details.

• When you use details in project, firm, system or any other folder than
\Drawing Details in the current model folder, the details are copied
to the current model folder.
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• When you update a detail with new or changed objects, all instances of
the detail in any drawings in the current model will be updated as well.
If you are fetching the detail that you update from the firm folder, the
detail will not change in the firm folder. Global changes can only be
done by the administrators of the firm, project and system folders.

• If the administrator updates a detail in the firm, project or system
folder, any already inserted detail instances will not get automatically
updated in any project. To do this, you would need to manually copy
the updated detail file and replace what's in the model folder.

• New folder allows you to create a new folder in the current model
folder in the subfolder \Drawing Details.

• Any subfolders in any of the folders are shown next to the details in
the selected folder in Drawing 2D Library view. Double-click the
subfolder to see the included details.

4. Search for details by entering a search term in the search box at the top of
Drawing 2D Library. Tekla Structures shows the matching details in the
view. Details are only searched in the currently displayed folder and its
subfolders.

Insert a detail to a drawing from 2D Library
In 2D Library, you can add details located in the system, project, firm or
current model folder to any of your drawings.

1. Open a drawing.

2. Click the Drawing 2D Library button  in the side pane to open
Drawing 2D Library. To browse to another folder for details, click the

Folder button , and select Current model, System, Project or Firm.
You can also browse further to other folders by selecting Browse...
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3. If you always want to insert a detail inside a view when necessary, click the

Options button  and select Create view if needed. 

Details created within their own views are automatically created as fixed
views.

You may want to create a view for the detail if you place it outside drawing
views. The new view will use the currently applied view properties and get
the same scale as the inserted detail. If the Create view if needed option
is not selected, the inserted detail does not get a view of its own, and
dimensioning will not work properly in the detail.

By default the standard view properties are used. You can also create a
new view properties file to be used for detail views. This will let you have a
specific view label in detail views, for example. You can select the new
properties file, or any of the existing view properties files, on the Options

menu . The selected view properties file settings will be applied to
every 2D detail container view.

4. Click a detail and then click the drawing view or drawing to place the
detail. 
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Tekla Structures inserts the detail. The detail is inserted as a plug-in, which
means that the detail objects are grouped and stay together when you
select or move the detail in a drawing.

Press Esc to interrupt picking insertion points.

You can also pick a secondary reference point for rotation. To do this,
right-click the detail in the Drawing 2D Library and enable Add
secondary reference point. When you insert the detail, Tekla Structures
asks you to give 2 input points. The secondary reference point will
determine the direction of the detail.

Create a new detail in Drawing 2D Library
You can create new details in the current model folder or its subfolders.

1. In an open drawing, add the objects that will shape your detail. 

In the example below, the detail represents a beam-to-beam connection.
The detail contains texts, circles, lines, polylines, and symbols that have
been added on top of a drawing and surrounded by a frame.

2. Click the Drawing 2D Library button  in the side pane to open
Drawing 2D Library.

3. Select the objects that you want to include in the detail. 
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4. Add the detail in Drawing 2D Library:

a. If you have subfolders in the current model folder, double-click the
subfolder in Drawing 2D Library view where you want to save the
new detail. 

You can create a detail even when the current model folder is not
selected. The detail will be stored in the current model folder, and a
status bar message will indicate the name of the new detail.

b. Click the New detail from selected objects button  at the top of
Drawing 2D Library. 

A message at the bottom of Drawing 2D Library asks you to pick a
reference point.

c. Pick a reference point in the drawing. 
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TIP You can also pick a secondary reference point for rotation. To
do this, right-click the detail in the Drawing 2D Library and
enable Add secondary reference point. When you insert the
detail, Tekla Structures asks you to give 2 input points. The
secondary reference point will determine the direction of the
detail.

A message at the bottom of Drawing 2D Library asks you to capture
a sample image by picking two points.

d. Pick two points to capture an image of the detail. 

Tekla Structures creates the detail and adds it to Drawing 2D Library in the
\Drawing Details folder (or its subfolder, if defined) under the current
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model folder. This folder is automatically created when a detail is created in
the current model for the first time. Tekla Structures saves the detail and its
metadata (name, description) as a .ddf file. The metadata is used when you
search for details in Drawing 2D Library. The captured image is saved as
a .png file.

Create a new folder in Drawing 2D Library and copy/move
to the folder
You can create details in a new folder or copy or move details to the new
folder in the current model folder.

1. In Drawing 2D Library, click the Folder button , and select New
folder. You can rename the new folder by clicking the folder and entering
a name at the bottom of the Drawing 2D Library pane.

2. Right-click a detail you want to copy or move and click Cut or Copy.

3. Right-click the new folder and select Paste. Tekla Structures copies or
moves the selected detail.

4. If you want to add some details in a system folder, create a subfolder in a
system folder (defined by XS_SYSTEM) and rename it Drawing Details,
then copy details from the model folder to the new \Drawing Details
system folder using Windows Explorer. You can copy or move details in
the same way to the project and firm folders.

Modify detail properties in Drawing 2D Library
You can modify detail properties of the details in the current model folder. You
cannot modify the detail objects, for example, the texts, marks, or lines inside
a detail, because the details are grouped. You first need to explode the detail,
and then update it.

1. In an open drawing, browse for a folder, and click a detail in Drawing 2D
Library. A new detail looks like the one below in Drawing 2D Library
when you have not touched its properties yet:

2. Modify the detail properties at the bottom of the Drawing 2D Library
pane: 

Edit drawings 526 2D Library in drawings



a. Edit the detail name and the description of the detail.

b. Select the original scale, enter a scale, or ignore the scale. 

The Scale value refers to the scale of the view where the detail was
originally created. The Scale value should not normally need to be
touched. This value is used when inserting the detail, for adapting the
detail to the scale of the target view, so that dimensioning, for
example, will work correctly.

Example:

You create a detail A from objects in a 1/10 scale view. So the scale of
the new detail gets recorded as 1/10 in Drawing 2D Library. You
then insert detail A (which has scale 1/10) into a scale 1/50 view W.
The detail will look 5 times smaller than in the original view, but
dimensioning will give the same results in both views.

You create another detail B from objects in a 1/5 scale view. So the
scale of the new detail gets recorded as 1/5 in Drawing 2D Library.
You then insert this detail (which has scale 1/5) into the scale 1/50
view W. The detail will look 10 times smaller than in the original view,
but again dimensioning will give the same results in both views.

You then change the scale of the detail A in the view W from 1/10 to
1/5. This makes Tekla Structures calculate the size of the detail as if
the original view had had the scale 1/5. So just as detail B, the detail A
will now look 10 times smaller than in the original view. However in
this case, dimensioning will now give only 1/2 of the expected results
(which is the ratio between the scale you have entered and the actual
original scale).

When you click Ignore scale, the detail will have the same visual size
regardless of the view scale, corresponding to the visual size it had
when it was created. This is indicated by the scale value 1/0.
Therefore dimensioning will not be correct if you use the Ignore
scale option.

c. To change the sample image, move the mouse pointer over the
image on the left, click the Capture new button, and then pick two
points in the drawing.
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3. To view and modify the detail properties in the drawing, double-click the
inserted detail.

Explode a detail
You can explode an inserted detail into lines and texts, for example, to update
the detail with new objects.

For example, you may have created a detail and something does not look
quite right. You can explode the detail, make modifications and update the
detail with the changes.

Another example could be that you have a set of company-specific details that
you are inserting details from. You can explode a detail and edit it, and make a
new detail out of it.

• In a drawing, right-click an inserted detail, and select Explode.

The detail is exploded to lines and texts. Now you can edit the detail, and then
update the detail.

Explode dimension included in details
You can create native dimensions in details instead of lines and symbols.

1. In Drawing 2D Library, click the Options  button and select Explode
native dimension.

2. Insert a detail containing dimensions in a drawing.

3. Right-click the inserted detail, and select Explode. The detail is exploded
and the included dimensions are exploded to native dimensions.

Explode symbols included in details
You can explode symbols included in details, and make them independent of
the local symbol files.

Drawing 2D Library saves the drawing symbols as symbols, which means that
later, when you insert the detail, you need to have the correct symbols files
present. You can avoid this by exploding the symbols.

1. In Drawing 2D Library, click the Options  button and select Explode
native symbols.

2. Insert a detail containing drawing symbols in a drawing.

3. Right-click the inserted detail, and select Explode. The detail and the
included symbols are exploded to lines and texts.
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Update objects in a detail
You can modify all instances of a detail by updating the detail with new or
modified objects.

1. Insert the detail in a drawing and explode it by right-clicking the detail and
selecting Explode.

2. Modify the exploded detail objects or add new ones.

3. Select all detail objects, including any new ones.

4. Right-click the detail in Drawing 2D Library view and select Update
detail with selected objects. You are asked to pick a new reference
point. If you are updating the detail in the same view as originally, you do
not need to pick a new reference point, otherwise you need to pick a new
reference point.

The detail gets updated. When you update a detail with new objects, the
detail will get updated in all drawings where it is used.

Insert a .dwg file to a drawing from Drawing 2D Library
You can insert .dwg files from the 2D Library to drawings as reference files.

1. Open a drawing.

2. Click the Drawing 2D Library button  in the side pane to open the
Drawing 2D Library.

3. Browse for the folder containing the .dwg files in the Drawing 2D
Library. You can also move your reference files to a \Drawing Details
folder under the current model folder.

4. If you always want to insert a detail inside a view when necessary, click the

Options button  and select Create view if needed.

5. Click a .dwg file and then click the drawing view or drawing to place
the .dwg file. Tekla Structures inserts the .dwg file as a reference object in
the drawing, not as a drawing detail. If the file is inserted from outside the
model folder, the file will be copied to the model folder first and the
insertion path will be relative to that.

You cannot update the .dwg file with new objects, but you can select an
inserted .dwg along with any other objects and create a new detail.

Insert an image to a drawing from Drawing 2D Library
You can insert image files from the Drawing 2D Library to drawings.

1. Open a drawing.
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2. Click the Drawing 2D Library button  in the side pane to open the
Drawing 2D Library.

3. Browse for the folder containing image files in the Drawing 2D Library.
You can also move your image files to a \Drawing Details folder under
the current model folder.

4. If you always want to insert a detail inside a view when necessary, click the

Options button  and select Create view if needed.

5. Click an image file and then click the drawing view or drawing to place the
image. 

The image is inserted. If the file is inserted from outside the model folder,
the file will be copied to the model folder first and the insertion path will
be relative to that.

Note that the image detail thumbnail is created automatically.

4.20 Custom presentations in drawings
You can modify the appearance of many of the objects in drawings using
custom presentations. Custom presentations are delivered in Tekla
Warehouse as extensions. The presentations can be controlled on the view
level and object level.

When you have downloaded a custom presentation for an object type, the
Custom presentation tab will become available in the drawing property
dialog for that object. The list will only show custom presentations that are
available for that specific object type – part, weld, mark, etc.

The following object types support custom presentations:

• welds and weld marks

• parts and part marks

• neighbor parts and part marks

• grid lines

• texts

• associative notes

Edit drawings 530 Custom presentations in drawings



Examples

In the example below, the Weld solid custom presentation is used for drawing
the weld solids.

In the following example, Corners Only custom presentation is used for laser
layout projection. Drawing all the lines of a part slows down the laser and
makes it too dim to see on the layout table.

Custom presentations in Tekla Warehouse

Center of gravity

GA schedules

See also

Edit drawings (page 155)

4.21 Moment connection symbols in Tekla Structures
drawings (Drawing tools)
Moment connections show the beams that are connected to columns with
rigid connections.

Edit drawings 531 Moment connection symbols in Tekla Structures
drawings (Drawing tools)

https://warehouse.tekla.com/#/catalog/details/u74e892d7-20c2-463a-9088-45d57cf34052
https://warehouse.tekla.com/#/catalog/details/aeb02255-a771-4381-8f5b-a60cbb360076


To display the moment connection symbols for a part in drawings, you need to
set the Moment connection to Yes on the End conditions tab in the user-
defined attributes of the part in the model.

You can create, update and delete moment connection symbols using drawing
tools.

For more information about other tools and macros, see .

Create moment connection symbols (Drawing tools)
In general arrangement drawings, you can create moment connection symbols
to show the beams that are connected to columns with rigid connections. The
symbols are created according to part end releases. You can create moment
connection symbols automatically for all parts in a drawing view, or for
selected parts.

Limitations: Moment connection symbols are created to reference lines. This
means that offsets are not taken into use.

1. Open the drawing.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. Double-click Drawing tools to display the Drawing tools toolbar.

5. Click Create moment connection symbols .

6. In the Create moment connection symbols dialog box, select the color
for the symbols from the color list.

7. Enter a scale for the symbols in the box next to the color list.

8. Do one of the following: 

• To create moment connection symbols for all parts in a drawing view,
select the view.

• To create moment connection symbols for selected parts, select the
parts.

9. Click Create. 

The moment connection symbols are created according to analysis part
and connection release properties:

• If a connection exists, start and end release information is read from
the Start releases and End releases tabs in analysis part properties.

• If a connection does not exist, release information is read from the
End conditions tab in the user-defined attributes of the part.
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Example

TIP The moment connection symbol that is used depends on if it points to right, left,
down, or up. The symbols are retrieved by default from the xsteel.sym symbol
file. If you want to use another symbol, you can modify the symbols in Symbol
Editor by opening the xsteel.sym symbol file and modifying the symbols 87
(right symbol), 86 (left symbol), 85 (down symbol), or 84 (symbol up) and saving
the changes.

Update moment connection symbols (Drawing tools)
If you want to remove all previously created moment connection symbols and
create new ones that are up to date, you can update the moment connection
symbols.
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1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Click the arrow next to Applications to open the applications list.

3. Double-click Drawing tools to display the Drawing tools toolbar.

4. Click Create moment connection symbols  in the Drawing tools
toolbar.

5. Do one of the following: 

• To update the moment connection symbols of all parts in the view,
select the view.

• To update the moment connection symbols of selected parts, select
the parts.

6. Click Create.

When you do this, Tekla Structures removes all previously created symbols,
and creates new ones that are up-to-date.

Delete moment connection symbols (Drawing tools)
You can delete moment connection symbols of all parts in a view or of
selected parts.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Click the arrow next to Applications to open the applications list.

3. Double-click Drawing tools to display the Drawing tools toolbar.

4. Click Create moment connection symbols .

5. Do one of the following: 

• To delete the moment connection symbols of all parts in the view,
select the view.

• To delete the moment connection symbols of selected parts, select the
parts.

6. Click Delete.
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4.22 Grids in drawings
You can show grids and grid line labels in single-part, cast unit, assembly, and
general arrangement drawings. You can set automatic grid properties and also
manually modify properties in an open drawing.

To Click below
Modify grid properties and the
properties of individual grid lines
manually

Modify grid and grid line properties in
drawings (page 535)

Drawing grid properties (page 1018)
Hide grids and individual grid lines
manually

Hide grids or grid lines (page 547)

Drag grid labels if the label is covering
an important area in a drawing

Drag grid labels (page 546)

Set automatic grid properties before
you create the drawing

Define automatic grid properties
(page 866)

Customize drawing grid labels by
including extra text and symbols

Customize drawing grid labels
(page 536)

Modify grid and grid line properties in drawings
You can modify grid properties on the drawing and view levels, and properties
of individual grids or grid lines in an open drawing.

To modify the grid or grid line properties on object level in an open drawing:

1. Ensure that you have the correct selection switch selected. 

To modify grids, use the selection switch , and to modify grid lines,

use .

2. Double-click the grid or the grid line. Tekla Structures displays Grid
properties or Grid line properties.

3. Visible shows the grid lines in the drawing. If you want to see the labels
only, select Only grid labels visible.

4. Modify the label text placing, grid line and text settings as required.

5. Click Modify.

NOTE You can also set a fixed width to the grid label frames and set a width factor
for the grid label frames:

XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH

XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR
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See also

Drawing grid properties (page 1018)

Customize drawing grid labels
In GA drawings, you can customize drawing grid labels by including extra text
and symbols in the labels. You can define the label text, offsets and offset
prefixes in the grid user-defined attributes in the model and show the grid
label text in drawings. You can also defined the prefixes in an open drawing.
You can use a combination of traditional grid labels and custom labels, or only
use custom labels.

Before you can customize grid labels, you need to modify the user-defined
grid properties in the model, and also other grid properties, depending on
your needs. You can also choose to modify the prefix text in the drawing.

Modify grid model properties
1. In the model, double-click the grid to open grid properties.

2. Modify the grid properties as required. 

In this example, you will create grid labels for elevations, so you need to
modify the Labels for Z direction.

3. Click User-defined attributes...

4. Fill in the necessary user-defined attribute information. 

Note that you cannot leave the Offset in Z box empty even if the offset
was 0. If the offset is 0, you still need to enter 0.

In this example, you need to have the Grid label text, Offset in Z and
Prefix offset in Z defined. You can also define the prefixes and the label
texts in Advanced grid label properties in the drawing.
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Note that the Datum level in the drawing View Properties does not work
in the same way as the Offset in Z. Setting Offset in Z in grid UDAs to
1000.00 gives the same result as setting the Datum level to -1000.00. The
view Datum level setting moves coordinates, and level marks are relative
to the coordinates. The Datum level setting does not move the content of
the view, the content just becomes relatively moved in the opposite
direction.

5. Click OK, select the grid and select Modify.

Now you have created the necessary grid label texts and adjusted the needed
values. Next, you can customize the drawing grid labels.

Customize drawing grid labels
1. Open a general arrangement drawing.

2. On the Annotations tab, hold down Shift and click  Grid labels.

3. Define the properties for the custom grid labels: 

Grid label placing Select which grid labels are displayed by selecting
the desired check boxes.

Use settings from Define where the grid label properties are taken
from:

• Grid inherits the properties from the grid.

Note that if you have defined settings for text
color, height and font in the standard drawing
Grid properties, the corresponding settings in
Advanced grid label properties will changed
accordingly, when you click Modify.
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• The dialog box option uses the settings defined
in Advanced grid label properties.

Frame type Select the type of the frame:

Any symbol, grid label text inside, at the bottom

.

Any symbol, grid label text inside at the top  .

Any symbol with a leader line, grid label text under

the leader line outside the symbol .

Any symbol with a leader line, grid label text above

the leader line outside the symbol 

Note that you can define a fixed size for the grid
label frame by setting the advanced option
XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH
to a defined value. If you want to calculate the grid
label frame size automatically, leave the value out.

File Select a symbol file from the list.
Number Click the ... button and double-click the symbol. For

example, the elevation symbol is by default symbol
number 35 in the xsteel.sym file.

Color Select the color and the line type of the grid label
frame symbol.

Height Set the height of the grid label frame symbol:

Enter height: Enter the height in the Height box.

Autosize: Adjust the symbol height automatically.

Enter Autosize minimum height: Set the
minimum height for the symbol.

Align to line Select Yes to rotate the labels of vertical and
inclined grid lines and align the labels with the grid
lines.

Grid: Number Define the Prefix, Color, Height and Font of the
grid numbers. If you define the prefix in the user-
defined attributes of the grid, you no longer need
to do it here.

Grid: Text Define the Prefix, Color, Height and Font of the
grid label texts. If you define the prefix in the user-
defined attributes of the grid, you no longer need
to do it here.
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Create axis text Select Yes or No. Yes enables the options below.
No is the default value. If you have defined
prefixes and grid axis texts in the user-defined
attributes of the grid, you not need to define them
here.

Prefix for axis X Define the prefix for the X axis.
Prefix for axis Y Define the prefix for the Y axis.
Prefix for axis Z Define the prefix for the Z axis.
Color Define the color of the grid axis text.
Height Define the height of the grid axis text.
Font Define the font used in the grid axis text.

4. Save the properties for future use by entering a unique name in the Save
as box and clicking Save as.

5. Click OK and pick a grid.

Tekla Structures customizes the grid labels and label texts according to the
modifications that you made in the grid UDAs in the model, and in Advanced
grid label properties in the drawing.

Note that if you get duplicate grid labels (traditional and custom), double-click
the drawing grid and clear the check boxes of double grid labels in grid
properties.

In the example below, the following properties were defined in the grid
properties and grid user-defined attributes in the model:

Labels: Z = Floor1 Floor2 Floor3
Grid label text = Text
Prefix offset in Z = Prefix Z
Offset in Z = 1000.00

In Advanced grid label properties,  was selected as the Frame
type.

Customize a grid label on a single grid line

1. Ensure that you have the Select grid line selection switch active .
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2. In an open drawing, on the Annotations tab, hold down Shift and click

 Grid labels .

3. Define the properties for the grid labels (see instructions above).

4. Click OK, and pick a grid line. You can also select several grid lines using
area selection.

Tekla Structures customizes the grid labels and label texts on the selected grid
line according to the modifications you made.

Modify custom grid labels
You can modify the custom grid labels by selecting the grid labels.

1. Ensure that you have the Select grid selection switch active .

2. In an open drawing, on the Annotations tab, hold down Shift and 
Grid labels .

3. Only select the check box of the grid label that you want to customize.

4. Define the properties for the custom grid label.

5. Click Modify and select the grid label.

Customize grid labels only at one end of a grid line
You can have regular and customized labels at different ends of a grid line.

1. Ensure that you have the Select grid selection switch active .

2. In an open general arrangement drawing, on the Annotations tab, hold

down Shift and click  Grid labels .

3. Only select the check box of the grid label you want to customize.

4. Define the properties for the custom grid label.

5. Click OK and select the grid.

6. Select the  selection switch.
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7. Select the desired grid lines, right-click and select Properties..., and only
select the check box at the opposite end of the grid line. Area select is
handy in grid line selection.

8. Click Modify. The custom grid label is displayed at the one end of the grid
line, and the traditional grid label at the other end.

Add different customized grid labels on horizontal and vertical grid
lines
You can use different customized labels in horizontal and vertical grid line
labels.

1. Ensure that you have the Select grid selection switch active .
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2. In an open drawing, on the Annotations tab, hold down Shift and click

 Grid labels.

3. In Advanced grid label properties, only select the check box for the right
horizontal grid labels.

4. Define the properties for the horizontal grid labels. For example, for
elevation grid label, set up an elevation symbol.

5. Click OK and select the grid. 

Custom grid labels are added on the horizontal grid lines. There are no
grid labels on the vertical grid lines.

6. Hold down Shift and click  Grid labels .

7. In Advanced grid label properties, only select the check box for the
upper vertical grid labels.

8. Define the properties for the vertical grid labels. For example, select the
desired frame label type.
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9. Click OK and select the grid line.

Custom grid labels are added on the vertical grid lines of the selected grid. The
horizontal grid lines have the labels that you added earlier.

Use model grid coordinates and prefix as text on grid axis in a drawing

1. On the Annotations tab, hold down Shift and click  Grid labels.

2. Do any of the following: 

• Define the following settings to show grid coordinates automatically
along grid lines:

• You can also do this in another way and use different prefixes:
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a. First in the model grid user-defined attributes, add in Prefix
offset in X and in Prefix offset in Y values W: and N: in the
following way:

b. Then in the drawing in Advanced grid label properties, set
Create axis text to Yes:
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If you want to write prefixes to these values, in Advanced grid
label properties, add the Prefix for axis X and Prefix for axis Y
information.

c. To get model grid coordinates shown in the drawing grid labels
automatically, in the model, go to user-defined grid attributes, and
change the offset values to 0.
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When you do this, go to drawing Advanced grid label properties,
and set Create axis text to No.

Limitations

• The grid lines are not refreshed automatically.

• If you have hidden grid lines or otherwise modified them, you need to
click Modify in Advanced grid label properties to refresh the grid
labels.

• If you drag grid line handles, the custom grid labels are not moved
together with the handle, until you click Modify in Advanced grid label
properties.

• Advanced grid labels are not supported in multidrawings, key plans or in
cloning, or when moving views to another drawing.

• Not all frame types are allowed for all axises.

Drag grid labels
You can move single grid labels in drawings by dragging them. This is useful, if
the grid label is covering an important area in a drawing.
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1. Ensure that you have the grid line selection switch selected .

2. Click a grid.

3. Hold down the left mouse button and drag the label by the handle to a
new location.

Hide grids or grid lines
You can hide grids and grid lines if you do not want to have them visible in a
drawing.

1. Ensure that you have the correct selection switch selected: 

To hide grids, use the selection switch , and to hide grid lines, use

.

2. Click a grid or a grid line.

3. Right-click the grid or the grid line and click Hide/Show --> Hide from
Drawing View .

TIP If you want to show the grids or grid lines, press B until the color mode is Color,
right-click the grid or the grid line, and select Hide/Show --> Show in Drawing
View . You can see and select the hidden grids and grid lines only in Color
mode.

4.23 Colors in drawings
You have three basic color modes for line colors in drawings: Black and
white, Grayscale, and Color. By default, drawings are black and white.

In addition to the three basic color modes, you can have a black background
and colored lines in drawings (advanced option
XS_BLACK_DRAWING_BACKGROUND).

In addition to the actual colors, you can specify a special color (page 552) that
is not converted to black in printouts.

When you are printing, you can also change the line thicknesses of different
colors (page 607). This setting affects printouts but also the line thicknesses
in color drawings on the screen, if you have selected Printer line widths in
File menu --> Settings.
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Colors and gray shades

The table below shows the basic colors available in Tekla Structures drawings,
and how the different colors are shown in black and white drawings and in
grayscale drawings. The corresponding pen numbers referring to the line
thicknesses used in the printed drawings are listed in the Pen column.

Some of the different gray shades are true colors in the way that they will keep
their color regardless of the drawing color mode, all the way to printing.

You can select the color for a line in part properties and shape properties.

Name Pen Tekla
Structures

color

Black and
white

Gray scale Lightness

Invisible 9 Invisible
Black 7 0%
Red 1 0%
Green 3 0%
Blue 5 0%
Cyan 4 0%
Yellow 2 0%
Magenta 6 0%
Brown 15 30%
Dark green 110 50%
Dark blue 141 70%
Blue-green 111 90%
Orange 31 100% white
Gray 8 60%
Gray 30 251 30%
Gray 50 252 50%
Gray 70 253 70%
Gray 90 254 90%
Special - -

Colors in drawing hatches

You can select the color for a hatch in part and shape properties on the Fill tab
after you have selected a fill type from the Type list.
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The true gray shades are marked with red in the image below.
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The gray scale colors (130 - 133) are also available for automatic hatches.

See also

Change drawing color (page 550)

Change drawing color
You can change the color of the drawings.

1. Open a drawing.

2. On the File menu, click Settings and select Black and white, Grayscale
or Color. 

You can toggle between the color modes by pressing B on the keyboard.

Example

Below is an example of a color drawing.
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In grayscale mode, the colors from 1 to 7 (black, red, green, blue, cyan, yellow,
magenta) are shown in black, and the colors from 8 to 14 (brown, dark green,
dark blue, blue-green, orange, gray) are shown in different shades of gray.
Below is an example of a gray scale drawing.

Below is an example of a black-and-white drawing.

See also

Colors in drawings (page 547)
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Specify a special color in drawings
You can define a special color that is not converted to black when printed. This
color will be printed as color or grayscale, depending on the selected printer
settings. The special color is defined using RGB (Red Green Blue) values in a
scale of 0 to 255. The special color is applied on parts as a hatch.

You can specify a special color for a building object (part, bolt) before creating
a drawing, and use it in the final drawing for a drawing shape or a building
object.

1. On the File menu, click Settings --> Advanced options and go to the
Hatching category.

2. Define the color using the following advanced options: 

• XS_HATCH_SPECIAL_COLOR_R

• XS_HATCH_SPECIAL_COLOR_G

• XS_HATCH_SPECIAL_COLOR_B

The default value for all of the above advanced options is 230.

The smaller the values are, the darker the shade.

3. Click OK or Apply.

4. Open a drawing.

5. Double-click a drawing object to open object properties. For example, click
a building object or a rectangle.

6. Select a fill type.

7. Select the Special fill color.

8. Click Modify.

The object that you selected now uses the color that you specified.

4.24 Reference models in drawings
Reference models can be shown in general arrangement, assembly and cast
unit drawings. For example, you may want to use 3D plant models or
architectural drawings as reference models. You can select whether to show a
reference model, and change the reference model appearance in the drawing
view properties in an open drawing. You can select whether to show the
reference model as outlines or as wireframe, set the hidden lines and own
hidden lines options, and define the line color and type. Reinforcement in
reference models is also shown.
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The appearance options can also be modified in drawing properties before
you create the drawing, but the visibility options only when a drawing is open.

For more information about reference models, see Reference models and
compatible formats and Import a reference model.

To show reference models in drawings and modify reference model
properties:

1. In an open drawing, double-click the drawing view frame to open the
drawing view properties. 

In GA drawings, you can also adjust the visibility settings on drawing level
by double-clicking the drawing background.

2. Click Reference object in the options tree. 

The Content tab lists all the reference models included in the model.

Note that only those reference models that have objects located the view
area are shown in the list.

3. To show a reference model in the drawing, click the row of the reference
model, and in the Visibility column, select Visible.

4. Go to the Appearance tab and select the representation for the reference
model: 

Wireframe: Shows the reference model as a wireframe. To open
drawings quickly, use the wireframe.

Outline: The reference model is drawn in the same way as Tekla
Structures native parts. It shows the reference model outline. With this
option, you have the Hidden lines and Own hidden lines options
available.

Hidden lines: Shows hidden lines in of the reference model that are
hidden by other reference models or parts.

Own hidden lines: Shows the hidden lines in the reference model that
are hidden by the reference model itself.

5. Modify the color and the type of Visible lines and Hidden lines.

6. Click Modify to modify the reference model in the selected view with the
new settings.

You can also change the visibility and appearance settings in an open drawing
by double-clicking the reference model and changing the settings in the
Reference Object Properties dialog.

Note that if you modify the reference model appearance on the object level,
you can no longer modify the appearance on the view level.

Reference model representation examples

Below is an example of the Wireframe representation:

Edit drawings 553 Reference models in drawings



Below is an example of the Outline representation. Hidden lines and Own
hidden lines are set Off:

Below is an example of the Outline representation. Hidden lines is set On,
and shown in red.

Below is an example of the Outline representation. Hidden lines and Own
hidden lines are both set On, and shown in red.
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Below is an example of how the parts are shown with reference models.
Reference model visible lines are shown in green, and hidden lines in red. The
part visible lines are shown in blue, and the hidden lines in cyan.

4.25 User coordinate system (UCS)
UCS is a local user coordinate system you can use in a drawing view. It is easier
to position drawing objects in view, when you can place objects relative to a
user-defined point of origin, or a base point, in the drawing view.

Tekla Structures shows the UCS symbol in the current drawing view, when you
create, copy, move, or modify objects.

You can define a different point of origin for the UCS for each drawing view,
and change the UCS point of origin as often as you like.
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The following example shows several views, each with their own UCS.

NOTE To position an object using the global coordinate system, you need to
calculate the coordinates of the object from the point of origin of the drawing,
not a drawing view.

Set a new UCS
You can set a new UCS (user coordinate system) using one point or two points.

1. Open a drawing.

2. On the Views tab, click User coordsys and click one of the following
commands: 

• Select Set origin to set the new UCS using one point.

• Select Set origin by two points to set the new UCS using two points.

Tekla Structures displays the UCS symbol with a crosshair marking the
center point.

3. Click the view where you want to place the origin.

4. If you are using two points, pick a point to define the direction of the x
axis.

Edit drawings 556 User coordinate system (UCS)



Toggle between two user coordinate systems
You can toggle between two user coordinate systems that have the same
point of origin: the UCS following the axes of the drawing view and the
oriented UCS you have created.

• To toggle between the coordinate systems, open a drawing, go to the
Views tab and click User coordsys --> Toggle orientation (Ctrl + T).

Reset UCS
You can reset the UCS to its original position in the current drawing view or in
all drawing views.

Do one of the following:

To Do this
Reset the UCS in the
current drawing view

In an open drawing, go to the Views tab, and click
User coordsys --> Reset current (Ctrl + 1).

Reset the UCS in all
drawing views

In an open drawing, go to the Views tab, and click
User coordsys --> Reset all (Ctrl + 0).
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5 Manage drawings

You can manage your drawings in Document manager. Depending on the
workflow phase, you have several tools available for managing the drawings.
You can update drawings when the model changes, lock drawings, freeze
drawings, issue drawings, revise drawings, and delete drawings.

To Click the link below:
Learn how to set up Document
manager and use it for searching
drawings, for example

Document manager (page 559)

Update saved drawings because of
model changes

Update drawings when the model
changes (page 581)

Indicate that a drawing is not
available for editing by locking it

Lock drawings (page 582)

Select whether to allow Tekla
Structures to update all associative
objects on top of the drawing views

Freeze drawings (page 583)

Mark drawings ready for issuing Mark drawings ready for issuing
(page 584)

Mark a drawing issued when it has
been released for fabrication

Issue drawings (page 585)

Delete a drawing that you do not
need anymore

Delete drawings and file documents
(page 594)

Renumber all GA drawings Delete drawings and file documents
(page 594)

Delete unnecessary drawing files
without waiting for Tekla Structures
to automatically delete them

Delete unnecessary drawing files in
single-user mode (page 593)

Revise drawings, and attach
information about the changes you
have made

Revise drawings (page 586)

Manage drawing versions Version control for drawings
(page 589)
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To Click the link below:
Use the old drawing list Drawing list (page 595)

5.1 Document manager
With Document manager you can list and manage your drawings and other
types of documents efficiently.

You can reorganize, freeze, show and hide columns, edit some of the list data
directly, and organize documents and drawings in categories, for example. You
can open drawings, and if you have a related application installed, you can
open other types of files, such as PDF files, NC files and DWG files. Document
manager has a powerful search tool, which supports wildcards and the most
common search operators. You can save your searches in search-based
categories, and also create manual categories.

Open Document manager
Open Document manager in one of the following ways:

• On the Drawings & reports tab on the ribbon, click the Document
manager button.

• Enter document manager in Quick Launch. You can also enter drawing
list.

• Press Ctrl+O if a drawing is open, or press Ctrl+L if you are in the model.
You can also customize the shortcut. You can find it in the Keyboard
shortcuts dialog box by searching either document manager or drawing
list.

• Select objects in the model, open the contextual toolbar, and select Open
or create drawings. Then list the drawings for the selected objects in
Document manager by selecting Show drawings for selected objects...
in the menu.
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Filter, sort and adjust Document manager content

To Do this
List documents in a
certain category

• Click a category on the left.

• You can also hold down Ctrl or Shift and select
several categories.

• You can show/hide the categories list by clicking
the arrow in the top left corner of the dialog
box.

• To exclude documents from or include
documents in an individual category in
Document manager, right-click the category
and select Exclude/Include. For example, if you
just want to see drawings and no other
documents, right-click the All files category and
select Exclude.

List all documents in the
model, both drawings
and file documents

• Click the All documents category.

The file
DocumentManagerFileDocumentSettings.txt
in your model, project, firm or system folder
defines which other document types are shown in
addition to drawings.
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To Do this
List all file documents in
the model, only
including other
document types than
drawings

• Click the All files category.

List all drawings in the
model

• Click the All drawings category.

List up-to-date drawings
only

• Click the Up-to-date drawings category.

List drawings that need
to be updated

1. Click the Up-to-date drawings category.

2.
Click the  Invert document visibility
switch.

Only list the documents
that you have selected
from the list

•

Activate the  Show selected documents
only switch. When the switch is active, it is blue

.

Note that when you activate the Show selected
documents only mode, Document manager
also show documents that you then create or
modify, as long as they match the active search
and selected category criteria. These
documents will then appear in the list as
unselected to distinguish them from the
already selected documents.

Hide the currently visible
documents in the list
and list all other
documents

•
Activate the Invert document visibility

switch. When the switch is active, it is blue .

•
When the switch is active, it is blue . The
name of the switch changes to Reset
document visibility to indicate that clicking the
button again will reset the visibility and not
invert the visibility a second time.

• If you click a category or enter a manual search,
this switch will be deactivated.

• Any documents that you have excluded from
Document manager using the Exclude
command will be ignored by Invert document
visibility and will never be shown.
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To Do this
Show changes from now
on

•
Activate the  Show changes from the
checkpoint set when the button is activated
switch. When the switch is active, documents
that have changed since the activation of the
switch will be displayed.

• When you have enabled the Show changes
from the checkpoint set when the button is
activated switch in Document manager, and
then when you disable this switch, you will get
the following message: Turning off 'Show
changes' will reset the changes checkpoint
and lose the history of which documents
have changed since the checkpoint was set.
Are you sure you wish to continue?. Select
Create new category.

• If this switch is active, and you run numbering,
any drawings who's status then changes (if
parts were modified, for example) will then be
automatically shown in the list.

Reset the document list • Click the  Show all documents button.

This resets the document list so that all
documents are visible, and all searches and
filtering are cleared. Excluded categories
remain excluded. This feature also provides a
convenient way to restore the document list to
a default state when recording macros.

Reorder columns • To reorder columns, drag the columns to new
locations.

Sort columns • To sort a column, click a column title. A small
arrow shows that the column is used for sorting
and the sort order.

• To sort by several columns, hold down Shift
and click column titles.

Freeze columns • To freeze one or more columns so that columns
to the left of the selected column will not scroll
horizontally, right-click a column and select
Freeze at this column.

• To unfreeze, right-click and select Unfreeze
columns.

Show or hide columns • To hide a column, right-click a column and
select Hide column.
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To Do this
• To show hidden columns, right-click a column

and select Show all columns , or Show
column and select a hidden column you want
to show.

• The column order, visibility and sorting order
are saved in the model folder in an user-
prefixed file
DocumentManagerDataGridSettings_<user
>.xml. Default values are read from
DocumentManagerDataGridSettings.xml
located in the system folder defined byt the 
XS_SYSTEM advanced option if there is no user-
specific settings file available. The user settings
file can be located in all standard locations
(model, project, firm, environment). For more
information about the folder search order, see .

Display time • Right-click a column that shows date
information, and select Time display and one
of the available options:

No time

Hours and minutes

Hours, minutes and seconds

If the property only supports date and no time,
these options will not be available.

Edit Document
manager list data
directly

1.
First ensure that the edit switch  is active.

2. Then click the data cell you wish to edit, such
as Name, Title 1 - Title 3, Freeze, Lock,
Ready for issuing, or a cell that comes from
drawing UDAs, such as date cells.
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To Do this

When the edit switch  is active in Document
manager, and you move the mouse cursor over a
cell that is not editable, the cursor changes to
indicate that you cannot edit the cell:

Show drawing views in
model

1. Select one or more drawings in the document
list.

2. Click the Show drawing views in the model
button in the top-right corner of the
Document managerwindow. When this
button is activated, it changes color:

The views in the selected drawings are now
displayed in the model. You can then use
direct modification to work with the view
extents and view plane of every view that is
contained within each selected drawing in the
currently open model views.

Delete drawings or other
documents Select drawings or file documents and click 

Delete, or right-click and select Delete.
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To Do this
If you have selected both drawings and file
documents, you get separate confirmation
messages for drawings and file documents.

If you hold down Shift while you select Delete,
Tekla Structures will not ask you to confirm the
deletion of documents.

Search for documents

Use the search box at the top to look for the desired documents. Only the
documents currently shown in the list are searched.

Search is case insensitive and partial. For example, searching for the string con
will match with concrete and second.

You do not need to write the operator AND, just use a space between search
terms. For example, searching for the string steel grade will match with
steel beam grade but not with steel beam.

You can search for documents within a specific date range or exact date, and
define multiple search strings.

You can save searches to avoid typing in frequent searches repeatedly. This is
done by saving the current search as a new category. You can also combine
existing categories together to easily create more complex queries.

Wildcards and operators

See the table below for explanations and examples of the different wildcards
and operators you can use.

Notation Explanation
* Match zero to any number of

characters.

Fore example, H*T matches hot,
heat, and heavy lifter

? Matches any single character.

For example, B?-1 matches B1-1,
B2-1, Bb-1.

[] Defines a matching group. The
matching group matches any single
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Notation Explanation
character out of a set of characters
that you give between the brackets.

For example, the search A[ABC]1
matches AA1, AB1, and AC1.

AND The search expressions on both sides
must match. This is the default
operator, and you do not have to type
it in the search string.

For example, steel AND grade
finds drawings that contain steel
grade S235JR but does not find
drawings that contain grade S235JR
or steel S235JR.

OR One of the search expressions on
either side must match.

For example, steel OR grade (or
steel grade) finds drawings that
contain grade S235JR, steel
grade S235JR or steel S235JR.

! This is the NOT operator.

Use to exclude from the search, for
example,!steel means that the
search will not find documents
including the string steel.

() Groups search expressions.

Use parentheses () to create more
complex expressions.

For example: (B2 AND concrete)
OR B3 matches all drawings
containing B3 and also the subset of
B2 drawings that mention concrete.

"" Disables special characters inside the
quotes.

Use for phrases that contains spaces
or if you want to search for characters
that are listed as wildcards or
operators in this table.

For example, Mark: "2 - 1"
matches drawings containing [B.2 - 1]
and [C.2 - 1].
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Notation Explanation
<Property name>: Replace <Property name> with one of

the properties displayed to limit the
search scope to that property.

You can search for documents based
on the internal name of the property
(search name). The search name is
shown in the property column header
tooltips when you move the mouse
pointer over the header. The search
name is case sensitive.

For example, CreationDate:
11/20/2020 matches drawings
created on the 20th of November
2020.

< Less than.

For example, CreationDate: <
11/20/2020 matches drawings
created before the 20th of November
2020.

> Greater than.

For example, CreationDate: >
11/20/2020 matches drawings
created after the 20th of November
2020.

= Exact match. Disables wildcards and
partial matching.

For example, CreationDate: =
11/20/2020 matches drawings
created on the 20th of November
2020, and Mark: = [B.2 - 1]
matches drawings containing [B.2 - 1]
only.

If you type a wildcard, asterisk (*) for
example, it is considered as the
character *.
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Notation Explanation
<= Less than or equal.

For example, CreationDate: <
11/20/2020 matches drawings
created on the 20th of November
2020 or before.

>= Greater than or equal.

For example, CreationDate: >
11/20/2020 matches drawings
created on the 20th of November
2020 or after.

<<inv>> Invariant (language-independent)
search.

Use if you want to match fields
written in different languages.

For more information, see below.

Searching with date and time

• You can search date and time in two different ways depending on the date
and time format Tekla Structures is using:

• dd.mm.yyyy or mm/dd/yyyy for dates, for example, 30.11.2018 or 
11/30/2018

• hh:mm:ss or hh:mm:sspm and hh:mm:ssam for time, for example, 
17:34:45 or 05:34:45pm

• Note that advanced options XS_IMPERIAL_DATE and XS_IMPERIAL_TIME
determine which date and time format is active. Only the active format is
used, which means that a non-imperial date will be ignored if imperial date
is the active date format.

• You can also enter partial dates and date ranges:

• 2018: any date and time in the year

• 6.2018 (or 6/2018): any date and time in the month

• 24.06.2018 (or 06/24/2018: any time in the specified day

• "06.06.2018 14" : any time in the range 14:00 to 14:59 on 
06.06.2018. Note that you need to use quotes because otherwise the
space is seen as the end of one search expression.

Complex search examples

Mark: FP !??FP finds all marks that begin with FP. The search matches
[FP123] and [FPZ23] but does not match [AB123FP].
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Invariant search values
The search syntax <<inv>>(...) allows you to search for documents and
create categories that work in the same way regardless of the language in use.

The values to use when doing invariant <<inv>>(...) searches are listed
below.

• Property name: IssuedStatus
• NotIssued
• Issued
• IssuedButModified

• Property name: DrawingUpToDateStatus
• DrawingIsUpToDate
• PartsWereModified
• DrawingIsUpToDateButMayNeedChecking
• IncludedDrawingModified
• OriginalPartDeleted
• AllPartsDeleted
• NumberOfPartsInNumberingSeriesIncreased
• NumberOfPartsInNumberingSeriesDecreased
• DrawingWasCloned
• DrawingWasUpdated
• CopiedViewChanged
• DrawingWasSplitted
• MovedViewDeleted
• MovedViewLabelChanged

• Property name: Changes
• Same values as DrawingUpToDateStatus and IssuedButModified

• In date and time search, you can only use the non-imperial formats
( dd.mm.yyyy and hh:mm:ss) :

• <<inv>>(10.5.2017)
• The invariant search ignores the advanced options XS_IMPERIAL_DATE

and XS_IMPERIAL_TIME.
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For Freeze, Lock, Ready for issuing and Master drawing the following values
can be searched for in invariant search and in normal search:

• True
• False

Create search-based document categories
There are default categories in Document manager, and you can create
categories of your own by saving search strings.

To create a search-based category:

1. Enter a search string that finds the documents you want to categorize. 

For more information about the allowed wildcards and operators, see the
searching instructions above.

2. Right-click in the category list on the left and select New.

3. Define the category properties: 

• Name: Enter the name to be shown in the category list. If you use a
translation key beginning with the prefix albl_, the name is translated if
the translation is found in DocumentManager.ail ( in \messages
\DotAppsStrings\). When a valid translation key is used, the
translation will be shown in the dialog box.

• Search string: Enter here the search string that gives the desired list
of documents. The default for the new category is the active search
string. You can test the string by clicking the Test button. Do not leave
the Search string box empty.

• Tooltip (optional): Text that is displayed when you move the mouse
pointer over a category. If you use a translation key beginning with the
prefix albl_, the tooltip is translated if the translation is found in
DocumentManager.ail. When a valid translation key is used, the
translation will be shown in the dialog box.

• Group: Enter a number that specifies the group of the category. There
is a separator in the category list between the different groups.

The default value for a new category is 0. Negative values are allowed.

• Sort index: Enter a number that specifies the location of the category
in the category list, and the smaller the number is, the higher the
category is on the category list. Categories are sorted first by Group,
then Sort index and then by Name.

The default value for a new category is 0. Negative values are allowed.

• Combining operator: Enter AND or OR. When you select several
categories at a time, categories with OR rule are combined first and
then the ones with AND rule.
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• Association type: Change the category association type. The options
are Search only, Manual only, and Manual and search. For more
information about changing the category type, see section "Change
category association type" below.

• Allow delete: If you select this, the Delete command will be available
for this category when you right-click the category in the categories list.

All changes in categories are saved in
DocumentManagerCategories_<user>.xml in the current model
folder. You can rename the file to DocumentManagerCategories.xml
and move it to a folder defined with the advanced options XS_PROJECT, 
XS_FIRM or XS_SYSTEM, or keep it in the current model folder. The
default categories are defined in DocumentManagerCategories.xml
located in the system folder defined by the advanced option XS_SYSTEM.
For more information about the folder search order, see .

4. Click Save.

Below is an example of a category that lists all assembly drawings that have
the character B in the mark:

Create manual document categories
Sometimes you may need to have a document category in Document
manager for documents that would be difficult to categorize using the search.
You can simply select documents, create a manual category and add your
documents there. You can also add documents to and remove documents
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from existing manually created categories, and combine categories, both
search-based and manual ones. A manual category may contain both
drawings and file documents.

Creating a manual category may be useful, for example, when you have
enabled the Show changes from the checkpoint set when the button is
activated feature in Document manager, and then when some documents
have changed and are listed, you can add the changed documents in the
manual category.

TO Do this
Create a new manual
category and add
documents there

Select the documents from the list, right-click and
select Manual category --> Add to new . Then
type a name for the category, an optional tooltip,
and define other necessary settings. Then click
Save.

Options are the same as in the search-based
categories, except that the functionality related to
search strings, and the Test button are missing if
there are documents associated. If there are no
documents associated, then the search controls
are visible and the category could become a
search-based category or a manual category.

The newly created or modified manual categories
are saved to the
DocumentManagerCategories_<user>.xml file
under the current model folder.

Save recently changed
documents in a new
manual category

When you have enabled the Show changes from
the checkpoint set when the button is
activated switch in Document manager, and
when you disable this switch, you will get the
following message: Turning off 'Show changes'
will reset the changes checkpoint and lose the
history of which documents have changed since
the checkpoint was set. Are you sure you wish
to continue?. Select Create new category.

You can also select to turn the switch off and lose
the history.

Edit a manual category Right-click the category in the category list and
select Edit.

Add documents to an
existing manual category

Select the documents from the list, right-click and
select Manual category --> Add to existing and
then select the desired category.

All compatible manual categories are listed. You
can add the selected documents to several
categories.
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TO Do this
Remove documents
from a manual category

Select the documents from the list, right-click,
select Manual category --> Remove from and
then select the category from which to remove the
documents.

You can also select manual categories first so that
all documents in those categories are listed, right-
click the list, and select Manual category -->
Remove from selected .

Delete a manual
category

Right-click the category in the category list, and
select Delete.

Note that if a document ID cannot be found when loading previously saved
manual categories, an entry will be written to the Document manager log
identifying the manual category and the document ID of the missing
document. This situation can arise if a drawing or file document is deleted
when Document manager is not open and that document was referenced in
a manual category.

Change category association type
You can use the setting Association type in the Edit category and New
category dialog boxes to define if a category is search based, manual, or both.

• If the category is of type Search only or Manual and search, you need to
define a Search string in the dialog box.

• If you create a category by first selecting documents from the documents
list, the association type is Manual only by default.

• If you create a category from the category list, the association type is
Search only by default.

• You can change the association type later. If you change the type from
Search only to Manual only, a message is displayed telling that the
Search string for that particular category will be cleared. If you change the
type from Manual only to Search only or Manual and search, you need
to define a Search string.

Find model objects that have associated drawings in
Document manager
You can use Document manager for identifying the objects in the model that
have associated drawings.

Before you start, ensure that you only have the  Select parts selection
switch active. Otherwise part selection may take a long time in large models.
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1. Open a model view where all objects are clearly visible.

2. Do one of the following: 

• Highlight the objects associated to individual drawings by selecting the

individual drawings in Document manager and clicking  Select
objects in the model for selected drawings.

• Highlight all objects that have associated drawings by selecting all

drawings in Document manager (Ctrl+A) and clicking  Select
objects in the model for selected drawings

TIP • To see the found objects more clearly in the model, right-click the
model and select Show Only Selected to only show the parts
that the Select objects in the model for selected drawings
command has found and hide all others.

• After completing the step above you can highlight the objects
that do not have drawings by holding down the Ctrl key and
selecting the entire model (hold down the left mouse button and
drag all the way from left to right).

Find drawings associated to objects selected in model
You can list drawings associated to the objects you have selected in the model
only. This is an easy way to identify the drawings associated with a specific
part, assembly or cast unit.

1. Open a model view where all objects are clearly visible.

2. Select the desired objects in the model.

3. In Document manager , click  Select and show only drawings
containing parts currently selected in the model. 

Tekla Structures only selects and shows the drawings associated with the
objects that you selected in the model. The result also depends on the
selected category, which means that if you only have the GA drawings
category selected, GA drawings are only shown in the list.

TIP You can also show drawings for the selected model objects in Document
manager by using the contextual toolbar: Click Open or create
drawings and select Show drawings for selected objects... from the
displayed menu.
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Open documents
To open a drawing, do any of the following:

• Double-click the drawing.

• Select the drawing from the list and click the Open  button at the
bottom.

• Right-click the drawing in the list and select Open.

• To open the previous or next drawing in the list, click the  Open

previous drawing button or the  Open next drawing button 
at the bottom.

You can also reopen an updated drawing:

• When you have a drawing open and you have edited it manually, open the
Document manager, and open the same drawing again.

If you have a related software installed, you can also open other documents,
such as NC files, DWG files, or PDF files. Do any of the following:

• Double-click the document.

• Select the document from the list and click the Open  button at the
bottom.

• Right-click the document in the list and select Open.

To open a folder of the selected file document in Windows Explorer, right-click
the document and select Open folder.

Issue, lock, freeze and mark ready for issuing
• You can lock, freeze or mark ready for issuing by selecting the drawing

from the list and clicking the appropriate column next to the drawing.

When you do this, first ensure that the edit list switch  is active. You
can also right-click drawings and select the commands from the context
menu, or use the buttons at the top for quick access. Note that you can
hide the buttons at the top by clicking the arrow next to the buttons.
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For more information about these functionalities, click the following links:

Mark drawings ready for issuing (page 584)

Issue drawings (page 585)

Freeze drawings (page 583)

Lock drawings (page 582)

Revise drawings
• To revise a drawing, select a drawing and click the Revision button. When

you revise drawings, you can attach information about the revision
changes. Tekla Structures displays this information alongside the revision
number or mark. The revision date appears in the revision table. The
revision number or mark is shown in the Document manager, and the
revision information can be included in reports.

For more information about revising drawings, see Revise drawings
(page 586).

Copy Document manager rows to clipboard
You can copy data from the Document manager list and paste the data in
another application, such as a spreadsheet application:

1. Select a number of documents in the Document manager list.

2. Right-click and select Copy rows to Clipboard.

3. Open the other application and paste the row data there.

Create GA drawings
You can create GA drawings quickly and easily in Document manager:

1. In Document manager, click Create GA Drawing. The Create General
Arrangement Drawing dialog box is displayed.

2. Select the model views of which you need GA drawings, and then create
the drawings by clicking Create.

Configure file documents to include in Document manager
The configuration file DocumentManagerFileDocumentSettings.txt
defines which file documents are included in Document manager. This file
also specifies the folders to search for. This file can be located in any of the
standard search locations (model, project, firm and system). By default this file
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is located in the system folder defined by the advanced option XS_SYSTEM,
and you can copy it from there to model, project, firm or system folders for
modifications. For more information about the folder search order, see .

The format of each line is <folder_path>\*.<file_name_extension>|
<include_subfolders> , where

• <folder_path> is a relative or absolute path. A relative model subfolder
can be specified using a leading period (.).

• *.<file_name_extension> specifies the accepted file types. You can use
standard wildcards ? and *.

• <include_subfolders> specifies if the subfolders are included. Set to 
true to include subfolders and to false to not to include subfolders.

Examples:

.\Plotfiles\*.dxf|false

.\DSTV_Profiles\*.nc1|false

.\DSTV_Plates\*.nc1|false

Configure drawing UDAs to show in Document manager
columns
The DocumentManagerUDAs*.txt files define the drawing UDAs that are
shown in the Document manager columns. The file name can be either
DocumentManagerUDAs.txt or DocumentManagerUDAs_<suffix>.txt
where <suffix> can be any string. These files can be placed in a folder
defined with the advanced options XS_FIRM, XS_PROJECT, XS_SYSTEM or 
XS_INP, and in the model folder. By default DocumentManagerUDAs.txt is
located in the \inp folder defined by the advanced option XS_INP, and you can
copy it from there to the model, project, firm or system folder for
modifications. The contents of each file found are merged together. For more
information about the folder search order, see .

List all the drawing UDAs that are needed in this file, one UDA on each line.
The UDA names are case sensitive. The UDA must exist in the objects.inp
file.

Below is an example of the DocumentManagerUDAs.txt file in the Common
environment:

DR_APPROVAL_DATE
DR_APPROVAL_SENT
DR_APPROVED_BY
DR_ASSIGNED_BY
DR_ASSIGNED_TO
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DR_CHECKED_BY
DR_CHECKED_DATE
DR_DRAWN_BY
comment
For more information about UDAs in drawings, see User-defined attributes in
drawings (page 903).

Document manager log
All errors occurring in the Document manager functionality are written in the
Document manager log file \logs\DocumentManager_<user>.log under
the current model folder. This log file also lists the full paths of all the settings
files that have been loaded (DocumentManagerUDAs*.txt,
DocumentManagerFileDocumentSettings.txt,
DocumentManagerDataGridSettings*.xml and
DocumentManagerCategories*.xml), which helps you to see which settings
files Document manager is finding. The log also tells if a settings file cannot
be found.

The log file is limited in size, and will be archived as \logs
\DocumentManager_<user>.bak.log when the maximum size has been
reached.

Example:

Loading UDA settings file C:\TeklaStructuresModels\New model 
3\DocumentManagerUDAs.txt
Loaded column layout settings from file: C:\TeklaStructuresModels\New 
model 3\DocumentManagerDataGridSettings_user.xml
Loaded frozen column name: Title1 from file: C:\TeklaStructuresModels\New 
model 3\DocumentManagerDataGridSettings_user.xml
Loaded the column sort order settings from file: C:\TeklaStructuresModels
\New model 3\DocumentManagerDataGridSettings_user.xml
Loaded 16 document categories from file: C:\TeklaStructuresModels\New 
model 3\DocumentManagerCategories_user.xml
No DocumentManagerFileDocumentSettings.txt file found. File documents 
will not be shown.

Drawing status flags and related status messages

Flag Column where
flag displayed

What's shown in
Changes column

Description

Parts modified The parts in the
drawing have
changed, for
example, parts
have been added
or deleted, or part
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Flag Column where
flag displayed

What's shown in
Changes column

Description

properties have
changed.

Quantity
increased or

Quantity
decreased

The actual
drawing is up to
date, but the
number of
identical parts has
changed.

All parts deleted All parts related to
the drawing have
been deleted
from the model.

 The drawing is
locked and you
cannot open it for
editing.

You can check
who marked the
drawing from the
Locked by
column.

 The drawing is
frozen. Changes
made to the
model objects,
which have
drawing objects
associated with
them, are no
longer available in
the drawing.

 The drawing has
been added as a
master drawing in
the Master
Drawing Catalog.

Drawing was
updated

The drawing is
marked ready for
issuing. You can
check who
marked the
drawing from the
Ready for issuing
by column.
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Flag Column where
flag displayed

What's shown in
Changes column

Description

Drawing was
updated

The drawing has
been updated.

Linked drawing
changed

You have a linked
drawing in this
drawing and the
linked drawing
has been
modified.

Copied view
changed

A copied view has
been modified.

Drawing was
cloned

The drawing is a
cloned drawing.

The flag
disappears when
you save and
close the drawing.

 The drawing has
been issued. You
might want to re-
issue drawings
that have been
sent to site.

Issued drawing
changed

The issued
drawing has been
edited or
otherwise
changed.

Other available functionalities in Document manager
In Document manager, the following functionalities are also available:

• Print to a .pdf file, plot file (.plt) or printer (page 607)

•

• Revise drawings (page 586)

• Create multidrawings (page 104)

• Copy a drawing to a new sheet (page 154)

• Add a cloning template master drawing in Master Drawing Catalog
(page 130)

• Delete drawings and file documents (page 594)
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• Version control for drawings (page 589)

• Update part and weld marks in drawings (page 303)

• Modify drawing properties of an existing drawing (page 67)

• User-defined attributes in drawings (page 903)

• Snapshots in drawings (page 159)

5.2 Update drawings when the model changes
Saved drawings need updating because of model changes. Cast-unit,
assembly, single part and multidrawings use position numbers as identifiers.
Many changes affect numbering, so many times renumbering is needed.
Before updating drawings you need to ensure that the numbering is correct.

The drawings needing updates are indicated by flags in Document manager.
Renumbering model objects after creating drawings may also generate flags.

NOTE • General arrangement drawings do not require model numbering
to be updated. If you use part position numbers in part marks, you
must number the model to get updated marks, because old and
not up-to-date part marks have question marks in them. If you do
not use numbering, you can modify general arrangement drawings
without numbering. Then, for example, profile changes are
highlighted with change symbols.

• When you update multidrawings, also the linked drawings are
updated.

Do the following after changing the model:

1. Check the numbering settings by going to the Drawings & reports tab
and clicking Numbering settings --> Numbering settings .

2. Select Compare to old for both the new and modified parts.

3. Number all model objects that have same numbering series settings on
the Drawings & reports tab by clicking Perform numbering --> Number
series of selected objects, or number only new or modified model
objects by clicking Perform numbering --> Number modified objects .

4. Check the Document manager for status flags.

5. To find the parts that have been affected, select each drawing marked

with the  flag in the Document manager and click the Select objects
button. 

Tekla Structures highlights the affected parts in the model.

Do the following:
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a. Check the numbering history log for renumbered parts by going to
the File menu and clicking Logs --> Numbering history log . 

Part or Assembly at the beginning of a line in the numbering history
log indicates that Tekla Structures has renumbered parts or
assemblies, as in the following example:

b. To find the renumbered parts in the model, select the relevant entries
from the numbering history log. Tekla Structures highlights the
corresponding parts in the model.

6. Select the affected drawings from Document manager and click Update.

7. If you have new parts in the model, create drawings for them.

See also

Manage drawings (page 558)

Document manager (page 559)

Recreation of drawings (page 78)

5.3 Lock drawings
You can indicate that a drawing is not available for editing by locking it. When
a drawing is locked, it cannot be accidentally modified. The geometry of the
locked drawing still changes when the model changes.

Tekla Structures flags locked drawings for update if the model changes.

1. In Document manager, select the drawing you want to lock.

2. Ensure that the edit switch  is active.

3. Click the Lock column next to the selected drawing. 
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You can also select this command from the context menu, or click the 
Lock button at the top. When you do this, you can lock several drawings
at a time.

The Locked by column in the Document manager shows who has locked
the drawing. If you have logged in to your Trimble Identity, your account
name is shown. Otherwise your user name is shown.

4. To unlock the drawings, click the  Lock column again, or select the
locked drawings and click the Unlock button at the top.

See also

Document manager (page 559)

5.4 Freeze drawings
You can select whether to allow Tekla Structures to update all associative
objects on top of the drawing views. The geometry of the model is always
updated, but freezing is used to stop the drawing intelligence (associativity) of
drawing objects on top of the model views, and prevent them from being
updated. For example, parts are updated, but dimensions, marks, views, and
drawing shapes are not. Use freezing only to avoid changes in drawings while
updates are made in the model, not just for noting that the drawing has been
edited. You can freeze/unfreeze several drawings at a time.

How freezing affects drawings

Freezing affects drawings in the following way:

• The associativity does not disappear from a frozen drawing. When you
unfreeze the drawing, the associativity works again.

• Freezing does not have any effect on the cloning result. If you edit the
drawing, it does not matter whether you freeze the drawing before or after
editing it.

• If a drawing is frozen, the associative drawing objects are not updated
when the drawing is updated. This means that the dimensions and views
are not updated, and the marks do not follow the parts if the parts have
been moved.

• If a drawing is frozen, and the part changes in the model, the geometry of
the part is updated in the frozen drawing when the drawing is updated.

• Unfreezing the drawing before cloning does not have any effect on the
cloning result. This means, for example, that it does not matter whether
you keep the drawing frozen all the time or temporarily unfreeze it before
cloning.
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• If you unfreeze a drawing before update, the drawing is updated normally.

Freeze general arrangement drawings

1. If you have the GA drawing open, close it without saving it.

2. In Document manager, select the drawing you want to freeze.

3. Ensure that the edit switch  is active.

4. Click the Freeze column next to the drawing you selected.

You can also select this command from the context menu, or click the
Freeze button at the top. When you do this, you can freeze several
drawings at a time.

5. When freezing is no longer necessary, select the frozen drawings and click

the Freeze column again, or click the Unfreeze button at the top.

Freeze single-part, cast unit and assembly drawings

1. Save the model.

2. Open a drawing.

3. If the drawing does not look the way you want, close it without saving it.

4. Reopen the model. Do not save it.

5. In the Document manager, select the drawing you want to freeze.

6. Click the Freeze column next to the drawing you selected.

You can also select this command from the context menu, or click the 
Freeze button at the top. When you do this, you can freeze several
drawings at a time.

7. Open the drawing.

8. When freezing is no longer necessary, select the frozen drawing and click

the  Freeze column again, or click the  Unfreeze button at the top.

5.5 Mark drawings ready for issuing
When a drawing is ready to be released for fabrication, you can mark it ready
for issuing by using the option Ready for issuing in Document manager.
When there are changes in the model, the geometry of the drawings that are
marked ready for issuing is updated. You can also edit the marked drawings
just like any other drawings.
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1. In the Document manager, select the drawing to be marked ready for
issuing.

2. Ensure that the edit switch  is active.

3. Click the Ready for issuing column next to the drawing that you want
to mark. 

You can also select this command from the context menu, or click the 
Mark drawing ready for issuing button at the top. When you do this,
you can mark several drawings at a time.

The drawings are marked ready for issuing, and flagged with

in the Ready for issuing column in Document manager. You can check who
marked the drawing from the Ready for issuing by column.

If you want to cancel the marking, use the  Unmark drawing ready for
issuing button at the top.

TIP You can also mark a drawing ready for issuing by selecting the Mark
drawing ready for issuing check box in the save confirmation message
box, which appears when you close an unsaved drawing.

You can add in your reports the information whether the drawing is marked
ready for issuing, and who has marked it using the template attributes and

See also

Document manager (page 559)

5.6 Issue drawings
When a drawing has been released for fabrication, it should be marked as
issued in Document manager. The geometry of the issued drawings is
updated when the model changes. Issuing only prevents the recreation of the
drawing during update.

The issuing information can be used to filter what is shown in the Document
manager and in templates.

1. In Document manager, select the drawings to be issued.

2. Right-click and select Issue --> Issue , or click the Issue button at the top. 
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Tekla Structures marks the issued drawings with a flag 

When an issued drawing has been edited or otherwise changed, the color

of the flag changes to  and the text Issued drawing changed is
displayed in Document manager. You can reissue the drawing by right-
clicking the drawing and selecting Issue --> Issue .

To unissue a drawing, select the drawing, right-click and select Issue -->
Unissue, or click the Unissue button at the top.

TIP To show the issue date in a report, add the template field in the appropriate
report template.

See also

Manage drawings (page 558)

Document manager (page 559)

5.7 Revise drawings
When revising drawings, you can attach information about the revision
changes. Tekla Structures displays this information alongside the revision
number or mark. The revision date appears in the revision table. The revision
number or mark is shown in Document manager, and the revision
information can be included in reports. You can also add manual revision
marks in an open drawing.

TIP One example of the report using revision information is
drawing_issue_rev.xsr, which shows the most recent revision dates of
drawings.

For more information about adding manual revision marks, see Add revision
marks in drawings (page 329).

Create drawing revisions
You can create revisions to follow the changes in the drawing using the
Revision command in the Document manager.

1. In Document manager, select the drawings to revise.

2. Click Revision. 

The Revision Handling dialog box is displayed.
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3. Enter a mark in the Mark box. 

Marks can be numerical or alphabetical such as 1, 2, 3… or A, B, C…

4. Fill in the Created by information and select the creation date from the
calendar that is displayed when you click the down-arrow next to the Date
option.

5. If you need to give information about who checked and approved the
drawing, enter the information in the corresponding boxes and select the
appropriate dates.

6. Enter a revision description in the Description box.

7. Enter delivery information in the Delivery box.

8. Enter any additional information in the Info 1 and Info 2 boxes.

9. Click Create.

The revision number or mark is now displayed in the Document manager.
When you open the drawing, you can see the revision information in the
revision table if there is one in the drawing.

TIP Each drawing has its own unique revision number, but several drawings can
share the same revision mark, date, and other information. To attach the same
revision information to several drawings simultaneously, select multiple
drawings from Document manager and then click the Revision button.

To show the revision mark instead of the revision number in the Document
manager, set the advanced option to TRUE.

Change drawing revisions
You can change revision information in an existing revision.

1. Open the Document manager and select a revised drawing.

2. Click Revision.

3. In the Revision Handling dialog box, select the number of the revision
that you want to change from the Rev.No. list.

4. Change the revision information as required.

5. Click Modify.

6. Close the Revision Handling dialog box.

Delete drawing revisions
You can delete unnecessary drawing revisions.

1. Open Document manager, and select a revised drawing.

2. Click Revision....
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3. In the Revision Handling dialog box, select the revision number from the
list next to the Mark box.

4. Click Delete. 

When you delete a revision, Tekla Structures automatically adjusts the
remaining revision numbers for that drawing. The revision marks remain
the change.

Attributes used in drawing revisioning
Drawing revisioning attributes can be included in drawing templates and
report templates.

All revisioning attributes and the corresponding options in the Revision
Handling dialog box are listed below.

Revision handling attribute Option in the Revision Handling
dialog box

MARK The revision mark in the Mark box.
NUMBER The revision number in Rev.No.
CREATED_BY The Created by information of the

revision.
DATE_CREATE Date next to Created by.
CHECKED_BY The Checked by information of the

revision.
DATE_CHECKED Date next to Checked by.
APPROVED_BY The Approved by information of the

revision.
DELIVERY The Delivery information of the

revision.
DESCRIPTION The revision Description.
DATE_APPROVED Date next to Approved by.
INFO1 The Info 1 text of the revision.
INFO2 The Info 2 text of the revision.
LAST The revision number of the latest

revision in Rev.No..
LAST_CREATED_BY The Created by information of the

latest revision.
LAST_CHECKED_BY The Checked by information of the

latest revision.
LAST_DATE_CHECKED The Checked by Date of the latest

revision.
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Revision handling attribute Option in the Revision Handling
dialog box

LAST_DATE_APPROVED The approval Date of the latest
revision.

LAST_DELIVERY The Delivery information of the latest
revision

LAST_MARK The revision mark of the latest
revision in the Mark box.

LAST_DESCRIPTION The Description of the latest revision.
LAST_DATE_CREATE The Created by date of the latest

revision.
LAST_APPROVED_BY The Approved by information of the

latest delivery.
LAST_INFO1 The Info 1 text of the latest revision.
LAST_INFO2 The Info 2 text of the latest revision.

5.8 Version control for drawings
Version control is available in all drawing types. You can list different versions
of the same drawing, show their snapshots, and change the current drawing
version. You can list drawing versions in other models, and deleted drawing
versions that are no longer available in Document manager. You can also
open a deleted GA drawing as a new drawing.

Listing drawing versions is useful when you want to revert to an older version
of the drawing for some reason. Version control is also available in Tekla
Model Sharing, and you can control unintentional changes made to drawings
and revert to the version that has the correct content.

• Every time you save a drawing, a new version of the drawing is saved.

The advanced option XS_DELETE_UNNECESSARY_DG_FILES deletes the dg
files older than seven days, which is the default value for the advanced
option XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD.

• Note that using Save as does not always contain needed drawing history
data and drawing update may fail.

Open drawing versions list
• To list the different versions of a drawing in the current model, click

Document manager on the Drawings & reports tab, select a drawing
from the list and click the Drawing versions button at the bottom.

The current drawing version appears bolded.
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The drawing snapshot is displayed in a separate window. When you save a
drawing, a snapshot is taken by default. The advanced option to control the
automatic saving of snapshots is XS_DRAWING_SNAPSHOT_CREATION.

Snapshots are not created at drawing creation if the advanced option 
XS_CREATE_SNAPSHOT_ON_DRAWING_CREATION is set to FALSE. If you
open a drawing and save it, you get a snapshot if 
XS_DRAWING_SNAPSHOT_CREATION is set to TRUE.

• You can now select an older version of the drawing and show its snapshot
or open the drawing version.

• To show all drawings and their versions related to the model, even the
deleted drawings, go to Document manager, and click Drawing versions
without selecting a drawing in the Document manager list. In this
Drawing versions dialog box, you can see the drawing versions, open
deleted GA drawing versions as new GA drawings, open the different
versions and show their snapshots. You can also compare drawings in two
different models: from the current model and from a model that you select
at the top left corner of the Drawing versions dialog box. In the dialog
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box, you can clearly see which drawings are in which model. The drawing
versions are listed on the right.

Version control for drawings
Version control is available in all drawing types. You can list different versions
of the same drawing, show their snapshots, and change the current drawing
version. You can list drawing versions in other models, and deleted drawing
versions that are no longer available in Document manager. You can also
open a deleted GA drawing as a new drawing.

Listing drawing versions is useful when you want to revert to an older version
of the drawing for some reason. Version control is also available in Tekla
Model Sharing, and you can control unintentional changes made to drawings
and revert to the version that has the correct content.

• Every time you save a drawing, a new version of the drawing is saved.

The advanced option XS_DELETE_UNNECESSARY_DG_FILES deletes the dg
files older than seven days, which is the default value for the advanced
option XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD.
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• Note that using Save as does not always contain needed drawing history
data and drawing update may fail.

What can you do with drawing versions

To Do this
Save another drawing version as the
current version

1. In the Document manager list,
select a drawing and click the
Drawing versions button at the
bottom.

2. Open another version of the
drawing.

3. Close the drawing version.

4. When you are asked Do you
want to keep the changes to
the drawing?, answer Yes.

This makes the drawing version the
current drawing version.

Open a deleted GA drawing version
as a new GA drawing

1. Click the Drawing versions
button without selecting a
drawing in the Document
manager list.

2. Select a deleted GA drawing
version from the list on the right
in the Drawing versions dialog
box, right-click and select Open
as new.

Show drawing versions in another
model

1. Click the Drawing versions
button without selecting a
drawing in the Document
manager list.

The drawings in the current
model are listed.

2. In the upper-left corner, browse
to the folder of the other model,
and click Select folder.

The drawings in the other model
are listed on the left, and their
version on the right.
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Drawing versions in Tekla Model Sharing
• In Tekla Model Sharing models, you can list the different versions of a

drawing in conflict situations. When users modify the same drawing in their
local version of the model and one user writes out, the Changes list will
show a conflict in other users' local version of the model when they read in.

• You can open the Drawing versions dialog box from the Changes list.
Select the changed drawing, right-click and select Open versions to view
the drawing versions and the changes made to the drawing.

5.9 Delete unnecessary drawing files in single-user mode
By default, all unnecessary drawing files are deleted automatically after seven
days. You can delete all your unnecessary drawing files in the single-user
mode using the Remove unnecessary drawing files command without
waiting for Tekla Structures to automatically remove them.

To delete the files, you need to have full privileges. You can find the Remove
unnecessary drawing files command through Quick Launch.

Note that the Remove unnecessary drawing files command does not work
in models shared with Tekla Model Sharing. Instead, all unnecessary drawings
are deleted automatically each time when a user writes out their changes.

NOTE If you have worked with the drawings (edited, deleted) after you saved
the last time, remember to save before you use the Remove
unnecessary drawing files command.

1. Search for the command Remove unnecessary drawing files in Quick
Launch.

2. When Tekla Structures finds the command, select it and press Enter. 

Tekla Structures deletes all drawings that do not have a corresponding
drawing in the database.
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TIP By default, the privileges are full. If you want to restrict the command usage, add
the following line in the privileges.inp file:

action:RemoveUnnecessaryDrawingFiles [who] [access]
[who] is everyone or <Windows_logon_name>, or <domain_name>
[access] can be none/view/full.

In the following example, only the administrator can use the Remove
unnecessary drawing files command:

action:RemoveUnnecessaryDrawingFiles everyone none
action:RemoveUnnecessaryDrawingFiles ORGANIZATION\admin full

5.10 Delete drawings and file documents
If some drawings or other file documents become unnecessary, you can delete
them from Document manager.

NOTE In some configurations, deleting drawings or other file documents
from Document manager is not allowed.

1. In the Document manager, select the drawings and other file documents
you want to delete.

2. Right-click and select Delete, or click the  Delete button at the bottom
of the Document manager window.

3. When Tekla Structures asks you to confirm the deletion, select Yes. 

If you press down Shift while you select Delete, Tekla Structures will not
ask you to confirm the deletion of documents.

If you have selected both drawings and file documents, you get separate
confirmation messages for drawings and file documents.

The file document files are deleted from the respective folders immediately.
The .dg files are not deleted from the\drawings folder immediately, but
after seven days by default. If you want to delete them immediately in the
single-user mode, enter Remove unnecessary drawing files in Quick
Launch.

The advanced option that controls if the drawing files are deleted is
XS_DELETE_UNNECESSARY_DG_FILES. The advanced option that controls how
often the drawing files will be deleted is
XS_DELETE_UNNECESSARY_DG_FILES_SAFETY_PERIOD.

If you work in the multi-user mode, see .
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TIP If you have deleted some GA drawings, and you want to have the GA drawings
renumbered, in modeling mode, enter Renumber all GA drawings in Quick
Launch and press Enter. This command renumbers all GA drawings starting
from number 1 in the order that they were originally created. Use this command
in single-user mode only.

Document manager list before running the Renumber all GA drawings
command:

Document manager list after running the Renumber all GA drawings
command:

See also

Manage drawings (page 558)

Document manager (page 559)

5.11 Drawing list
All drawings in a Tekla Structures model are displayed in the Drawing list
dialog box. You can search, sort, select, and display drawings according to
different criteria, and open the drawings displayed in the list. You can take
snapshots of the drawings, and locate the drawing parts in the model, and to
find out if a part is included in any of the drawings.

Document manager is enabled by default instead of Drawing list. All
commands and buttons that would have launched Drawing list in earlier
Tekla Structures versions will from version 2018i onwards launch Document
manager. If you want to enable the old Drawing list instead, set the advanced
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option XS_USE_OLD_DRAWING_LIST_DIALOG to TRUE in the Drawing
Properties category of the Advanced Options dialog box. If you do this,
Document manager will be disabled.

For details about Document manager, see Document manager (page 559).

For details about issuing, freezing, locking and revising drawings, see Manage
drawings (page 558).

Open Drawing list

To open the Drawing list dialog box, do one of the following:

• In the model, on the Drawings & reports tab, click Document manager
(Ctrl + L).

• In an open drawing, on the Drawing tab, click Document manager (Ctrl +
O).

• Enter document manager in Quick Launch. You can also enter drawing
list.

• You can also customize the shortcut. You can find it in the Keyboard
shortcuts dialog box by searching either document manager or drawing
list.
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What is displayed in the Drawing list

Option Description For more information
Issue, Ready for
issuing, Lock, Freeze,
Master, and Up to date

These columns contain
flags indicating the
drawing status.

Manage drawings
(page 558)

Changes Textual information
about the changes in the
drawing. For example, if
the drawing has been
cloned, it says Cloned in
this column.

 

Created The creation date of the
drawing.

 

Modified The latest modification
date of the drawing.

 

Revision The revision number or
revision mark of the
drawing.

By default, Tekla
Structures shows
revision numbers. To
show revision marks
instead, set the
advanced option 
XS_SHOW_REVISION_MA
RK_ON_DRAWING_LIST
to TRUE.

Revising drawings
(page 586)

Type The drawing types are
identified by the
following letters:

• W for single-part
drawings.

• A for assembly
drawings.

• C for cast unit
drawings.

• G for general
arrangement
drawings.

• M for multidrawings.

U (unknown) means that
an error has occurred,

Drawing types (page 80)
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Option Description For more information
and you need to delete
the drawing.

Size The paper size the
drawing uses.

 

Mark In a single-part drawing
mark is the part position,
and in an assembly
drawing the assembly
position from which the
drawing was created.
You cannot change
drawing marks.

Mark contains the sheet
number as well, if it is
not zero (0).

You can choose to have
Tekla Structures base
the mark of cast unit
drawings on the position
number or the ID (GUID)
of the cast unit.

XS_SHOW_REVISION_MA
RK_ON_DRAWING_LIST

Name The name given for the
drawing in the drawing
properties dialog box.

Rename drawings
(page 156)

Title 1, Title 2, and Title
3

Extra drawing titles
added in the drawing
properties dialog box.

Giving titles to drawings
(page 156)

Ready for issuing by Indicates who has
marked the drawing
ready for issuing.

Mark drawings ready for
issuing (page 584)

Locked by The Drawing list
column shows who
locked the drawing. If
you have logged in to
your Trimble Identity,
your account name is
shown. Otherwise your
user name is shown.

Lock drawings
(page 582)

User-defined
attributes

You can show up to 20
user-defined attributes
in the Drawing list.
These user-defined
attributes must be
added in the User-
defined attributes

User-defined attributes
in drawings (page 903)

Manage drawings 598 Drawing list



Option Description For more information
dialog box or panel in
drawing properties. To
include a user-defined
attribute in drawing lists,
the user-defined
attribute must have the
option special_flag
set to yes in the
objects.inp file.

Drawing status flags

Tekla Structures uses certain symbols called flags, to indicate the status of the
drawings. The columns Issue, Ready for issuing, Lock, Freeze, Master and
Up to date contain the flags, and the potential additional information is
displayed in the Changes column. If a drawing does not have any flag symbol,
it is up to date.

How to read drawing status information

The table below explains the meaning of the status flags and information
about the status of a drawing in the Drawing list.

Flag Column where
shown

Information in
the Changes

column

Description

Up to date Parts modified The parts in the
drawing have
changed, for
example, parts
have been added
or deleted, or part
properties have
changed.
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Flag Column where
shown

Information in
the Changes

column

Description

  Quantity
increased or

Quantity
decreased

The actual
drawing is up to
date, but the
number of
identical parts has
changed.

Up to date All parts deleted All the parts
related to the
drawing have
been deleted.

Lock  The drawing is
locked and you
cannot open it for
editing.

Freeze  The drawing is
frozen. Changes
made to the
model objects,
which have
drawing objects
associated with
them, are no
longer available in
the drawing.

Master  The drawing has
been added as a
master drawing in
the Master
Drawing Catalog.

Ready for issuing Drawing
updated

The drawing is
marked ready for
issuing. You can
check who
marked the
drawing from the
new Ready for
issuing by
column.

Up to date Linked drawing
changed

You have a linked
drawing in this
drawing and the
linked drawing
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Flag Column where
shown

Information in
the Changes

column

Description

has been
modified.

Up to date Copied view
changed

A copied drawing
has been
modified.

Up to date Drawing
updated

A frozen drawing
has been
updated.

Up to date Drawing
updated

Drawing that has
been marked
ready for issuing
has changed.

Up to date Cloned The drawing is a
cloned drawing.

The flag
disappears when
you save and
close the drawing.

Issue  The drawing has
been issued. For
example, you
might re-issue
drawings that
have been sent to
site.

Issue Issued drawing
changed

The issued
drawing has been
edited or
otherwise
changed.

Filter drawing list contents

To filter the Drawing list contents, do any of the following:

To Do this
Display a predefined set of
drawings

Select a set of drawings from the or select
drawing set list.

Saved search results are also displayed in this
list.

List all drawings Click Show all.
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To Do this
Invert the contents of the current
list

Click Invert.

This feature allows you to list the opposite of
the current content.

For example, if you had selected to display
Locked drawings, clicking Invert shows all
drawings except the locked ones.

List selected drawings only Select the drawings and click Selected.
List up-to-date drawings only Click Up to date.
List drawings that need to be
updated

1. Click Up to date.

2. Click Invert.
Lists only drawings associated
with the objects you have selected
in the model.

1. Select objects in the model.

2. Click By parts.

This is an easy way to identify the drawings
associated with a specific part, assembly or
cast unit. This works also for objects in GA
drawings.

Sort the list according to column
name

Click the column name.

Search for drawings and save search results

You can search for drawings in the Drawing list.

To search for drawings and save the results:

1. In the Drawing list, enter the search criteria in Enter search criteria.

2. If needed, you can limit the search so that it addresses only information in
a certain column by selecting a column from the Search in list.

3. If needed, you can also limit the search to the currently visible drawings
by selecting Search within the currently visible drawings.

4. Click Search.

5. Click Store to save the search results.

6. Enter a name for the search results in the Store Search Result dialog box
and click OK.

The search results are saved in the DrawingListSearches folder, which is
created in the model folder.

You can move the saved search results to your environment, company or
project folder. After you have saved the search results, they will be visible in
the predefined drawing sets list in the Drawing list dialog box.

Example
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In the following example, you want to find all cast unit drawings that are
assigned to Dean Detailer:

1. From the drawing sets, select Cast unit drawings. Only cast unit drawings
are displayed in the list.

2. In Enter search criteria, type Dean Detailer.

3. In the Search in list, select Assigned To.

4. Click Search.

Select drawings in Drawing list

The Drawing list allows you to select one or several drawings at a time.
Selecting several drawings is useful, for example, if you want to lock or freeze
several drawings at a time, or print several drawings.

To select drawings in the Drawing list:

To Do this
Select one drawing Click the drawing in the list.
Select several consecutive
drawings

Click the first drawing, then hold down the
Shift key and click the last drawing.

Select several non-consecutive
drawings

Click the first drawing, then hold down the Ctrl
key and click the other drawings you want to
select.

Select all drawings in the list Press Ctrl+A.

Check whether parts have drawings

You can use the Drawing list to identify parts in the model that have
associated drawings.

Before you start, ensure that you have only the Select parts selection switch

 active on the Selecting toolbar. Otherwise selecting objects can take a
long time in large models.

1. Open a model view where all parts are clearly visible.

2. In the Drawing list, press Ctrl + A to select all drawings.
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3. To highlight the parts that have drawings, click the Select objects
button.

This works also in GA drawings.

To see the found parts easier, right-click the model and select Show Only
Selected to show only the parts that the Select objects command has
found and hide all others.

4. After completing the previous step you can highlight the parts that do
not have drawings by holding down the Ctrl key and selecting the entire
model (hold down the left mouse button and drag all the way from left to
right).

Open a drawing when the Drawing list is open

Do any of the following:

• Double-click drawing.

• Right-click the drawing in the list and select Open.

• Select a drawing from the list and click the Open button at the bottom.

When you open a drawing, a message box is displayed showing the progress
and what is happening, and a snapshot of the drawing is displayed. You can
click Cancel to cancel the opening.

Create and view drawing snapshots

With snapshots you can take a quick look at any drawings without opening the
drawing. Use this tool when you just want to check but not edit a drawing, or
take a look at several drawings while trying to find the one you are looking for,
for example, a certain drawing revision. You can take snapshots of all types of
drawings.

A snapshot is by default created when you open and save a drawing. The
snapshot represents the situation when the drawing was last saved, so any
newer changes to the model are not reflected in the snapshot.

If you have made changes in the drawing and close it by selecting the Close
button in the upper-right corner, a message box is displayed where you can
select if you want to save the drawing, and also if you want to create a
snapshot of the drawing when the drawing is saved.

1. Select a drawing and open it from the Drawing list.

2. Save the drawing by going to the File menu and clicking Save drawing.

The snapshot is saved in the ..\<model>\drawings\Snapshots folder.

3. Select the same drawing from the Drawing list.

4. Click the Snapshots button at the bottom of the Drawing list to display
the snapshot.

Below is an example of a snapshot.
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If you have selected a drawing that does not have a snapshot and click
Snapshots, an instructional view is displayed asking you to open the drawing
and save it to create the snapshot.

To create a snapshot of a drawing automatically when the drawing is created,
set XS_DRAWING_CREATE_SNAPSHOT_ON_DRAWING_CREATION to TRUE in the
Drawing Properties category in the Advanced Options dialog box.
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6 Print drawings

You can print drawings as PDF files, save them as plot files (.plt) for printing
with printer/plotter, or print them on a selected printer. You can also change
the line thickness of different colors. Tekla Structures provides a real-time
preview of drawings in the Print Drawings dialog box.

Limitations in printing

• You cannot print to several paper sizes at the same time using the Print
Drawings dialog box. To print to several paper sizes, you need to modify
the drawingsizes.dat (page 621) file.
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• Drawings in previews are in color even if you select Grayscale or Black
and white through File menu --> Settings).

• In an open drawing, you can only preview and print that drawing. Having a
drawing open, and you open another drawing (for example, by double-
clicking another drawing in Document manager), the preview may not be
updated. Select the drawing again (single-click) in Document manager and
the preview is then updated to match the selection.

NOTE You can also use the so called "old" printing functionality where you
use the Printer Catalog dialog box and Tekla Structures printer
instances. To do this, see Print drawings using Printer Catalog printer
instances (old printing) (page 625).

See also

Print to a .pdf file, plot file (.plt) or printer (page 607)

Create and edit drawing layouts (page 656)

Configuration files used in printing (page 621)

Customize print output file names (page 622)

Print drawings using Printer Catalog printer instances (old printing)
(page 625)

6.1 Print to a .pdf file, plot file (.plt) or printer
You can print drawings and selected drawing areas to .pdf files, plot files (.plt)
to be sent to a plotter/printer, or to a printer. You can also change the colors
and the related line thicknesses (pen numbers) in the printed drawings. You
can print to a single printer or to multiple printers.

Print to a single printer
1. On the File menu, click Printing --> Print drawings . 

You can also start printing in the following ways:

• In Document manager, select the drawings, right-click, and select

Print, or click the Print  button.

The order of drawings matches the order they appeared in Document
manager at the point in time when the Print Drawings dialog box was
opened.

• When a drawing is open, select File --> Print drawings.

2. In the upper-left corner, select Use one printer.
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3. Load the desired printing settings from the settings list. 

You can also give the settings a new name. In this case, you need to give
the new name before you modify any settings, otherwise your changes
will be lost. For more information about the printing settings, see Printing
settings and search order (page 620).

4. On the displayed Document manager, select the drawings that you want
to print. 

Any out-of-date drawings are detected and you are asked whether to
include them in the output or not.

You can also print locked drawings that are up to date. If a locked drawing
is not up to date, you cannot open or print it, and a failed printout will be
reported. You can print any unlocked drawing unless the status of the
drawing is Original part deleted.

5. To show a preview of a drawing, select it from the list of drawings at the
top of the Print Drawings dialog box, and click Click here to load a
preview. 

The drawings are shown one by one in a preview. The preview shows the
drawings always up to date. Use Next and Previous to scroll through the
set of selected drawings.

6. Select the printing option: 

• PDF file: Converts drawings to PDF format.

• Printer: Sends the drawings to the selected printer.

Print drawings 608 Print to a .pdf file, plot file (.plt) or printer



• Plot file: Converts drawings to print files in a format suitable for the
selected printer and saves them in a specified location.

7. Define the printing settings on the Options tab. The available settings
depend on the printing option that you have selected: 

Option Description
File location Enter the location for the .pdf or plot file, or use

Browse... to browse for the folder.

The \Plotfiles folder under the model folder is
the default value.

Include revision mark
to file name

Add the mark of the latest revision of the printed
drawing to the file name.

Revision number is used by default. If you always
want to use the revision mark, set the advanced
option XS_SHOW_REVISION_MARK_ON_DRAWING_
LIST to TRUE.

Open folder when
finished

Open the .pdf or plot file folder in Windows
Explorer after the printout has been created.

Open folder when
finished

Open the .pdf file after it has been created.

Output to single file Print the selected drawings to a single .pdf file.

If you do not select this option, each drawing will
be printed in a .pdf file of its own.

File name Give a file name to a pdf file. The file name is
compulsory if you are printing to a single file.

File extension Specify a file name extension for the plot file. The
default is plt.

File prefix

File suffix

Enter a specific prefix and/or suffix in the file
name.

When you enter a prefix or suffix, the print file
name preview under the File prefix and File suffix
boxes will reflect the change immediately.

The print file name can also be controlled by a
couple of advanced option switches for
customizing print file names (page 622). These
switches do not work for single combined multiple
drawings .pdf file.

Fit to paper Fit the drawing to a specific paper size.
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Option Description
Scale Force the printout to a specific scale.

The Scale value will turn red if the drawing cannot
fit on the specified sheet.

Center drawing on
paper

Center the drawing on the sheet (or sheets).

Print on multiple
sheets

Print on multiple sheets and specify the direction
of printing the sheets. Select either Left to right,
top to bottom or Bottom to top, right to left.

When you use Print on multiple sheets, select a
particular paper size.

Paper size Define the paper size or use automatic size.

With the Auto setting Tekla Structures selects the
paper size that has the least wasted area when the
scaled print is fitted to the printable area on the
sheet.

Printers are often unable to print on the full area
of a sheet, and leave borders. The printable area is
determined for the selected printer when the
option Printer or Plot file is selected. For .pdf
files, the printer is not known so the output is sized
to the full sheet. However, when printing a .pdf,
the same problem exists and the drawing content
is fitted to the printable area of whatever printer is
being used. The printable area is shown with white
background and the non-printable border is
shaded gray in the image below.

Two configuration files affect paper sizes and
drawing sizes: PaperSizesForDrawings.dat and
DrawingSizes.dat . For more information, see
Configuration files used in printing (page 621)
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Option Description
Orientation Define the orientation or use automatic

orientation.

The Auto setting means that the orientation that
wastes least space is selected automatically.

Color Select if the output is to be Color, Black and white
or Grayscale.

Number of copies Define the number of plot file or paper copies to
be printed.

Collate Collate the printout when you are printing multiple
copies.

Embed fonts Embed the fonts in a .pdf file.

This ensures that fonts may be reproduced in a
system that does not have the same fonts
installed, but this also increases the file size. In
certain cases, fonts may be embedded
automatically. When using non-Latin fonts, it is
recommended that embedding is selected,
otherwise the .pdf may not be displayed correctly.

Select area Select a rectangular area from an open drawing to
only show and print that area. This option only
works when you have a drawing open.

All settings in the dialog box also work when this
option is selected, and you can change the
orientation, line thicknesses, and paper size, for
example.

Show entire drawing When you have selected an area with Select area,
the Show entire drawing button is displayed, and
you can use it to show the entire drawing in the
preview again.

8. Go to the Line properties tab to map colors to line thicknesses (pen
numbers) and set the printout colors: 

Option Description
Object color Shows the basic set of object colors.
Color on output • Set the printout color by clicking a color box

under Color on output and selecting a new
color from the displayed colors. You can also
define custom colors.
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Option Description

Different output color is often used when you just
need one or two lines in color and the rest in black.
Output colors are used in all printing options
(printer, plot file and PDF file). The output colors
are saved to and loaded from the printing settings
files.

If you select the Printer line colors through File --
> Settings , and change a line color, the change is
immediately shown in the drawing.

The Color on output only applies when the Color
option is set to Color on the Options tab in the
Print Drawings dialog box.

For instructions on how to show correct line
thicknesses in the Black and white mode, see Line
thickness in drawings (page 617).

Line thickness • Enter the line thickness for each color in the
boxes.

Line thicknesses are expressed as a multiple of the
advanced option XS_BASE_LINE_WIDTH value. The
default value for this advanced option is 0.01 mm.
For example, pen number 25 will give a line weight
of 0.25 mm.
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Option Description
In color drawings, the lines are shown with
different thicknesses on the screen and in the
printouts if the Printer line widths switch is active
in File --> Settings .

You can define Invisible color for parts and shapes
in drawings in the part or shape properties. The
Invisible color is not shown in printouts, neither
on paper nor on .pdf.

For instructions on how to show correct line
thicknesses in the drawing in the Black and white
mode, see Line thickness in drawings (page 617).

Reset colors You can reset the printout colors:

• To reset an individual output color, click the
corresponding Object color color box. The
Color on output color box will change to have
the same color.

• To reset all output colors to be the same as the
object colors, click the Reset colors button.

9. If you need to change Windows printing settings for a printer or for a plot
file, click the Properties... button and change the necessary settings.

10. Save your printing settings by using the Save button in the upper-left
corner. 

For more information about the printing settings and the search order,
see Printing settings and search order (page 620).

You can also add frames and foldmarks (page 656) to you printouts.

11. Click Print to print the drawings in .pdf format or as plot files, or to send
them to a printer according to the settings you defined in the dialog box. 

Each drawing is sent to the printer as a separate print job.

All printing errors are written to a log file in the model folder: logs
\DPMPrinter_<username>.log .

Example: Printing to multiple sheets

In the example below the setting Bottom to top, right to left is selected. The
numbers indicate the printing order of the sheets.
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In the next example, the option Left to right, top to bottom is selected.
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Print to multiple printers
You can print to more than one printer in one go based on the paper size of
each selected drawing. When printing to multiple printers you typically have
different printers for handling different paper sizes. Tekla Structures
automatically selects the appropriate printer for each drawing.

Create single printing settings

To be able to print to multiple printers, you first need to create single printing
settings for each of the printers you want to print to:

1. On the File menu, click Printing --> Print drawings .

2. Select Use one printer.

3. Define the printing properties as desired on the Options tab and on the
Line properties tab. Select the output type and printer, and define the
paper size that this printer will handle in the Use multiple printers
mode.

4. Save the settings with a desired name by clicking Save.

5. Repeat this for each of the desired paper sizes. Do not use the size option
Auto.

For example, you could create the following single printer settings files
with the output type set to PDF file:

• PDF A4: Paper size set to A4, file prefix set to A4_
• PDF A3: Paper size set to A3, file prefix set to A3_
• PDF A2: Paper size set to A2, file prefix set to A2_
When printing a set of drawings in the multiple printers mode using the
above single printer settings files, all A4 drawings will generate .pdf files
with prefix A4_, all A3 drawings will have prefix A3_, and all A2 drawing
will generate .pdf files with prefix A2_.

If you want to print more than one sheet size to the same printer in the
Use multiple printers mode, create a single printer settings file for each
paper size, and specify the same printer in all of these files.
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Print to multiple printers

1. On the File menu, click Printing --> Print drawings .

2. In the upper-left corner, select the Use multiple printers mode.

3. In the Selected single printer settings files list, select the settings files to
use in printing. You can select all or just some of the single printer settings
files. 
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The output type (printer, plot file, PDF file) is defined by each selected
single printer settings file. Typically you would select settings files with the
same output type. Output types lists the output types that are specified
in the selected single printer settings files.

4. Change other necessary settings on the Options tab. The available
settings depend on the output type you have selected. The settings are
described in the "Print to a single printer" section above.

5. On the displayed Document manager, select the drawings that you want
to print.

Line thickness in drawings
You can set the printer line thickness (pen number) in the Print drawings
dialog box, but you may have some challenges in showing the lines correctly in
the drawing on the screen. You can solve this issue by adjusting the printer
line widths or by using some predefined printer settings in the printer
definition file plotdev.bin.

Change line thickness (pen width/pen number/line width) for printed
drawings

You can change the line width for printing. To do this, open the Print
Drawings dialog box and go to the Line properties tab:

Print drawings 617 Print to a .pdf file, plot file (.plt) or printer



The base line default width is 0.01, and this can be changed using the
advanced option XS_BASE_LINE_WIDTH. For example, to get the line
thickness of 0.25 mm, enter the number 25.

Set the line thickness shown on the screen

The line thickness that you see in the drawing is not the real line thickness that
you get in the printed drawing. There is a way to affect how the lines are
shown in the drawing.

To be able to set the pen width for the drawings in a Tekla Structures model:

1. Take old printing into use by setting the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE.

2. Define the line settings for the first printer in the list.
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3. Take new printing into use by setting the advanced option 
XS_USE_OLD_PLOT_DIALOG to FALSE.

4. Go to the File menu and check if the switch Printer line widths is active
or not. This switch takes the settings from the old printer dialog settings. If
the switch is not active, the line widths are only shown in black and white
mode, if active, the line widths are shown for all color modes.

You can toggle between color modes by pressing B.

The file plotdev.bin in ..\ProgramData\Trimble\Tekla Structures
\<version>\environments\default\system contains some predefined
line thicknesses for the first printer instance. These are not the same that you
use for printing, unless you use defaults in the Print Drawings dialog box.

You can save printer definitions file plotdev.bin in the current model folder
or in the project and firm folders, and in a folder indicated by the advanced
option XS_DRIVE. Tekla Structures searches first for plotdev.bin in the
model, project and firm folders, then in the folder indicated by the advanced
option.

 Without line thickness (pen
number) set up in
plotdev.bin

With settings for line
weight for the first printer
in plotdev.bin

Color
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Grayscale

Black and
white

See also

Change the pen numbers (line thickness) for colors (page 647)

6.2 Printing settings and search order
Tekla Structures printing settings in the Print Drawings dialog box are stored
in two files: <user>_ PdfPrintOptions.xml and PdfPrintOptions.xml.
When you open a new model, the PdfPrintOptions.xml file is loaded. The
changes that you make in printing settings are automatically saved in <user>_
PdfPrintOptions.xml, and settings in this file are loaded when you re-open
the model. The PDF report options are read from settings files with the name
report.PdfPrintOptions.xml (in the printing dialog box, this settings file is
shown as report).

You can create printing settings files for different printing purposes and load
them later on. You can also create and share common settings throughout an
organization.

You can load existing printing settings or save the current printing settings to
either an existing printing settings file or a new file. The first settings file name
in the control list will be standard and any other settings file names will be
listed alphabetically after this. The latest settings used are automatically saved
to <model>\attributes\<user>_PdfPrintOptions.xml (where <user> is
the current Windows user when the dialog box is closed. The printing settings
that you save using the Save button are saved to the <model>\attributes\
folder with the following names:

• The standard file is saved as PdfPrintOptions.xml .

• The report file is saved as report.PdfPrintOptions.xml.
• All other printing settings names have the filename

<SettingsName>.PdfPrintOptions.xml. For example, if you use the
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name MyPrintingSettings, the settings will be saved as
MyPrintingSettings.PdfPrintOptions.xml.

• If a file already exists it will be overwritten.

• You can move the saved printing settings files to the following locations so
that other models and/or other users can access the settings:

• XS_PROJECT

• XS_FIRM

• XS_DRIVER

• XS_SYSTEM

• XS_USER_SETTINGS_DIRECTORY

• When you open the dialog box, Tekla Structures searches the above
locations in the listed order for any available settings files and adds them
to the setting list.

• It will load the settings from the first of the following settings files it finds:

• <model>\attributes\<user>_PdfPrintOptions.xml
• <model>\attributes\PdfPrintOptions.xml
• PdfPrintOptions.xml from the standard search locations listed

above.

See also

Print drawings (page 606)

6.3 Configuration files used in printing
In printing, two configuration files are needed. They affect paper sizes and
drawing sizes: PaperSizesForDrawings.dat and DrawingSizes.dat.

• PaperSizesForDrawings.dat defines a list of paper size names allowed
to be used, and their dimensions. The PaperSizesForDrawings.dat file
is by default located in the ..\ProgramData\Trimble\Tekla
Structures\<version>\environments\common\system folder.

• DrawingSizes.dat provides a list of properties that should be set up to
match the drawing sizes configured in the Tekla Structures drawing layout
definitions. It is used to link those drawings to the paper size name that
each drawing was set up for, and provides information about the drawing
sizes and the margins around them. The DrawingSizes.dat file is located
in the ..\ProgramData\Trimble\Tekla Structures\<version>
\environments\common\system folder.
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• The exact file location may vary depending on the folder structure of your
environment files.

Default values are provided in the files installed with the printing functionality.
These values are appropriate in most cases. The optimum values depend on
the details of the existing drawing layout definitions. If the printed area of the
drawing needs to be moved, or if inappropriate paper sizes are selected, see
instructions for adjusting values in these two files.

Make copies of the original configuration files if you want to modify the
settings, and place the copies in appropriate folders. You may have several
copies of the configuration files on your computer. When needed, these files
are searched for and the first one found is used in the following search order:

• model folder

• project folder as defined by the XS_PROJECT advanced option

• firm folder as defined by the XS_FIRM advanced option

• system folder as defined by the XS_SYSTEM advanced option

If no files are found default values will be used.

TIP When making copies of the configuration files, keep them first in a test
model folder. Validate the results before using them through the project,
firm or environment folders. Also, keep backup copies of the
configuration files in a safe location as re-installing later versions of Tekla
Structures may overwrite your own settings.

See also

Print drawings (page 606)

6.4 Customize print output file names
You can affect the way Tekla Structures automatically names the .pdf files
and plot files by using certain drawing-type-specific advanced options.

1. On the File menu, click Settings --> Advanced options and go to the
Printing category.

2. Enter values for any or all of the advanced options 
XS_DRAWING_PLOT_FILE_NAME_A, XS_DRAWING_PLOT_FILE_NAME_W, 
XS_DRAWING_PLOT_FILE_NAME_G, XS_DRAWING_PLOT_FILE_NAME_M, or 
XS_DRAWING_PLOT_FILE_NAME_C. 

The letter at the end indicates the drawing type. You can also combine
several values. The values are not case sensitive.

3. Click OK. 
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Example:

Use single % around the values.

The example below results in the assembly drawing .pdf name
E_P1_PLATE_Revision=2.pdf:

XS_DRAWING_PLOT_FILE_NAME_A=E_%NAME.%_%TITLE%%REV?
_Revision=%%REV%.pdf

Possible values

Value Example of
the result

Description

%NAME%
%DRAWING_NAME%

P_1 Part, assembly, or cast unit
position, using the file name format 
prefix_number.

%NAME.-%
%DRAWING_NAME.-%

P-1 Part, assembly, or cast unit
position, using the file name format 
prefix-number.

%NAME.%
%DRAWING_NAME.%

P1 Part, assembly, or cast unit
position, using the file name format 
prefixnumber.

%REV%
%REVISION%
%DRAWING_REVISION%

2 Drawing revision number.

%REV_MARK%
%REVISION_MARK%
%DRAWING_REVISION_M
ARK%

B Drawing revision mark.

%TITLE%
%DRAWING_TITLE%

PLATE Drawing name from the drawing
properties dialog box.

%UDA:<drawing user-
defined attribute>%

Painted Value of a user-defined drawing
attribute. The user-defined drawing
attributes are defined in
objects.inp. The actual values for
the user-defined attributes are
entered in the drawing-specific
user-defined attributes dialog box.

%REV? - <text>% 2 - Rev Adds conditional prefixes. In this
example, if REV exists, Tekla
Structures adds the text between ?
and % to the filename.

%TPL:<template
attribute>%

Base plate You can use template attributes
that can be found in Template
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Value Example of
the result

Description

Editor. The actual values for these
attributes are entered in the
drawing properties dialog box.
Examples:

• %TPL:TITLE1%
• %TPL:TITLE2%
• %TPL:TITLE3%
• %TPL:DR_DEFAULT_HOLE_SIZE

%
• %TPL:DATE%
• %TPL:TIME%
• %TPL:DR_DEFAULT_WELD_SIZE

%

NOTE The print output file name switches %DRAWING_NAME% and %NAME% that
should produce an underscore in the print file name (P_1) do not work if 
XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING does not use a
separator between the values (for example, %ASSEMBLY_PREFIX%
%ASSEMBLY_POS%), or if XS_USE_ASSEMBLY_NUMBER_FOR is set.

To make the switches work, do the following:

• If you want to useXS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING ,
use a dot (.) slash (/) or hyphen (-) between the values, for example, 
%ASSEMBLY_PREFIX%.%ASSEMBLY_POS%, or similar.

• Leave XS_USE_ASSEMBLY_NUMBER_FOR empty.
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7 Print drawings using Printer
Catalog printer instances (old
printing)

You can also use Tekla Structures own Printer Catalog printer instances for
printing drawings. To do this, you need to set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE.

Print drawings using Printer Catalog printer
instances (old printing)
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Setting XS_USE_OLD_PLOT_DIALOG to TRUE takes the Printer Catalog dialog
box in use, and printer instances need to be set.

Print drawings using Printer Catalog printer
instances (old printing)
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Setting up printers in the Microsoft Windows environment is not covered in
this documentation. It is assumed that printers are set up and tested in your
environment. For further information about on setting up printers, contact
your system administrator.

If you prefer to print using the "new" printing functionality, see Print to a .pdf
file, plot file (.plt) or printer (page 607) .

Click the links below to find out more:

• Print single drawings (old printing) (page 627)

• Print multiple drawings with different sizes at one go (old printing)
(page 630)

• Create .pdf files (old printing) (page 631)

• Print to file (old printing) (page 632)

• Print to multiple sheets (old printing) (page 636)

• Frames and fold marks in drawings (old printing) (page 639)

• Set up printer instances in Printer Catalog (old printing) (page 642)

• Printing settings in Print Drawings dialog box (old printing) (page 637)

• Printing tips (old printing) (page 648)

7.1 Print single drawings (old printing)
The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

Before you print the drawing, check that the printer instance settings are
correct and the layout contains the correct drawing size settings.

1. Open a drawing.

2. On the File menu, click Print drawing.

3. In the Print Drawings dialog box, select the printer instance you want to
use.

4. If needed, modify the printing settings and add frames and fold marks in
the printout.

5. Click Print.

TIP Shortcut for opening the Print Drawings dialog box: Shift+P.
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Examples

To see some examples of printing single drawings, click the links below:

Example: Print on A4 in landscape (page 628)

Example: Print on A3 in portrait (page 629)

Example: Print A3 drawing on A4 paper (page 630)

See also

Frames and fold marks in drawings (old printing) (page 639)

Print drawings using Printer Catalog printer instances (old printing) (page 625)

Printing settings in Print Drawings dialog box (old printing) (page 637)

Set up printer instances in Printer Catalog (old printing) (page 642)

Example: Print on A4 in landscape

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

This example describes how you can print on A4 paper in landscape style in
black and white.

NOTE In this example, it is assumed that the print area h*b is defined h
being along the longer side of the paper and b being along the shorter
side of the paper. When using some other printer driver you might
have to change h*b values if you find out that the printer driver uses h
along the short side of the paper.

1. Open a drawing and double-click the drawing background.

2. In drawing properties dialog box, click layout.

3. Define the following settings: 

• Set Size definition mode to Specified size.

• Set Drawing size to 287 * 200.

• You can also use Autosize. Then you need to make sure that you have
defined appropriate Fixed sizes or Calculated sizes.

4. Click Modify and OK.

5. On the File menu, click Print drawing.

6. In the Print Drawings dialog box, click the printer instance you want to
use.

7. Click Add / Edit... and check that the printer settings are correct: 
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• Paper size: A4 210 x 297 mm

• Print area h*b: 287 x 200
• Color: Black/white

8. Click Update.

9. Click OK.

10. Set Scaling to Scale and enter 1. 

In this case, also Scaling setting Auto would produce a similar printout
because drawing size and h*b are the same.

11. Set Orientation to Landscape (or Auto).

12. Set Print area to Entire drawing.

13. Click Print.

Example: Print on A3 in portrait

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

This example describes how you can print on A3 paper in portrait style in black
and white.

1. Open a drawing and double-click the background.

2. In drawing properties dialog box, click layout.

3. Define the following settings: 

• Set Size definition mode to Specified size .

• Set Drawing size to 287 * 410.

• You can also use Autosize. Then you need to make sure that you have
defined appropriate Fixed sizes or Calculated sizes.

4. Click Modify and OK.

5. On the File menu, click Print drawing.

6. In thePrint Drawings dialog box, click the printer instance you want to
use.

7. Click Add / Edit... and check that the printer settings are correct: 

• Paper size: A3 297 x 420 mm.

• Print area h*b: 410 x 287
• Color: Black/white
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8. Click Update.

9. Click OK.

10. Set Scaling to Scale and enter 1.

11. Set Orientation to Portrait (or Auto).

12. Set Print area to Entire drawing.

13. Click Print.

Example: Print A3 drawing on A4 paper

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

This example describes how you can print an A3 drawing on A4 paper. This is
useful, for example, when you need draft drawings that do not have to show
the correct scale.

1. Open the A3 drawing.

2. On the File menu, click Print drawing.

3. In the Print Drawings dialog box, click the printer instance that you want
to use.

4. Click Add / Edit..., click the printer instance that you are going to use and
ensure that: 

• It prints to A4 paper.

• The Print area h*b value takes into account the printer hard margins.
In this case, the Print area h*b could be 287*200.

5. If you changed any settings, click Update and OK. 

If you did not change any settings in the Printer Catalog, click OK to
return to the Print Drawings dialog box.

6. Set Scaling to Auto. 

When you use Auto, and the drawing is bigger than the paper, the
drawing is scaled down to fit the paper.

7. Click PrintPrint.
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7.2 Print multiple drawings with different sizes at one go
(old printing)
You can print multiple drawings from the Document manager, and print
drawings of different sizes at the same time.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

1. In the Document manager, select the drawings you want to print.

2. Right-click the selected drawings and select Print.

3. In the Print Drawings dialog box, indicate the printer instances you want
to use. 

To select several printer instances, hold down Ctrl and select the printers.

When you select drawings of several sizes and several printer instances,
Tekla Structures sends each drawing to the printer instance that is using
the smallest paper size on which the drawing will fit. For example, if you
have two printer instances selected, one A4 and one A3, Tekla Structures
will send A4 drawings to the A4 printer instance and A3 to the A3 printer
instance.

4. Set Scale to 1. 

This makes it possible for Tekla Structures to select and use the printer
instance that is using the correct paper size.

5. If necessary, modify other printing settings and add frames and fold
marks in the printout.

6. Click Print.

See also

Set up printer instances in Printer Catalog (old printing) (page 642)

Frames and fold marks in drawings (old printing) (page 639)

Print drawings using Printer Catalog printer instances (old printing) (page 625)

Print single drawings (old printing) (page 627)

7.3 Create .pdf files (old printing)
You can use any standard pdf printer to create .pdf files, such as pdfFactory,
Win2PDF, or Adobe Acrobat. You can print several drawings at a time, and use
several printer instances.
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The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

Before you start creating .pdf files using Adobe Acrobat, ensure that you have
Adobe Acrobat and Adobe Distiller installed and configured with the Adobe
Postscript Printer Driver set up to print to file. Consult your Adobe
documentation for more information.

Also ensure that you have an Adobe postscript printer instance in the Tekla
Structures printer catalog.

1. In Document manager, select the drawings of which you want to
create .pdf files.

2. Right-click the selected drawings and select Print Drawings....

3. In Print Drawings dialog box, select the pdf printer instances you want to
use. 

If you select several printer instances, Tekla Structures sends each
drawing to the printer instance that is using the smallest paper size on
which the drawing will fit. For example, if you have two printer instances
selected, one A4 and one A3, Tekla Structures will send A4 drawings to the
A4 printer instance and A3 to the A3 printer instance.

4. If needed, modify the printing settings and add frames and fold marks in
the PDF.

5. Click Print. 

Tekla Structures creates the .pdf files and saves them in the folder that
you specified when you defined the printer instance. The file will have the
name shown in Document manager with the extension ps.

Limitations

Do not use the Print to file option when you create .pdf files.

See also

Printing settings in Print Drawings dialog box (old printing) (page 637)

Add an Adobe postscript printer instance (page 644)

Frames and fold marks in drawings (old printing) (page 639)

Print drawings using Printer Catalog printer instances (old printing) (page 625)
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7.4 Print to file (old printing)
You can print to a file using a print-to-file printer instance. The file is by default
printed to the \Plotfiles folder under model folder, but you can change the
folder.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

Before you start, make sure you have a printer instance set up to print to file.

1. In Document manager, select all drawings that you want to print.

2. Right-click the selected drawings and select Print Drawings...

3. Click a printer instance that is set up to print to file.

4. Select the Print to file check box. 

Specify the folder. You can use the folder specified during printer instance
setup or click Browse... to locate the destination folder in the Browse For
Folder dialog box.

If you do not enter a folder, Tekla Structures creates the files in the
current model folder or in the folder defined by the advanced option 
XS_DRAWING_PLOT_FILE_DIRECTORY.

5. If needed, modify other printing settings and add frames and fold marks
in the printout.

6. Click Print.

Tekla Structures prints the selected drawings to files in the specified folder
using the drawing names.

See also

Printing settings in Print Drawings dialog box (old printing) (page 637)

Add a print-to-file instance (page 643)

Frames and fold marks in drawings (old printing) (page 639)

Print drawings using Printer Catalog printer instances (old printing) (page 625)

7.5 Customize print file names (old printing)
By default, Tekla Structures uses the drawing names as print file names. You
can customize these file names using an advanced option indicating the
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drawing type, and entering switches defining the format of the print file name
as a value.

To customize the filenames:

1. On the File menu, click Settings --> Advanced options and go to the
Printing category.

2. Enter switches for the advanced options
XS_DRAWING_PLOT_FILE_NAME_A, XS_DRAWING_PLOT_FILE_NAME_W,
XS_DRAWING_PLOT_FILE_NAME_G, XS_DRAWING_PLOT_FILE_NAME_M,
and XS_DRAWING_PLOT_FILE_NAME_C 

You can also combine several switches. The switches are not case
sensitive.

3. Click OK.

Example

The example below results in the filename E_P1_PLATE_Revision=2.dxf:

XS_DRAWING_PLOT_FILE_NAME_A=E_%NAME.%_%TITLE%%REV?_Revision=%
%REV%.dxf

See also

Switches for customizing print file names (old printing) (page 634)

Switches for customizing print file names (old printing)

Use the following switches when you want to customize the print file name
format. If you are defining these in an .ini file, use double %%. Use single %
in the Advanced Options dialog box.

Switch Example of the
result

Description

%NAME%
%DRAWING_NAME%

P_1 Part, assembly, or cast unit position,
using the filename format
prefix_number.

%NAME.-%
%DRAWING_NAME.-%

P-1 Part, assembly, or cast unit position,
using the filename format prefix-
number.

%NAME.%
%DRAWING_NAME.%

P1 Part, assembly, or cast unit position,
using the filename format
prefixnumber.

%REV%
%REVISION%
%DRAWING_REVISION%

2 Drawing revision number, if Include
revision mark to file name is
checked in the Print Drawings
dialog box.
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Switch Example of the
result

Description

%REV_MARK%
%REVISION_MARK%
%DRAWING_REVISION_
MARK%

B Drawing revision mark, if Include
revision mark to file name is
checked in the Print Drawings
dialog box.

%TITLE%
%DRAWING_TITLE%

PLATE Drawing name from the drawing
properties dialog box.

%UDA:<drawing
user-defined
attribute>%

Painted Value of a drawing user-defined
attribute. The drawing user-defined
attributes are defined in
objects.inp. The actual values for
the user-defined attributes are
entered in the drawing-specific user-
defined attributes dialog box.

%REV? - <text>% 2 - Rev Adds conditional prefixes. In this
example, if REV exists, Tekla
Structures adds the text between ?
and % to the filename.

%TPL:<template
attribute>%

Base plate You can use here template attributes
that can be found in Template Editor.
The actual values for these attributes
are entered in the drawing
properties dialog box. Examples:

• %TPL:TITLE1%
• %TPL:TITLE2%
• %TPL:TITLE3%
• %TPL:DR_DEFAULT_HOLE_SIZE%
• %TPL:DATE%
• %TPL:TIME%
• %TPL:DR_DEFAULT_WELD_SIZE%

NOTE The print output file name switches %DRAWING_NAME% and %NAME%
that should produce an underscore in the print file name (P_1) do not
work if XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING does not
use a separator between the values (for example, 
%ASSEMBLY_PREFIX%%ASSEMBLY_POS%), or if 
XS_USE_ASSEMBLY_NUMBER_FOR is set.

To make the switches work, do the following:
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• If you want to use 
XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING, use a dot (.)
slash (/) or hyphen (-) between the values, for example, 
%ASSEMBLY_PREFIX%.%ASSEMBLY_POS%, or similar.

• Leave XS_USE_ASSEMBLY_NUMBER_FOR empty.

See also

Customize print file names (old printing) (page 633)

7.6 Print to multiple sheets (old printing)
If your drawing is very large, you can print it on multiple sheets. With correct
scaling settings, Tekla Structures automatically calculates the required amount
of sheets.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

Before printing to multiple sheets, make sure that the layout of the drawing
supports printing on several smaller sheets. Remember that Tekla Structures
automatically adds a 5 mm margin to the printouts.

Also ensure that you have set up the printer instance correctly for printing to
multiple sheets.

1. Open a drawing.

2. On the File menu, click Print drawing .

3. In the Print Drawings dialog box, select the printer instance you want to
use.

4. Select the Print on multiple sheets option.

5. In Scaling, set Scale = 1. This preserves the scale. The number of sheets is
rounded up. 

Do not use Auto when you print to multiple sheets.

Tekla Structures calculates the required amount of sheets needed to print
the drawing.
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6. If needed, modify other printing settings and add frames and fold marks
in the printout. 

If you set Orientation to Auto, Tekla Structures selects an orientation
that results in the smallest number of printed sheets.

Tekla Structures prints the drawing to multiple sheets so that it prints the
lower right corner the first, and the upper left corner the last (see the
numbered sheets in the example below).

If you want to have drawing frames and/or the title blocks for each smaller
size sheet, you need to use proper table layout as shown in the example
below.

TIP Use the advanced option XS_PRINT_MULTISHEET_BORDER to set borders that
are left out from the smaller sheets.

See also

Printing settings in Print Drawings dialog box (old printing) (page 637)

Print drawings using Printer Catalog printer instances (old printing) (page 625)
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7.7 Printing settings in Print Drawings dialog box (old
printing)
The Print Drawings dialog box contains options for setting up printing. This
dialog box is only displayed if you have set XS_USE_OLD_PLOT_DIALOG to 
TRUE in File menu --> Settings --> Advanced options --> Printing.

Setting Description
Print to file Prints the drawing to a file.
Include revision mark to file
name

Adds the latest revision of the printed drawing to
the filename.

Revision number is used by default. However, if
you set the advanced option to TRUE, the
revision mark is used.

Scaling Auto fits the drawing to the Print area h*b size,
i.e. fits it to the paper. This is useful, for example,
when you are printing draft drawings on A4.
With this option you can include everything in
the printout, but the scale of the drawing may be

Print drawings using Printer Catalog printer
instances (old printing)

638 Printing settings in Print Drawings dialog box (old
printing)



Setting Description
affected as drawing size is fitted to the Print
area h*b.

With Auto, if the drawing size is smaller than the
paper, the drawing is scaled up to fill the defined
Print area h*b, keeping the aspect ratio.

Entering an exact scale in the Scale box scales
the drawing manually to the defined scale.

Examples on Scale: 1.0 = 100%, 0.9 = 90%
Print on multiple sheets Prints the drawing on multiple small sheets.
Number of copies Defines the number of copies.
Orientation Auto orientates the drawing to suit the paper.

Landscape prints the drawing horizontally - as it
is displayed on the screen.

Portrait prints the drawing vertically.
Print area Entire drawing prints the entire drawing.

Visible area prints the area visible in the current
drawing window.

Add / Edit... Add (page 642) or delete printer instances, or
modify their settings.

Frames... Opens a dialog box where you can select to print
frames and fold marks (page 639).

Printer setup... Opens the Windows print setup dialog box
where you can change the printing settings for
the current Tekla Structures session only. The
changes that you make are not saved for the
printer permanently.

7.8 Frames and fold marks in drawings (old printing)
You can have a frame around drawing contents, or two drawing frames inside
each other. You can add default Tekla Structures frames around the drawing
contents, or use DWG/DXF files in the table layouts as drawing frames.

You can add frames and fold marks only when the advanced option 
XS_USE_OLD_PLOT_DIALOG is set to TRUE (old printing).

You can create fold marks as guides for folding printed drawings. They are
small lines between and perpendicular to the drawing frames.
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1. Frame

2. Fold mark

See also

Add frames and fold marks in printouts (old printing) (page 640)

Create and edit drawing layouts (page 656)

Add frames and fold marks in printouts (old printing)
You can add frames around printed drawings, and fold marks to indicate folds.
You can select a color for the frames and fold marks

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing . If this advanced option is set to FALSE, you are using the
newer printing functionality, where you cannot set the frames and fold marks
through the Print Drawings dialog box.

Drawing frames to be printed are controlled in the standard.fms file under
the system folder. There is no saving option in the Drawing Frame Properties
dialog box, which is why the default values are located in a standard file. You
can save the standard file in the model folder, and then copy it to the project
or firm folders, if needed. If you want to save a set of standard files in the
model folder, see .

1. On the File menu, click Printing --> Print drawings.

2. In the Print Drawings dialog box, click Frames....

3. In the Drawing Frame Properties dialog box, select the check boxes of
the frames you want to print.

4. In Margins, enter in millimeters the distance between each frame and the
left, right, bottom, and top edge of the paper.
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5. Select a color for each frame.

6. To print the foldmarks, select the Foldmarks check box.

7. Enter in millimeters the horizontal and vertical distances of the first
foldmarks from the lower right corner of the outer frame, and between
the other fold mark.

8. Select a color for the fold marks.

9. Click OK.

Below is an example of the properties dialog box contents and the standard
file.

See also

Table sets (page 669)
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7.9 Set up printer instances in Printer Catalog (old
printing)
You need to set up printer instances in Printer Catalog for different purposes:
for printing to .pdf, to print file, or to different printers, and to print in different
sizes.

You can only set up Tekla Structures printer instances in Printer Catalog if
you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File
menu --> Settings --> Advanced options --> Printing. If this advanced option
is set to FALSE, you are using the newer printing functionality, and the Printer
Catalog is not available.

Tekla Structures uses Microsoft Windows printer drivers to write the printed
data directly to a printer, print file or .pdf.

There are two steps in setting up printer instances in Tekla Structures:

• First, you need to add a printer instance (page 642) in the Printer
Catalog. By default, several printer instances are already defined.

• Next, you need connect the printer instances to printer drivers and adjust
the printer instance settings such as paper size and print area (page 645).
You can also connect one printer driver to several printer instances, for
example, to print in different sizes on the same printer.

See also

Add a print-to-file instance (page 643)

Add an Adobe postscript printer instance (page 644)

Line thickness (pen number) in Color Table (page 646)

Add a printer instance
You need to add printer instances in Printer Catalog to be able to print. This
applies to printing when the advanced option XS_USE_OLD_PLOT_DIALOG is
set to TRUE.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

1. On the File menu, click Printing --> Choose printer.

2. In Printer Catalog, click an existing printer instance that has similar
settings to the one you want to add.

3. Enter a new name for the new printer instance in the box under the
Printer instances list.
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4. Click Add.

5. Click Browse... to access the Select Printer dialog box, which shows a list
of Microsoft Windows printer drivers currently configured in your system.

6. Click a printer driver and then OK.

7. Select the paper size (page 645).

8. Enter the print area (page 645) in Print area h*b (height and width).

9. If necessary, use Offset for print origin to move the drawing print origin.

10. Select Black/white, Gray Scale or Color. 

If you select Color, Tekla Structures prints lines with the colors defined in
the drawing properties.

11. Click Color table... to map pen size to the on-screen line color. The
background color is not printed.

12. Click Update.

13. Click OK.

14. Confirm that you want to save changes to the model folder.

See also

Print drawings using Printer Catalog printer instances (old printing) (page 625)

Define printing paper size and print area h*b (page 645)

Line thickness (pen number) in Color Table (page 646)

Add a print-to-file instance
To print to a file, you need to add a print-to-file printer instance in Printer
Catalog. This applies to printing when the advanced option 
XS_USE_OLD_PLOT_DIALOG is set to TRUE.

1. On the File menu, click Printing --> Choose printer.

2. In Printer Catalog, click Add.

3. Enter a printer instance name for the printer driver, followed immediately
(no spaces) by @path\folder\. The folder must already exist. For
example, 11X17@d:\small\ 

You can also leave the folder out. If you do this, Tekla Structures prints the
file in the current model folder or in the folder specified for the advanced
option XS_DRAWING_PLOT_FILE_DIRECTORY.

WARNING XS_DRAWING_PLOT_FILE_DIRECTORY overrides the folder
defined in the Printer Catalog.
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4. Click Add.

5. Click Browse... to access the Select Printer dialog box and click a printer
driver that is configured to print to file and then click OK.

6. In Paper size, select By print area.

7. Enter the print area (page 645) in Print area h*b (height and width).

8. Enter a file name extension, for example, plt for a print file.

9. Select Color, Gray Scale or Black/white as the color.

10. Click Color table... to change the pen sizes of different colors, if needed.

11. Click Update.

12. Click OK.

13. Confirm that you want to save changes to the model folder.

TIP One way to send different drawing sizes to different folders is to set up a
Microsoft Windows printer to print to file for each paper size you will use. Enter
a different destination folder for each paper size in the Printer instances list in
Tekla Structures.

See also

Print drawings using Printer Catalog printer instances (old printing) (page 625)

Define printing paper size and print area h*b (page 645)

Line thickness (pen number) in Color Table (page 646)

Print to file (old printing) (page 632)

Add an Adobe postscript printer instance
To print to a .pdf file, you need to add a Adobe postscript printer instance in
Printer Catalog. This applies to printing when the advanced option 
XS_USE_OLD_PLOT_DIALOG is set to TRUE.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

1. On the File menu, click Printing --> Choose printer.

2. In Printer Catalog, click Add.

3. Enter a new printer instance name followed immediately (no spaces) by @
and the folder where Adobe Distiller should look for files. For example,
A4_PDF@c:\plots\pdf\in\ .

4. Click Add.
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5. Click Browse... to access the Select Printer dialog box. Click the Adobe
postscript printer driver and then OK.

6. Set Paper size to By print area.

7. Enter the print area (page 645) in Print area h*b (height and width).

8. Enter the file name extension ps.

9. Select Black/white, Gray Scale or Color as the color.

10. Click Color table... to change the pen sizes of different colors, if needed.

11. Click Update.

12. Click OK.

13. Confirm that you want to save the changes to the model folder.

See also

Print drawings using Printer Catalog printer instances (old printing) (page 625)

Define printing paper size and print area h*b (page 645)

Line thickness (pen number) in Color Table (page 646)

Create .pdf files (old printing) (page 631)

Define printing paper size and print area h*b
You need to define paper size and print area h*b for each printer instance you
add in Printer Catalog. This applies to printing when the advanced option 
XS_USE_OLD_PLOT_DIALOG is set to TRUE.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

1. On the File menu, click Printing --> Choose printer.

2. In the Printer Catalog, select the printer instance.

3. Use the Paper size setting to select the paper size used in printing:

• Named paper size: Tekla Structures lists a named paper sizes for most
sizes A3 and smaller. Selecting one of the listed sizes is recommended
for A3 printers and smaller.

• By print area: The printer selects the paper size based on the print
area. This option is recommended for A2 printers and larger. If you use
a named paper size with a larger printer than A3, drawings larger than
the print area are cropped to the size of the print area.
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• None: Sends no size information to the printer. This option provides
legacy support for Xsteel 5.0 and is not recommended for use in other
circumstances.

4. Enter the Print area h*b:

• Tekla Structures uses the print area values to position the printout on
the paper. Ensure that the values for h and b relate to the paper size
required.

Usually the value is the paper size less the hard clip margins of the
printer. For example, if the paper size is 297*420, the print area could
be 407 * 284. See your printer documentation for the hard clip
margins of your printer.

• Usually for roll feed printers, h defines the roll width direction and b
defines the roll feed direction. Usually for tray feed printers, h defines
the tray feed direction, and b defines the tray width direction. Enter
the values, and test how the printing works. If you can see, that the
direction is wrong, switch the h and b values.

• When you are printing from Tekla Structures, it uses the values set for
the printer in the Tekla Structures printer instance settings in the
Printer Catalog, and overrides for these settings the Windows printer
settings.

5. Click OK and confirm the change.

TIP To print to different paper sizes, you can define several printer instances,
each using a different paper size, but all connected to the same physical
printer. For more information about setting up print devices in Microsoft
Windows, see your operating system documentation.

See also

Add a printer instance (page 642)

Printing tips (old printing) (page 648)

Line thickness (pen number) in Color Table
You can only set Tekla Structures pen numbers in the Color Table of Printer
Catalog if you have set the advanced option XS_USE_OLD_PLOT_DIALOG to 
TRUE in File menu --> Settings --> Advanced options --> Printing. If this
advanced option is set to FALSE, then you are using the newer printing
functionality, and the Printer Catalog is not available.

Pen numbers in the Color Table dialog box refer to the line weights used in
the printed drawing. By default, pen number 0 corresponds to a line weight of
0.01 mm. The final line weight in a printed drawing is the default pen thickness
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multiplied by the pen number. For example, pen number 25 will give a line
weight of 0.25 mm.

• The line thicknesses displayed on the screen are taken from the first
printer instance on the Printer instances list in the Printer Catalog. When
you print a drawing, the line thickness is taken from the printer instance
you use for printing.

• In color drawings, the lines are shown with different thicknesses if the
Printer line widths check box is selected in File menu --> Settings .

• In black and white drawings, Tekla Structures shows the black lines on the
screen using pen number thickness defined for the color in the Color
Table.

• You can change the default line thickness using the advanced option .

See also

Change the pen numbers (line thickness) for colors (page 647)

Change the pen numbers (line thickness) for colors
You can change the pen numbers for colors in Printer Catalog to show and
print lines with different thicknesses. This applies to printing when the
advanced option XS_USE_OLD_PLOT_DIALOG is set to TRUE.

The instructions below apply when you are printing using Printer Catalog
printer instances, which means that you have set the advanced option 
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced
options --> Printing .

1. Open a drawing.

2. On the File menu, click Printing --> Printer catalog, and select a printer
instance.

3. Click Color table

4. Enter or change a pen number. 

For example, to get line weight of 0.25 mm, enter 25.

You can change the default line thickness 0.01 using the advanced option .

5. Click OK.

6. In a color drawing, on the File menu, click Settings and select Printer line
widths, otherwise you cannot see the changes on the screen.

See also

Change drawing color (page 550)

Colors in drawings (page 547)

Line thickness (pen number) in Color Table (page 646)
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7.10 Printing tips (old printing)
Here are some tips that help you print drawings the way you want.

• If you are printing a drawing to a smaller paper, the line weights are scaled
accordingly. This means that no lines are drawn too thickly and the
drawings are more readable.

• You can force a drawing to use a different size paper: Open the drawing
and go to Drawing Properties --> Layout . In Size definition mode, select
Specified size. Insert the required sheet size into Drawing size.

• If a drawing does not fit to the paper or is printed to a wrong location, use
the Offset for print origin option in the Printer Catalog to move the
drawing print origin for the selected printer instance.

The advanced options XS_PLOT_ORIGIN_MOVE_X and 
XS_PLOT_ORIGIN_MOVE_Y move the print origin in the x or y direction for
all printer instances. If you set values for the advanced options, they are
used instead of the Offset for print origin value.

• You can disable the print date information to prevent the loss of
information when working with multi-user models. This is useful in cases
where a user modifies drawings while another user prints the same
drawings. Use the XS_DISABLE_DRAWING_PLOT_DATE to disable the print
date.

• You can add several Windows printer drivers for the same physical printer,
and define an exact paper size for each printer driver in Windows printer
driver printing preferences or printing defaults. Then in Tekla Structures,
you can set printer instances so that you select the printer driver that
matches the desired paper size. See the table at the end.

• If you only have one Windows printer driver for one physical printer, define
the largest paper size you are going to use for that printer driver in
Windows printer driver printing preferences or printing defaults, for
example, A0. Then in Tekla Structures, you can use that one printer driver,
and set several printer instances for it, each using the necessary paper size.
See the table below.
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Physical printer Windows printer drivers Tekla Structures printer
instances

One printer. Separate Windows printer
drivers for each needed
size.

Separate Tekla Structures
printer instances are defined for
each needed size, each printer
instance is using the printer
driver with a matching paper
size.

One printer. One Windows printer
driver. The printer driver
is set to the biggest
needed paper size.

Separate Tekla Structures
printer instances are defined for
each needed size, the same
printer driver is used for each
printer instance.

See also

Print drawings using Printer Catalog printer instances (old printing) (page 625)

Set up printer instances in Printer Catalog (old printing) (page 642)
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8 Define automatic drawing
settings

Drawing settings tell Tekla Structures what the drawing should look like and
what it should include. Automatic drawing settings are defined before
drawings are created.

Automatic drawing settings

Automatic drawing settings are settings that are defined through:

• Drawing, view and object properties in various drawing types. The
properties are stored in property files. Properties can be defined
separately for each drawing that you create, but it is advisable to save the
most commonly used settings in property files for future use, for example,
in Master Drawing Catalog. When creating a new drawing, always start by
loading automatic drawing properties that you think contain the best
settings for the drawing you are creating, and then adjust the settings as
required before creating the drawing. Properties can be adjusted also after
you have created the drawing.

You can open the drawing properties dialog boxes for setting the
automatic drawing properties by going to the Drawings & reports tab,
selecting Drawing properties and then selecting the drawing type.

• Drawing settings that are defined through various options and advanced
options in Options and Advanced Options dialog boxes.

• Additional settings files, such as rebar_config.inp (page 1004) for setting
reinforcement, and hatch_types1.pat (page 883) for setting hatch
patterns.

Single-part, assembly and cast unit drawing properties

These drawings contain two types of automatic properties: drawing-specific
and view-specific. Drawing-specific properties apply to the whole drawing:
coordinate system, coordinate system rotation, drawing titles, drawing layout,
user-defined properties, and some detail and section view properties.
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View-specific properties are defined separately for each view that you select to
create. For example, you might want to show marks in one view, dimensions in
another, and surface treatment in the third one. You may also want to define
different protection settings for each view. You can create as many views as
you need.

To specify the drawing views to create and the properties to use, follow the
path shown in the image below. First select the views to create and then select
view properties to be used for the views. If you need to adjust view properties
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or create new ones, click View properties and adjust the view properties,
including protection settings, dimensions, filters, marks and objects. Always
use Save to save the view properties, otherwise your changes are not saved.

Drawing-level and view-level properties in single-part, assembly and cast unit
drawings can be modified in an open drawing by double-clicking the drawing
background or the view frame, respectively. The available properties are the
same as in the dialog boxes shown above.

General arrangement drawing properties

Automatic drawing properties for general arrangement drawings can be
defined on drawing level before creating the drawing. You can modify the
drawing level properties in an open drawing by double-clicking the drawing
background.

Define automatic drawing settings 652



You can select the views that you want to create after starting the creation of a
general arrangement drawing. You can adjust the view-level properties in an
open drawing by double-clicking a view frame.
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Individual view, protection, dimension, mark and object properties

You can modify the dimension, mark and object properties manually in an
open drawing and save the changed properties in property files to be use later
on for different purposes.

See also

Set automatic drawing properties before creating drawings (page 65)

Modify drawing properties of an existing drawing (page 67)

Modify view-level drawing properties (page 67)

Modify drawing object properties (page 69)

Detailed object level settings (page 70)

How Tekla Structures applies drawing properties in drawing creation (page 78)

8.1 Define drawing layout
A drawing layout defines which tables to include in a drawing and where the
tables are located. Each drawing layout has its own table sets and applicable
drawing sizes. You can create and edit drawing layouts through Layout
editor.

The drawing layout connects drawing table sets to drawing sizes. Tekla
Structures has several predefined drawing layouts. Each drawing type;
assembly, single-part, cast unit, general arrangement, and multidrawing, can
have its own individual drawing layout with necessary table sets. You can also
create customized drawing layouts that can be used for more than one
drawing type.

Using different layouts you can, for example, set assembly drawings to use A1
and A2 size drawing sheets, and single-part drawings to use A3 and A4 sheets.
Another example is that you may want to include a material list in assembly
drawings, but not in general arrangement drawings.
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You can also customize the table sets within the same drawing layout, so that
different drawing sizes have different table sets. For example, A1 sheets and
A4 sheets can have the same drawing layout, but they may require different
positioning of table sets. By managing the number and location of tables, you
can ensure that the tables fit to each drawing size. You can also exclude some
tables from the drawing layout and edit them as part of the open drawing, so
that the drawing layout does not change.

In previous versions of Tekla Structures, table sets were not associated to any
drawing sizes if you used the Specified size option in drawing properties. In
case you open an old layout file without associated table sets, Tekla Structures
generates a drawing size to each table set automatically and names the
drawing size in the following format: ###_[TABLE SET NAME]. If needed, you
can then customize the table set of each drawing size in Layout editor.

If you use the Autosize in drawing properties, Tekla Structures selects the
smallest available drawing size that will fit the drawing views and the
connected table set. You can select which drawing sizes are compatible with
Autosize in the Drawing size settings dialog box.

Tekla Structures saves the new layouts you create in separate files with the file
name extension .lay. The layout files are located in the \attributes sub-
folder in the model folder. You can copy layout files to project or firm folders
defined by the XS_FIRM and XS_PROJECT advanced options.

Note that the .lay files created in Layout editor are not compatible with
Drawing Layout tool and Layout editor in previous Tekla Structures versions.
This means that you cannot use new drawing layouts in Tekla Structures 2019i
or earlier versions.

When an old .lay file is opened, all table sets in that .lay file that are not
tied to any fixed drawing sizes in the same .lay file are converted to
independent table sets. In the conversion, a new fixed size is automatically
generated for each table set, and the table set is then tied to the newly
generated size. The generated drawing sizes are always either A1 (841 mm x
594 mm) in non-imperial environments or ANSI D (864 mm x 559 mm) in
imperial environments. The names of the generated drawing sizes are of the
form ###_<name_of_converted_table_layout>.

Create and edit drawing layouts
Use Drawing layout editor to create new drawing layouts and edit existing
ones. Working on the layout, you can add, modify, move, and remove tables,
add and modify drawing sizes, and select if you want to see table names or
hidden tables in the drawing layout. Frames and fold marks are also added to
drawings in Drawing layout editor.

Open Drawing layout editor
• To access Drawing layout editor, do any of the following: 
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To access Drawing
layout editor

Do this

Through the File menu • On the File menu, select Editors --> Drawing
layout editor .

Through a drawing
properties dialog box

1. Click Layout.

2. On the right side of the Layout list, click Edit.
Through the ribbon in
the modeling mode

• On the Drawings & reports tab, click Drawing
properties --> Drawing layout editor .

In an open drawing Do any of the following:

• Right-click an existing table set and select Open
Layout editor.

• Double-click an existing table set and select
Drawing layout editor.

Through Quick Launch 1. Type Drawing layout in the Quick Launch
box.

2. Select Drawing layout editor from the list.

The layout editing mode opens.

Create a new drawing layout

1. On the Layout editor ribbon, click  Create layout.

2. Name the new drawing layout and select the initial drawing size. 

The drawing layout name can contain a maximum of 63 characters.

Note that you can apply the layout to additional drawing sizes later.

3. Click Create.

4. In the Layout editor side pane, select which drawing types the new layout
applies to.

5. Customize the drawing layout according to your needs. 

For example, add new tables to the layout or create and modify the
available drawing sizes. See detailed instructions below.

6. To save the drawing layout, click Save as on the Layout editor ribbon.

7. In the Save layout dialog box, type a name for the drawing layout in the
Save layout with a name box.

8. Select the drawing sizes to which you want to apply the current tables,
drawing view margins, and spaces between drawing views.

9. To ensure that the drawing sizes that you have created for the current
drawing layout are also available for printing, select the Synchronize
listed sizes with paper sizes for printing check box. 
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If Tekla Structures detects new drawing sizes, a copy of the 
Papersizesfordrawings.dat file is created in the \attributes folder
under the model folder.

Note that the drawing sizes and paper sizes are only synchronized in the
current model.

10. Click Save.

The drawing layout is saved in the \attributes folder under the model
folder as a .lay file. Note that the .lay files are not compatible with the
Drawing layout tool or the Layout editor that were available in previous
versions of Tekla Structures. This means that you cannot use the new layout
with older versions of Tekla Structures.

You can now continue working with drawing layouts or close the layout editing

mode by clicking  Close Layout editor.

Add new tables to a drawing layout
Here, we refer to all the elements that you can add to the drawing layout as
tables. The elements include:

• Template files (.tpl)

• DWG/DXF files

For example, you might have some details in a DWG or DXF file that you
want to show in certain types of drawings and therefore add the file in the
drawing layout.

• Key plans

Tekla Structures automatically includes the correct object in the key plan.
You can use drawings that contain only one view of the correct scale as a
key plan. Tekla Structures only uses the view from the original drawing. The
view position, drawing size, and templates of the original drawing are not
relevant to the key plan.

The combination of tables in the drawing layout is called a table set.

To add new tables to the drawing layout:

1. In the Drawing size list, select a drawing size to which you want to add
tables. 

You can apply the changes to multiple drawing sizes when you save the
drawing layout.

2. On the Layout editor ribbon, click  Add tables.

3. In the Available tables dialog box, click the table that you want to add.
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4. If you are adding a DWG or DXF file, or a keyplan, do one of the following: 

To Do this
Add a DWG or DXF File a. Select the file in the list of

available tables.

b. Browse to find and select the file
that you want to add to the
drawing.

c. Click Open.
Add a keyplan a. Select Keyplan in the list of

available tables.

b. In the Drawings dialog box,
select an existing key plan
drawing and click Select.

You can now close the Available
tables dialog box.

5. Click the point in the drawing layout where you want to add the table. 

The tables are automatically anchored to the drawing view frame.

6. If you want to change the table scale or rotation, select the table and type
new Scale or Rotation values. 

Note that you can only edit the scale and rotation of template files (.tpl).

Rotation and scale changes are applied to the drawing layout
immediately. When you scale or rotate a table, the table remain anchored
to the same position.
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7. If you want to allow the table to overlap with a drawing view, select the
Overlap with views check box. 

If you do not select the Overlap with views check box, Tekla Structures
keeps the drawing views outside the tables area when it creates or
recreates drawings. Note that overlap changes are applied to the drawing
layout only during drawing recreation and creation.

Move tables in the drawing layout
1. On the Drawings & reports tab, click Drawing properties --> Drawing

layout editor .

2. From the Drawing layout list, select the drawing layout.

3. In the drawing layout, do either of the following:

• To move one table, click the table that you want to move.

• To move several tables, hold down the left mouse button and drag a
box around the tables that you want to move.
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Two green handles appear.

The handle that is further from the table determines where the table is
anchored. The closer handle determines where one corner of the table is
located.

4. Do one of the following:

• Click the table that you want to move, and hold down the left mouse
button.

• Pick one of the green handles, and hold down the left mouse button.

5. Drag the tables to a new position. 

The tables snap to offsets of 1 millimeter in metric environments, or 1/16
inch in the US imperial environment.

Tekla Structures shows the distance between the handles in both the
vertical and the horizontal direction. The distance is shown in either
millimeters or fractions of inches, depending on the environment that you
are using.

6. To place the tables, release the left mouse button.

The tables are moved to the new position.

Remove tables from the drawing layout
• Do any of the following:

• In the drawing layout, right-click a table and select Delete.

• In the drawing layout, click a table and press Delete on the keyboard.
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• Select a table in the Tables in use list and press Delete on the
keyboard.

Adjust drawing sizes, frames, and fold marks
Frames and fold marks can be customized individually for each drawing
layout, or .lay file. However, the frame properties are initially read from the
standard.fms file with global frame and fold mark properties. If you do not
want to use the global frame and fold mark properties in a drawing layout,
adjust the appropriate properties in the Drawing size settings dialog box.

1. In the Layout editor side pane, click the  Edit button on the right side
of the Drawing size list.

2. In the Sizes in use section in the Drawing size settings dialog box, edit
the drawing sizes according to your needs: 

To Do this
Add a new drawing size a. Click + under the list of existing drawing sizes.

A new line is added at the bottom of the list of
drawing sizes.

b. Either select a predefined drawing size from
the list in the Name column, or type a name
for the new drawing size.

The predefined drawing sizes in the Name list
are defined in the
PaperSizesForDrawings.dat file. By
default, the file is located in
the ..\ProgramData\Trimble\Tekla
Structures\<version>\environments
\common\system folder folder.

c. To adjust the width and height, double-click
the Width and Height boxes and type new
values.

d. If you want to allow Tekla Structures to use the
drawing size when automatically selecting
suitable drawing sizes for drawings, select the
Autosize check box.

For more information on autosizing, see
Define drawing size and drawing view scale
(page 672).

Adjust the width and
height of a drawing size

a. Select the drawing size whose width and
height you want to modify.

Define automatic drawing settings 662 Define drawing layout



To Do this
b. Double-click the Width and Height boxes and

type new values.

TIP You can change the page orientation by right-
clicking the Width or Height box and
selecting Swap orientation.

The width and height of the drawing size are
swapped.

Enable using the
drawing size for
automatic drawing sizes

a. Select the drawing size that you want to use in
autosizing.

b. Select the Autosize check box.
Delete a drawing size
from the drawing layout

• Click - on the right side of the drawing size that
you want to delete.

3. In the Frames section, adjust the frames:

a. Select which frames you want to have in the drawing layout. 

We recommend that you use at least one frame in your drawings. If
you want to use only one frame, select the Primary frame.

If you use fold marks in your drawings, select both the Primary and
the Secondary frames, and use the secondary frame as the outer
frame.

b. Type the distances in millimeters or inches between each frame and
the left, right, bottom, and top edges of the paper.

c. Select a color for each frame.

4. If you use fold marks in your drawing layouts, define the fold mark
properties:

a. Type the horizontal and vertical distances between fold marks in
millimeters or inches.

b. Select a color for the fold marks.

5. To save the settings and close the Drawing size settings dialog box, click
OK.

Adjust the position of drawing views
To adjust the position of drawing views, you need to have a drawing open.

1. Scroll to see the Drawing views section of the Layout editor side pane.
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2. In the boxes under the Margins heading, type the horizontal and vertical
distances between the outermost drawing view and the drawing edges or
the table edges. 

Note that Tekla Structures automatically adds 5 millimeters to the
distances that you type.

3. In the boxes under the Spaces heading, type the horizontal and vertical
spaces between drawing view frames.

Note that the Drawing views settings work together with the
XS_DISABLE_VIEW_CENTERING_[drawing type] advanced options. By setting
the values of these advanced options to VER, HOR, or both, you can disable
automatically centering drawing views in horizontal, vertical, or both
directions.

You can enable or disable centering of drawing views manually for all drawing
types except for cast unit drawings. In cast unit drawings, centering of drawing
views is always enabled.

Adjust the visibility of tables in the drawing layout
The drawing layout contains some information that you may not always need
to see, because some tables are not relevant in all drawings that use the same
drawing layout. These tables are called hidden tables. If the content of a
drawing changes, these tables may appear again. For example, a table may
become visible if you add a revision.

By default, hidden tables are shown as simple boxes that have a known width
and a default height. In the image below, the upper table is a regular table,
while the lower table is a hidden table.

If necessary, you can choose to hide hidden tables from the drawing layout
completely.

• Do any of the following: 

To Do this
Hide or show hidden tables • In the Layout editor side pane,

click  next to Show hidden
tables.
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To Do this
• To show hidden tables again, click

 next to Show hidden tables.
Hide or show table names • In the Layout editor side pane,

click  next to Show table
names.

The table names are hidden.

• To show hidden tables again, click
 next to Show table names.

The table names are shown again.

Edit a drawing layout

TIP You can remove or rename drawing layouts in the file folder. Go to the
\attributes sub-folder under the model folder, find the right .lay file,
and remove or rename the file.

1. On the Drawings & reports tab, click Drawing properties --> Drawing
layout editor .

2. From the Drawing layout list, select the drawing layout that you want to
edit.

3. Edit the drawing layout according to your needs. 

For example, you can add, move or remove tables, or change the drawing
sizes.

4. To save the drawing layout, click Save as on the Layout editor ribbon.

5. If you want to save the edited layout with another name, in the Save
layout dialog box, type a name in the Save layout with a name box. 

If you do not type a new name for the layout, the changes you made
overwrite the existing layout (.lay) file.

6. Select the drawing sizes to which you want to apply the current tables,
drawing view margins, and spaces between drawing views.

7. To ensure that the drawing sizes that you have created for the current
drawing layout are also available for printing, select the Synchronize
listed sizes with paper sizes for printing check box. 
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If Tekla Structures detects new drawing sizes, a copy of the 
Papersizesfordrawings.dat file is created in the \attributes folder
under the model folder.

Note that the drawing sizes and paper sizes are only synchronized in the
current model.

8. Click Save.

The changes that you made are saved to the drawing layout (.lay) file. All
drawings that use the edited layout are automatically updated to match the
changes.

You can now continue working with drawing layouts or close the layout editing
mode by clicking Close Layout editor.

Example: Use different table sets for different drawing
sizes within a drawing layout
With Drawing layout editor, you can create separate table sets for different
drawing sizes within the same drawing layout. This way, you can ensure that
the tables fit to each drawing size.

In this example, we will create one table set for the A1, A2, and A3 drawing
sizes, and another table set for the A4 drawing size. We will do this for an
existing drawing layout.

1. From the Drawing layout list in the Layout editor side pane, select the
drawing layout that you want to edit.

2. Click the  Edit button on the right side of the Drawing size list.

3. In the Drawing size settings dialog box, click + and create the A1 drawing
sizes.

4. To close the Drawing size settings dialog box, click OK.

5. In the Drawing size list, select A1.

6. On the Layout editor ribbon, click Add tables.

7. Add tables and move them to appropriate positions in the drawing layout.
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See an example below.

The above drawing layout shows both hidden tables and table names.

When you have placed the tables as you wish, we can apply the table set
to more drawing sizes.

8. Again, click the  Edit button on the right side of the Drawing size list.

9. In the Drawing size settings dialog box, click + and create the following
drawing sizes: 

• A2
• A3
• A4
The table set that you created for the A1 drawing size is automatically
copied for the new drawing sizes.

In this example, we do not want the A4 drawing size to use the same table
set, so we will continue to adjust the table set.

10. To close the Drawing size settings dialog box, click OK.

11. In the Drawing size list, select A4.

12. Move, add or remove tables. See an example below.
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The above drawing layout shows both hidden tables and table names.

13. On the Layout editor ribbon, click Save as.

14. In the Save layout dialog box, type a name for the drawing layout.

15. Clear the A1, A2, and A3 check boxes. 

This way, the new table set is only applied to the A4 drawing size.

16. Click Save.

Tables in drawing layout
Tables are Template Editor templates added in Tekla Structures drawings
containing information on model objects. In Template Editor, the tables are
referred to as graphical templates.

The term table refers to various elements in a drawing layout, such as:

• Tables (such as revision tables)

• Title blocks

• Lists (such as part and bolt lists)

• General notes

• Key plans

• DWG/DXF files
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If you change the model, Tekla Structures updates the contents of the affected
drawings and tables created in Template Editor. The contents of the tables are
filled in by Tekla Structures at run time.

The available graphical templates are read from the following folders in the
following order, and shown in the Available tables list in the Layout editor
side pane:

• Template folder (XS_TEMPLATE_DIRECTORY)

• Current model folder

• Project folder (XS_PROJECT)

• Firm folder (XS_FIRM)

• Environment-specific system templates folder
(XS_TEMPLATE_DIRECTORY_SYSTEM)

• System folder (XS_SYSTEM)

See also

Edit tables in Template Editor (page 671)

Create and edit drawing layouts (page 656)

Table sets
A table set is a group of tables or templates included in a drawing of a
particular type and size.

The table set defines:

• Which tables are included in the drawing

• Where the tables are located in the drawing

• How much space Tekla Structures leaves between the drawing frame and
views and between the drawing views

Table sets define the background of the drawing, not the number or location
of the drawing views to include.

You can either use the same table sets with different drawing sizes, or give
each drawing size its own table set. For example, if the number of views
changes in a drawing and Tekla Structures chooses a new drawing size, Tekla
Structures may also choose another table set automatically.

The examples below illustrate the relationship between the table set and
drawing views. The drawing views are blue, and the elements of the table set
are green.

Below is an example of a GA drawing layout.
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1. General arrangement drawing view

2. Part list on assembly or cast unit level

3. Revision table and title block

Below is an example of an assembly drawing layout.

1. Margins between the drawing frame and the outermost views

2. Spaces between the views
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3. Top view

4. Front view

5. Section views A-A and B-B

6. Drawing frame

7. Key plan

8. Material list

9. Revision table

10. Drawing title block

11. Fold marks

See also

Create and edit drawing layouts (page 656)

Tables in drawing layout (page 668)

Select a new layout for your drawing (page 163)

Edit tables in Template Editor
If you need to edit a table in a drawing layout, you can open it in Template
Editor (TplEd). In Template Editor, drawing layout tables are called templates.

You can only open tables with templates created or saved in Template Editor
version 3.2. or later.

If your templates are located in a protected folder, the templates are read-
only, and you cannot save modified templates in a protected folder. In this
case, you need to start Tekla Structures as an administrator.

1. In a drawing, double-click the table you want to modify. 

The following dialog box opens:
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2. Click Template Editor. 

Tekla Structures starts Template Editor, and the selected template is
displayed.

3. Modify the template and save the changes by selecting File --> Save , or
Save as to use another folder, for example the model folder.

For more information about the Template Editor, see Template Editor User's
Guide.

The example below illustrates how a table looks in a drawing and in Template
Editor. In this example, there is a revision table and a title block. The revision
table is located above the title block and bound to the title block in the layout.

See also

Tables in drawing layout (page 668)

8.2 Define drawing size and drawing view scale
Tekla Structures offers you several combinations of settings that you can use
for defining the drawing size and the drawing view scale. You can use exact
drawing view scale and automatic drawing size, automatic view scale and
exact size, or both automatic scale and size.
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Settings Click the link below to find out
more

Autosizing: If you always want to use
a certain scale, then you would set
the exact scale to be used and let
Tekla Structures automatically select
the drawing size that suits the
selected scale.

You can define different scales for
main views and section views. All
main views in a drawing automatically
use the same scale unless you fine-
tune individual views manually.

Set exact drawing view scale and
automatic drawing size (page 673)

Autoscaling: If you always need to use
a certain drawing size, for example,
A3, A4 or A1, then you would set the
size and let Tekla Structures
automatically select the drawing view
scale that suits the selected size.

Tekla Structures first tries to use the
preferred scale for the drawing views,
then the alternative scales, and
selects the largest possible scale.

Set exact drawing size and automatic
drawing view scale (page 674)

If you are not bound to any specific
drawing sizes or drawing view scales,
you might want to let Tekla Structures
take care of both.

Autoscale and autosize drawings
(page 676)

See also

Create and edit drawing layouts (page 656)

Layout properties (page 918)

Set exact drawing view scale and automatic drawing size
You can let Tekla Structures find appropriate sizes and table sets for drawings.
Tekla Structures automatically updates drawings to adapt to these changes by
using different drawing sizes and table sets.

Using exact drawing view scale and automatic drawing size is very useful, for
example, when the number, size, or location of drawing views may change.

Note that the following instructions do not apply to GA drawings.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
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2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Layout.

4. Set Size definition mode to Autosize.

The available sizes for autosizing are defined in the Drawing size settings
dialog box, which you can access through Layout editor.

5. Go to the Scale tab and set Autoscale to No.

This way Tekla Structures uses the exact scale that you have set for the
main views and section views.

6. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

7. On the Attributes 1 tab, set the desired Scale.

8. Save the view properties and click Close.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

When you create the drawing, Tekla Structures creates the views using the
selected scale and selects the smallest drawing size where the views fit in the
drawing.

Note that each drawing size might have its own individual table set, so the
table set might also change when Tekla Structures adapts another drawing
size. Tekla Structures uses only drawing sizes that use the drawing layout that
you have selected from the Layout list.

See also

Define drawing size and drawing view scale (page 672)

View properties in drawings (page 920)

Section view properties (page 927)

Create and edit drawing layouts (page 656)

Layout properties (page 918)

Set exact drawing size and automatic drawing view scale
If you need to use a specific size in your drawings, for example, A3, A2, or A1,
you can specify the exact size, and let Tekla Structures automatically select the
suitable drawing view scale. The drawing size should always be smaller than
the actual paper size to accommodate printer margins.

Note that the following instructions do not apply to GA drawings.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
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2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Layout.

4. On the Drawing size tab, set Size definition mode to Specified size .

5. Select the size from the Drawing size list. 

The available drawing sizes are defined through the (page 656).

6. Select the table set from the Layout list.

7. On the Scale tab, set Autoscale to Yes.

8. Set the Main view scales and Section view scales. 

Enter the denominators of scales and separate them with spaces. For
example, enter "5 10 15 20" for the scales 1/5, 1/10, 1/15, and 1/20.

9. Select the Scale change mode, which defines the relationship between
the scales of main and section views within a drawing. 

The options are:

• main = section: The scales of the main and section view are equal.

• main < section: Main view scales are smaller than section view scales.

• main <= section: Main view scales are smaller than or equal to section
view scales.

10. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

11. Enter the preferred scale. 

Do the same for each view that you create.

12. Save the view properties and click Close.

13. Click Save to save the drawing properties, then click OK and create the
drawing.

Tekla Structures creates the drawing using the specified size. Tekla Structures
first tries to use the preferred scale for the drawing views, then the alternative
scales, and selects the largest possible scale.

See also

Define drawing size and drawing view scale (page 672)

View properties in drawings (page 920)

Section view properties (page 927)

Create and edit drawing layouts (page 656)

Layout properties (page 918)
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Autoscale and autosize drawings
If you are not bound to any specific drawing sizes or drawing view scales, you
can let Tekla Structures take care of both.

You can first set autoscale and after that autosize. Both of the settings are set
in Layout properties.

Note that the following instructions do not apply to GA drawings.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

4. On the Attributes 1 tab, set the preferred drawing view scale in the Scale
box. 

Do the same for all of the views you plan to create.

5. Click Save to save the view properties. Do this for all of the views you have
modified.

6. Click OK to return to drawing properties.

7. Click Layout, go to the Scale tab and set Autoscale to Yes.

8. Set the alternative Main view scales and Section view scales.

9. Select the Scale change mode, which defines the relationship between
the scales of main and section views within a drawing. 

The options are:

• main = section: The scales of the main and section view are equal.

• main < section: Main view scales are smaller than section view scales.

• main <= section: Main view scales are smaller than or equal to section
view scales.

10. Enter the Preferred size.

11. On the Drawing size tab, set Size definition mode to Autosize.

12. Click Save to save the drawing properties, then click OK and create the
drawing.

When you use both autoscaling and autosizing at the same time, Tekla
Structures follows the steps below:

• First Tekla Structures tries to find a drawing size where the drawing
contents fit by first trying to use the exact scale defined in View Properties
--> Attributes 1 and the smallest drawing size defined in the current
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layout. The sizes are defined through Drawings & reports --> Drawing
properties --> Drawing layout editor .

For more information, see Create and edit drawing layouts (page 656).

• Then Tekla Structures increases the drawing size until it reaches the
Preferred size defined in Layout --> Scale .

• If the drawing fits with the original scale, Tekla Structures tries to increase
the scale using the alternative main and section view scales you defined in
Layout --> Scale.

• If the drawing does not fit to any of the defined scales, Tekla Structures
starts to increase the drawing size until the contents fit, using Autosize.
When necessary, Tekla Structures changes to another appropriate table set
within the current layout.

• When the views fit, Tekla Structures begin to increase the scale again so
that the final drawing uses the largest possible scale.

See also

Define drawing size and drawing view scale (page 672)

View properties in drawings (page 920)

Section view properties (page 927)

Create and edit drawing layouts (page 656)

Layout properties (page 918)

8.3 Define object protection and placement settings in
drawings
When you create a drawing, Tekla Structures uses predefined rules for
positioning marks and dimensions. Marks and dimensions are automatically
placed in the first suitable position.

The following settings are considered when placing the objects:

• The protected areas defined in drawing view properties in single-part, cast
unit and assembly drawings. In GA drawings they can be defined on both
levels. How the protection settings are applied depends on the drawing
order of the objects in the drawing: the parts are drawn first, then the
marks and then the dimensions.

• The placing and leader line type settings (page 839) of the annotation
objects defined in the annotation object properties. Marks are usually
drawn before dimensions, but if the marks have leader lines, they are
drawn after the dimensions.

Define automatic drawing settings 677 Define object protection and placement settings
in drawings



• The predefined mark location and part orientation settings for some
marks. For more information, see Set a predefined location for beam,
bracing and column marks (page 838).

• The modeling direction of parts.

• XS_MARK_INTELLIGENT_PLACING: Marks are automatically placed
according to the mark placing algorithm if this advanced option is set to 
TRUE (default). The placement algorithm tries to avoid crossing leader lines,
and also places marks otherwise more clearly. 
XS_MARK_INTELLIGENT_PLACING is available in the category Marking:
General in the Advanced Options dialog box. The algorithm applies to all
marks and associative notes, except weld marks.

• XS_MARK_PLACING_ANGLE_CLOSE_TO_45_DEGREES: If you set this
advanced option to TRUE (default), marks with leader lines are placed in a
45-degree angle if allowed by the protection settings.

• XS_MARK_INTELLIGENT_ POST_FREEPLACE_NEARBY: If you set this
advanced option to TRUE (default), Tekla Structures first places the marks
avoiding crossing leader lines and after that runs the place nearby
command, which ensures that the mark locations follow the protection
settings. If you set this advanced option to FALSE, the crossing mark check
is performed, but the place nearby command is not run, so some of the
protection settings may not be followed.

When you create a drawing, Tekla Structures places the annotation objects
according the automatic placement settings and protection settings. You can
modify the placement settings in drawing view properties and on object level
for individual objects. The protection settings are also considered when you
add annotation objects manually.

When you create a drawing, Tekla Structures places the views in the drawing
according the settings in the drawing layout and view properties. In final
drawings, you can select whether to use fixed or free view placement of views,
drag drawing views to new locations, or align them.

To Click a link below to find out more
Specify protected areas in your
drawings

Protect areas in a drawing
(page 679)

Arrange drawing objects Arrange annotation objects
(page 344)

Align drawing objects Align selected drawing objects
(page 345)

Specify how the marks or dimensions
are placed

Define automatic placement settings
for marks (page 683)

Define placement settings for
dimensions (page 685)
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To Click a link below to find out more
Specify whether the view placement is
fixed of free

Define automatic free or fixed
placement for drawing views
(page 686)

See also

Placement properties for marks, dimensions, notes, texts and symbols
(page 1013)

Protect areas in a drawing
You can define protected areas in drawings to prevent text, marks or
dimensions from being placed in that area. When Tekla Structures places text,
marks, dimensions or other annotation objects in a drawing, it first checks the
protection settings.

The drawing view properties contain pre-defined protection settings, which
you may change. In GA drawings, you may also define protection settings on
the drawing level.

For example, In GA drawings you often want to have different protection
settings in plan views and section or detail views. In plan views, you may want
to show marks inside the member, for example, a slab. In section and detail
views all marks need to be outside the member.

Below is an example of the protection properties dialog with explanations of
the selections.

(1) With a selection like this, text and marks may overlap with part corners and
edges, but not with part content.

(2) With a selection like this, dimension values may not overlap with other
dimension arrowheads, lines or values.

Define automatic drawing settings 679 Define object protection and placement settings
in drawings



The objects at the top of the dialog box define the areas to be protected, see
descriptions below:

Column Description

Part corners

Part edges

Part content

Text, mark or weld mark

Dimension arrowhead

Dimension line

Dimension value

Cutting line

Section mark

Weld arrow

Weld mark content

The objects on the left in the dialog box define which objects, or object
elements, Tekla Structures cannot place in the protected areas. See the
descriptions below:

Row Description
Text, mark or weld mark

Dimension arrowhead

Dimension line

Dimension value
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You can check which areas are protected by using the Show protection
command. You can enter this command in the Quick Launch box. This
command shows the protected areas with colors.

Define automatic protection settings in single-part, assembly and cast
unit drawings
1. On the Drawings & reports tab, click Drawing properties and select the

drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree, and define the drawing views you
want to create.

4. In the View creation, select a view row, and click View properties

5. Click Protection in the options tree. 

The settings are same for all drawing types.

6. Select check boxes to indicate the areas that you want to protect from
text, marks, weld marks, associative notes, dimension arrowheads,
dimension lines or dimension values. 

• For example, to prevent text, marks, dimensions or other annotation
objects from being placed over the inside area of parts, select the third
check box on the first row. The first row defines the placement of
annotation objects, and the icon above the third check box indicates
the inside area of parts. With this setting, Tekla Structures may place
annotation objects on the corners and edges of parts.

• If you clear the first two columns of check boxes, Tekla Structures does
not protect part corners and edges. This increases drawing speed and
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decreases the memory requirements. You can still protect these areas
by using the third column of check boxes for part protection.

7. Click Save to save the view properties.

8. Click Close to return to drawing properties.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

Define automatic protection settings for GA drawings
In GA drawings, automatic protection settings can only be defined on drawing
level.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type. This time, select GA drawing.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Protection.

4. Select check boxes to indicate the areas that you want to protect from
text, marks, weld marks, associative notes, dimension arrowheads,
dimension lines or dimension values. 

• For example, to prevent text, marks, dimensions or other annotation
objects from being placed over the inside area of parts, select the third
check box on the first row. The first row defines the placement of
annotation objects, and the icon above the third check box indicates
the inside area of parts. With this setting, Tekla Structures may place
annotation objects on the corners and edges of parts.
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• If you clear the first two columns of check boxes, Tekla Structures does
not protect part corners and edges. This increases drawing speed and
decreases the memory requirements. You can still protect these areas
by using the third column of check boxes for part protection.

5. Click Save as and save the protection settings with a unique name, and
OK to return to drawing properties.

6. Click Save to save the drawing properties, then click OK and create the
drawing.

Modify protection settings in an existing drawing on view level
You can modify the protection settings on view level in all drawing types.

1. When the drawing is open, click the view frame of the view where you
want to have different protection settings.

2. Click Protection in the options tree. 

The settings are same for all drawing types.

3. Adjust the settings as necessary and click Modify.

In GA drawings, you can also adjust the drawing level protection settings. To
do so, double-click the drawing background, click Protection, adjust the
settings and click Modify.

Define automatic placement settings for marks
You can define automatic placement settings for the marks before creating a
drawing. You can modify the settings in an open drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.
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3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click an object that you want to adjust, for example Part mark.

5. On the appropriate tab, click the Place... button to open the Placing
dialog box.

6. Adjust the placement settings. The options available in the dialog box vary
depending on the annotation object type. 

• In Minimum distance, enter the closest distance Tekla Structures
uses to place the marks. See number 2 in the image below.

• In Maximum distance, enter the farthest distance Tekla Structures
uses to place the marks. If no place for mark is found within the
specified distance, Tekla Structures will force the mark to that distance.
If you set this option to 0, the maximum distance behaves like infinity.
See number 3 in the image below.

• In Search margin, enter the empty margin that you want to have
around the marks. See number 1 in the image below.

• Note that if you use a high Search margin and Minimum distance
values, the mark placement does not work properly.

• To move marks away from each other, use Search margin, not
Minimum distance. Keep the minimum distance setting as small as
possible to reduce the possibility of marks overlapping.

• Select the Quarter to define the areas Tekla Structures searches for a
space to place the object.

(1) Search margin

(2) Minimum distance

(3) Maximum distance

7. Click OK.

8. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties.

9. General arrangement drawings: Click OK.

10. Click Save to save the drawing properties, then click OK and create the
drawing.
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TIP If you are not happy with the mark placement settings in a drawing, you
can change the settings in the mark placing dialog box on object level,
which has more options available. In an open drawing, you can also
change the placement settings for manually added marks, notes, texts,
and symbols.

To open an object level dialog box, double-click the mark, text, note, or
symbol in the drawing and click Place.... If you set Placing to free, you
are letting Tekla Structures to decide the location of the mark. If you set
Placing to fixed, you can place the mark in any location. When you use
the setting fixed, the mark stays where you place it even though you
update the drawing, whereas with free, Tekla Structures tries to find the
optimal place for the mark. You can select several or all marks in a view
and change the placing settings this way.

See also

Define object protection and placement settings in drawings (page 677)

Protect areas in a drawing (page 679)

Define placement settings for dimensions
You can set dimension placement to free or fixed, and control the space
between parallel dimension lines and the location of the dimension in relation
to the object it is dimensioning. You can also select whether to place short
dimension text inside or outside the dimension.

In single-part, assembly and cast unit drawings, the dimension placement
settings can be defined in an open drawing, saved into a dimension properties
file and loaded in another drawing, or taken into use in dialog box. In general
arrangement drawings, most of the settings can be defined on drawing and
view level, but placement settings only on object level.

Remember that in addition to dimension placement settings, the placement is
also affected by Protection properties.Tekla Structures uses the protection
properties to prevent marks and dimensions from being placed in protected
areas.

To adjust dimension placement settings in an open drawing and save the
settings for later use:

1. On the Drawing tab, click Properties --> Dimension.

2. Go to the General tab in dimension properties.

3. In Dimension lines spacing, enter the desired space between two
parallel dimension lines.

4. Select whether to place short dimension text inside or outside of the
dimensions from the Short dimensions list.
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5. Click Place..., and define the desired placing settings: 

• Set Placing to free to let Tekla Structures decide the location and
direction of the dimension based on the Direction settings.

• If you set Placing to fixed, you can place the dimension in any
location. When you use the setting fixed, the dimension stays where
you place it even though you update the drawing, whereas with free,
Tekla Structures tries to find the optimal place for the dimension.

• The option Direction defines where Tekla Structures places
dimensions relative to the dimensioned object. You can select either
positive or negative, or both. Positive places the dimension further
away and negative closer to the dimensioned object. This setting
affects the Placing: free setting.

6. In Minimum distance, enter the closest distance Tekla Structures uses to
place the dimension.

7. In Search margin, enter the empty margin that you want to have around
the dimension. If Tekla Structures cannot place the dimension at the
minimum distance, it moves the dimension by the value you enter in the
Search margin box. Tekla Structures tries to place the dimension using
the Search margin value until it finds a place for the dimension.

8. Click OK to close the dimension placing dialog box.

9. Save the dimension properties using Save, or save them in another file
using Save as.

10. Click Modify to modify the dimension properties in the open drawing.

The dimensions are placed according the changes you made. Now you have a
dimension properties file that you can load whenever you need to adjust the
dimension placement settings in the same way. For example, you can load
these properties in the Dimension Properties box in the Dimensioning rule
properties dialog box, or in an open general arrangement drawing in the
Dimension Properties dialog box.

See also

Define object protection and placement settings in drawings (page 677)

Dimension properties - General tab (page 929)

Dimension properties - Appearance tab (page 934)

Dimension properties - Units, precision and format (page 932)

Placement properties for marks, dimensions, notes, texts and symbols
(page 1013)
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Define automatic free or fixed placement for drawing views
You can keep the views in the same location (fixed) or let Tekla Structures find
a suitable place for the view (free) during drawing updates.

In general arrangement drawings, this setting can only be defined on view
level in an open drawing. In single-part, assembly and cast unit drawings, you
can set the view placement before creating drawings.

To define automatic free or fixed placement of in single-part, assembly and
cast unit drawings:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

4. On the Attributes 1 tab, select one of the following options: 

• Set Place to fixed to always keep the view in the same location when
you update the drawing.

• Set Place to free to let Tekla Structures find a suitable place for the
view when you update the drawing.

5. Click Save to save the view properties.

6. Click Close to return to drawing properties.

7. Click Save to save the drawing properties, then click OK and create the
drawing.

NOTE The Arrange views (page 189) command only affects views where the Place is
set to free. fixed views are not moved.

See also

Define object protection and placement settings in drawings (page 677)

8.4 Define drawing views
With automatic drawing views we mean views that you select to create before
creating a single-part, assembly or cast unit drawing. You can define the
desired drawing view properties separately for each view before you create
the drawings.

When you create general arrangement drawings, you cannot select the views
to be created in the general arrangement properties dialog box, but you select
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them at GA drawing creation. However, you can define automatic settings that
apply to all the views you create in a general arrangement drawing.

To Click the links below to find out
more:

Select the views that you want to
create in single-part, assembly or cast
unit drawings

Define the views to create in single-
part, assembly and cast unit drawings
(page 689)

Define automatic view properties for
general arrangement drawings

Define automatic view settings for
general arrangement drawings
(page 690)

Define automatic view properties for
section views

Define automatic section view
properties (page 717)

Define the contents of the main view
and section view labels before you
create the drawing

Define view labels and view label
marks (page 691)

Define how Tekla Structures places
the projections of a part in cast unit,
single-part, and assembly drawings

Set drawing view projection type
(page 693)

Include single-part drawings of the
individual parts that make the
assembly in assembly drawings

Include single-part drawings in
assembly drawings (page 695)

Adjust the orientation of parts by
changing the coordinate system,
rotating parts in drawing views,
setting viewing direction of columns,
beams or bracings, or changing the
project north

Part orientation in drawing views
(page 697)

Show neighbor parts in drawing views Show neighbor parts in drawings
(page 705)

Shorten or lengthen parts in model or
drawing views

Shorten or lengthen parts (page 708)

Unfold polybeams and bent plates in
single-part drawings according to
unfolding parameters

Unfold polybeams in drawings
(page 712)

Undeform warped or cambered parts
and show the developed shape of
deformed parts in drawings

Undeform deformed parts in
drawings (page 713)

Show symbols for part openings and
recesses (blind holes) in drawing
views

Show part openings and recesses in
drawings (page 714)

See also

View properties in drawings (page 920)
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Section view properties (page 927)

Define the views to create in single-part, assembly and cast
unit drawings
Before you create single-part, assembly or cast unit drawings, you need to
select the views that you want to include automatically. At the same time, you
can set the necessary view properties.

To select the drawing views to be created and set the view properties:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.. Select single-part, cast-unit or assembly drawing.

2. Load the drawing properties file that you want to modify from the list at
the top.

3. Click View creation.

4. Go to the Attributes tab and change the settings as required. 

These settings apply to all views in the drawing. Here you can select the
coordinate system, set the coordinate system rotation, and undeform
warped or cambered parts.

5. On the Views tab, select the views you want to create. You can create as
many views as you like. 

• If you select Off, Tekla Structures does not create the view, but
dimensions the parts in the available views. If you set all four main
views off, Tekla Structures will still create one front view.

• If you select On, Tekla Structures always creates the view, even if it was
not necessary in order to show the dimensions. For section views,
Tekla Structures creates one additional section view showing the
middle of the main part. For end views, Tekla Structures creates an
end view from one end of the main part.

• If you select Auto, Tekla Structures creates the view if it is necessary in
order to show the dimensions. For section views, Tekla Structures
creates the necessary number of views to show all the dimensions. For
end views, Tekla Structures also creates another end view from the
other end of the main part, if there are dimensions at that end.

6. For each of the views that you create, select the view properties that you
want to use in the View properties column. 

The lists contain predefined view properties for different types of
drawings, also the view properties that you save in the View Properties
dialog box. For more information about view properties, see View
properties in drawings (page 920).
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7. Check the view properties for each view by selecting the view from the list
and clicking View properties button, and modify the properties as
required.

8. Check the settings on the Attributes 1 tab in View Properties. 

Here you can set the view scale and size, view extension distance, view
place, and rotation of 3D views, show a reflected view and apply detailed
object level settings for the selected view.

9. Check the settings on the Attributes 2 tab in View Properties. 

Here you can undeform warped or cambered parts, shorten parts, show
openings and recesses, select whether to se the location by the model
origin or a base point, set the datum point for elevations and select the
dimension creation method in the selected view.

10. Check the settings on the Label tab in View Properties. 

Here you can define the label text and position, add a symbol in the label
and show the view direction marks in the selected view.

11. Go throug the options in the options tree, and modify dimensioning,
protection, mark and building object settings as required.

12. Save the view properties by clicking Save.

13. Click Close.

14. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

View properties in drawings (page 920)

Section view properties (page 927)

Define drawing views (page 687)

Set automatic drawing properties before creating drawings (page 65)

Define automatic view settings for general arrangement
drawings
Before you create general arrangement drawings, define the automatic view
properties.

1. Click Drawings & reports --> Drawing properties --> GA drawing .

2. Load the drawing properties file that you want to modify from the list at
the top.

3. Click View... and load the view properties you want to modify.
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4. On the Attributes tab, change the settings as required. 

Here you can set the view scale, view extension distance, show a reflected
view, show openings and recesses, set the datum point for elevations and
show pours.

5. Go to the Shortening tab and define the part shortening settings. 

Here you can select whether you want to cut parts, set the minimum part
length, and set the space between cut parts.

6. Go to the Label tab and define the view label text, symbol and position.

7. If you want to create an anchor bolt plan drawing, go to the Anchor bolt
plan tab and set Show as anchor bolt plan to Yes. 

You can also select, whether you want to create detail views in anchor bolt
plans and set the enlarged part view scale.

8. Save the view properties.

9. Click OK to return to drawing properties.

10. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

View properties in drawings (page 920)

Define drawing views (page 687)

Create anchor bolt plans using saved settings (page 113)

Set automatic drawing properties before creating drawings (page 65)

Define view labels and view label marks
All drawing views can have view labels, which may contain text and symbols.
You can set the contents of the main view labels and section view labels
before you create the drawing. You can also adjust them after you have
created the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Do one of the following depending on the drawing type: 

Single-part, assembly and cast unit drawings:

a. Click View creation in the options tree on the left, select the view and
the properties that you want to change, and click View properties.
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b. Click Attributes and go to the Label tab.

General arrangement drawings:

a. Click View...

b. Go to the Label tab.

4. Click the ... button next to A1 - A5 to open the Mark Contents dialog box. 

The illustration in the view properties dialog box is only one way to
position the label text. When you modify the positioning, the illustration in
the dialog box does not change.

5. On the Content tab, select the elements that you want to include in the
view label mark.

6. If needed, select an element from the list and click < Add frame and
select the frame Type and Color.

7. If needed, select an element from the list and select the text Color, Font
and Height.

8. Go to the Position tab and set the text position, horizontal and vertical
offset, and the text alignment. 

Text positioning depends on whether you use a symbol or not.

9. Click OK.

10. Select the view label Symbol you want to use in the label. 

You can simply use only a label or add a symbol in it. You can also set the
color, size, line length and the position of the view label.

11. Select the Vertical and Horizontal position for the view label.

12. To save the changes, click Save.

13. Single-part, assembly and cast unit drawings: Click Close. 

General arrangement drawings: Click OK.

14. Click Save to save the drawing properties, then click OK and create the
drawing.
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See below for examples of view labels:

Drag the view label to the desired page in an open drawing.

The view frame is resized automatically, if necessary.

For more information on the elements available in view label marks, see View,
section view and detail view label mark elements (page 982).

For more information about the positioning of the view label marks, see
Positioning properties of view label, section and detail marks (page 983)

Define section view properties for all views in a drawing

If you want to use the same section view properties, such as start number or
letter, cutting line, contents, and text position, in all your section views, you
can do this in on the drawing level. For more information, see Define
automatic section view properties (page 717).

See also

View properties in drawings (page 920)

Section view properties (page 927)

Define drawing views (page 687)
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Set drawing view projection type
Projection type defines how Tekla Structures places the projections of a part in
cast unit, single-part, and assembly drawings. Projection type affects the order
of the views in the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load the properties you want to change.

3. Click Layout and go to the Other tab.

4. Select one of the following: 

• First angle (also referred to as European projection).

• Third angle (also referred to as American projection).

5. To save the properties in the properties file, click Save.

6. Click OK and create the drawing.

First-angle projection:

Third-angle projection:
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See also

Define drawing views (page 687)

View properties in drawings (page 920)

Layout properties (page 918)

Include single-part drawings in assembly drawings
You can include in assembly drawings single-part drawing views of the
individual parts that make the assembly. You can use existing single-part
drawings in Document manager or create new single-part drawing views.

1. On the Drawings & reports tab, click Drawing properties --> Assembly
drawing .

2. Load the desired assembly drawing properties.

3. Click Layout and go to the Other tab.

4. Set Include single-parts to Yes. 

This activates the Single-part attributes list.

5. In the Single-part attributes list, select the desired drawing properties to
be used in the single-part view. The properties file standard is the
default.

6. Click Save to save the drawing properties in the properties file.

Define automatic drawing settings 695 Define drawing views



7. Click OK and create the drawing.

The value of the advanced option 
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_DRAWING
affects how Tekla Structures creates the single-part views. If the option is set
to TRUE, Tekla Structures will use single-part drawings in the . If it is set to 
FALSE, or if there is no existing single-part drawing for a given part, a new
view will be created according to the Include single-parts setting. The default
value is FALSE.

Tekla Structures also maintains the original scale in a single part drawing in an
assembly drawing when you set the layout to include single part drawings, and
set the option 
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_DRAWINGS is
set to TRUE. If you do not want to maintain the scale of the existing single part
drawing, set the advanced option
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_SCALE can be set to FALSE. If
you do this, thee scale of the included single part drawing will follow the scale
of the assembly drawing, or advanced option XS_SINGLE_SCALE if it is set.

The following advanced options all affect how the single-part drawing views
behave:

XS_SINGLE_CENTERED_SCREW

XS_SINGLE_CLOSE_DIMENSIONS

XS_SINGLE_CLOSE_SHORT_DIMENSIONS

XS_SINGLE_COMBINE_DISTANCE

XS_SINGLE_COMBINE_MIN_DISTANCE

XS_SINGLE_COMBINE_WAY

XS_SINGLE_DIMENSION_TYPE

XS_SINGLE_DRAW_PART_AS

XS_SINGLE_EXCLUDE

XS_SINGLE_FORWARD_OFFSET

XS_SINGLE_NO_SHORTEN

XS_SINGLE_ORIENTATION_MARK

XS_SINGLE_PART_EXTREMA

XS_SINGLE_PART_SHAPE

XS_SINGLE_SCALE

XS_SINGLE_SCREW_INTERNAL

XS_SINGLE_SCREW_POSITIONS

XS_SINGLE_USE_WORKING_POINTS

XS_SINGLE_X_DIMENSION_TYPE
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XS_USE_EXISTING_SINGLE_PART_DRAWINGS_SCALE

XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS

See also

Add single-part views in assembly drawings (page 194)

Define drawing views (page 687)

Part orientation in drawing views

In single-part, assembly, and cast unit drawings, you can adjust the orientation
of the parts in the drawing views by selecting an appropriate coordinate
system and by rotating the parts. You can also separately set the viewing
direction of columns, beams and bracings in assembly drawings. The project
north setting also affects part orientation.

To Click the links below to find out
more

To change the angle from which the
part, assembly, or cast unit is viewed,
how the part, assembly, or cast unit is
rotated, and how the dimensions in
the drawing view are oriented

Change the coordinate system
(page 697)

Rotate a part, assembly, or cast unit
in a drawing view around its local
axes

Rotate parts in drawing views
(page 700)

Select which side of a steel or timber
part is always shown in the drawing
main view

Select the steel or timber part face
that is shown in front drawing view
(page 702)

Change the plate orientation in
drawing views

Change plate orientation in drawings
(page 704)

XS_POLYGON_SQUARE_CORNER_PREF
ERENCE_FACTOR

XS_POLYGON_PERPENDICULAR_EDGE
_PREFERENCE_FACTOR

Define the front view direction
separately for columns

Set viewing direction for parts in
assembly drawings (page 703)

Define the front view direction
separately for beams and bracings

Set viewing direction for parts in
assembly drawings (page 703)
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Change the coordinate system
You change the angle from which objects are viewed, how the object is
rotated, and how the dimensions in the drawing view are oriented.

The coordinate system defines:

• The angle from which the part, assembly, or cast unit is viewed.

• How the part, assembly, or cast unit is rotated.

• The orientation of the dimensions in the drawing view.

To change the coordinate system:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load the drawing properties that you want to change.

3. Click View creation and go to the Attributes tab. 

The settings affect all views in a drawing.

4. In Coordinate system, select one of the available coordinate systems: 

• local

Tekla Structures uses the local coordinate system of the main part. The
x axis of the part is parallel to the x axis of the drawing, and the start
point (the end point created first) of the part is on the left. The start
point is marked with yellow, and the end point created second is
marked with pink.

• model

Tekla Structures uses the global coordinate system. The part has the
same position in the drawing as it has in the model. This is one option
when you want to show columns vertically. You can also use this
option to display sloping parts in position. Tekla Structures cannot
display horizontally skewed parts.
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• oriented

Tekla Structures uses the local coordinate system of the main part, but
the coordinate system is oriented so that the x axis of the part points
to the right even if the part was created from right to left.

• horizontal brace

Tekla Structures automatically rotates the drawing views so that the
front view is from the top of the model. This is used for skewed braces.
It automatically rotates the front view around the x axis.

• vertical brace

Tekla Structures automatically rotates the drawing views so that the
front view is in the same plane as the brace in the model. This is used
for skewed braces. It automatically rotates the front view around the x
axis.

• For concrete parts, the option Fixed rotates the front view so that it
shows the casting direction (the face that is top in form) of the
concrete part, if it is defined in the model.

5. To save the changes, click Save.
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6. Click OK and create the drawing.

Rotate parts in drawing views
You can rotate a part, assembly, or cast unit in a drawing view around its local
axes.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load the drawing properties that you want to change.

3. Click View creation and go to the Attributes tab. 

The settings affect all views in a drawing.

4. In Rotate coordinate system, specify the angle: 

• With the Around X, you can rotate in steps of 90 degrees (0, 90, 180,
270).

• With the Around Y, you can rotate in steps of 180 degrees (0, 180).

• With the Around Z, you can specify any angle.

5. To save the changes, click Save.

6. Click OK and create the drawing.

Examples

Below there are some examples of rotating an object around the x axis:
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1. 0 degrees

2. 90 degrees

3. 180 degrees

4. 270 degrees

Below is an example of rotating the same part 180 degrees around the y axis:

Below is an example of rotating the same part 30 degrees around the z axis:
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See also

View properties in drawings (page 920)

Select the steel or timber part face that is shown in front drawing view
You can select which face of a steel or timber part is shown in the drawing
main (front) view by using the user-defined attribute Fixed drawing main
view.

The user-defined attribute Fixed drawing main view controls the drawing
coordinate system for steel and timber parts. This UDA is only taken into
account when you use the coordinate system Fixed in drawing properties.
When the fixed coordinate system is used, the part is rotated so that the front
view shows the part face that has been selected with the Fixed drawing main
view UDA.

1. In the model, double-click a steel or timber part to open part properties,
and click the UDAs button.

2. On the Parameters tab, click Fixed drawing main view, and select one
of the options: 

• Top

• Back

• Bottom

• Start

• End

• Front

3. Click Drawings & reports --> Drawing properties, and select assembly or
single part drawing properties.

4. Click View creation in the options tree, go to the Attributes tab, and set
Coordinate system to Fixed.

5. Click OK to activate the settings, and create the drawing using the current
settings.
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NOTE If you set the advanced option 
XS_SET_FIXEDMAINVIEW_UDA_TO_AFFECT_NUMBERING to STEEL, TIMBER or 
MISC, and if identical steel, timber or miscellaneous material parts have
different options selected for Fixed drawing main view, they get different
assembly position numbers.

If you have set this advanced option, the Top in form face command is now
available also for non-concrete material in the model.

Set viewing direction for parts in assembly drawings
In assembly drawings, you can define the front view viewing direction
separately for columns, beams and bracings.

NOTE Do not change the viewing direction settings in the middle of the project. If
you change the settings, some drawings may disappear.

For more information about orientation marks, see .

Set viewing direction for columns in assembly drawings

1. On the File menu, click Settings --> Options and go to the Orientation
marks settings.

2. Under Viewing direction, use the Columns in assembly drawing option
to set the front view direction of columns: 

• The values are As beam and bracing, North, East, South and West.
Select As beam and bracing to use the same viewing direction as you
use for beams and bracings. This is the default value.

• If you have set the coordinate system to local in View creation
properties, Tekla Structures uses the coordinate system of the column
when setting the viewing direction of the front view.

• If you have set the coordinate system to oriented, the column is in a
horizontal position, and the viewing direction of the front view is the
option you select (North, East, South or West).

• If you have set the coordinate system to model, the column is in a
vertical position, and the viewing direction of the front view is the
option you select (North,East, South or West).

3. Click OK.

Set viewing direction for beams and bracings in assembly drawings

1. On the File menu, click Settings --> Options and go to the Orientation
marks settings.
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2. Under Viewing direction, use the Beams and bracings in assembly
drawing option to set the front view direction: 

• The values are North or east, North or west, South or east, and
South or west. The default value is North or east.

• If the beam or bracing is parallel to the X axis of the model, it is also
parallel to the X axis in the drawing.

• If you have set the coordinate system to model, and the beam or
bracing is sloped, it is also sloped in the drawing.

3. Click OK.

Change plate orientation in drawings
Plates created with the Plate command are automatically oriented in
drawings. The longest side of the plate always faces downwards in the
drawing. You can affect this orientation.

Example Description
Contour plate in the model view.

1. First creation point

2. Second creation point

Single-part drawing of the contour
plate.

Instead of using automatic plate orientation, you can set the plate main axis to
follow the line created by the first and second points you pick, regardless of
the plate dimensions. This enables you to define the plate orientation in
drawings or reports.

To define the contour plate orientation with first and second picked points:

1. Create the contour plate. 

The first and second points you pick also define the plate’s main axis.
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2. Double-click the plate to open the contour plate properties.

3. Click UDAs, and click the Orientation tab. 

4. Select From 1st to 2nd creation point in the Main axis direction list.

5. Click Modify, and close the dialog box.

6. Click Drawings & reports --> Perform numbering --> Number modified
objects to update numbering.

7. To view the orientation of the plate, create a single-part drawing of the
plate.

Example Description
Contour plate in the model view.

1. First creation point

2. Second creation point

Single-part drawing of the plate.
The user-defined attribute Main
axis direction is set to From 1st to
2nd creation point.

NOTE You can also affect the orientation of the plates using the advanced options 
XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR and 
XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR.

Define automatic drawing settings 705 Define drawing views



Show neighbor parts in drawings
You can select which neighbor parts to show in drawings and also
automatically extend the view boundary if necessary.

Neighbor parts refer to (optionally shown) parts that are close to the part that
is depicted in a drawing. Depending on settings, the neighbor parts may be
parts somehow connected to the part in question, or just parts that happen to
be close by.

For more information about neighbor part properties, see Part and neighbor
part properties in drawings (page 991).

TIP If you do not want to see neighbor part extensions in drawing views, set the
advanced option XS_VISUALIZE_VIEW_NEIGHBOR_PART_EXTENSION to FALSE.

Show neighbor parts in assembly and cast unit drawings
1. On the Drawings & reports tab, click Drawing properties and select the

drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

4. Click Neighbor part...

5. On the Visibility tab, select the parts and that you want to show using the
following options: 

• None does not show neighbor parts.

• Connected parts shows all parts connected to the model object.

• Connecting parts shows only the parts the model object is connected
to.

• All components combines the Connected parts and the Connecting
parts options.

• By extreme show all parts within the boundaries of the main and
secondary part. This setting is affected by the value entered for View
extension for neighbor parts on the Attributes 1 tab.

• Main/Secondary parts: Main parts shows only neighbor parts that
make the main part of an assembly or a cast unit.

• Main/Secondary parts: Secondary parts shows only neighbor parts
that are secondary parts of an assembly or a cast unit.

• Main/Secondary parts: Both shows both main and secondary parts.

• Skew parts: Yes shows skew parts as neighbor parts in the drawing,
No does not show skew parts as neighbor parts.
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• Bolts: Yes shows the bolts in the neighbor parts, whereas No does not
show the neighbor part bolts.

6. On the Content tab, set the representation of the neighbor part and
neighbor part bolts, and which lines and marks are shown

7. On the Appearance tab, set the colors and line types you want to use in
neighbor parts.

8. Click Attributes in the options tree and enter a value by which to extend
the view in the View extension for neighbor parts box. 

Try different values and check which one suits your needs. Often too big
values do not work very well. If you set the value to 0, neighbor part
extension is not shown.

For more information about view properties, see View properties in
drawings (page 920).

9. To save the changes, click Save.

10. Click Close to return to drawing properties.

11. Click Save to save the drawing properties, then click OK and create the
drawing.

In the following example, View extension for neighbor parts is set to 100.
No neighbor parts are located in this area.

Show neighbor parts in general arrangement drawings
In GA drawings, you need to define neighbor parts using neighbor part filters
because neighbor parts are not automatically detected. The parts that fulfill
the filtering criteria will be treated as neighbor parts. You must also define a
filter for normal parts to get neighbor parts working.

1. On the Drawings & reports tab, click Drawing properties --> GA
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.
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3. Go to the General - Filter Properties dialog box and create a filter by
Part - Name and Object - Object type for all parts that should be treated
as normal parts and click OK.

4. Go to the General - Part Properties dialog box, and on the Content,
AppearanceFill tabs, define the needed part properties. For example,
select a fill that shows the normal parts in a different way than the
neighbor parts. Then OK.

5. Go to the General - Neighbor Part Filter Properties dialog box, create a
filter by Part - Name and Object - Object type for all parts that should be
treated as neighbor parts and click OK.

6. Go to the General - Neighbor Part Properties dialog box, and on the
Visibility tab, selectBy extreme to show all parts within the boundaries
of the main and secondary part. This setting is affected by the value
entered for View extension for neighbor parts on the Attributes 1 tab. 

None does not show neighbor parts.

7. On the Content, Appearance and Fill tabs, define the needed part
properties. For example, select a fill that shows the neighbor parts in a
different way than the normal parts. Then OK.

8. Click View..., and on the Attributes tab, enter a value by which to extend
the view in the View extension for neighbor parts box. 

Try different values and check which one suits your needs. Often too big
values do not work very well. If you set the value to 0, neighbor part
extension is not shown.

For more information about view properties, see View properties in
drawings (page 920).

9. Click OK to return to drawing properties.

10. Click Save to save the drawing properties, then click OK and create the
drawing.

Shorten or lengthen parts
You can use the shortening functionality in the model to make the part longer
or shorter in the drawing than in the model. You can shorten and lengthen
parts also in drawing views.

Lengthening can be useful for adding length to concrete precast parts in the
cast condition while the model stays in the erected state. The most common
use for this is to account for pre-stressing elastic shortening, where the part
actually shrinks a fraction of an inch after casting and after the strands are cut.
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Shorten a part in the model
You can shorten parts in the model. When you do that the true length of the
part is decreased in the drawing.

1. Double-click a part to open the part properties in the property pane.

2. Go to the Deforming tab.

3. In the Shortening box, define the degree of shortening.

4. Click Modify.

When drawings are created, Tekla Structures decreases the true length of the
part by the value defined in the Shortening box. Shortening is applied linearly
along the length in drawings.

TIP To show the dimensions of the shortened part correctly in the drawings, set
Undeformed to Yes on the Attributes tab in the View creation panel in
drawing properties. For more information about undeformed parts in drawings,
see Undeform deformed parts in drawings (page 713).

Lengthen a part in the model
You can lengthen parts in the model. When you do this, the true length of the
part is increased in the drawing.

To have a concrete part lengthened in cast unit drawings, you must enter a
negative value for shortening in part properties.

1. Double-click a part to open the part properties in the property pane.

2. Go to the Deforming section.

3. In the Shortening box, enter a negative value. 

For example, -20 would result in a part that is cast 20 units longer in the
drawing than the part in the model.

4. Click Modify.

Shorten parts in drawing views
If parts are large and do not include any important details, you can shorten
them in drawing views by cutting them.

Parts are only cut in empty areas. If there is something important, for
example, a stiffener in the part, the part is not cut in that area, because that
area is not considered empty.

You can also shorten parts view by view, see Shorten parts view by view
(page 377).

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
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2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

4. Go to the Attributes 2 tab.

5. In Cut parts, select one of the following: 

• Yes to cut in both X and Y direction.

• Only in x direction

• Only in y direction

6. In Minimum cut part length and Space between cut parts, select how
to cut the middle regions of the parts in drawing views. 

The Minimum cut part length defines how long the part must at least be
to get shortened. The length of the part must be at least twice the entered
value.

The Space between cut parts defines the distance between cut parts on
paper. For example, try 3.0 mm.

7. Set Cut skew parts to Yes to also cut skew parts in views.

8. To save the changes, click Save.

9. Click Close.

10. Click Save to save the drawing properties, then click OK and create the
drawing.

Related advanced options

• You can show view shortening symbols in drawings by setting the
advanced options 
XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS and 
XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS to TRUE
through File menu --> Settings --> Advanced options --> Drawing
Properties .

• You can also control the appearance of the view shortening symbol with
the advanced options XS_SHORTENING_SYMBOL_COLOR, 
XS_SHORTENING_SYMBOL_LINE_TYPE, and 
XS_SHORTENING_SYMBOL_WITH_ZIGZAG.

Examples

Below is an example of a part before and after cutting. Note that the width is
the same in the non-cut and cut part. Minimum cut part length is 1' 4" and
cut length is 3/8".
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The following example describes the meaning of Minimum cut part length,
Space between cut parts, and an area that is not considered to be empty in
the part, and therefore the part is not cut. Minimum cut part length is set to
650, which means that the part is shortened in the view at 650.

1. Space between cut parts is set to 1. This means the distance between
cut parts on paper (not in model).

2. There is not enough empty area between the stiffeners, and that is why
the part is not shortened at Minimum cut part length.

Below is an example of using the advanced options 
XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS and 
XS_SHORTENING_SYMBOL_WITH_ZIGZAG.
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Lengthen shortened parts in drawing views
You can stretch shortened drawing views to fill up empty areas of the
drawing .

After Tekla Structures has scaled drawing views and selected the drawing size,
it may stretch shortened views to fill up empty areas of the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Layout and go to the Other tab.

4. Set Expand shortened parts to fit to Yes.

5. To save the changes, click Save.

6. Click OK and create the drawing.

Unfold polybeams in drawings
When you create a drawing, you can automatically unfold polybeams and bent
plates in single-part drawings. Tekla Structures unfolds the polybeams
according to unfolding parameters, which define the location of the neutral
axis when a profile is unfolded.

Limitations:

• You can unfold only beams that have been created with the Polybeam
command. You cannot unfold beams created with the Curved beam
command.
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• You can unfold a polybeam only on one plane.

1. On the Drawings & reports tab, click Drawing properties --> Single-part
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree and go to the Attributes tab.

4. Set Unfolded to Yes.

5. To save the changes, click Save.

6. Click OK and create the drawing. 

Tekla Structures unfolds the polybeam in the single-part drawing.

NOTE The Unfolded setting in the View Properties properties dialog
box on the Attributes 2 tab is ignored in drawing creation when
you set this option on the Attributes tab of the Single-Part
Drawing Properties dialog box.

See also

View properties in drawings (page 920)

Undeform deformed parts in drawings
You can undeform warped or cambered parts and show the developed
(undeformed) shape of deformed parts in drawings.

Deformed parts are parts that have been warped or cambered in the model.
You may want to undeform these parts if you want a concrete part to have two
states: as erected (in the model view) and as cast (in the drawing view), for
example.

NOTE Part shortenings are hidden if you set Undeformed to No.
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1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation and go to the Attributes tab.

4. To hide deforming angles and cambering, set Undeformed to Yes.

5. To save the changes, click Save.

6. Click Close.

7. Click Save to save the drawing properties, then click OK and create the
drawing.

The created drawing shows the developed shape and dimensions of the part.

See below for an example of a undeformed part in a drawing.

See below for an example of a warped part in a drawing.

NOTE The Undeformed option value in the View Properties properties dialog box
on the Attributes 2 tab is ignored in drawing creation when the Undeformed
option is set to a value on the View creation --> Attributes tab.

See also

View properties in drawings (page 920)
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Show part openings and recesses in drawings
You can select whether you want to show symbols for part openings and
recesses (blind holes) in drawing views.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Depending on the drawing type, do one of the following: 

Single-part, assembly and cast unit drawings:

a. Click View creation in the options tree on the left, select the view and
the properties that you want to change, and click View properties.

b. Go to the Attributes 2 tab.

c. Set Show openings/recess symbol to Yes.

d. Save the view properties and click Close.

General arrangement drawings:

a. Click View...

b. On the Attributes tab, set Show openings/recess symbol to Yes.

c. Click OK.

4. Click Save to save the drawing properties, then click OK and create the
drawing.

By default, Tekla Structures displays openings and recesses in the following
way:

Type of opening Shown as Examples
Hole through a part Hole symbol

Recess in the front face
of a part

Recess symbol and
bounding lines shown as
unbroken lines

Recess in the back face
of a part

Recess symbol and
bounding lines shown as
dashed lines

Remember to switch
hidden lines on for parts.
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Add symbols in openings and recesses

Tekla Structures has some advanced options that you can use for adding
symbols in openings and recesses in your drawings.

1. On the File menu, click Settings --> Advanced options and go to
Drawing Properties.

2. Set the advanced option XS_USE_CROSS_FOR_OPENING_SYMBOL to 
FALSE to show the openings and recesses as follows:

3. Set XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES to TRUE to show
opening/recess symbols in openings located at part borders. This
advanced option is by default set to FALSE. The symbol used depends on
the setting of the advanced option 
XS_USE_CROSS_FOR_OPENING_SYMBOL.

4. Set XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES to TRUE to show
opening/recess symbols in openings located in part corners. This
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advanced option is by default set to FALSE. The symbol used depends on
the setting of the advanced option 
XS_USE_CROSS_FOR_OPENING_SYMBOL.

See also

View properties in drawings (page 920)

Define drawing views (page 687)

Define automatic section view properties
You can set some automatic properties for section views before you create a
drawing. Properties for automatic section views need to be set in two places in
drawing properties: in the Section view pane, and in View creation --> View
properties . The settings on the Section view pane apply to all section views
in the drawing.

For a list and descriptions of section view properties, see Section view
properties (page 927).

Define automatic section view properties
Note that for general arrangement drawings, you can only modify the Start
number or letter of section view and symbol label setting.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Section view.
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4. On the Attributes tab, set values for either Fit by parts or Section depth
and Distance for combining cuts. Remember to select the Size check
box first: 

• Fit by parts setting works as an alternative to Section depth and
Distance for combining cuts, and it shows the whole part in the
sections.

• Section depth defines the positive and negative depth of the section
view when sections are not combined. In an open drawing, you can
adjust the section view depth also by dragging the view boundary.

• Distance for combining cuts defines the distance range for
combining cut views.

• You can additionally control which section views get combined using
the advanced option 
XS_DRAWING_CUT_VIEW_COMPARISON_CRITERIA.

5. Still on the Attributes tab, set the direction of the Left section, Middle
section and Right section to left or right.

6. Go to the Cutting line tab and set the section mark line length and offset
(distance between the section mark and the section).

7. Go to the Section mark tab and modify the section mark settings:

a. Click the ... button next to A1 - A5 to open the Mark Contents dialog
box.

b. Select the elements that you want to include in the mark.

c. If needed, select an element from the list and click < Add frame and
select the frame Type and Color.

d. If needed, select an element from the list and select the text Color,
Font and Height.

e. Go to the Position tab and select the side to show the text, the text
position, the horizontal and vertical offset, and the text rotation
options.

f. In Start number or letter of section view and symbol label, select
whether you want to start the section view and section symbol labels
with a number or a letter: 

• You can enter any number starting from 1, or any letter A - Z or a -
z (also shown in uppercase in the label).

• If you use a letter, and the entered string is longer than one letter,
only the first letter is shown. If you use numbers, all entered
numbers are shown.

• The start number in the label changes only when you change it in
the drawing properties before creating a drawing, and when you
change it in an existing drawing and recreate the drawing, in
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which case the labels for all automatically included section views
and all new section views will change.

g. Click OK to return to drawing properties.

8. Click View creation and add the section and end views you want to
create.

9. Still in the View creation panel, select the view and the properties that
you want to change and click View properties.

10. Adjust the view properties as required.

11. Click Save to save the view properties.

12. Click Close.

13. Repeat steps 9 - 12 for all the section and end views you create.

14. To save the changes, click Save.

Examples of section view and mark settings

Combining section views

1. Distance for combining cuts = 1’- 4"

2. Section depth = 4"

3. Combined sections

Section view direction

The arrow in the section view symbol indicates the direction of the section
view, as shown below:
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1. Left section, right direction

2. Middle section, right direction

3. Right section, left direction

Section marks

See below for examples of section marks:

Show section and end view direction marks in drawings
You can display view direction marks in section views and end views in
drawings.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties. 

In this case, select a section view or an end view.

4. Go to the Label tab in View Properties.
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5. Select one of the options in View direction marks: Show marks: 

• Symbol only

• Label only

• Symbol and label

• None does not show any marks.

6. Define the height of the symbol and text label in Height. 

If you try to use 0, you will get an error message.

7. To save the changes, click Save.

8. Click Close.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

The view direction mark is shown with a small symbol (optionally with a text
label) around the end or section view.

The view orientation mark position follows the label position setting. In the
image below, Center by view restriction box has been selected for the label.
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Tips

• You can drag view direction marks to a better place in a drawing view: click
the view frame to activate the handles, point the handle, press and hold
down the left mouse button and drag. The view frame is resized
automatically, if necessary.

• You can define the view direction mark symbol in File menu --> Settings --
> Advanced options --> Drawing Properties by using the following
advanced options:

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT

• XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP

The default symbol is xsteel@66.

Define the location for end views and section views
You can always place section views and end views next to the main view or in
any empty location in a single-part, assembly, and cast unit drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Layout and go to the Other tab.

4. Set Align end views with main view to Yes to place the views next to the
main view.

5. Set Align section views with main view to Yes to place the views next to
the main view.

6. To save the changes in a drawing properties file, click Save at the top.
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7. Click OK and create the drawing. 

If you select No, Tekla Structures places the section and end views in any
available location.

Example

End and section views in any location (No selected).

End and section views beside the main view (Yes selected).
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8.5 Define dimensioning
Dimensions are associative annotation objects that represent building object
measurements. Dimensions are more than lines or vectors; they are
interactive callouts of geometry. In automatic dimensioning Tekla Structures
creates dimensions in the whole drawing or in drawing views based on
dimensioning settings you define before creating the drawing.

In single-part, assembly and cast unit drawings automatic dimensions are set
view by view.

In general arrangement drawings, automatic dimensions are set for the whole
drawing.

You can define automatic dimensions settings before you create a drawing
and you can also modify the settings after you have created the drawing.

To Click the links below to find out
more

Create automatic dimensions in
single-part, assembly or cast unit
views

What are automatic view-level
dimensions (page 725)

Add automatic view-level dimensions
(page 729)
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To Click the links below to find out
more

Check the settings affecting
dimension creation, and have a look
at some examples

Dimensioning rule properties
(page 743)

Create a filter that is needed in view-
level dimensioning for selecting the
objects that you want to dimension

Create a drawing view filter for view-
level dimensioning (page 758)

See examples of different
combinations of dimensioning types
and settings

Various scenarios of using different
dimensioning types (page 767)

Use the traditional way of
dimensioning in the Dimensioning
dialog box by using the dimensioning
type Integrated

Add automatic view-specific
dimensions using dimensioning type
Integrated (page 771)

Create dual dimension tags
automatically in all types of drawings

Add automatic dual dimensions
(page 795)

Control the dimensions that Tekla
Structures adds for unfolded parts

Add dimensions to unfolded parts
(page 796)

Create minimum and maximum
position dimensions for bolts

Add minimum and maximum position
dimensions to bolts (page 798)

Add extensions to dimension lines Create dimension line extensions
(page 799)

Adjust extension line settings Set the dimension extension line
length (page 272)

Adjust absolute dimensions Change the appearance of absolute
dimensions (page 799)

Exaggerate narrow dimensions to
make them easier to read

Create exaggerated dimensions
(page 800)

Use another prefix in radial
dimensions

Change the prefix in radial
dimensions (page 802)

Dimension plates using advanced
options

Add dimensions to plates (page 802)

Adjust profile dimensioning using
dimension planes table

Add dimensions to profiles
(page 805)

See examples of sloped dimension
texts

Sloped dimension texts (page 808)

Add automatic dimensions in general
arrangement drawings

Add automatic dimensions to general
arrangement drawings (page 808)
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What are automatic view-level dimensions

Automatic view-level dimensioning gives you full control on the dimensions in
each drawing view you create, with a lot of dimensioning options. Automatic
view-level dimensioning can be used in single-part, assembly and cast unit
drawings.

In view-level dimensioning, the dimensions are created based on the rules you
define. You can define what you want to dimension, where the dimensions are
placed, in which order they are created, and which settings you want to use for
each dimension. You can dimension shapes and holes, for example.

Below you can find short description on how to proceed in dimensioning.

1. When you click the View creation option in the options tree in drawing
properties, you are able to select the views to be created and the view
properties to be used.

2. Click View properties.

3. Click Dimensioning in the options tree.

In the Dimensioning panel, you can add rules by clicking Add row. Then
select which dimensioning rules you want to use in the Dimensioning
type column and the desired dimensioning rule properties file.
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4. You can modify the selected rule by clicking Edit rule.

In the Dimensioning rule properties dialog box, you can select what to
dimension, how to dimension, which objects to measure from, where to
place the dimensions, and select the dimension properties. The
Properties list contains properties files that you have saved in the object
level Dimension Properties dialog box in an open drawing. For example,
you may want to use some special font or color in the dimensions. To do
this, double-click a dimension in a drawing, make the necessary changes
and save the properties file. Then you can load the properties here.

To select different dimension line properties for each side, deselect the
Same on all sides and select the dimension properties from the lists.
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If you select Integrated dimensions, the Dimensioning Properties
dialog box is displayed. Make your changes to the settings on the tabs and
save the properties file with a unique name using Save as. You can also
load dimension properties here as well.

5. When you have set the rule properties, give a name to the rules file and
click Save As.

6. Click Close to return to the Dimensioning panel.

7. Ensure that you have selected correct dimensioning properties files for
the dimensioning rules.
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8. Enter a unique name for the view properties in the box at the top of the
View Properties dialog box and click Save.

Now you can select the saved view properties for a view in the View creation
panel. These view properties contain the saved dimensioning properties.

See also

Dimensioning rule properties (page 743)

Add automatic view-level dimensions (page 729)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Add automatic view-level dimensions
The next examples will go through the basic workflow of creating automatic
dimensions on view level. The goal is to create drawing properties that you can
use later on to create similar drawings, including all necessary views, having
the dimensions that you want, just by loading the appropriate drawing
properties file and then creating the drawing.

If you want to use Integrated dimensions, see Add automatic view-specific
dimensions using dimensioning type Integrated (page 771), or dimension
spiral beams, see Dimension spiral beams (page 391).

The workflow consists of four tasks:

1. Create drawing properties

2. Define drawing views and drawing view settings

3. Define dimensioning rules

4. Create and apply dimensioning rule properties

Define the drawing properties file
Create a drawing properties file that will pull together all the settings that you
define in drawing properties, including view-level dimension settings.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
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2. In drawing properties, load the properties that you want to use as a basis
for the new properties by selecting from the list at the top. 

If you do not have any suitable drawing properties available, give the
drawing properties file a unique name and save the properties by clicking
Save.

Now you have created a drawing properties file where you can save the new
dimensioning settings.

Define the drawing views to be created
Create the desired views and define the view properties to use:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load the drawing properties that you created and saved in the phase 1 of
this workflow.

3. Click View creation in the options tree.

4. In the next panel, click Add row to add new views in your drawing. 

5. For those views that you want to create, set the on/off control to On. 

If you select Auto, the view is created if relevant dimensions are created
with the used dimensioning settings. If relevant dimensions are not
created, neither is the view. Tekla Structures can automatically decide
whether dimensions are relevant or not.

Now you have defined the views that you want to have in the drawing you will
create. You can save the list of views using Save, and then load it if you need
the same set of views in another drawing.
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Define view dimensions
Define the dimensioning rule properties to be used in the drawing views that
you just created.

If you are planning to use filters to select the parts that you want to
dimension, you need to create the drawing view filters first, for example, for
selecting embeds, inner panels or outer panels.

You need to create separate dimensioning rules for each dimensioning type.
For example, the rules made with Overall dimensions are valid for Overall
dimensions only, not for Shape dimensions, for example.

1. Select a view in the View creation panel and click View properties.

2. In the View Properties dialog box, click Dimensioning in the options tree
to define the dimensions to be created for the selected view.

3. Click Add row to add a rule. 

Here we add two rows.

The order of the rules in the list defines the order of the dimension lines
in the drawing: the dimension created by the first rule is placed closest to
the dimensioned object

At the moment, the filter can only be set for the Integrated dimensions
in this panel. You are able to select the filter in the Dimensioning rule
properties dialog box, and you can leave the selection Current assembly
in the Filter column for all rules.

Leave Current assembly in the Filter column.

4. Select the Dimensioning type for the selected rules. 

Here we select overall dimensions and hole dimensions:
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5. Click one of the rules and click Edit rule.

6. Depending on the selected dimensioning type, a specific Dimensioning
rule properties dialog box is displayed. Do one of the following: 

• For most of the dimensioning types, you need to define what to
dimension, and where and how to place the dimensions. From the
Dimension properties list, select a suitable set of saved dimension
properties to change the dimension appearance, dimension text font
size or color, for example. If you want, you can define different
dimension line properties for each side by deselecting Same on all
sides and selecting different dimension properties.

• If you have selected dimensioning type Spiral beam dimensions,
select predefined dimension properties. If none of the available
properties suit your needs, open a drawing, click Drawing -->
Properties --> Dimension when a drawing is open, and edit and save
the needed dimension properties so that they are available for
selecting in the spiral beam Dimensioning rule properties dialog box
for the three dimension types.
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7. Give the dimensioning rule a unique name and click Save As.

8. Click Close.

9. Define other dimensioning rules needed for the view following the steps 5
- 8.

10. Select correct properties for the rules. 

Even though the dimension lines are created and placed by default in the
order that you define them in the View creation panel, Tekla Structures
searches for the first suitable location for the dimension lines according to
the placement and protection settings. So the dimension placement may
not always follow the creation order. Check the result and adjust the
location of the dimension lines if necessary.

11. In the top-left corner, give a unique name to the view properties and click
Save to save your changes to the view properties file. 
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Now you have created new view properties containing two types of
dimensions. You can connect this properties file with a drawing view and use
the defined dimensions in that view.

Connect view properties to views and save drawing properties
Connect then new view properties to drawing views and save drawing
properties.

1. In the View creation panel, select correct view properties for the views
that you are creating. 

In the example below, one front view and one section view are created,
and the views have been connected to view properties cu_FRONT and 
cu_SECTION .

2. Remember that you created or loaded the drawing properties file in
phase 1 of this workflow. Click Save to save the drawing properties, then
click OK and create the drawing.

Tekla Structures creates the drawing according to the definitions in various
properties files.

Example workflow: Create automatic overall and hole dimensions on
view level

In this example workflow, you will create a cast unit wall panel drawing that
contains

• one front view with automatic overall and hole dimensions

• one section view with overall dimensions

In overall and hole dimension rules you will apply the dimension properties
that you have earlier created and saved manually in a cast unit drawing. You
will save the created dimensioning rule properties in view properties. Finally,
you will save the created view properties in drawing properties and create a
cast unit drawing.

Define automatic drawing settings 734 Define dimensioning



Before starting, create manually in the object-level ’ dialog box in an open cast
unit drawing a dimension properties file dim_font_5, where the dimension
text font size is 5.00, and a dimension properties file dim_red, where the
dimension color is red.

In this example, you are going to dimension the following cast unit wall panel
in the model:

Define the views to be created

1. On the Drawings & reports tab, click Drawing properties --> Cast unit
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree.

4. In the View creation panel, click Add row to add new views in your
drawing.

In this example, you want to add two views, one front view and one
section view.
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5. Set the on/off setting to On for the views that you want to create.

If the list contains extra views, set them to Off or use the Delete row button
to delete them.

Now you have defined the views that you want to create. Next, you need to
define the dimensions that you want to have in the front view and section
view.

Define front view dimensions

1. Select a view in the View creation list.

In this example, select one Front view.

2. Click View properties and then click Dimensioning in the option tree to
define the dimensions to be created in the front view.

3. In the Dimensioning panel, use Add row to add two new dimension rules
in the dimensioning rules list.

4. Select Overall dimensions as the first rule and Hole dimensions as the
second.

The order of the rules in the list defines the order of the dimension lines
in the drawing: the dimensions created by the first rule is placed closest to
the dimensioned part.

Leave Current assembly in the Filter column for both rules.
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5. To the define overall dimension rules, click the Overall dimensions row,
and click Edit rule.

6. In the Dimensioning rule properties dialog box, define what to
dimension, where and how to place the dimensions, and which dimension
properties to use.

• Select the check boxes above and on left side of the object, and also
the check box in the upper-left corner to link the dimensions together.

• Use default values in the Start point lists. The default values are left
for the Horizontal and bottom for the Vertical dimension.

• From the Dimension properties list, select a suitable set of saved
dimension properties. In this example, select the dimension properties
file dim_font_5, which contains a definition for a larger font.

• Give the dimensioning rule a unique name and click Save As.

In this example, the name overall is used.
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7. Click Close.

8. Next, define the hole dimensions. In the Dimensioning panel, select Hole
dimensions from the dimensioning rules list and click Edit rule.

9. Create dimensioning rules for hole dimensions:

• Select the check boxes above and on left side of the object, and also
the check box in the upper-left corner to link the dimensions together.

• Use the default values in the Start point lists.

• In Close lines, select the setting that extends the dimension lines to
the other end of the cast unit.

• In Dimension to, select the setting that dimensions to both ends.

• From the Dimension properties list, select a suitable set of saved
dimension properties. In this example, select the dimension properties
file dim_red containing a definition for red dimensions.

• Give the hole dimensioning rule a unique name and click Save As.

In this example, the name hole is used.
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10. Click Close.

11. For the Overall dimensions rule, select overall properties, and for the
Hole dimensions rule, select hole properties from the Properties
column.

12. In the View Properties dialog box, give the front view properties a unique
name and click Save.

In this example, the front view properties are saved with the name
CU_Front.

Now you have saved the view properties for the front view containing overall
and hole dimensions. Leave the View Properties dialog box open for further
modifications.
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Define section view dimensions

A section view is also needed in the cast unit drawing, because you want to
show the wall thickness. Next, you will create overall dimensions for the
section view.

1. In the View creation panel, select the Section views row and click View
properties.

2. Load the view properties file CU_Front.

You can start creating new view properties on the basis of already existing
view properties.

3. Click Dimensioning in the options tree.

4. In the Dimensioning panel, delete the unnecessary hole dimension rule
by clicking the Hole dimensions row and Delete row.

You will only need the overall dimensions in the section view.

5. Click the Overall dimensions row and click Edit rule.

6. Create a dimensioning rule for the overall dimensions in the section view:

• Select the check box below the object only, because you only want to
show the thickness.

• Select the same dimension properties as for the overall dimensions in
the front view, because you want to show the dimension text with a
little bit larger font: dim_font_5.

• Give the rule a unique name and click Save As.

In this example, the name thickness is used.

Define automatic drawing settings 740 Define dimensioning



7. Click Close.

8. In the Dimensioning panel, select thickness in the Properties column
as the property file for the overall dimensioning rule.

9. Give a unique name for the section view properties and click Save As.

In this example, the name CU_Section is used.

10. Click OK.

Now you have saved the view properties for the section view containing
overall dimensions.

Connect view properties to views and save drawing properties

1. In the View creation panel, select CU_Front for the front view and
CU_Section for the section view.

2. In the Drawing Properties dialog box, give the drawing properties a
unique name and click Save.

In this example, the name cu_wall_panel is used.
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3. Click OK and create the cast unit drawing.

Tekla Structures creates the cast unit drawing according your definitions in
different properties files. The cast unit drawing contains a front view and a
section view. The overall dimensions in both views have a little bit larger font,
and the front view has red hole dimensions. Only the wall thickness is
dimensioned in the section view.

You can use the drawing properties file cu_wall_panel later on when you
need drawings with similar settings.
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TIP You can still change the dimensioning settings in the views after creating
the cast unit drawing:

1. Double-click the drawing view frame to open the view properties
dialog box.

2. Click Dimensioning in the options tree to open the Dimensioning
panel where you can select and then edit the dimensioning rules.
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Dimensioning rule properties

The following table describes the options and their settings in the
Dimensioning rule properties dialog box. This dialog box can be opened by
selecting View creation in a Drawing Properties dialog box, selecting a view
row and then clicking View properties --> Dimensioning --> Edit rule .

If you have selected Integrated (page 771) as the dimension type, the
Dimensioning properties (page 949) dialog box will be displayed instead.

Dimensioning rule properties

Setting Description
What is dimensioned Sets the dimensioning type:

• Overall dimensions creates dimensions for the
bounding box of the objects you select in the
Measure from list.

• Edge shape creates dimensions for the edge of
the object selected in the Measure from list.

By selecting the Visible faces option,
dimensions will be created only to faces that
are visible in the drawing view. The other
option All faces dimensions all faces. All faces
is the default value, and it will be used if the
dimension settings file does not contain any
value for the new setting.

For sandwich walls, the default setting Cast
unit / Assembly may not give the desired
result with Edge shape. Then you can
dimension the internal and external layers
separately according to the part name.

• Secondary parts creates dimensions for the
secondary parts of a cast unit or an assembly.

• Holes creates dimensions for the holes of the
objects selected in the Measure from list. The
hole dimensions are combined according to the
Combine on one line setting.

NOTE: The Holes dimensioning type does not
dimension bolts, you need to use the
Integrated dimensions to get the bolt
dimensions.

• Recesses creates dimensions for the recesses
of the objects selected in the Measure from
list. The hole dimensions are combined
according to the Combine on one line setting.
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Setting Description
• Distance to grid creates dimensions from the

grid line to the bounding box of the object
selected in the Measure from list. This setting
works only when the grid lines are visible.

• Filter can be used to dimension anything that
can be filtered. It is often used when
dimensioning embeds. For example, you can
dimension bolt locations after you have created
a filter for bolts.

When you select Filter from the What is
dimensioned list, a list is displayed where you
can select the filter. The filter is a drawing view
filter and you need to create it beforehand to
be able to use it here.

Dimension line
location and linking

Controls on which sides of the cast unit the
dimensions will be created.

• Dimension line locations are rotated together
with the drawing view if the view is manually
rotated.

• When selecting both sides, top and bottom or
left and right, the objects will be dimensioned
on the side that is closest to the object.

• When only a part of the cast unit is selected for
the rule, one of the check boxes will be dimmed
and you cannot select it.

• When you have selected one vertical and one
horizontal dimension line, the linking check
boxes in the corners are activated, and you can
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Setting Description
link the perpendicular dimension lines. The
check boxes are dimmed by default.

• You can select objects for dimensioning from
the whole cast unit or only from one half of the
cast unit. If you do this, objects in the other half
will be ignored in dimension creation. The
default value is the whole cast unit.

Place dimensions
inside

When you select this setting, the dimensions can
be placed inside a cast unit, assembly or part.

This is only visible for the dimensioning type Filter
dimensions.

Orientation Orients the dimensions along the sloped edge of a
part. Another possibility is to create horizontal or
vertical dimensions.

• This option is visible only when the
dimensioning type Filter or Edge shape is
selected.

• When Filter is selected, there are two settings
available for orientation.

The first setting places the dimensions along
the sloped edge:
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Setting Description

The second setting places the dimensions
horizontally and vertically:

• When Edge shape is selected, there are three
settings available for orientation. First two
settings work in the same way as the first two
Filter settings. The first setting is the default
value. The third one creates both dimensions:

Minimum length for
skew section

Defines the minimum length of skewed sections
when dimensions are still created for skew
sections. The default value is 300 mm. For
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Setting Description
example, when you use the value 500 mm and the
skew section is shorter than 500 mm, the
dimensions are not created along the skew section,
but horizontally and vertically instead.

Start point Defines where the origin points for the dimensions
are:

• The default values are left for the Horizontal
and bottom for the Vertical dimension.

•
The setting marked with symbol  chooses
the nearest edge as the dimension origin, for
every dimension separately. In the example
below, the object is closer to the right edge, and
so the horizontal dimension starts from there.

Vertical = Horizontal Often the settings are similar for both directions,
and when this option is used, only vertical settings
need to be set.
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Setting Description
Close lines Defines whether the dimension lines extend to the

other end of the cast unit or assembly or not

. The dimension lines extend to the other end
by default.

Dimension to Defines which points of the selected objects are
dimensioned:

• Both ends is the default.

• If you select the center point setting and the
object is a custom part (=embed), Tekla
Structures will use the component insertion
point, which is not always in the center. For
other objects, the actual center point will be
used.

Round holes Defines whether the round holes will be

dimensioned by center point or diameter

:

• This option is visible only when Holes or
Recesses is selected.

• The diameter is the default value.

• Currently, round holes are identified only by cut
part profile (prefix D). If you create the round
hole using round chamfers, for example, the
hole will not be dimensioned.

Dimension properties Select and apply dimensions line settings defined
in the dimension properties file that has been
saved earlier in theDimension Properties dialog
box in a drawing. The default value is standard.

If you select Same on all sides, the settings in the
same dimension properties file are used on all
sides. If you deselect Same on all sides, you can
select and apply different dimension line
properties for Top, Bottom, Left and Right side.
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Setting Description
Measure from Defines the objects that will be used as the origin

point for the dimensions. The available settings
are:

• Cast unit/Assembly: This is the default value. If
you select this setting, you have three more
settings available:

• Only concrete/steel parts: For a cast unit,
only concrete parts are used, and for steel
only steel parts.

• All parts

• All parts and rebars

• Main part: This setting uses cast unit or
assembly main part.

• Part name: If you select Part name, you can
define the part name.

• Filter: If you select Filter, you can use a
predefined filter for selecting the objects that
you want to use as dimension origin points.

• Current part: Select Current part when you
are dimensioning a single part.

• Bounding box: Uses the bounding box of an
object as the origin point for the dimensions.
This option is only available in filter, hole,
recess and secondary part dimensioning.

• Nearest edge: Uses the nearest edge an object
as the origin point for the dimensions. This
option is only available in filter, hole, recess and
secondary part dimensioning.

• And grid: Adds grid lines to the dimensions.
This option is only available for the Overall
dimensions, Shape dimensions, Filter
dimensions, Secondary parts dimensions,
Hole dimensions, and Recess dimensions
dimensioning types.

Combine on one line Creates a rule based on a filter, for example, for
embeds (EB_*), and then groups the embeds
according to the main part name, so that embeds
with different names will get their own dimension
lines. The filtered object can be a part, a reinforcing
bar or an assembly. The available settings are:

• All objects (default)
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Setting Description
• By name

• By position number

• No

When Holes or Recesses is selected, the Combine
on one line option changes to display suitable
settings for holes or recesses. The available
settings are:

• All holes (default)

• Any holes of the same size

• By cut part name

• No
Combine only objects
that have the same

X or Y coordinate

Z coordinate

Combines only the dimensions of objects that are
on the same horizontal or vertical line, or
dimensions of objects that have the same Z
coordinate. By default, these options are not
selected.

Tolerance The tolerance is the maximum distance between
objects when Tekla Structures still considers the
objects to be on the same line. 50 mm is the
default value.

Preferred combining
direction

Sets the preferred direction for combining
dimensions if an object can be combined both in
horizontal and in vertical direction. X is the default
value.

Do not create
dimensions shorter
than

Defines the minimum length of the dimensions for
Tekla Structures to create them. 0 is the default
value, which means that all dimensions are
created.

Do not dimension
holes smaller than

Defines the minimum diameter for the holes for
Tekla Structures to create the dimensions.

With this option you can prevent the creation of
dimensions for small holes. The distance is the
shortest dimension of a hole. If any dimension of
the hole is larger than the given value, the hole will
be dimensioned in all directions. For example, with
value 40, a rectangular hole of 80*30 will get both
dimensions 80 and 30. Default value is 0, which
means that all dimensions are created.

Component objects Defines how component objects are dimensioned:

• By reference points (default) places the
dimensioning point to the first insertion point
of the component. Only one dimension will be
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Setting Description
created for each component regardless of the
number of parts inside the components.

• As secondary objects creates separate
dimensions for each part inside the
component.

Dimension rule properties for spiral beam dimensioning

When you select dimensioning type Spiral beam dimensions, and click Edit
rule, a different Dimensioning rule properties dialog box is displayed.

Setting Description
Straight dimensions

Angle dimensions

Angle and radius
dimensions

Select predefined dimension properties. If none of
the available properties suit your needs, open a
drawing, click Drawing --> Properties -->
Dimension, and edit and save the needed
dimension properties so that they are available for
selecting in the spiral beam Dimensioning rule
properties dialog box for the three dimension
types.

Examples of dimensions

See below for examples of dimensions created with different settings in the
Dimensioning Rule Properties dialog box.

Overall dimensions

Edge shape

Define automatic drawing settings 752 Define dimensioning



Secondary parts

Holes

Recesses
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Distance to grid

Filter: Embeds
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Filter: Surface treatment

Filter: Bolts

To get the location of every bolt in the bolt group dimensioned, set Dimension

to to midpoint :
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Filter: Reinforcing bars and strands

Use the midpoint option to dimension each bar in a group:

Start point and end point option  will dimension the first and the last
reinforcing bar in a group:
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If you want to have separate dimension lines for reinforcing bars that are not
of the same size, set the Combine on one line to By position number:

To make the rule creation easier, the midpoint setting of the Dimension to
option works so that it will create dimensions to start point and end point of
the reinforcing bars that are parallel to the view plane:

If you want to get different size of reinforcing bars on separate dimension
lines, set Combine on one line to By position number:
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Add automatic view-level dimensions (page 729)

Create a drawing view filter for view-level dimensioning (page 758)

Dimension and dimensioning properties (page 928)

Spiral beams in drawings (page 390)

Create a drawing view filter for view-level dimensioning
You need to create a drawing view filter to use the Filter dimensions
dimensioning type in view-level dimension creation in single-part, assembly
and cast unit drawings. The filter needs to be created on view level, because
you create the dimensions view by view.

Create a drawing view filter
You need to create a drawing view filter to use the Filter option in view-level
dimension creation in single-part, assembly and cast unit drawings. The filter
needs to be created on view level, because you create the dimensions view by
view.

NOTE If the performance becomes a problem, you can try using a selection
filter instead of a drawing view filter. If you want to improve the
performance of dimensioning, check if you have some rules that are
not creating any dimensions and remove them. Every rule consumes
time even if it does not find any objects to dimension.

1. In an open drawing, double-click the drawing view frame to open the
View Properties dialog box.

Define automatic drawing settings 758 Define dimensioning



2. Click Filter.

3. Click Add row and define the filter properties. 

• Add a row first to define the Object type object category. This needs
to be defined for all drawing view filters that are going to be used in
dimensioning definitions. Set the Value to Part or Reinforcing
barReinforcing bar

• Then add a filter row that selects all parts in a specific class, for
example.

4. Use Save to save the filter with a unique name.

5. Click Cancel to close the dialog box.

Now you can select the drawing view filter from the filter list in the
Dimensioning rule properties dialog box and use it for dimensioning. If the
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filter is not displayed immediately after creation, refresh the list by closing and
opening the dialog box.

For more information about rule properties, see Dimensioning rule properties
(page 743).

Create a filter for holes and recesses
You can create a filter for cut parts. The filter can be a drawing view filter or a
model selection filter.

To create a model selection filter for holes and recesses:

1. Click the Selection filter button  on the Selecting toolbar.

2. In the Object Group - Selection Filter dialog box, add the first row: 

• Select Object as category, Object type as property and Equals as
condition.

• To fill 11 in the value, use Select from model, and select a cut part.

3. Add the second row: 

• Select Template as category, enter NAME in uppercase as property and
select Equals as condition.

• Enter the name of the template as the value.

4. Select check boxes Selection filter and All drawing types. 

Too see all available filter types, click 

5. Save the filter with a unique name using Save as. 
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For more information about creating filters, see .

Create a filter for the main part of an assembly
When your subassembly consists of many objects, but you only want to select
the main part for dimensioning, you can create a filter for that.
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Create an exclude filter for dimension tag
Often several objects need to be excluded from dimension tag content. You
can exclude everything else from the tag content, except the parts that you
want to include.

With the example filter shown below it is possible to exclude everything else
from the tag content, except cut parts that have the name ‘HVAC’.

Create an exclude filter for stirrups in section views
The view-level dimensioning currently dimensions reinforcing bar polygon
points along the center line of the reinforcing bar. You can filter, where
stirrups (shape 14) are excluded but all other reinforcing bars are
dimensioned.

Below is an example of a stirrup in section view. In some cases, the resulting
dimensions are created similarly regardless of the hook type.
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To avoid this kind of results, you can use suitable filtering criteria. See below
for an example of a filter, where stirrups (shape 14) are excluded but all other
reinforcing bars are dimensioned.

Dimensioning method of shapes, holes and recesses
The logic and functionality of shape dimensions, hole dimensions and recess
dimensions in view-level dimensioning is clear and predictable. The definition,
which geometry is shape, hole or recess is done only once for the object to be
dimensioned, and that definition is used in all drawing views.

The definition of shape and hole is done by looking at the shadow of an object
in three directions X, Y and Z in the following way:

• Points along the outer edge of the shadow are dimensioned as a shape.

• Inner loops in the shadow will be dimensioned as holes.

• All other geometry points that are not visible in the shadow, will be
dimensioned as recesses.

In the image below there are some examples of each geometry type:

1. Holes
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2. Recesses

3. Shapes

Examples

Below is an example of a shape in a model object and the dimensions in a
drawing:
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Below is an example of a hole in a model object and the dimensions in a
drawing:
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Below is an example of a recess in a model object and the dimensions in a
drawing:
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See also

What are automatic view-level dimensions (page 725)

Dimensioning rule properties (page 743)

Various scenarios of using different dimensioning types
Enter a short description of your topic here (optional).

Depending on what you want to dimension and how, you can create different
sets of dimensioning rules to get what you need. Have a look at the examples
scenarios below.

Use view-level dimensioning only
In this scenario, dimension types suitable for precast objects are used only.

Each rule creates one dimension line on selected sides of the cast unit or
assembly. In the image below, four rules have been defined and four
dimension lines are created. Only the first rule (shape dimensions) is
configured to create dimensions on all sides. Other rules are configured to
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create dimensions only on two sides. Rules are executed in the order they
appear in the list; the topmost rule first, then the second, and so on. The first
rule is closest to the part being dimensioned.

Use both view-level dimensioning and integrated dimensioning
Both view-level and integrated dimensioning methods are used.

In this example, integrated, overall and shape dimensions are created for both
top and front view.
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Use integrated dimensioning only
In this scenario, integrated dimensioning is used for creating the reinforcing
bar dimensions.

When you select Integrated dimensions as the Dimensioning type and click
Edit rule in the View Dimensioning Rules dialog box, the Dimensioning
Properties dialog box is displayed. Go to the Reinforcement dimensions tab
and define the desired properties. On the General tab there are some options
for controlling dimension properties, and you can load object level dimension
properties for various dimension types. Save the changes with Save or Save
as to save the properties file for later use.
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When you return to the View Dimensioning Rules dialog box by clicking
Close, you can attached the new integrated dimensioning properties to the
Integrated dimensioning rule.
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Add automatic view-specific dimensions using
dimensioning type Integrated
In the Dimensioning dialog box, you can control what gets dimensioned and
how in a drawing. You can experiment with different combinations of options
to achieve different kinds of dimensioning effects.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

4. Click Dimensioning.

5. Select Integrated dimensions as the dimensioning type, select
dimensioning rule properties and click Edit rule.

6. Select the dimensions to create and adjust the related settings. 

The available tabs and settings depend on the drawing type:

• On the Part dimensions tab, select the part dimensions to create and
adjust the related settings (Dimensioning properties - Part dimensions
tab (Integrated dimensioning) (page 955)).

• On the General tab, adjust settings related to minimizing the number
of views, dimension type, combining dimensions, closing dimensions,
limit for dimensioning asymmetry in secondary parts, forward offset,
grid dimensions, dimension position, and part marks on dimension
line ( Dimensioning properties - General tab (Integrated dimensioning)
(page 949)).
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• On the Position dimensions tab, select the position dimensions to
create. They indicate the position of parts in relation to the main part
or to work points (Dimensioning properties - Position dimensions tab
(Integrated dimensioning) (page 952)).

• On the Bolt dimensions tab, select the bolt dimensions to create,
combine bolt dimensions and select the side for the dimension
(Dimensioning properties - Bolt dimensions tab (Integrated
dimensioning) (page 957)).

• On the Dimension grouping tab, group dimensions and adjust the
related settings (Dimensioning properties - Dimension grouping tab
(Integrated dimensioning) (page 959)).

• On the Sub-assemblies tab, create dimensions for parts in sub-
assemblies and adjust the related settings (Dimensioning properties -
Sub-assemblies tab (Integrated dimensioning) (page 960)).

• On the Reinforcement dimensions tab, create dimensions for
reinforcing bar groups in cast unit drawings, add dimension marks and
adjust the related settings (Dimensioning properties - Reinforcement
dimensions tab (Integrated dimensioning) (page 961)).

7. Save the dimensioning settings by clicking Save and close the dialog box
by clicking Close.

8. Save the view properties by clicking Save and return to the drawing
properties dialog box by clicking Close.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Add minimum and maximum position dimensions to bolts (page 798)

Group identical objects to the same dimension line (page 773)

Add dimensions to unfolded parts (page 796)

Add elevation dimensions (page 774)

Add dimensions to plates (page 802)

Add dimensions to profiles (page 805)

Create check dimensions (page 776)

Example: Part dimensioning (page 778)

Example: Position dimensioning (page 781)

Example: Combine dimensions (page 787)

Example: Closing dimension (page 786)

Example: Forward offset (page 792)

Example: Recognizable distance (page 793)
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Example: Grid dimensions (page 793)

Example: Combine bolt group dimensions (page 791)

Example: Preferred dimension side (page 794)

Example: Reinforcement dimension (page 795)

Example: Bolt dimensioning (page 780)

Group identical objects to the same dimension line
You can group identical parts, bolts, components and cuts or shapes to the
same dimension line in integrated dimensioning. You also have the option to
include automatic dimension tags to grouped dimensions.

1. In the Dimensioning Properties dialog box, go to the Dimension
grouping tab.

2. In Activate dimension grouping, select the objects that you want to
group.

3. Highlight a row (Parts, Bolts, Components or Cuts/Shapes in the
Activate dimension grouping list and select the elements by which you
define the identical conditions in grouping properties.

4. In Automatic tagging, select the appropriate options to include
automatic dimension tags.

5. If you want Tekla Structures to update dimension grouping automatically,
set the option Update grouping when model changes to Yes.

6. Click OK.

TIP You can change the dimension tag contents in the final drawing and include
some other elements in the tag.
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See also

Dimensioning properties - Dimension grouping tab (Integrated dimensioning)
(page 959)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Add elevation dimensions
You can add elevation dimensions (level marks) in your drawings for the start
and end points of parts in integrated dimensioning. Tekla Structures
dimensions elevations relative to a reference point, which you can change.

For example, if the elevation is 5000 mm, and you set the reference point to
200, the elevation changes to 4800 mm. You can also change the elevation
dimension prefix, which in the English version is EL by default.

To change the reference point and create elevation dimensions using another
prefix:

1. Go to the Position dimensions tab, and set Elevation dimensions to On.

2. Click OK.

3. In the drawing properties dialog box, click View --> Attributes 2 .

4. Do one of the following: 

• To use a specific value, select Specified from the Datum point for
elevations list and enter a value in the Datum level box.

• To measure elevations relative to the view plane, select view plane
from the Datum point for elevations list.

5. Save the drawing properties and create the drawing.

6. To change the prefix, open the dim_operation.ail file in a text editor
that supports UTF-8 coding. Recommended editors are Visual Studio and
Notepad++. 

This file is located in the Tekla Structures/<version>/messages/
folder. Replace EL with a new prefix on the following line in the file:

string dim_operation_dim_elevation_prefix{entry = ("enu",
"EL");};

NOTE Shortening value added in the user-defined properties of a part affects also
elevation dimensions.
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Example

Limitations

Tekla Structures creates elevation dimensions for skew parts only if the parts
are in the same position in the drawing as they are in the model. This means
that the coordinate system must be set to model.

If you are using local, oriented, or brace coordinate systems, Tekla Structures
does not draw the elevation dimensions for skewed parts by default. If you
want to create elevation dimensions, set the advanced option 
XS_DRAW_SKEWED_ELEVATIONS to TRUE in File menu --> Settings -->
Advanced options --> Dimensioning: Parts . See below for an example of an
elevation dimension for a skew part.

See also

Part orientation in drawing views (page 697)

Dimensioning properties - Position dimensions tab (Integrated dimensioning)
(page 952)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Add level marks in drawings (page 292)

Change the coordinate system (page 697)
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Check dimensions
Check dimensions are additional dimensions in integrated dimensioning that
you can use for checking, usually in thinner text than other dimensions. They
are not required for fabrication or erection, and they are mainly used for
checking detailing, not for assembling parts.

Tekla Structures uses work points to create check dimensions. Work points
can be either the points between which the part was originally created, or the
intersection point of the reference lines of the parts. The reference line
location depends on the part position At depth set in part properties. If it is
Middle, the reference line is the center line, if it is Front, the line is located in
the part front edge, etc.

Knock-off dimension is a special type of check dimension that dimensions the
distance from work points to the end of the part.

See also

Create check dimensions (page 776)

Create check dimensions
In integrated dimensioning, you can create additional dimensions to check the
accuracy of dimensions.

To create check dimensions, do any of the following:

To Do this Number in
the image

Create check dimensions
between outermost work points.

In the Dimensioning dialog box,
click Part dimensions and set
Main part work points to Yes.

(1)

Create check dimensions
between outermost bolts.

In the Dimensioning dialog box,
click Bolt dimensions and set
Extreme bolts to Assembly or
Main part.

(2)

Create check dimensions from
outermost work point to first
bolt.

In the Dimensioning dialog box,
click Bolt dimensions and set
Extreme bolts to Assembly or
Main part and Extreme bolts
to work points to Yes.

(3)

Create horizontal and vertical
check dimensions between the
work points in a skewed brace.

In the Dimensioning dialog box,
click Position dimensions and
set Main part skew position to
Yes.

(4)

Create check dimensions
between the work points, such
as the intersections of main and
neighbor part reference lines.

In the Dimensioning dialog box,
click Position dimensions and
set Position bolts to or Position
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To Do this Number in
the image

parts to Working points or
Both.

Create check dimensions to the
bolt hole locations in the main
part.

In the Dimensioning dialog box,
click Position dimensions and
set Main part bolt position to
On.

 

Create knock-off dimensions. In the Dimensioning dialog box,
click Part dimensions and set
Knock-off dimensions to On.

(5)

See also

Check dimensions (page 775)
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Dimensioning properties - Part dimensions tab (Integrated dimensioning)
(page 955)

Dimensioning properties - Position dimensions tab (Integrated dimensioning)
(page 952)

Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 957)

Example: Part dimensioning
Here are some examples of what the part dimensions look like in integrated
dimensioning with different settings selected on the Part dimensions tab.

Dimensioning setting Example
Internal dimensions set to
None

Internal dimensions set to
All.

Overall dimensions
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Dimensioning setting Example
Main part shape (Shape
dimensions) set to On.

Bevel dimensions set to
On.

Bevel angle set to Angle of
cut.
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Dimensioning setting Example
Bevel angle set to Angle of
beam.

See also

Dimensioning properties - Part dimensions tab (Integrated dimensioning)
(page 955)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Bolt dimensioning
Here are a couple of examples of what the bolt dimensions look like in
integrated dimensioning with different settings.

Dimensioning setting Example
Main part bolt internal
dimensions is set to All on the
Bolt dimensions tab of the
Dimensioning Properties
dialog box.
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Dimensioning setting Example
All bolt and hole dimensions
are shown in the front view of
the main assembly. The
elements Gage of outstanding
leg (GOL) and Center-to-
center distance (C/C or Gage)
have been added in a bolt and
hole mark in Content.

Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 957)

Bolt mark elements (page 975)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Position dimensioning
Here are some examples of what the position dimensions look like in
integrated dimensoning with different settings selected on the Position
dimensions tab.

Dimensioning setting Example
Position parts to is set to
None.
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Dimensioning setting Example
Position parts to is set to
Main part.

Position bolts to is set to
Working points.
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Dimensioning setting Example
Secondary part is
dimensioned By bolt.

Secondary part is
dimensioned By part.

Secondary part is
dimensioned By both.

Secondary part is
dimensioned By bolt.

Secondary part
dimension direction is
Neighbor part.

Position from is set to
Work point.

(1) Running dimensions start from the intersection of
the main and secondary part (=work point)

(2) Dimensions are aligned with the neighboring part
Main part bolt position is
set to Off.

(Main part bolt internal
dimensions is set to
Internal on the Bolt
dimensions tab.)
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Dimensioning setting Example
Main part bolt position is
set to On.

(Main part bolt internal
dimensions is set to
Internal on the Bolt
dimensions tab.)

By default, create minimum and maximum position
dimensions are not created for bolts. For information
on how to create these dimensions, see Add
minimum and maximum position dimensions to bolts
(page 798).

Main part skew position
is set to Yes.

Skew position is set to
angle.
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Dimensioning setting Example
Centered part is set to
Internal.

Centered part is set to
Position.

Centered bolt is set to
Internal.

Centered bolt is set to
Position.

See also

Dimensioning properties - Position dimensions tab (Integrated dimensioning)
(page 952)

Define automatic drawing settings 785 Define dimensioning



Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Closing dimension
Here are some examples of how Tekla Structures creates dimensions in
integrated dimensioning with different options selected in the Close
dimensions area on the General tab.

Closing option Example
Close dimensions is set to No.
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Closing option Example
Close dimensions is set to All.

Short dimensions is set to No.

See also

Dimensioning properties - General tab (Integrated dimensioning) (page 949)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)
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Example: Combine dimensions
Here are some examples of how Tekla Structures combines dimensions in
integrated dimensioning with different options selected on the General tab.

Combining option Example
Option No prevents
dimensions from being
combined.

Option 1 combines part
position dimensions with
part internal dimensions,
and bolt group internal
dimensions with bolt edge
distances. Bolt position
dimensions are not
combined with bolt
internal dimensions.
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Combining option Example
Option 2 combines the
part position dimension
with part internal
dimensions and bolt group
internal dimensions. Bolt
internal dimensions are
combined with bolt
position dimensions. Edge
distances are shown
separately.

Option 3 combines bolt
internal dimensions and
position dimensions in the
same dimension line.
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Combining option Example
Option 4 combines bolt
group position dimensions
with part position
dimensions. Part and bolt
internal dimensions are
not combined with this
option, but bolt internal
dimensions are combined
with bolt edge distances.

Option 5 combines
internal dimensions and
the position dimension of
bolt groups where there
are several bolt groups.

Option 4.5 uses a combination of option 5 for the main part and option 4 for
the secondary parts.
Distance 5’-0

Distance 1’-0
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Combining option Example
Min distance 5’-0

Min distance 5"

See also

Dimensioning properties - General tab (Integrated dimensioning) (page 949)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Combine bolt group dimensions
For dimensioning and marking purposes, Tekla Structures treats bolt groups
located close together in integrated dimensioning as one group on the basis of
the minimum number of dimensions to combine and format selected on the
Bolt dimensions tab. See an example below:

1. Bolt group 1
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2. Bolt group 2

See also

Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 957)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Forward offset
Here are some examples of how Tekla Structures places dimensions in
integrated dimensioning with different forward offset values set on the
General tab.

Forward offset setting Example
Forward offset greater than the 1’-8
dimension to the hole group.

Forward offset set to a smaller value.

See also

Dimensioning properties - General tab (Integrated dimensioning) (page 949)
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Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Grid dimensions

Here is an example of how Tekla Structures creates dimensions in integrated
dimensioning with different options selected in the Grid dimensions area on
the General tab.

(1) Option Overall selected

(2) Option Individual spans selected

Example: Recognizable distance
Here is an example of how Tekla Structures uses the Recognizable distance
setting in integrated dimensioning. If you set value for Recognizable distance
on the General tab, and the asymmetry of the parts is smaller than the
distance you entered, Tekla Structures represents it using a dimension.

This setting is used, when the Internal dimension is set to Necessary.
Recognizable distance dimension is not necessarily needed, if the part can be
assembled correctly without it.

A typical example is a rectangle that is almost as long as it is wide.

Define automatic drawing settings 793 Define dimensioning



See also

Dimensioning properties - General tab (Integrated dimensioning) (page 949)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Preferred dimension side
You can set the preferred dimension side for parts and bolts on the Part
dimensions tab and Bolt dimensions tab in integrated dimensioning. The
examples below show how the different settings for Preferred dim side look
like for part dimensions.

See also

Dimensioning properties - Part dimensions tab (Integrated dimensioning)
(page 955)

Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 957)
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Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Reinforcement dimension
Here are some examples of how Tekla Structures creates dimensions for
reinforcing bar groups in integrated dimensioning with different options
selected on the Reinforcement dimensions tab.

Settings Example
Dimensions for reinforcing
bar groups is set to On, no
dimension tags specified in
dimension properties.

Dimensions for reinforcing
bar groups is set to On,
dimension tags specified in
dimension properties.

Dimensions for reinforcing
bar groups is set to On,
dimension tags specified in
dimension properties, closing
dimensions added to the edge
of the part in dimension
properties (Part edge set to
Yes).

See also

Dimensioning properties - Reinforcement dimensions tab (Integrated
dimensioning) (page 961)

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Add automatic dual dimensions
You can create dual dimension tags automatically in all types of drawings.

Limitations:

Dual dimensions can only be shown in relative and US absolute dimensions,
but not in absolute dimensions.
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1. Click On the File menu, click Settings --> Options and go to Drawing
dimensions settings.

2. Set the units, format and precision.

3. Select the drawing types where you want to have the dual dimensions.

4. Click OK.

When Tekla Structures creates the drawing, it adds in the lower dimension tag
in the selected unit and format, and adds the text DIMENSION in the middle
dimension tag in the Dimension Properties dialog box.

Example

Below is an example of dual dimensions using the units mm and format ###.

See also

Define dimensioning (page 724)

Add dual dimensions manually (page 209)
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Add dimensions to unfolded parts

In single-part and assembly drawings, you can control the dimensions Tekla
Structures adds for unfolded parts that have been created using View
Properties --> Attributes 2 --> Unfolded : Yes.

Use the advanced options in File menu --> Settings --> Advanced options -->
Dimensioning: Unfolding .

To Do this
Create bending line dimensions for
unfolded parts.

Set the advanced option 
XS_DRAW_BENDING_LINE_DIMENSIO
NS_IN_UNFOLDING=TRUE.

Create angle and radius dimensions
for unfolded parts.

Set the advanced option 
XS_DRAW_ANGLE_AND_RADIUS_INFO
_IN_UNFOLDING=TRUE.

Set a prefix text for an angle
dimension.

Set the advanced option 
XS_ANGLE_TEXT_IN_UNFOLDING_BE
NDING_LINE_DIMENSIONING=A=.

Set a prefix text for a radius
dimension.

Set the advanced option 
XS_RADIUS_TEXT_IN_UNFOLDING_B
ENDING_LINE_DIMENSIONING=R=.

For angle text dimensions, show the
interior angle instead of the exterior
angle.

Set the advanced option 
XS_DRAW_INSIDE_ANGLE_IN_UNFOL
DING=TRUE.

Set the format for angle text. Set the advanced option 
XS_UNFOLDING_ANGLE_DIM_FORMAT
=1.

###= 0

###[.#]= 1

###.#=2

###[.##]= 3

###.##= 4

###[.###]=5

###.###= 6

### #/#= 7

###/##.###= 8
Set the accuracy of the angle text. Set the advanced option 

XS_UNFOLDING_ANGLE_DIM_PRECIS
ION=10.

0.00= 1
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To Do this
0.50= 2

0.33= 3

0.25= 4

1/8= 5

1/16= 6

1/32= 7

1/10= 8

1/100= 9

1/1000= 10

See also

Dimension properties - Units, precision and format (page 932)

Add minimum and maximum position dimensions to bolts
By default, Tekla Structures does not create minimum and maximum position
dimensions for bolts. You can use an advanced option to create the
dimensions.

To create minimum and maximum position dimensions for bolts:

1. On the File menu, click Settings --> Advanced options and go to the
Dimensioning: Bolts category.

2. Set XS_BOLT_POSITION_TO_MIN_AND_MAX_POINT to TRUE .

Setting Example
Before setting the advanced option.

After setting the advanced option to 
TRUE.
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Create dimension line extensions
You can create line extensions for dimensions that have line arrows.

Limitations

Line extensions cannot be applied to dimensions that have different arrows
from line arrows, or to knock-off dimensions of the following type:

1. On the File menu, click Settings --> Options and go to the Drawing
dimensions settings.

2. Enter the length of the dimension line extension in the Dimension line
extension length for line arrow box.

Example

Line extensions added No line extensions

Change the appearance of absolute dimensions
You can select whether to show zero at the zero point of the absolute
dimensions, and also change the orientation of the absolute dimensions.

1. On the File menu, click Settings --> Options, and go to the Drawing
dimensions settings.

2. Set Show zero in absolute dimensions to No if you do not want to show
zero at the zero points in absolute dimensions. 

Yes is the default value.

3. Set Draw absolute dimension values parallel to dimension line to Yes
to show dimensions parallel to dimension lines in absolute dimensions. 

No is the default value.

4. Click OK.

Example

In the following example, dimensions are parallel to the dimension line and
zero is shown at the zero point.
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See also

Dimension properties - Appearance tab (page 934)

What are automatic view-level dimensions (page 725)

Create exaggerated dimensions
You can exaggerate narrow dimensions to make them easier to read.

When you enable the exaggeration of the dimensions, a dimension that is
narrower than the defined limit is enlarged. If there are many exaggerated
dimensions, Tekla Structures arranges them automatically. Setting
exaggeration consists of selecting the exaggeration limit and the exaggeration
scale, enabling the exaggeration and setting the direction, origin, width,
position and height for the exaggerated dimensions.

For single-part , assembly and cast unit drawings, save the dimension
exaggeration properties on object level in an open drawing into a dimension
properties file, which you can take into use when you modify dimensioning
rules.

Limitation: Exaggeration works only if the dimension extension lines are long.
Set Short extension line to No on the General tab of the Dimension
Properties dialog box.

1. On the File menu, click Settings --> Options and go to the Drawing
dimensions settings.

2. Enter the exaggeration limit in the Exaggeration limit box.

3. Select Paper or Model as the exaggeration scaling method. 

If you select Paper, the exaggeration limit is multiplied by the view scale.
For example, if the scale is 1:10 and the limit is 10 mm, then all the
dimensions smaller than 100 mm are exaggerated.

If you select Model, and the scale is 1:10, all the dimensions smaller than
10 mm are exaggerated regardless of the drawing scale.

4. Click OK.

5. Open a drawing and double-click a dimension.

6. Go to the Marks tab of the Dimension Properties dialog box.
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7. Enable the exaggeration by setting Exaggeration to Specified.

8. Set the values for Direction, Origin, Width, Position and Height.

9. Enter a name for the dimension properties file at the top and click Save.

10. If you want to modify the current dimension, click Modify. Otherwise,
close the dialog box. 

Now you have a dimension properties file that contains the exaggeration
settings, which you can load later on or use in dimensioning rules.

Example

See below for an example of exaggerated dimensions:
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See also

Dimension properties - Appearance tab (page 934)

Dimension properties - Marks and Tags tabs (page 936)

Change the prefix in radial dimensions
You can change the dimension prefix in radial dimensions.

By default, the prefix of radial dimensions is R, for example, R 200.

1. Close Tekla Structures

2. Open the file dim_operation.ail located in ..\Tekla Structures
\<version>\messages\.

3. Change the prefix R to Radius: 

string dim_operation_dim_radius_prefix{ ... entry =
("enu", "R ");};
string dim_operation_dim_radius_prefix{ ... entry =
("enu", "Radius ");};

4. Save the changes and reopen Tekla Structures.

See also

Add manual dimensions (page 195)

Add dimensions to plates

You can dimension plates using some advanced options in File menu -->
Settings --> Advanced options --> Dimensioning: Parts .

NOTE If you have added a path to the dim_planes_table.txt file as a
value to the advanced option XS_PART_DIMENSION_PLANES_TABLE,
the settings in dim_planes_table.txt are always used, not the
values that you set to the advanced options described below.

To dimension plates using the advanced options:

To Do this
Dimension the plates to
the edge that is nearest
to the neighbor part

Set the advanced option to TRUE.

Dimension the plates to
the leading edge of the
beams

1. Set the advanced option to FALSE.

2. Set the advanced option to FALSE.
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To Do this
3. Set the advanced option to TRUE.

Dimension the plates to
the leading edge of the
columns

1. Set the advanced option to FALSE.

2. Set the advanced option to FALSE.

3. Set the advanced option to TRUE.
Dimension the plates to
the trailing edge

1. Set the advanced option to FALSE.

2. Set the advanced option to FALSE.

3. Set the advanced option to FALSE.

4. Set the advanced option to FALSE.
Dimension the plates
using their original
reference points in the
model

1. Set the advanced option to FALSE.

2. Set the advance option to TRUE.

Note: If you have created one plate from left to
right and another from right to left, Tekla
Structures dimensions them differently.

Below is an example of dimensioning plates to the leading edge.

Below is an example of dimensioning plates to the trailing edge.

In the following two examples, neighbor parts are blue, and the plate creation
points are shown.
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In the example below, the following values are used:

XS_PART_DIMENSION_PLANES_TABLE= (no value given)

XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOR=TRUE
XS_PART_POSITION_TO_LEADING_EDGE=FALSE
XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO=FALSE
XS_USE_PLATE_SIDE_POSITIONING=FALSE

In the example below, the following values are used:

XS_PART_DIMENSION_PLANES_TABLE= (no value given)

XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOR=FALSE
XS_PART_POSITION_TO_LEADING_EDGE=FALSE
XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO=FALSE
XS_USE_PLATE_SIDE_POSITIONING=TRUE
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See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Add dimensions to profiles
You can affect the way Tekla Structures dimensions different profiles in
drawings. For example, you can have Tekla Structures always dimension round
bars to the middle of the profile and large I profiles to the top.

To define dimension settings for profiles, you need to edit the dimension
planes table dim_planes_table.txt.

1. On the File menu, click Settings --> Advanced options and go to the
Dimensioning: Parts category.

2. Set the advanced option as follows: 

XS_PART_DIMENSION_PLANES_TABLE=%XS_PROFDB%
\dim_planes_table.txt
This advanced option defines the path to the part dimension planes table.
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3. Open the dim_planes_table.txt file in any text editor, for example,
Microsoft Notepad. The file is located under the environment
folder ..\Tekla Structures\<version>\environments in the
\profiles folder. The exact folder location may vary depending on your
environment.

4. Edit the file contents and save the file.

5. To use the new settings in drawings, restart Tekla Structures and recreate
the drawings. Changing the file does not automatically update existing
drawings.

Example 1

In this example, the hole dimension is set from the middle of the flange
instead of the flange edge for "I" Profile.

Open the file and edit the middle of the column to TRUE* in the ProfType 1
row line, save and restart Tekla Structures. However, when you generate the
new drawing, it will create the hole dimension from the middle of the flange.

dim_planes_table.txt
/*** DIMENSION PLANES TABLE for different profile types and sizes
***/

//Values: -1.0 in max size means no size limit!

/*** FLANGE WEB

ProfType, MaxSize, middle, left, right, middle, bottom, top

========================================================
***/

//I-profile - horizontal by reference line,vertical from top flange

1, TRUE*, FALSE, FALSE, FALSE, TRUE, TRUE*

(1) Required dimension (middle of flange)

(2) Default dimension (edge of flange)

Example 2

Here is another example of a dimension planes table:
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dim_planes_table.txt
FLANGE WEB

ProfType,MaxSize, middle,right, left, middle, right, left

========================================================

1, 300.0, TRUE*, FALSE, FALSE, FALSE, TRUE*, TRUE

7, -1.0, TRUE*, FALSE, FALSE, TRUE*, FALSE, FALSE

The line beginning with 1 means that Tekla Structures always dimensions I
profiles (ProfType = 1) smaller than 300 mm (MaxSize = 300) to the middle of
the flange and to the right edge of the web, no matter how the part was
created.

The line beginning with 7 means that Tekla Structures always dimensions
round tubes (ProfType = 7) to the middle of the profile

The ProfType numbers run in the same order as the profiles in the Profile
catalog:

• 1 = I profile

• 2 = L profile

• 3 = Z profile

• 4 = U profile

• 5 = plate

• 6 = round bar

• 7 = round tube

• 8 = square pipe

• 9 = C profile

• 10 = T profile

• 15 = ZZ profile

• 16 = CC profile

• 17 = CW profile

• 51 = polygon plate

• 999 = sketched profile

• etc.

The value -1.0 in the MaxSize indicates that there is no size limit for the
profile.

The asterisk after TRUE indicates that it is the default value.
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Sloped dimension texts
Tekla Structures aligns slightly sloped dimension text. If the dimension text is
sloped more than a certain degree, Tekla Structures flips the text.

Below is an example of a dimension text that is slightly sloped.

Below is an example of a flipped dimension text.

The default limit for aligning dimension text is 0.1 (5.74 degrees). When this
limit is exceeded, the dimension text gets flipped. To adjust this limit, use the
advanced option XS_TEXT_ORIENTATION_EPSILON.

See also

Add automatic dimensions to general arrangement
drawings
In the general arrangement drawing General - Dimensioning Properties
dialog box, you can create part, grid and overall dimensions, and control the
way they are created. You can experiment with different combinations of
options to achieve different kinds of dimensioning effects.
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1. On the Drawings & reports tab, click Drawing properties --> GA
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click Dimensioning...

4. Select the dimensions to create and modify the related settings.

5. On the Grid tab, adjust the grid dimension and overall dimension creation
settings and the positioning of the dimensions.

6. On the Parts tab, adjust part dimension creation settings and the
positioning of the dimensions.

7. Click OK and create the drawing.

See also

Object groups in dimensioning general arrangement drawings (page 809)

Dimension object groups on different dimension lines (page 809)

Example: Grid and overall dimensions (page 811)

Example: Maximum leader line length options (page 812)

Example: Dimension parts partly outside the view (page 814)

Example: Limit the number of outside dimensions (page 814)

Example: Position part dimensions (page 815)

Example: Dimension anchor bolt plans (page 820)

Dimensioning properties - Grid tab (GA drawings) (page 962)

Dimensioning properties - Parts tab (GA drawings) (page 962)

Object groups in dimensioning general arrangement drawings
You can use the object groups (selection filters) that you have created in the
model, or create the necessary groups through the Parts tab in the General -
Dimensioning Properties dialog box using the Object groups button. For
example, you might want to create an object group for beams of a certain size.

See also

Dimension object groups on different dimension lines (page 809)

Dimension object groups on different dimension lines
You can use object groups to specify different objects to be dimensioned on
different dimension lines.

1. On the Drawings & reports tab, click Drawing properties --> GA
drawing.

Define automatic drawing settings 809 Define dimensioning



2. Click Dimensioning, and go to the Parts tab

3. Add the desired object groups to dimensioning rules by clicking Add rule
and selecting the rule from the list in the Object group column.

4. If needed, you can create new object groups by clicking Object group. For
example, add object group rules for beams of different size.

5. For each object group, select the Positioning option, the Horizontal
position option, and the Vertical position option, depending on the type
of the objects in the group. 

For example, for beam groups, set Horizontal position to Left side to
position the beam dimensions to the left side of the grid.

6. If needed, in the Tag column, enter the text tags that you want to display
for the different object groups in the drawing. For example, enter the size
of the beam.

Example

In this example, several beam groups were created, one for each beam size to
be dimensioned, then the position for the dimensions in different groups was
selected, and tags were added displayed for each group:

See also

Object groups in dimensioning general arrangement drawings (page 809)

Example: Position part dimensions (page 815)

Example: Dimension parts partly outside the view (page 814)
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Example: Limit the number of outside dimensions (page 814)

Example: Maximum leader line length options (page 812)

Dimensioning properties - Parts tab (GA drawings) (page 962)

Example: Grid and overall dimensions

Here are some examples of what the grid and overall dimensions look like in
general arrangement drawings with different settings selected on the Grid tab.

Dimensioning setting Example
Grid line dimensions = On

Overall dimension = On

Horizontal = Left

Vertical = above
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Dimensioning setting Example
Grid line dimensions = On

Overall dimension = Off

Horizontal = Left

Vertical = above

See also

Dimensioning properties - Grid tab (GA drawings) (page 962)
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Example: Maximum leader line length options

Here are some examples of how the dimensions are positioned when you
have set values for the Maximum leader line length options Outside
dimensions and Inside dimensions on the Parts tab.

Dimensioning setting Example
A value has been set for
Outside dimensions.

A value has been set for
Inside dimensions.
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See also

Dimensioning properties - Parts tab (GA drawings) (page 962)

Add automatic dimensions to general arrangement drawings (page 808)

Example: Dimension parts partly outside the view

Here is an example of how the parts are dimensioned if you set the option
Include parts not entirely in the view to On on the Parts tab of the General
- Dimensioning properties dialog box.

See also

Dimensioning properties - Parts tab (GA drawings) (page 962)

Example: Limit the number of outside dimensions

Here is an example of what the part dimensions look like when you set 3 as
the value for the option Maximum number of outside dimensions on the
Parts tab in general arrangement drawing dimensioning properties. Tekla
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Structures creates three dimensions outside the grid and the fourth inside the
grid.

See also

Dimensioning properties - Parts tab (GA drawings) (page 962)

Example: Position part dimensions

Here are some examples of how the part dimensions are positioned in general
arrangement drawings with different positioning settings selected on the
Parts tab.

In the example below, Positioning is set to Inside grid, which places all
dimensions next to or near the grid.
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In the example below, Positioning is set to Outside grid, which places all
dimensions outside the grid.

In the example below, Horizontal position is set to Left side, which places all
dimensions to horizontal parts to the left of the grid.
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In the example below, Horizontal position is set to Right side, which places
all dimensions to horizontal parts to the right of the grid.
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In the example below, Horizontal position is set to Distributed to both
sides, which places all dimensions to horizontal parts to the side of the grid
nearest the part they are dimensioning.

In the example below, Vertical position is set to Above, which places all
dimensions to vertical parts above the grid.
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In the example below, Vertical position is set to Below, which places all
dimensions to vertical parts under the grid.
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In the example below, Vertical position is set to Distributed to both sides,
which places all dimensions to vertical parts to the side of the grid nearest the
part they are dimensioning.

See also

Dimensioning properties - Parts tab (GA drawings) (page 962)

Example: Dimension anchor bolt plans

Here are some examples of what the dimensions in anchor bolt plans look like
in different situations.

First an example of a typical situation, where all columns are located in grid
line intersections:
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If the column reference point is not located on the grid line, Tekla Structures
dimensions the reference point automatically relative to the grid lines. See the
example below.
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If the column is rotated relative to the drawing, the rotation is also
automatically dimensioned. See the example below.
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If you set the advanced option to FALSE and create the drawing, all
dimensions are in the drawing coordinate system.
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See also

Create anchor bolt plans using saved settings (page 113)

8.6 Define marks
Marks are associative annotation objects that are used for identifying
individual building objects in a drawing. A mark displays a set of user-
selectable properties called mark elements. Automatic marks are marks that
Tekla Structures creates in a drawing based on the mark properties defined in
drawing properties.

You can modify the mark properties after creating the drawing, and add marks
manually in an open drawing.

The mark properties define what Tekla Structures shows in marks and how the
marks are shown. In addition, Tekla Structures uses the
contentattributes_global.lst attributes file for setting the default unit
settings for some mark elements. You can use
contentattributes_userdefined.lst when you want to configure
settings of your own.

Tekla Structures is able to create the following automatic marks:
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• Part marks

• Bolt marks

• Neighbor part marks

• Surface treatment marks

• Connection marks

• Model weld marks

• Reinforcement marks

• Pour object marks

• Dimension marks

• View and section view label marks, and section marks

To Click the links below to find out
more

Set up and add automatic marks for
building objects

Add automatic marks (page 826)

Indicate whether to show and merge
marks

Adjust the visibility of automatic
marks (page 829)

Add frames around single mark
elements or around the mark itself,
adjust the appearance of the mark
text and leader line, and change the
unit and format of an element

Adjust text, frames and leader lines of
automatic marks (page 834)

Check how the location of the mark is
affected by mark placement settings,
the type of the leader line, predefined
mark location and part orientation
settings, modeling direction of parts,
and drawing protection settings

Mark location (page 837)

Automatically merge part marks,
surface treatment marks or
reinforcement marks

Merge marks automatically
(page 841)

Show the mark frame and leader line
of the hidden part with a dashed or a
solid line

Show mark frames and leader lines
for hidden parts (page 847)

Set or change the unit and the
number of decimals in measurement
values for various mark elements

Change unit settings for marks
(page 848)

Use advanced options to define the
contents of the bolt mark Size
element

Define size in bolt marks using
advanced options (page 860)
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To Click the links below to find out
more

Add level attributes in part marks and
associative notes as user-defined
attributes

Add level attributes in automatic part
marks (page 851)

Add user-defined attributes and
template attributes in marks

Add attributes in automatic marks
(page 850)

Add custom graphical templates as
elements in marks, for example, add
a template that changes the unit and
the number of decimals in
measurement values in a mark

Add templates in marks (page 854)

Add symbols in mark from a specific
symbol file

Add symbols in automatic marks
(page 860)

Add a pull-out picture of a reinforcing
bar in a reinforcement mark

Add pull-out pictures in automatic
reinforcement marks (page 863)

See also

Mark properties (page 965)

Mark elements (page 971)

Define object protection and placement settings in drawings (page 677)

Create and modify marks, notes, texts, symbols and links in drawings
(page 276)

Pours in drawings (page 488)

Show pour objects, pour marks and pour breaks in drawings (page 894)

Units and decimals in drawings, reports and templates (page 902)

Add automatic marks
You can set up automatic marks for building objects (parts, neighbor parts,
bolts, surface treatment, connections, reinforcement, and neighbor
reinforcement) and save the mark properties in a property file for later use.

You can do this the view properties dialog box of single-part, assembly, and
cast unit drawings. For general arrangement drawings, automatic marks can
be defined on drawing level.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Do one of the following depending on the drawing type. 
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Drawing type Add automatic marks
Single-part, assembly and cast unit
drawings:

a. Click View creation in the
options tree on the left, select the
view and the properties that you
want to change, and click View
properties.

b. Click the mark type you want to
modify, for example, Part mark.

c. For some marks, you need to
select from a list the object that
you are defining the marks for.

For example, for part marks, you
can define part mark settings
independently for main and
secondary parts, and for sub-
assembly main and secondary
parts.

d. Add elements in the mark by
double-clicking the elements in
the Available elements list.

e. Modify the element appearance
(frame and font).

For length, height, spacing and
diameter elements, you can
adjust also the unit and format.

f. Use the Move up and Move
down buttons to place the
elements in the order you want.

g. Modify the appearance,
placement and visibility settings
on the Content and General
tabs. For example, adjust the
leader line (page 990).

h. Save the view properties by
entering a properties file name in
the box at the top and click Save.
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Drawing type Add automatic marks
i. Click Close to return to the

drawing properties.
General arrangement drawings: a. Click the mark type you want to

modify, for example, Part
mark....

b. For some marks, you need to
select from a list the object that
you are defining the marks for.

For example, for part marks, you
can define part mark settings
independently for main and
secondary parts, and for sub-
assembly main and secondary
parts.

c. Add elements in the mark by
double-clicking the elements in
the Available elements list.

d. Modify the element appearance
(frame and font).

For length, height, spacing and
diameter elements, you can
adjust also the unit and format.

e. Use the Move up and Move
down buttons to place the
elements in the order you want.

f. Modify the appearance,
placement and visibility settings
on the Content and General
tabs. For example, adjust the
leader line (page 990).

g. Save the mark properties by
entering a properties file name in
the box at the top and click Save
as.

h. Click OK in the subdialog to save
the changes, close the subdialog

Define automatic drawing settings 828 Define marks



Drawing type Add automatic marks
and return to the drawing
properties.

4. Click Save to save the drawing properties, then click OK and create the
drawing.

Example

This is an example of a part mark.

1. Assembly position

2. Size

3. Mark frame

4. Profile

5. Mark element frame

6. Length

See also

Mark location (page 837)

Define automatic placement settings for marks (page 683)

Mark properties (page 965)

Mark elements (page 971)

Add symbols in automatic marks (page 860)

Add templates in marks (page 854)

Add pull-out pictures in automatic reinforcement marks (page 863)

Add attributes in automatic marks (page 850)

Define size in bolt marks using advanced options (page 860)
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Adjust the visibility of automatic marks
Using the visibility options in the mark properties you can indicate whether the
marks are displayed in a drawing. You can modify these settings before
creating a drawing, and also in an open drawing after creating a drawing.

To adjust the visibility of marks before creating a drawing:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. For bolt marks and weld marks in assembly and single-part drawings,
adjust the following settings located at the bottom of the View creation
page. These settings affect all views in a drawing: 

• The Weld mark visible setting controls the visibility of model weld
marks in assembly drawing views. The options are:

• In one view: Tekla Structures automatically finds the most relevant
view for showing the model weld marks. Every weld mark is shown
in a drawing in one view only.

• In all views: Tekla Structures adds the model weld marks in all
drawing views that contain the part with the weld.

• The Weld size limit setting filters welds of the defined size and bigger
out of all views in a drawing. This setting is available in single-part
drawings and assembly drawings.

• The Ignore bolt size setting filters standard-sized bolt marks out of all
views in a drawing, which means that Tekla Structures does not display
bolt marks of the defined bolt size in the drawings. This setting is
available in single-part drawings and assembly drawings.

4. Do one of the following depending on the drawing type. Note that all
settings are not available for all mark types. 

Drawing type Adjust mark visibility settings
Single-part, assembly and cast unit
drawings:

a. Click View creation in the
options tree on the left, select the
view and the properties that you
want to change, and click View
properties.

You need to adjust the setting for
all the views in the drawing
separately.

b. Click a mark type in the options
tree. For example, click Part
mark.
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Drawing type Adjust mark visibility settings
• Go to the General tab and

select whether you want to
display marks by selecting
one of the Visibility in view
options. The available options
depend on the mark type:

• distributed: Distributes
the marks evenly in the
drawing view. Tekla
Structures only creates
marks that are not visible
in the other views.

• always: Always creates
marks in the view,
regardless of the settings
in other views.

Selecting the option
always might slow down
the drawing update during
opening, even if you had
deleted the marks
manually.

• Select preferred for one
view only in a drawing. If
you set other views to
distributed, the marks are
located only in the view
that has the setting
Visibility in view set to
preferred.

The option preferred acts
like the option
distributed, but the
preferred view has a
higher priority.

• none: Does not create
marks.

Note that if you want to
create your own marks,
always use the
distributed option.

• In Parts out of view plane,
select whether you want to
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Drawing type Adjust mark visibility settings
display marks for parts that
are out of view plane:

• Visible: Displays marks for
parts outside the view in
the drawing.

• Not visible: Displays no
marks for parts outside
the view in the drawing.

• For bolt marks, select if you
want to show bolt marks in
main parts, secondary parts,
sub-assembly main parts, or
in sub-assembly secondary
parts.

For bolt marks, you can also
define the Ignore size, which
filters marks for standard-
sized bolts out of drawings.
Tekla Structures will not
display bolt marks of the bolt
size you enter here. Note that
this setting is also available in
drawing level properties at
the bottom of the View
creation page.

• For weld marks, select if and
how you want to show weld
marks in sub-assemblies and
hidden parts.

For weld marks, you can also
define the Weld size limit to
filter welds of the defined size
and bigger out of the drawing.
Note that this setting is also
available in drawing level
properties at the bottom of
the View creation page.

c. Click Save to save the changes in
view properties, and then click
Close to return to drawing
properties.

d. Click Save to save the drawing
properties, then click OK and
create the drawing.
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Drawing type Adjust mark visibility settings
General arrangement drawings: a. Click a mark type button in the

drawing properties dialog box.
For example, click Part mark...

b. Go to the General tab and select
whether you want to display
marks by selecting one of the
Visibility in view options. The
available options depend on the
mark type:

• distributed: Distributes the
marks evenly in the drawing
view. Tekla Structures only
creates marks that are not
visible in the other views.

• always: Always creates marks
in the view, irrespective the
settings in other views.

Selecting the option always
might slow down the drawing
update during opening, even
if you had deleted the marks
manually.

• Select preferred for one view
only in a drawing. If you set
other views to distributed,
the marks are located only in
the view that has the setting
Visibility in view set to
preferred.

The optionpreferred acts like
the option distributed, but
the preferred view has a
higher priority.

• none: Does not create marks.

Note that if you want to
create your own marks,
always use the none option.

c. In Parts out of view plane,
select whether you want to
display marks for parts that are
out of view plane:
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Drawing type Adjust mark visibility settings
• Visible: Displays marks for

parts outside the view in the
drawing.

• Not visible: Displays no
marks for parts outside the
view in the drawing.

d. For bolt marks, select if you want
to show bolt marks in main parts,
secondary parts, sub-assembly
main parts, or in sub-assembly
secondary parts.

For bolt marks, you can also
define the Ignore size, which
filters standard-sized bolts out of
drawings. Tekla Structures will
not display bolt marks of the bolt
size you enter here.

e. Click OK.

f. Click Save to save the drawing
properties, then click OK and
create the drawing.

See also

Adjust mark visibility in an existing drawing (page 300)

Merge marks automatically (page 841)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Mark properties (page 965)

Adjust text, frames and leader lines of automatic marks
You can add frames around single mark elements and around the mark itself.
You can also adjust the appearance of the mark text and leader line. For some
elements, you can change the unit and format.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Do one of the following depending on the drawing type: 
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Single-part, assembly and cast unit drawings:

a. Click View creation in the options tree on the left, select the view and
the properties that you want to change, and click View properties.

b. Click a mark type in the drawing properties dialog box. For example,
click Part mark.

General arrangement drawings:

• Click a mark type in the drawing properties dialog box. For example,
click Part mark...

4. On the Content tab of the in mark properties, select one or several
elements from the Elements in mark list and adjust the element settings:

• To apply your changes in all of them, hold down Shift and click the last
element in the list to select all elements.

• To add a frame around the selected elements, click < Add frame.

• Select a Type and Color for the frame.

You can select a different frame type and color for each element you
add.

• Select the element text Color, Font and Height.

You can select a different color, font and font height for each element
you add.

• If necessary, change the unit and the format of a length, height,
spacing or diameter element.

Before you can do this, you must first select the element from the
Elements in mark list.

5. Go to the General (or the Appearance) tab adjust the mark frame and
leader line settings: 

• Select the mark frame Type and Color.

• Select the Type for the leader line and the Arrow to use.

All marks do not have leader lines, in which case the leader line type
selection is not available.

• If you want to hide leader lines of hidden parts, set Use hidden lines
for hidden parts to Yes.

This option is not available for all marks.

6. Single-part, assembly and cast unit drawings: Click Save to save the
view properties, and then click Close to return to drawing properties. 

General arrangement drawings: Click OK.

7. Click Save to save the drawing properties, then click OK and create the
drawing.
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See also

Adjust part mark leader lines with advanced options (page 836)

Place reinforcement mark leader line base point automatically (page 836)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Mark properties (page 965)

Adjust part mark leader lines with advanced options
You can modify part mark leader line settings using advanced options. On the
File menu, click Settings --> Advanced options and go to Marking: Parts.

To modify part mark leader line settings using advanced options:

To Do this
Define whether a leader line is drawn
when the leader line is shorter than
defined with the advanced option 
XS_DRAW_SHORT_LEADER_LINES_OF
_PART_MARKS_MINIMUM_LENGTH

Set to TRUE (default) to always draw
leader lines in part marks. When you
set this option to FALSE, the leader
line is not drawn if it would be shorter
than the minimum you set for the
advanced option .

Give a minimum length for the leader
line. If the length is less than this
value, the leader line is not drawn.

Set a value in millimeters for the
advanced option .

Define the leader line start position
for a leader line with a rectangular
frame.

Set a value for the advanced option .

Define the leader line start position
for a leader line of a mark without a
frame and for a leader line of a mark
with a mark element frame.

Set a value for the advanced option .

Define the length of the leader line
extension.

Set a value for the advanced option .

See also

Adjust text, frames and leader lines of automatic marks (page 834)

Place reinforcement mark leader line base point automatically
Tekla Structures places the base point of reinforcement mark leader lines so
that it points to only one reinforcing bar. You can adjust how Tekla Structures
searches for the place for the base point.

• On the File menu, click Settings --> Advanced options and go to the
Concrete Detailing category.
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To Do this
Select an optimal place for the base
point.

Set to TRUE.

Define how far the other reinforcing
bars must be from the base point in
order for Tekla Structures to place the
base point.

Set a millimeter value for .

Define the search step length while
searching for an optimal place for the
base point along the reinforcing bar.

Set a millimeter value for .

Example

An example showing optimized base points.

See also

Adjust text, frames and leader lines of automatic marks (page 834)

Mark location
The location of the marks in drawings is affected by several settings, not only
the properties of the mark itself.

Define automatic drawing settings 837 Define marks



Setting Click the links below to find out
more

The placement settings in the mark
properties

Define automatic placement settings
for marks (page 683)

The type of the selected leader line How leader line type affects part
mark and surface treatment mark
location (page 839)

How leader line type affects
reinforcement mark location
(page 841)

How merging affects reinforcing bar
group mark location (page 839)

The predefined mark location and
part orientation settings

Set a predefined location for beam,
bracing and column marks
(page 838)

: Orientation settings

Indicate part orientation (page 873)
Protection settings Protect areas in a drawing (page 679)
The modeling direction of parts
Alignment of the marks Align selected drawing objects

(page 345)

See also

Mark properties (page 965)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Set a predefined location for beam, bracing and column marks
By default, part marks are placed at the end point of the part. You can change
this by adjusting the predefined location settings for beam, bracing and
column marks.

1. On the File menu, click Settings --> Options and go to the Orientation
marks settings.

2. In Mark location: Preferred location for beams and bracings, select
Left or Right to place the mark to the left or right end of the part.

3. In Mark location: Mark always to center of column in GA drawings,
select Yes to place part marks in the center of columns in plan views, or
No to place part marks on the same flange in GA drawings and assembly
drawings.

4. Click OK.
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See also

Mark location (page 837)

Mark properties (page 965)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Indicate part orientation (page 873)

How leader line type affects part mark and surface treatment mark
location
Part marks and surface treatment marks have several types of leader lines you
can select. The type of the leader line affects the location of the mark.

Leader line type Description
Always uses a leader line.

Tries to find a space along the part for the mark. If
impossible, Tekla Structures uses a leader line.
The mark is always along the part. Lack of space might
cause the mark to overlap other elements.
The mark is always inside the part.

The mark is always inside the part and parallel to the
part axis.
Tries to find a space for the mark inside the part. If
impossible, Tekla Structures places the mark along the
part with a leader line.
Tries to find a space inside the part for the mark and
align it parallel to the part axis. If impossible, Tekla
Structures places the mark along the part with a leader
line.
Places the part mark along and in the middle of a part
face.

See also

Mark location (page 837)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Mark properties (page 965)

How merging affects reinforcing bar group mark location
In reinforcing bar groups, Tekla Structures first tries to place the mark on the
middle bar if it is visible. If that is not possible, Tekla Structures tries the next
visible bar.
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Below is a list of leader line options available for identical reinforcement marks
and reinforcing bar group marks:

Option Image Example
One leader line to group

One leader line per row

Parallel leader lines

Leader lines to one
point

Perpendicular leader
lines
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Option Image Example
Leader line to first and
last

See also

Mark location (page 837)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Mark properties (page 965)

How leader line type affects reinforcement mark location
Reinforcement marks have several types of leader lines you can select. The
type of the leader line affects the location of the mark. Tekla Structures tries to
place the mark close to the midpoint on straight bars, or to the midpoint of
the longest bar segment.

Reinforcement leader
line type

Description

Always creates a leader line.

Tries to find a space along the reinforcing bar for the
mark. If impossible, creates a leader line.
The mark is always along the reinforcing bar. The mark
may overlap other elements if there is not enough
space.
The mark is parallel to the reinforcing bar.

The mark is parallel to the reinforcing bar on line. If
there is not enough space for the mark, a leader line is
created.

See also

Mark location (page 837)

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Merge marks (page 311)

Mark properties (page 965)
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Merge marks automatically
You can let Tekla Structures automatically merge marks.

You can automatically merge:

• Part marks and surface treatment marks

• Reinforcement marks

For more information about mark properties, including merging settings, see
Mark properties - Content, General, Merging and Appearance tabs
(page 965).

You can also merge marks manually. For more information, see Merge marks
(page 311).

Merged part marks
A merged part mark means that you have only one part mark for similar parts
in a drawing, instead of a separate mark for each of the parts. Merged part
marks indicate the number of included parts, and contain the defined part
mark contents, and the near side and far side information. The marks are
merged only in X direction of the main part.

Tekla Structures merges marks for visible parts in drawings if:

• The secondary parts are welded or bolted to the same main part.

• The parts are on the same line.

• Distances between the parts are equal.

• The parts have the same part position.

• Distance between parts is not more than what is set for the advanced
option XS_PART_MERGE_MAX_DISTANCE.

• There are at least as many parts in the array as it has been set for the
advanced option XS_MIN_MERGE_PART_COUNT.

Limitations

• You cannot merge part marks (assembly marks) that are not part of the
same assembly.

• Tekla Structures does not merge neighbor part marks.

Advanced options in merging marks

In merging part marks, you may find the following advanced options useful:
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Example

In the example below, the part marks are merged in X direction of the HEA300
beam (main part).

In the example below, the leftmost part marks are not merged, because they
are too far from each other.

In the example below, the marks in the Y direction are not merged, because
the marks are merged only in X direction (which in this example is horizontal).
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Merge part marks automatically
You can merge part marks and surface treatment marks automatically to
reduce the number of marks in the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. ClickPart mark . 

If you want to merge surface treatment, click Surface treatment mark
instead.

5. On the General tab in the part mark properties, set Merge marks to On.

6. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.
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7. Click Save to save the drawing properties, then click OK and create the
drawing.

Tekla Structures merges marks for identical secondary parts on both faces of
main parts.

Merged reinforcement marks
Tekla Structures can automatically merge similar reinforcement marks of bars,
and you can also merge reinforcement marks manually. Merged
reinforcement marks may include several blocks, and additional information.
Blocks combine similar single marks.

NOTE To have Tekla Structures automatically merge reinforcement marks in
drawings, the reinforcement must be attached to a concrete part or cast unit
in the model.

Tekla Structures automatically merges marks for visible reinforcing bars in
drawings if:

• The bars belong to the same concrete part or cast unit.

• The direction of the bars is the same.

• The bar marks are identical.

• The bars are close to each other.

• A straight line can be drawn through all the bars.

You can also define the distance within which to automatically merge marks
for visible reinforcing bars using the following advanced options:

XS_MAX_MERGE_DISTANCE_IN_HORIZONTAL

XS_MAX_MERGE_DISTANCE_IN_VERTICAL

Merge reinforcement marks automatically
You can merge reinforcement marks automatically to reduce the number of
marks in the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type. You can merge reinforcement marks in cast unit drawings
and general arrangement drawings.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Cast unit drawings: Click View creation in the options tree on the left,
select the view and the properties that you want to change, and click View
properties.

4. Click .

5. Go to the Merging tab of the reinforcement marks dialog box.
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6. Select an option from the Identical marks in same cast unit list to
merge marks and create leader lines: 

• One leader line to group creates one leader line for a group of
reinforcing bars.

• One leader line per row: Merges the marks and creates one leader
line for a row of reinforcing bars.

• Parallel leader lines: Merges the marks and creates parallel leader
lines.

• Leader lines to one point: Merges the marks and draws all leader
lines to one point.

• No merge: Marks are not merged, an individual leader line is created
for each mark.

• If you select No merge, you still need to define the mark content for
the marks that Tekla Structures automatically merges on the Merging
tab.

7. If there are several possible merge directions, select the horizontal or
vertical from Preferred direction of merge.

8. Select the contents to be included in the merged reinforcement marks
from the Available elements list. 

To ensure that merged reinforcement marks appear in the drawing,
always include Symbol separating blocks in mark as the last element in
the reinforcement mark. To omit the separating symbol, leave this box
blank, but still include the element in the mark.

9. If needed, add a frame around the single elements in the mark. You can
define the frame individually for each element.

10. Adjust the font, font height and the color of the mark text. You can adjust
these settings individually for each element.

11. Cast unit drawings: Click Save to save the changes in view properties
and Close to return to drawing properties. 

General arrangement drawings: Click OK.

12. Click Save to save the drawing properties, then click OK and create the
drawing.

Example

In this example, three A φ12 L2000 marks are merged to a block, and six V φ8
L650 marks to another block, and then these blocks are merged in the
following way:
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1. Single mark content

2. Symbol separating the blocks

3. Block prefix

4. Distance between groups

5. Block 1

6. Block 2

Show mark frames and leader lines for hidden parts
If a part is behind another part in the drawing so that it is hidden, you can
select whether to show the mark frame and leader line of the hidden part with
a dashed or a solid line.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. Click Part mark.

5. In part mark properties, go to the General tab.

6. Use one of the following options: 

Use hidden lines for hidden parts: Yes

Part mark frame and leader line are shown with a dashed line.
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Use hidden lines for hidden parts: No

Part mark frame and leader line are shown with a solid line.

7. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.

8. Click Save to save the drawing properties, then click OK and create the
drawing.

TIP With the advanced option you can omit the marks of hidden objects in general
arrangement drawings.

See also

Mark properties - Content, General, Merging and Appearance tabs (page 965)

Mark properties (page 965)

Change unit settings for marks
Tekla Structures uses the contentattributes_global.lst attributes file
for setting the default unit settings for various mark elements. This file defines,
for example, the unit used, and the number of decimals. You can change the
unit and format for the length, height, diameter, and spacing elements in the
mark, associative note and dimension mark properties dialog box. One
additional way to change the unit is to add individual settings at the end of the
contentattributes.lst file.

The contentattributes_global.lst file also defines default values for
attributes in templates created in Template Editor.

If you change the unit and format, save the changes for future usage in a
property file if necessary.

WARNING Do not edit contentattributes_global.lst.

For user-defined attributes in mark elements, the default unit settings are
taken from the contentattributes_userdefined.lst file. You can use
contentattributes_userdefined.lst also when you want to configure
settings of your own. By default, this file is located in ..\Program Files
\Tekla Structures\<version>\nt\TplEd\settings, but often the
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location depends on your environment. The files are read from different
locations in a certain search order.

The container file contentattributes.lst lists all the files that contain the
actual attribute definitions. The order of the files included in
contentattributes.lst defines the reading order of the files.

TIP You can add in the mark a template that changes the unit and number of
decimals. This affects all drawings that have marks containing the
changed template.

Example 1

This first example shows how you can change the unit and format of a length
element in the part mark, save your changes in a property file and apply the
changes in a part mark.

1. Double-click the background of an open drawing to open the Drawing
Properties dialog box.

2. Click Part mark.

3. Add a Length element in the part mark.

4. Select Length from the Elements in mark list and adjust the unit and
format as required. For example, select mm and ###.##.

The unit and format settings only become available when you select the
Length element in the Elements in mark list.

5. Give a name to the property file next to the Save as button and click Save
as.

Now you can load this file later on when you need to use the same unit
and format again.

6. Click Modify.

All the part marks in your drawing now have the new unit and format
setting for the length element.

Example 2

This second example shows a situation when you want a certain project to
have certain individual settings. In this case, you can add
contentattributes.lst under the model folder, and add this individual
setting at the end of the contentattributes.lst. See the example below
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showing the included global attributes and user attributes files, and the added 
DIAMETER setting.

See also

Mark elements (page 971)

Add templates in marks (page 854)

Add attributes in automatic marks
All types of building object marks allow you to add user-defined attributes and
template attributes. For example, you might want to add control numbers or
specify the number of characters in part numbers in assembly or part marks.

You can add user-defined attributes and template attributes in automatic and
manual marks.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. Click Part mark.

5. In the mark properties dialog box, double-click the User-defined
attribute element in the Available elements list to add it in the mark.

6. Enter the user-defined attribute name in the Mark content - user
defined attribute dialog box exactly as it appears in the objects.inp
file. 

If you need a template attribute in your mark, enter that instead.
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7. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.

8. Click Save to save the drawing properties, then click OK and create the
drawing.

Example

In the following example, the user-defined attribute OBJECT_LOCKED has been
added in the part mark after a text element Locked:.

See also

Add level attributes in automatic part marks (page 851)

Mark elements (page 971)

Add level attributes in automatic part marks
You can add level attributes, such as TOP_LEVEL, BOTTOM_LEVEL, 
ASSEMBLY_TOP_LEVEL, ASSEMBLY_BOTTOM_LEVEL, and 
ASSEMBLY.MAIN_PART.TOP_LEVEL, in part marks as user-defined attributes.

The level attributes take the dimension format from the
MarkDimensionFormat.dim file. If you want, you can also change the
dimension format in the Dimension Properties dialog box in an open
drawing and load the changed dimension properties in the dimensioning rule
that you use for creating dimensions in a view.

You can add level attributes in automatic and manual marks.

To change the dimension format and add level attributes:

1. In an open drawing, on the Drawing tab, click Properties --> Dimension.

2. Select MarkDimensionFormat from the properties file list at the top, and
click Load.

3. Change the unit, precision and format as desired. 
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4. Click Save to save the changes in the MarkDimensionFormat file, and
then click Cancel to close the dialog box.

5. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

6. Load drawing properties that are as close to the ones you need as
possible.

7. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

8. Click Part markPart mark.

9. In part mark properties, double-click the User-defined attribute element
to add it to the mark.

10. Enter a user-defined attribute name in the Mark content - user defined
attribute dialog box. 

You can enter the following values:

TOP_LEVEL
TOP_LEVEL_UNFORMATTED
TOP_LEVEL_GLOBAL
TOP_LEVEL_GLOBAL_UNFORMATTED
BOTTOM_LEVEL
BOTTOM_LEVEL_UNFORMATTED
BOTTOM_LEVEL_GLOBAL
BOTTOM_LEVEL_GLOBAL_UNFORMATTED
ASSEMBLY_TOP_LEVEL
ASSEMBLY_TOP_LEVEL_UNFORMATTED
ASSEMBLY_TOP_LEVEL_GLOBAL
ASSEMBLY_TOP_LEVEL_GLOBAL_UNFORMATTED
ASSEMBLY_BOTTOM_LEVEL
ASSEMBLY_BOTTOM_LEVEL_UNFORMATTED
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ASSEMBLY_BOTTOM_LEVEL_GLOBAL
ASSEMBLY_BOTTOM_LEVEL_GLOBAL_UNFORMATTED
CAST_UNIT_TOP_LEVEL
CAST_UNIT_BOTTOM_LEVEL
and/or the following: 

ASSEMBLY.MAIN_PART.TOP_LEVEL.

11. Click Dimensioning in the options tree.

12. Select a dimension rule from the list and click Edit rule.

13. Select MarkDimensionFormat from the Dimension properties list.

14. Save the dimensioning rule by clicking Save and click Close.

15. Save the view properties clicking Save.

16. Click Save to save the drawing properties, then click OK and create the
drawing.

Example

In the following example, TOP_LEVEL and ASSEMBLY_TOP_LEVEL have been
added in the mark.

In the following example, the top level of the part itself (TOP_LEVEL), the top
level of the assembly (ASSEMBLY_TOP_LEVEL), and the top level of the
assembly main part (ASSEMBLY.MAIN_PART.TOP_LEVEL) have been added in
the mark.
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See also

Add attributes in automatic marks (page 850)

Units and decimals in drawings, reports and templates (page 902)

Add templates in marks
You can create custom graphical templates (.tpl) with Template Editor and
add them as elements in all types of marks, dimension marks and associative
notes in all drawing types.

In mark templates, you can include detailed information of an embed or
assembly, such as the sub-material used. Or you can use a template that
changes the unit and the number of decimals in measurement values in a
mark. You can also add graphical objects using the Template Editor tools.

To add templates in dimension marks or tags, you need to modify the
Dimension Properties in an open drawing. You can save the dimension
properties, and then take the saved properties into use when you create
automatic dimensions (page 729).

The size of the templates in part marks is calculated according to the actual
size of template contents. Only lines and texts in the template are considered
when calculating the exact size. This means, for example, that circles or
bitmaps in the template do not have any effect.
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Limitations: Mark templates do not support image files like the other
graphical drawing templates.

Before you add a template in a mark, ensure that the template you use does
not contain any margins.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. Click the mark type that you want to change. 

For example, click Part mark.

5. In the mark properties dialog box, double-click the Template element in
the Available elements list to add it in the mark. 

This will remove all other elements from the mark.

6. Select a template from the list in the Mark content - template dialog
box. If you have not created a template yet, or want to edit the template,
you can do that from here by selecting Create new... or Edit...

Remember that if you edit the template here, the change affects all
drawings that have marks containing the changed template.

7. Click OK to return to mark properties.

8. Save the mark properties for later using a unique name.

9. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.

10. Click Save to save the drawing properties, then click OK and create the
drawing.

11. When necessary, copy the saved mark properties files from the <model>
\attributes folder into your firm or project folder.

TIP The mark templates are by default searched from the following folders in the
following order:

%XS_TEMPLATE_DIRECTORY%\mark
ModelDir\mark
%XS_PROJECT%\mark
%XS_FIRM%\mark
%XS_TEMPLATE_DIRECTORY_SYSTEM%\mark
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%XS_SYSTEM%\mark
The mark folder name can be changed using the advanced option 

Example

For more information about templates in marks, see the following examples:

Example 1: Create a mark template containing separate value fields and text
elements (page 856)

Example 2: Create a mark template containing a formula in the value field
(page 858)

Example 1: Create a mark template containing separate value fields
and text elements
You can use decimals instead of fractions in your part marks in the US
environment Imperial role by using a mark template. The template contains
separate value fields and text elements that change the fractions to decimals,
and change the number of decimals.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. Click Part mark.

5. Double-click Template in the Available elements list.
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6. In the Mark content - template dialog box, click Create new. 

This starts the Template Editor.

7. Click File --> New and create a new graphical template.

8. Click Insert --> Component --> Row .

9. Select PART as the content type.

10. Click Insert --> Text , enter L and place it inside the row you just added.

11. Click Insert --> Value field and place the value field on the right side of
the L text.

12. In the displayed Select Attribute [Part] dialog box, scroll down to
PROFILE - Profile, open the profile tree, select the HEIGHT - height
property and click OK.

13. Double-click the value field. In the Value Field Properties dialog box,
change the settings as follows: 

• Unit: inch
• Decimals: 1
• Length: 8

14. Click OK.

15. Click Insert --> Text , enter X as text and place it on the right side of the
value field.

16. In the similar way, add another value field for the width information
(WIDTH - Width profile property).

17. Click Insert --> Text and add the second X between the value fields.

18. Add the third value field for the profile flange thickness by selecting
FLANGE_THICKNESS_1 - Flange thickness 1 profile property and modify
the settings as follows: 

• Unit: inch
• Decimals: 2
• Length: 4

19. Click Edit --> Properties and minimize the height and the width of the
row.

20. Click File --> Save to save the template. 

The template is by default saved as a .tpl file in the \mark folder under
the model folder. You can copy this template to other models as required.

21. In Tekla Structures, click Refresh list in the Mark content - template
dialog box to see the template you created.

22. Select the template and click OK.
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23. Save the mark properties for late use with a unique name.

24. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.

25. Click Save to save the drawing properties, then click OK and create the
drawing.

Example

The first example below uses fractions and the second one decimals.

Example 2: Create a mark template containing a formula in the value
field
You use decimals instead of fractions in your part marks in the US
environment Imperial role by adding a formula in the mark template value
field.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. Click Part mark.

5. In the mark properties dialog box, double-click the User-defined
attribute element in the Available elements list to add it in the mark.
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6. In the Mark content - template dialog box, click Create new. 

This starts the Template Editor.

7. Click File --> New and create a new graphical template.

8. Click Insert --> Component --> Row .

9. Select PART as the content type.

10. Click Insert --> Value field , and place the field.

11. In the displayed Select Attribute [Part] dialog box, click the Formula
button.

12. Add the following formula in the Formula box and click OK: 

"L " + format(GetValue("HEIGHT"),"Length","inch",1) + " x
"+ format(GetValue("WIDTH"),"Length","inch",1) + " x " +
format(GetValue("PROFILE.FLANGE_THICKNESS_1"),"Length","i
nch",2)

13. Double-click the value field to open the Value Field Properties dialog
box.

14. Set the Data type to text, enter a name for the field, for example,
PART_MARK, and ensure that the length value you give in the Length field
is high enough to fit all the characters and numbers included, for
example, 20.

15. Click OK.

16. Click Edit --> Properties and minimize the height and the width of the
row.

17. Click File --> Save to save the template. 

The template is by default saved as a .tpl file in the \mark folder under
the model folder. You can copy this template to other models as required.

18. In Tekla Structures, click Refresh list in the Mark content - template
dialog box to see the template you created.

19. Select the template and click OK.

20. Save the mark properties for later use with a unique name.

21. Single-part, assembly and cast unit drawings:Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.

22. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Example 1: Create a mark template containing separate value fields and text
elements (page 856)
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Add symbols in automatic marks
All types of marks allow you to add symbols in them. You can select the
symbol file to be used and the symbol to be added in the mark.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties.

4. Click Part mark.

5. In mark properties, double-click Symbol in the Available elements list.

6. In the Mark content - symbol dialog box, click Select... next to the File
box to select the symbol file you want to use.

7. When you have selected the file, click Select... next to the Number box to
select the number of the symbol you want to use.

8. Click OK. 

Tekla Structures adds the name of the symbol file and the number of the
symbol in the elements list.

9. Save the mark properties for late use with a unique name.

10. Single-part, assembly and cast unit drawings: Click Save to save the
changes in view properties and Close to return to drawing properties. 

General arrangement drawings: Click OK.

11. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Add symbols in drawings (page 330)

Define size in bolt marks using advanced options
You can use certain advanced options to define the contents of the bolt mark
Size element in different types of drawings.

To change the bolt mark Size element content, go to File menu --> Settings --
> Advanced options --> Marking: Bolts .

NOTE • General arrangement drawings have separate advanced options.
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• Any changes made to the advanced options listed in the table
below will take place only in the new drawings you create, and if
you modify the affected bolt marks.

To Do this
Define the contents of the size
element in slotted hole marks or
longhole marks (general arrangement
drawings).

Set a value for the advanced option 
XS_LONGHOLE_MARK_STRING_FOR_S
IZE.

For GA-drawings, set a value for the
advanced option 
XS_LONGHOLE_MARK_STRING_FOR_S
IZE_IN_GA.

Define the contents of the size
element in slotted hole marks or
longhole marks (general arrangement
drawings) for site bolts.

Set a value for the advanced option 
XS_SITE_LONGHOLE_MARK_STRING_
FOR_SIZE.

For GA-drawings, set a value for the
advanced option 
XS_SITE_LONGHOLE_MARK_STRING_
FOR_SIZE_IN_GA.

Define the contents of the size
element in slotted hole marks or
longhole marks (general arrangement
drawings) for workshop bolts.

Set a value for the advanced option 
XS_SHOP_LONGHOLE_MARK_STRING_
FOR_SIZE.

For GA-drawings, set a value for the
advanced option 
XS_SHOP_LONGHOLE_MARK_STRING_
FOR_SIZE_IN_GA.

Define the contents of the size
element in hole marks.

Set a value for the advanced option 
XS_HOLE_MARK_STRING_FOR_SIZE.

For GA-drawings, set a value for the
advanced option 
XS_HOLE_MARK_STRING_FOR_SIZE_
IN_GA.

Define the contents of the size
element in hole marks for site bolts.

Set a value for the advanced option 
XS_SITE_HOLE_MARK_STRING_FOR_
SIZE
For GA-drawings, set a value for the
advanced option 
XS_SITE_HOLE_MARK_STRING_FOR_
SIZE_IN_GA
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To Do this
Define the contents of the size
element in hole marks for workshop
bolts.

Set a value for the advanced option 
XS_SHOP_HOLE_MARK_STRING_FOR_
SIZE
For GA-drawings, set a value for the
advanced option 
XS_SHOP_HOLE_MARK_STRING_FOR_
SIZE_IN_GA

Define the contents of the size
element in bolt marks.

Set a value for the advanced option 
XS_BOLT_MARK_STRING_FOR_SIZE
For GA-drawings, set a value for the
advanced option 
XS_BOLT_MARK_STRING_FOR_SIZE_
IN_GA

Define the contents of the size
element in bolt marks for site bolts.

Set a value for the advanced option 
XS_SITE_BOLT_MARK_STRING_FOR_
SIZE
For GA-drawings, set a value for the
advanced option 
XS_SITE_BOLT_MARK_STRING_FOR_
SIZE_IN_GA

Define the contents of the size
element in bolt marks for workshop
bolts.

Set a value for the advanced option 
XS_SHOP_BOLT_MARK_STRING_FOR_
SIZE
For GA-drawings, set a value for the
advanced option 
XS_SHOP_BOLT_MARK_STRING_FOR_
SIZE_IN_GA

You can use any combination of text and the following options as the value for
the above advanced options. Enclose each option in % characters. To use
special characters enter a backslash (\) followed by an ASCII number. You can
use the options in any order, and make calculations.

• BOLT_NUMBER
• DIAMETER
• LENGTH
• HOLE.DIAMETER
• LONG_HOLE_X
• LONG_HOLE_Y
• LONGHOLE_MIN (the shorter of the slotted hole dimensions)

• LONGHOLE_MAX (the longer of the slotted hole dimensions)
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• BOLT_STANDARD
• BOLT_MATERIAL
• BOLT_ASSEMBLY_TYPE
• BOLT_COUNTERSUNK
• BOLT_SHORT_NAME
• BOLT_FULL_NAME

Example

Example of using the advanced options:

XS_LONGHOLE_MARK_STRING_FOR_SIZE=D%HOLE.DIAMETER%
(%HOLE.DIAMETER+LONG_HOLE_X%x%HOLE.DIAMETER+LONG_HOLE_Y%)
XS_SITE_HOLE_MARK_STRING_FOR_SIZE=D%HOLE.DIAMETER%
Please note that for calculations the operator (+, -, *, /) must not be outside the
"%" marks:

Correct: %OPTION1*OPTION2%
Incorrect: %OPTION1%*%OPTION2%
For example, if OPTION1 = 5.0 and OPTION2 = 3.0, the results would be "15"
and "5*3"

Add pull-out pictures in automatic reinforcement marks
You can add a pull-out picture for a reinforcing bar in the reinforcement mark
to illustrate the shape and dimensions of the bar in the drawing.

Pull-out pictures can be added in automatic and manually created
reinforcement marks.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Cast unit drawings: Click View creation in the options tree on the left,
select the view and the properties that you want to change, and click View
properties.

4. Click Reinforcement mark.

5. Double-click the Pullout picture element in the Available elements list
to add it in the reinforcement mark.

6. In the Pullout picture dialog box, select the scaling option in Scale by: 

• Auto auto-scales the pull-out.
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• One factor and Two factors scale the pull-out according to the values
that you enter.

The scale of the pull-out is relative to the scale of the drawing view. For
example, if the drawing view scale is 1/10 and the pull-out scaling is 2,
the actual scale of the pull-out in the drawing view is 1/5.

7. In Rotation, select the rotation of the pull-out: Automatic, Plane or 3D. If
the pull-out is 3D, and you select Automatic, Tekla Structures
automatically shows the pull-out in 3D.

8. In End marks, define the shape of bar ends in the pull-out.

9. Select Dimensions to show bar dimensions in the pull-out.

10. Select Exaggeration to show reinforcing bar hooks more clearly in the
pull-out.

11. Select Bending radius to show the bending radius in form of diameter of
the bending roll.

12. Select Bending angle to show bar bending angles in the pull-out.

13. Select Coupler/end anchor symbols to show graphical symbols
representing the rebar couplers and end anchors in pull-out pictures.

14. Select Placeholders to show placeholders instead of dimensions in pull-
out pictures.

15. Click OK.

16. Save the mark properties for late use with a unique n

17. Cast unit drawings: Click Save to save the changes in view properties
and Close to return to drawing properties. 

General arrangement drawings: Click OK.

18. Click Save to save the drawing properties, then click OK and create the
drawing.

Example

A 3D pull-out showing the bending radius:
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Placeholders shown instead of dimensions:

TIP To change the leader line length, color, line type, or representation of a pull-out,
open the (page 1004) file located in the system folder defined by the advanced
option XS_SYSTEM and edit the following lines: 
PullOutLeaderLineMinLength, PulloutColor, PulloutVisibleLinetype
and PulloutRepresentation.

See also

Reinforcement and neighbor reinforcement mark elements (page 976)

8.7 Define drawing grids
You can show grids in all types of drawings. You can change the appearance
and visibility of the labels, label frames, and grid lines.
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See also

Grids in drawings (page 534)

Define automatic grid properties (page 866)

Drawing grid properties (page 1018)
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Define automatic grid properties
You can modify drawing grid properties of single-part, assembly and cast unit
drawings individually for each view. In general arrangement drawings, you can
modify the grid properties on both view and drawing level. You can also
modify individual grid properties of in an open drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click Grid.

5. Modify the grid properties as required.

6. Single-part, assembly and cast unit drawings: Click Save to save the view
properties and click Close. 

General arrangement drawings: Click OK.

7. Click Save to save the drawing properties, then click OK and create the
drawing.

TIP The advanced options and allow you to adjust the grid labels further.

See also

Drawing grid properties (page 1018)

8.8 Define drawing parts and neighbor parts
Parts and neighbor parts in drawings are building objects that will exist in the
real structure or which will be closely related to the structure.

Parts and neighbor parts have drawing properties that affect the way that the
part is shown in the drawing.

To Click the links below to find out
more

Define what is shown in a part and
how the part is shown

Define automatic drawing part
properties (page 868)

Define what is shown of neighbor
parts and how the neighbor parts are
shown. You can also control the
visibility of the neighbor part bolts.

Define automatic neighbor part
properties (page 872)
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To Click the links below to find out
more

Check examples of modifying the part
settings

Example: Part representations
(page 869)

Indicate the part orientation by using
part marks, by including compass
direction in marks, and showing
orientation marks and connecting
side marks

Indicate part orientation (page 873)

Check and change part and neighbor
part properties

Part and neighbor part properties in
drawings (page 991)

Define automatic drawing part properties
You can define what is shown in a part and how the part is shown.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in
the options tree on the left, select the view and the properties that you
want to change, and click View properties..

4. Click Part.

5. On the Content tab, select the part representation, whether to show
hidden lines, center lines and reference lines, and which additional
markings to show. 

A reference line is a line between the points from which a part is created.

Note that Bounding box is a good option to use with complex items with
an extrema box containing many polygons slowing down drawings,
because Bounding box makes drawings faster.

6. On the Appearance tab, select the color and type of the lines. 

The color of the center lines can be changed only on the drawing and view
level, not on the object level. For center lines, you can only adjust the color
in the properties dialog box, not the type. You can adjust the line type of
part center lines with the advanced option XS_CENTER_LINE_TYPE.

7. On the Fill tab, set the part and section fill options.

8. Do one of the following depending on the drawing type: 

• Single-part, assembly and cast unit drawings: Click Save to save the
view properties. Then return to drawing properties by clicking Close.
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• General arrangement drawings: Click OK to return to drawing
properties.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Part and neighbor part properties in drawings (page 991)

Example: Part representations (page 869)

Example: Part representations

Here are some examples of what parts and items look like with different
settings defined in the View Properties dialog box.

Setting Example
Part and item
Representation is set to
Outline.
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Setting Example
Representation is set to
Exact.

The Edge chamfers
check box is selected in
Additional marks.

Representation is set to
Symbol.
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Setting Example
Representation is set to
Symbol with partial
profile.

You can change the
partial profile settings
Length and Offset from
middle point. In the first
example on the right,
the default values are
used. In the second
example, both the
length and the offset
have been adjusted.
Representation is set to
Bounding box.

Representation is set to
Bounding box.
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Setting Example
Representation is set to
Base box.

Representation is set to
Exact and Symbol
offset is set to 0.00.

The Center line check
box is selected.
Representation is set to
Exact and Symbol
offset is set to 10.00.

The Center line check
box is selected.
The Hidden lines check
box is not selected.

The Hidden lines check
box is selected.

The Own hidden lines
check box is selected.

1. Hidden lines for
other parts are
shown.

2. Own hidden lines
for the main part
are shown.

See also

Part and neighbor part properties in drawings (page 991)

Define automatic drawing part properties (page 868)

Define automatic neighbor part properties
You can define what is shown of neighbor parts and how the neighbor parts
are shown. You can also control the visibility of the neighbor part bolts.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
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2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click Neighbor part.

5. Select the desired visibility options on the Visibility tab. 

• For more information, see Show neighbor parts in drawings
(page 705).

6. On the Content tab, select the neighbor bolt representation, whether to
show hidden lines, center lines and reference lines, and which additional
markings to show. 

A reference line is a line between the points from which a part is created.

7. On the Appearance tab, select the color and type of the lines. 

The color of the center lines can be changed only on the drawing and view
level, not on the object level. For center lines, you can only adjust the color
in the properties dialog box, not the type.

You can adjust the line type of part center lines with the advanced option .

8. Single-part, assembly and cast unit drawings: Click Save to save the view
properties. Then return to drawing properties by clicking Close.

9. General arrangement drawings: Click OK to return to drawing properties.

10. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Define drawing parts and neighbor parts (page 867)

Part and neighbor part properties in drawings (page 991)

Example: Part representations (page 869)

Indicate part orientation
Part orientation marks indicate the erection direction of assemblies and cast
units. There are many ways available for indicating part orientation: by using
part marks, by including compass direction in marks, and showing orientation
marks and connecting side marks.

To check how the location of the mark is affected by mark placement settings,
the type of the leader line, predefined mark location and part orientation
settings, modeling direction of parts, and drawing protection settings, see
Mark location (page 837).
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Use part mark as an orientation mark in general arrangement
drawings
In general arrangement drawings, part marks appear at the same end as in
assembly drawings. Parts with the same assembly position are always marked
at the same end.

1. Select Drawings & reports --> Drawings properties --> Assembly
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.

3. In assembly drawing properties, click View creation --> Attributes and
set the Coordinate system to oriented or model. 

You must use oriented or model if you want the Viewing direction
settings in File menu --> Settings --> Options --> Orientation marks to
have effect.

4. Click Save to save the properties and Close to close the dialog box.

5. In the model, click Drawings & reports --> Numbering settings -->
Numbering settings and clear the Beam orientation and Column
orientation check boxes. 

When you do this, similar assemblies get the same number regardless of
the part orientation.

6. Go to File menu --> Settings --> Options --> Orientation marks and set
the following options: 

• Set the desired Viewing direction for beams, bracings and columns.

• Set Mark always to center of column in GA drawings to No.

• Set Preferred location for beams and bracings to Left or Right.

The preferred location determines the end where the mark is placed.

7. Click OK.

8. Check the leader line type through Drawings & reports --> Drawings
properties --> GA drawing --> Part marks --> General . 

Place the mark near the part end, not in the middle of the part using one
of the following settings:

9. Click Save to save the drawing properties and OK to close the dialog box.
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10. Create assembly (and single-part) drawings using the settings you
modified. 

If you have not created a drawing earlier, the modeling direction of the
part that has the smallest id is used, except if the top-in-form face has
been defined.

11. Create general arrangement drawings using the settings you modified.

NOTE • In general arrangement drawings, the cast unit part marks behave
in the same way as the assembly part marks, except when Top in
form face is set to Front or Back on the Parameters tab of the
part’s User-defined attributes dialog box. These settings tell the
end where the part mark is placed.

• When you update an assembly drawing so that the mark is placed
at the other end of the part, remember to update the marks in the
corresponding general arrangement drawing. Tekla Structures
does not do this automatically.

• Also note that if you have set the advanced option 
XS_UPSIDE_DOWN_TEXT_ALLOWED to TRUE, the text reading
direction indicates the part installation direction.

Example

The part mark is positioned at the stiffener side:

The marks are positioned at the same side irrespective of the orientation of
the beams:
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Show compass direction in part marks
You can include face direction information in part marks. No matter where you
add or move the mark, the face direction stays the same. The face direction
indicates the compass direction (North, East, South, West) of the face where
the mark appears.

Limitation: Tekla Structures indicates the face direction only if it is the same
for all assemblies or cast units with the same assembly or cast unit position
number.

1. Check in which direction north is in the model by clicking File --> Settings
--> Options --> Orientation marks and checking Project north (degrees
counterclockwise from global x). 

For more information about the orientation mark settings in the Options
dialog box, see .

2. In the model, click Drawings & reports --> Numbering settings and
select the Column orientation check box. 

This forces Tekla Structures to show the face direction in the part mark for
two similar columns with different orientation.

3. In the desired assembly or cast unit drawing view properties, click Part
mark and insert the Face direction element in the part mark.
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Now the assembly or cast unit drawings show the face direction in the part
marks.

TIP To show compass direction in GA drawings, go to File --> Settings --> Options --
> Orientation marks and set Mark always to center of column in GA
drawings to No.

Show orientation marks (north marks)
You can use orientation marks or north marks to indicate the erection
direction of assemblies. The default orientation mark is a triangle inside a
circle.

1. On the Drawings & reports tab, click Drawing properties --> Assembly
drawing.

2. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

3. Click Part --> Content and select the Orientation marks check box.

4. Save the view properties and click Close.

5. Save the assembly drawing properties and click OK.

6. If needed, define which parts Tekla Structures considers to be columns,
braces or beams by setting the skew limits through File menu -->
Settings --> Options --> Orientation marks --> Skew limit .

7. Use the following advanced options to adjust orientation marks: 

• XS_ORIENTATION_MARK_DIRECTION

• XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS

• XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS

• XS_NORTH_MARK_SYMBOL

• XS_HIDDEN_NORTH_MARK_SYMBOL

• XS_NORTH_MARK_SCALE
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• XS_GA_NORTH_MARK_SYMBOL (general arrangement drawings)

• XS_GA_HIDDEN_NORTH_MARK_SYMBOL (general arrangement
drawings)

• XS_GA_NORTH_MARK_SCALE (general arrangement drawings)

8. Create the assembly drawing.

For different parts, Tekla Structures draws orientation marks in the following
way:

• To the top flange of beams, at the end which points closest to the north or
to the direction defined in XS_ORIENTATION_MARK_DIRECTION (see part 1
and 2 in the illustration below)

• To the lower end of columns, on the flange which points closest to the
north or to the direction defined in XS_ORIENTATION_MARK_DIRECTION
(see part 4 in the illustration below)

• To the flange of bracing, at the end which points closest to the north or to
the direction defined in XS_ORIENTATION_MARK_DIRECTION (see 3 A and
B in the illustration below)

TIP You can display orientation marks for single-part views included in assembly
drawings by setting the advanced option to TRUE.

Show connecting side marks
You can use a symbol in assembly drawings to indicate the side of a part to
which a connecting part is attached.

1. Select Drawings & reports --> Drawings properties --> Assembly
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.

3. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

4. Click Part.
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5. On the Content tab, select the Connecting side marks check box.

6. Click Save to save the view properties.

7. Click Close.

8. Click Save to save the drawing properties, then click OK and create the
drawing. 

TIP If needed, you can change the connecting side mark symbol with the advanced
option , and use to control whether the connecting side mark is drawn or not.

8.9 Define drawing bolts
Bolts are connecting objects that fasten parts or assemblies or attach to them.
You can change how the bolts are shown in drawings.

To Click the links below to find out
more

Change how the bolts are shown in
drawings

Define automatic bolt properties in
drawings (page 880)

Create you own bolt symbols Create customized bolt symbols
(page 880)

Chech examples of different bolt
settings

Example: Bolt representations
(page 881)
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To Click the links below to find out
more

Check bolt properties Bolt content and appearance
properties in drawings (page 997)

Define automatic bolt properties in drawings
You can define what is shown in bolts and how the bolts are shown.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click Bolt.

5. On the Content tab, select the bolt representation, bolt symbol content,
and the visibility of bolts in main parts. 

For assembly and cast unit drawings, you can also set the visibility of bolts
in secondary parts and sub-assemblies.

6. On the Appearance tab, select the color of the bolts.

7. Single-part, assembly and cast unit drawings: Click Save to save the view
properties. Then click Close to return to drawing properties.

8. General arrangement drawings: Click OK.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Define drawing bolts (page 879)

Bolt content and appearance properties in drawings (page 997)

Example: Bolt representations (page 881)

Create customized bolt symbols
You can create your own bolt symbols in Symbol Editor and use them in
drawings. You only need to create bolt symbols if you need different bolt
symbols than the ones that you can find in Tekla Structures.
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1. Save the symbol file ud_bolts.sym in the symbol folder (usually the
folder..\Tekla Structures\<version>\environments\common
\symbols\).

2. Open Microsoft Notepad, or any text editor.

3. Create a text file consisting of lines in three columns: 

• The first column contains the bolt assembly standard.

• The second contains the bolt diameter.

• The third column contains the name of the symbol file and the symbol
number, separated with the @ character.

Example of file contents:

7990 24 ud_bolts@1
7990 25 ud_bolts@2
Tekla Structures uses the user-defined symbol for bolts in drawings
that have the standard and diameter you define in this text file.

4. Save the file with the name bolt_symbol_table.txt.

5. Set the name of the file as a value for the advanced option 
XS_USER_DEFINED_BOLT_SYMBOL_TABLE in File menu --> Settings -->
Advanced options --> Marking: Bolts as follows: 

XS_USER_DEFINED_BOLT_SYMBOL_TABLE=bolt_symbol_table.txt
You can also enter a full path to the bolt definition file. Without the path
Tekla Structures searches for the file in the model, firm, project, and
system directories.

6. To use your own bolt symbol, click Bolt --> Content --> Solid/Symbol -->
User-defined symbol in the drawing view properties dialog box.

See also

Define drawing bolts (page 879)

Example: Bolt representations
There are several representation options available for displaying bolts in
drawings.

You can select the options from the Solid/Symbol list. Here are some
examples of different selections.

Note that there can be difference in bolt represetation depending of whether
the bolt is workshop or site bolt, and also what kind of a symbol has been
defined in the xsteel.sym file.
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Setting Example
solid

exact solid

Symbol

Symbol2

Symbol3 Example of a workshop bolt:
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Setting Example
DIN symbol

See also

Define drawing bolts (page 879)

Bolt content and appearance properties in drawings (page 997)

8.10 Define hatches in drawings
Use hatching on part faces, part sections or drawing shapes, such as circles
and polygons, to show different materials.

The hatches are located in the hatch_types1.pat file in the folder defined
by the advanced optionXS_INP. You can also use hatch patters on surface
treatment.

You can also add hatch patterns to Tekla Structures:

• To add custom hatch patterns in the hatch_types1.pat file, see How can
I define my own hatch patterns.

Define automatic drawing settings 883 Define hatches in drawings

https://teklastructures.support.tekla.com/support-articles/how-can-i-define-my-own-hatch-patterns
https://teklastructures.support.tekla.com/support-articles/how-can-i-define-my-own-hatch-patterns


• If you have a hatch pattern file (created in a CAD software, for example),
you can add it to Tekla Structures .pat file with a little modification, see
Adding custom fill patterns.

See also

Add hatches (fills) to parts and sketch objects in drawings (page 884)

Colors in drawings (page 547)

Define automatic surface treatment in drawings (page 892)

Example: Insulation hatch patterns (page 890)

Hatch pattern settings (.htc) for automatic drawing hatches (page 887)

Surface treatment hatch pattern properties (surfacing.htc) (page 999)

Add hatches (fills) to parts and sketch objects in drawings
You can use hatches as fills in parts, neighbor parts, cross sections and sketch
objects in a drawing. You can use automatic hatches or manual hatches.

Limitations

There are some limitations in the hatch background color usage:

• Background color does not work in conjunction with hardware hatches.

• The background color does not have any effect if there is an automatic
hatch available. The background color can only be changed if the automatic
hatch is not defined for the material type.

To add a fill to a part:

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click Part and go to the Fill tab.

5. Select the hatch from the Type list. Select Automatic or a manual hatch
pattern. 

To preview the hatches, click the ... button next to the Type list.

You can select the desired hatch by double-clicking it in the Hatches
window.
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If you select Automatic, Tekla Structures uses the hatches defined in the
hatch schema file (page 887) (.htc). Each drawing type has its own
schema file.

The names of the schema files (page 887) Tekla Structures are defined in
the Hatching category of the Advanced Options dialog box:

6. Define a color for the hatch (page 547) in the Color box.

7. Define a background color for the hatch in the Background box. 

You can define the background color only after selecting a hatch first.

8. In Scale, select whether to use automatic or custom scaling and rotation
for hatches. 

If you select automatic scaling and rotation, Tekla Structures automatically
scales the hatch to suit the profile size, and you do not need to edit each
drawing manually. If you select Custom scaling and rotation:

• Enter the scales in Scaling in direction x and Scaling in direction y,
and select whether to Keep ratio of x and y.

• Enter the angle of rotation in the Angle box. Angle 0.0 is for horizontal
and 90.0 for vertical.

9. Single-part, assembly and cast unit drawings: Click Save to save the
view properties. Then return to drawing properties by clicking Close.

10. General arrangement drawings: Click OK to return to drawing
properties.

11. Click Save to save the drawing properties, then click OK and create the
drawing.
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Example

In the example below, the following hatch options have been selected for
cross sections:

Scale: Custom

Scaling in direction x: 0.25

Scaling in direction y: 0.50

Keep ratio of x and y is selected.

Angle: 10.00

Cast-in-place and precast hatches use different automatic hatch depending on
the cast unit type. You need to select the appropriate cast unit type in the
concrete part properties.
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NOTE If the hatches are not displayed in the drawing, check the session history log
for the following messages:

"Solid warning: Clipped part Id: XXXX was created with second fall back and
may contain overlapping volume and area."

"Solid warning: Pour Id: XXX was created with second fall back and may
contain overlapping volume and area."

Usually it is enough that you move a part or a cut a little bit, maybe 1 mm, in
any direction.

Some advanced options related to hatches

See also

Define hatches in drawings (page 883)

Part and neighbor part properties in drawings (page 991)

Hatch pattern settings (.htc) for automatic drawing hatches (page 887)

Hatch pattern settings (.htc) for automatic drawing hatches
The hatch patterns for material types and names in drawings are defined in a
hatch schema file .htc. Different drawing types (general arrangement,
assembly, single-part, and cast unit drawings) have their own schema files.
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The hatch patterns defined in schema files are used when you set Type to
Automatic on the Fill page in the part or shape properties.

Hatch schema file name and location

The name of the schema file Tekla Structures uses for each drawing type is
defined in the Hatching category of the Advanced Options dialog box:

• XS_DRAWING_GA_HATCH_SCHEMA=general.htc
• XS_DRAWING_ASSEMBLY_HATCH_SCHEMA=assembly.htc
• XS_DRAWING_SINGLE_PART_HATCH_SCHEMA=single.htc
• XS_DRAWING_CAST_UNIT_HATCH_SCHEMA=cast_unit.htc
The default schema files are located in the ..\Tekla Structures
\<version>\environments\common\system folder. The environment-
specific schema files are located under the environments. The exact file
location may vary depending on the folder structure of you environment files.

Schema file syntax
Material type, Cast unit type, Material name, Hatch name,
Scale, Color, Automatic scaling and rotation
Examples:

CONCRETE,,hardware_SOLID,,120 (gray shade)

CONCRETE,Precast,C25/30,CONC,0.3,1 ("traditional" concrete Precast)

CONCRETE,CIP,C25/30,CONCRE,0.3,1 ("traditional" concrete CIP)

CONCRETE,,CROSS,2,1 (small crosses)

MISCELLANEOUS,Insulation,HARD_INS1,1,,1 (straight lines)

MISCELLANEOUS,Insulation,SOFT_INS,1,,1 (rounded lines)

MISCELLANEOUS,Insulation,SOFT_INS2,1,,1 (completely round)

To see an example of the cast_unit.htc file, click the following link:
cast_unit.htc

Option Description
Material type STEEL, CONCRETE, TIMBER,

MISCELLANEOUS (case sensitive)
Cast unit type Precast or CIP. You also need to

define the cast unit type for concrete
parts in part properties.

Material name The material name defined for the
part in part properties in the model.

The character limit for the material
name is 32 characters.
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Option Description
Hatch name To check the hatch pattern names

and related hatch patterns go to the
Fill tab in Part properties, select a
hatch pattern from the Type list and
click the ... button next to the list.
Then click a pattern to see its name in
the Type list. The selected hatch
pattern is marked with a red frame.
Hatch names are case sensitive.

If you do not want to use any hatch
pattern for a material, leave the hatch
name field blank in the schema file.

Color BLACK: 0 (default)

WHITE: 1

RED: 2

GREEN: 3

BLUE: 4

CYAN: 5

YELLOW: 6

MAGENTA: 7

Special: 120 (use this color for gray
shade)

GRAYSCALE 1: 130

GRAYSCALE 2: 131

GRAYSCALE 3: 132

GRAYSCALE 4: 133

The hatch color defines the line width
for the printer. If you do not define a
color for a hatch in the schema file,
Tekla Structures uses the default
color black (0). To use the special
color that is printed as color or
grayscale, depending on the selected
printer settings, set the color number
in the .htc file to 120.

To adjust the gray shade for Special
color 120, use the following advanced
options:

XS_HATCH_SPECIAL_COLOR_R
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Option Description
XS_HATCH_SPECIAL_COLOR_G

XS_HATCH_SPECIAL_COLOR_B
Scale Scale is a numeric value that Tekla

Structures uses to scale hatches.
Automatic scaling and
rotation

Automatic scaling and rotation
defines whether you want to use
automatic scaling and rotation.

TRUE: 1

FALSE: 0 (default)

Automatic scaling and rotation
requires additional processing, so use
it only when necessary.

See also

Add hatches (fills) to parts and sketch objects in drawings (page 884)

Part and neighbor part properties in drawings (page 991)

Example: Insulation hatch patterns

You can use the following fill types to represent insulation:

These hatch types can be scaled and rotated.

Hatch name Pattern
HARD_INS1

SOFT_INS
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Hatch name Pattern
SOFT_INS2

Previewing patterns

To preview the scaled and rotated patterns, click the ... button next to the
Type box.

See also

Define hatches in drawings (page 883)

8.11 Define drawing surface treatment
You can add various types of surface treatment to steel and concrete parts in
the Tekla Structures model and show them in drawings.

The properties of the hatch patterns to use for each surface treatment type
are defined in the surfacing.htc file. Also the product_finishes.dat
code file is needed listing all surface treatment codes that are used in
drawings and reports, for example, TS1 for Tile Surface 1.

See also

Define automatic surface treatment in drawings (page 892)

Surface treatment visibility and content properties in drawings (page 998)
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Surface treatment hatch pattern properties (surfacing.htc) (page 999)

Define automatic surface treatment in drawings
You can define what is shown in a surface treatment and how the surface
treatment is shown in drawings.

The hatch pattern Tekla Structures adds on the surface treatment depends on
the type of the surface treatment that you selected in surface treatment
properties in the model, and on the hatch properties defined in the surface
treatment hatch pattern properties file surfacing.htc.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click Surface treatment.

5. On the Content tab, select the surface treatment representation, and
whether to show the surface treatment pattern, hidden lines, and own
hidden lines.

6. On the Appearance tab, select the color and type of visible and hidden
lines.

7. General arrangement drawings: Click OK.

8. Click Surface treatment mark, add the elements that you want to
include in the mark and adjust the appearance of the mark as required.

9. Single-part, assembly and cast unit drawings: Click Save to save the view
properties. Then click Close to return to drawing properties.

10. General arrangement drawings: Click OK.

11. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Define automatic surface treatment in drawings (page 892)

Surface treatment visibility and content properties in drawings (page 998)

Surface treatment hatch pattern properties (surfacing.htc) (page 999)

Define hatches in drawings (page 883)
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8.12 Define drawing welds
You can define automatic weld settings to be used in a drawing before you
create a drawing. You can modify the settings in an open drawing after you
have created the drawing.

Before creating a single-part drawing or an assembly drawing, you can define
the representation, visibility and appearance properties (page 1015) for the
model welds. For general arrangement drawings, representation settings can
only be defined on view and object level, not on drawing level.

See also

Define automatic model weld properties in drawings (page 893)

Welds in drawings (page 492)

Define automatic model weld properties in drawings
You can define what the model welds look like in your drawings before you
create the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part and assembly drawings: Click View creation in the options
tree on the left, select the view and the properties that you want to
change, and click View properties.

4. Click Weld.

5. On the Content tab, define the visibility settings: 

• In Welds and Welds in sub-assemblies, select Not visible, Site weld
visible, Workshop weld visible, or Both visible.

• In Weld size limit, enter a weld size to filter out welds of that size and
smaller.

This is useful when you only want to show non-typical welds in a
drawing.

To set whether the weld size is an exact or minimum value, use the
advanced option XS_WELD_FILTER_TYPE.

To filter out a standard weld type, use the advanced option 
XS_OMITTED_WELD_TYPE.

Note that you can also set the Weld size limit for all views in the
drawing at one go at the bottom of the View creation page in
assembly and single-part drawing properties (page 915).
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• In Representation, select Outline or Path, and enable Hidden lines
and Own hidden lines, if required.

6. On the Appearance tab, modify the color and line as required.

7. Single-part, assembly and cast unit drawings: Click Save to save the view
properties. Then click Close to return to drawing properties.

8. General arrangement drawings: Click OK.

9. Click Save to save the drawing properties, then click OK and create the
drawing.

See also

Model weld properties in drawings (page 1015)

Model weld mark visibility and appearance properties in drawings (page 986)

8.13 Define drawing pours
You can define automatic pour object settings to be used in a drawing before
you create a drawing. You can modify the pour settings in an open drawing
after you have created the drawing.

You can select whether to show pours and pour breaks in drawings, define the
desired pour object and pour break content and appearance. For pour objects,
you can also define the desired fill. Additionally, you can add automatic pour
object marks in your drawings.

You can change these settings also in an open drawing.

For more information, see Show pour objects, pour marks and pour breaks in
drawings (page 894).

See also

Pours in drawings (page 488)

Pour object and pour break properties in drawings (page 1010)

Add hatches (fills) to parts and sketch objects in drawings (page 884)

Show pour objects, pour marks and pour breaks in
drawings
You can show pour objects and pour breaks in general arrangement drawings.
You can also add automatic pour object marks.
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Ensure that you have enabled pour management (set the advanced option 
XS_ENABLE_POUR_MANAGEMENT to TRUE.)

To show pour objects and pour breaks automatically, modify their appearance
and add pour object marks:

1. On the Drawings & reports tab, click Drawing properties --> GA
drawing .

2. Load drawing properties that are as close to the ones you need as
possible.

3. In the properties dialog box, click the View... button and set Show pours
in drawing to Yes, and click OK.

4. Click the Pour object... button to modify the properties: 

• Content tab: Select whether you want to see the hidden lines and own
hidden lines, and the edge chamfers by clicking on or off.

• Appearance tab: Set the color and type for visible lines and hidden
lines.

• Fill tab: Select the fill for the pour object face and/or pour object
section face.

5. Click OK.

6. Click the Pour object mark... button, select the contents and appearance
of the mark, and click OK.

7. Click the Pour breaks... button and set the Visibility to Visible and click
OK. 

You can also select whether you want to show pour break hidden lines on
the Visibility tab. On the Appearance tab you can change the color and
type of the visible and hidden lines in pour breaks.

8. Modify the other properties as required. For example, click
Reinforcement... and set the Visibility of all reinforcing bars to Visible
to show the reinforcement in the pour drawing.

9. Save the changed properties and click OK. 

Now you can create the general arrangement drawing using the modified
properties. The pour objects, pour object marks and pour breaks are
shown accordingly.

You can also open the pour drawing and modify the properties further on
drawing, view and object level.

See also

Pours in drawings (page 488)

Pour object and pour break properties in drawings (page 1010)

Add hatches (fills) to parts and sketch objects in drawings (page 884)
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8.14 Define drawing reinforcement and meshes
There are numerous ways of showing reinforcing bars and meshes in
drawings. You can define automatic reinforcement and mesh settings before
you create the drawing, and adjust the settings in an open drawing. In addition
to modifying the properties available in the properties dialog box, you can also
modify the bending schedules, rounding of bar dimensions, symbols in use,
and reinforcement appearance in the rebar_config.inp settings file.

Click the links below to find out more:

Define automatic reinforcement and reinforcement mesh properties
(page 896)

Example: Hide reinforcing bar lines in drawings (page 897)

Example: Reinforcement representations (page 898)

See also

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)

Reinforcement settings for drawings (rebar_config.inp) (page 1004)

Part and neighbor part properties in drawings (page 991)

Define automatic reinforcement and reinforcement mesh
properties
You can define what is shown in reinforcing bars and meshes and how they
are shown in cast unit and general arrangement drawings. You can also do
this for neighbor reinforcement.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Load drawing properties that are as close to the ones you need as
possible.

3. Single-part, assembly and cast unit drawings: Click View creation in the
options tree on the left, select the view and the properties that you want
to change, and click View properties.

4. Click Reinforcement (or Neighbor reinforcement).

5. On the Bar content tab, set the bar representation, bar end symbols, and
the visibility of bars and lines.

6. On the Bar appearance tab, select the color and type of the visible lines
and hidden lines.

7. On the Mesh content tab, set the mesh representation, mesh symbols,
and the visibility of meshes, wires, bars and lines.
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8. On the Mesh appearance tab, select the color and type of the visible lines
and hidden lines.

9. General arrangement drawings: Click OK.

10. Click Reinforcement mark (or Neighbor reinforcement mark), add the
elements that you want to have in the mark and adjust the mark
appearance.

11. Single-part, assembly and cast unit drawings: Click Save to save the view
properties. Then click Close to return to drawing properties.

12. General arrangement drawings: Click OK.

13. Click Save to save the drawing properties, then click OK and create the
drawing.

TIP The representation of reinforcing bars that point away from the drawing can be
changed. You can customize reinforcing bar bent symbols (cross, circle, filled
circle) by editing the symbol file bent.sym, which in the default environment is
located in the folder ..\ProgramData\Trimble\Tekla Structures
\<version>\\environments\common\symbols. Or, you can create a new
symbol file in the same folder, for example, my_new_symbols.sym, and take it
into use in the rebar_config.inp (page 1004) by entering the following string in
the file: BentSymbolFile=my_new_symbols.sym

See also

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)

Reinforcement settings for drawings (rebar_config.inp) (page 1004)

Part and neighbor part properties in drawings (page 991)

Define drawing reinforcement and meshes (page 896)
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Example: Hide reinforcing bar lines in drawings
You can hide reinforcement bar lines behind other reinforcing bars and
behind parts in cast unit drawings.

Here are some examples of what reinforcing bars look like with different
settings selected on the Bar content tab in Reinforcement or Neighbor
reinforcement properties.

Setting Description
Hide lines behind parts is selected.
The reinforcing bar lines are hidden
behind other parts.

Hide lines behind other rebars is
selected. The reinforcing bar lines are
hidden behind other reinforcing bar
lines.

See also

Define automatic reinforcement and reinforcement mesh properties
(page 896)

Define drawing reinforcement and meshes (page 896)

Example: Reinforcement representations

Here are examples of how the reinforcement will look with the different
representation options selected on the Bar content tab in Reinforcement or
Neighbor reinforcement properties.

Setting Example
single line
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Setting Example
single line with filled ends

double lines

double lines with filled ends

filled line

stick

outline

See also

Define drawing reinforcement and meshes (page 896)

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)

Automatic grouping of rebar sets for drawings
The reinforcing bars created by using the rebar set commands are
automatically grouped for drawing marking and dimensioning purposes. The
automatic grouping works both for simple, non-tapered groups as well as for
tapered groups.
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The automatic grouping of rebar set bars takes cast units into consideration. If
a cast unit consists of multiple parts, the bars are grouped within the cast unit
instead of the parts.

Preconditions for rebar group creation

Simple, non-tapered groups are created when:

• Bars are created by the same rebar set

• Bars are side by side, placed radially, or parallel and distributed along a
curve

• Bars have identical properties, including length

• Bars have the same position number

Linearly tapered bars are grouped when:

• Bars are created by the same rebar set

• Bars have identical properties, except length

• Length of bars increases linearly

• Distance between each bar end and the tapering line is less than or equal
to the value set by
XS_REBARSET_TAPERED_LINEAR_GROUPING_TOLERANCE for the model, or
by the Tapered linear tolerance user-defined attribute for a rebar set or
property modifier.

• There are minimum of 3 bars in a group

Bars that are tapered along a curve are grouped when:

• Bars are created by the same rebar set

• Bars have identical properties, except length

• Length of bars increases by following the curve

• Distance between each bar end and the curve is less than or equal to the
value set by XS_REBARSET_TAPERED_CURVED_GROUPING_TOLERANCE for
the model, or by the Tapered curved tolerance user-defined attribute for
a rebar set or property modifier.

Spacing of bars is taken into account in grouping if the advanced option XS_
REBARSET_ENABLE_BAR_GROUPING_WHEN_SPACING_DIFFERS is set to FALSE.
Then only bars with same spacing are grouped, and each spacing zone of a
rebar set automatically creates a separate group. If the advanced option is set
to TRUE, spacing is ignored, and groups can contain bars from more than one
adjacent spacing zones.

Work with rebar set groups in drawings

Automatically created groups behave in the drawing similarly as the old rebar
groups:
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• There is only one mark for the rebar group, and the reinforcement mark
content (page 976) comes from the content setting Group in
Reinforcement mark properties.

Note that if XS_REBARSET_USE_GROUP_NUMBER_FOR_BARS_IN_TAPERED_
GROUPS is set to FALSE, bars in tapered bar groups within rebar sets do
not have a common position number (GROUP_POS), so position
information is not included in reinforcement marks.

• You can adjust the rebar visibility (page 1001) in Reinforcement
properties. For example, you can select to show bar in the middle of
group.

• You can use the following rebar-group-specific interactive dimensioning
and marking commands (page 211) found in the pop-up menu for rebar
groups:

• Create dimension line

• Add Mark --> Dimension Mark

• Add Mark --> Tagged Dimension mark

• Associative notes (page 297) can be created.

Below is an example of an automatically created rebar group in a drawing. The
drawing uses rebar group visibility option bar in the middle of group, and
reinforcement mark option One leader line to group, and the dimensions
have been created with the command Create dimension line.
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TIP If you want to fine-tune the automatic grouping, you can manually group and
ungroup rebar set bars by using property modifiers.

Create a property modifier for the bars that you want to group, and in the Rebar
property modifier properties, set Grouping to Manual.

If you need to ungroup automatically or manually grouped bars, create a
property modifier with Grouping set to No grouping.

For more information about creating rebar sets, see .

For more information about showing rebar set bar groups in the model, see
XS_REBARSET_COLOR_BARGROUPS.

8.15 Units and decimals in drawings, reports and
templates
Unit settings used in drawing objects, and reports and templates created in
Template Editor are taken from different places. These settings include, for
example, the used unit and the number of decimals.

In drawings, reports and templates, the units and decimals are defined in the
following way:

• Unit settings for marks: Tekla Structures uses the
contentattributes_global.lst attributes file for setting the default
unit and decimal settings for various mark elements. You can use
contentattributes_userdefined.lst when you want to configure
settings of your own.

For more information about unit settings in marks, see Change unit
settings for marks (page 848).

For more information about the contentattributes_global.lst and
contentattributes_userdefined.lst files, see .

• Unit settings for drawing objects: Default unit settings for drawing
objects (other than marks) either come from the standard drawing
properties files (standard.*) or are hardcoded in Tekla Structures.

• Unit settings for dimensions in dimension tags: Default unit settings for
dimensions and dimension tags are defined in the Options dialog box on
the Drawing dimensions page.

• Level attributes in marks, such as TOP_LEVEL, and BOTTOM_LEVEL take
the dimension format from the MarkDimensionFormat.dim file. For more
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information about level attributes in part marks, see Add level attributes in
automatic part marks (page 851).

• Unit settings for reports/templates created with Template Editor: Unit
settings for reports and templates created in Template Editor can be
defined in the Value Field Properties dialog box Format area or in format
functions. The default unit and decimal settings are taken from the
contentattributes_global.lst attributes file.

Format area:

Formula containing a format function:

For tips for using format functions, see . For more information about
formats and value fields, see Template Editor User's Guide.

8.16 User-defined attributes in drawings
Many Tekla Structures dialog boxes contain user-defined attributes for various
objects. When you define a new user-defined attribute, make the definition of
the user-defined attribute unique. This is because a user-defined attribute
cannot have different definitions for different object types. In drawings, the
user-defined attributes can be used in templates, Document manager, and
marks, for example.
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The user-defined attributes in the drawing are displayed when you click User-
defined attributes in drawing properties.

When you define new user-defined attributes

When you define new user-defined (page 905) attributes, you need to create
your own file in the company, project or firm folder. After adding your own
user-defined attributes, you need to use the Diagnose and change attribute
definitions tool to update the definitions in the model. The object.inp files
are merged so that if there are user-defined attributes in any of the files, they
are displayed in the user interface. Tekla Structures merges the files in a way
that eliminates duplicate attributes. If Tekla Structures encounters the same
attribute name in different objects.inp files, the attribute from the first read
objects.inp file will be used.

Tekla Structures reads the objects.inp files from the following folders in the
following order:

1. model folder

2. company folder

3. project folder

4. firm folder

5. system folder

6. inp folder

Show user-defined attributes in Template Editor

In order to show the new user-defined attribute in Template Editor, you need
to add the user-defined attribute in a customized
contentattributes_userdefined.lst file and include the name of the
customized file in the contentattributes.lst file.

Make a copy of these modified files as the Tekla Structures installation always
overwrites these files.

See also

Add attributes in automatic marks (page 850)

Document manager (page 559)

Switches for customizing print file names (old printing) (page 634)

Modify automatic user-defined drawing attributes (page 904)

Modify automatic user-defined drawing attributes
You can modify the user-defined attributes before you create a drawing.

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
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2. Load drawing properties that are as close to the ones you need as
possible.

3. Click User-defined attributes.

4. On the Workflow tab, enter project-specific information to be displayed
in drawings and in the Document manager.

5. On the Parameters tab, enter a user-defined Comment for drawings,
projects, assemblies, parts, and so on.

6. Use the User field 1 to User field 8 on the Parameters tab to enter
drawing-specific information.

7. On the Title tab, select if you want to use project-specific or drawing-
specific information in the title block of the drawing. 

When you click Use project settings, you cannot enter any information in
the title block fields.

8. If you selected Use drawing settings, the title block fields become
available, and you can enter the necessary data in the fields.

9. General arrangement drawings: Click OK.

10. Click Save to save the drawing properties, then click OK and create the
drawing.

TIP • You can control whether the modifications in user-defined attributes affect
all selected drawings in the Document manager at the same time, even if
the drawings are of different types by using the advanced option .

See also

Create a new user-defined drawing attribute (page 905)

Create a new user-defined drawing attribute
If you want to add a new line in the user-defined drawing attributes dialog box
and a new column in Document manager, you need to create your own
objects.inp and add a new user-defined attribute there. You also need to
do this if you want the user-defined attribute to be available in Template
Editor.

Before you start, close Tekla Structures.

1. Open the objects.inp file located by default in ..\ProgramData
\Trimble\Tekla Structures\<version>\environments\common
\inp.

2. Save the objects.inp file in your model, project or firm folder.

3. Delete all user-defined attribute definitions from the objects.inp file,
except the property definitions in the beginning of the file that describe
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the properties, and the sections that define the new tab to different
drawing types. Also leave one property definition in section User-defined
attributes for objects that you can use as a template for the new property.

4. Enter the name of the tab page where you want the new user-defined
attributes to be located and the attribute properties. 

Do not enter the names of the tab pages that come with the installation,
use a new one instead.

5. To show the user-defined attribute in the Document manager and in the
user-defined attributes dialog box, set status_flag to yes. 

6. Define the drawing types where you want to use the new tab containing
the new user-defined attribute. 

7. Save and close the file.

8. Update the definitions of the user-defined attributes:

a. On the File menu, click Diagnose & repair --> Diagnose and change
attribute definitions . 
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The Diagnose and change attribute definitions dialog box is
displayed.

b. If there are conflicts between your objects.inp and the default
objects.inp, select the definition in the area on the right and click
Change current settings to selected Objects.inp settings. 

The definition of the user-defined attribute is updated in the model.

9. On the Drawings & reports tab, click Drawing properties and select the
drawing type. 

In this example, select GA drawing.

10. Click User-defined attributes... 

The user-defined drawing attributes dialog box of the general
arrangement drawing shows the tab you created.

11. Use Save as to save the properties for future use.

12. Click OK and create a general arrangement drawing.

13. Right-click the created drawing in Document manager and select User-
defined attribute .

Define automatic drawing settings 907 User-defined attributes in drawings



14. Go to the new tab (My tab) and enter the needed information (the
designer name in the Designed By box).

15. Click Modify and close the dialog box. 

Document manager contains a column for the new user-defined
attribute, and the name of the designer is displayed:

See also

User-defined attributes in drawings (page 903)

8.17 Define customized line types in TeklaStructures.lin
You can define your own line types, and use them wherever line type settings
are available. The customized line types are handled the same way as other
line types. The customized line types are defined in the TeklaStuctures.lin
file in ..\ProgramData\Trimble\Tekla Structures\<version>
\environments\common\inp. By default, the most widely used line types are
available in the file.

1. Open the TeklaStuctures.lin file.

2. Start every line with the letter A to indicate the beginning of the line type
pattern. 

You can use three different objects: dashes, dots and spaces to form a
line.

3. Define the length of a dash (-) using positive numbers.

4. Define the length of a space ( ) using negative numbers.

5. Define dots (.) using the number zero (0). 

The patterns must begin with a dash. They typically end with a space,
although the space in the end is not required.

6. After you have defined the line type pattern, press Enter.

The TeklaStructures.lin.id file contains the names of the line types
visible in the user interface and the unique IDs assigned for each line type. The
value of the ID must be greater than 10, for example:

CENTER, 1000
BORDER, 1002
DASHDOT, 1003

Define automatic drawing settings 908 Define customized line types in
TeklaStructures.lin



You can use TeklaStructures.lin also in mapping the exported line types.

NOTE If you add new customized line types, you need to add corresponding bitmaps
to the ..\ProgramData\Trimble\Tekla Structures\<version>
\bitmaps folder, and name them dr_line_type_*.bmp, for example
dr_line_type_CENTER.bmp.

Example 1

Line type definition for DASHDOT is A, 12.7, -6.35, 0, -6.35
This string means that the pattern starts with a dash with the length of 12.7
units, followed by a space with the length of 6.35 units, then a dot, and then
again a space with the length of 6.35 units. Then the first dash is drawn again.

Example 2

Below is an example containing definitions for dotted lines:

*DOT,Dot . . . . . . . . . . . . . . . . . . . . . . . .
A, 0, -1.5875
*DOT2,Dot (.5x) ........................................
A, 0, -0.79375
*DOTX2,Dot (2x) . . . . . . . . . . . . . .
A, 0, -3.175

Printed line types

Printing will look for the line type files in the model folder, and in the locations
specified by the advanced options XS_PROJECT, XS_FIRM, XS_SYSTEM and 
XS_INP, in that order.
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See also

Drawing sketch object properties (page 1017)
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9 Drawing settings reference

There are a lot of settings in Tekla Structures that you mainly control in the
properties dialog boxes. There are also some additional settings files that you
need to modify in a text editor.

Click the links below to find out more:

• General arrangement drawing properties (page 912)

• Single-part, assembly and cast unit drawing properties (page 915)

• Layout properties (page 918)

• View properties in drawings (page 920)

• Section view properties (page 927)

• Dimension and dimensioning properties (page 928)

• Mark properties (page 965)

• Mark elements (page 971)

• Pour object and pour break properties in drawings (page 1010)

• Part and neighbor part properties in drawings (page 991)

• Bolt content and appearance properties in drawings (page 997)

• Surface treatment visibility and content properties in drawings (page 998)

• Surface treatment hatch pattern properties (surfacing.htc) (page 999)

• Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)

• Reinforcement settings for drawings (rebar_config.inp) (page 1004)

• Placement properties for marks, dimensions, notes, texts and symbols
(page 1013)

• Model weld properties in drawings (page 1015)

• Drawing sketch object properties (page 1017)

• Drawing grid properties (page 1018)

• : Orientation settings
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9.1 General arrangement drawing properties
On the Drawings & reports tab, click Drawing properties --> GA drawing .
You can modify the properties after creating the drawing by double-clicking
the drawing background.

The options in the general arrangement drawing properties dialog box are
described below.

Option Description For more information
Name The name of the drawing. This

name is shown in Document
manager, and can be
included in drawing and
report templates.

The maximum length of the
drawing name is 32
characters.

 

Title 1, Title
2, Title 3

Titles are shown in the
Document manager and in
drawing and report
templates.

Modifying drawing names and
titles (page 156)

Use detailed
object level
settings

Set to Yes to use the detailed
object level settings created in
the Object level settings for
drawing dialog box.

Detailed object level settings
(page 70)

Layout... Select the drawing layout and
define drawing sizes. You can
also select whether you want
to list hidden objects in
templates.

Define drawing layout
(page 655)

Define drawing size and
drawing view scale (page 672)

View... Define view properties: scale,
neighbor part view extension,
reflected view, opening and
recess symbol, datum point
elevation, part shortening,
view label, and anchor bolt
plan settings.

View properties in drawings
(page 920)

Detail view... Define detail view properties:
view label, detail boundary
and detail mark settings.

Modify detail mark, view label
and mark boundary
properties in drawings
(page 297)

Dimension... Define dimension properties:
dimension type, units,

Dimension and dimensioning
properties (page 928)
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Option Description For more information
precision, format, placing, and
appearance.

Dimensionin
g...

Define dimensioning
properties: grid dimension
and part dimension settings.

Dimension and dimensioning
properties (page 928)

Dimensioning properties -
Parts tab (GA drawings)
(page 962)

Dimensioning properties -
Grid tab (GA drawings)
(page 962)

Part mark...

Bolt mark...

Neighbor
part mark...

Surface
treatment
mark...

Weld mark...

Reinforceme
nt marks...

Neighbor
reinforceme
nt marks...

Connection
mark...

Pour object
mark...

Define mark properties:
included elements and
element settings, and mark
visibility, mark frame, mark
leader line and placing
settings.

Mark properties (page 965)

Part and neighbor part
properties in drawings
(page 991)

Drawing weld mark
properties (page 983)

Mark properties - Content,
General, Merging and
Appearance tabs (page 965)

Model weld mark visibility and
appearance properties in
drawings (page 986)

Mark elements (page 971)

Pours in drawings (page 488)

Part... Define part properties: part
representation, hidden line,
center line and reference line
visibility, additional mark
visibility, part appearance,
and fill settings.

Part and neighbor part
properties in drawings
(page 991)

Bolt... Define bolt properties: bolt
representation, bolt symbol
content, bolt visibility, and
bolt appearance settings.

Bolt content and appearance
properties in drawings
(page 997)

Neighbor
part...

Define neighbor part
properties: visibility, part
representation, hidden line,
center line and reference line

Part and neighbor part
properties in drawings
(page 991)
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Option Description For more information
visibility, additional mark
visibility, and part appearance
settings. You can also define
bolt representation and bolt
symbol content settings for
neighbor parts.

Surface
treatment...

Define surface treatment
properties: surface treatment
visibility, pattern visibility,
hidden lines visibility and
surface treatment
representation settings.

Surface treatment visibility
and content properties in
drawings (page 998)

Weld... Define welding properties:
weld visibility, weld size limit
and weld appearance
settings.

Model weld properties in
drawings (page 1015)

Reinforceme
nt...

Define reinforcement and
mesh properties: bar and
mesh representation and
visibility, bar and mesh
symbol, and bar and mesh
appearance settings.

Reinforcement/Neighbor
reinforcement and mesh
properties in drawings
(page 1001)

Neighbor
reinforceme
nt...

Define neighbor
reinforcement and mesh
properties: bar and mesh
representation and visibility,
bar and mesh symbol, and
bar and mesh appearance
settings.

Reinforcement/Neighbor
reinforcement and mesh
properties in drawings
(page 1001)

Reference
objects...

Define reference object
visibility and appearance
settings.

Reference models in drawings
(page 552)

Grid... Define grid visibility and
appearance settings.

Drawing grid properties
(page 1018)

Customize drawing grid labels
(page 536)

Protection... Define protected areas to
prevent text, marks or
dimensions from being
placed there.

Protect areas in a drawing
(page 679)

Filter... and
Neighbor
part filter...

Create and modify part filters/
neighbor part filters on
drawing level.
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Option Description For more information
User-defined
attributes...

Add customized information
to a drawing, such as
information related to
workflow, and comments.
This information can be
displayed in Document
manager, and you can use it
in report and drawing
templates and marks, and as
switches when customizing
print file names.

The user-defined attributes
and tabs shown in this dialog
box are defined in the
objects.inp file.

The availability of the various
user-defined attributes
depends on your
environment, role and
configuration.

User-defined attributes in
drawings (page 903)

9.2 Single-part, assembly and cast unit drawing
properties
On the Drawings & reports tab, click Drawing properties and select the
drawing type. You can modify the properties after creating the drawing by
double-clicking the drawing background.

The options in single-part, assembly and cast unit drawing properties dialog
box are described below.

Option Description For more information
Name Define the name of the

drawing that is shown in the
Document manager, and
that can be included in
drawing and report
templates.

The maximum length of the
drawing name is 32
characters.
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Option Description For more information
Cast unit
definition
method

By cast unit position: A
drawing will be created from
each cast unit. If there are
identical cast units, one of
them will serve as the base
cast unit for the drawing. This
is the most common method
for creating cast unit
drawings.

By cast unit ID: Each part in
the model has a unique GUID.
You can create drawings by
using the cast unit GUIDs. The
GUID determines the marking
of the drawing. You can
create several drawings from
identical cast units.

 

Title 1, Title
2, Title 3

Define titles that are shown in
Document manager and that
can be included in drawing
and report templates.

Modifying drawing names and
titles (page 156)

Sheet
number

Used for creating several
drawings of the same part as
multiple drawing sheets. The
number of sheets is not
limited.

Create multiple drawing
sheets of the same part
(page 152)

Layout Select the drawing layout, and
define drawing sizes,
autoscale, projection type,
view alignment and part
expansion settings. You can
also select whether you want
to list hidden objects in
templates.

Define drawing layout
(page 655)

Define drawing size and
drawing view scale (page 672)

View
creation

Define the drawing views to
be created. From here you
can move on to modifying the
view properties for each view.

Here you can also define
Common settings for all
views:

• Weld mark visible
controls the visibility of
model weld marks in

View properties in drawings
(page 920)

Define the views to create
(page 689)
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Option Description For more information
assembly drawings. The
options are:

• In one view: Tekla
Structures
automatically finds the
most relevant view for
showing the model
weld marks. Every weld
mark is shown in a
drawing in one view
only.

• In all views: Tekla
Structures adds the
model weld marks in
all drawing views that
contain the part with
the weld.

• Ignore bolt size filters
standard-sized bolts out of
drawings, which means
that Tekla Structures does
not display bolt marks of
the defined bolt size in
drawings. This setting is
available in single-part and
assembly drawings.

• Weld size limit filters
welds and weld marks of
the defined weld size and
smaller out of the drawing.
This setting is available in
single-part and assembly
drawings.

Section view Define section view
properties.

Section view properties
(page 927)

Detail view Define the start number or
letter of the detail view and
detail symbol label.

Modify detail mark, view label
and mark boundary
properties in drawings
(page 297)

User-defined
attributes

Add customized information
to a drawing, such as
information related to
workflow, and comments.
This information can be
displayed in the Document

User-defined attributes in
drawings (page 903)
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Option Description For more information
manager, and you can use it
in report and drawing
templates and marks, and as
switches when customizing
print file names.

The user-defined attributes
and tabs shown in this dialog
box are defined in the
objects.inp file.

The availability of the various
user-defined attributes
depends on your
environment, role and
configuration.

9.3 Layout properties
On the Drawings & reports tab, click Drawing properties and select the
drawing type. Then click Layout. You can modify the properties after creating
the drawing by double-clicking the drawing background.

All options in all layout property panels and dialog boxes are described below.
All the described options are not available for all drawing types.

Option Description
Drawing size tab
Layout Define the layout that you want to use.
Edit Open the Layout editor to customize drawing

layouts.
List hidden objects in
templates

Select Yes to list hidden objects in templates. No
removes all information about the hidden parts,
also from the total weight.

Size definition mode Select Autosize if you want to let Tekla Structures
find appropriate sizes and table sets for drawings.
Select Specified size to specify the exact size for
the drawing. The drawing size should always be
smaller than the actual paper size to accommodate
printer margins.

Drawing size If you selected Specified size, define the drawing
size here.

Scale tab
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Option Description
Autoscale Set Autoscale to Yes to let Tekla Structures

automatically select the suitable scale for the
drawing view.

Main view scales

Section view scales

When you use autoscaling, enter the denominators
of main view and section view scales and separate
them with spaces.

For example, enter "5 10 15 20" for the scales 1/5,
1/10, 1/15, and 1/20

Scale change mode When you use autoscaling, set the scale change
mode which defines the relationship between the
scales of main and section views within a drawing:

main = section: The scales of the main and section
view are equal.

main < section: Main view scales are smaller than
section view scales.

main <= section: Main view scales are smaller
than or equal to section view scales

Preferred size Enter the preferred size of the drawing, if you use
both autosizing and autoscaling. Tekla Structures
tries to find a drawing size where the drawing
contents fit by first trying to use the exact scale
and the smallest drawing size. If the contents do
not fit, Tekla Structures increases the drawing size
until it reaches the preferred size.

Other tab
Projection type Define how Tekla Structures places the projections

of a part in cast unit, single-part, and assembly
drawings. Projection type affects the order of the
views in the drawing. The options are:

First angle, also referred to as the European
projection.

Third angle, also referred to as the American
projection.

Align section views
with main view

Align end views with
main view

Set to Yes to place the views next to the main view.

If you select No, Tekla Structures places the section
and end views in any available location.

Expand shortened
parts to fit

Set to Yes to stretch shortened views to fill up
empty areas of the drawing.

Include single-parts Set to Yes to include in assembly drawings the
single-part drawings of the individual parts that
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Option Description
make the assembly. Setting this to Yes, activates
the Single-part attributes option.

Single-part attributes Define the desired single-part drawing properties
to be used in the single-part view. To do this, set
Include single-parts to Yes.

See also

Define drawing size and drawing view scale (page 672)

Define drawing layout (page 655)

Set drawing view projection type (page 693)

Define automatic section view properties (page 717)

Shorten or lengthen parts (page 708)

Include single-part drawings in assembly drawings (page 695)

9.4 View properties in drawings
Use the View Properties dialog box to view and modify the drawing view
properties.

The table below describes all view level properties for all drawing types.

Option Description
Views tab when View creation is selected from the options tree in drawing
properties:
View type on/off Defines the main views, section views

and 3D views that you want to create.

• If you select Off, Tekla Structures
does not create the view, but
dimensions the parts in the
available views. If you set all four
main views off, Tekla Structures
will still create a front view.

• If you select On, Tekla Structures
always creates the view, even if it
was not necessary in order to
show the dimensions. For section
views, Tekla Structures creates
one additional section view
showing the middle of the main
part. For end views, Tekla

Drawing settings reference 920 View properties in drawings



Option Description
Structures creates end view from
one end of the main part.

• If you select Auto, Tekla Structures
creates the view if it is necessary
in order to show the dimensions.
For section views, Tekla Structures
creates the necessary number of
views to show all the dimensions.
For end views, Tekla Structures
also creates another end view
from the other end of the main
part, if there are dimensions at
that end.

View label Shows the view label set in view
properties. If the label is defined in
view properties, you can change it
here. You can always change the label
of the main views.

View properties Shows the current view properties for
the selected view. You can select
another view properties file from the
list and modify the view properties by
clicking View properties.

Attributes tab when View creation is selected from the options tree in
drawing properties:
Coordinate system Sets the coordinate system of the

drawing views. The options are: local,
model, oriented, horizontal brace,
vertical brace, and fixed.

For more information, see Change the
coordinate system (page 697).

Rotate coordinate systemAround
X,Around Y and Around Z

Rotates the view around the x, y, or z
axis of the parts using the entered
values.

For more information, see Rotate
parts in drawing views (page 700).

Unfolded Yes shows and dimensions the bend
lines in the drawing.

For more information, see Unfold
polybeams in drawings (page 712).

Undeformed Yes undeforms deformed parts and
shows the developed (undeformed)
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Option Description
shape of the deformed parts in
drawings.

For more information, see Undeform
deformed parts in drawings
(page 713).

Recreate the drawing Yes recreates the drawing.
Attributes 1 and Attributes 2 tabs in view properties (Attributes and
Shortening tabs in general arrangement drawings) :
Scale Sets the view scale.
Reflected view Displays load bearing structures, such

as columns and beams on a lower
floor.

Yes displays structures with a
continuous line, and No displays
them with a dashed line.

Rotation around \n (in 3D views) Modify the view angle of 3D views.
Enter the values for the angles in y
and x directions. Rotation in a
drawing view is around the local axis.
Value 0.0 for both equals the front
view.

Size Fit by parts Tekla Structures fits the
view contents in the drawing view
frame without leaving any
unnecessary space.

Define as distances The x and y
boxes define the view size along the x
and y axes of the view. The depth
boxes define the depth of the view
relative to, and perpendicular to the
view plane.

View extension for neighbor parts Sets the distance from the drawing
view to display neighboring parts.

For more information, see Show
neighbor parts in drawings
(page 705).

Place Set the placing for the drawing view
to be fixed or free:

• Fixed: Maintain the views in the
same location during updates.
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Option Description
• Free: Let Tekla Structures find a

suitable place for the view during
updates.

For more information, see Define
automatic free or fixed placement for
drawing views (page 686).

Undeformed Yes undeforms deformed parts and
shows the developed (undeformed)
shape of the deformed parts in
drawing views.

For more information, see Undeform
deformed parts in drawings
(page 713).

Shortening If parts are very long and do not
include any details, you can shorten
them:

• Cut parts: Yes activates
shortening. You can also select to
cut Only in x direction or Only in
y direction.

• Minimum cut part length defines
the minimum length of the
shortened part to show.

• Space between cut parts defines
the distance between cut parts.

• Cut skew parts: Yes cuts skew
parts.

For more information, see Shorten
parts in drawing views.

Show openings/recess symbol Yes shows symbols in openings and
recesses.

For more information, see Show part
openings and recesses in drawings
(page 714).

Location by Select model origin, project base
point or any base point defined
coordinate system. Location by uses
the project base point as the default
value.

• Base point data can be used to set
the coordinate system for the
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Option Description
view. The base point can be used
instead of datum offset.

• When the base point is set, level
attributes and template attributes
in marks provide values in the
specific base-point-defined
coordinate system.

• If you change the project base
point Z or the elevation value, the
level value will change accordingly
when a drawing is opened.

• This setting affects level marks
and attributes that end with 
_BASEPOINT.

Datum point for elevations Specified uses the entered value.

View plane measures reference
points relative to the view plane.

For more information, see Add
elevation dimensions (page 774).

Show pours in drawing Yes shows pours in drawings. For
more information, see Show pour
objects, pour marks and pour breaks
in drawings (page 894).

Dimension creation method in this
view

Clones the dimensions separately for
the selected view only. Using this
option affects the creation of the
dimensions during cloning and re-
dimensioning of existing drawings.

For more information, see Clone
dimensions in selected views only
(page 148).

Labels tab:
Text Defines the view label text. Enter text

in fields A1-A5, or click the ... buttons
and select the label mark contents
and appearance.

For more information about view
labels, see Define view labels and
view label marks (page 691)

Symbol Defines a symbol to be used in the
view label, and the color, size, and line
length of the symbol.
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Option Description
Label position Defines the vertical and horizontal

position of the view label:

• For Vertical, select Above or
Below.

• : Select one of the following for
Horizontal:

Left aligned to view frame

Center aligned to view frame

Right aligned to view frame

Left aligned to view restriction
box

Center aligned to view
restriction box

Right aligned to view restriction
box

View direction marks Shows or hides the view direction
marks and defines the mark height.

Other options in the view properties options tree:
Dimensioning Define view-level dimensions settings

for each view separately.

For more information on
dimensioning settings, see
Dimensioning rule properties
(page 743), and Add automatic view-
level dimensions (page 729).

Filter Define drawing view filters.

For more information, see .
Neighbor part filter Define drawing view filters for

neighbor parts.

For more information, see .
Protection Define protected areas to prevent

text, marks or dimensions from being
placed there.

For more information, see Protect
areas in a drawing (page 679).

Marks Define view-level mark properties.

For more information, see Mark
properties - Content, General,
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Merging and Appearance tabs
(page 965).

Objects Define view-level properties for the
following objects:

Parts and neighbor parts (page 991)

Bolts (page 997)

Surface treatment (page 998)

Welds (page 1015)

Reinforcement and neighbor
reinforcement (page 1001)

Reference objects (page 552)

Grid (page 1018)

Pour objects and pour breaks
(page 894)

Anchor bolt plan (general arrangement drawings only)
Show as anchor bolt plan Yes shows the general arrangement

drawing as an anchor bolt plan.

For more information, see Create
anchor bolt plans using saved settings
(page 113)

Enlarged part view scale Defines the scale used in the enlarged
part views.

Create detail views Yes creates separate detail views.

If you select No, Tekla Structures
dimensions the anchor bolts in the
enlarged view. Tekla Structures
groups similar detail views so that
similar details are drawn only once.

Detail view scale Defines the scale used in the anchor
bolt plan detail views.

See also

Define drawing views (page 687)

Define drawing size and drawing view scale (page 672)

Define the views to create in single-part, assembly and cast unit drawings
(page 689)

Define automatic view settings for general arrangement drawings (page 690)
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9.5 Section view properties
When you create automatic section views, Tekla Structures creates section
views and section marks using the current view and mark properties. You can
modify the section view properties in an open drawing.

Option Description
Attributes tab
Fit by parts The Fit by parts setting works as an

alternative to Section depth and
Distance for combining cuts, and it
shows the whole part in the sections.

Section depth Defines the positive and negative
distances of the section view when
views are not combined.

Distance for combining cuts Defines the distance range for
combining cut views.

Direction Define the view direction of the
section. The options are:

• Right section

• Middle section

• Left sectionLeft section

The available values are left or right.
Cutting line tab
Line Length and offset of the cutting line.
Properties Color of the cutting line.
Section mark tab
Text Defines the text on the section mark.

Click the ... buttons next to the text
boxes to open the Mark Contents
dialog box.

Symbol: Color Color of the section mark symbol.
Left symbol, Right symbol Left and right section mark symbol.
Size Size of the section mark left and right

symbol.
x/y Offset of the section mark left and

right symbol.
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Option Description
Start number or letter of section
view and symbol label

Defines the letter or number used in
the section view label or in the section
symbol label.

You can enter any number starting
from 1 or any letter A - Z or a - z (also
shown in uppercase in the label). If
you use letter, and the entered string
is longer than one letter, only the first
letter is shown in the view label and
section symbol label. If you use
numbers, all entered numbers are
shown. The start number changes
only if you change it in the drawing
properties before creating a drawing,
and if you change the option in an
existing drawing and recreate the
drawing, in which case section view
and symbol labels for all
automatically included section views
and all new section views will change.

See also

View properties in drawings (page 920)

Define object protection and placement settings in drawings (page 677)

Define drawing views (page 687)

Define the views to create in single-part, assembly and cast unit drawings
(page 689)

Create views in drawings (page 169)

9.6 Dimension and dimensioning properties
Dimension and dimensioning properties define what the dimensions look like,
and which formats, units etc. are used, and what is being dimensioned and
how.

Click the following link to find out more about dimension properties:

• Dimension properties - General tab (page 929)

• Dimension properties - Units, precision and format (page 932)

• Dimension properties - Appearance tab (page 934)

• Dimension properties - Marks and Tags tabs (page 936)
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• Rebar dimension mark properties (page 939)

Click the following links to find out more about dimensioning properties
in view-level dimensioning:

• Dimensioning rule properties (page 743)

• Dimensioning properties - General tab (Integrated dimensioning)
(page 949)

• Dimensioning properties - Part dimensions tab (Integrated dimensioning)
(page 955)

• Dimensioning properties - Position dimensions tab (Integrated
dimensioning) (page 952)

• Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)
(page 957)

• Dimensioning properties - Dimension grouping tab (Integrated
dimensioning) (page 959)

• Dimensioning properties - Sub-assemblies tab (Integrated dimensioning)
(page 960)

• Dimensioning properties - Reinforcement dimensions tab (Integrated
dimensioning) (page 961)

Click the following links to find out more about dimensioning properties
in GA drawings:

• Dimensioning properties - Grid tab (GA drawings) (page 962)

• Dimensioning properties - Parts tab (GA drawings) (page 962)

Dimension properties - General tab
Use the General tab in the Dimension Properties dialog box to view and
modify the format, type, unit, precision, extension line, grouping and placing
settings of the dimensions.

The drawing level View Properties dialog box and object level Dimension
Properties dialog box contents differ. All options in both dialog boxes are
described below.

• To open the drawing level Dimension Properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Dimension .

• To open the object level Dimension Properties, double-click a dimension
in an open drawing.

• To open Dimension Properties dialog box for general arrangement
drawings before creating a drawing: On the Drawings & reports tab, click
Drawing properties --> GA drawing , and then click Dimension...
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Option Description
Dimension types
Straight Sets the dimension type for straight

dimensions.
Relative: Point to point dimensions.

Absolute: Dimensions from a
common start point.
Relative and absolute: Combination
of point to point and common start
point.
US absolute: Dimensions from a
common start point, which include a
running dimension mark (RD).
US absolute 2: Similar to US
absolute, but it changes short
dimensions to relative.
Absolute plus short relatives:
Similar to Absolute, but it changes
short dimensions to relative. Also
called internal absolute. This option
may show both dimensions, but it
does not show relative dimensions
when dimensions are long. This
option shows the absolute
dimensions inside the dimension
lines.
Absolute plus all relatives above
the absolutes: Similar to Relative
and absolute, but it places the
relative dimensions above the
absolute.
Elevation: Creates an elevation
dimension at a picked point. This type
is only available in the dimension
properties of manual dimensions in
drawing mode.

In x direction As above, but overrides the straight
setting for horizontal dimensions. If
you use the blank option, Tekla
Structures uses the Straight option
settings. The x direction usually
means dimensions parallel to the
drawing x axis.
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Option Description
Angle Defines the appearance of angle

dimensions.
Shows the angle dimensions in
degrees on side.
Shows the angle dimensions in
degrees at angle vertex.
Shows the angle dimensions using a
triangle.

You can also set the Triangle base
length to control the base dimension
shown for bevel dimensions.
Shows the angle dimensions using a
triangle with degrees.

Triangle base length The base length of a triangle.
Curved Defines whether to use angle units or

distance units for curved dimensions.
Short extension line Defines whether Tekla Structures

should create extension lines all of
the same length or use the short
extension line automatically if the
dimension line falls on a grid line.

If you want to exaggerate (page 800)
dimensions, you need to set this
option to No.

Dimension format
Units Defines the units (page 932) used in

dimensioning.
Precision Defines dimension precision

(page 932): rounding, imperial units.
Format Defines the dimension format

(page 932): the number of decimals
and their appearance.

Use grouping Defines whether long dimension
values are grouped.

Combine equal dimensions Combines equal dimensions. The
choices are Off, 3*60 or 3*60=180.

The accuracy of combining equal
dimensions is 0.1.

Minimum number to combine Defines the minimum number of
dimensions to combine.

Dimension grouping
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Option Description
Update grouping when model
changes

Yes updates dimension grouping
automatically when the model
changes.

Placing
Dimension lines spacing Defines the space between parallel

dimension lines.

In manually created dimensions, this
setting works only if dimension
Placing is set to free, see below.

Short dimensions Defines the text location of short
dimensions: between or outside the
dimension lines.

Place... Opens the Dimension Placing dialog
box.

Placing is the method used for
placing dimensions. The choices are:

• free lets Tekla Structures to
decide the location and direction
of the dimension based on the
Direction settings.

• fixed allows you to place the
dimension at any point.

Search margin is the empty margin
that you want to have around the
dimension.

Minimum distance is the closest
distance Tekla Structures uses to
search for an empty space for a
dimension.

Direction defines the side of the
dimensioned object on which Tekla
Structures places the dimensions.

See also

Dimension properties - Units, precision and format (page 932)
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Dimension properties - Units, precision and format
Use the General tab of the Dimension properties dialog box to view and
modify options related to dimension format, unit and precision.

The integer values are provided for situations when you need to use the value
as a value for an advanced option.

Option Integer value Notes
Format  
### 0  
###[.#] 1  
###.# 2  
###[.##] 3  
###.## 4  
###[.###] 5  
###.### 6  
### #/# 7  

## # /##.## # 8 This option is available
only for straight
dimensions.

Precision  
0.00 1 For defining precision

with rounding. For
example, with precision
0.33 the actual
dimension 50.40 is
shown as 50.33.

0.50 2
0.33 3
0.25 4

1/8 5 For imperial units
1/16 6
1/32 7
1/10 8 For defining precision

without rounding1/100 9
1/1000 10
Units
automatic Uses the units defined in

the model
mm millimeters
cm centimeters
m meters
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Option Integer value Notes
foot - inch feet and inches

Inches are converted
into integer feet, and the
remaining inches are
shown in inches.

cm / m centimeters and meters

Dimensions under 100
cm are shown in
centimeters, and
dimensions above 100
cm are shown in meters.
Millimeters are shown as
superscript.

inch inches
feet feet

See also

Dimensioning rule properties (page 743)

Dimension properties - General tab (page 929)

Dimension properties - Appearance tab
Use the Appearance tab in the Dimension Properties dialog box to view and
modify the settings affecting the dimension appearance.

• To open the drawing level Dimension Properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Dimension.

• To open the object level Dimension Properties dialog box, double-click a
dimension in an open drawing.

• To open Dimension Properties dialog box for general arrangement
drawings before creating a drawing: On the Drawings & reports tab, click
Drawing properties --> GA drawing, and then click Dimension.

Option Description
Text
Color The color of the dimension mark text.

This controls the line weight in
printed drawings.

Height Controls the height of the text used in
the dimension marks in the drawing.
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Option Description
Font Controls which font is used in the

dimension mark.
Frame Defines a frame for the dimension

mark.
Place Defines how the dimension mark is

placed relative to the dimension line.
Line, Arrow
Color Controls the color of the dimension

line. The color controls the line weight
in printed drawings.

Background mask Select Opaque to hide the area of the
drawing that is covered by the
dimension mark.

Select Transparent to show the
drawing content in the dimension
mark background so that drawing
linework is visible.

Arrow shape Controls the type of mark used with
the dimension line.

You can also create arrow types of
your own, see Customize dimension
line arrows (page 258).
Sets the height and the length of the
arrowhead.

US Absolute dimensions Controls the type of mark used with
the dimension line in US Absolute
dimensions.

Drawing settings reference 935 Dimension and dimensioning properties



Option Description
Level dimensions Controls the type of mark used with

the dimension line in level
dimensions.

See also

Dimension properties - General tab (page 929)

Dimension properties - Marks and Tags tabs
Use the Marks and Tags tabs in the Dimension Properties dialog box to view
and modify the contents of dimension marks and tags in an open drawing.

• To open the drawing level Dimension Properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Dimension .

• To open the object level Dimension Properties, double-click a dimension
in an open drawing.

• To open General - Dimension Properties dialog box for general
arrangement drawings before creating a drawing: On the Drawings &
reports tab, click Drawing properties --> GA drawing , and then click
Dimensioning...

Option Description
Marks tab
Prefix Displays the defined value before the

numeric value of the dimension.
Enter text or click ... to select
elements.

The prefix value cannot be plain
numbers, and cannot end with a
number.

Visibility of numeric value Defines whether the numeric value of
the dimension is visible or hidden.

If you hide the numeric value of the
dimension, the prefix and postfix text
will still be shown.

Postfix Displays the defined value after the
numeric value of the dimension.
Enter text or click ... to select
elements.

The postfix cannot be plain numbers,
and the it cannot start with a number
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Option Description
when the numeric value of the
dimension is visible.

... buttons Define dimension mark contents by
adding elements. You can also modify
the mark appearance.

Frame around elements: Type and
Color define the element frame type
and color individually for each
element.

< Add frame allows you to add
frames around elements. Font: Color,
Height and Font define the font type,
color, and height used in element
texts individually for each element.
Clicking Select... gives more font
choices.

Units: Units and Format allow you to
set the unit and format for length
elements. Unit settings can be
modified only when a length element
is selected.

You can also use template attributes
in the User-defined attribute
element. In marks, you cannot use
template attributes such as 
MODEL_TOTAL that refer to the whole
model. Marks only check the
information from the object in the
drawing and not from the whole
model.

Plate side marks Specified creates plate side marks to
plate dimension (page 260) using the
specified color, size and offset. Offset
means the distance of the mark from
the dimension line.

The option Automatic is available
only in intelligent drawings, that is
when the advanced option 
XS_INTELLIGENT_DRAWING_ALLOWE
D is set to TRUE.
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Option Description
Exaggeration Specified exaggerates narrow

dimensions (page 800).

Select the Direction: Left / Down,
Right / Up or Both.

Set the Origin, Width, Position and
Height.

Tags tab
Tags area Add tags to dimensions (page 204):

You can enter text in the tag box or
add elements by clicking the ...

When you click the ... button next to a
tag box, a dialog box for the particular
tag is displayed and you can define
dimension tag contents by adding
elements. You can also modify the tag
element appearance.

• Rotation --> Perpendicular to
dimension line rotates the tag.

• Rotation --> Parallel to
dimension line does not rotate
the tag. This is the default value.

• Frame around elements: Type
and Color define the element
frame type and color individually
for each element.

• < Add frame allows you to add
frames around elements. Font:
Color, Height and Font define the
font type, color, and height used in
element texts individually for each
element. Clicking Select... gives
more font choices.

• Units: Units and Format allow
you to set the unit and format for
length elements. Unit settings can
be modified only when a length
element is selected.

• You can also use template
attributes in the User-defined
attribute element.

In tags, you cannot use template
attributes such as MODEL_TOTAL
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Option Description
that refer to the whole model.
Tags only check the information
from the object in the drawing,
and not from the whole model.

Include part count in the tag Select the tag positions for which you
want to include the part count in the
tag.

Exclude parts according to filter Select a drawing view filter that
removes desired content from the tag
(page 204).

Curved Dimension Tag Type Select a tag type for a curved
reinforcing bar (page 211) dimension
line. The tag type controls how the
tags are aligned to the dimension.

See also

Add manual dimensions (page 195)

Add manual dimensions to general arrangement drawings (page 201)

Add dimensions to reinforcement (page 211)

Rebar dimension mark properties
Use the Rebar dimension mark properties dialog box to define what rebar
dimensions look like and which formats, units etc. are used. The Rebar
dimension mark properties dialog box is introduced in Tekla Structures 2020
SP2.

• To open the Rebar dimension mark properties dialog box, open the
drawing, go to the Drawing tab and click Properties --> Rebar dimension
mark.
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Rebar tab
Use the Rebar tab in the Rebar dimension mark properties dialog box to
modify the style of the rebar dimension mark in an open drawing.

Option Description
Dimension to Specifies whether dimensions are

created between All rebars or
between the Start and end rebars
only.

Part edge Adds closing dimensions to the edge
of the part in reinforcing bar group
dimensions. This setting is only
available if Dimension to is set to All
rebars.

Subgrouping Specifies whether subgroups are
created for different rebar spacings
within a rebar object so that
dimension marks can display the
subgroup properties. Subgrouping is
only available when Dimension to is
set to All rebars and is disabled for
Start and end rebars.

Extension line to visible rebar Controls the display of extension lines
to the visible rebars.

Tapered dimension type Specifies whether skewed dimensions
have skewed or horizontal

representation .
Curved dimension type Specifies whether curved dimensions

have curved or horizontal

representation .

General tab
Use the General tab in the Rebar dimension mark properties dialog box to
view and modify the format, type, unit, precision, extension line, grouping and
placing settings of the dimensions.

Option Description
Dimension types
Straight Sets the dimension type for straight

dimensions.
Relative: Point to point dimensions.
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Option Description
Absolute: Dimensions from a
common start point.
Relative and absolute: Combination
of point to point and common start
point.
US absolute: Dimensions from a
common start point, which include a
running dimension mark (RD).
US absolute 2: Similar to US
absolute, but it changes short
dimensions to relative.
Absolute plus short relatives:
Similar to Absolute, but it changes
short dimensions to relative. Also
called internal absolute. This option
may show both dimensions, but it
does not show relative dimensions
when dimensions are long. This
option shows the absolute
dimensions inside the dimension
lines.
Absolute plus all relatives above
the absolutes: Similar to Relative
and absolute, but it places the
relative dimensions above the
absolute.
Elevation: Creates an elevation
dimension at a picked point. This type
is only available in the dimension
properties of manual dimensions in
drawing mode.

In x direction As above, but overrides the straight
setting for horizontal dimensions. If
you use the blank option, Tekla
Structures uses the Straight option
settings. The x direction usually
means dimensions parallel to the
drawing x axis.

Angle Defines the appearance of angle
dimensions.
Shows the angle dimensions in
degrees on side.
Shows the angle dimensions in
degrees at angle vertex.
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Option Description
Shows the angle dimensions using a
triangle.

You can also set the Triangle base
length to control the base dimension
shown for bevel dimensions.
Shows the angle dimensions using a
triangle with degrees.

Triangle base length The base length of a triangle.
Short extension line Defines whether Tekla Structures

should create extension lines all of
the same length or use the short
extension line automatically if the
dimension line falls on a grid line.

If you want to exaggerate (page 800)
dimensions, you need to set this
option to No.

Dimension format
Units Defines the units used in

dimensioning.

automatic

Uses the units defined in the model.

mm (millimeters)

cm (centimeters)

m (meters)

foot - inch (feet and inches)

Inches are converted into integer feet,
and the remaining inches are shown
in inches.

cm / m (centimeters and meters)

Dimensions under 100 cm are shown
in centimeters, and dimensions above
100 cm are shown in meters.
Millimeters are shown as superscript.

inch (inches)

feet (feet)
Precision Defines dimension precision:

rounding, imperial units.

The following are for defining
precision with rounding. For example,
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Option Description
with precision 0.33 the actual
dimension 50.40 is shown as 50.33.

0.00

0.50

0.33

0.25

The following are for imperial units:

1/8

1/16

1/32

The following are for defining
precision without rounding:

1/100

1/1000

1/10
Format Defines the dimension format: the

number of decimals and their
appearance.

###

###[.#]

###.#

###[.##]

###.##

###[.###]

###.###

### #/#

The following is only available for
straight dimensions:

## #/##.## #

Use grouping Defines whether long dimension
values are grouped.

Combine equal dimensions Combines equal dimensions. The
choices are Off, 3*60 or 3*60=180.

The accuracy of combining equal
dimensions is 0.1.
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Option Description
Minimum number to combine Defines the minimum number of

dimensions to combine.
Placing
Dimension lines spacing Defines the space between parallel

dimension lines.

In manually created dimensions, this
setting works only if dimension
Placing is set to free, see below.

Short dimensions Defines the text location of short
dimensions: between or outside the
dimension lines.

Place... Opens the Dimension Placing dialog
box.

Placing is the method used for
placing dimensions. The choices are:

• free lets Tekla Structures to
decide the location and direction
of the dimension based on the
Direction settings.

• fixed (default) allows you to place
the dimension at any point.

Search margin is the empty margin
that you want to have around the
dimension.

Minimum distance is the closest
distance Tekla Structures uses to
search for an empty space for a
dimension.

Direction defines the side of the
dimensioned object on which Tekla
Structures places the dimensions.

Appearance tab
Use the Appearance tab in the Dimension Properties dialog box to view and
modify the settings affecting the dimension appearance.

Option Description
Text
Color The color of the dimension mark text.

This controls the line weight in
printed drawings.
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Option Description
Background mask Select Opaque to hide the area of the

drawing that is covered by the
dimension mark.

Select Transparent to show the
drawing content in the dimension
mark background so that drawing
linework is visible.

Height Controls the height of the text used in
the dimension marks in the drawing.

Font Controls which font is used in the
dimension mark.

Frame Defines a frame for the dimension
mark.

Place Defines how the dimension mark is
placed relative to the dimension line.

Line, Arrow
Color Controls the color of the dimension

line. The color controls the line weight
in printed drawings.

Arrow shape Controls the type of mark used with
the dimension line.

You can also create arrow types of
your own, see Customize dimension
line arrows (page 258).
Sets the height and the length of the
arrowhead.
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Marks and Tags tabs
Use the Marks and Tags tabs in the Rebar dimension mark properties
dialog box to view and modify the contents of rebar dimension marks and tags
in an open drawing.

Option Description
Marks tab
Prefix Displays the defined value before the

numeric value of the dimension.
Enter text or click ... to select
elements.

The prefix value cannot be plain
numbers, and cannot end with a
number.

Visibility of numeric value Defines whether the numeric value of
the dimension is visible or hidden.

If you hide the numeric value of the
dimension, the prefix and postfix text
will still be shown.

Postfix Displays the defined value after the
numeric value of the dimension.
Enter text or click ... to select
elements.

The postfix cannot be plain numbers,
and the it cannot start with a number
when the numeric value of the
dimension is visible.

... buttons Define dimension mark contents by
adding elements. You can also modify
the mark appearance.

Frame around elements: Type and
Color define the element frame type
and color individually for each
element.

< Add frame allows you to add
frames around elements. Font: Color,
Height and Font define the font type,
color, and height used in element
texts individually for each element.
Clicking Select... gives more font
choices.

Units: Units and Format allow you to
set the unit and format for length
elements. Unit settings can be

Drawing settings reference 946 Dimension and dimensioning properties



Option Description
modified only when a length element
is selected.

You can also use template attributes
in the User-defined attribute
element. In marks, you cannot use
template attributes such as 
MODEL_TOTAL that refer to the whole
model. Marks only check the
information from the object in the
drawing and not from the whole
model.

Plate side marks Specified creates plate side marks to
plate dimension (page 260) using the
specified color, size and offset. Offset
means the distance of the mark from
the dimension line.

The option Automatic is available
only in intelligent drawings, that is
when the advanced option 
XS_INTELLIGENT_DRAWING_ALLOWE
D is set to TRUE.

Exaggeration Specified exaggerates narrow
dimensions (page 800).

Select the Direction: Left / Down,
Right / Up or Both.

Set the Origin, Width, Position and
Height.

Tags tab
Tags area Add tags to dimensions (page 204):

You can enter text in the tag box or
add elements by clicking the ...

When you click the ... button next to a
tag box, a dialog box for the particular
tag is displayed and you can define
dimension tag contents by adding
elements. You can also modify the tag
element appearance.

• Rotation --> Perpendicular to
dimension line rotates the tag.

• Rotation --> Parallel to
dimension line does not rotate
the tag. This is the default value.
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Option Description
• Frame around elements: Type

and Color define the element
frame type and color individually
for each element.

• < Add frame allows you to add
frames around elements. Font:
Color, Height and Font define the
font type, color, and height used in
element texts individually for each
element. Clicking Select... gives
more font choices.

• Units: Units and Format allow
you to set the unit and format for
length elements. Unit settings can
be modified only when a length
element is selected.

• You can also use template
attributes in the User-defined
attribute element.

In tags, you cannot use template
attributes such as MODEL_TOTAL
that refer to the whole model.
Tags only check the information
from the object in the drawing,
and not from the whole model.

Include part count in the tag Select the tag positions for which you
want to include the part count in the
tag.

Exclude parts according to filter Select a drawing view filter that
removes desired content from the tag
(page 204).

Curved Dimension Tag Type Select a tag type for a curved
reinforcing bar (page 211) dimension
line. The tag type controls how the
tags are aligned to the dimension.
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Dimensioning properties - General tab (Integrated
dimensioning)

Use the General tab in the Dimension Properties dialog box to view and
modify the general settings of the dimensions. This dialog box is displayed if
you use Integrated dimensions dimensioning type in dimensioning.

Option Description
Dimensioning type Standard is used for almost all

dimensioning.

Truss meets the specific
requirements needed to dimension
truss drawings. It dimensions the
position and length of the diagonals.
The dimensioning is done only if the
diagonals are secondary parts that
are welded to upper and lower
chords, which are main parts and not
welded to any parts. If the truss
welding is done some other way,
standard dimensioning is used.

Minimize Yes minimizes the number of views
that Tekla Structures creates.

Also check the settings in the drawing
View Properties dialog box.

Combine dimensions Combines (page 787) several single
dimensions into one dimension line.

In Options, select the combination
level. The larger the number, the
more Tekla Structures combines
dimensions.

Option 4.5 uses a combination of
option 5 for main part and option 4
for secondary parts.

The Distance means the distance
within which Tekla Structures
combines internal dimensions.

If the distance between two details is
less than the defined Min distance,
Tekla Structures combines the
dimensions.
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Option Description
Close dimensions Close dimensions (page 786)

completes dimension lines to include
the entire part.

No does not close dimensions

In X only closes dimensions in the x
direction and leaves others open

All closes all dimensions

This setting is not relevant to profile
shape dimensions.

Close dimensions: Short
dimensions

Yes closes short dimensions.

With No, the open dimension is the
middle one rather than the short end
dimension.

When you leave short dimensions
open, Tekla Structures leaves out the
longer dimension line in dimension
lines that contain two dimensions. If
dimension lines contain three
dimensions, Tekla Structures leaves
out the middle one. This option does
not affect dimension lines with more
than three dimensions.

Placing: Forward offset Forward offset (page 792) defines the
distance Tekla Structures uses to
search for the base point of a
dimension. If Tekla Structures does
not find a base point (corner) within
the Forward offset search distance, it
uses an edge point.

The Centered bolt setting affects on
how the dimension is displayed.

Necessary internal dimensioning:
Recognizable distance

Recognizable distance (page 793)
defines the limit for dimensioning
asymmetry in secondary parts. In
some cases, it is important to look at
the asymmetrical relationship of
parts, so that an asymmetric
secondary part is correctly connected
to a main part. You can use
Recognizable distance to have
asymmetry reflected in dimensioning.
If the asymmetry is smaller than the
distance you enter here, Tekla
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Option Description
Structures represents it using a
dimension.

Part mark on dimension line None creates no part mark on the
dimension line.

On assembly overall dimension
creates a part mark on the assembly
overall dimension line.

Between extreme bolts creates a
part mark on the dimension line
between the outermost bolts.

Main dimension position Defines the side on which Tekla
Structures places the Assembly
overall dimensions, Main part work
points, and Knock off dimensions.

Auto treats the main dimensions in
the same way as other dimensions.

Above places the main dimensions
above the part (or to the left for
vertical parts).

Below places the main dimensions
below the part.

Above places the skew position
dimensions of the main part below
the part and Below places them
above.

Grid dimensions Creates grid dimensions (page 793).
The values are: None, Individual
spans, Overall or Individual spans
and overall.

Grid dimension position Sets the grid dimension position. The
values are:

Main view - above

Main view - below

Top view - above

Top view - below

Bottom view - above

Bottom view - below

Back view - above

Back view - below
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Option Description
All views - above

All views - below.
Dimension properties
Straight dimensions Sets the dimension type for straight

dimensions using the settings in the
properties file you select.

In X direction Otherwise same settings as in straight
dimensions but overrides the straight
setting for horizontal dimensions. If
you use the blank option, Tekla
Structures uses the Straight
dimensions option settings. The x
direction usually means dimensions
parallel to the drawing x axis.

Arrow shape: US Absolute
dimensions

Controls the type of mark used with
the dimension line in US Absolute
dimensions.

US Absolute dimensions are
dimension types US Absolute and US
Absolute 2 that can be defined in
Dimension properties (page 929). If
the advanced option XS_USE_
USABSOLUTE_ARROW_TYPE_FOR_
ABSOLUTE_DIMENSIONS is set to 
TRUE, the arrow shape is overridden
for other types of absolute
dimensions as well.

Arrow shape: Level dimensions Controls the type of mark used with
the dimension line in level
dimensions.

Angle and radius dimensions Sets the dimension type for angle
dimensions using the settings in the
properties file you select.

Check dimensions Sets the dimension type for check
dimensions using the settings in the
properties file you select.

See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Drawing settings reference 952 Dimension and dimensioning properties



Dimensioning properties - Position dimensions tab
(Integrated dimensioning)
Use the Position dimensions tab in the Dimensioning Properties dialog box
to view and modify the settings for the position dimensions in single-part,
assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type
in dimensioning.

Option Description
Position bolts to

Position parts to

Controls from where Tekla Structures
creates the part/bolt position
dimensions.

None creates no position dimensions.

Main part creates the dimensions
from the main part reference line.

Working points creates the
dimensions between the work points,
such as the intersections of main and
neighbor part reference lines.

Embedded objects Creates position dimensions for
locating embedded objects in cast
unit drawings. The embedded objects
are custom components attached to
the cast unit.

As secondary objects dimensions
embedded objects in cast unit
drawings the same way as secondary
parts.

By reference point dimensions
embedded objects to their reference
point, which is the origin of the
custom component.

Secondary part Creates dimensions to bolt holes or
edges of the secondary part.

None creates no position dimensions
for secondary parts.

By bolt dimensions bolt hole
locations in the secondary parts.
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Option Description
By part dimensions edges of
secondary parts.

By both dimensions bolt hole
locations and edges of the secondary
part.

Secondary part dimension
direction

Aligns dimensions with the main or
neighboring part. Only for skewed clip
angles or shear plates.

Position from Sets the start point for running
dimensions. Only for skewed clip
angles or shear plates bolted to a
neighboring part.

Reversed direction for running
dimensions

Yes changes the direction of running
dimensions. With this option, you can
set the zero point to the end of a
member rather than to the start.

Main part bolt position On creates dimensions to the bolt
hole locations in the main part.

Main part skew position Yes creates horizontal and vertical
check dimensions representing the
skew position of a brace. Created
between the work points of the main
part.

Skew check dimensions are located in
the front view. Their location depends
on the Main dimension position
setting selected on the General tab.
When the main dimensions are above
the part, the skew dimensions are
below, and vice versa.

Skew position Defines how Tekla Structures
dimensions skewed secondary part
positions.

None creates no dimensions for
skewed secondary part positions.

angle creates an angle dimension for
the secondary part.

Dimensions creates dimensions for
the skewed position of the secondary
part.

Both creates both the angle and the
dimensions.
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Option Description
Centered part Controls the dimensions of centrally-

placed parts. These settings have an
effect only if position dimensions are
created.

Internal dimensions the centered
parts overall size.

Position dimensions the part to the
main part center lines.

None creates no centered part
dimensions.

Centered bolt Controls the dimensions of centrally-
placed bolt groups.

Internal dimensions the centered
bolts spread.

Position dimensions the bolts to the
main part center-lines.

Centered bolt overrides the
Secondary part bolt internal option
for centered bolts. This only applies
to bolts located centrally on the part.

Elevation dimensions On creates elevation dimensions.
Combine equal dimensions Combines equal dimensions. The

choices are Off, 3*60 or 3*60=180.

The accuracy of combining equal
dimensions is 0.1.

Minimum number to combine Defines the minimum number of
dimensions to combine.

Dimensioning properties - Part dimensions tab (Integrated
dimensioning)
Use the options on the Part dimensions tab of the Dimensioning Properties
dialog box to view and modify part dimensioning settings for single-part,
assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type.
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Option Description
Internal Creates internal dimensions for

secondary parts connected to the
main part.

None creates dimensions for
secondary parts.

Necessary creates only the
dimensions that are necessary for
assembling the parts.

All creates all dimensions for the
secondary parts.

Main part overall dimensions Once creates one overall dimension
for the main part.

All creates overall dimensions for
main parts in all views.

None creates no overall dimensions
for the main part.

The Assembly part overall
dimensions settings have some
effect on these options.

Assembly part overall dimensions Length only creates overall
dimensions for an entire assembly or
cast unit in the x direction only.

All dimensions creates overall
dimensions for an assembly or cast
unit in all directions.

Off creates no overall dimensions for
an assembly or a cast unit.

Main part work points On creates a check dimension
between the outermost work points.

Main part shape (Shape
dimensions)

On creates dimensions to show the
shape of a main part.

By default, Tekla Structures
automatically draws shape
dimensions on both ends of a beam,
even if the ends are symmetrical.
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Option Description
Main part radius dimensions
(Radius dimensions)

On creates radius dimensions for
curved chamfers and round holes in
the main part.

This option is available only if you
have set Main part shape
dimensions to On.

Note that this option does not create
radius dimensions for curved beams
or polybeams with chamfers.

Bevel dimensions On creates linear dimensions of a
bevel.

Bevel angle Creates an angle dimension and
defines which side of the bevel to
dimension. The choices are None,
Angle of cut and Angle of beam.

Knock off dimensions On creates check dimensions from
the edge of the main part to the work
point.

Preferred dim side Sets the preferred view (front or side)
for part dimensions.

From the nearest floor level to part On creates dimensions indicating the
distance from the closest floor level to
the bottom and/or top of the parts.

From grid to part centerline On creates dimensions showing the
offset of a part from the grid to the
part center line.

From grid to part ends On creates dimensions showing the
offset of a part from the grid to the
near or far end of the part.

See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Part dimensioning (page 778)
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Dimensioning properties - Bolt dimensions tab (Integrated
dimensioning)
Use the options on the Bolt dimensions tab of the Dimensioning Properties
dialog box to select which bolt dimensions to create and how in single-part,
assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type.

Option Description
Main part bolt internal dimensions Creates internal dimensions for bolt

groups in the main part.

None creates none of the internal
bolt dimensions.

Internal creates bolt group internal
dimensions (distances between bolts).

All creates edge distance and bolt
group internal dimensions. Edge
distance is the dimension from the
outermost bolt to the part edge.

Main part bolt internal dimensions:
Skewed bolt group

Indicates whether the dimensions are
parallel to the part or the bolt group.

The choices are No dimensions, In
part direction, and In bolt group
direction.

Secondary part bolt internal
dimensions

Creates internal dimensions for bolt
groups in the secondary part.

The choices are None, Necessary,
Internal, and All.

Secondary part bolt internal
dimensions: Skewed bolt group

Aligns the bolt dimensions with the
secondary part or bolt group.

The choices are In part direction, No
dimensions, and In bolt group
direction

Distance between extreme bolts:
Extreme bolts

Creates check dimension between the
outermost bolts.

The choices are None, Main part,
and Assembly.

Distance between extreme bolts:
Extreme bolts to work points

Creates check dimensions from the
outermost bolts to the work points.

Yes creates the check dimensions.
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Option Description
Preferred dim side Sets the preferred view (front or side)

for bolt dimensions.

Combine bolt dimensions Sets the format of the combined bolt
group internal dimensions.

You can combine bolt group internal
dimensions and display them in the
format 3*60 or 3*60=180, or have
single dimensions.

Minimum number to combine Defines the minimum number of
dimensions to combine.

See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Combine bolt group dimensions (page 791)

Dimensioning properties - Dimension grouping tab
(Integrated dimensioning)
Use the Dimension grouping tab in Dimensioning Properties dialog box to
view and modify settings for dimension grouping in single-part, assembly and
cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type
in dimensioning.

Option Description
Activate dimension grouping Selects the objects for grouping.
Parts Groups according to parts.
Bolts Groups according to bolts.
Components Groups according to components.
Cuts/Shapes Groups according to cuts or shapes.
Automatic tagging Defines how to display information in

a dimension line.
Display tags Displays tags.
Include part count in the tag Includes part count in the tag.
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Option Description
Do not display marks\nfor the
grouped items

Does not display part marks for
grouped items.

Available elements Elements available to define identical
conditions.

Add > Adds items to Selected elements list.
Remove Removes items from Selected

elements list.
Move up Moves the element higher in the list.
Move down Moves the element lower in the list.
Update grouping\nwhen model
\nchanges

Yes updates dimension grouping
automatically when the model
changes.

See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Group identical objects to the same dimension line (page 773)

Dimensioning properties - Sub-assemblies tab (Integrated
dimensioning)
Use the options on the Sub-assemblies tab of the Assembly - Dimensioning
Properties dialog box to view and modify which dimensions to create and
how for sub-assemblies.

Note that the contents of the dialog box vary depending on the drawing type,
and all the options listed below are not available for all drawing types. This
dialog box is displayed if you use Integrated dimensions dimensioning type
in dimensioning.

Option Description
Dimension parts inside sub-
assemblies

Defines whether to dimension parts
inside sub-assemblies.

Yes creates internal dimensions for
parts inside sub-assemblies.

No does not create internal
dimensions for parts inside sub-
assemblies.
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Option Description
Measure sub-assembly position
from

Defines the position from which the
sub-assembly is measured.

None does not measure the sub-
assembly position.

Bolt measures the position of the
sub-assembly from the bolts. If bolts
are not included in the sub-assembly,
or if it is not possible to measure the
position from bolts, Tekla Structures
measures the sub-assembly position
from the reference point.

Extrema points measures the
position of the sub-assembly from the
bounding box of the sub-assembly.

Reference point measures the
position of the sub-assembly from the
reference point.

See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Dimensioning properties - Reinforcement dimensions tab
(Integrated dimensioning)
Use the Reinforcement dimensions tab in the Dimensioning Properties
dialog box to view and modify the setting affecting the creation of
reinforcement dimensions and how they are displayed.

This dialog box with this tab is displayed if you use Integrated dimensions
dimensioning type in dimensioning cast unit drawings.

Option Description
Dimensions for reinforcing bar
groups

On creates dimensions for reinforcing
bar groups. This also activates the
other selections on this tab.

Dimension mark settings Sets the mark type, which can be
dimension line, dimension mark,
tagged dimension mark, or variants of
these typical styles.

The Default environment contains
three predefined settings files: 
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Option Description
rebar_dimension_line, 
rebar_dimension_mark, and 
rebar_tagged_dimension_mark
Clicking the ... button opens the
dimension properties, and you can
view the settings file and also change
the settings, if needed.

See also

Add automatic view-specific dimensions using dimensioning type Integrated
(page 771)

Example: Reinforcement dimension (page 795)

Dimensioning properties - Grid tab (GA drawings)
Use the Grid tab in the General - Dimensioning Properties dialog box to view
and modify settings for grid and overall dimensions in general arrangement
drawings.

To open this dialog box:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and click Dimensioning....

• In an open GA drawing, double-click the drawing background, and click
Dimensioning...

Option Description
Grid line dimensions On creates grid dimension lines.
Overall dimension On creates the overall dimensions.
Dimension positioning: Horizontal Positions the vertical grid and overall

dimension lines to the Left or Right
side of the drawing or on Both sides.

Dimension positioning: Vertical Positions the horizontal grid and
overall dimension lines Above or
Below the drawing or Both.

See also

Add automatic dimensions to general arrangement drawings (page 808)

Example: Grid and overall dimensions (page 811)
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Dimensioning properties - Parts tab (GA drawings)
Use the Parts tab in the General - Dimensioning Properties dialog box to
view and modify settings for part dimensions in general arrangement
drawings.

To open this dialog box:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and click Dimensioning...

• In an open GA drawing, double-click the drawing background, and click
Dimensioning...

Option Description
Maximum leader line length:
Outside dimensions

Controls how close the dimension
lines are positioned to the parts they
are dimensioning. Defines that the
outside dimension lines take the
maximum leader line length from the
grid line.

Maximum leader line length: Inside
dimensions

Controls how close the dimension
lines are positioned to the parts they
are dimensioning. Defines that the
inside dimension lines take the
maximum leader line length from the
part reference point.

Include parts not entirely in view On dimensions the parts partly
outside the view. Off will not
dimension these parts.

Maximum number of outside
dimensions

Specifies the maximum number of
dimension lines allowed outside the
grid. When you dimension different
objects on different dimension lines,
using this setting helps you to create
cleaner drawings.

Once the desired maximum is
reached, Tekla Structures creates the
dimensions inside the grid.

Object group dimensioning rules Specifies different object groups to be
dimensioned on different dimension
lines.

Object group The object group to be dimensioned.
Positioning No dimensions does not create

dimensions for the parts.

Inside grid creates dimensions next
to or near the parts being
dimensioned. All part dimensions are
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Option Description
placed inside the grid when the parts
are inside the grid. The dimension will
still be outside, even if you have
selected Inside grid because of
where the parts are in the end bay
and the end being dimensioned to is
next to the outside.

Outside grid creates dimensions to
parts and positions them outside the
grid.

Either creates dimensions to parts
and positions them either inside or
outside the grid depending on the
part position and the setting of the
Maximum number of outside
dimensions option.

You must use the Either option if you
define the Maximum number of
outside dimensions, so that Tekla
Structures can position dimensions
inside the grid when the maximum
number of dimensions is reached
outside the grid.

Horizontal position Left side positions all dimensions to
horizontal parts to the left of the grid.

Right side positions all dimensions to
horizontal parts to the right of the
grid.

Distributed to both sides positions
all dimensions to horizontal parts to
the grid nearest the part they are
dimensioning.

Vertical position Above positions all dimensions to
vertical parts above the grid.

Below positions all dimensions to
vertical parts below the grid.

Distributed to both sides positions
all dimensions to vertical parts to the
grid nearest the part they are
dimensioning.

See also

Add automatic dimensions to general arrangement drawings (page 808)
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Example: Position part dimensions (page 815)

Example: Limit the number of outside dimensions (page 814)

Example: Dimension parts partly outside the view (page 814)

Example: Maximum leader line length options (page 812)

9.7 Mark properties
You can adjust the mark appearance and contents before creating a drawing
and also in an open drawing.

Click the links below to find out more:

• Mark appearance and merging properties (page 965)

• Leader line types (page 990)

• Positioning properties of view label, section and detail marks (page 983)

• Drawing weld mark properties (page 983)

• Model weld mark visibility and appearance properties in drawings
(page 986)

• Level mark properties (page 989)

• Mark elements (page 971)

Mark properties - Content, General, Merging and
Appearance tabs
Use the General, Merging and Content tabs in the properties of different
types of marks to view and modify the settings affecting the mark content and
appearance. For some marks, there is a separate Appearance tab.

Note that all the listed settings are not available for all marks.

To open mark properties:

• On the Drawings & reports tab, click Drawing properties, select the
drawing type, and go to mark properties directly by clicking the button of
the respective mark (GA drawings) or through view properties.

• In an open drawing, double-click the drawing background, and go to mark
properties directly by clicking the button of the respective mark (GA
drawings) or through view properties.

• In an open drawing, double-click the drawing view frame and click the
desired mark in the options tree on the left.

• In an open drawing, go to Drawing --> Properties and select a mark type.

• Double-click a mark in an open drawing.
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Setting Description
Content tab:
Available elements

Elements in mark

Available elements lists the elements that are
available for the current mark.

Elements in mark lists the elements that you have
selected to include in the mark.

For more information about mark elements, see
Mark elements (page 971).

For a list of elements that are common to all
marks, see Common elements in marks
(page 972).

< Add frame Add frames around individual elements in side the
mark.

Frame around
elements: Type and
Color

Defines the element frame type and color for one
or several elements. To select all elements in the
Elements in mark list to apply the same
modification to all of them, hold down Shift on the
keyboard, and click the last element in the list.

Font: Color, Height and
Font

Defines the font type, color, and height used in
element texts in one or several elements. To select
all elements in the Elements in mark list to apply
the same modification to all of them, hold down
Shift and click the last element in the list.

Clicking Select... gives more font choices.
Units: Units and
Format

Change the units and format of the length, height,
spacing or diameter element that you have
selected from the Elements in mark list.

General or Appearance tab:
In main parts

In secondary parts

In sub-assembly main
parts

In sub-assembly
secondary parts

These settings are for bolt marks.

Visible displays bolt marks.

Not visible does not display bolt marks.

Visibility in view distributed distributes the marks in the view.
Tekla Structures only creates marks that are not
visible in the other views.

always always creates marks in the view,
irrespective the settings in other views.

preferred acts as distributed, but the preferred
view has a higher priority.
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Setting Description
Select distributed to one view only in a drawing. If
you set other views to distributed, the marks are
located only in the view that has the setting
Visibility in view set to preferred.

none creates no marks.
Parts out of view plane This setting is available only in view level

properties.

Visible displays marks outside of the view in the
drawing.

Not visible displays no marks outside the view.
Ignore size This setting is for bolt marks.

Filters standard-sized bolt marks out of drawings,
which means that Tekla Structures does not
display bolt marks of the defined size in drawings.

There are some advanced options that can be used
in addition to the Ignore size setting so that you
first give the ignored size and then set the
advanced option:

XS_OMITTED_DIAMETER_TYPE defines if the
ignored size is the size of the bolt (value BOLT) or
the hole (value HOLE).

XS_OMITTED_BOLT_TYPE can be used for filtering
out ignored bolt marks on the basis of the bolt
standard. Enter the name of the bolt standard as
the value, for example, 7990. You can also use
wildcards, such as * or ?.

XS_OMITTED_BOLT_ASSEMBLY_TYPE can be used
for filtering out ignored bolt marks on the basis of
the bolt type. The values are SITE, SHOP, and 
SITE_AND_SHOP.

Merge marks This setting is for part marks and surface
treatment marks.

On merges marks.

For more information about part marks merging
distance and other merging principles, see Merge
marks (page 311). By default, the maximum
merging distance is 1200 mm from the part.

Frame around mark:
Type and Color

Define the frame to be used around marks, and
the color of the frame.
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Setting Description
Background mask Select Opaque to hide the part of the drawing that

is covered by the mark.

Select Transparent to show the part of the
drawing that is covered by the mark, so that line
work is visible, for example.

Leader line: Rebar
group mark, Merged
marks, Type, Arrow and
Use hidden lines for
hidden parts.

Define the leader line type and line arrow type, and
select to hide leader lines for hidden parts.

If you are merging marks, or adding rebar group
marks, select one of the following options:

: One leader line to group creates one
leader line for a group of objects.

: One leader line per row merges the
marks and creates one leader line for a row of
objects.

: Parallel leader lines merges the marks
and creates parallel leader lines.

: Leader lines to one point merges the
marks and draws all leader lines to one point.
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Setting Description
: Perpendicular leader lines allows you to

create marks with perpendicular leader lines to
rebar groups. Creates marks with leader lines to
each rebar in a group plane

: Leader line to first and last allows you to
create marks with perpendicular leader lines to
rebar groups. Creates marks to first and last rebar
in a group.

You can control the length of the perpendicular
leader lines with the advanced option 
XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDI
CULAR ( File --> Settings --> Advanced options -->
Marking: General ). The default value is 0 mm.

Rotation Define the part mark rotation.
Alignment Select one of the alignment options:

Left

Center

Right

Leader line

The Leader line option is available in following
mark types: bolt marks, connection marks, part
marks, neighbor part marks, pour object marks,
reinforcement marks, neighbor reinforcement
marks, merged reinforcement marks and surface
treatment marks.

Place... Clicking the Place... button opens the placing
dialog box.

Placing: free allowsTekla Structures to search for
the first suitable location for the mark.

Placing: fixed allows you to place the mark in any
location.

When you use the option fixed, the mark stays
where it is even though you update the drawing,
whereas with free, Tekla Structures tries to find the
optimal place for the annotation object.

Search margin is the empty margin that you want
to leave around the mark.

Minimum distance is the minimum distance of
the mark from the part.
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Setting Description
Maximum distance is the maximum distance of
the mark from the part.

Note that if you use a high Search margin and
Minimum distance values, the mark placement
does not work properly.

Quarter defines the areas where Tekla Structures
searches for a position to place the mark.

(1) Search margin

(2) Minimum distance

(3) Maximum distance

For more information about placing annotation
objects, see Arrange annotation objects (page 344).

Setting Image Description
Merging tab

Use the Merging tab in Reinforcement mark properties to view and modify
the settings affecting the merging of the reinforcement marks in cast unit
drawings.

For more information about merged reinforcement marks, see Elements in
merged reinforcement marks (page 979), and Merge marks automatically
(page 841).
Identical marks in
same cast unit

One leader line to
group creates one
leader line for a group of
reinforcing bars.
One leader line per
row merges the marks
and creates one leader
line for a row of
reinforcing bars.
Parallel leader lines
merges the marks and
creates parallel leader
lines.
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Setting Image Description
Leader lines to one
point merges the marks
and draws all leader
lines to one point.
No merge does not
merge marks. Tekla
Structures creates an
individual leader line for
each mark.

If you select No merge,
you still need to define
the mark content for the
marks that Tekla
Structures automatically
merges on the Merging
tab.

Preferred direction of
merge

Merge vertical merges
the marks in the vertical
direction of the drawing.
Merge horizontal
merges the marks in the
horizontal direction of
the drawing.

See also

Define marks (page 824)

Add automatic marks (page 826)

Define view labels and view label marks (page 691)

Modify section mark, view label and cutting line in drawings (page 294)

Add part marks manually in drawings (page 287)

Delete marks for selected parts (page 304)

Mark elements
The elements and options selected on the mark properties Content tab define
the contents of the marks in drawings.

To add marks to a drawing automatically using the drawing properties, see
Add automatic marks (page 826).

To add part marks manually in an open drawing, see Add part marks manually
in drawings (page 287).
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To add marks manually in reinforcement, see Add reinforcement marks
manually in drawings (page 289)

Click the links below to find out more:

• Common elements in marks (page 972)

• Part mark elements (page 973)

• Bolt mark elements (page 975)

• Reinforcement and neighbor reinforcement mark elements (page 976)

• Reinforcement and neighbor reinforcement mesh mark elements
(page 977)

• Pour object mark elements (page 980)

• Elements in merged reinforcement marks (page 979)

• Connection mark elements (page 979)

• Surface treatment mark elements (page 981)

• Section and detail mark elements (page 981)

• View, section view and detail view label mark elements (page 982)

Common elements in marks
There are some mark elements that can be used in most of the mark types.

Element Description
User-defined attribute Available for building object marks.

Adds a user-defined attribute to the
mark. You can also use template
fields for user-defined attributes.

In marks, you cannot use template
attributes such as MODEL_TOTAL that
refer to the whole model. Marks only
check the information from the object
in the drawing and not from the
whole model.

For more information about adding
user-defined attributes in marks, see
Add attributes in automatic marks
(page 850).

Text Opens a dialog box where you can
enter text in the mark. The maximum
number of characters is 255.

Symbol Opens a dialog box where you can
change the symbol file in use and
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Element Description
select a symbol from the Tekla
Structures symbol file to add to the
mark.

< > Adds spaces between mark elements.
<--' Adds a line feed between the

elements to create multi-row marks.
The default space between the lines
depends on the text height and can
be changed with the advanced option 
XS_MARK_ELEMENT_SPACE_FACTOR.

<-- Adds a backspace between the
desired elements to remove the
default space between them. The
default space between the elements
depends on the text height and can
be changed with the advanced option 
XS_MARK_ELEMENT_SPACE_FACTOR.

Template Available for building object marks.

Adds in the mark a custom graphical
template created with Template
Editor. Opens a dialog box where you
can select the template.

For more information about adding
templates in marks, see Add
templates in automatic marks
(page 854).

Part mark elements
You can define part mark contents independently for main and secondary
parts and for sub-assembly main and secondary parts.

The following table lists all elements specific to part marks and neighbor part
marks. Some of the available elements are not listed here, because they are
common to many types of marks, and listed separately (page 972).

Element Description
Assembly position Adds the prefix and position number

of the assembly.
Part position Adds the prefix and position number

of the part.
Profile Adds the profile name of part,

assembly, or cast unit main part.
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Element Description
Material Adds the material of part, assembly,

or cast unit main part.
Name Adds the name of part, assembly, or

cast unit main part.
Class Adds the class of part, assembly, or

cast unit main part.
Finish Adds the finish of part, assembly, or

cast unit main part.
Size Adds the size of the part or the

assembly or cast unit main part.
Length Adds the length of the part or

assembly, or of the cast unit main
part.

You can change the unit and format
of the length.

Camber Adds the camber of the part or the
assembly or cast unit main part (if this
user-defined part attribute is set).

Fittings (NS/FS) Displays the near side/far side marks
in the part mark. (only available in
front views).

Face direction Displays main compass direction
(North, East, South, West) of the face,
where the mark is added. The
direction can only be shown if

• the face is vertical

• the direction is the same for all
assemblies with the same
assembly position number

In other cases, the element produces
no text to mark.

Furthermore, face direction is not
shown for columns in general
arrangement drawings, if you have
set Mark always to center of
column in GA drawings to Yes in
File menu --> Settings --> Options --
> Orientation marks .

Gage of outstanding leg Adds the hole gage.

You can control the format of this
option with the advance option .
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Element Description
Center-to-center distance Adds center-to-center distance in the

mark.

You can control the format of this
option with the advanced options 
and .

Rotation angle Adds the rotation angle of a spiral
beam in the mark. For other parts this
element gives an empty value.

Bolt mark elements
You can define bolt mark options independently for site and shop bolts.

Below is a list of the elements specific to bolt marks.

For additional information about defining size in bolt marks, see Define size in
bolt marks using advanced options (page 860).

Element Description
Bolt length Adds the length of the bolt.

You can change the unit and format
of the length.

Bolt diameter Adds the bolt diameter.

You can change the unit and format
of the diameter.

Hole diameter Adds the hole diameter.

You can change the unit and format
of the diameter.

Hole depth Adds the bolt hole depth.
Material Adds the bolt material grade.
Standard Adds the bolt standard.
Short name Adds the bolt’s short name. This can

be the commercial name of a specific
bolt, for example.

Full name Adds the complete name of the bolt.
This name is visible in the dialog box
list.

Assembly type Adds the bolt assembly type.
Number of bolts Adds the quantity of bolts.
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Element Description
Slot length (x)

Slot length (y)

Adds the slot length in the x or y
direction.

You can change the unit and format
of the length.

Slot length Adds the slot length.

You can change the unit and format
of the length.

Slot height Adds the slot height.

You can change the unit and format
of the height.

Size Adds the hole size.

You can change the unit and format
of the size.

Countersunk Adds countersink in the countersunk
bolt marks.

Gage of outstanding leg Adds hole gage.

You can control the format of this
element with the advanced option .

Center-to-center distance Adds center-to-center distance.

You can control the format of this
element with the advanced options 
and .

Reinforcement and neighbor reinforcement mark elements
You can define mark contents separately for single reinforcing bars, bar
groups, and reinforcement meshes.

Below is a list of the elements you can include in all reinforcement and
neighbor reinforcements marks. Some of the available elements are not listed
here, because they are common to many types of marks, and listed separately
(page 972).

Element Description
Name Adds the name of the bar or mesh.
Grade Adds the material grade of the bar or

mesh.
Diameter Adds the nominal diameter of the

bar.
Class Adds the class of the bar or mesh.
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Element Description
Length Adds the total length of the bar.

You can change the unit and format
of the length.

Number Adds the quantity of the bars.
Position Adds the reinforcement position

number.
Shape Adds the shape of the bar or mesh.
Weight Adds the weight of the bar or mesh.
cc Adds the center-to-center spacing of

the bars. The options are:

• cc adds the spacing value if
spacing does not vary

• cc min adds the smallest spacing
value of the bar group if spacing
varies

• cc max adds the largest spacing
value of the bar group if spacing
varies

• cc exact lists all spacing values of
the bar group

• cc target lists all reinforcing bar
target spacing values

You can change the unit and format
of the cc options.

Pullout picture Adds a pull-out picture of a bar to the
mark.

For more information about pull-out
pictures, see Add pull-out pictures in
automatic reinforcement marks
(page 863)

See also

Add automatic marks (page 826)

Elements in merged reinforcement marks (page 979)
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Reinforcement and neighbor reinforcement mesh mark elements
You can define mark contents separately for reinforcement meshes.

The following elements are specific to the reinforcement and neighbor
reinforcement mesh marks, other elements are the same as for reinforcement
marks (page 976). Some of the available elements are not listed here, because
they are common to many types of marks, and listed separately (page 972).

Element Description
Size Adds the nominal diameters of the

mesh bars, dimensions of the mesh,
and the spacings of the bars in the
longitudinal and crossing directions.

Mesh length Adds the length of the reinforcement
mesh.

Mesh width Adds the width of the reinforcement
mesh.

cc You can define cc individually for the
longitudinal and crossing bars in the
mesh.

Adds the center-to-center spacing of
the bars. The options are:

• cc longitudinal/cc crossing adds
the spacing value if spacing does
not vary

• cc min longitudinal/cc min
crossing adds the smallest
spacing value of the bar group if
spacing varies

• cc max longitudinal/cc max
crossing adds the largest spacing
value of the bar group if spacing
varies

• cc exact longitudinal/cc exact
crossing lists all spacing values of
the bar group

• cc target lists all reinforcing bar
target spacing values

Diameter longitudinal Adds the diameter or size of the
longitudinal bars.

Diameter cross Adds the diameter or size of the
crossing bars.
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See also

Add automatic marks (page 826)

Elements in merged reinforcement marks
Some extra elements are available for merged reinforcement marks, in
addition to basic reinforcement marks.

Element Description
Block prefix Adds text or a value to the beginning

of each repeated block. Opens a
dialog box where you can enter the
prefix.

You can use the following variables as
block prefixes:

%NUMBER% includes the number of
marks merged to the mark.

%NUMBER_IN_PLANE% includes the
number of marks merged in the plane
of the drawing to the mark.

%NUMBER_OUT_OF_PLANE% includes
the number of marks merged in the
depth direction of the drawing to the
mark.

Single mark content Adds the content of the single
reinforcement mark selected on the
Content tab to the mark.

Distances between groups Adds the center-to-center distances
between reinforcing bars or bar
groups included in a merged mark.

Symbol separating blocks in mark Adds a symbol between the blocks in
the merged mark. Opens a dialog box
where you can define the symbol.

The elements that appear before this
element on the mark content list
generate a block.

See also

Reinforcement and neighbor reinforcement mark elements (page 976)

Add automatic marks (page 826)

Merge marks automatically (page 841)
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Connection mark elements
In connection marks, you can show the connection code, name, number, and
running number, the group they belong to, potential errors, and the related
DSTV code.

Below is a list of elements specific to connection marks.

Element Description
Code Adds the connection code. This is a

user-defined code you give for the
connection in the connection dialog
box. The code can be either a text
string or a number.

Name Adds the connection name, for
example, Tube_splice.

DSTV code Adds the DSTV code.
Connection number Adds the number of the connection.
Running number Adds the connection running number.

All connections are automatically
numbered with a running number.

Group Adds the connection group.
Connection error Adds the connection error. The

numbers correspond to the
connection symbol colors:

• 1 = green

• 2 = yellow

• 3 = red symbol

Pour object mark elements
Pour objects have some mark elements of their own, in addition to common
mark elements (Text, Symbol, User-defined attribute, Template).

Element Description
Material Adds the defined pour material.
Pour number Adds the identifier that groups the pour objects in

the same group, for example, to be poured at the
same time.

Pour type Adds a property of the pour based on the name of
a part.

Concrete mixture Adds the defined concrete mixture.
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See also

Common elements in marks (page 972)

Surface treatment mark elements
In surface treatment marks, you can show the name, material, Tekla
Structures-specific name, and the code of the surface treatment.

Here is a list of elements specific to surface treatment marks. Some of the
available elements are not listed here, because they are common to many
types of marks, and listed separately (page 972).

Element Description
Name Adds the name defined in the Name

box in the surface treatment
properties in a model.

Material Adds the surface treatment material.
Class Adds the class of the surface

treatment.
Code Adds the code of the surface

treatment option selected from the
Subtype list in the in the surface
treatment properties in a model.

For example, if the subtype is MF
Magnesium Float, the code is MF.

Surface treatment name Adds the full name of the surface
treatment option selected from the
Subtype list in the in the surface
treatment properties in a model.

For example, if the subtype is MF
Magnesium Float, the full name is
Magnesium Float.

See also

Add automatic marks (page 826)

Section and detail mark elements
In section and detail marks, you can show the name of the section/detail, the
name of the current drawing, and the name of the source drawing.
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Below is a list of elements specific to section and detail marks. Some of the
available elements are not listed here, because they are common to many
types of marks, and listed separately (page 972).

Element Description
Section name/Detail name Adds the name of the section or the

detail (A, B, C, and so on).
Drawing name Adds the name of the current

drawing.
Source drawing name Adds the name of the drawing where

the view is.
Source drawing name when moved Adds the name of the drawing where

the view is. This is shown only if the
view is not in the same drawing as the
section/detail mark.

See also

Modify section mark, view label and cutting line in drawings (page 294)

Positioning properties of view label, section and detail marks (page 983)

View, section view and detail view label mark elements
In view labels, you can show the name of the view, section or detail, the view
scale, drawing name, and source drawing name.

Below is a list of the elements specific to view, section view and detail view
label marks. Some of the available elements are not listed here, because they
are common to many types of marks, and listed separately (page 972).

Element Description
View name/Section name/Detail
name

Adds the name of the view, section or
the detail.

Scale Adds the scale of the view.
Drawing name Adds the name of the current

drawing.
Source drawing name Adds the name of the drawing where

the view has originally been created.
Source drawing name when moved Adds the name of the drawing where

the view has originally been created.
This is shown only when the view has
been moved from its original drawing.

See also

Define view labels and view label marks (page 691)
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Positioning properties of view label, section and detail marks (page 983)

Positioning properties of view label, section and detail
marks
Use the Position tab in the Mark Contents dialog box in view properties to
set the positioning options for view labels marks, section marks and detail
marks.

Option Description
Show on For section marks.

Defines if the section marks are
shown at both ends of the cut line or
at the left or right end.

Text position Defines the position of the mark text
in relation to the line or in relation to
the symbol or symbol center line.

Horizontal offset sets the horizontal
offset of the mark text from the line.

Vertical offset sets the vertical offset
of the mark text from the line.

Text rotation For section marks.

Defines the rotation of the mark text.
Alignment For view label marks.

Defines if the view label mark is
aligned to the center, right, or left.

See also

Define view labels and view label marks (page 691)

Modify section mark, view label and cutting line in drawings (page 294)

Drawing weld mark properties
In Weld Mark Properties dialog box you can view and modify the properties
of a weld mark that has been manually added in a drawing.

To open the weld mark properties, do one of the following in an open drawing:

• Double-click a manually created weld.

• Hold down Shift and click Weld mark on the Annotations tab.

• On the Drawing tab, click Properties --> Weld mark.
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Option Description
Prefix a= design throat thickness, s= penetration throat

thickness, or z= leg length
Size The size of the weld. If you select a partial

penetration weld as the weld type, you can enter
two sizes.

Type The type of the weld.

For a list of available weld types and their
descriptions, see List of weld types.

You can customize some of the weld type symbols,
see Customize weld type symbols for more
information.

Angle The angle of weld preparation, bevels, or groove.

Tekla Structures displays the angle between the
weld type symbol and the fill type contour symbol.

Contour The fill type contour of a weld can be:

• None

• Flush 

• Convex 

• Concave 
Finish Tekla Structures displays the finish symbol above

the weld type symbol in drawings. The options are:

• G (Grind)

• M (Machine)
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Option Description
• C (Chip)

• (Flush finished weld)

• (Smooth blended weld face)
Length The length of a regular weld depends on the length

of the connection between the welded parts. You
can set the exact length of a polygon weld by, for
example, defining the start and end points of the
weld.

Pitch The center-to-center spacing of welds for non-
continuous welds. Pitch is shown in the weld mark
if the value is greater than 0.0.

To create a non-continuous weld, define the
center-to-center spacing and the pitch of the
welds. Tekla Structures calculates the distance
between the welds as the pitch minus the length of
the weld.

By default, Tekla Structures uses the – character to
separate weld length and pitch, for example, 50–
100. To change the separator to @, for example,
set the advanced option
XS_WELD_LENGTH_CC_SEPARATOR_CHAR to @.

Effective throat The weld size used in weld strength calculation.
Root opening The space between the welded parts.
Reference text Additional information to appear in the weld

symbol. For example, information about the weld
specification or process.

Edge/Around Indicates whether only one edge or the entire
perimeter of a face should be welded.

A circle in the weld symbol in drawings indicates
the Around option has been used.

Workshop/Site Indicates where the weld should be made.
Stitch weld Set this option to Yes to create a staggered,

intermittent weld.

Stitch welds are staggered on both sides of the
welded part. Tekla Structures shows the weld type
symbols as staggered in weld symbols.

If you set this option to No, a non- staggered
intermittent weld is created. To show the pitch in a
weld mark, set Pitch to a value greater than 0.0.
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Option Description
Placing Search margin is the empty margin that you want

to leave around the mark.

Minimum distance is the minimum distance of
the mark from the part.

Quarter defines the areas Tekla Structures
searches for a space to place the weld marks.

Placing is the method used to place welds marks:

• free lets Tekla Structures decide the location
and direction of the mark.

• fixed allows you to place the weld at any point.

See also

Welds in drawings (page 492)

Model weld mark visibility and appearance properties in
drawings
You can select which model weld marks are visible in drawings, and define the
content that is displayed in weld marks. In assembly drawings, you can define
the visibility of welds in sub-assemblies.

Use options in Weld mark properties (or General - Welding Mark Properties
in general arrangement drawings) to set the visibility and contents of model
weld marks.

Single-part and assembly drawings

1. On the Drawings & reports tab, click Drawing properties and select the
drawing type.

2. Click View creation in the options tree on the left, select the view and the
properties that you want to change, and click View properties.

3. Click Weld mark in the options tree.

General arrangement drawing

1. Click Drawings & reports --> Drawing properties --> GA drawing .

2. Click Weld mark.

Option Description
Weld number Yes shows the weld number.

Tekla Structures assigns a number to
each weld when the weld is created.
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Option Description
You can select whether to show or
hide the weld number.

Welds

Welds in sub-assemblies (assembly
drawings)

None displays no welds in the
drawing.
Site displays only site welds in the
drawing.
Workshop displays only workshop
welds in the drawing.
Both displays both site welds and
workshop welds in the drawing.

Welds in hidden parts Select how to show the weld marks
for welds in hidden parts:

• None: If the part is hidden, the
weld mark is not drawn.

• Site: If the part is hidden, weld
marks for site welds are drawn
only.

• Workshop: If the part is hidden,
weld marks for workshop welds
are drawn only.

• Both: Weld marks are always
drawn for hidden parts.

Weld size limit Enter a weld size to filter welds of that
size out of the drawing. This is useful
when you only want to show non-
typical welds in a drawing.

To set whether the weld size limit is
an exact or minimum value, use the
advanced option .

To filter out a standard weld types,
use the advanced option XS_
OMITTED_WELD_TYPE.

Above line, Below line and Other If there is no check mark in the
Visible column next to the following
properties, the properties are not
displayed in the weld mark. These
settings are set separately to above
line and below line:

Prefix

Size

Type
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Option Description
Angle

Contour

Finish

Length

Pitch

Effective throat

Root opening
Reference text

Edge/Around

Workshop/Site

These settings are common to above
line and below line. If there is no
check mark in the Visible column
next these properties, they are not
displayed in the weld mark.

Place... Placing:

• free allows Tekla Structures to
search for the first suitable
location for the mark, dimension,
weld or another annotation object.
fixed allows you to place the
mark, dimension, weld or another
annotation object in any location.

• When you use the option fixed,
the annotation object stays where
it is even though you update the
drawing, whereas with free, Tekla
Structures tries to find the optimal
place for the annotation object.

Search margin is the empty margin
that you want to leave around the
mark.

Quarter defines the areas Tekla
Structures searches for a space for
placing the mark.

Minimum distance is the minimum
distance of the mark from the part.

Note that if you use high Search
margin and Minimum distance
values, the mark placement may not
work properly.

Color Sets the color of the text.
Height Sets the height of the text.
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Option Description
Font Sets the font of the text. Click Select...

to show more options.
Type Sets the type of the line.
Color Sets the color of the line.
Background mask Select Opaque to hide the part of the

drawing that is covered by the mark.

Select Transparent to show the part
of the drawing that is covered by the
mark, so that line work is visible, for
example.

See also

Welds in drawings (page 492)

Level mark properties
Use the options in the Level Mark Properties dialog box to view and modify
level mark contents and appearance.

To open the dialog box in an open drawing, go to the Drawing tab, and click
Properties --> Level mark .

Option Description
General tab
Prefix Displays text before the mark.
Prefix for positive level + displays a + character in front of the value.
Visibility of numeric
value

Defines if the numeric values are visible or hidden.

Postfix Displays text after the mark.
Level mark format:
Precision

Defines the precision of the level mark dimension.

Level mark format:
Format

Defines the format of the level mark dimension.

Level mark format: Use
grouping

Defines whether to use different grouping options
to represent the level mark dimensions.

Level mark format:
Units

Defines the units used in level mark dimensions.
The available values are automatic, mm, cm, m,
foot - inch, inch and feet.
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Option Description
Placing Search margin is the farthest distance Tekla

Structures uses when searching for an empty
space for the level mark.

Minimum distance is the closest distance Tekla
Structures uses to search for an empty space for a
level mark.

Quarter defines the areas Tekla Structures
searches for a space to place the level marks.

Placing is the method used to place level marks:

• free lets Tekla Structures decide the location of
the level mark.

• fixed allows you to place the level mark at any
point.

Appearance tab
Text: Color, Height,
Font, Angle

Defines the text color, height, font and angle.

Frame: Type, Leader
line, Color

Defines the frame to be used around marks, the
type of the leader line, and the color of the frame.

Frame: Background
mask

Select Opaque to hide the part of the drawing that
is covered by the level mark.

Select Transparent to show the part of the
drawing that is covered by the mark.

Arrow: Type Defines the type of the arrow.

Defines the height and the length of the
arrowhead.

See also

Add level marks in drawings (page 292)

9.8 Leader line types
You can use leader lines with text, symbols, associative notes and marks to
make it clearer to which item it is related to.
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Option Description Click the links below to find
out more

Texts Add text in drawings (page 320)

Symbols Add symbols in drawings
(page 330)

Level marks Add level marks in drawings
(page 292)

Part marks Add automatic marks (page 826)

Add part marks manually in
drawings (page 287)

Revision marks Add revision marks in drawings
(page 329)

Surface treatment
marks

Define automatic surface
treatment in drawings
(page 892)

Reinforcement
marks

Define automatic reinforcement
and reinforcement mesh
properties (page 896)

Associative notes Add associative notes in
drawings (page 297)
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9.9 Part and neighbor part properties in drawings
Use the options in part properties or neighbor part properties to check and
change the part or neighbor part properties. In neighbor part properties, you
can also control the visibility and appearance of neighbor part bolts.

To go to part or neighbor part properties:

• On the Drawings & reports tab, click Drawing properties , select the
drawing type and go to part or neighbor part properties.

• In an open drawing, double-click the drawing view frame, select View
creation, select a view, click View properties and click Part... or Neighbor
part... In GA drawings, just double-click the view frame and click Part... or
Neighbor part...

• In an open drawing, double-click the drawing background, and go to part or
neighbor part properties.

• Double-click a part or neighbor part in an open drawing.

All part properties do not contain all of the settings listed below.

Content tab:

Option Description
Representation Outline shows parts as solid objects.

Exact shows parts as solid objects.
This choice also draws the fillet edges
and chamfers in the profile cross
sections. For some profiles, Outline
shows them as well.

Symbol draws parts as lines.

Symbol with partial profile shows a
partial profile of the part. You can
also adjust the length of the partial
profile (Length), and the offset of the
partial profile from the middle point
of the part (Offset from middle
point).

Workshop form draws round tube
profiles as wrap-around templates.
Note that Workshop form can only
be used in single part drawings.

Bounding box draws parts as boxes
surrounding the actual profiles.

Bounding box is a good option to use
with complex items with an extrema
box containing many polygons
slowing down drawings, because

Drawing settings reference 992 Part and neighbor part properties in drawings



Option Description
Bounding box makes drawings
faster.

Base box shows parts as boxes and
uses the h and b values from the
profile catalog as box dimensions.

Symbol offset Defines the distance of the end points
of reference lines and center lines
from the end points of the object.

Note that the Symbol offset value
affects the size of the center line
cross. If the value is 0, the cross is not
visible.

Inner contours Shows the inner contours of a tube.
Hidden lines If the Hidden lines check box is

selected, Tekla Structures shows
hidden lines in secondary and
neighbor parts.

If the Own hidden lines check box is
selected, Tekla Structures shows
hidden lines in main parts.

Center line Select whether you want to show
center lines.

Select the Main part: Beam, Plate or
Polygon check box to show center
lines in main parts.

Select the Sec part: Beam, Plate or
Polygon check box to show center
lines in secondary parts.

Note that the center line is only
shown for assembly primary parts
and not for secondary parts when
looking from the cross section
direction. If the part is viewed from
the side, the center line is also shown
for secondary parts.

Note that the Symbol offset value
affects the size of the center line
cross. If the value is 0, the cross is not
visible.
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Option Description
Reference lines Select wether you want to show

reference lines.

Select the Main part: Beam, Plate or
Polygon check box to show reference
lines in main parts.

Select the Sec part: Beam, Plate or
Polygon check box to show reference
lines in secondary parts.

Additional marks Select the following check boxes to
show additional marks in drawings:

• Orientation marks shows
orientation marks (page 873).

• Connecting side marks shows
connecting side marks (page 873).

• Pop-marks shows pop-marks
defined in NC settings.

• Edge chamfers shows edge
chamfers (page 378).

• Fillet edges shows fillet edges
(page 382).

Bolt representation (neighbor parts) Select bolt representation. The
options are solid, exact solid
Symbol, Symbol2 , Symbol3, DIN
symbol, and User-defined symbol.

DIN symbol corresponds to German
standards (DIN). The only DIN
symbols you can control are:

• Symbol 24 for normal workshop
bolts

• Symbol 25 for normal site bolts

• Symbol 26 for front countersunk
site bolts

• Symbol 27 for back countersunk
site bolts

• Symbol 28 for front countersunk
workshop bolts

• Symbol 29 for back countersunk
workshop bolts

• Symbol 30 for front countersunk
holes

Drawing settings reference 994 Part and neighbor part properties in drawings



Option Description
• Symbol 31 for back countersunk

holes

User-defined symbol is a symbol
that has been created in Symbol
Editor.

Symbol content (neighbor parts) Select whether to include hole or axis
in the symbol.

Neighbor parts have a Visibility tab:

Option Description
Neighbor parts None does not show neighbor parts.

Connected parts shows all parts
connected to the model object.

Connecting parts shows only the
parts the model object is connected
to.

All componentscombines the
Connected parts and the
Connecting parts options.

By extreme shows all parts within
the boundaries of the main and
secondary part.

Main/Secondary parts Main parts shows only neighbor
parts that make the main part of an
assembly or a cast unit.

Secondary parts shows only
neighbor parts that are secondary
parts of an assembly or a cast unit.

Both shows both main and secondary
parts.

Skew parts Yes shows skew parts as neighbor
parts in the drawing, No does not.

Bolts Yes shows the bolts in the neighbor
parts, No does not.

The Appearance tab is similar in all of the properties of all kinds of building
objects (parts, neighbor parts, bolts, welds, surface treatments, reinforcement,
and meshes).

Option Description
Visible lines Sets the Color and Type of the visible

lines.
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Option Description
Hidden lines, Center line Sets the Color and Type of the

hidden lines.

Sets the Color of the center lines.
Reference lines Sets the Color and Type of the

reference lines.
Text: Color Sets the Color of the text.
Text: Height Sets the Height of the text.
Text: Font Sets the Font of the text. Click

Select... to show more options.
Line: Type Sets the Type of the line.
Line: Color Sets the Color of the line.
Bolts: Color Sets the color of the bolts in neighbor

parts.

Both parts and neighbor parts have a Fill tab. To add a fill for outer part faces,
use the Part faces area, and to add a fill to cross sections in section views, use
the Sections area.

Setting Description
Type Defines the fill type. Clicking the

button next to the list opens a
preview of the hatch patterns
(page 884).

Automatic selects the fill type
automatically from the hatch pattern
schema files.

None uses no fill.
Color Defines the color for the fill.

You can select a predefined color or
use Special color that is not
converted to black in printouts.

Background Defines the background color for the
fill.

Background color selection is
disabled for hardware hatches.

Background color can be set for
automatic hatches, but it has effect
only if automatic hatch is not defined
for the material in the hatch pattern
schema file.
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Setting Description
Scale Automatic scales and rotates the fill

automatically.

Custom allows you to select scaling
and rotation manually.

Scaling in direction x and Scaling in
direction y define the scales in x and
y direction.

Keep ratio of x and y retains the
relative proportions in the hatch
pattern.

Angle rotates the fill. Angle 0.0 is for
horizontal and 90.0 for vertical.

See also

Define automatic drawing part properties (page 868)

Define automatic neighbor part properties (page 872)

9.10 Bolt content and appearance properties in drawings
Use the options in bolt properties to check or change the bolt content and
appearance.

To go to bolt properties:

• On the Drawings & reports tab, click Drawing properties , select the
drawing type and go to bolt properties.

• In an open drawing, double-click the drawing background, and go to bolt
properties.

• Double-click a bolt in an open drawing.

All bolt properties dialog boxes do not contain all of the settings listed below.

Option Description
Solid/Symbol The options are solid, exact solid,

Symbol, Symbol2, Symbol3, DIN
symbol, and User-defined symbol.

DIN symbolcorresponds to German
standards (DIN). The only DIN
symbols you can control are:

• Symbol 24 for normal workshop
bolts
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Option Description
• Symbol 25 for normal site bolts

• Symbol 26 for front countersunk
site bolts

• Symbol 27 for back countersunk
site bolts

• Symbol 28 for front countersunk
workshop bolts

• Symbol 29 for back countersunk
workshop bolts

• Symbol 30 for front countersunk
holes

• Symbol 31 for back countersunk
holes

User-defined symbol is a symbol
that has been created in Symbol
Editor.

Symbol content Indicates whether to include the Hole
and Axis symbols in the drawing.

Visibility of bolts Control the visibility of bolts in main
parts, secondary parts and sub-
assemblies separately. Visible shows
bolt group holes in main parts or
secondary parts. Not visible hides
them. In assembly drawings you can
also define whether to show or hide
bolt group holes in sub-assemblies.

Color Change the bolt color.

See also

Define drawing bolts (page 879)

Part and neighbor part properties in drawings (page 991)

Define automatic bolt properties in drawings (page 880)

9.11 Surface treatment visibility and content properties in
drawings
Use the options in surface treatment properties to check or change the
surface treatments drawing properties.
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Option Description
Visibility Visible shows the surface treatment.

Not visible does not show the
surface treatment.

Representation Defines the appearance of the
surface treatment. The available
options are Outline, Exact,
Workshop form, Symbol, Bounding
box, and Base box.

Show pattern Defines whether the hatch pattern is
shown.

Hidden lines Defines whether hidden lines in
secondary and neighboring parts are
shown.

Own hidden lines Defines whether hidden lines in main
parts are shown.

See also

Define drawing surface treatment (page 891)

Surface treatment hatch pattern properties (surfacing.htc)
You can change the properties of the hatch patterns for each surface
treatment type separately.

The properties of the hatch patterns are defined in the surfacing.htc file,
located by default in ..\Tekla Structures\<version>\environments
\common\system . In addition to this file, the surface treatment code file 
product_finishes.dat is needed. It is located in the same folder.

If you create your own surface treatment hatch patterns in your company, you
can store surfacing.htc and product_finishes.dat in the firm folder
defined by the advanced option XS_FIRM.

Note:

NOTE When you edit a schema file, you must reopen the model to apply the
changes.

The syntax of surfacing.htc file is:

Surfacing Type, Surfacing Code, Hatch name, Scale, [Color],
[Automatic Scaling and Rotation]
Example:

1,MF,ANSI31,0.7
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1,SMF,ANSI32,0.7
1,WT,ANSI33,0.7
1,HT,ANSI34,0.7
1,LSB,AR-SAND,0.7
2,SM1,CROSS,1.0
2,SM2,CHECKERED,1.0
3,TS3,FBBRICKC,1.0
4,FP,ANSI31,1.0
4,UP,ANSI32,1.0

Option Description
Surface treatment type • 1 = concrete finish

• 2 = special mix

• 3 = tile surface

• 4 = steel finish
Surface treatment code This is the abbreviation used in

drawings and reports, for example,
MF for Magnesium Float. The
product_finishes.dat file
contains a full list of surface
treatment codes.

Hatch name You can check the hatch pattern
names and related hatch patterns by
going to the Fill tab in part properties,
selecting a hatch pattern from the
Type list and clicking the ... button
next to the list. The selected hatch
pattern is marked with a red frame.

Scale Scale is a numeric value that Tekla
Structures uses to scale hatches.

Color (optional) 0=black (default)

1=white

2=red

3=green

4=blue

5=cyan

6=yellow

7=magenta
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Option Description
120= Special (use this color for gray
shade)

The hatch color defines the line width
for the printer. If you do not define a
color for a hatch in the
surfacing.htc file, Tekla Structures
uses the color defined on the
Appearance tab in surface treatment
properties. The Visible lines color
and type is used for the front of the
surface treatment, and the Hidden
lines for the back.

Automatic Scaling and
Rotation (optional)

1=true

0=false (default)

See also

Define automatic surface treatment in drawings (page 892)

9.12 Reinforcement/Neighbor reinforcement and mesh
properties in drawings
Use the options in the Reinforcement or Neighbor Reinforcement
properties to check and modify the reinforcement and mesh visibility,
appearance and content.

Option Description
Visibility of all reinforcing bars

Visibility of all meshes

Visible shows the bars or meshes.

Not visible does not show the bars
or meshes

Representation single line draws a single line with
radiused bends.

single line with filled ends draws a
single line for parallel bars and filled
ends for perpendicular bars.

double lines draws an outline of the
bar with radiused bends.

double lines with filled ends draws
an outline of the bar with radiused
bends and filled bar ends.
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Option Description
filled line draws a solid bar with
radiused bends.

stick draws a single line without
radiused bends.

outline shows the shape of the mesh
using an outline rectangle or polygon,
and a diagonal line. Applies only to
reinforcement meshes.

outline (ignore holes) ignores holes
and draws over them. Applies only to
reinforcement meshes.

Visibility of reinforcing bars in
group

Visibility of longitudinal wires

Visibility of crossing bars

all shows all bars in a group or mesh.

first bar shows only the first bar in
the group or mesh.

last bar shows only the last bar in the
group or mesh.

first and last shows the first and last
bar in the group or mesh.

bar in the middle of group shows
one bar in the middle of the group or
mesh.

two bars in the middle of group
shows two bars in the middle of the
group or mesh.

customized indicates that you have
specified the location of the only
visible reinforcing bar. Applies only to
bar groups and meshes.

Hide lines behind parts Hides the lines behind the part. This is
useful, for example, with lifting
anchors where the reinforcing bar is
partly outside the part.

Hide lines behind other rebars Hides the lines behind other
reinforcement bar lines.

Symbol at straight end

Reinforcing bar end symbols are
always drawn in solid line type,
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Option Description
regardless of the selected
reinforcement line type.

Applies only to reinforcing bars.
Symbol at hooked end

Applies only to reinforcing bars.

Reinforcing bar end symbols are
always drawn in solid line type,
regardless of the selected
reinforcement line type.

Mesh symbol Defines the mesh symbol to be used.
The mesh symbol appears in the
middle of the diagonal line.

Symbol 1

Symbol 2

Symbol 3

Mesh symbol size Defines the size of the mesh symbol.
Visible lines Defines the color and type of the

visible lines.

Reinforcing bar end symbols are
always drawn in solid line type,
regardless of the selected
reinforcement line type.

Hidden lines Defines the color and type of the
hidden lines.

Additional ways of modifying reinforcement

In addition to the settings in reinforcement properties, you can modify the
reinforcement in any of the following ways:
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• Increase the size of the bend and end symbols (in drawing units) using the
advanced options and in File menu --> Settings --> Advanced options -->
Concrete Detailing .

• Use the advanced option in File menu --> Settings --> Advanced options
--> Concrete Detailing to change the end symbols to a different direction.

• Modify the reinforcing bar bending schedule, rounding of bar dimensions,
symbols for meshes, strands, and unbonding, and appearance of
reinforcement pull-outs in the rebar_config.inp (page 1004) file.

See also

Define drawing reinforcement and meshes (page 896)

Part and neighbor part properties in drawings (page 991)

Reinforcement settings for drawings (rebar_config.inp)

Tekla Structures uses the settings in the rebar_config.inp file in the system
folder (XS_SYSTEM), firm folder or in the project folder to define the following
reinforcement-related issues in drawings:

• Selected area-specific reinforcing bar bending schedule

• Rounding of bar dimensions

• Available symbols for meshes, strands, and unbonding

• Appearance of reinforcement pull-outs

The entries in the rebar_config.inp are listed and described below:

Entry Description
MergeOneFormat No longer used. Define these properties in the

drawing properties.MergeTwoOrMoreFormats
MergeAndFormat
LeaderLinetype
DimensionMarkSpacingSep
arator

="/"
Affects the separator in reinforcement marks.

ExactDimensionMarkSpaci
ngSeparator

=" + "
Separator between different exact spacing
values in reinforcement marks.

ExactDimensionMarkPcsSe
parator

="*"
Separator between the number of bars and
their exact spacing value in reinforcement
mark.
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Entry Description
BendingAngleTolerance Set a tolerance value for the angle. Angles that

differ from the set tolerance value less than
the tolerance are recognized and lead to a
correct bending shape.

Enter the tolerance value as a radians, not as
a degree. The default value is 0.001 radians,
which is 0.0573 in degrees. This applies to all
bending shapes.

BentRebarTolerance Set a tolerance value. Depending on the value,
slightly curved reinforcing bars get straight
shape.

If reinforcing bar diameter is 20 mm and
radius is 200 m then value 20/200000 =
0.0001.

This variable defines correct curved
reinforcing bar in case of long reinforcing bars
to get a correct shape for the bar. This option
is used in comparing the relation of the
reinforcing bar diameter and radius. If the
relation is smaller than 
BentRebarTolerance, the reinforcing bar is
of bend_type_1, otherwise it is of
bend_type_34.

PullOutBendingRadiusAsM
ultiplier

Set to 1 to show the pullout bending radii
using multiplier instead of mm.

GroupBarMark No longer in use.
MarkingDimAttributes No longer in use.
ScheduleCountry Defines which bending schedule is used.

Affects bending shapes in templates and
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Entry Description
reports. The available schedules are FIN, SWE,
UK, US.

When you number the model, the bending
shape for the bar is given according to this
information. For example, in the Default
environment, the bending shapes are letters
A, B, C, and so on.

ScheduleDimensionRoundi
ngDirection
ScheduleTotalLengthRoun
dingDirection

Options:

• "UP": rounds bar dimensions up

• "DOWN": rounds bar dimensions down

• "NEAREST": rounds bar dimensions either
up or down

ScheduleDimensionRoundi
ngAccuracy

Sets the rounding accuracy for bar
dimensions. Default is 1 mm.

Tekla Structures rounds individual bar
dimensions up or down according to the
option you select for 
ScheduleDimensionRoundingDirection.

ScheduleTotalLengthRoun
dingAccuracy

Sets the rounding accuracy for the total bar
length. Default is 10 mm.

Tekla Structures rounds individual bar
dimensions up or down according to the
option you select for 
ScheduleTotalLengthRoundingDirection
.

BentSymbolFile Points to the symbol file that contains the
available reinforcing bar bent symbols. By
default, points to the file bent.sym, which in
the default environment is located in the
folder ..\ProgramData\Trimble\Tekla
Structures\<version>\\environments
\common\symbols.

MeshSymbolFile Points to the mesh symbol file that contains
the available mesh symbols. Affects the
available reinforcement mesh symbols in
drawings.

By default, points to the mesh.sym file in
the ...\Tekla Structures\<version>\
\environments\common\symbols folder.
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Entry Description
StrandSymbolFile Points to the strand symbol file that contains

the available strand symbols. Affects
drawings.

By default, points to the strand.sym file in
the ...\Tekla Structures\<version>
\environments\common\symbols folder.

UnbondingSymbolFile Points to the unbonding symbol file that
contains the available unbonding symbols.

RebarMeshSize Template for rebar mesh size.
PullOutDimensionFormat Defines the format for displaying the

dimensions.

The format follows the dimension properties
format.

Options:

• 0 = ###

• 1 = ###[.#]

• 2 = ###.#

• 3 = ###[.##]

• 4 = ###.##

• 5 = ###[.###]

• 6 = ###.###

• 7 = ### #/#

• 8 = ###/##.###

PullOutDimensionPrecisi
on

Sets the level of precision. The precision is
calculated using the following formula: 1/
value = precision.

In metric systems, you may want to use the
values 1, 10, and 100, and in imperial systems,
the values 2, 4, 8, 16 and 32, for example.

PullOutDimensionUnit Defines the units to use.

Options:

• 0 = auto

• 1 = mm

• 2 = cm

• 3 = m

• 4 = inch

Drawing settings reference 1007 Reinforcement/Neighbor reinforcement and
mesh properties in drawings



Entry Description
• 5 = foot and inch

PullOutColor Sets the color for the pull-outs in
reinforcement marks.

Options:

• 1 = black

• 2 = red

• 3 = bright green

• 4 = blue

• 5 = cyan

• 6 = yellow

• 7 = magenta
PullOutVisibleLineType Sets the line type for reinforcing bar shape in

pull-outs.

Options:

1 = 

2 = 

3 = 

4 = 

5 = 

6 = 

7 = 
PullOutRepresentation Sets the representation type.

Options:

• 0 = single

• 1 = double

• 2 = filled

• 3 = stick
PullOutAngleColor Sets the color for the angle in pull-outs.

Options:

• 1 = black

• 2 = red
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Entry Description
• 3 = green

• 4 = blue

• 5 = cyan

• 6 = yellow

• 7 = magenta

• 8 = brown

• 9 = green

• 10 = dark blue

• 11 = forest green

• 12 = orange

• 13 = gray

PullOutAngleLineType Sets the line type for angle lines in pull-outs.

Options:

• 1 = 

• 2 = 

• 3 = 

• 4 = 

• 5 = 

• 6 = 

• 7 = 
PullOutLeaderLineMinLen
gth

Sets a minimum length for the small leader
lines that point to the dimension text. The
default value is 10 mm. To switch leader lines
off completely, use a large value.

PullOutShowDuplicateDim
s

Defines whether duplicate dimensions are
showed multiple times for one bar.

Options:
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Entry Description
• 0 = duplicate dimensions are not shown

(default)

• 1 = equal and parallel dimensions are
shown, but similar hook dimensions are
not shown

• 2 = equal and parallel dimensions are not
shown, but both hook dimensions are
shown

• 3 = all dimensions are shown

• 4 = hook dimensions are not shown

• 5 = hook dimensions, or equal and parallel
dimensions are not shown

PullOutShowUSHookDims Defines if the US/NA style of dimension will be
shown for hooks over 90 degrees.

Options:

• 0 = shows European hook dimension (= leg
length, default)

• 1 = shows US hook dimension (= straight
length) for hooks >90 degrees

See the image below for the difference
between the US/NA (A) and European (B) hook
dimension.

See also

Add pull-out pictures in automatic reinforcement marks (page 863)

Define automatic reinforcement and reinforcement mesh properties
(page 896)

Reinforcement/Neighbor reinforcement and mesh properties in drawings
(page 1001)
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9.13 Pour object and pour break properties in drawings
Use the options in Pour Object Properties and Pour Break Properties in
general arrangement drawings to control the visibility of the pour objects and
pour breaks in drawings.

Pour object properties

To open Pour Object Properties:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and then click Pour object...

• In an open drawing, double-click the drawing background and click Pour
object...

• In an open drawing, double-click a pour object.

Option Description
Content tab - Hidden lines
Hidden lines on/off Select the check box to display pour

object hidden lines.
Own hidden lines on/off Select the check box to display own

hidden lines.
Content tab - Additional marks
Edge chamfers on/off Select on to display edge chamfers

(page 378).
Fillet edges on/off Select on to display fillet edges

(page 382).
Appearance tab - Visible lines
Color Select the color of the visible pour

object lines.
Type Select the type of the visible pour

object lines.
Appearance tab - Hidden lines
Color Select the color of the hidden pour

object lines.
Type Select the type of the hidden pour

object lines.
Fill tab

To add a fill for outer pour faces, use the Pour faces area, and to add a fill for
cross sections in section views, use the Sections area.
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Option Description
Type Defines the fill type. Clicking the

button next to the list opens a
preview of the hatch patterns.

Automatic selects the fill type
automatically from the hatch pattern
schema files.

None uses no fill.
Color Defines the color for the fill.

You can select a predefined color or
use Special color that is not
converted to black in printouts.

Background Defines the background color for the
fill.

Background color selection is
disabled for hardware hatches.

Background color can be set for
automatic hatches, but it has effect
only if automatic hatch is not defined
for the material in the hatch pattern
schema file.

Scale Automatic scales and rotates the fill
automatically.

Custom allows you to select scaling
and rotation manually.

Scaling in direction x and Scaling in
direction y define the scales in x and
y direction.

Keep ratio of x and y retains the
relative proportions in the hatch
pattern.

Angle rotates the fill. For example,
Angle 0.0 is for horizontal and Angle
90.0 for vertical.

Pour break properties

To open Pour Break Properties:

• On the Drawings & reports tab, click Drawing properties --> GA drawing
and then click Pour breaks...

• In an open drawing, double-click the drawing background and click Pour
breaks...

• In an open drawing, double-click a pour break.
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Option Description
Content tab
Visibility Defines if the pour breaks are visible

(Visible) or not (Not visible).
Hidden lines Select the check box to display pour

break hidden lines.
Appearance tab - Visible lines
Color Select the color of the visible pour

break lines.
Type Select the type of the visible pour

break lines.
Appearance tab - Hidden lines
Color Select the color of the hidden pour

break lines.
Type Select the type of the hidden pour

break lines.

See also

Pours in drawings (page 488)

9.14 Placement properties for marks, dimensions, notes,
texts and symbols
Use the settings in the Placing dialog boxes for dimensions, marks, notes,
texts annotation objects and dimensions to control how the annotation
objects are placed in a drawing.

You can set automatic placement properties for dimensions and marks before
you create a drawing. In an open drawing, you can modify the placement
properties of marks, notes, texts, symbols and dimensions.

To open the Placing properties in an open drawing:

• In an open drawing, on the Drawing tab, click Properties and then click
Text, Note, Symbol, Dimension or one of the mark types. After that, click
the Place... button.

• In an open drawing, double-click a text, mark, symbol, note or dimension.
After that, click the Place... button.

Drawing settings reference 1013 Placement properties for marks, dimensions,
notes, texts and symbols



Option Description
Search margin Defines the empty margin that you

want to have around the the
annotation objects.

Note that if you use a high Search
margin value, the mark placement
does not work properly.

Minimum distance Defines the minimum distance of the
mark, weld mark, dimension or
another annotation object from the
part.

Note that if you use a high Minimum
distance value, the mark placement
does not work properly.

Maximum distance Defines the maximum distance of the
mark, dimension or another
annotation object from the part.

Quarter For marks and manually added
annotation objects.

Defines the areas Tekla Structures
searches for a space to place the
annotation object.

Weld placement depends on the
welding direction. Welds can only be
placed in certain sectors, so the
Quarter options are not available.
However, this option is available for
manually added welds in the final
drawing.

Placing free allows Tekla Structures to search
for the first suitable location for the
mark, dimension, weld or another
annotation object. fixed allows you to
place the mark, dimension, weld or
another annotation object in any
location.

When you use the option fixed, the
annotation object stays where it is
even though you update the drawing,
whereas with free, Tekla Structures
tries to find the optimal place for the
annotation object.
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Option Description
Direction Available only for manual dimensions.

Defines the side of the dimensioned
object where Tekla Structures places
dimensions. This setting affects the
free setting.

The following image illustrates the search margin, minimum distance and
maximum distance of a mark:

(1) Search margin

(2) Minimum distance

(3) Maximum distance

See also

Define object protection and placement settings in drawings (page 677)

9.15 Model weld properties in drawings
You can select which model welds are visible in drawings and drawing views,
and set the weld color and line type.

• To set the automatic welding properties in single-part and assembly
drawings: On the Drawings & reports tab, click Drawing properties and
select the drawing type. Click View creation in the options tree on the left,
select the view and the properties that you want to change, and click View
properties. Now click Weld... in the options tree and adjust the settings as
required.

• To set the automatic welding properties in general arrangement drawing:
On the Drawings & reports tab, click Drawing properties and select the
drawing type. Click Weld... and adjust the settings as required.

• To modify the welding properties on drawing level in a general
arrangement drawing: Double-click the drawing background and click
Weld...
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• To modify the welding properties on view level: Double-click the drawing
view frame and click Weld... in the View Properties dialog box.

Option Description
Content tab - Visibility
Welds

Welds in sub-
assemblies

Not visible does not display any welds in the
selected view/drawing.

Site weld visible displays only site welds in the
view/drawing.

Workshop weld visible displays only workshop
welds in the view/drawing

Both visible displays both site welds and
workshop welds in the view/drawing.

Weld size limit Enter a weld size limit to filter welds of that size
and smaller out of the drawing. This is useful when
you only want to show non-typical welds in a
drawing.

To set whether the weld size is an exact or
minimum value, use the advanced option
XS_WELD_FILTER_TYPE.

To filter out a standard weld type, use the
advanced option XS_OMITTED_WELD_TYPE.

Content tab: Representation
Representation Select Path or Outline.

You can also select whether to show Hidden lines
or Own hidden lines.

Weld solids are shown in drawings in the following
cases:

• Weld solids are shown in drawings for those
weld types that have real solid support. Welds
that have no real solid support are shown in the
model with a hexagonal placeholder, and in
drawings weld solids are not shown.

• Welds that have custom cross-sections are also
supported.

Appearance tab: Visible lines
Color Sets the color of the weld lines.
Type Sets the type of the weld lines.
Appearance tab: Hidden lines
Color Sets the color of the hidden lines.
Type Sets the type of the hidden lines.
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See also

Welds in drawings (page 492)

Model weld mark visibility and appearance properties in drawings (page 986)

9.16 Drawing sketch object properties
You can draw different kinds of sketch objects (graphical objects) in your
drawings (lines, rectangles, polylines, polygons, arcs, circles) and use the
sketch objects for highlighting particular spots of interest, for example. Use
the properties dialog boxes of different sketch objects to check and change
the appearance of the shapes.

To open the properties dialog box of a sketch object, go to the Drawing tab,
hold down Shift and click the sketch object command. When you have added
a sketch object in a drawing, you can open its properties by double-clicking the
object.

The settings you have in the dialog box vary depending on the sketch object
type.

Setting Description
Behind model objects When set to Yes, places the graphical

object behind model objects.
Line: Type Defines the line type of the object.
Line: Color Defines the color of the object lines.
Line: Bulge or Bulge for all lines Values 0 - 1.The bulge factor defines

the curvature of the curved segments
of objects using the calculation:

Arc height = Line length * Bulge factor

Changing the bulge factor of a
polyline or polygon modifies all the
segments of that object.

Line: Radius Defines the radius of arcs and circles.
Arrow: Position
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Setting Description
Arrow: Type

Arrow: 
Defines the arrow height.

Arrow: 
Defines the arrow length.

Fill: Type Defines the fill type to be used in the
object. Clicking Select... shows the
available hatch types.

Fill: Color Defines the color of the fill.
Fill: Background Defines the background color of the

fill.
Scaling in direction x

Scaling in direction y

Keep ratio of x and y

Defines the fill scales in the x and y
direction.

Angle Rotates the fill. Angle 0.0 is for
horizontal and 90.0 for vertical.

Offset Moves the fill pattern inside the
object to in the x and y direction by
the specified value.

See also

Define hatches in drawings (page 883)

Draw sketch objects in drawings (page 353)

9.17 Drawing grid properties
Use the grid properties to view and modify the grid settings in drawings.

• To set the automatic grid properties in single-part and assembly drawings:
On the Drawings & reports tab, click Drawing properties and select the
drawing type. Click View creation in the options tree on the left, select the
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view and the properties that you want to change, and click View
properties. Now click Grid... in the options tree and adjust the settings as
required.

• To set the automatic grid properties on drawing level in general
arrangement drawing: On the Drawings & reports tab, click Drawing
properties and select the drawing type. Click Grid... and adjust the settings
as required.

• To modify the grid properties on drawing level in a general arrangement
drawing: Double-click the drawing background, click Grid... and adjust the
settings as required.

• To modify the grid properties on view level: Double-click the drawing view
frame and click Grid... in the View Properties dialog box, and adjust the
settings as required.

Option Description
Grid Visible shows the grids.

Not visible does not show the grids.

Visible in all views shows the grids in
all drawing views. This option is not
available for general arrangement
drawings.

Only grid labels visible shows only
the grid label and a short section of
the grid line. The length of the
displayed grid line depends on the
value entered in the Text placingbox.
In the drawing level, this option is
only available for general
arrangement drawings. On the view
and object level this option is
available for all types of drawings.

Text placing Sets the side to show the grid labels
and the length of the grid line
extension (the distance between the
end of the grid line and the text).

Text: Color, Height, Font and Frame Defines the grid label text color,
height, font and frame.

Other ways to adjust grids

Additionally, for example , and allow you to adjust the grid labels further.

See also

Define drawing grids (page 865)

Define automatic grid properties (page 866)
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positioning......................................815,962
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settings................................................... 771
sloped..................................................... 808
specifying on view level........................725
straight................................................... 929
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transparent............................................ 934
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559
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double dimensioning..................................209
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dragging
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drawing layouts
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examples of pour drawings................. 488

drawing views
aligning................................................... 189

1027



copying from other drawings.............. 178
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Drawing layout
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drawing properties
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rebar dimension mark..........................939

drawing views
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images.................................................... 519
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limitations.............................................. 519
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opening.................................................. 519
storing.................................................... 519
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drawing files
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drawing layout editor

add table................................................ 656
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drawing layout
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drawing mode............................................... 50
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loading object properties....................... 69
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moving....................................................348
reshaping............................................... 348
resizing................................................... 348
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detailed object level settings................. 70
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modifying in an open drawing...............67
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object level............................................... 69
setting before creating drawings.......... 65
view level.................................................. 70
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drawing revisions
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in dimensioning rules........................... 758
drawing view labels

section views..........................................294
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3D............................................................920
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arranging........................................ 178,189
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automatic............................................... 687
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back.........................................................920
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bottom....................................................920
bottom views......................................... 169
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creating...................................................689
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deformed parts..................................... 713
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direction marks..............................717,920
end.......................................................... 920
front........................................................ 920
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of reinforcement meshes.....................482
of selected area in a drawing.............. 169
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part orientation..................................... 697
projection type...................................... 693
rotating...................................................189
rotating parts.........................................700
scale.................................................674,920
section.................................................... 920
section view properties........................ 927
section views..........................................169
settings................................................... 920
shortening parts....................................708
showing openings and recesses......... 714
single-part views................................... 194
size.......................................................... 674
top...........................................................920
top views................................................ 169
unfolding polybeams............................712
view boundaries....................................189
view label marks....................................691
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viewing direction of beams, bracings and
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drawing
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dimensions............................................ 724
adding texts........................................... 320
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assembly drawing................................... 88
automatic drawing settings................. 650
autoscaling.............................................676
autosizing...............................................676
before creating........................................ 97
cast unit drawings................................... 90
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changing color....................................... 550
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cloning..................................... 141,142,144
closing.....................................................158
colors...............................................339,547
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creating....
95,99,106,112,116,122,142,151,153
creating for all parts..............................122
creating general arrangement drawings
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deleting...................................................594
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drawing size....................................672,674
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drawing view scale................. 672,673,674
editing.....................................................155
Exclude tables........................................164
fold marks.............................................. 639
frames.................................................... 639
freezing...................................................583
general arrangement drawings.............80
grid lines.................................................535
grids......................................... 534,535,865
hiding and showing objects................. 339
hyperlinks...............................................323
issuing.....................................................585
layouts...............................................59,163
links to other drawings.........................323
locking.................................................... 582
managing............................................... 558
master drawings................................... 129
modifying properties.........................67,69
moving......................................................55
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multiple drawing sheets of the same
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opening.................................................. 157
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printing to multiple sheets (old printing
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screen layout........................................... 50
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settings............................................650,911
single-part drawings............................... 85
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tables...................................................... 668
text files..................................................323
three levels of modifying........................62
titles........................................................ 156
types......................................................... 80
unissuing................................................585
unlocking................................................582
updating.......................................61,78,581
user-defined attributes................. 903,904
view filters................................................ 70
views.......................................... 59,687,689
with black background......................... 547
wizards................................................... 122
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dual dimensions
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DWG and DXF files
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DWG files
inserting to drawings............................519

DWG/DXF files.................................59,149,668
DWG
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in associative notes...............................297
edge chamfers..................................... 869,991

adding chamfer marks......................... 378
in drawings.............................................378

editing
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elements
in bolt marks..........................................860
in detail view label marks.....................982

in dimension marks.............................. 195
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in marks.......................................... 971,972
in merged reinforcement marks.........979
in neighbor reinforcement mesh marks
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in part marks......................................... 973
in reinforcement marks........................976
in reinforcement mesh marks.............977
in section view label marks..................982
in surface treatment marks................. 981
in view label marks............................... 982

elevation views............................................168
elevations

datum point........................................... 920
dimensioning.........................................774

embeds...........................................................85
end views..............................................689,920
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view direction marks............................ 717

enlarged views
adding dimension points..................... 259

enlarging
dimensions............................................ 800

erection elevation drawings........................ 80
exaggerating dimensions...........................800
exaggerating

selected dimensions............................. 256
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cast unit drawings................................... 90
cloning drawings................................... 146
dimensions in drawings....
263,778,780,781,786,787,791,792,793,
794,795
general arrangement drawings.............80
hatch patterns....................................... 890
part representation in drawings......... 869
printing (old)............................628,629,630
single-part drawings............................... 85

exploding
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file names
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in printing (old)...................................... 633

fill.................................................................. 991
fill, see hatches............................................883
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fillet
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fills.................................................................884
filtering

dimension tag content......................... 204
using drawing filters in anchor bolt plans
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view filters................................................ 70

filters
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in dimensioning rules

exclude filter for dimension tag.... 758
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filter for holes and recesses...........758
filter for main part of assembly.....758

on view level............................................ 70
finding
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finish.............................................................973
firm folder

for images and symbols....................... 330
fittings (NS/FS) ............................................ 973
fixed..............................................................195
fixed drawing main view ........................... 702
flipping outside dimensions...................... 261
fold marks....................................................639

add.......................................................... 656
add to drawings.....................................656
add to print outs................................... 656
in printed drawings...............................640

folders
in Master Drawing Catalog....138,139,140

folding printed drawings............................639
foldmarks.....................................................639
format

dimensions............................................ 851
level attributes.......................................851

forward offset...................................... 792,949
foundation plans.........................................113

frames.......................................................... 639
add.......................................................... 656
add to drawings.....................................656
add to print outs................................... 656
around marks........................................ 834
in printed drawings...............................640

framing plans.................................................80
free............................................................... 195
freezing
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and cloning............................................ 583
assembly drawings............................... 583
cast unit drawings.................................583
drawings.................................................583
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single-part drawings............................. 583

front drawing views..................... 169,703,920
front views................................................... 689
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creating...................................................112
defining automatic view properties....690

GA drawings, see general arrangement
drawings.......................................................201
gage of outstanding leg...................... 780,973
general arrangement drawings

3D views................................................... 80
anchor bolt plans.................................... 80
deck plans................................................ 80
erection elevation drawings...................80
foundation plans..................................... 80
framing plans...........................................80
isometric drawings..................................80
plans......................................................... 80
slab plans................................................. 80

general arrangement drawings
creating...................................................112

general arrangement drawings
creating using ribbon command...........97
defining automatic view properties....690
dimensioning parts to grids.................201
dimensions..............................808,809,962
freezing...................................................583
neighbor parts............................... 385,705
neighbor reinforcement.......................385
views....................................................... 690
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graphical drawing objects .........................149
graphical objects............................... 353,1017

re-ordering.............................................358
grid dimensions.......................................... 962
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grid labels
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grid lines
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modifying in drawings.......................... 535

grid UDAs..................................................... 536
grids

customizing in drawings.......................536
hiding in drawings.................................547
in drawings............... 534,535,536,865,866
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modfying in drawings........................... 535
moving grid labels in drawings............546
properties in drawings....................... 1018
user-defined attributes for customizing
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grouped dimensions
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handles
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hatch patterns
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surface treatment................................. 999
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parts........................................................884
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hidden parts
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showing frames and leader lines........ 847
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change symbols.....................................306
dimensions in drawings....................... 339
drawing objects..................................... 339
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highlighting
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holes
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identical objects
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images
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independent annotation objects
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independent annotation objects
DWG and DXF files................................ 323
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links.........................................................323
modifying............................................... 329
revision marks....................................... 329
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labels

drawing view labels...............................691
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landscape
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layout editor
add table................................................ 656
create layout..........................................656
edit layout.............................................. 656
move table............................................. 656

layouts
change.................................................... 163
select a new........................................... 163
table sets................................................669

leader lines.................................................. 841
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customizing arrows...............................330
for reinforcing bar group marks......... 839
handle points.........................................348
marks......................................................319
maximum leader line length in GA
drawings.................................................812
modifying............................................... 348
part marks..............................................836
setting advanced options.....................836
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types................................................839,990

length .......................................................... 973
lengthening parts........................................708
lengthening

shortened parts.....................................708
level attributes............................................ 851
level dimensions......................................... 929
level marks...................................................149

adding.....................................................292
properties.............................................. 989

levels
drawing level............................................62

object level............................................... 62
three levels of modifying drawings.......62
view level.................................................. 62

limitations in printing................................. 606
limiting outside dimensions in GA drawings
.......................................................................814
line extensions............................................ 799
line thickness ..............................................617
line thickness

pen numbers......................................... 646
line type........................................................376
line weight ...................................................617
line weight

pen numbers......................................... 646
line weights (old printing)

changing.................................................647
in printouts............................................ 647

line width..................................................... 617
lines.....................................................353,1017

customized line types...........................908
dividing................................................... 368
extending............................................... 366
shortening..............................................366
trimming.................................................366

linetypes.......................................................908
linking

dimension lines..................................... 271
drawing views from other drawings...178

links.................................................................59
hyperlinks...............................................323
modifying............................................... 329
to images................................................323
to DWG/DXF files...................................323
to other drawings..................................323
to text files............................................. 323

listing hidden parts.....................................339
location
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of column marks................................... 838
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of marks..........................................837,873
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locking
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adding surface treatment symbols in
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main views............................................168,689
managing

cut lines.................................................. 350
drawings.................................................558
moment connection symbols..............531

manual dimensions.................................... 195
mark drawings ready for issuing ............. 584
mark elements

pours.......................................................980
MarkDimensionFormat.dim...................... 851
marks............................................... 59,683,920
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adding............................................. 278,826
adding symbols..................................... 330
adding symbols..................................... 860
adding templates...........................850,854
appearance............................................ 965
automatic........................................824,826
bolt marks.............................................. 860
checking mark count............................ 278
color........................................................834
common elements................................972
containing templates............................856
content................................................... 965
contents................................................. 971
deleting...................................................278
detail marks........................................... 981
detail view label marks.........................982
drawing weld marks............................. 983
element unit settings............................848
elements..................................834,971,973
font..........................................................834
frames.................................................... 834
height......................................................834
in dimensions........................................ 936
in view labels......................................... 691
leader line types....................................839
leader lines.............................................330
level marks..................................... 292,989
location.............................837,838,841,873
merged reinforcement marks ............ 979
merging............................ 311,312,842,844
model weld marks................................ 986

neighbor reinforcement.......................976
part marks..............................................287
placing...........................................677,1013
positioning............................................. 983
properties....................................... 826,965
reinforcement................................ 398,976
reinforcement marks.................... 845,977
revision marks....................................... 329
section marks........................................ 981
section view label marks...................... 982
settings................................................... 824
showing frames and leader lines........ 847
surface treatment marks..................... 981
text appearance.................................... 834
units........................................................ 902
updating................................................. 303
user-defined attributes........................ 850
using templates.....................................858
view direction marks............................ 717
visibility...................................................829

Master Drawing Catalog..................... 106,130
adding master drawings...................... 130
cloning templates.......................... 130,137
copying drawings.................................. 140
customizing............................................129
managing............................................... 129
managing folders...........................138,139
master drawing properties...........133,134
preview images..................................... 133
removing drawings........................133,140
sample images.......................................133
searching................................................128
wizard files............................................. 135

master drawings......................................... 129
adding.....................................................130
cloning templates..................................130
properties....................................... 133,134
removing................................................ 133
rule sets..................................................130
searching................................................128
types....................................................... 108

material ....................................................... 973
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maximum number of outside dimensions....
814
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marks.............................................. 311,844
part marks...............................311,312,842
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mesh class................................................... 976
mesh diameter............................................977
mesh length.................................................977
mesh name..................................................976
mesh shape................................................. 976
mesh size..................................................... 977
mesh weight................................................ 976
mesh width.................................................. 977
mesh

creating a drawing view........................482
in drawings.............................................896
in neighbor parts...................................896
properties............................................ 1001
properties in drawings......................... 896

minimizing views.........................................949
minimum position dimensions................. 798
model objects................................................ 46

in drawings.............................................375
model weld marks

appearance in drawings.......................505
visibility in drawings..............................505

model welds................................................ 892
modeling direction......................................837
modifying

annotation object properties...............299
building objects..................................... 376
detail properties....................................297
dimension properties........................... 257
drawing grid line properties................ 535
drawing grid properties........................535
drawing grids.........................................866
drawing view properties.......................189
drawings...................................................62
independent annotation objects.........329
leader line shape...................................348
section properties................................. 294
symbol properties.................................330
wizard files............................................. 135

moment connection symbols....................330
moment connection symbols

creating........................................... 531,532
deleting...................................................531
managing............................................... 531
updating................................................. 531

moving
drawing views by dragging.................. 189
drawing views to another drawing..... 178
drawings...................................................55
end of dimension line...........................276
objects in drawings............................... 348
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creating empty multidrawings............ 104
creating of selected drawings..............104
creating of selected parts.....................104
updating................................................. 581

multiple drawing sheets of the same part....
152,153
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named size...................................................645
names

drawings.................................................156
neighbor part marks...................................826
neighbor parts.............................................867

in drawing views....................................705
in drawings.............................................872
in GA drawings...................................... 385
in general arrangement drawings...... 705
properties.............................................. 991
view extension............................... 705,920

neighbor reinforcement marks
elements......................................... 976,977

neighbor reinforcement
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new printing................................................ 607
north marks.................................................873
notes
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number of bars........................................... 976
numbering..................................................... 97
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in dimensioning............................. 809,962
in dimensioning GA drawings..............809
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building objects..................................... 375
cloned objects....................................... 149
drawing objects....................................... 59
modifying in drawings............................ 69
shapes.................................................... 352

offset.......................................................... 1017
forward offset................................ 792,949

opening
drawings......................................... 157,595

openings and recesses
showing in drawings.............................714
showing in views................................... 920

orientation marks....................................... 873
showing.................................................. 873
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orientation

of parts............................................697,873
of plates..................................................704

overall dimensions..................................... 729
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panning
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paper size............................................. 630,645
part marks
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advanced options for setting leader lines
.................................................................836
compass direction.................................873
containing templates............................856
deleting...................................................304
elements.................................................973
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level attributes.......................................851
merging................................... 312,842,844
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rotation angle........................................ 390
showing frames and leader lines........ 847
spiral beams.......................................... 390
updating................................................. 303
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part position ............................................... 973
parts

representation in drawings................. 376
additional markings in drawings.........376
color........................................................376

compass direction.................................873
connecting side marks..........................873
developed parts in drawings............... 713
dimensions..................................... 778,962
dimensions in GA drawings................. 815
fill options.............................................. 376
fills...........................................................884
hatches............................................376,884
in drawings..................................... 867,868
lengthening............................................708
lengthening in model............................708
lengthening shortened parts...............708
line types................................................ 376
orientation......................................697,873
properties....................................... 869,991
representation.......................................869
settings................................................... 869
shortening..............................................708
shortening in model............................. 708
shortening view by view.......................377

pattern line.................................................. 353
Pattern line editor.......................................353

creating pattern lines........................... 359
pattern lines................................................ 353
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hatches................................................... 883
pdf files
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pdf

customizing file names.........................622
printing................................................... 607

pen number.................................................617
pen numbers............................................... 646
pen numbers (old printing)

changing.................................................647
placement settings.......................677,683,685
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associative notes.................................1013
dimensions............................677,685,1013
fixed........................................................ 195
free..........................................................195
marks.....................................677,683,1013
notes.......................................................683
symbols.........................................683,1013
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plate side marks

showing.................................................. 260
plates.............................................................. 85
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orientation in drawings........................ 704

plot files, see print files.............................. 634
plotter

sending to.............................................. 607
plotting, see printing........................... 632,634
plotting, see printing (old)..........................625
plt
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plug-ins
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polybeams
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polygons............................................. 353,1017
polylines............................................. 353,1017
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portrait
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maximum...............................................798
minimum................................................798

positioning properties
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pour breaks
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properties............................................ 1010
showing in drawings.............................894

pour marks
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pour objects
modifying............................................... 488

pours
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examples of drawings and reports.....488
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pour breaks............................................488
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pour break symbol in drawings.......... 488

properties in drawings....................... 1010
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showing in drawings.............................894
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precast stairs
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precast beams
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preferred dim side......................................794
preferred scale............................................ 674
preventing
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preview images
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print files...................................................... 634
print paper size........................................... 607
printer.......................................................... 607
Printer Catalog............................................ 642
Printer Catalog (old printing)...... 642,643,644
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setting up............................................... 642
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printing (old)
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